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CHAPTER 1

Introduzione

Questo documento è la guida utente originale del software QGIS. Il software e l’hardware descritti in questo
documento sono nella maggior parte dei casi marchi registrati e sono pertanto soggetti a vincoli legali. QGIS è
rilasciato con la GNU General Public License. Maggiori informazioni sono disponibili sulla homepage di QGIS,
https://www.qgis.org.

I dettagli, i dati, i risultati ecc. presenti in questo documento sono stati scritti e verificati al meglio delle conoscenze
e della responsabilità degli autori e degli editori. Ciononostante, possono essere presenti errori nei contenuti.

Pertanto, nessun dato è soggetto ad alcun obbligo o garanzia. Gli autori, i redattori e gli editori non si assumono
alcun obbligo o responsabilità per malfunzionamenti e possibili conseguenze. Tutti gli utenti sono pertanto invitati
a segnalare eventuali errori.

Questo documento è stato realizzato con reStructuredText. E” disponibile come codice sorgente reST via github
<https://github.com/qgis/QGIS-Documentation> e online come HTML e PDF su https://www.qgis.org/en/docs/.
Le versioni tradotte di questo documento possono essere scaricate in diversi formati anche attraverso l’area di
documentazione del progetto QGIS. Per ulteriori informazioni su come contribuire a questo documento e sulla
sua traduzione, visitare il sito https://qgis.org/en/site/getinvolved/index.html.

Collegamenti presenti in questo documento

Questo documento contiene collegamenti interni ed esterni. Cliccando su un collegamento interno puoi spostarti
all’interno del manuale, mentre cliccando su un collegamento esterno si aprirà un indirizzo internet. in formato
PDF i collegamenti interni ed esterni sono mostrati in colore blu e sono gestiti dal browser del sistema operativo.
In formato HTML, il browser gestisce e mostra entrambi allo stesso modo.

Autori e redattori delle guide per l’utente, l’installazione e la programmazione:

L’elenco delle persone che hanno contribuito a scrivere, rivedere e tradurre la guida ufficiale è disponibile al
seguente link at Hanno contribuito.

Copyright (c) 2004 - 2017 QGIS Development Team

Internet: https://www.qgis.org

Licenza di questo documento

È garantito il permesso di copiare, distribuire e/o modificare questo documento in base ai termini della GNU
Free Documentation License, Versione 1.3 o ogni versione successiva pubblicata dalla Free Software Foundation;
senza alcuna sezione non modificabile, senza testo di copertina e retro-copertina. Una copia della licenza è inclusa
nell’appendice
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CHAPTER 2

Premessa

Benvenuti nel meraviglioso mondo dei Sistemi Informativi Geografici (GIS)!

QGIS è un sistema informativo geografico open source. Il progetto è nato a maggio del 2002 ed è stato confermato
come progetto su SourceForge a giugno dello stesso anno. Abbiamo lavorato sodo per creare un software GIS
(che normalmente è software proprietario e molto costoso) facilmente installabile e utilizzabile da tutti. QGIS
attualmente funziona sulla maggior parte delle piattaforme Unix, Windows e OS X. QGIS viene sviluppato usando
gli strumenti software Qt (https://www.qt.io) e il linguaggio C++. Questo significa che QGIS ha un’interfaccia
utente (GUI) snella, piacevole e facile da usare.

QGIS punta a essere un GIS facilmente utilizzabile da chiunque, fornendo tutte le funzioni e caratteristiche prin-
cipali. QGIS ha raggiunto l’obiettivo di essere utilizzato da molti utenti per soddisfare le esigenze quotidiane
di visualizzazione di dati georiferiti. QGIS supporta ora moltissimi formati raster e vettoriali, con supporti ad
ulteriori formati che sono aggiunti utilizzando plugin esterni.

QGIS è rilasciato sotto la GNU General Public License (GPL). Sviluppare QGIS con questa licenza significa che
puoi ispezionare e modificare il codice sorgente e garantisce che tu, nostro utente, avrai sempre accesso a un
programma GIS libero che potrai liberamente modificare. Insieme alla copia di QGIS dovresti aver ricevuto anche
una copia completa del testo della licenza che puoi trovare anche nell’Appendice di questo manuale Appendix A:
GNU General Public License.

Suggerimento: Documentazione aggiornata

La versione più recente di questo documento è sempre disponibile nell’area documentazione del sito web QGIS
all’indirizzo https://www.qgis.org/en/docs/.

3
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CHAPTER 3

Convenzioni

Questa sezione descrive le convenzioni e gli stili che verranno usati in questo manuale.

3.1 Convenzioni per l’interfaccia grafica

Le convenzioni stilistiche per l’interfaccia grafica hanno lo scopo di imitarne l’effettivo aspetto. In generale,
lo stile presentato nel manuale fa riferimento a ciò che compare nell’interfaccia grafica e non ai messaggi che
compaiono se il cursore del mouse si ferma sopra un pulsante.

• Opzioni di menu: Layer → Aggiungi raster oppure Impostazioni → Barre degli strumenti → Digitaliz-
zazione

• Strumenti: Aggiungi raster

• Pulsante : Salva come predefinito

• Titolo finestra di dialogo: Proprieta layer

• Scheda (tab): Generale

• Casella di controllo: Visualizzatore

• Pulsante di scelta: Postgis SRID EPSG ID

• Seleziona un numero:

• Seleziona una stringa:

• Cerca un file: . . . .

• Seleziona un colore:

• Cursore:

• Inserimento testo:

L’ombreggiatura caratterizza un componente dell’interfaccia grafica che è cliccabile.

5
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3.2 Convenzioni per il Testo o la Tastiera

Questo manuale include anche convenzioni stilistiche relative al testo, a comandi da tastiera e a parti di codice
che identificano costrutti diversi come classi o metodi. Questi stili non corrispondono all’attuale aspetto di nessun
testo o codice presente in QGIS.

• Link ipertestuali: https://qgis.org

• Combinazioni di tasti: Ctrl+B significa premere il tasto B mentre si tiene premuto il tasto Ctrl.

• Nome di un file: lakes.shp

• Nome di una classe: NewLayer

• Metodo: classFactory

• Server: myhost.de

• Inserimento di testo utente: qgis --help

I frammenti di codice sono identificati con un carattere a spaziatura fissa:

PROJCS["NAD_1927_Albers",
GEOGCS["GCS_North_American_1927",

3.3 Istruzioni specifiche per un sistema operativo

Sequenze GUI e piccole quantità di testo possono essere formattate in linea: Click File QGIS → Esci
per chiudere QGIS. Ciò indica che su piattaforme Linux, Unix e Windows, è necessario prima fare clic sul menu
File, quindi su Esci, mentre su piattaforme macOS, è necessario prima fare clic sul menu QGIS, quindi su Esci.

I testi di grandi dimensioni possono venire formattati come elenco:

• fai questo

• fai quello

• o fai questo

o come paragrafi:

fai questo e questo e questo. Quindi fai questo e questo, e questo.

fai questo. Poi fai questo e questo e questo , e ancora e ancora e ancora, e ancora e ancora e ancora, e ancora e
ancora.

Le schermate riportate nella guida sono state create su diversi sistemi operativi, indicati da apposite icone alla fine
della didascalia.

6 Chapter 3. Convenzioni
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CHAPTER 4

Caratteristiche

QGIS offre molte delle più comuni funzionalità GIS grazie alle sue caratteristiche di base e ai plugin. Di seguito
viene elencato un piccolo riassunto delle sei categorie generali delle funzionalità e dei plugin, seguito da una
panoramica della console python integrata.

4.1 Visualizzazione dati

Puoi visualizzare una combinazione di dati vettoriali e raster (in 2D o 3D) in differenti formati e proiezioni senza
convertirli in un formato interno o comune. I formati supportati includono:

• Tabelle e viste con dati spaziali che usano PostGIS, SpatiaLite e MS SQL Spatial, Oracle Spatial e vettori
supportati dalla libreria OGR, inclusi GeoPackage, ESRI shapefile, MapInfo, SDTS, GML e molti molti
altri. Vedi la sezione Lavorare con i vettori.

• Raster e immagini supportati dalla libreria GDAL (Geospatial Data Abstraction Library), come GeoTIFF,
ERDAS IMG, ArcInfo ASCII GRID, JPEG, PNG e molti altri ancora, vedi la sezione Lavorare con i dati
raster.

• Raster e vettori GRASS dai relativi database (location/mapset), vedi la sezione Integrazione con GRASS
GIS.

• Dati spaziali accessibili da Web Services OGC, come (WMS, WMTS, WCS, WFS, WFS-T, . . . ), vedi
sezione Lavorare con i dati OGC.

4.2 Esplorare dati e comporre mappe

Puoi creare delle mappe ed esplorare i dati spaziali con un’interfaccia grafica molto facile da usare. L’interfaccia
grafica ti mette a disposizione molti strumenti, fra cui:

• QGIS Browser

• Riproiezione al volo

• DB Manager

• Layout di stampa

• Pannello vista generale
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• Segnalibri spaziali

• Note testuali

• Funzioni di identificazione/selezione

• Modifica/visualizzazione/ricerca degli attributi

• Etichettatura con dati definiti dall’utente

• Simbologia definita dall’utente per vettori e raster

• Creazione atlante

• Freccia nord, barra di scala ed etichetta di copyright per le mappe

• Supporto per il salvataggio e il ripristino di progetti

4.3 Creazione, modifica, gestione ed esportazione dati

Puoi creare, modificare, gestire ed esportare i vettori e i raster in molti formati. QGIS offre quanto segue:

• Strumenti per la digitalizzazione per i formati OGR e per i vettori GRASS

• Possibilità di creare e modificare molti formati di file e layer vettoriali GRASS

• Plugin georeferenziatore per geocodificare le immagini

• Strumenti GPS per importare ed esportare il formato GPX, e convertire altri formati GPS in GPX o scari-
care/caricare direttamente su un’unità GPS (su Linux, usb: è stato aggiunto all’elenco dei dispositivi GPS).

• Supporto per la visualizzazione e la modifica di dati OpenStreetMap

• Possibilità di creare tabelle di database spaziali dai file con il plugin DB Manager

• Gestione delle tabelle di database spaziali migliorata

• Strumenti per gestire le tabelle degli attributi di un vettore

• Salvataggio di schermate come immagini georiferite

• DXF-Export strumento con avanzate capacità di esportare stili e plugins in grado di attivare funzioni tipo
CAD.

4.4 Analisi dei dati

Puoi effettuare analisi di dati spaziali sia su database spaziali che su altri formati supportati da OGR. Attualmente
QGIS offre strumenti di analisi vettoriale, campionamento, geoprocessing, gestione della geometria e del database.
Puoi anche utilizzare gli strumenti integrati di GRASS che includono l’intera funzionalità di GRASS di oltre 400
moduli. (Vedi sezione Integrazione con GRASS GIS). Oppure puoi lavorare con il plugin Processing che fornisce
una potente struttura di analisi geospaziale per richiamare da QGIS algoritmi nativi e di terze parti, come GDAL,
SAGA, GRASS e altri. (Vedi sezione Introduzione).

4.5 Pubblicazione di mappe su internet

QGIS può essere usato come client WMS, WMTS, WMS-C o WFS e WFS-T, e come server WMS, WCS o WFS
(vedi sezione Lavorare con i dati OGC). Inoltre, puoi pubblicare i tuoi dati su Internet utilizzando un webserver
con installato UMN MapServer o GeoServer.
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4.6 Estendi le funzionalità di QGIS attraverso i plugin

Puoi adattare QGIS ai tuoi scopi grazie all’architettura estensibile dei plugin e alle librerie che possono essere
usate per la creazione di plugin. Ma puoi anche creare le tue nuove applicazioni con C++ o Python!

4.6.1 Plugin nativi

I plugin nativi includono:

1. Cattura coordinate (cattura tramite mouse di coordinate in differenti Sistemi di Riferimento)

2. DB Manager (scambia, modifica e visualizza layer e tabelle da/su database; esegue interrogazioni in SQL)

3. eVIS (visualizza eventi)

4. Validatore geometria (controlla gli errori delle geometrie)

5. Georeferenziatore raster (aggiunge ai raster informazioni sulla proiezione utilizzando GDAL)

6. Strumenti GPS (carica e importa dati GPS)

7. GRASS 7 (integra il GIS GRASS)

8. Client Catalogo MetaSearch (interfaccia con i servizi di catalogazione dei metadati che supportano lo stan-
dard OGC Catalog Service for the Web (CSW))

9. Editing Offline (permette la modifica offline e la sincronizzazione con i database)

10. Processing (il framework per l’elaborazione di dati spaziali di QGIS)

11. Validatore topologico (trova errori topologici nei layer vettoriali)

4.6.2 Plugin esterni in python

QGIS offre un crescente numero di plugin Python esterni creati dalla comunità. Questi plugin sono presenti
all’interno del repository ufficiale dei plugin e possono essere facilmente installati usando l’installatore dei plugin
python. Vedi Sezione La finestra di dialogo Plugins.

4.7 Console python

Per lo scripting, è possibile usufruire di una console Python integrata, che può essere aperta con: Plugins → Python
Console. La console si apre come finestra di utilità non modale. Per l’interazione con l’ambiente QGIS, c’è la
variabile qgis.utils.iface, che è un’istanza di QgisInterface. Questa interfaccia fornisce l’accesso
al canvas della mappa, ai menu, alle barre degli strumenti e ad altre parti dell’applicazione QGIS.Puoi creare uno
script, quindi trascinarlo e rilasciarlo nella finestra di QGIS e verrà eseguito automaticamente.

Per ulteriori informazioni su come lavorare con la console Python e programmare i plugin e le applicazioni QGIS,
fare riferimento a QGIS Python console e PyQGIS-Developer-Cookbook.

4.8 Problemi noti

4.8.1 Limitazione numero di file aperti

Se stai aprendo un grande progetto di QGIS e sei sicuro che tutti i layer sono validi, ma qualche layer viene
segnalato come corrotto, probabilmente ti stai scontrando con questo problema. Linux (e probabilmente anche
altri sistemi operativi) hanno un limite di file aperti per ogni processo. I limiti delle risorse e per ogni processo
vengono automaticamente ereditati. Il comando ulimit, preinstallato nella console dei comandi, cambia i limiti
solo per il processo attuale; il nuovo limite viene ereditato da ogni altro processo.
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Puoi vedere tutti gli ulimit attuali digitando:

$ ulimit -aS

Poi vedere l’attuale numero permesso di le aperti per ogni processo con questo comando da console:

$ ulimit -Sn

Per cambiare i limiti di una sessione esistente, potresti usare qualcosa del genere:

$ ulimit -Sn #number_of_allowed_open_files
$ ulimit -Sn
$ qgis

Risolverlo per sempre

Sulla maggior parte dei sistemi Linux, i limiti alle risorse sono impostati al momento del login tramite il mod-
ulo pam_limits in funzione delle impostazioni contenute in /etc/security/limits.conf o /etc/
security/limits.d/*.conf. Dovresti modificare questi file sei hai i permessi di amministratore (anche
tramite sudo), ma dovrai effettuare di nuovo il login prima che i cambiamento siano effettivi.

Maggiori informazioni:

https://www.cyberciti.biz/faq/linux-increase-the-maximum-number-of-open-files/ https://linuxaria.com/article/
open-files-in-linux
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CHAPTER 5

Novità in QGIS 3.4

Questa versione contiene nuove funzionalità ed amplia l’interfaccia di programmazione delle precedenti versioni.
Consigliamo quindi di usare questa versione al posto di quelle precedenti.

Questa release include centinaia di correzioni di bug e molte nuove funzionalità e miglioramenti su QGIS 2.18
che saranno descritti in questo manuale. Puoi anche consultare l’elenco delle modifiche su https://qgis.org/en/site/
forusers/visualchangelogs.html.
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CHAPTER 6

Come Iniziare

Questo capitolo fornisce una rapida panoramica sull’installazione di QGIS, su dati campione scaricabili dal sito
di QGIS e su come avviare una prima semplice sessione in cui visualizzare dati raster e dati vettoriali.

6.1 Installare QGIS

Il progetto QGIS fornisce differenti modi per installare QGIS in base alla tua piattaforma.

6.1.1 Installazione da codice sorgente

Sono disponibili pacchetti di installazione standard per MS Windows e macOS. Pacchetti binari (rpm e deb)

o repository software sono disponibili per molte versioni di GNU/Linux .

Per ulteriori informazioni e istruzioni per il tuo sistema operativo consulta https://download.qgis.org.

6.1.2 Installazione da codice sorgente

Se vuoi generare QGIS dal codice sorgente, fai riferimento alle istruzioni per l’installazione. Sono distribuite con
il codice sorgente QGIS in un file chiamato INSTALL. Puoi trovarle anche online all’indirizzo http://htmlpreview.
github.io/?https://raw.github.com/qgis/QGIS/master/doc/INSTALL.html.

Se vuoi generare un particolare release e non la versione in sviluppo, dovresti sostituire master con il nome
del release (comunemente nella versione release-X_Y) nel link di cui sopra (le istruzioni di installazione
potrebbero essere differenti).

6.1.3 Installazione su supporti esterni

È possibile installare QGIS (con tutti i plugin e le impostazioni) su una flash drive. Questo si ottiene definendo
un’opzione –profiles-path che sovrascrive il percorso predefinito user profile e costringe QSettings ad usare anche
questa cartella. Vedere la sezione Impostazioni di sistema per ulteriori informazioni.
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6.1.4 Dati campione

Questa guida utente contiene alcuni esempi basati sull’insieme di dati campione di QGIS (anche chiamato
Alaska dataset).

Durante l’installazione di QGIS in Windows hai la possibilità di scaricare un insieme di dati campione. Se
hai selezionato questa opzione, i dati verranno scaricati nella tua cartella My Documents e verranno copiati in
una cartella chiamata GIS Database. Puoi usare Windows Explorer per spostare questa cartella in qualunque
altra posizione. Se non hai selezionato la casella di controllo per scaricare l’insieme di dati campione durante
l’installazione iniziale di QGIS puoi scegliere fra:

• Usare dati GIS che hai già

• Fare il download dei dati di esempio da http://qgis.org/downloads/data/qgis_sample_data.zip

• Disinstallare QGIS e reinstallarlo selezionando l’opzione per lo scaricamento dei dati (opzione consigliata
solo se le soluzioni precedenti non sono riuscite)

Per GNU/Linux e MacOS, non sono ancora disponibili pacchetti di installazione come rpm, deb o dmg.
Per utilizzare l’insieme dei dati di esempio, scaricare il file qgis_sample_data come archivio zip da http:
//QGIS.org/downloads/data/ e decomprimere l’archivio sul sistema.

L’insieme di dati Alaska comprende tutti i dati GIS usati per gli esempi e le schermate nel manuale utente, e include
anche un piccolo database GRASS. La proiezione per l’insieme di dati campione di QGIS è Alaska Albers Equal
Area con unità in piedi. Il codice EPSG è 2964.

PROJCS["Albers Equal Area",
GEOGCS["NAD27",
DATUM["North_American_Datum_1927",
SPHEROID["Clarke 1866",6378206.4,294.978698213898,
AUTHORITY["EPSG","7008"]],
TOWGS84[-3,142,183,0,0,0,0],
AUTHORITY["EPSG","6267"]],
PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],
UNIT["degree",0.0174532925199433,
AUTHORITY["EPSG","9108"]],
AUTHORITY["EPSG","4267"]],
PROJECTION["Albers_Conic_Equal_Area"],
PARAMETER["standard_parallel_1",55],
PARAMETER["standard_parallel_2",65],
PARAMETER["latitude_of_center",50],
PARAMETER["longitude_of_center",-154],
PARAMETER["false_easting",0],
PARAMETER["false_northing",0],
UNIT["us_survey_feet",0.3048006096012192]]

Se vuoi usare QGIS come interfaccia grafica per GRASS, puoi trovare una selezione di dati di esempio (per
esempio Spearsh o South Dakota) direttamente dal sito ufficiale GRASS GIS, http://grass.osgeo.org/download/
sample-data/.

6.2 Avviare e uscire da QGIS

L’avvio di QGIS può essere fatto in modo analogo a quello che tu generalmente fai per altre applicazioni sul tuo
sistema. Ciò significa che puoi avviare QGIS:

• usando il menu Applicazioni, il menu Start o il Dock

• doppio clic sull’icona nella tua cartella Applicazioni o sul collegamento sul desktop

• facendo doppio clic su un file di progetto QGIS esistente (con estensione .qgz o .qgs). Nota che questo
aprirà anche il progetto.
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• digitando qgis nel prompt dei comandi (supponendo che QGIS sia aggiunto al tuo PATH o che tu sia nella
sua cartella di installazione)

Per uscire da QGIS, usa:

• l’opzione del menu Progetto → Esci da QGIS o usa la scorciatoia Ctrl+Q

• QGIS → Quit QGIS, o usa la scorciatoia Cmd+Q

• oppure utilizza la croce rossa nell’angolo in alto a destra dell’interfaccia principale dell’applicazione.

6.3 Sessione di esempio: caricare layers raster e vettoriali

Ora che hai QGIS installad e un sample dataset disponibile, mostreremo una prima sessione di esempio. In questo
esempio, visualizzeremo un layer raster e un layer vettoriale. Useremo:

• il layer raster landcover (qgis_sample_data/raster/landcover.img)

• e il layer vettoriale lakes (qgis_sample_data/gml/lakes.gml)

Dove qgis_sample_data rappresenta il percorso del dataset decompresso.

1. Avvia QGIS come visto in Avviare e uscire da QGIS.

2. Per caricare i file in QGIS:

(a) Clicca sull’icona Apri Gestore della sorgente dati. Il Data Source Manager dovrebbe aprirsi in modalità
Browser.

(b) Sfoglia la cartella qgis_sample_data/raster/

(c) Seleziona il file IMG ERDAS landcover.img e fai doppio clic su di esso. Il layer landcover viene
aggiunto in background mentre la finestra Data Source Manager rimane aperta.

(d) Per caricare i dati dei laghi, sfoglia la cartella qgis_sample_sample_data/gml/, e fai doppio
clic sul file :file:‘lakes.gml‘per aprirlo.

(e) Si apre la finestra di dialogo Selettore Sistema di Riferimento delle Coordinate. Nel menu Filtro, digita
2964, si ottiene di seguito la lista filtrata dell’elenco dei sistemi di riferimento delle coordinate.

(f) Seleziona il sistema NAD27 / Alaska Alberts

(g) Fai clic su OK

(h) Chiudi la finestra Gestore della sorgente dati.

Ora hai i due layer disponibili nel tuo progetto in alcuni colori casuali. Facciamo qualche personalizzazione sul
layer laghi.

1. Seleziona lo strumento Ingrandisci sulla barra degli strumenti Gestisci la barra di navigazione

2. Fai zoom su un’area con alcuni laghi

3. Fai doppio click sul layer lakes nella legenda per aprire la finestra di dialogo Proprietà.

4. Per cambiare il colore dei laghi:

(a) Clicca sulla scheda Simbologia e seleziona blu come colore di riempimento.

(b) Seleziona blu come colore di riempimento

(c) Premi OK. I laghi sono ora visualizzati in blu nella mappa.

5. Per visualizzare i nomi dei laghi:

(a) Riapri la finestra di dialogo Proprietà del layer lakes.

(b) Clicca sulla scheda Etichette
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Figure 6.1: Aggiungere dati a un nuovo progetto in QGIS
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Figure 6.2: Seleziona il Sistema di Riferimento delle Coordinate
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Figure 6.3: Selezione del colore dei laghi
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(c) Seleziona Etichette singole nel menu a discesa per abilitare l’etichettatura.

(d) Dalla lista Etichetta con, scegli il campo Nomi.

Figure 6.4: Visualizzazione del nome dei laghi

(e) Premi Applica. I nomi ora passeranno sopra i confini.

6. Puoi migliorare la leggibilità delle etichette aggiungendo un buffer bianco intorno ad esse:

(a) Clicca sulla scheda Buffer nella lista sulla sinistra

(b) Seleziona Disegna buffer del testo

(c) Scegli 3 come dimensione del buffer

(d) Fai clic su Applica

(e) Controlla se il risultato è buono e, se necessario, aggiorna il valore.

(f) Infine clicca OK per chiudere la finestra di dialogo Proprietà vettore e applicare le modifiche.

Aggiungiamo ora alcune decorazioni per migliorare la mappa ed esportarla da QGIS:

1. Seleziona il menu Visualizza → Decorazioni → Barra di scala

2. Nella finestra di dialogo che si apre, spunta l’opzione Attiva Barra di Scala

3. Personalizza le opzioni nella finestra di dialogo come preferisci

4. Premi Applica

5. Analogamente, dal menu decorazioni, aggiungi altre voci (freccia nord, copyright. . . .) alla mappa con
proprietà personalizzate.

6. Clicca Progetto → Importa/Esporta → Esporta Mappa come Immagine. . .

6.3. Sessione di esempio: caricare layers raster e vettoriali 19
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7. Premi Salva nella finestra di dialogo aperta

8. Seleziona il percorso del file, il formato e conferma cliccando Salva ancora.

9. Premi Progetto → Salva per memorizzare le modifiche come file di progetto .qgz.

Ecco fatto! Puoi vedere quanto sia facile visualizzare i layer raster e vettoriali in QGIS, configurarli e generare la
tua mappa in un formato immagine che puoi usare in altri software. Passiamo ad approfondire le funzionalità, le
caratteristiche e le impostazioni disponibili e come usarle.

Nota: Per continuare ad imparare QGIS attraverso esercizi passo dopo passo, utilizza il Training manual.
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CHAPTER 7

Lavorare con i File di Progetto

7.1 Introduzione ai progetti QGIS

Lo stato della tua sessione QGIS è considerato un Progetto. QGIS lavora su un progetto alla volta. Le impostazioni
sono proprie di un progetto oppure di una applicazione predefinita per i nuovi progetti (vedi la sezione Opzioni
dell’interfaccia grafica (GUI)). QGIS può salvare lo stato del tuo spazio di lavoro in un le di progetto usando le

opzione del menu Progetto → Salva o Progetto → Salva come. . . .

Nota: If the project you loaded has been modified in the meantime, by default, QGIS will ask you if you want

to overwrite the changes. This behavior is controlled by the Prompt to save project and data source changes
when required setting under Settings → Options → General menu.

Puoi caricare progetti salvati in QGIS usando Progetto → Apri. . . , Progetto → Nuovo da modello o Progetto
→ Apri recenti →.

All’avvio di QGIS viene visualizzata una lista di progetti aperti di recente, inclusi gli screenshot, i nomi e i link
di riattivazione (fino a dieci progetti). Questo è un modo pratico e veloce per aprire progetti recenti. Se invece
vuoi creare un nuovo progetto, aggiungi nuovi layer e l’elenco scompare, lasciando il posto alla visualizzazione
mappa.

Se vuoi iniziare una nuova sessione, scegli Progetto → Nuovo. In questo modo ti sarà chiesto di salvare il
progetto esistente se sono state apportate modifiche da quando è stato aperto o salvato l’ultima volta.

Le informazioni salvate in un file di progetto includono:

• Layer aggiunti

• Quali layer sono interrogabili

• Proprietà dei layer, inclusi i simboli e gli stili associati

• Proiezione usata per la mappa

• Ultima estensione della mappa

• Layout di stampa

• Gli elementi del layout di stampa con le impostazioni
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Figure 7.1: Aprire un nuovo progetto in QGIS

• Le impostazioni del layout di stampa dell’atlante

• Settaggi dei parametri di digitalizzazione

• Relazioni tra le tabelle

• Macro di progetto

• Stili predefiniti per il Progetto

• Settaggi dei Plugin

• Impostazioni del server QGIS dalla scheda Impostazioni OWS nelle proprietà del progetto

• Query memorizzate nel DB Manager

Il file di progetto viene salvato in formato XML. Questo significa che è possibile modificare il file al di fuori di
QGIS se sai cosa stai facendo. Il formato del file è stato aggiornato più volte rispetto alle versioni precedenti di
QGIS. I file di progetto delle versioni precedenti di QGIS potrebbero non funzionare più correttamente.

Nota: Per impostazione predefinita, QGIS ti avvertirà delle differenze di versione. Questo comportamento è

controllato in Impostazioni → Opzioni. . . . Nella scheda Generale, dovresti spuntare Avvisa quando si apre un
file di progetto salvato con una versione precedente di QGIS.

Ogni volta che salvi un progetto .qgs in QGIS, viene creato un backup del file di progetto con l’estensione
.qgs~ e memorizzato nella stessa directory del file di progetto.

L’estensione per i progetti QGIS è .qgs ma quando si salva da QGIS, l’impostazione predefinita è quella di
salvare utilizzando un formato compresso con l’estensione .qgz. Il file .qgs è incorporato nel file .qgz (un
archivio zip), insieme al database associato sqlite (.qgd) per i dati ausiliari. Puoi accedere a questi file effettuando
la decompressione.

Nota: Un progetto zippato può essere particolarmente utile con il meccanismo Proprietà Dati Ausiliari per
includere il database sottostante.
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I progetti possono anche essere salvati/caricati in/da un database PostgreSQL utilizzando le seguenti voci del menu
Progetto:

• Progetto → Apri da

• Progetto → Salva su

Entrambe le voci di menu hanno un sottomenu con una lista di implementazioni extra di storage del progetto
(attualmente solo PostgreSQL). Facendo clic sull’azione si aprirà una finestra di dialogo per scegliere il nome di
una connessione PostgreSQL, il nome dello schema e del progetto.

I progetti memorizzati in PostgreSQL possono anche essere caricati dal pannello del browser QGIS (le voci si
trovano all’interno dello schema in cui sono memorizzate), facendo doppio clic su di essi o trascinandoli nell’area
di disegno della mappa.

7.2 Generazione output

Ci sono diversi modi per generare output dalla sessione QGIS. Abbiamo già discusso il salvataggio come file di
progetto in Introduzione ai progetti QGIS. Altri modi per produrre file di output sono:

• Creazione di immagini: Progetto → Importa/Esporta → Esporta Mappa come Immagine. . . apre una
finestra di dialogo dove si seleziona il nome, il percorso e il tipo di immagine (PNG, JPG e molti altri
formati). Questo creerà anche un world file (con estensione PNGW or JPGW) che viene salvato nella tua
cartella delle immagini. Questo world file viene utilizzato per georeferenziare l’immagine.

• Esportazione in file DXF: Progetto → Importa/Esporta → Esporta Progetto in DXF. . . . apre una finestra di
dialogo dove è possibile definire la “Modalità simbologia”, la “Scala Simbologia” e i layeri vettoriali che
vuoi esportare in DXF. Attraverso la modalità “Modalità simbologia” i simboli della Simbologia originale
di QGIS possono essere esportati con alta fedeltà (vedi la sezione Creazione di nuovi file DXF).

• Esportazione in file PDF: Progetto → Importa/Esporta → Esporta Mappa in PDF. . . apre una finestra di
dialogo dove si può definire la parte (Estensione) della mappa da esportare, la Scala, Risoluzione, Larghezza
di Output (pixel) e Altezza di Output (pixel). Si può anche scegliere Disegna le decorazioni attive e Scrivi
annotazioni, così come Rasterizza mappa.

• Stampare le mappe: Progetto → Nuovo Layout di Stampa. . . . apre una finestra di dialogo dove è
possibile impaginare e stampare la mappa corrente (vedere la sezione Layout di stampa).
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CHAPTER 8

QGIS GUI

Quando QGIS si avvia, viene visualizzata una GUI come mostrato nella figura sottostante (i numeri da 1 a 5
cerchiati in giallo sono di seguito trattati).

Figure 8.1: QGIS GUI con i dati di esempio Alaska

Nota: L’aspetto delle finestre (barra del titolo, ecc.) potrà apparire diverso a seconda del sistema operativo e
dell’ambiente desktop.

La QGIS GUI è divisa in 5 aree:

1. Barra dei Menu

25
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2. Barre degli strumenti

3. Pannelli

4. Mappa

5. Barra di Stato

Scorri verso il basso per spiegazioni dettagliate di queste funzionalità.

8.1 Barra dei Menu

La barra dei menu fornisce accesso alle varie funzioni di QGIS utilizzando un menu gerarchico standard. I Menu,
le relative opzioni, le icone associate e le scorciatoie da tastiera sono descritti di seguito. Queste scorciatoie da
tastiera sono le impostazioni predefinite, ma possono essere riconfigurate utilizzando il menu Tastiera Scorciatoie
tramite il menu Impostazioni →.

La maggior parte delle opzioni dei menu hanno uno strumento corrispondente e viceversa. Tuttavia, i menu non
sono organizzati esattamente come le barre degli strumenti. Le posizioni delle opzioni di menu nelle barre degli
strumenti sono indicate nella tabella seguente. I plugin possono aggiungere nuove opzioni ai menu. Per ulteriori
informazioni sugli strumenti e le barre degli strumenti, vedi Barre degli strumenti.

Nota: QGIS è un’applicazione multipiattaforma - sebbene gli stessi strumenti siano disponibili su tutte le pi-
attaforme - possono essere posizionati in menu differenti sui diversi sistemi operativi. Gli elenchi che seguono
mostrano le posizioni più comuni, comprese le variazioni note.

8.1.1 Progetto

Il menu Progetto fornisce le opzioni di accesso e di uscita del project file. Fornisce gli strumenti per:

• Creare un Nuovo file da zero o utilizzando un altro file di progetto come modello (vedi Project files options
per la configurazione del modello).

• Apri. . . . un file di progetto o da un progetto recente o da un database PostgreSQL

• Chiudi un progetto o riportalo al suo ultimo salvataggio

• Salva un progetto in formato .qgs o .qgz, come file o all’interno di un database PostgreSQL.

• Esporta la mappa in diversi formati o utilizza un print layout per output più complessi.

• Imposta le proprietà del progetto e le opzioni di aggancio quando si modificano i layer.
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Voce di Menu Scorcia-
toia

Barra degli
Strumenti

Riferimento

Nuovo Ctrl+N Progetto Introduzione ai progetti QGIS
Nuovo da modello → Introduzione ai progetti QGIS

Apri. . . Ctrl+O Progetto Introduzione ai progetti QGIS
Apri da → PostgreSQL Introduzione ai progetti QGIS
Apri Recenti → Introduzione ai progetti QGIS
Chiudi Introduzione ai progetti QGIS

Salva Ctrl+S Progetto Introduzione ai progetti QGIS

Salva come. . . Ctrl+Shift+SProgetto Introduzione ai progetti QGIS
Salva su → Post-
greSQL. . .

Introduzione ai progetti QGIS

Ripristina. . .
Proprietà. . . Ctrl+Shift+P Proprietà progetto
Opzioni di aggancio. . . Impostare la Tolleranza dello Snapping e il rag-

gio di ricerca degli elementi
Importa/Esporta →

Esporta Mappa come
Immagine. . .

Generazione output

Esporta Mappa come
PDF. . .

Generazione output

Esporta Progetto in
DXF. . .

Generazione output

Importa vettori da
DWG/DXF

Importare file DXF o DWG

Nuovo Layout di
Stampa. . .

Ctrl+P Progetto Layout di stampa

Nuovo Report. . . Layout di stampa

Gestore del Lay-
out. . .

Progetto Layout di stampa

Layout → Layout di stampa

Esci da QGIS Ctrl+Q

In macOS, il comando Exit QGIS corrisponde a QGIS → Esci da QGIS (Cmd+Q).

8.1.2 Modifica

Il menu Modifica fornisce la maggior parte degli strumenti nativi necessari per modificare gli attributi dei layer o
la geometria (vedi Modifica per i dettagli).

Voce di Menu Scorciatoia Barra degli Strumenti Riferimento

Annulla Ctrl+Z Digitalizzazione Annullare e rispristinare

Ripristina Ctrl+Shift+Z Digitalizzazione Annullare e rispristinare
Continued on next page
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Table 8.1 – continued from previous page
Voce di Menu Scorciatoia Barra degli Strumenti Riferimento

Taglia geometrie Ctrl+X Digitalizzazione Tagliare, copiare ed incollare elementi

Copia geometrie Ctrl+C Digitalizzazione Tagliare, copiare ed incollare elementi

Incolla geometrie Ctrl+V Digitalizzazione Tagliare, copiare ed incollare elementi
Incolla Elementi Come → Lavorare con la tabella degli attributi
Seleziona → Attributi Selezionare elementi

Aggiungi elemento Ctrl+. Digitalizzazione

Aggiungi Elemento Puntuale Ctrl+. Digitalizzazione Aggiungere Elementi

Aggiungi Elemento Lineare Ctrl+. Digitalizzazione Aggiungere Elementi

Aggiungi Elemento Poligonale Ctrl+. Digitalizzazione Aggiungere Elementi

Aggiungi geometria circolare Digitalizzazione Aggiungere arco circolare

Aggiungi geometria circolare dal raggio Digitalizzazione Aggiungere arco circolare
Aggiungi Cerchio → Digitalizzazione
Aggiungi Rettangolo → Digitalizzazione
Aggiungi Poligono Regolare → Digitalizzazione
Aggiungi Ellisse → Digitalizzazione

Muovi geomertria(e) Digitalizzazione avanzata Sposta Elemento(i)

Copia e Sposta Elemento(i) Digitalizzazione avanzata Sposta Elemento(i)

Elimina selezionato Digitalizzazione Eliminare Elementi Selezionati

Modifica Attributi Elementi Selezionati Digitalizzazione Modifica dei valori nella tabella degli attributi

Ruota geometria(e) Digitalizzazione avanzata Ruota Elemento/i

Semplifica geometria Digitalizzazione avanzata Semplifica Elemento

Aggiungi buco Digitalizzazione avanzata Aggiungi buco

Aggiungi parte Digitalizzazione avanzata Aggiungi Parte

Riempi buco Digitalizzazione avanzata Riempi buco

Elimina buco Digitalizzazione avanzata Elimina buco

Elimina parte Digitalizzazione avanzata Elimina Parte

Modifica geometrie Digitalizzazione avanzata Modifica la forma

Curva di offset Digitalizzazione avanzata Curve di Offset

Dividi geometrie Digitalizzazione avanzata Spezza Elementi

Dividi parti Digitalizzazione avanzata Dividi Parti

Unisci geometrie selezionate Digitalizzazione avanzata Fondi elementi selezionati

Fondi Attributi Elementi Selezionati Digitalizzazione avanzata Fondi gli attributi degli elementi selezionati (merge)

Strumento Vertice (per tutti i vettori) Digitalizzazione Strumento Vertice

Strumento Vertice (Layer attivo) Digitalizzazione Strumento Vertice

Ruota i simboli per i punti Digitalizzazione avanzata Ruota Simboli del Punto

Offset simboli punti Digitalizzazione avanzata Offset dei simboli per i punti
Continued on next page
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Table 8.1 – continued from previous page
Voce di Menu Scorciatoia Barra degli Strumenti Riferimento

Invertire Linea Digitalizzazione avanzata

Gli strumenti che dipendono dal tipo di geometria vettoriale selezionata, cioè punto, polilinea o poligono, vengono
attivati di conseguenza:

Voce di Menu Punto Polilinea Poligono

Sposta Elemento(i)

Copia e sposta geometria(e)

8.1.3 Mappa

La mappa viene visualizzata nell’area mappa. Puoi interagire con queste visualizzazioni utilizzando gli strumenti
Visualizza (vedi Lavorare sulla mappa per maggiori informazioni). Per esempio, puoi:

• Creazione di nuove visualizzazioni di mappe 2D o 3D accanto all’area di disegno della mappa principale

• Zoom or pan in una zona

• Interrogazione degli attributi o delle geometria degli elementi visualizzati

• Migliorare la visualizzazione della mappa con le modalità di anteprima, le annotazioni o le decorazioni

• Accesso ai diversi pannelli o barre degli strumenti

Il menu ti permette anche di riorganizzare l’interfaccia QGIS stessa utilizzando azioni come:

• Attiva schermo intero: copre l’intero schermo nascondendo la barra del titolo.

• Attiva Visibilità Pannello: mostra o nasconde pannelli attivi panels - utile per la digitalizzazione di elementi
(per la massima visibilità della mappa) così come per presentazioni (proiettate/registrate) utilizzando la
mappa principale di QGIS

• Attiva solo la Mappa: nasconde pannelli, barre degli strumenti, menu e barra di stato e mostra solo la mappa.
In combinazione con l’opzione a schermo intero, visualizza sul tuo schermo solo la mappa

Voce di Menu Scorciatoia Barra degli Strumenti Riferimento

Nuova Visualizzazione Mappa Ctrl+M Navigazione mappa

Nuova Visualizzazione Mappa 3D Ctrl+Shift+M Visualizzazione Mappa 3D

Sposta Mappa Navigazione mappa Zoom e Pan

Sposta la mappa sulla selezione Navigazione mappa

Ingrandisci Ctrl+Alt++ Navigazione mappa Zoom e Pan

Rimpicciolisci Ctrl+Alt+- Navigazione mappa Zoom e Pan

Informazione elementi Ctrl+Shift+I Attributi Informazione Elementi
Misura → Attributi Misurazioni

Sintesi delle statistiche Attributi Pannello Statistiche

Zoom completo Ctrl+Shift+F Navigazione mappa
Continued on next page
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Table 8.2 – continued from previous page
Voce di Menu Scorciatoia Barra degli Strumenti Riferimento

Zoom sul layer Navigazione mappa

Zoom alla selezione Ctrl+J Navigazione mappa

Ultimo zoom Navigazione mappa

Zoom successivo Navigazione mappa

Zoom alla risoluzione originale (100%) Navigazione mappa
Proprietà → Decorazioni
Modalità anteprima →

Mostra Suggerimenti Mappa Attributi Proprietà Suggerimenti

Nuovo segnalibro. . . Ctrl+B Navigazione mappa Segnalibri Spaziali

Mostra segnalibri Ctrl+Shift+B Navigazione mappa Segnalibri Spaziali

Aggiorna F5 Navigazione mappa

Mostra tutti i layers Ctrl+Shift+U Pannello dei Layer

Nascondi tutti i layers Ctrl+Shift+H Pannello dei Layer

Mostra layer selezionati Pannello dei Layer

Nascondi layer selezionati Pannello dei Layer

Nascondi layer non selezionati Pannello dei Layer
Pannelli → Pannelli e Barre degli strumenti
Barre degli strumenti → Pannelli e Barre degli strumenti
Attiva la modalità a schermo intero F11
Attiva/Disattiva visibilità pannello Ctrl+Tab
Attiva solo la Mappa Ctrl+Shift+Tab

In Linux KDE, Pannelli→, Barre degli strumenti→ e Attiva schermo intero sono nel menu Impostazioni.

8.1.4 Layer

Il menu Layer fornisce un ampio set di strumenti per create nuove fonti dati, add aggiungerle a un progetto save
modifications salvare le modifiche. Usando le stesse fonti di dati, puoi anche:

• Duplicare un layer, generando una copia che puoi modificare all’interno dello stesso progetto.

• Copia e Incolla layer o gruppi da un progetto all’altro come nuova istanza le cui caratteristiche e proprietà
puoi modificare indipendentemente dall’originale.

• o I layer e gruppi incorporati. . . . da un altro progetto, come copie di sola lettura che non è possibile
modificare (vedi Progetti nidificati)

Il menu Layer contiene anche strumenti per configurare, copiare o incollare le proprietà del layer (stile, scala,
SR. . . ).
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Voce di Menu Scorciatoia Barra degli
Strumenti

Riferimento

Gestore della sorgente dati Ctrl+L Gestione Sor-
gente Dati

Opening Data

Crea Layer → Gestione Sor-
gente Dati

Creare nuovi layer Vettore

Aggiungi Layer → Gestione Sor-
gente Dati

Accedere ai dati

Includi Layers e Gruppi. . . Progetti nidificati
Aggiungi da un file di definizione
del layer. . .

File di definizione Layer

Copia Stile Salvare e condividere le proprietà
di un layer

Incolla Stile Salvare e condividere le proprietà
di un layer

Copia Layer

Incolla Layer/Gruppo

Apri tabella attributi F6 Attributi Lavorare con la tabella degli at-
tributi

Attiva modifiche Digitalizzazione Modifica di un layer esistente

Salva modifiche vettore Digitalizzazione Salvare i layer modificati

Modifiche in uso → Digitalizzazione Salvare i layer modificati
Salva con nome. . . Creare nuovi layer da layer es-

istente
Salva come file di definizione del
layer. . .

File di definizione Layer

Elimina Layer/Gruppo Ctrl+D

Duplica Layer(s)
Definisci la scala di visibilità
del/dei Layer(s)
Imposta SR del/dei Layer(s) Ctrl+Shift+C
Imposta SR del Progetto dal Layer
Proprietà vettore. . . Proprietà dei vettori
Filtra. . . Ctrl+F Costruttore di interrogazioni

Etichettatura Proprietà etichette

Mostra nella Panoramica Pannello Panoramica
Mostra tutto nella Panoramica Pannello Panoramica

Nascondi tutto dalla Panoram-
ica

Pannello Panoramica
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8.1.5 Impostazioni

Voce di Menu Riferimento
Profili Utente → Lavorare con i Profili Utente

Gestore di stile. . . Gestore di stile

Proiezione personalizzata. . . Sistemi di riferimento personalizzati

Scorciatoie da tastiera. . . Tasti di scelta rapida

Personalizzazione interfaccia. . . Personalizzazione
Opzioni. . . Opzioni dell’interfaccia grafica (GUI)

In Linux KDE, troverai altri strumenti nel menu Impostazioni come Panelli →, Barre degli strumenti → e
Attiva modalità schermo intero.

8.1.6 Plugins

Voce di Menu Scorciatoia Barra degli Stru-
menti

Riferimento

Gestire e installare Plug-
ins. . .

La finestra di dialogo Plug-
ins

Console Python Ctrl+Alt+P Plugin QGIS Python console

Quando si avvia QGIS per la prima volta non tutti i plugin di base verranno caricati.

8.1.7 Vettore

Questo è ciò che appare nel menu Vettore se tutti i plugin di base sono abilitati.

32 Chapter 8. QGIS GUI



QGIS User Guide, Release 3.4

Voce di Menu Scorcia-
toia

Barra degli Stru-
menti

Riferimento

Cattura Coordinate Vettore Plugin Cattura Coordinate

Validatore geometria Vettore Plugin Controllo Geometria

Strumenti GPS Vettore Plugin GPS

Validatore Topologico Vettore Plugin Validatore topologico
Strumenti di Geoprocessing
→

Alt+O + G Configuring the Processing Frame-
work

Strumenti di Geometria → Alt+O + E Configuring the Processing Frame-
work

Strumenti di Analisi → Alt+O + A Configuring the Processing Frame-
work

Strumenti di Gestione Dati
→

Alt+O + D Configuring the Processing Frame-
work

Strumenti di Ricerca → Alt+O + R Configuring the Processing Frame-
work

Per impostazione predefinita, QGIS aggiunge algoritmi Processing al menu Vettore, raggruppati per sotto-menu.
Questo fornisce scorciatoie per molte comuni operazioni sui dati GIS vettoriali provenienti dalle diverse fonti.
Se non tutti questi sotto-menu sono disponibili, abilita il plugin Processing in Plugins → Gestisci e installa
Plugins. . . ..

Da notare che l’elenco degli strumenti del menu Vettore può essere esteso con altri algoritmi di Processing o
tramite algoritmi esterni plugins.

8.1.8 Raster

Questo è ciò che appare nel menu Raster se tutti i plugin di base sono abilitati.

Voce di Menu Barra degli Strumenti Riferimento

Calcolatore Raster. . . Calcolatore raster
Alinea Raster. . . Allineamento Raster
Analisi → Configuring the Processing Framework
Proiezioni → Configuring the Processing Framework
Miscellanea → Configuring the Processing Framework
Estrazione → Configuring the Processing Framework
Conversione → Configuring the Processing Framework

Georeferenziatore Raster Plugin Georeferenziatore

Per impostazione predefinita, QGIS aggiunge gli algoritmi Processing al menu Raster, raggruppati per sotto-
menu. Questo fornisce una scorciatoia per molti comuni compiti di diversi fornitori GIS riferiti ai raster . Se non
tutti questi sotto-menu sono disponibili, abilita il plugin Processing in Plugins → Gestisci e installa Plugins. . . ..

Nota che l’elenco degli strumenti del menu Raster può essere esteso con qualsiasi algoritmo di Processing o con
alcuni algoritmi esterni plugins.
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8.1.9 Database

Questo è ciò che appare nel menu Database se tutti i plugin di base sono abilitati. Se non sono abilitati i plugin
del database, non ci sarà il menu Database.

Voce di Menu Barra degli Strumenti Riferimento

DB Manager Database Plugin DB Manager
eVis → Database Plugin eVis
Editing Offline → Database Plugin Offline Editing

Quando si avvia QGIS per la prima volta non tutti i plugin di base verranno caricati.

8.1.10 Web

Questo è ciò che appare nel menu Web se tutti i plugin di base sono abilitati. Se non sono abilitati i plugin Web,
non ci sarà il menu Web.

Voce di Menu Barra degli Strumenti Riferimento

MetaSearch Web Client Catalogo MetaSearch

Quando si avvia QGIS per la prima volta non tutti i plugin di base verranno caricati.

8.1.11 Processing

Voce di Menu Scorciatoia Riferimento

Barra strumenti Processing Ctrl+Alt+T The Toolbox

Modellatore grafico. . . Ctrl+Alt+M Modellatore grafico

Storico Ctrl+Alt+H Il gestore della cronologia di Processing

Visualizzatore Risultati Ctrl+Alt+R Configurazione di applicazioni esterne

Modifica geometrie sul posto Il processamento di modifiche al layer sul posto

Quando si avvia QGIS per la prima volta non tutti i plugin di base verranno caricati.
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8.1.12 Guida

Voce di Menu Scorciatoia Barra degli Strumenti

Contenuti della Guida F1 Guida
Documentazione sulle API
Segnala un problema
Serve supporto commerciale?

Home Page di QGIS Ctrl+H
Verifica versione di QGIS

Informazioni

QGIS Sponsors

8.1.13 QGIS

Questo menu è disponibile solo in macOS e contiene alcuni comandi relativi a tale sistema operativo.

Voce di Menu Scorciatoia Riferimento
Preferenze
Aiuto su QGIS
Nascondi QGIS
Mostra tutto
Nascondi gli altri
Esci da QGIS Cmd+Q

Preferenze e About QGIS sono comandi equivalenti a Impostazioni → Opzioni e Aiuto → About. Esci da QGIS
corresponde a Progetto → Esci da QGIS negli altri sistemi.

8.2 Pannelli e Barre degli strumenti

Dal menu Visualizza (o Impostazioni), puoi attivare e disattivare i widget QGIS (Panelli →) e le barre degli
strumenti (Barre degli strumenti →). Per (dis)attivarle, clicca con il tasto destro del mouse sulla barra dei menu
o sulla barra degli strumenti e scegli l’elemento desiderato. Ogni pannello o barra degli strumenti può essere
spostato e posizionato ovunque ci si senta a proprio agio all’interno dell’interfaccia QGIS. La lista può anche
essere estesa con l’attivazione di Core o plugin esterni.

8.2.1 Barre degli strumenti

La barra degli strumenti fornisce l’accesso alla maggior parte delle stesse funzioni dei menu, oltre a strumenti
aggiuntivi per interagire con la mappa. Ogni elemento della barra degli strumenti dispone di un aiuto a comparsa.
Passa il mouse sulla voce e verrà visualizzata una breve descrizione dello scopo dello strumento.

Puoi spostare a piacimento ogni barra in funzione delle tue esigenze. Inoltre puoi disattivare ogni barra cliccando
con il tasto destro sulla barra degli strumenti disattivando la voce relativa nel menu.

Suggerimento: Ripristinare le barre degli strumenti
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Figure 8.2: Il menu Barra degli strumenti

Se hai disattivato accidentalmente una barra strumenti, puoi ripristinarla dalla voce di menu Visualizza → Barre

degli strumenti → (o Impostazioni → Barre degli strumenti →). Se una barra degli strumenti per qualsi-
asi ragione scompare dall’interfaccia di QGIS puoi effettuare il ripristino come descritto in ripristinare la GUI
iniziale.

8.2.2 Pannelli

Oltre alle barre degli strumenti, QGIS fornisce molti pannelli predefiniti con cui lavorare. I pannelli sono wid-
get speciali con cui è possibile interagire (selezionando opzioni, caselle di controllo, riempiendo valori. . . .) per
eseguire compiti più complessi.

Di seguito la lista dei pannelli di default previsti in QGIS:

• il Pannello dei Layer

• il Browser Panel

• Il Pannello Digitalizzazione Avanzata

• Il Il Pannello Segnalibri geospaziali

• Il Pannello informazioni GPS

• Il Pannello scala delle mattonelle

• Il Pannello informazione elementi

• Il Pannello Digitalizzazione avanzata

• Il Pannello ordine Layer

• il Pannello Stile Layer
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Figure 8.3: Il menu Pannelli

• il Pannello Statistiche

• il Pannello Panoramica

• il Pannello Messaggi di Log

• il Pannello Annulla/Ripristina

• l” Ambiente di Processing di QGIS

8.3 Mappa

Chiamata anche Rappresentazione della Mappa, questa è il «fine aziendale» di QGIS – le mappe vengono
visualizzate in questa area. La mappa visualizzata in questa finestra dipenderà dai layer vettoriali e raster che hai
scelto di caricare.

Quando aggiungi un layer (vedi ad esempio Accedere ai dati), QGIS cerca automaticamente il suo sistema di
riferimento delle coordinate (SR) ed effettua lo zoom fino alla sua estensione se si inizia con un progetto QGIS
vuoto. Il SR del layer viene poi applicato al progetto. Se ci sono già dei layer nel progetto, e se il nuovo layer ha
lo stesso SR del progetto, verranno visualizzati gli elementi che rientrano nell’estensione corrente della mappa.
Se il nuovo layer ha un SR diverso da quello del progetto, devi scegliere Effettua la trasformazione “al volo” del
SR (OTF) dal Progetto → Proprietà. . . .. → SR (vedi Trasformazioni SR On The Fly (OTF)). Il layer aggiunto
dovrebbe ora essere visibile se i dati sono disponibili nell’estensione della vista corrente.

La visualizzazione della mappa può essere spostata, spostando la visualizzazione in un’altra regione della mappa,
e può essere ingrandita e rimpicciolita. È possibile eseguire diverse altre operazioni sulla mappa come descritto
nella sezione Barre degli strumenti. La visualizzazione della mappa e la legenda sono strettamente collegate tra
loro — le mappe in visualizzazione riflettono le modifiche apportate nell’area legenda.

Suggerimento: Zoom in e Zoom out con la rotella del mouse
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Per le operazioni di zoom puoi anche utilizzare la rotella del mouse. Posizionando il puntatore del mouse nell’area
di visualizzazione delle mappe aumenterai lo zoom girando la rotella verso lo schermo, lo ridurrai girandola nel
verso contrario. La posizione del puntatore costituisce il centro per l’ingrandimento. Puoi regolare il comporta-
mento della funzione di zoom con la rotella del mouse nella scheda Strumenti mappa del menu Impostazioni →
Opzioni .

Suggerimento: Muovere la mappa con i Tasti Freccia e la Barra Spazio

Puoi utilizzare i tasti freccia per spostare la mappa. Posiziona il cursore del mouse all’interno dell’area della
mappa e fai clic sui tasti freccia per spostarti a sinistra, destra, su e giù. Puoi inoltre spostare la mappa muovendo
il mouse tenendo premuto il pulsante centrale o la barra spaziatrice del mouse (o tenendo premuta la rotellina del
mouse).

8.4 Visualizzazione Mappa 3D

Il supporto alla visualizzazione 3D viene reso disponibile attraverso la visualizzazione della mappa 3D.

Nota: La visualizzazione 3D in QGIS richiede una versione recente della libreria QT (5.8 o successiva).

Puoi creare e aprire una vista mappa 3D tramite Visualizza → Nuova Mappa 3D. Apparirà un pannello QGIS
fluttuante. Il pannello può essere agganciato alla finestra.

Inizialmente, la visualizzazione della mappa 3D ha la stessa estensione e la stessa visualizzazione della mappa in
2D. Non esiste una barra degli strumenti dedicata per la navigazione nella mappa 3D. Lo zoom avanti/indietro e la
panoramica sono uguali a quelli della mappa 2D principale. È inoltre possibile eseguire lo zoom avanti e indietro
trascinando il mouse verso il basso/su con il tasto destro del mouse premuto.

Opzioni di navigazione per esplorare la mappa in 3D:

• Inclina e ruota

– Per inclinare il terreno (ruotandolo intorno ad un asse orizzontale che passa attraverso il centro della
finestra):

* Trascina il mouse avanti/indietro con il pulsante centrale del mouse premuto

* Premi Shift e trascina il mouse avanti/indietro con il pulsante sinistro del mouse premuto.

* Premi Shift e usa i tasti su/giù.

– Per ruotare il terreno (intorno ad un asse verticale che passa attraverso il centro della finestra):

* Trascina il mouse a destra/sinistra con il pulsante centrale del mouse premuto

* Premi Shift e trascina il mouse a destra/sinistra con il pulsante sinistro del mouse premuto.

* Premi Shift e usa i tasti sinistra/destra.

• Cambiare l’angolo di ripresa

– Premendo Ctrl e trascinando il mouse con il pulsante sinistro del mouse premuto cambia l’angolo di
ripresa corrispondente alle direzioni di trascinamento.

– Premendo Ctrl e usando i tasti freccia si gira la fotocamera in su, in giù, a sinistra e a destra.

• sposta la fotocamera su/giù

– Premendo i tasti Page Up/Page Down sposta il terreno su e giù, rispettivamente.

• Ingrandisci e rimpicciolisci
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– Trascinando il mouse con il pulsante destro del mouse premuto, effettuerai lo zoom in avanti (trascina
verso il basso) e indietro (trascina verso l’alto).

• Spostarsi sul terreno

– Trascinando il mouse con il pulsante sinistro del mouse premuto si sposta il terreno

– Utilizzando i tasti su/giù/giù/sinistra/destra si sposta il terreno più vicino, lontano, a destra e a sinistra,
rispettivamente.

Per ripristinare la visualizzazione della fotocamera, fai clic sul pulsante Zoom ad estensione massima nella parte su-
periore del pannello della mappa 3D.

8.4.1 Configura Terreno

Un raster del terreno fornisce l’elevazione. Questo layer raster deve contenere una banda che rappresenta
l’elevazione. Per selezionare l’informazione raster del terreno:

1. Fai clic sul pulsante Configura nella parte superiore del pannello della mappa 3D per aprire la finestra
Configurazione 3D.

2. Scegli il layer raster del terreno nel menu a discesa Altitudine.

Nella finestra Configurazione 3D ci sono diverse altre opzioni per la regolazione fine della scena 3D. Prima di
immergersi nei dettagli, vale la pena notare che il terreno in una vista 3D è rappresentato da una gerarchia di
mattonelle del terreno e, man mano che la fotocamera si avvicina al terreno, le mattonelle esistenti che non
hanno sufficienti dettagli sono sostituite da mattonelle più piccole con maggiori dettagli. Ogni mattonella ha una
geometria mesh derivata dal layer raster altimetrico e una texture dai layer della mappa 2D.

Opzioni di configurazione e loro significato:

• Elevazione: Raster da utilizzare per la generazione del terreno.

• Scala verticale: Fattore di scala per l’asse verticale. Aumentando la scala amplificherà la variazione di
altezza del terreno.

• Risoluzione mattonella: Quante campionature dal layer raster del terreno da utilizzare per ogni mattonella.
Un valore di 16px significa che la geometria di ogni mattonella sarà costruita a partire da 16x16 campiona-
ture di elevazione. Un numero più alto crea un terreno più dettagliato a scapito di una maggiore complessità
di visualizzazione.

• Altezza bordo: A volte è possibile vedere piccole crepe tra le mattonelle del terreno. Aumentando questo
valore si aggiungono pareti verticali («bordi») intorno alle mattonelle del terreno per nascondere le crepe.

• Risoluzione mattonelle Mappa: Larghezza e altezza delle immagini della mappa 2D usate come suddivisione
in mattonelle del terreno. 256px significa che ogni mattonella sarà visualizzata in un’immagine di 256x256
pixel. Un numero più alto crea mattonelle di terreno più dettagliate a scapito di una maggiore complessità
di visualizzazione.

• Max. errore di schermo: Determina la soglia per sostituire le mattonelle del terreno con altre più dettagliate
(e viceversa) - cioè quanto tempo la vista 3D utilizzerà mattonelle di qualità superiore. Un numero inferiore
significa maggiori dettagli della scena a scapito di una maggiore complessità di visualizzazione.

• Max. errore al suolo: La risoluzione delle mattonelle del terreno in cui si interrompe la divisione delle mat-
tonelle in mattonelle più dettagliate (dividerle non introdurrebbe comunque alcun dettaglio in più). Questo
valore limita la profondità della gerarchia delle mattonelle: valori più bassi rendono la gerarchia profonda,
aumentando la complessità di visualizzazione.

• Zoom labels: Mostra il numero di livelli di zoom (dipende dalla risoluzione delle mattonelle della mappa e
dall’errore massimo al suolo).

• Mostra etichette: Attiva/disattiva le etichette della mappa

• Mostra le info sulle mattonelle della mappa: Include i numeri delle mattonelle di confine e delle mat-
tonelle del terreno (utile per la soluzione delle tematizzazioni del terreno).
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• Mostra i perimetri di delimitazione: Mostra i perimetri di delimitazione 3D delle mattonelle del terreno
(utile per la soluzione delle tematizzazioni del terreno)

• Mostra il centro di ripresa della fotocamera

8.4.2 Layer vettoriali 3D

Un layer vettoriale con valori di elevazione può essere mostrato nella mappa 3D controllando Configura nella
scheda Nuova mappa 3D delle proprietà del layer vettoriale. Sono disponibili diverse opzioni per controllare la
visualizzazione del layer vettoriale 3D.

8.5 Barra di Stato

La barra di stato ti fornisce informazioni generali sulla visualizzazione della mappa e sulle azioni elaborate o
disponibili e ti offre strumenti per gestire la visualizzazione della mappa. Sul lato sinistro della barra di stato, la
barra di localizzazione, un widget di ricerca rapida, ti aiuta a trovare ed eseguire qualsiasi funzione o opzione in
QGIS. Basta digitare il testo associato all’elemento che stai cercando (nome, tag, parola chiave. . . .) e ottieni una
lista che si aggiorna mentre scrivi. Puoi anche limitare la portata della ricerca usando locator filters. Fai clic sul

pulsante per selezionare uno qualsiasi di essi e premi la voce Configura per le impostazioni globali.

Nell’area accanto alla barra di localizzazione, quando necessario ti verrà mostrato un riepilogo delle azioni ese-
guite (come la selezione di elementi in un layer, la rimozione del layer) o una completa descrizione dello strumento
su cui si passa sopra (non disponibile per tutti gli strumenti).

In caso di lunghe operazioni, come l’acquisizione di statistiche in layer raster, l’esecuzione di algoritmi di elabo-
razione o la visualizzazione di più layer nella mappa, nella barra di stato viene visualizzata una barra dello stato
di avanzamento.

L’opzione Coordinate mostra la posizione corrente del mouse, seguendolo durante lo spostamento sulla
mappa. Puoi impostare le unità di misura (e la precisione) nella scheda Progetto → Proprietà. . . → Generale.

Clicca sul piccolo pulsante a sinistra della casella di testo per passare dall’opzione Coordinate all’opzione
Estensioni che mostra le coordinate in unità mappa degli attuali angoli in basso a sinistra e in alto a destra della
mappa.

Accanto al display delle coordinate si trova il display Scala. Mostra la scala della visualizzazione della mappa.
C’è un selettore di scala, che permette di scegliere tra predefined and custom scales.

Sul lato destro del display della scala, premi il pulsante per bloccare la scala e utilizza la lente di ingrandimento
per ingrandire o ridurre lo zoom. La lente d’ingrandimento consente di ingrandire una mappa senza alterare la
scala della mappa, rendendo più facile modificare con precisione la posizione delle etichette e dei simboli. Il livello
di ingrandimento è espresso in percentuale. Se Livello di ingrandimento ha un livello del 100%, allora la mappa
corrente non viene ingrandita. Inoltre, un valore di ingrandimento predefinito può essere impostato all’interno di
Impostazioni → Opzioni. . . → Visualizzazione → Livello ingrandimento, che è molto utile per schermi ad alta
risoluzione per ingrandire simboli piccoli.

A destra della scala puoi definire la rotazione corrente in gradi in senso orario della mappa.

Sul lato destro della barra di stato, c’è una piccola casella di controllo che può essere usata temporaneamente per
impedire che i layeri vengano aggiornati nella visualizzazione mappa (vedi la sezione Visualizzazione).

A destra delle funzioni di visualizzazione, trovi il pulsante EPSG:code che mostra il SR del progetto corrente.
Cliccando su questo pulsante si apre la finestra di dialogo Proprietà progetto e ti consente di applicare un altro SR
alla visualizzazione della mappa.

Il pulsante Messages accanto ad esso apre il pannello Messaggi di Log che contiene informazioni sui processi in
corso (attivazione di QGIS, caricamento di plugin, strumenti di processing. . . .).
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A seconda di Plugin Manager settings, la barra di stato può a volte mostrare icone a destra per informarti sulla

disponibilità di plugin nuovi o aggiornabili. Clicca sull’icona per aprire la finestra di dialogo Plugin.

Suggerimento: Calcolare la scala corretta della mappa

Quando avvii QGIS, il SR predefinito è WGS 84 (EPSG 4326) e le unità di misura sono i gradi. Ciò significa
che QGIS interpreterà qualsiasi coordinata del layer come specificato in gradi. Per ottenere valori di scala corretti,
è possibile modificare manualmente questa impostazione nella scheda Generale sotto Progetto → Proprietà. . .

(ad es. ai metri), oppure è possibile utilizzare l’icona EPSG:code vista sopra. In quest’ultimo caso, le unità sono
impostate a quanto specificato dalla proiezione del progetto (ad esempio, +units=us-ft).

Da notare che la scelta del sistema SR di partenza può essere fatta in Impostazioni → Opzioni → SR.
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CHAPTER 9

Configurazione QGIS

QGIS è altamente configurabile. Tramite il menu Impostazioni, fornisce diversi strumenti per:

• Opzioni. . . : impostazioni globali opzioni da applicare in diverse aree del software. Queste preferenze
sono salvate nelle impostazioni attive Profilo utente e applicate di default ogni volta che si apre un nuovo
progetto con questo profilo. Inoltre, possono essere sovrascritte durante ogni sessione QGIS dal menu
Proprietà progetto (accessibile dal menu Progetto).

• Personalizzazione interfaccia. . . : configura application interface, nascondendo finestre di dialogo o
strumenti di cui non hai bisogno.

• Scorciatoie da tastiera. . . : definisce le tue impostazioni delle scorciatoie keyboard shortcuts.

• Gestore di stile. . . : creare e gestire symbols and color ramps.

• Proiezione personalizzata. . . : crea il tuo coordinate reference systems.

9.1 Opzioni dell’interfaccia grafica (GUI)

Alcune opzioni di base per QGIS possono essere impostate nella finestra di dialogo Opzioni. Seleziona
l’opzione del menu Impostazioni → Opzioni. Puoi modificare le opzioni in accordo alle tue necessità. Al-
cune delle modifiche potrebbero richiedere il riavvio di QGIS prima di diventare effettive.

Le schede in cui puoi personalizzare le tue opzioni sono descritte di seguito.

Nota: I plugin possono gestire proprie impostazioni nella finestra di dialogo Opzioni

Mentre solo le impostazioni di base sono presentate di seguito, si noti che questa lista può essere estesa da installed
plugins implementando proprie opzioni nella finestra di dialogo Opzioni standard. Questo evita che ogni plugin
abbia la propria finestra di dialogo di configurazione con voci di menu extra solo per loro. . . ..

9.1.1 Impostazioni generali

Lingua
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• Seleziona Sovrascrittura lingua del sistema se vuoi utilizzare una lingua diversa da quella del sistema e
scegli la sostituzione nella casella a scelta multipla Locale.

• Vengono elencate le informazioni sul sistema locale attivo.

Applicazione

• Scegli lo Stile (necessario il riavvio di QGIS) e scegli tra “Oxygen”, “Windows”, “Motif”, “CDE”,
“Plastique” and “Cleanlooks”.

• Definisci il UI theme . Può essere “default” o “Night Mapping”;

• Definisci la Dimensione delle icone ;

• Definisci il Carattere e la sua Dimensione. Il carattere può essere Qt predefinito o uno definito
dall’utente.

• Cambia il Timeout per messaggi o dialoghi a tempo ;

• Nascondi la schermata iniziale all’avvio;

• Controlla la versione di QGIS all’avvio per essere informato se è stata rilasciata un versione più recente;

• Finestra di gestione non modale della sorgente dati per mantenere aperta la finestra di dialogo data
source manager e permettere l’interazione con l’interfaccia QGIS mentre si aggiungono layer al progetto;

• Usa le finestre di dialogo native della selezione del colore (vedi Scelta colore).

File di progetto

• Apri un progetto all’apertura di QGIS (scegli tra “Nuovo”, “Più recente”, “Pagina di benvenuto” e
“Specifico”). Quando si seleziona “Specifico”, utilizza il pulsante . . . per definire il progetto da utilizzare
per impostazione predefinita. La “Pagina di benvenuto” mostra un elenco di progetti recenti con screenshot.

• Crea un nuovo progetto dal progetto predefinito. Puoi scegliere Definisce il progetto attuale come
predefinito oppure Ripristina il predefinito. Sfoglia fra i tuoi file e specifica la cartella in cui sono presenti

i progetti da usare come modello. Se hai spuntato la casella di controllo Crea un nuovo progetto dal
progetto predefinito e hai salvato un progetto nella cartella dei modelli, comparirà la nuova voce Progetto
→ Nuovo da modello.

• Chiedi di salvare il progetto e cambia sorgente dati quando richiesto per evitare di perdere le modifiche
apportate.

• Chiedi conferma quando si vuole rimuovere un layer

• Avvisa quando si apre un file di progetto salvato con una vecchia versione di QGIS. Puoi sempre aprire
progetti creati con una versione precedente di QGIS, ma una volta che il progetto viene salvato, provare
ad aprirlo con una versione precedente potrebbe fallire a causa di caratteristiche non disponibili in quella
versione.

• Enable macros . This option was created to handle macros that are written to perform an action
on project events. You can choose between “Never”, “Ask”, “For this session only” and “Always (not
recommended)”.

9.1.2 Impostazioni di sistema

Percorsi SVG

Aggiungi o Rimuovi Percorso(i) dove cercare i simboli SVG (Scalable Vector Graphic). Questi file SVG sono
quindi disponibili per simboleggiare le geometrie o decorare la tua composizione della mappa.

Percorsi verso i plugin
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Aggiungi o rimuovi Percorsi per cercare ulteriori librerie plugin C+++.

Documentazione percorsi

Aggiungi o rimuovi Percorsi della documentazione da usare per l’help di QGIS. Per impostazione predefinita,
viene aggiunto un link al Manuale Utente online ufficiale corrispondente alla versione utilizzata. Puoi comunque
aggiungere altri link e dar loro priorità dall’alto verso il basso: ogni volta che clicchi su un pulsante Help in una
finestra di dialogo, viene controllato il link più in alto e se non viene trovata alcuna pagina corrispondente, viene
provata quella successiva, e così via.

Nota: La documentazione è versionata e tradotta solo per QGIS Long Term Releases (LTR), il che significa che
se si esegue un rilascio regolare (es. QGIS 3.0), il pulsante help aprirà di default la prossima pagina del manuale
LTR (es. 3.4 LTR), che può contenere la descrizione delle caratteristiche delle nuove versioni (3.2 e 3.4). Se
non è disponibile documentazione LTR viene utilizzata la documentazione testing doc, con le caratteristiche delle
versioni più recenti e di sviluppo.

Impostazioni

Ripristina l’interfaccia utente alle impostazioni predefinite (riavvio richiesto) ti aiuta se hai fatto qualche person-
alizzazione.

Ambiente

Il gruppo Ambiente mostra le variabili di ambiente e permette anche di configurarle (vedi fig-
ure_environment_variables). Questa opzione è particolarmente utile per piattaforme stile Mac, dove le appli-
cazioni GUI non ereditano necessariamente l’ambiente shell dell’utente. È utile anche per impostare/visualizzare
le variabili di ambiente usate da strumenti esterni, gestiti da Processing come, SAGA e GRASS. Infine è utile
anche per abilitare gli output del debug per specifiche sezione del codice sorgente.

• Usa variabili utente (necessario il riavvio - includere i separatori). Puoi Aggiungere e Rimuovere le
variabili. Le variabili di ambiente già definite sono mostrate in Variabili di ambiente attuali, ed è possibile

filtrarle attivando Mostra solo le variabili specifiche di QGIS.

9.1.3 Impostazioni SR

SR predefinito per i nuovi progetti

Esiste un’opzione per impostare automaticamente il SR per il nuovo progetto:

• Usa SR dal primo layer aggiunto: il SR del progetto viene trasformato per corrispondere al SR del primo
layer caricato in esso.

• Usa SR predefinito: un SR predefinito viene applicato di default a qualsiasi nuovo progetto e viene
lasciato invariato quando si aggiungono layer al progetto.

La scelta verrà salvata per l’uso nelle successive sessioni QGIS e, in ogni caso, il sistema di riferimento delle
coordinate del progetto può ancora essere sovrascritto dai menu di selezione della scheda: Progetto –> Proprietà
del progetto –> SR.

SR per i nuovi layer

Questa sezione permette di specificare il comportamento da adottare quando viene creato un nuovo layer oppure
quando viene caricato un layer privo di SR.

• Richiedi SR

• Usa il SR del progetto

• Usa SR predefinito
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Figure 9.1: Variabili ambiente di sistema in QGIS

Trasformazioni datum predefinite

In questo gruppo puoi controllare se la riproiezione dei layer in un altro SR debba essere:

• processata automaticamente usando le impostazioni di trasformazione predefinite di QGIS;

• e/o meglio controllata da te con preferenze personalizzate come:

– Chiedi la trasformazione del datum se disponibili più di uno.

– un elenco predefinito di trasformazioni del datum da applicare per impostazione predefinita. Vedi
Trasformazioni Datum per maggiori dettagli.

Nota: Per maggiori informazioni su come QGIS gestisce la proiezione dei layer, leggi la sezione dedicata in
Lavorare con le proiezioni.

9.1.4 Impostazioni sorgenti dati

Attributi delle geometrie e tabelle

• Apri la tabella degli attributi in una finestra agganciata

• Copia elementi come “Testo normale, nessuna geometria”, “Testo normale, geometria WKT”, o “GeoJSON”
quando si incollano le geometrie in altre applicazioni.

• Comportamento della tabella di attributi : imposta il filtro sulla tabella degli attributi all’apertura.
Sono presenti tre possibilità: ‘Mostra tutti gli elementi’, ‘Mostra gli elementi selezionati’ e ‘Mostra gli
elementi visibili nella mappa’.
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Figure 9.2: Impostazioni SR in QGIS
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• Vista predefinita: definisce la modalità di visualizzazione della tabella degli attributi ad ogni apertura. Può
essere “Ricorda l’ultima vista”, “Vista tabella” o “Vista modulo”.

• Cache riga attributi tabella . La cache permette di salvare le ultime N righe degli attributi caricate:
in questo modo il lavoro con la tabella degli attributi risulterà essere molto più veloce. La cache verrà
cancellata alla chiusura della tabella degli attributi.

• Mostra i valori NULL come. Puoi definire un attributo con cui verranno visualizzati i valori NULL (nessun
valore).

Suggerimento: Migliorare l’apertura della tabella degli attributi con grandi quantità di dati

Quando si lavora con layer con una grande quantità di record, l’apertura della tabella degli attributi potrebbe
essere lenta nel mostrare tutte le righe. L’impostazione del Comportamento della tabella di attributi su Mostra gli
elementi visibili nella mappa richiede l’elenco solo per le geometrie visibili nella mappa corrente, consentendo
un rapido caricamento dei dati.

Nota che i dati con questa modalità della tabella degli attributi saranno sempre legati all’area di visualizzazione,
il che significa che selezionando Mostra tutte gli elementi all’interno di tale tabella non verranno visualizzate
nuove geometrie. Puoi comunque aggiornare il set di geometrie visualizzate cambiando l’estensione della mappa
e selezionando l’opzione Mostra gli elementi visibili nella mappa nella tabella degli attributi.

Trattamento delle sorgenti dei dati

• Ricerca elementi validi nella finestra del browser . Puoi scegliere fra ‘Controlla estensione’ e ‘Con-
trolla il contenuto del file’.

• Ricerca contenuto dei file compressi (.zip) nella finestra del browser definisce quanto dettagliato è
il widget informativo nella parte inferiore del pannello Browser quando si cercano tali file. Le possibili
opzioni sono “No”, “Scansione di base” e “Scansione completa”.

• Richiedi i sublayer raster al caricamento. Alcuni raster supportano i sublayer, chiamati subdataset in
GDAL. Un esempio sono i file netCDF: se sono presenti diverse variabili netCDF, GDAL riconosce ogni
variabile come un subdataset. L’opzione permette di gestire i sublayer quando uno di questi viene aperto.
Puoi scegliere fra:

– “Sempre”: chiede sempre (se sono presenti sublayer)

– “Se necessario”: chiede se il layer non ha bande, ma ha sublayer

– “Mai”: non chiede mai e non carica niente

– “Carica tutto”: non chiede, ma carica tutti i sublayer

• Ignora la dichiarazione di codifica per lo shapefile. Se lo shapefile ha informazioni sulla sua codifica,
queste verranno ignorate.

• Aggiungi layer PostGIS con un doppio click e seleziona modalità estesa

• Aggiungi layer Oracle con un doppio click e seleziona modalità estesa

• Esegui le espressioni sul server se possibile

• Valuta valori predefiniti definisce se i valori predefiniti dal database devono essere calcolati quando si
digitalizza la nuova geometria (stato controllato) o quando si salvano le modifiche.

Percorsi nascosti al Browser

Questo widget elenca tutte le cartelle che hai scelto di nascondere dal Browser panel. La rimozione di una cartella
dalla lista la renderà disponibile nel pannello Browser.
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Figure 9.3: Impostazioni Sorgente Dati in QGIS
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Figure 9.4: Scheda Visualizzazione della finestra di dialogo Proprietà progetto

9.1.5 Impostazioni di visualizzazione

Opzioni di visualizzazione

• Per impostazione predefinita i nuovi layer aggiunti alla mappa vengono visualizzati subito: dese-
lezionare questa opzione può essere utile quando si caricano più layer per evitare che ogni nuovo layer
venga visualizzato nella mappa e rallenti il processo.

• Usa il caching del disegno quando possibile per velocizzare la visualizzazione

• Visualizza i layyer in parallelo usando più processori della CPU

• Numero massimo di processori

• Intervallo dio aggiornamento della mappa (predefinito a 250 ms)

• Abilita semplificazione delle geometrie per i nuovi layer aggiunti

• Semplifica dal lato provider se possibile

• Algoritmo di semplificazione: Questa opzione esegue una semplificazione locale «on-the-fly» sulle geome-
trie e accelera la visualizzazione della stessa. Non modifica la geometria originaria. Questo è importante
quando hai espressioni che si riferiscono alla geometria (ad esempio il calcolo dell’area) assicurando che
questi calcoli vengano eseguiti sulla geometria originale, non su quella semplificata. A tale scopo, QGIS
fornisce tre algoritmi: “Distanza” (predefinito), “SnapToGrid” e “Visvalingam”.

• Semplifica dal lato fornitore se possibile: le geometrie sono semplificate dal fornitore (PostGIS, Oracle
. . . ) e diversamente dalla semplificazione sul lato locale, i calcoli basati sulla geometria potrebbero essere
compromessi

• Scala massima alla quale il layer dovrebbe essere semplificato
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• Livello ingrandimento (vedi magnifier)

Nota: Oltre all’impostazione globale, la semplificazione delle geometrie può essere impostata per qualsiasi layer
specifico dal menu Proprietà vettore → Visualizzazione.

Impostazioni di visualizzazione

• Rendi le linee meno irregolari a spese delle prestazioni

Segmentazione curva

• Tolleranza di segmentazione: questa impostazione controlla il modo in cui gli archi di cerchio sono visualiz-
zati. Definendo più piccolo l’angolo massimo (tra i due vertici consecutivi e il centro della curva, in gradi)
o la differenza massima (distanza tra il segmento dei due vertici e la linea della curva, in unità di mappa), i
segmenti più dritti verranno utilizzati durante la visualizzazione.

• Tipo di tolleranza: può essere Angolo massimo o Differenza massima tra approssimazione e curva.

Raster

• Con Selezione banda RGB puoi scegliere il numero di bande rosse, verdi e blu.

Miglioramento contrasto

Le opzioni di miglioramento del contrasto possono essere applicate a Banda singola grigia, Colore multibanda
(byte/band) o Colore multibanda (>byte/band). Per ognuna di queste, è possibile impostare:

• L” Algoritmo da usare, i cui valoro possono essere “Nessuno stiramento”, “Stira a MinMax”, “Stira e taglia
a MinMax” o “Taglia a MinMax”

• i Limiti (minimo/massimo) da applicare, con valori come “Taglio del conteggio cumulativo pixel”, “Min-
imo/Massimo”, “Media +/- deviazione standard”.

Per la visualizzazione dei raster, puoi anche definire le seguenti opzioni:

• Limiti di taglio del conteggio cumulativo pixel

• Moltiplicatore deviazione standard

Debugging

• Aggiornamento della visualizzazione della mappa per visualizzare il debugging nel pannello Messaggi
di Log.

9.1.6 Impostazioni Mappa e Legenda

Queste proprietà ti consentono di impostare:

• l” Aspetto della mappa (modificato dalle proprietà di progetto): il Colore della selezione e il Colore di
sfondo.

• Azione eseguita in legenda Layer:

– Azione doppio click in legenda . Puoi scegliere fra ‘Apri proprietà layer’ oppure ‘Apri tabella
degli attributi’ facendo doppio click sul layer.

– Apri la tabella attributi nel pannello Layer, ad esempio quando si applica una visualizzazione
categorizzata o basata su regole (vedi Proprietà Simbologia per maggiori informazioni).

– la Risoluzione WMS getLegendGraphic

• il Ritardo in millisecondi della visualizzazione dei layer map tips

9.1. Opzioni dell’interfaccia grafica (GUI) 51



QGIS User Guide, Release 3.4

Figure 9.5: Impostazioni Mappa e Legenda

9.1.7 Impostazioni strumenti Mappa

Questa scheda ti permette di scegliere alcune opzioni sul comportamento di Informazioni elementi.

• Raggio di ricerca per identificare gli elementi e visualizzare le relative informazioni sulla mappa è una
distanza di tolleranza all’interno della quale lo strumento di identificazione mostrerà i risultati fintanto che
si fa clic su tale tolleranza.

• Colore di evidenziazione ti permette di scegliere con quale colore saranno evidenziate le geometrie identifi-
cate.

• Buffer determina una distanza di buffer da visualizzare dal contorno dell’evidenziazione di identificazione.

• Larghezza minima determina di quale spessore deve essere il contorno di un oggetto evidenziato.

Strumenti di misura

• Colore elastico

• Posizioni decimali

• Mantieni le unità di base per non convertire automaticamente numeri grandi (ad esempio, metri a
chilometri)

• Unità preferite per le distanze (“Metri”, “Chilometri”, “Piedi”, “Iarde”, “Miglia”, “Miglia Nautiche”,
“Gradi” o “Unità Mappa” )

• Unità preferite per le aree (“Metri quadri”, “Chilometri quadrati”, “Piedi quadrati”, “Iarde quadrate”,
“Miglia quadrate”, Ettari”, “Acri”, “Miglia nautiche quadrate”, “Gradi quadrati” o “Unità mappa”)

• Unità preferite per gli angoli (“Gradi”, “Radianti”, “Gon/gradianti”, “Minuti di arco”, “Secondi di
arco” o “Rotazioni/rivoluzioni”)

Spostamento e zoom

• Definire un Fattore di zoom per strumenti di zoom o rotella del mouse

Scale preimpostate

Qui trovi una lista di scale predefinite. Con i pulsanti e puoi aggiungere o rimuovere le scale personali.
Puoi anche importare o esportare le scale da/a un file .XML. Nota che puoi ancora avere la possibilità di rimuovere
le tue modifiche e ripristinare l’elenco predefinito.
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Figure 9.6: Impostazioni Strumenti mappa in QGIS
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9.1.8 Impostazioni colori

Questo menu ti consente di creare o aggiornare le tavolozze di colori utilizzati in tutta l’applicazione nel color
selector widget. Puoi scegliere tra:

• Colori recenti che mostra i colori usati di recente

• Colori standard, la tavolozza predefinita dei colori

• Colori del progetto, un insieme di colori specifici per il progetto corrente (vedi Proprietà Stili predefiniti
per maggiori dettagli).

• Colori per nuovi layer, un insieme di colori da usare di default quando nuovi layer vengono aggiunti a
QGIS.

• o puoi creare o importare tavolozza(i) personalizzata(e) usando il pulsante . . . . accanto alla casella combi-
nata della tavolozza.

Per impostazione predefinita, Colori recenti, Colori standard e Colori del progetto non possono essere rimossi e
sono impostati per apparire nel menu a discesa del pulsante colori. Le tavolozze personalizzate possono anche
essere aggiunte a questo widget grazie all’opzione Mostra bottoni colore.

Per ogni tavolozza, puoi gestire l’elenco dei colori utilizzando l’insieme di strumenti accanto al riquadro, ad
esempio:

• Aggiungi colore o Elimina colore

• Copia i colori o Incolla colori

• Importa colori da file o Esporta colori l’impostazione dei colori da/per .gpl file.

Fai doppio clic su un colore nell’elenco per modificarlo o sostituirlo nella finestra di dialogo Color Selector. Puoi
anche rinominarlo facendo doppio clic nella colonna Etichetta.

Figure 9.7: Impostazioni colori

9.1.9 Impostazioni digitalizzazione

Questa scheda ti aiuta a configurare le impostazioni generali quando sei in modifica layer vettoriale (attributi e
geometria).

Creazione elemento
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• Non aprire il modulo dopo la creazione di ogni geometria: questa scelta può essere annullata in ogni
finestra di dialogo delle proprietà layer.

• Ripeti i valori degli attributi usati per ultimi.

• Verifica le geometrie. Modificare linee/poligoni con molti nodi può portare a una visualizzazione molto
lenta. Questo succede perché le procedura di verifica delle geometrie in QGIS richiede molto tempo. Per
velocizzare la visualizzazione è possibile selezionare GEOS (a partire da GEOS 3.3) oppure disattivare del
tutto la verifica. La verifica effettuata da GEOS è molto più rapida, ma ha lo svantaggio di comunicare
solamente il primo problema geometrico riscontrato.

• Valore Z predefinito da usare quando si creano nuovi elementi 3D.

Elastico

• Definisce le proprietà dell’elastico Spessore della linea, Colore della linea e Colore di riempimento.

• Non aggiornare l’elastico mentre si aggiorna il nodo.

Aggancio

• Abilitare sempre l’aggancio atttiva l’aggancio quando un progetto viene aperto

• Imposta la Modalità di aggancio predefinita (‘Vertice”, “Vertice e segmento”,”Segmento”)

• Imposta la Tolleranza di aggancio predefinita in unità di mappa o pixel

• Imposta il Raggio di ricerca per le modifiche dei vertici in unità di mappa o in pixel

• Mostra finestra principale come (richiesto riavvio): imposta se la finestra di dialogo di Aggancio in Digi-
talizzazione Avanzata deve essere visualizzata come “Finestra” o “Finestra agganciabile”.

• Colore del simbolo di aggancio

• Mostra suggerimenti sull’aggancio come il nome del layer su cui stai operando l’aggancio. Utile quando
più elementi sono sovrapposti.

• Abilita aggancio su elementi invisibili

Indicatori di vertice

• Utilizza simboli solo per le geometrie selezionate

• Definisci vertice Stile simbolo (‘Croce’ (predefinito), ‘Cerchio semi trasparente’ o ‘Nessuno’)

• Specifica le Dimensioni simbolo per il vertice

Strumento per la curva di offset

Le 3 opzioni successive si riferiscono allo strumento Curva di offset in Digitalizzazione avanzata. Attraverso i
vari settaggi è possibile influenzare la forma della linea di offset. Queste opzioni sono possibili a partire da GEOS
3.3.

• Stile unione: “Tondo”, “Seghettato” o “Smussato”

• Segmenti di quadrante

• Limite di smusso

9.1.10 Impostazioni Layout

Opzioni predefinite del layout

Puoi scegliere il Carattere predefinito da usare nel print layout.

Reticolo

• Scegli lo Stile reticolo (“Pieno”, “Punti”, “Croci”)
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Figure 9.8: Impostazioni Digitalizzazione in QGIS
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• Scegli il Colore del reticolo

Opzioni predefinite delle guide e del reticolo

• Specifica la Spaziatura reticolo

• Definisci l” Offset reticolo per X e Y

• Definsci la Tolleranza di aggancio

Percorsi Layout

• Definisci il Percorso(i) per cercare modelli di stampa aggiuntivi: un elenco di cartelle con modelli di layout
personalizzati da utilizzare quando se ne crea uno nuovo.

Figure 9.9: Impostazioni delle stampe in QGIS

9.1.11 Impostazioni GDAL

GDAL è una libreria di interscambio dati per file vettoriali e raster. Fornisce driver per leggere e o scrivere dati in
diversi formati. La scheda GDAL attualmente elenca i driver per i formati raster con le loro specifiche.

Opzioni driver GDAL

Questa scheda fornisce modi per personalizzare il comportamento dei driver che supportano l’accesso in lettura e
scrittura:

• Modifica le opzioni di creazione: ti permette di modificare o aggiungere diversi profili di trasformazione dei
file, cioè un insieme di combinazioni predefinite di parametri (tipo e livello di compressione, dimensione dei
blocchi, panoramica, colorimetria, alfa. . . .) da utilizzare per l’output di file raster. I parametri dipendono
dal driver.

La parte superiore della finestra di dialogo elenca i profili correnti e ti consente di aggiungerne di nuovi
o rimuovere alcuni di essi. Puoi inoltre ripristinare il profilo ai suoi parametri predefiniti se sono stati
modificati. Alcuni driver (ad esempio GeoTiff) hanno alcuni esempi di profili con cui è possibile lavorare.

Nella parte inferiore della finestra di dialogo:
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Figure 9.10: Esempio di creazione di un profilo di opzioni (per GeoTiff)

– Il pulsante ti permette di aggiungere righe da riempire con il nome e il valore del parametro

– Il pulsante cancella il parametro selezionato

– Fai clic sul pulsante Convalida per verificare che le opzioni di creazione inserite per il formato speci-
ficato siano valide

– Utilizza il pulsante Guida per trovare i parametri da utilizzare, oppure fai riferimento alla documen-
tazione GDAL raster drivers.

• Modifica le opzioni per le Piramidi

Figure 9.11: Esempio di profilo delle piramidi

GDAL driver

In questa cornice, puoi definire quale driver GDAL deve essere utilizzato per leggere e/o scrivere file, poiché in
alcuni casi è disponibile più di un driver GDAL.

Suggerimento: Facendo doppio clic su un driver che permette l’accesso in lettura e scrittura (rw+(v)) si apre
la finestra di dialogo Edit Create options per la personalizzazione.
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Figure 9.12: Impostazioni GDAL in QGIS
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9.1.12 Impostazioni variabili

La scheda Variabili elenca tutte le variabili disponibili a livello globale.

Permette inoltre all’utente di gestire variabili di livello globale. Fai clic sul pulsante per aggiungere una nuova
variabile personalizzata a livello globale. Allo stesso modo, selezionare una variabile personalizzata a livello

globale dall’elenco e fare clic su pulsante per rimuoverla.

Maggiori informazioni sulle variabili nella sezione Memorizzazione valori nelle Variabili.

Figure 9.13: Impostazione variabili in QGIS

9.1.13 Impostazioni di autenticazione

Nella scheda Autenticazione puoi impostare le configurazioni di autenticazione e gestire i certificati PKI. Vedi
Authentication System per maggiori dettagli.

9.1.14 Impostazioni di rete

Generale

• Indirizzo di ricerca WMS (Quello predefinito è http://geopole.org/wms/search?
search=%1&type=rss)

• Imposta il Timeout per le richieste di rete (ms) - il valore predefinito è 60000

• Imposta il Periodo di scadenza predefinito per capabilities WMS (ore) - l’impostazione predefinita è 24

• Imposta il Periodo di scadenza predefinito per mattonelle WMSC/WMTS (ore) - valore standard è 24

• Definisci il Numero massimo di tentativi in caso di errore nella richiesta della mattonella o della geometria

• Definisci l” Utente-Agente

Impostazioni della cache

Definisci la Cartella e una Dimensione per la cache. Offre anche strumenti per Automaticamente cancellare la
cache di autenticazione della connessione su errori SSL (raccomandato).

Proxy per l’accesso web

• Usa un proxy per l’accesso web
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Figure 9.14: Impostazioni di autenticazione in QGIS

• Imposta Tipo proxy in base alle tue necessità e definisci “Host” e “Porta”. I tipi di proxy disponibili
sono:

– Default Proxy: Il Proxy è determinato in base al proxy di sistema

– Socks5Proxy: Proxy generico per ogni tipo di connessione. Supporta TCP, UDP, associazione a una
porta (connessione in entrata) e autenticazione.

– HttpProxy: Realizzato usando il comando «CONNECT», supporta solamente connessioni TCP in
uscita; supporta l’autenticatione.

– HttpCachingProxy: Realizzato usando normali comandi HTTP, è utile solamente nel contesto di richi-
este HTTP.

– FtpCachingProxy: Realizzato usando un proxy FTP, è utile solamente nel contesto di richieste FTP.

Le credenziali del proxy vengono impostate usando il authentication widget.

Puoi escludere alcuni URL aggiungendo il testo nella sezione dedicata (vedi Figure_Network_Tab).

Se hai bisogno di informazioni più dettagliate sulle diverse impostazioni del proxy, fai riferimento al man-
uale della seguente documentazione della libreria QT all’indirizzo https://doc.qt.io/qt-5.9/qnetworkproxy.html#
ProxyType-enum

Suggerimento: Utilizzo proxy

L’utilizzo dei proxy a volte può essere complicato. È utile procedere con “tentativo e errore” con i suddetti tipi di
proxy, per verificare se hanno successo nel tuo caso.
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Figure 9.15: Impostazione proxy in QGIS
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9.1.15 Impostazioni Localizzatore

La scheda Localizzatore permette di configurare il widget Locator bar, un widget di ricerca rapida disponi-
bile sulla barra di stato che aiuta ad eseguire ricerche in qualsiasi punto dell’applicazione. Fornisce alcuni filtri
predefiniti (con prefisso) da utilizzare:

• Layer del Progetto (l): trova e seleziona un layer nel pannello Layer.

• Impaginazioni del Progetto (pl): trova ed apre un layout di stampa.

• Azioni (.): trova ed esegue un’azione QGIS; le azioni possono essere qualsiasi strumento o menu in QGIS,
aprire un pannello. . .

• Proprietà layer attivo (f): ricerca gli attributi corrispondenti in qualsiasi campo del layer attivo corrente ed
effettua lo zoom sull’elemento selezionato.

• Proprietà in tutti i layer (af): ricerca gli attributi corrispondenti in display name di ciascun searchable
layers ed effettua lo zoom sull’elemento selezionato.

• Calcolatore (=): permette di calcolare qualsiasi espressione di QGIS e, se valida, dà la possibilità di copiare
il risultato negli appunti.

• Segnalibri spaziali (b): trova ed effettua lo zoom sull’estensione del segnalibro.

• Impostazioni (set): sfoglia e apre le finestre di dialogo delle proprietà del progetto e dell’applicazione.

• Algoritmi di Processing (a): ricerca e apre una finestra di dialogo di Algoritmi di Processing.

• Modifica le geometrie selezionate (ef): fornisce un accesso rapido ed esegue un algoritmo di elaborazione
compatibile modify-in-place sul layer attivo.

Per ogni filtro, puoi personalizzare il filtro, impostare se è abilitato per impostazione predefinita o meno. L’insieme
dei filtri predefiniti del localizzatore può essere esteso dai plugin, ad esempio per le ricerche OSM Nominatim, la
ricerca diretta nel database, le ricerche nel catalogo dei layer.

La barra di ricerca del localizzatore può essere attivata premendo Ctrl+K. Digita il tuo testo per eseguire una
ricerca. Per impostazione predefinita, i risultati vengono restituiti per tutti i filtri del localizzatore abilitati, ma
puoi limitare la ricerca ad un certo filtro, prefissando il tuo testo con il Prefisso del filtro localizzatore, ad esempio
digitando l cad restituirà solo i layer il cui nome contiene cad. Clicca sul risultato per eseguire l’azione
corrispondente, a seconda del tipo di elemento.

La ricerca viene gestita tramite thread, in modo che i risultati siano sempre disponibili il più rapidamente possibile,
indipendentemente dall’eventuale installazione di filtri di ricerca lenta. Essi appaiono anche non appena ogni
risultato viene rilevato da ciascun filtro, il che significa che, ad esempio, un filtro di ricerca file mostrerà i risultati
uno per uno mentre l’albero dei file viene scansionato. In questo modo l’interfaccia utente è sempre reattiva anche
in presenza di un filtro di ricerca molto lento (ad esempio, un filtro che utilizza un servizio online).

Suggerimento: Accesso rapido alle configurazioni del localizzatore

Clicca sull’icona all’interno del widget localizzatore sulla barra di stato per visualizzare l’elenco dei filtri che
puoi usare e la voce che avvia le Impostazioni della scheda Localizzatore del menu Impostazioni → Opzioni. . . ..

9.1.16 Impostazioni avanzate

A seconda del sistema operativo, tutte le impostazioni relative a QGIS (interfaccia utente, strumenti, provider di
dati, valori predefiniti, opzioni plug-in . . . ) vengono salvate:

• in un file di testo: $HOME/.config/QGIS/QGIS2.conf

• nel file che elenca le proprietà: $HOME/Library/Preferences/org.qgis.qgis.plist

• nel registro in: HKEY\CURRENT_USER\Software\QGIS\qgis
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Figure 9.16: Impostazioni Localizzatore in QGIS

La scheda Avanzato ti offre in un unico posto, indipendentemente dal tuo sistema operativo, strumenti per gestire
queste impostazioni attraverso Impostazioni avanzate Editor. Dopo averti avvisato di fare attenzione, il widget
viene popolato con un albero di tutte le impostazioni di QGIS, che è possibile modificare direttamente.

Avvertimento: Evita di utilizzare ciecamente le impostazioni della scheda Avanzate

Fai attenzione quando modifichi gli elementi in questa finestra di dialogo dato che le modifiche vengono
applicate automaticamente. Fare cambiamenti senza consapevolezza può coorompere l’installazione di QGIS
in vari modi.

9.1.17 Impostazioni Processing

La scheda Processing ti fornisce le impostazioni generali degli strumenti e delle sorgenti dati utilizzati nel
framework QGIS Processing. Maggiori informazioni su ambiente Processing di QGIS.

9.2 Lavorare con i Profili Utente

Il menu Impostazioni → Profili utente fornisce funzioni per impostare e accedere ai profili utente. Un profilo
utente è una configurazione unificata dell’applicazione che permette di memorizzare in una singola cartella:

• tutte le global settings incluse proiezioni locali, impostazioni di autenticazione, tavolozze di colori, scorci-
atoie. . .

• Configurazione GUI e customization

• plugins installati e loro configurazioni

• modelli di progetto e cronologia del progetto salvato con la loro immagine di anteprima

• processing settings, log, script, modelli.
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Figure 9.17: Scheda impostazioni Avanzate in QGIS

Figure 9.18: Scheda impostazioni Processing in QGIS
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Per impostazione predefinita, un’installazione QGIS contiene un solo profilo utente denominato default. Ma
puoi creare tutti i profili utente che vuoi:

1. Fai clic sulla voce Nuovo Profilo. . . ..

2. Ti verrà chiesto di fornire un nome di profilo, creando una cartella con lo stesso nome sotto ~/
<UserProfiles>/ dove:

• ~ rappresenta la HOME directory, che in Windows è solitamente qualcosa come
C:\Users\(user).

• e <UserProfiles> rappresenta la cartella principale del profilo, ad esempio:

– .local/share/QGIS/QGIS3/profiles/

– AppData\Roaming\QGIS\QGIS3\profiles\

– Library/Application Support/QGIS/QGIS3/profiles/

La cartella del profilo utente può essere aperta da QGIS utilizzando la Open Active Profile Folder.

3. Viene avviata una nuova istanza di QGIS, utilizzando una configurazione pulita. Puoi quindi impostare le
tue configurazioni personalizzate.

Poiché ogni profilo utente contiene impostazioni separate, plugin e cronologia possono essere ottimizzati per
diversi flussi di lavoro, demo, utenti della stessa macchina, o impostazioni di test, ecc. E puoi passare dall’uno
all’altro selezionandoli nel menu Impostazioni → Profili utente. Puoi anche eseguire QGIS con un profilo utente
specifico da command line.

Se non viene modificato, il profilo dell’ultima sessione chiusa di QGIS verrà utilizzato nelle successive sessioni
QGIS.

Suggerimento: Eseguire QGIS sotto un nuovo profilo utente per verificare la persistenza dei bug

Quando incontri uno strano comportamento con alcune funzioni in QGIS, crea un nuovo profilo utente ed esegui
nuovamente i comandi. A volte, i bug sono correlati ad alcune sporcizie sul profilo utente corrente e la creazione
di un nuovo profilo utente può correggerli quando si riavvia QGIS con il nuovo profilo (pulito).

9.3 Proprietà progetto

Nella finestra delle proprietà del progetto sotto Progetto -> Proprietà progetto, puoi impostare le opzioni speci-
fiche per il progetto. Le opzioni specifiche del progetto sovrascrivono il loro equivalente nella finestra di dialogo
Opzioni sopra descritta.

9.3.1 Proprietà Generali

Nella scheda Generale, le Impostazioni generali ti permettono di:

• vedere la posizione del file di progetto

• impostare la cartella home del progetto (disponibile nella voce visualizzata Home del progetto). Il
percorso può essere relativo alla cartella del file di progetto (digitare in) o assoluto. La home del progetto
può essere utilizzata per memorizzare dati e altri contenuti utili per il progetto.

• dare un titolo al progetto accanto al percorso del file di progetto

• scegliere il colore da usare per le geometrie quando vengono selezionate

• scegliere il colore di sfondo: il colore da usare per l’area della mappa

• scegliere se il percorso dei layer nel progetto deve essere salvato come assoluto (completo) o come relativo
al percorso del file di progetto. Puoi preferire il percorso relativo quando sia i layers che i file di progetto
possono essere spostati o condivisi o se si accede al progetto da computer su piattaforme diverse.
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• scegliere di evitare artefatti quando il progetto viene reso come tessere mappa. Nota che il controllo con
questa opzione può comportare un peggioramento delle prestazioni.

Calcolare le aree e le distanze è un’esigenza comune in GIS. Tuttavia, questi valori sono in realtà legati alle
impostazioni di proiezione sottostanti. La scheda Misura ti consente di controllare questi parametri. Puoi infatti
scegliere:

• l” Ellissoide, su cui si basano interamente i calcoli di distanza e superficie; può essere:

– Nessuno/Planimetrico: i valori restituiti sono in questo caso misure cartesiane.

– uno Personalizzato: devi impostare i valori del semiasse maggiore e del semiasse minore.

– o uno esistente nella lista predefinita (Clarke 1866, Clarke 1880 IGN, New International 1967, WGS
84. . . ).

• le unità di misura per le distanze per la lunghezza e il perimetro e le unità di misura per le aree. Queste im-
postazioni, i cui valori preimpostati sono nelle opzioni QGIS ma che poi sostituisci per il progetto corrente,
vengono utilizzate in:

– Barra di aggiornamento del campo della tabella degli attributi

– Calcoli del calcolatore di campo

– Identifica la lunghezza, il perimetro e i valori dell’area derivati dallo strumento

– Unità predefinita mostrata nella finestra di dialogo delle misure

L’opzione Mostra le coordinate usando permette di scegliere e personalizzare il formato delle unità da utiliz-
zare per visualizzare le coordinate del mouse nella barra di stato e le coordinate derivate visualizzate tramite lo
strumento di identificazione.

Infine, puoi definire una lista di Scale predefinite per il Progetto, che sostituisce le scale globali predefinite.

9.3.2 Proprietà Metadati

La scheda Metadati permette di definire metadati dettagliati, includendo (tra gli altri): autore, data di creazione,
lingua, abstract, categorie, parole chiave, contatti, link, storia. C’è anche una funzionalità di validazione che
controlla se i campi specifici sono stati compilati, in ogni caso questo non è vincolante. Vedi vector layer metadata
properties per altri dettagli.

9.3.3 Proprietà SR

La scheda SR ti aiuta a impostare il sistema di riferimento delle coordinate da utilizzare in questo progetto.
Può essere:

• Nessuna proiezione (o proiezione sconosciuta/non terrestre): questa impostazione può essere usata per
trovare un SR di un layer o quando si usa QGIS per usi non terrestri come mappe di gioco di ruolo, mappe
di edifici o materiale microscopico. In questo caso:

– Non viene eseguita alcuna riproiezione durante la visualizzazione dei layer: gli elementi vengono
disegnati usando le loro coordinate grezze.

– L’ellissoide viene annullato e viene impostato a Nessuno/Planimetrico.

– Le unità di distanza e di area e la visualizzazione delle coordinate sono bloccate e impostate a «unità
sconosciute»; tutte le misurazioni sono effettuate in unità di mappa sconosciute e non è possibile
alcuna conversione.

• o un sistema di riferimento di coordinate esistente che può essere geografico, proiettato o definito
dall’utente. Viene visualizzata un’anteprima dell’estensione del SR sulla terra per aiutare l’utente a se-
lezionare quella appropriata. I layer aggiunti al progetto vengono tradotti al volo in questo SR per poterli
sovrapporre indipendentemente dal loro SR originale. L’uso delle unità, l’impostazione dell’ellissoide sono
disponibili e hanno senso ed è possibile eseguire i calcoli di conseguenza.
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Figure 9.19: Scheda Generale della finestra di dialogo Proprietà progetto
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La scheda SR ti aiuta anche a controllare le impostazioni di riproiezione dei layer configurando le preferenze
di trasformazione dei dati da applicare nel progetto corrente. Di norma, queste sostituiscono le corrispondenti
impostazioni globali. Vedi Trasformazioni Datum per maggiori dettagli.

9.3.4 Proprietà Stili predefiniti

La scheda Stili predefiniti ti consente di controllare come saranno disegnati nuovi layer nel progetto quando non
hanno uno file di stile .qml definito. Puoi:

• Impostare i simboli di default (Simbolo, Linea, Riempimento) da applicare a seconda del tipo di geometria
del layer come anche il default della Scala di colori.

• Applicare un valore di default per l” Opacità ai nuovi layer

• Assegnare colori casuali ai simboli, modificando il riempimento dei colori dei simboli, evitando così la
stessa visualizzazione per tutti i layer.

Figure 9.20: Scheda Stili predefiniti

Utilizzando il pulsante Gestore di stile, puoi anche accedere rapidamente alla finestra di dialogo Style Manager
e configurare simboli e scale di colori.

C’è anche un’altra sezione dove è possibile definire colori specifici per il progetto in esecuzione. Analogamente
con global colors, puoi:

• Aggiungi colore o Elimina colore

• Copia i colori o Incolla colori

• Importa colori da file o Esporta colori l’impostazione dei colori da/per .gpl file.

Fai doppio clic su un colore nell’elenco per modificarlo o sostituirlo nella finestra di dialogo Color Selector. Puoi
anche rinominarlo facendo doppio clic nella colonna Etichetta.
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Questi colori sono identificati come Colori del Progetto ed elencati come parte di color widgets.

Suggerimento: Utilizzare i colori del progetto per assegnare e aggiornare rapidamente i widget dei colori

I colori del progetto possono essere riferiti all’uso delle loro etichette e i widget di colore in cui sono usati sono
correlati alle stesse. Questo significa che invece di impostare ripetutamente lo stesso colore per molte proprietà e,
per evitare un aggiornamento impegnativo, puoi:

1. Definire colori come Colori del Progetto

2. Applicalo usando l’espressione project_color('color_label') nel colore data defined override
widget.

3. Aggiungi un colore uno alla volta nella lista Colori del Progetto

4. E il cambiamento si riflette su TUTTO.

9.3.5 Proprietà sorgenti dati

Nella scheda Sorgenti dati puoi:

• Crea automaticamente la transizione dei gruppi quando possibile: Quando questa modalità è attivata,
tutti i layer (postgres) dello stesso database sono sincronizzati nel loro stato di modifica, cioè quando un
layer è messo in stato di modifica, tutti lo sono, quando un layer è impegnato o un layer è riportato allo stato
precedente, ciò vale anche per gli altri. Inoltre, anziché eseguire il buffering delle modifiche di modifica in
locale, vengono direttamente inviate a una transazione nel database che viene eseguita quando l’utente fa
clic su Salva layer. Nota che è possibile (dis)attivare questa opzione solo se nel progetto non c’è in fase di
modifica layer.

• Valutazione dei valori predefiniti lato provider: Quando si aggiungono nuovi elementi in una tabella
PostgreSQL, i campi con vincolo di valori predefiniti sono valutati e popolati all’apertura del modulo e
non al momento del commit. Ciò significa che invece di un’espressione come nextval('serial'), il
campo nel modulo Aggiungi elemento mostrerà il valore atteso (ad esempio, 25).

• Fidati del progetto quando il sorgente non possiede metadati: Per accelerare il caricamento del progetto
saltando i controlli dei dati. Utile nel contesto di QGIS Server o in progetti con enormi viste di database/viste
materializzate. L’estensione dei layer sarà letta dal file del progetto QGIS (invece che dalle fonti di dati) e
quando si utilizza il provider PostgreSQL l’unicità della chiave primaria non sarà controllata per le viste e
le viste materializzate.

• Configurare le Capabilities dei Layer, ad esempio:

– Abilitare (o disabilitare) quali layer sono identificabili, cioè risponderanno a identify tool. Per
impostazione predefinita, i layer sono interrogabili.

– Definire se un layer deve essere di Sola lettura, il che significa che non può essere modificato
dall’utente, indipendentemente dai vincoli della sorgente dati. Anche se questa è una protezione de-
bole, rimane una configurazione rapida e pratica per evitare che gli utenti finali modifichino i dati
quando lavorano con layer definiti in file

– Definire quali layer sono Ricercabili, cioè potrebbero essere interrogati uasando il locator widget.
Per impostazione predefinita, i layer sono ricercabili.

– Definire quali layer sono definiti come Obbligatori. I layer selezionati in questa lista sono protetti
dalla rimozione accidentale dal progetto.

La tabella Capabilities dei Layer fornisce alcuni strumenti utili:

– Selezionare più celle e premere Inverti selezione per farle cambiare lo stato di modalità di comporta-
mento;

– Mostra solo layer spaziali, filtra i layer non spaziali dalla lista dei layer;
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– Filtra layer. . . e rapidamente seleziona la configurazione per un particolare layer.

9.3.6 Proprietà Relazioni

La scheda Relazioni è usata per definire le relazioni 1: n. Le relazioni sono definite nella finestra di dialogo delle
proprietà del progetto. Una volta che le relazioni esistono per un layer, un nuovo elemento dell’interfaccia utente
nella vista modulo (ad es. quando si identifica una geometria e si apre il suo modulo) elencherà le entità correlate.
Questo fornisce un modo efficace per esprimere per es. lo storico delle ispezioni su una lunghezza del gasdotto
o del segmento stradale. Puoi trovare ulteriori informazioni sul supporto delle relazioni 1:n nella Sezione Creare
una relazione uno a molti o molti a molti.

9.3.7 Proprietà Variabili

La scheda Variabili elenca tutte le variabili disponibili a livello di progetto (che include tutte le variabili globali).

Inoltre, consente anche all’utente di gestire variabili a livello di progetto. Fai clic sul pulsante per aggiungere
una nuova variabile personalizzata a livello di progetto. Allo stesso modo, selezionare una variabile a livello di

progetto personalizzata dall’elenco e fare clic sul pulsante pulsante per rimuoverlo. Maggiori informazioni
sull’utilizzo delle variabili nella sezione Strumenti generali Memorizzazione valori nelle Variabili.

9.3.8 Proprietà Macro

La scheda Macro è usata per modificare le macro Python per i progetti. Attualmente sono disponibili solo tre
macro: openProject (), saveProject () e closeProject ().

9.3.9 Proprietà QGIS Server

La scheda QGIS Server ti permette di configurare il tuo progetto per pubblicarlo online. Qui puoi definire le infor-
mazioni sulle capabilities di QGIS Server WMS e WFS, l’estensione e le restrizioni SR. Maggiori informazioni
sono disponibili nella sezione Configure your project e successive.

9.4 Personalizzazione

La finestra di dialogo di personalizzazione consente di (dis) attivare quasi tutti gli elementi dell’interfaccia utente
di QGIS. Questo può essere molto utile se vuoi fornire ai tuoi utenti finali una versione «leggera» di QGIS,
contenente solo le icone, i menu o i pannelli di cui hanno bisogno.

Nota: Prima che le modifiche trovino applicazione, è necessario riavviare QGIS.

Spuntando la casella di controllo Abilita personalizzazione è il primo passo verso la personalizzazione di
QGIS. Ciò abilita la barra degli strumenti e il pannello dei widget da cui è possibile deselezionare e quindi dis-
abilitare alcuni elementi della GUI.

Gli elementi configurabili possono essere:

• un Menu o alcuni dei suoi sotto-menu da Barra dei Menu

• un intero Panello (vedi Pannelli e Barre degli strumenti)

• la Barra di stato descritta in Barra di Stato o qualcuno dei suoi strumenti

• una Barra degli strumenti: per intero o per alcune sue icone

• o ogni widget di ogni finestra di dialogo in QGIS: etichette, pulsanti, caselle combinate. . .
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Figure 9.21: Impostazioni delle macro in QGIS

Figure 9.22: Finestra di dialogo Personalizzazione
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Con Passa ai widget per la cattura nell’applicazione principale, puoi fare clic su un strumento dell’interfaccia di QGIS che
vuoi nascondere e QGIS deseleziona automaticamente la voce corrispondente nella finestra di dialogo Personaliz-
zazione.

Una volta impostata la configurazione, fai clic su Applica o OK per convalidare le modifiche. Questa configu-
razione diventa quella utilizzata di default da QGIS all’avvio successivo.

Le modifiche possono essere salvate in un file .ini usando il pulsante Salva su file. Questo è un modo pratico

per condividere una interfaccia comune QGIS fra più utenti. Basta fare click su Carica da file dal computer di
destinazione per importare il file .ini. Puoi anche utilizzare opzioni della riga dei comandi e salvare varie
impostazioni anche per casi d’uso diversi.

Suggerimento: Ripristinare in modo semplice lo stato predefinito di QGIS

La configurazione iniziale della GUI di QGIS può essere ripristinata in uno dei seguenti modi:

• deselezionando l’opzione Abilita personalizzazione nella finestra di dialogo Personalizzazione o fare

clic su Verifica tutto

• premendo il pulsante Ripristina nel riquadro Impostazioni nel menu Impostazioni → Opzioni. . . , scheda
Sistema

• lanciando QGIS al prompt dei comandi con la seguente riga di comando qgis --nocustomization

• impostando a false il valore della variabile UI -> Personalizzazione -> Abilitato nel menu Impostazioni
→ Opzioni, scheda Avanzato (vedi warning).

In quasi tutti i metodi esposti per rendere operativo il ripristino è necessario riavviare QGIS.

9.5 Tasti di scelta rapida

QGIS fornisce scorciatoie da tastiera predefinite per molte funzionalità. Puoi trovarle nella sezione Barra dei

Menu. Inoltre, l’opzione del menu Impostazioni → Configura scorciatoie . . . ti consente di modificare le
scorciatoie da tastiera predefinite e aggiungere nuove scorciatoie da tastiera alle funzioni di QGIS.

La configurazione è molto semplice. Usa la casella di ricerca in cima alla finestra di dialogo per trovare una
particolare azione, selezionala dall’elenco e clicca su:

• Cambia e premi la nuova combinazione che vuoi assegnare come nuova scorciatoia

• Set None per eliminare la scorciatoia assegnata

• o Selezione predefinita per ripristinare la scorciatoia ai suoi valori di default.

Procedi come sopra per tutti gli altri strumenti che vuoi personalizzare. Una volta terminata la configurazione,
semplicemente Chiudi la finestra di dialogo per applicare le modifiche. Puoi anche fare Salva. . . i cambiamenti
come file .XML e Carica. . . in un’altra installazione di QGIS.

9.6 Esecuzione di QGIS con impostazioni avanzate

9.6.1 Linea di comando e variabili di ambiente

Abbiamo visto che lanciare QGIS è fatto come per qualsiasi applicazione sul tuo sistema operativo. QGIS fornisce
opzioni a riga di comando per casi d’uso più avanzati (in alcuni casi puoi utilizzare una variabile d’ambiente
invece dell’opzione a riga di comando). Per ottenere una lista delle opzioni, inserisci qgis --help sulla riga
di comando, che restituisce:
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Figure 9.23: Definire le opzioni di scelta rapida

QGIS is a user friendly Open Source Geographic Information System.
Usage: /usr/bin/qgis.bin [OPTION] [FILE]

OPTION:
[--version] display version information and exit
[--snapshot filename] emit snapshot of loaded datasets to given file
[--width width] width of snapshot to emit
[--height height] height of snapshot to emit
[--lang language] use language for interface text (changes existing

→˓override)
[--project projectfile] load the given QGIS project
[--extent xmin,ymin,xmax,ymax] set initial map extent
[--nologo] hide splash screen
[--noversioncheck] don't check for new version of QGIS at startup
[--noplugins] don't restore plugins on startup
[--nocustomization] don't apply GUI customization
[--customizationfile path] use the given ini file as GUI customization
[--globalsettingsfile path] use the given ini file as Global Settings

→˓(defaults)
[--authdbdirectory path] use the given directory for authentication

→˓database
[--code path] run the given python file on load
[--defaultui] start by resetting user ui settings to default
[--hide-browser] hide the browser widget
[--dxf-export filename.dxf] emit dxf output of loaded datasets to

→˓given file
[--dxf-extent xmin,ymin,xmax,ymax] set extent to export to dxf
[--dxf-symbology-mode none|symbollayer|feature] symbology mode for dxf

→˓output
[--dxf-scale-denom scale] scale for dxf output
[--dxf-encoding encoding] encoding to use for dxf output
[--dxf-map-theme maptheme] map theme to use for dxf output
[--take-screenshots output_path] take screen shots for the user

→˓documentation
[--screenshots-categories categories] specify the categories of

→˓screenshot to be used (see QgsAppScreenShots::Categories).
[--profile name] load a named profile from the user's profiles

→˓folder.
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[--profiles-path path] path to store user profile folders. Will create
→˓profiles inside a {path}\profiles folder

[--version-migration] force the settings migration from older version if
→˓found

[--openclprogramfolder] path to the folder containing the sources
→˓for OpenCL programs.

[--help] this text
[--] treat all following arguments as FILEs

FILE:
Files specified on the command line can include rasters,
vectors, and QGIS project files (.qgs and .qgz):
1. Rasters - supported formats include GeoTiff, DEM

and others supported by GDAL
2. Vectors - supported formats include ESRI Shapefiles

and others supported by OGR and PostgreSQL layers using
the PostGIS extension

Suggerimento: Esempi di uso degli argomenti delle righe di comando

Puoi avviare QGIS specificando uno o più file di dati sulla riga di comando. Per esempio, supponendo di essere
nella directory qgis_sample_data, puoi avviare QGIS con un layer vettoriale e un file raster da caricare
all’avvio usando il seguente comando: qgis ./raster/landcover.img ./gml/lakes.gml

--version

Questa opzione restituisce Informazioni sulla versione di QGIS.

--snapshot

Questa opzione ti permette di creare un’istantanea in formato PNG dalla vista corrente. Questa opzione è utile
quando si hanno molti progetti e si desidera generare istantanee dai propri dati, o quando è necessario creare
istantanee dello stesso progetto con dati aggiornati.

Attualmente, genera un file PNG con 800x600 pixel. La dimensione può essere regolata usando gli argomenti
-width e --height. Il nome del file può essere aggiunto dopo --snapshot. Ad esempio:

qgis --snapshot my_image.png --width 1000 --height 600 --project my_project.qgs

--width

Questa opzione restituisce la larghezza dello scatto da emettere (usato con --snapshot`).

--height

Questa opzione restituisce l’altezza dello scatto da emettere (usato con --snapshot`).

--lang

In base alla tua zona, QGIS seleziona la localizzazione corretta. Se vuoi cambiare la lingua, è possibile specificare
un codice lingua. Per esempio, qgis --lang inizia QGIS in localizzazione italiana.
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--project

È anche possibile avviare QGIS con un file di progetto esistente. Basta aggiungere l’opzione della riga di comando
--progetto` seguita dal nome del progetto e QGIS si aprirà con tutti i layer del file caricato.

--extent

Per iniziare con una determinata estensione della mappa, utilizza questa opzione. Devi aggiungere il rettangolo di
delimitazione della tua estensione nel seguente ordine separato da una virgola:

--extent xmin,ymin,xmax,ymax

Questa opzione ha probabilmente più senso se abbinata all’opzione --project per aprire uno specifico progetto
nella estensione desiderata.

--nologo

Questa opzione nasconde la schermata iniziale quando si avvia QGIS.

--noversioncheck

Salta il controllo per nuova versione di QGIS all’avvio.

--noplugins

Se hai problemi all’avvio con i plugin, puoi evitare di caricarli all’avvio con questa opzione. In seguito saranno
ancora disponibili nel Plugins Manager.

--nocustomization

Usando questa opzione, qualsiasi esistente GUI customization non sarà applicata all’avvio. Questo significa che
tutti i pulsanti nascosti, le voci di menu, le barre degli strumenti e così via, appariranno all’avvio di QGIS. Questo
non è un cambiamento permanente. La personalizzazione verrà applicata di nuovo se QGIS viene lanciato senza
questa opzione.

Questa opzione è utile per consentire l’accesso temporaneo agli strumenti che sono stati rimossi tramite personal-
izzazione.

--customizationfile

Utilizzando questa opzione, puoi definire un file di personalizzazione dell’interfaccia utente, che verrà utilizzato
all’avvio.

--globalsettingsfile

Utilizzando questa opzione, puoi specificare il percorso di un file di impostazioni globali (.ini`), noto anche
come Impostazioni predefinite. Le impostazioni nel file specificato sostituiscono quelle originali predefinite in
linea, ma le impostazioni dei profili utente saranno impostate sopra di esse. Le impostazioni globali predefinite si
trovano in your_QGIS_PKG_PKG_path/resources/qgis_global_settings.ini.

Attualmente, non c’è modo di specificare un file su cui scrivere le impostazioni; pertanto, è possibile creare una
copia di un file di impostazioni originale, rinominarlo e adattarlo.
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Impostando il percorso qgis_global_setting.ini in una cartella condivisa in rete, permette ad un am-
ministratore di sistema di cambiare le impostazioni globali e le impostazioni predefinite in diverse macchine
modificando un solo file.

La variabile d’ambiente equivalente è QGIS_GLOBAL_SETTINGS_FILE.

--authdbdirectory

Questa opzione è simile a --globalsettingsfile, ma definisce il percorso della directory dove sarà mem-
orizzato e caricato il database di autenticazione.

--code

Questa opzione può essere usata per eseguire un dato file python direttamente dopo l’avvio di QGIS.

Per esempio, quando si ha un file python chiamato load_alaska.py con il seguente contenuto:

from qgis.utils import iface
raster_file = "/home/gisadmin/Documents/qgis_sample_data/raster/landcover.img"
layer_name = "Alaska"
iface.addRasterLayer(raster_file, layer_name)

Supponendo che sei nella directory dove si trova il file load_alaska.py, puoi avviare QGIS, caricare il file
raster landcover.img e dare al layer il nome “Alaska” usando il seguente comando:

qgis --code load_alaska.py

--defaultui

Al caricamento, resetta permanentemente l’interfaccia utente (UI) alle impostazioni predefinite. Questa opzione
ripristina la visibilità, la posizione e le dimensioni dei pannelli e delle barre degli strumenti. A meno che non
venga modificata di nuovo, le impostazioni predefinite dell’interfaccia utente verranno utilizzate nelle sessioni
successive.

Nota che questa opzione non ha alcun effetto su GUI customization. Gli elementi nascosti dalla personaliz-
zazione dell’interfaccia grafica (ad esempio la barra di stato) rimarranno nascosti anche utilizzando l’opzione
--defaultui`. Vedi anche l'opzione ``--nocustomization.

--hide-browser

Al caricamento, nasconde il pannello Browser dall’interfaccia utente. Il pannello può essere abilitato cliccando
con il tasto destro del mouse su uno spazio nella barra degli strumenti o usando la voce Visualizza → Pannelli

(Impostazioni → Pannelli in Linux KDE).

A meno che non sia di nuovo abilitato, il pannello Browser rimarrà nascosto nelle sessioni successive.

--dxf-*

Queste opzioni possono essere utilizzate per esportare un progetto QGIS in un file DXF. Sono disponibili diverse
opzioni:

• –dxf-export: il nome del file DXF in cui esportare i layer;

• –dxf-extent: l’estensione del file DXF finale;

• –dxf-symbology-mode: qui è possibile utilizzare diversi valori: none (nessuna simbologia),
symbollayer (simbologia a livello simbolo), feature (simbologia dell’elemento);
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• –dxf-scale-deno: il denominatore della scala della simbologia;

• –dxf-encoding: la codifica del file;

• –dxf-map-theme: sceglie un map theme dalla lista della configurazione layer.

--take-screenshots

Acquisisce schermate per la documentazione utente. Può essere usato insieme a
--screenshots-categories per filtrare quali categorie o sezioni delle schermate della documentazione
dovrebbero essere create (vedi QgsAppScreenShots::Categories).

--profile

Carica QGIS utilizzando un profilo specifico dalla cartella del profilo dell’utente. Se non viene modificato, il
profilo selezionato verrà utilizzato nelle seguenti sessioni QGIS.

--profiles-path

Con questa opzione, puoi scegliere un percorso per caricare e salvare i profili (impostazioni utente). Crea profili
all’interno di una cartella {path}\profiles, che include impostazioni, plugin installati, modelli di elabo-
razione e script, e così via.

Questa opzione ti permette, ad esempio, di memorizzare tutti i plugin e le impostazioni in un’unità flash o, ad
esempio, di condividere le impostazioni tra computer diversi utilizzando un servizio di condivisione file.

La variabile d’ambiente equivalente è QGIS_CUSTOM_CONFIG_PATH.

--version-migration

Se vengono trovate le impostazioni di una versione precedente (e.g., la cartella .qgis2 da QGIS 2.18), questa
opzione le importerà nel profilo QGIS predefinito.

--openclprogramfolder

Utilizzando questa opzione, puoi specificare un percorso alternativo per i programmi OpenCL. Questo è utile per
gli sviluppatori mentre testano nuove versioni dei programmi senza dover sostituire quelle esistenti.

La variabile d’ambiente equivalente è QGIS_OPENCL_PROGRAM_FOLDER.

9.6.2 Distribuzione di QGIS all’interno di un’organizzazione

Se devi installare QGIS all’interno di un’organizzazione con un file di configurazione personaliz-
zato, devi prima copiare/incollare il contenuto del file delle impostazioni predefinite che si trova in
your_QGIS_PKG_PKG_path/resources/qgis_global_settings.ini. Questo file contiene già
alcune sezioni predefinite identificate da un blocco che inizia con []. Consigliamo di mantenere questi valori
predefiniti e di aggiungere le proprie sezioni in fondo al file. Se una sezione è duplicata nel file, QGIS prenderà
l’ultima dall’alto verso il basso

Puoi cambiare allowVersionCheck=false per disabilitare il controllo della versione di QGIS.

Se non vuoi visualizzare la finestra di migrazione dopo una nuova installazione, devi usare la seguente sezione:

[migration]
fileVersion=2
settings=true
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Se vuoi aggiungere una variabile personalizzata a livello globale:

[variables]
organisation="Your organization"

Per scoprire tutte le possibilità del file INI, suggeriamo di impostare la configurazione che si desidera in QGIS
Desktop e poi cercarla nel file INI situato nel proprio profilo utilizzando un editor di testo. Molte impostazioni
possono essere impostate usando il file INI come WMS/WMTS, connessioni PostGIS, impostazioni proxy, sug-
gerimenti per la mappa. . . ..

Infine, devi impostare la variabile d’ambiente QGIS_GLOBAL_SETTINGS_FILE al percorso del tuo file per-
sonalizzato.

Inoltre, puoi anche installare file come macro Python, tavolozze di colori, modelli di layout, modelli di progetto. . . .
nella cartella di sistema QGIS o nel profilo utente QGIS

• I modelli di layout devono essere installati nella cartella composer_templates.

• I modelli di progetto devono essere installati nella cartella project_templates.

• Le macro Python personalizzate devono essere installate nella cartella python.
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CHAPTER 10

Lavorare con le proiezioni

Un Sistema di Riferimento delle Coordinate, o SR, è un metodo per associare coordinate numeriche ad una po-
sizione sulla superficie terrestre. QGIS supporta circa 7.000 SR standard, ognuno con diversi casi d’uso, pro e
contro! Scegliere un sistema di riferimento appropriato per i tuoi progetti e dati QGIS può essere un compito
complesso, ma fortunatamente QGIS ti aiuta ad orientarti in questa scelta e rende il lavoro con i diversi SR il più
trasparente e accurato possibile.

10.1 Panoramica sul supporto alle proiezioni

QGIS supporta circa 7.000 SR noti. Questi SR standard si basano su quelli definiti dall’European Petroleum
Search Group (EPSG) e dall’Institut Geographique National de France (IGNF) e sono disponibili in QGIS at-
traverso la sottostante libreria di proiezione «Proj». Comunemente, queste proiezioni standard sono identifi-
cate attraverso l’uso di una combinazione di autorità:codice, dove l’autorità è un nome dell’organizzazione come
«EPSG» o «IGNF», e il codice è un numero unico associato a uno specifico SR. Ad esempio, il comune SR
WGS 84 latitudine/longitudine è noto con l’identificatore EPSG:4326 e lo standard di mappatura web SR è
EPSG:3857.

I SR personalizzati creati dall’utente sono memorizzati in un database SR utente. Vedi la sezione Sistemi di
riferimento personalizzati per informazioni sulla gestione dei tuoi Sistemi di Riferimento delle coordinate person-
alizzate.

10.2 Sistemi di Riferimento delle coordinate e layer

Per proiettare correttamente i dati in uno specifico SR di destinazione, i dati devono contenere informazioni sul
sistema di riferimento delle coordinate oppure è necessario assegnare manualmente il SR corretto per il layer. Per
i layer PostGIS, QGIS utilizza l’identificatore di riferimento spaziale specificato al momento della creazione del
layer PostGIS. Per i dati supportati da OGR o GDAL, QGIS si basa sulla presenza di un mezzo riconosciuto per
specificare il SR. Ad esempio, per il formato Shapefile, si tratta di un file contenente la rappresentazione Well-
Known Text (WKT) del SR del layer. Questo file di proiezione ha lo stesso nome di base del .shp file e una
estensione .prj. Per esempio, alaska.shp ha un file di proiezione corrispondente chiamato alaska.prj.

Ogni volta che un layer viene caricato in QGIS, QGIS tenta di determinare automaticamente il SR corretto per
quel layer. In alcuni casi questo non è possibile, ad esempio quando un layer viene fornito senza avere queste
informazioni. Se QGIS non è in grado di determinare automaticamente il SR corretto per un layer, verrà richiesto
di selezionare manualmente il SR. Selezionare la scelta corretta è fondamentale, in quanto una scelta sbagliata
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collocherà il layer nella posizione sbagliata sulla superficie terrestre! A volte, i metadati allegati descrivono il SR
corretto per un layer, in altri casi è necessario contattare l’autore originale dei dati per determinare il SR corretto
da utilizzare.

10.3 Sistemi di Riferimento delle coordinate e Progetti

Ogni progetto in QGIS ha anche un sistema di riferimento di coordinate associato. Il SR del progetto determina
come vengono proiettati i dati dalle sue coordinate grezze sottostanti alla mappa resa piana all’interno della tua
mappa QGIS. Dietro le quinte, QGIS riproduce in modo trasparente tutti i layer contenuti nel SR del progetto, in
modo da renderli tutti nella posizione corretta l’uno rispetto all’altro!

È importante fare una scelta appropriata di SR per i tuoi progetti QGIS. La scelta di un SR inappropriato può
causare distorsioni delle mappe e riflettere in modo inadeguato le dimensioni e le posizioni degli oggetti rispetto
al mondo reale. Di solito, mentre si lavora in aree geografiche più piccole, ci sarà un certo numero di SR standard
utilizzati all’interno di un particolare paese o area amministrativa. È importante cercare quali SR sono scelte
appropriate o standard per l’area che si sta mappando e assicurarsi che il progetto QGIS segua questi standard.

Il SR del progetto può essere impostato attraverso la scheda SR della finestra di dialogo Proprietà del Progetto
(Progetto → Proprietà. . . ). Verrà visualizzato anche nella parte inferiore destra della barra di stato di QGIS.

Figure 10.1: Finestra di dialogo Proprietà del progetto
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La scheda SR ha anche un’impostazione opzionale per Nessuna proiezione. La scelta di questa impostazione
disabiliterà la gestione di TUTTE le proiezioni all’interno del progetto QGIS, facendo sì che tutte le coordinate
dei layer e della mappa siano trattate come semplici coordinate cartesiane 2D, senza alcuna relazione con le
posizioni sulla superficie terrestre.

Ogni volta che selezioni un nuovo SR per il progetto QGIS, le unità di misura verranno automaticamente modifi-
cate nella scheda Generale della finestra di dialogo delle Proprietà progetto (Project → Properties. . . ) per cor-
rispondere al SR selezionato. Ad esempio, alcuni SR definiscono le loro coordinate in piedi invece che in metri,
pertanto, impostando il progetto QGIS su uno di questi SR, il tuo progetto verrà anche impostato per utilizzare i
piedi come default per le misure.

10.4 Impostazioni SR

Per impostazione predefinita, QGIS avvia ogni nuovo progetto utilizzando una proiezione globale predefinita.
Questo SR predefinito è EPSG:4326 (noto anche come «WGS 84»), ed è un sistema di riferimento globale basato
su latitudine/longitudine. Questo SR predefinito può essere modificato tramite l’impostazione SR predefinito per i
nuovi progetti nella scheda SR in Impostazioni → Opzioni. Esiste un’opzione per impostare automaticamente
il SR del progetto in modo che corrisponda al SR del primo layer caricato in un nuovo progetto o, in alternativa, è
possibile selezionare un SR predefinito diverso da utilizzare per tutti i progetti appena creati. Questa scelta verrà
salvata per l’uso nelle successive sessioni QGIS

Figure 10.2: Scheda SR nella finestra di dialogo opzioni QGIS

Quando usi layer che non hanno un SR, puoi definire come QGIS risponde a questi layer. Questo può essere fatto
a livello globale nella scheda SR sotto Impostazioni → Opzioni.

Le opzioni mostrate in figure_projection_options sono:
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• Richiedi SR

• Usa il SR del Progetto

• Usa SR predefinito

Se vuoi definire il sistema di riferimento delle coordinate per un certo layer senza informazioni SR, è possibile
farlo anche nella scheda Source della finestra di dialogo delle Proprietà raster o Proprietà vettore (vedi Proprietà
Sorgente per i raster e Proprietà Sorgente per i vettori). Se il layer ha già definito un SR, verrà visualizzato come
mostrato in Finestra di dialogo scheda Generale Proprietà Layer. Nota che cambiare il SR in questa impostazione
non altera in alcun modo i dati originari, ma cambia unicamente il modo in cui QGIS interpreta le coordinate
grezze dal layer solo nel progetto QGIS corrente.

Suggerimento: SR nel Pannello Layer

Facendo click con il tasto destro su di un layer nel Layers Panel hai a disposizione due scorciatoie per
l’impostazione del SR. Imposta SR del layer apre direttamente la finestra per la scelta del sistema di riferimento
(vedi figure_projection_project). Imposta il SR del progetto dal layer imposta il SR del progetto sulla base di
quello del layer

10.5 Trasformazioni SR On The Fly (OTF)

QGIS supporta la trasformazione SR «on the fly» sia per i dati raster che vettoriali. Questo significa che, indipen-
dentemente dai SR sottostanti di particolari layer di mappe nel tuo progetto, essi saranno sempre automaticamente
trasformati nel SR comune definito per il tuo progetto.

10.6 Scelta del sistema di riferimento delle coordinate

Questa finestra di dialogo consente di assegnare un sistema di riferimento di coordinate a un progetto o a un layer,
a condizione che siano disponibili database di sistemi di proiezione. Gli elementi nella finestra di dialogo sono:

• Filtro: se conosci il codice EPSG, l’identificatore o il nome del SR che vuoi impostare, puoi utilizzare
questa area di ricerca per trovarlo nell’elenco. Inserisci il codice EPSG, l’identificatore o il nome.

• Sistemi di riferimento usati di recente: se hai certi SR che usi frequentemente nel tuo lavoro GIS quotidi-
ano, questi verranno visualizzati in questa sezione della finestra di dialogo. Clicca su una di queste voci per
impostare il SR associato.

• Sistemi di riferimento mondiali: questa è una lista di tutti i SR supportati da QGIS, compresi quelli
geografici, proiettati e personalizzati. Per specificare un SR, selezionalo dalla lista espandendo la lista dallo
specifico raggruppamento. Il SR attivo è preselezionato.

• PROJ in formato testo: Questa è la stringa SR usata dal motore di proiezione PROJ. Questo testo è di sola
lettura ed è dato a scopo informativo.

Il selettore del SR mostra anche un’anteprima approssimativa dell’area geografica per la quale un SR selezionato
è valido per l’uso. Molti SR sono progettati solo per l’uso in piccole aree geografiche e non devono essere
utilizzati al di fuori dell’area per cui sono stati progettati. L’anteprima della mappa ombreggia un’area di utilizzo
approssimativa ogni volta che si seleziona un SR dall’elenco. Inoltre, questa mappa di anteprima mostra anche
una indicazione dell’estensione della mappa principale corrente.

10.7 Sistemi di riferimento personalizzati

Se QGIS non ha le informazioni sul sistema di riferimento di cui hai bisogno, puoi crearne uno personalizzato.

Per farlo, seleziona SR personalizzato. . . dal menu Impostazioni. I SR personalizzati vengono salvati nel tuo
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database utente di QGIS. Oltre ai SR personalizzati, questo database contiene anche i segnalibri geospaziali e altri
dati utente.

Figure 10.3: Finestra di dialogo SR personalizzato

Definire un SR personalizzato in QGIS richiede una buona comprensione delle librerie PROJ. Per iniziare, fai
riferimento al documento “Cartographic Projection Procedures for the UNIX Environment - A User’s Manual”
di Gerald I. Evenden, U.S. Geological Survey Open-File Report 90-284, 1990 (disponibile all’indirizzo ftp://ftp.
remotesensing.org/proj/OF90-284.pdf ).

Questo manuale descrive l’uso di proj e delle relative utilità da riga di comando. I parametri cartografici usati
da proj sono descritti nel manuale e sono identici a quelli usati da QGIS.

La finestra di dialogo Definizione Sistema Riferimento Spaziale Personalizzato richiede solamente due parametri
per definire un SR personalizzato:

1. Il nome

2. I parametri cartografici in formato PROJ

Per creare un nuovo SR, click sul pulsante Aggiungi nuovo SR e immetti un nome e i parametri del SR.

La voce Parametri deve iniziare con un blocco +proj=, per rappresentare il nuovo SR.

Puoi testare i parametri del SR per vedere se danno risultati corretti. Per fare questo, inserisci i valori noti di
latitudine e longitudine WGS 84 rispettivamente nei campi North e East. Fai clic su Calculate, e confronta i
risultati con i valori noti nel tuo sistema di riferimento delle coordinate.
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10.7.1 Inserire una trasformazione NTv2 in QGIS

Per inserire un file di trasformazione NTv2 in QGIS devi fare un ulteriore passo:

1. Mettere il file NTv2 (.gsb) nella cartella SR/Proj che utilizza QGIS (ad esempio.
C:\OSGeo4W64\share\proj per gli utenti Windows)

2. Aggiungere nadgrids (+nadgrids=nameofthefile.gsb) alla definizione Proj nel campo Parametri
del Definizione Sistema Riferimento Personalizzato delle coordinate (Impostazioni → Proiezioni personal-
izzate. . . ).

Figure 10.4: Impostazione di una trasformazione Ntv2

10.8 Trasformazioni Datum

In QGIS, la trasformazione CRS “on-the-fly” è abilitata di default, il che significa che quando si utilizzano layer
con sistemi di coordinate differenti, QGIS li riproduce in modo trasparente al SR del progetto. Per alcuni SR,
ci sono un certo numero di possibili trasformazioni disponibili per riproiettare il SR del progetto! QGIS per-
mette facoltativamente di definire una particolare trasformazione da utilizzare, altrimenti QGIS ne utilizza una
predefinita.

Questa personalizzazione viene effettuata nel menu Impostazioni → scheda Opzioni –> SR sotto il gruppo
Trasformazioni datum predefinite:

• utilizzando Chiedi la trasformazione del datum se disponibili: quando esiste più di una trasformazione
appropriata di datum per una combinazione sorgente/destinazione di SR , si aprirà automaticamente una
finestra di dialogo che chiederà agli utenti di scegliere quale di queste trasformazioni di datum utilizzare per
il progetto;

• o un elenco predefinito di appropriate trasformazioni da utilizzare quando si caricano i layer sui progetti o
si riproietta un layer.

Usa il pulsante per aprire la finestra di dialogo Seleziona le trasformazioni del datum. Poi:

1. Indica il SR sorgente, utilizza il menu a discesa o il widget Seleziona SR.

2. Allo stesso modo, definisci il SR destinazione.

3. A seconda dei file della griglia di trasformazione (in base alle versioni GDAL e PROJ installate sul
vostro sistema), nella tabella è riportato un elenco delle trasformazioni disponibili dalla sorgente alla
destinazione. Facendo clic su una riga vengono visualizzati i dettagli sulle impostazioni applicate
(codice epsg, precisione della trasformazione, numero di stazioni coinvolte. . . .).

Puoi scegliere di visualizzare solo le trasformazioni attualmente valide selezionando l’opzione
Nascondi i SR sconsigliati.

4. Trova la trasformazione che preferisci, selezionala e clicca su OK.

Una nuova riga viene aggiunta alla tabella in SR → Trasformazioni datum predefinite con informazioni
su “SR sorgente” e “SR destinazione” così come “Trasformazione sorgente” e “Trasformazione desti-
nazione”.

Da ora, QGIS utilizza automaticamente la trasformazione del dato selezionato per un’ulteriore trasfor-

mazione tra questi due SR fino a quando non lo si rimuove dalla lista o lo si sostituisce con un altro.

Le trasformazioni di Datum impostate nella scheda Impostazioni → Opzioni –> SR saranno ereditate da tutti
i nuovi progetti QGIS creati sul sistema. Inoltre, un particolare progetto può avere una propria impostazione
specifica di trasformazioni specificata tramite la scheda SR della finestra di dialogo Proprietà Progetto (Progetto
→ Proprietà. . . .). Queste impostazioni si applicano solo al progetto corrente.
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Figure 10.5: Seleziona una trasformazione di default di datum
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CHAPTER 11

Strumenti generali

11.1 Guide contestuali

Ogni volta che hai bisogno di aiuto su un argomento specifico, puoi accedere alla pagina corrispondente nel
manuale utente corrente tramite il pulsante Guida disponibile nella maggior parte delle finestre di dialogo - tieni
presente che i plugin di terze parti possono puntare a pagine web dedicate.

11.2 Pannelli

Per impostazione predefinita, QGIS fornisce molti pannelli con cui lavorare. Alcuni di questi pannelli sono de-
scritti di seguito, mentre altri possono essere trovati in diverse parti del documento. Un elenco completo dei
pannelli predefiniti forniti da QGIS è disponibile tramite il menu Visualizza → Panelli → e descritto in Pannelli.

11.2.1 Pannello dei Layer

Il pannello Layer (chiamato anche la legenda della mappa) elenca tutti i layer del progetto e aiuta a gestire
la loro visibilità. Puoi mostrarlo o nasconderlo premendo Ctrl+1. Un layer può essere selezionato e trascinato
su o giù nella legenda per cambiare l’ordinamento secondo Z. Ordinamento secondo Z significa che i layer elencati
più vicino alla parte superiore della legenda sono disegnati sopra i layer elencati più in basso nella legenda.

Nota: Questo comportamento di default può essere cambiato tramite il pannello Layer Order.

In cima al Pannello dei Layer, una barra degli strumenti ti permette di:

• Apri il pannello Stile layer (F7): attiva e disattiva il pannello Stile layer.

• Aggiungi gruppo

• Gestisci Temi Mappa: controlla la visibilità dei layer e li organizzai in differenti temi mappa.

• Filtra la legenda in base al contenuto della mappa: solo i layers che ricadono nell’area in visualizzazione vengono
elencati in modo completo, gli altri restano ma hanno simbologia nulla, in questo modo viene evidenziato
quali sono i layer di interesse nella zona visualizzata.
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• Filtra legenda tramite espressione: applica un’espressione per rimuovere gli stili dall’albero dei layer selezionati
che non hanno elementi che soddisfano la condizione. Questo può essere usato per evidenziare gli elementi
che si trovano all’interno di una area/elemento di un altro layer. Dall’elenco a discesa, è possibile modificare
e cancellare l’espressione attualmente applicata.

• Espandi tutti o Racchiudi tutti layer e gruppi nel pannello Layer.

• Elimina Layer/Gruppo attualmente selezionato.

Figure 11.1: Barra degli strumenti nel pannello Layer

Nota: Strumenti per la gestione del pannello layer sono anche disponibili per gli oggetti mappa e legenda nei
layout di stampa.

Gestisci Temi Mappa

Il pulsante a discesa Gestisci Temi Mappa fornisce l’accesso a comode scorciatoie per manipolare la visibilità dei
layer nel pannello Layer:

• Mostra tutti i layer

• Nascondi tutti i layer

• Mostra i layer selezionati

• Nascondi i layer selezionati

• Nascondi layer non selezionati

Oltre al semplice controllo della visibilità dei layer, il menu Gestisci Temi Mappa permette di configurare Temi
mappa nella legenda e passare da un tema mappa ad un altro. Un tema della mappa è una fotografia della legenda
della mappa corrente che registra:

• i layer impostati come visibili nel pannello Layer

• e per ogni layer visibile:

– il riferimento allo style applicato al layer

– le classi visibili dello stile, ad esempio gli oggetti nodo del layer selezionati nel pannello Layer. Questo
si applica a symbologies oltre che alla visualizzazione del singolo simbolo

– lo stato collassato/espanso del/i nodo(i) del layer e del gruppo(i) che si trova all’interno di esso

Per creare un novo Tema Mappa:

1. Seleziona un layer che vuoi venga mostrato

2. Configura le proprietà del layer (simbologia, diagramma, etichette. . . ..) come al solito

3. Espandi il menu in basso Stile → e clicca su Aggiungi. . . per memorizzare le impostazioni come a new style
embedded in the project.

Nota: Un tema mappa non memorizza i dettagli attuali delle proprietà: viene salvato solo un riferimento
al nome dello stile, quindi ogni volta che si applicano modifiche al layer mentre questo stile è abilitato
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(ad esempio, si cambia la visualizzazione della simbologia), il tema mappa viene aggiornato con nuove
informazioni.

4. Se necessario ripeti i passaggi precedenti per altri layer

5. Se applicabile, espandi o comprimi gruppi o nodi layer visibili nel pannello Layer

6. Clicca sul pulsante Gestisci temi mappa nella parte superiore del pannello, e Aggiungi tema. . .

7. Inserisci il nome del tema mappa e clicca su OK

Il nuovo tema è in elenco nella parte inferiore del menu a discesa .

Puoi creare tutti i temi della mappa di cui si ha bisogno: quando la combinazione corrente nella legenda della
mappa (layer visibili, il loro stile attivo, gli elementi della legenda della mappa) non corrisponde ad alcun con-
tenuto esistente del tema della mappa come sopra definito, clicca su Aggiungi Tema. . . per creare un nuovo tema
mappa, oppure usa Sostituisci Tema → per aggiornare il tema della mappa corrente. Usa il pulsante :menuselec-
tion:‘ Rimuovi Tema Attuale‘ per eliminare il tema attivo.

I temi mappa sono utili per passare rapidamente da una combinazione preconfigurata all’altra: selezionare un tema
mappa nell’elenco per ripristinare la sua combinazione. Tutti i temi configurati sono accessibili anche nel layout
di stampa, consentendo di creare diversi elementi di mappa basati su temi specifici e indipendenti dall’attuale
visualizzazione della mappa principale (vedi Map item layers).

Panoramica del menu di scelta rapida del Layers Panel

Nella parte inferiore della barra degli strumenti, il componente principale del pannello Layer è il riquadro che
elenca i layer vettoriali o raster aggiunti al progetto, eventualmente organizzati in gruppi. A seconda dell’oggetto
selezionato nel pannello, con il tasto destro del mouse viene mostrato un insieme dedicato di opzioni presentate di
seguito.

Opzione Vettore Layer Raster Gruppo

Zoom su
Layer/Gruppo

Zoom alla selezione

Mostra nella
panoramica

Mostra totale elementi

Copia Layer/Gruppo

Rinomina Layer/Gruppo

Zoom alla
risoluzione nativa
(100%)

Stira usando l’estensione
attuale

Aggiorna SQL
Layer. . .

Aggiungi Gruppo

Duplica

Rimuovi
Layer/Gruppo. . .

Elimina dal Gruppo
Continued on next page
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Table 11.1 – continued from previous page
Opzione Vettore Layer Raster Gruppo

Sposta al primo posto

Seleziona con tutti i gen-
itori

Gruppi Selezionati

Apri tabella degli at-
tributi

Attiva modifiche

Modifiche in uso →
Filtra. . .

Imposta la visibilità del
layer in funzione della
scala. . . ‘

Zoom alla scala di visbil-
ità

Imposta SR →

• Imposta il SR del
Layer/Gruppo. . .

• Imposta il SR del
progetto dal layer

Imposta proprietà WMS
per il Gruppo

Visualizza un solo
gruppo per volta

Seleziona e mostra tutti i
suoi figli (Ctrl-click)

Deseleziona e nascondi
tutti i suoi figli (Ctrl-
click)

Rendi permanente

Esporta →

• Salva Come. . .

• Salva Elementi
Come. . .

• Salva Elementi Se-
lezionati Come. . .

Continued on next page
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Table 11.1 – continued from previous page
Opzione Vettore Layer Raster Gruppo

• Salva come file
di definizione del
layer. . .

• Salva come file di
stile del layer. . .

Stili →

• Copia Stile

• Incolla Stile

• Aggiungi. . .

• Rinomina. . .

Proprietà. . .

Tabella: Menu contestuali degli oggetti nel Layers Panel

Per i layers vettoriali GRASS, Attiva modifiche non è disponibile. Vedi la sezione Digitalizzare e modificare layer
vettoriali GRASS per informazioni su modifiche dei layers vettoriali GRASS.

Interagire con gruppi e layer

I layer presenti nella finestra della legenda possono essere organizzati in gruppi. Ciò può essere fatto in due modi:

1. Premi l’icona per aggiungere un nuovo gruppo. Digita un nome per il gruppo e premi Enter. Ora
clicca su un layer esistente e trascinalo nel gruppo.

2. Seleziona alcuni layer, fai clic con il tasto destro del mouse nella finestra di legenda e scegli Gruppo se-
lezionato. I layer selezionati verranno automaticamente inseriti in un nuovo gruppo.

Per togliere un layer da un gruppo, trascinalo fuori, o fai clic destro su di esso e scegli Muovi fuori dal gruppo: il
layer viene spostato dal gruppo e posizionato sopra di esso. I gruppi possono anche essere annidati all’interno di
altri gruppi. Se un layer è inserito in un gruppo annidato, Muovi fuori dal gruppo sposterà il layer da tutti i gruppi
annidati.

Per spostare un gruppo o un layer nella parte superiore del pannello dei layer, trascinalo nella parte superiore o
scegli Sposta in alto. Se utilizzi questa opzione su un layer annidato in un gruppo, il layer viene spostato verso
l’alto nel suo gruppo corrente.

Puoi usare la casella di controllo di un gruppo per mostrare/nascondere tutti i layer del gruppo con un singolo
click.

Abilitare l’opzione Gruppo Esclusivo significa che ti è possibile rendere visibile in un gruppo un solo layer alla
volta. Ogni volta che un layer all’interno di un gruppo è impostato come visibile, gli altri non saranno visibili.
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Puoi selezionare più di un layer o gruppo allo stesso tempo tenendo premuto il tasto Ctrl mentre fai clic su layer
aggiuntivi. Puoi quindi spostare tutti i layer selezionati in un nuovo gruppo allo stesso tempo.

Puoi anche eliminare più di un layer o gruppo alla volta selezionando diversi elementi con il tasto Ctrl e poi
premendo Ctrl+D: tutti i layer o gruppi selezionati saranno rimossi dalla lista dei layer.

Maggiori informazioni sui layer e sui gruppi utilizzando l’icona indicatore

In alcune circostanze, le icone appaiono accanto al layer o al gruppo nel pannello Layer per dare maggiori infor-
mazioni sul layer/gruppo. Questi simboli sono:

• per indicare che il layer è in modalità di modifica e puoi modificare i dati.

• per indicare che il layer in fase di modifica ha delle modifiche non salvate.

• per indicare a filter applicato al layer. Passa il mouse sull’icona per vedere l’espressione del filtro e fai
doppio clic per aggiornare le impostazioni.

• per identificare un embedded group o layer e il percorso del loro file di progetto originale.

• per ricordarti che il layer è un layer temporary scratch layer e il suo contenuto verrà eliminato quando
si chiude il progetto. Per evitare la perdita di dati e rendere il layer permanente, fai clic sull’icona per
memorizzare il layer in uno qualsiasi dei formati vettoriali OGR supportati da QGIS.

Modificare lo stile dei layer vettoriali

Dal pannello Layer, sono disponibili scorciatoie per cambiare la visualizzazione dei layer in modo rapido e sem-
plice. Clicca con il tasto destro del mouse su un layer vettoriale e seleziona Stile → nella lista per poterlo fare:

• vedi gli styles attualmente applicati al layer. Se sono stati definiti molti stili per il layer, puoi passare da uno
all’altro e la visualizzazione del layer verrà aggiornata automaticamente nell’area di disegno della mappa.

• copia lo stile corrente o, se applicabile, incolla uno stile copiato da un altro layer

• rinomina lo stile corrente, aggiungi un nuovo stile (che in realtà è una copia di quello corrente) o elimina lo
stile corrente (quando sono disponibili più stili).

Nota: Le opzioni precedenti sono disponibili anche per i layer raster.

Sia che gli oggetti del layer vettoriale abbiano tutte lo stesso simbolo unico o siano classificate (nel qual caso il
layer è visualizzato in una struttura ad albero con ogni classificazione come sotto-voce), le seguenti opzioni sono
disponibili a livello di layer o di classificazione:

• Modifica Simbolo. . . . per aprire la finestra di dialogo simbolo-selettore per cambiare qualsiasi proprietà del
layer o del simbolo dell’oggetto (simbolo, dimensione, colore. . . .). Facendo doppio clic su un oggetto si
apre anche la finestra di dialogo Seleziona Simbolo.

• Scelta colore con una Ruota colori da cui puoi fare clic su un colore per aggiornare automaticamente il
colore di riempimento del simbolo. Per comodità, Colori recenti sono disponibili nella parte inferiore della
ruota dei colori.

• Mostra tutti i layer e Nascondi tutti i layer per attivare o disattivare la visibilità di tutte le classi di
oggetti. Questo evita di (de)selezionare gli oggetti uno ad uno.

Suggerimento: Condividere rapidamente lo stile di un layer
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Dal menu contestuale, copia lo stile di un layer e incollalo in un gruppo o una selezione di layer: lo stile viene
applicato a tutti i layer che sono dello stesso tipo (vettore/raster) del layer originale e, per i layer vettoriali, che
hanno lo stesso tipo di geometria (punto, linea o poligono).

11.2.2 Pannello Stile Layer

Il pannello Stile Layer (attivato anche con Ctrl+3) è un collegamento ad alcune delle opzioni della finestra di
dialogo Proprietà Layer. Fornisce un modo semplice e veloce per definire la visualizzazione e il comportamento
di un layer e per visualizzare i suoi effetti senza dover aprire la finestra di dialogo delle proprietà del layer.

Oltre ad evitare la finestra di dialogo delle proprietà di blocco (o «modale») dei layer, il pannello di stile dei layer
evita anche di ingombrare lo schermo con finestre di dialogo e contiene la maggior parte delle opzioni dello stile
(selettore colore, proprietà degli effetti, modifica regole, sostituzione etichette. . . .): ad esempio, facendo clic sui
pulsante colore all’interno del pannello di stile del layer, la finestra di selezione colore viene aperta all’interno del
pannello di stile del layer stesso piuttosto che come finestra di dialogo separata.

Dall’elenco a discesa dei layer presenti nel Pannello Layer, seleziona un elemento e:

• Imposta le proprietà del layer raster Simbologia, Trasparenza, e Proprietà istogramma.
Queste opzioni sono le stesse del Proprietà raster .

• Imposta le proprietà del layer vettoriale Simbologia, Mappa 3D e Etichette. Queste opzioni
sono le stesse del Proprietà dei vettori.

• Gestisci lo stile(i) associato nel Gestore di Stili (maggiori dettagli in Gestione stili personalizzati).

• Vedi lo Storico dei cambiamenti che hai applicato allo stile dei layer nel progetto corrente: puoi quindi
cancellare o ripristinare qualsiasi stato selezionandolo nell’elenco e cliccando su Applica.

Un’altra potente opzione di questo pannello è la casella di controllo Aggiornamento immediato. Spuntala
e le tue modifiche vengono automaticamente visualizzate in modo continuo nella mappa. Non è più necessario
premere il pulsante Applica.

Suggerimento: Aggiungere schede personalizzate al pannello Stile Layer

Usando PyQGIS, puoi impostare nuove schede per gestire le proprietà dei layer nel Pannello Stile Layer. Vedi
https://nathanw.net/2016/06/29/qgis-style-dock-part-2-plugin-panels/ per un esempio.

11.2.3 Pannello Ordine dei Layer

Per impostazione predefinita, i layer mostrati nell’area di disegno della mappa QGIS sono disegnati seguendo il
loro ordine nel pannello Layer: più alto è il layer nel pannello, più alto (quindi, più visibile) sarà nella visualiz-
zazione della mappa.

Puoi definire un ordine di disegno per i layer indipendentemente dall’ordine nel pannello dei layer con il pannello

Layer Order attivato in Visualizza → Pannelli → o con Ctrl+9. Spunta la casella di controllo Controllo
ordine di visualizzazione sotto l’elenco dei layer e riorganizza i layer nel pannello come vuoi. Questo ordine
diventa quello applicato alla visualizzazione della mappa. Per esempio, in figure_layer_layer_order, puoi vedere
che gli oggetti airports vengono visualizzati sul poligono alaska nonostante il rispettivo posizionamento di
quei layer nel pannello Layer.

Deselezionando Controllo ordine di visualizzazione tornerà al comportamento predefinito.
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Figure 11.2: Definizione della simbologia di un layer dal pannello di stile del layer
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Figure 11.3: Definire un ordine dei layer indipendente dalla legenda

11.2.4 Pannello Panoramica

Il pannello Panoramica (Ctrl+8) visualizza una mappa con una vista completa di alcuni dei layer. La mappa
panoramica è riempita con i layer usando l’opzione Mostra nella panoramica dal menu Layer o nel menu contes-
tuale dei layer. All’interno della vista, un rettangolo rosso mostra l’estensione della mappa corrente, aiutandoti a
determinare rapidamente quale area dell’intera mappa state visualizzando. Se clicchi e trascini il rettangolo rosso
nel riquadro panoramico, l’estensione della visualizzazione della mappa principale si aggiornerà di conseguenza.

Da notare che le etichette non vengono visualizzte nella panoramica della mappa anche se i layer utilizzati nella
panoramica della mappa sono stati impostati per l’etichettatura.

11.2.5 Pannello Messaggi di Log

Durante il caricamento o l’elaborazione di alcune operazioni, puoi tracciare e seguire i messaggi che appaiono in

diverse schede utilizzando il Pannello Messaggi di Log. Può essere attivato utilizzando l’icona più a destra
nella barra di stato in basso.

11.2.6 Pannello Annulla/Ripristina

Per ogni layer in fase di modifica, il pannello Annulla/Ripristina (Ctrl+5) mostra l’elenco delle azioni effettuate,
consentendoti di annullare rapidamente un insieme di azioni selezionando l’azione elencata. Maggiori dettagli in
Undo and Redo edits.

11.2.7 Pannello Statistiche

Il pannello Statistiche (Ctrl+6) fornisce informazioni riassuntive su qualsiasi layer vettoriale. Questo pannello
ti permette di selezionare:

• il layer vettoriale su cui calcolare le statistiche
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• la colonna da usare, o una espressione.

• le statistiche da restituire utilizzando il pulsante a discesa in basso a destra della finestra di dialogo. A
seconda del tipo di campo (o dei valori dell’espressione), le statistiche disponibili sono:

Statistiche Stringa Intero Numero reale Data

Conteggio

Conteggio Distinti

Conteggio Mancanti

Somma

Media

Deviazione Standard

Deviazione Standard su un Campione

Valore Minimo

Valore Massimo

Intervallo

Minoranza

Maggioranza

Varietà

Primo Quartile

Terzo Quartile

Scarto interquartile

Lunghezza Minima

Lunghezza Massima

Tabella: Statistiche disponibili per ciascun tipo di campo

Il riepilogo statistico può essere:

• il risultato di tutto il layer o di Solo geometrie selezionate

• ricalcolato usando il pulsante quando i dati cambiano (ad esempio per inserimento di nuovi o elimi-
nazione di oggetti/campi, per modifica degli attributi)

• copiato negli appunti e incollato come tabella in un’altra applicazione.

11.3 Progetti nidificati

A volte, ti piacerebbe mantenere un insieme di layer con lo stesso stile in diversi progetti. Puoi o creare un default
style per questi layer o incorporarli da un altro progetto per risparmiare tempo e fatica.

Layer e Gruppi nidificati da un progetto esistente presenta alcuni vantaggi rispetto alla gestione dello stile:

• Possono essere aggiunti tutti i tipi di layer (vettoriali o raster, locali o online. . . .)

• Nel recupero di gruppi e layers, puoi mantenere la stessa struttura ad albero dei layers di «sfondo» nei tuoi
diversi progetti

• Mentre i layers incorporati sono modificabili, non puoi modificare le loro proprietà come simbologia,
etichette, moduli, valori predefiniti e azioni, garantendo la consistenza in tutti i progetti.

• Modificare gli oggetti nel progetto originale e le modifiche vengono propagate a tutti gli altri progetti.
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Figure 11.4: Mostrare statistiche su un campo
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Se vuoi incorporare il contenuto di file di un altro progetto nel tuo progetto, seleziona Layer -> Includi layer e
gruppi:

1. Clic sul pulsante . . . per cercare un progetto: puoi vedere il contenuto del progetto (vedi fig-
ure_embed_dialog)

2. Premi Ctrl ( o Cmd) e fai click sui layer e sui gruppi che vuoi recuperare.

3. Fai clic su OK

I layer e i gruppi selezionati sono incorporati nel pannello Layer e visualizzati sulla mappa. Un’icona viene
aggiunta accanto al loro nome per il riconoscimento e passandovi sopra viene visualizzato un suggerimento con il
percorso originale del file di progetto.

Figure 11.5: Selezionare layers e gruppi nidificati

Come qualsiasi altro layer, un layer incorporato può essere rimosso dal progetto facendo clic con il tasto destro

del mouse sul layer e scegliendo Elimina layer/gruppo.

Suggerimento: Cambiare la visualizzazione di un layer nidificato

Non è possibile modificare la visualizzazione di un layer nidificato, a meno che non si apportino le modifiche nel
file di progetto originale. Tuttavia, se fai clic con il tasto destro su un layer e selezioni: Duplica si crea un layer
che è completo e non dipende dal progetto originario. Puoi quindi rimuovere in sicurezza il layer collegato.

11.4 Lavorare sulla mappa

11.4.1 Visualizzazione

In modo predefinito, QGIS visualizza tutti i layer visibili ogni volta che la mappa viene aggiornata. La mappa
viene aggiornata ogni volta che:

• aggiungi un layer

• sposti o ingrandisci

• ridimensioni la finestra QGIS

• cambi la visibilità di uno o più layer

QGIS consente di controllare il processo di visualizzazione in diversi modi.

Visualizzazione in funzione della scala

La visualizzazione in funzione della scala permette di specificare la scala minima e massima alla quale il layer
(raster o vettore) verrà visualizzato.. Per impostare la visualizzazione in funzione della scala apri la finestra
Proprietà con un doppio click sul layer in legenda. Nella scheda Visualizzazione, clicca sulla casella di controllo

Visualizzazione dipendente dalla scala e immetti i valori Minimo (escluso) e Massimo (incluso).
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Puoi anche impostare la visualizzazione dipendente dalla scala per un layer dal Pannello Layer. Fai clic con il
tasto destro sul layer e nel menu contestuale seleziona Imposta la scala di visibilità del layer. . . .

Il pulsante Imposta alla scala scala corrente dell’estensione di mappa ti aiuta a usare la scala di rappresentazione corrente della
mappa come limite della visibilità.

Nota: Quando un layer non viene visualizzato nell’area di disegno della mappa a causa della scala della mappa al
di fuori del suo intervallo di visibilità, nel Pannello Layer il file del layer viene oscurato e nel menu di scelta rapida
del layer viene visualizzata una nuova opzione Zoom alla Scala Visibile. Selezionala e la mappa viene ingrandita
sulla scala di visibilità più vicina al limite previsto per il layer.

Controllare la visualizzazione della mappa

Puoi controllare la visualizzazione della mappa in molti modi diversi, come descritto di seguito.

Sospensione della visualizzazione

Per interrompere la visualizzazione, clicca sulla casella di controllo Visualizza in basso a destra della barra di

stato. Quando Visualizza non è spuntata, QGIS non aggiorna la vista quando si verifica uno degli eventi prece-
dentemente descritti nella sezione Visualizzazione. Alcuni casi in cui potresti voler sospendere la visualizzazione
sono:

• aggiunta di molti layer e simbologia predefinita prima della visualizzazione

• aggiunta di uno o più layer di grosse dimensioni e impostazione di una scala prima della visualizzazione

• aggiunta di uno o più layer di grossa dimensione e zoom ad un’area specifica prima della visualizzazione

• ogni combinazione delle opzioni sopracitate

Se la casella di controllo Aggiorna è spuntata, la visualizzazione e l’aggiornamento della mappa saranno
immediati.

Controllare la visibilità dei layer quando sono caricati

Puoi scegliere l’opzione di caricare sempre i nuovi layer senza che questi vengano visualizzati sulla mappa. Ciò
significa che i layer vengono aggiunti alla mappa, ma la loro casella di controllo per la visibilità nella legenda
risulterà disabilitata. Per impostare questa opzione, apri il menu Impostazioni → Opzioni → e clicca sulla scheda

Visualizzazione. Deseleziona la casella di controllo Per impostazione predefinita i nuovi layer aggiunti alla
mappa vengono visualizzati subito. Ogni layer aggiunto alla mappa risulterà essere quindi spento (invisibile).

Fermare la visualizzazione

Per fermare la visualizzazione della mappa primi il tasto ESC. In questo modo l‘aggiornamento della mappa verrà
bloccato e la mappa rimarrà parzialmente disegnata. Dopo aver premuto il tasto ESC potrebbe passare un po‘ di
tempo affinché l‘interruzione della visualizzazione della mappa diventi effettiva.

Nota: Attualmente non si può interrompere la visualizzazione in corso: questa opzione è stata disabilitata nella
porta Qt4 a causa di diversi problemi dell’interfaccia utente (UI).

11.4. Lavorare sulla mappa 101



QGIS User Guide, Release 3.4

Modificare la qualità della visualizzazione

QGIS ha una opzione per modificare la qualità della restituzione nella visualizzazione della mappa. Nel menu

Impostazioni → Opzioni, click sulla scheda Visualizzazione e seleziona o deseleziona Rendi le linee meno
irregolari a spese delle prestazioni.

Velocizzare la visualizzazione

Ci sono alcune opzioni che ti permettono di velocizzare la visualizzazione. Apri la finestra di dialogo di QGIS
Impostazioni → Opzioni, vai alla scheda Visualizzazione e seleziona o deseleziona le seguenti caselle di controllo:

• Usa il caching del disegno quando possibile per velocizzare la visualizzazione

• Visualizza i layer in parallelo usando più processori della CPU e poi imposta Numero massimo di
processori da utilizzare.

• La costruzione della mappa avviene in background su un’immagine separata e ad ogni Intervallo di
aggiornamento della mappa, il contenuto di questa immagine (fuori schermo) verrà utilizzato per aggiornare
la rappresentazione della visualizzazione sullo schermo. Tuttavia, se la costruzione termina più velocemente
di questa durata, la visualizzazione avverrà immediatamente.

• Con Attiva la semplificazione delle geometrie in modo predefinito per i nuovi layer aggiunti, semplifichi
le geometrie (meno nodi) e quindi hai una più veloce visualizzazione. Da tener presente però che potrebbero
essere introdotte incongruenze.

11.4.2 Zoom e Pan

QGIS fornisce strumenti per fare zoom e per spostarti alla tua area di interesse

Oltre all’utilizzo delle icone pan e zoom-in / zoom-out sulla barra degli strumenti con il mouse, la nav-
igazione può essere effettuata anche con la rotellina del mouse, la barra spaziatrice e i tasti freccia. Un Fattore di
zoom può essere impostato in Impostazioni → Ozioni → Strumenti Mappa per definire il comportamento della
scala durante lo zoom.

Con la rotella del mouse

Puoi premere la rotella del mouse per eseguire spostamenti di quanto visualizzato nella finestra principale (in
macOS, devi tenere premuto cmd key). Puoi ruotare la rotellina del mouse per ingrandire o rimpicciolire la
visualizzazione delle mappa; la posizione del cursore del mouse costituirà il centro dell’area di interesse. Tenendo
premuto Ctrl mentre si ruota la rotellina del mouse si ottiene uno zoom più affinato.

Con i tasti freccia

Si può effettuare il Pan sulla mappa con i tasti freccia. Posiziona il cursore del mouse all’interno della zona di
visualizzazione della mappa e poi fai clic sui tasti freccia per spostarti in alto, in basso, a sinistra e a destra.

Puoi anche usare la barra spaziatrice per effettuare spostamenti temporanei sulla mappa. I tasti PgUp e PgDown
sulla tastiera causeranno l’ingrandimento o la riduzione della visualizzazione della mappa rispetto al fattore di
zoom impostato. È inoltre possibile effettuare uno zoom in/out sulla mappa premendo Ctrl++ o Ctrl+-.

Quando alcuni strumenti mappa sono attivi (Informazioni, Misura . . . ), puoi eseguire uno zoom tenendo premuto
Shift e trascinando un rettangolo sulla mappa per ingrandire quell’area. Questa modalità non è attiva per gli
strumenti di selezione (poiché usano Shift per l’aggiunta alla selezione) né per gli strumenti di modifica.
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11.4.3 Segnalibri Spaziali

I segnalibri geospaziali ti permettono di memorizzare una posizione geografica alla quale potrai ritornare in un
secondo momento. Per impostazione predefinita, i segnalibri vengono salvati sul computer, il che significa che
sono disponibili per qualsiasi progetto attivato su tale computer. Se desideri memorizzare il segnalibro nel file di
progetto (.qgs) puoi fare ciò selezionando la casella di controllo Nel Progetto.

Creazione di un segnalibro

Per creare un segnalibro:

1. Usa lo zoom o muovi la mappa all’estensione d’interesse.

2. Seleziona l’opzione di menu Visualizza -> Nuovo segnalibro. . . o premere Ctrl-B. Il pannello Segnalibri
Spaziali si apre con il segnalibro più recente creato.

3. Inserisci un nome descrittivo per il segnalibro (fino a 255 caratteri).

4. Seleziona il campo Nel Progetto se desideri salvare il segnalibro nel file di progetto.

5. Premi Invio per aggiungere il segnalibro o fai clic altrove.

Nota che puoi avere più di un segnalibro con lo stesso nome.

Uso e gestione dei segnalibri

Per utilizzare o gestire i segnalibri, seleziona Visualizza -> Mostra segnalibri o premi Ctrl+7. Il pannello
Pannello Segnalibri Geospaziali ti consente di:

• Zoom a un Segnalibro: seleziona il segnalibro desiderato e poi fai click su Zoom a un Segnalibro. Puoi fare
lo zoom su un segnalibro anche facendo doppio click su di esso.

• Cancellare un Segnalibro: seleziona il segnalibro e fai click su Elimina segnalibro. Conferma la tua scelta.

• Importare o Esportare un segnalibro: per condividere o trasferire i segnalibri tra computers puoi utiliz-
zare Importa/Esporta Segnalibri nel menu a discesa per esportare tutti i segnalibri in un file .xml oppure
importare i segnalibri da un file di questo tipo.

Puoi anche zoomare ai segnalibri salvati digitando il nome del segnalibro in locator.

11.4.4 Decorazioni

Le decorazioni includono Reticolo, Etichetta Copyright, Freccia Nord e Barra di Scala. Sono usate per ‘decorare’
la mappa aggiungendo elementi cartografici.

Reticolo

Reticolo ti permette di aggiungere un reticolo e le coordinata alla mappa.

1. Seleziona Visualizza → Decorazioni → Reticolo per aprire la finestra di dialogo.

2. Attiva la casella di controllo Abilita reticolo e imposta i valori per il reticolo in funzione dei layer caricati
sulla mappa.

3. Attiva la casella di controllo Scrivi annotazioni e imposta le definizioni delle annotazioni in base ai layer
caricati nella mappa.

4. Fai clic su Applica per verificare che appaia come previsto o OK se sei soddisfatto.
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Figure 11.6: Finestra di dialogo Reticolo

Etichetta Copyright

Etichetta Copyright aggiunge un” Etichetta Copyright alla mappa utilizzando il testo da te scelto.

1. Seleziona Visualizza → Decorazioni → Etichetta Copyright per aprire la finestra di dialogo.

Figure 11.7: La finestra di dialogo Copyright

2. Assicurati che Abilita etichetta di copyright sia spuntata.

3. Digita il testo che vuoi aggiungere sulla mappa. Puoi includere espressioni (utilizzando il pulsante Inserisci
una Espressione).

4. Scegli il font per l’etichetta dalla casella combinata Carattere . Imposta il colore e l’opacità del font
cliccando sulla freccia nera a destra della casella combinata Carattere.

5. Scegli il posizionamento dell’etichetta nel menu a tendina Posizione .

6. Puoi affinare la posizione dell’oggetto impostando un margine orizzontale e/o verticale dal bordo Margine
dal bordo. Questi valori possono essere immessi come distanza in Millimetri o Pixels o impostati come
Percentuale della larghezza o altezza dell’area di stampa.

7. Puoi cambiare il colore da applicare

8. Fai clic su Applica per verificare che appaia come previsto o OK se sei soddisfatto.

Nell’esempio sopra riportato, che applica le opzioni di default, QGIS applica il simbolo di copyright QGIS seguito
dalla data nell’angolo in basso a destra della mappa.
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Freccia Nord

Freccia Nord aggiunge una freccia nord sulla mappa, con opzioni per lo stile e il posizionamento.

Per aggiungere una freccia nord:

1. Seleziona Visualizza → Decorazioni → Freccia Nord per aprire la finestra di dialogo.

Figure 11.8: La finestra di dialogo Freccia Nord

2. Assicurati che Abilita Freccia Nord sia spuntata.

3. Opzionalmente cambia il colore e la dimensione, oppure scegli una SVG personalizzata.

4. Opzionalmente cambia l’angolo o scegli Automatico per permettere a QGIS di determinare la direzione.

5. Facoltativamente scegli il posizionamento dalla casella combinata Posizione

6. Facoltativamente perfeziona il posizionamento della freccia impostando un Margine da bordo mappa oriz-
zontale e/o verticale. Questi valori possono essere in Millimetri o Pixel o Percentuale della larghezza o
dell’altezza della mappa.

7. Fai clic su Applica per verificare che appaia come previsto o OK se sei soddisfatto.

Barra di Scala

Barra di scala aggiunge una semplice barra di scala alla mappa. Puoi controllare il posizionamento, lo stile, il
colore e le dimensioni di etichettatura della barra.

QGIS supporta solamente la visualizzazione della scala nella stessa unità di misura della mappa. Così se l’unità
nel SR del tuo progetto è il metro, non potrai creare una barra di scala in piedi. Allo stesso modo, se usi i gradi
decimali, non potrai creare una barra di scala che mostri le distanze in metri.

Per aggiungere una barra di scala:

1. Seleziona Visualizza → Decorazioni → Barra di scala per aprire la finestra di dialogo.

2. Assicurati che Abilita barra di scala sia selezionata

3. Scegli uno stile dal menu a tendina Stile della Barra di scala

4. Seleziona Colore della barra scegliendo un colore di riempimento (predefinito: nero)
e un colore di contorno (predefinito: bianco). Il riempimento della barra di scala e il contorno possono
essere resi opachi cliccando sulla freccia in basso a destra dell’input del colore.
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Figure 11.9: La finestra di dialogo Barra di Scala

5. Seleziona il carattere per la barra della scala dalla casella a scelta multipla Font of bar

6. Specifica la Dimensione della barra .

7. Facoltativamente spunta Arrotonda automaticamente il numero durante il ridimensionamento per visu-
alizzare valori di facile lettura.

8. Scegli la posizione dell’etichetta dal menu a tendina Posizionamento

9. Puoi affinare il posizionamento dell’oggetto impostando un Margine dal bordo orizzontale e/o verticale.
Questi valori possono essere in Millimetri o Pixel oppure impostati come Percentuale della larghezza o
altezza della mappa.

10. Fai clic su Applica per verificare che appaia come previsto o OK se sei soddisfatto.

Estensione del Layout

Estensioni di layout aggiunge le estensioni di map item(s) nel layout di stampa. Quando abilitato, le estensioni di
tutti gli oggetti della mappa all’interno di tutti i layout di stampa sono mostrati utilizzando un bordo leggermente
punteggiato etichettato con il nome del layout di stampa e dell’oggetto della mappa. Puoi controllare lo stile e
l’etichettatura degli oggetti del layout visualizzato. Questa decorazione è utile quando stai modificando il po-
sizionamento di oggetti della mappa, come le etichette, e hai bisogno di conoscere l’effettiva regione visibile dei
layout di stampa.

Per aggiunge l’estensione(i) del Layout:

1. Seleziona Visualizza → Decorazioni → Estensione del Layout per aprire la finestra di dialogo.

2. Assicurati che Mostra estensioni del Layout sia spuntata.

3. Facoltativamente cambia il simbolo e l’etichettatura delle estensioni

4. Fai clic su Applica per verificare che appaia come previsto e OK se sei soddisfatto.

Suggerimento: Impostazioni Decorazioni
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Figure 11.10: Esempio estensioni layout visualizzati in un progetto QGIS con due layout di stampa. Il layout di
stampa denominato “Sights” contiene due oggetti nella mappa, mentre l’altro layout di stampa contiene un oggetto
nella mappa.

Figure 11.11: Finestra di dialogo estensione Layout
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Quando salvi un file di progetto QGIS, tutte le modifiche apportate a Reticolo, Freccia Nord, Barra di scala,
Copyright ed Estensioni di layout verranno salvate nel progetto e ripristinate la prossima volta che carichi il
progetto.

11.4.5 Note testuali

Le annotazioni sono informazioni aggiunte all’area di disegno della mappa e mostrate all’interno di un fumetto.
Queste informazioni possono essere di diversi tipi e le annotazioni vengono aggiunte utilizzando gli strumenti
corrispondenti nella barra degli strumenti Barra degli strumenti relativa agli Attributi:

• Nota Testuale per testo formattato personalizzato

• Nota HTML per posizionare il contenuto di un file html

• Nota SVG per aggiungere un simbolo SVG.

• Nota con Modulo: utile per visualizzare gli attributi di un layer vettoriale in un file ui personalizzato (vedi
figure_custom_annotation). Questo è simile ai moduli personalizzati attributo custom form, ma visualiz-
zato in una annotazione. Vedi anche questo video https://youtu.be/0pDBuSbQ02o?t=2m25s=2m25s da Tim
Sutton per maggiori informazioni.

Figure 11.12: Modulo personalizzato annotazione Qt Designer

Per aggiungere un’annotazione, seleziona lo strumento corrispondente e fai clic sull’area di disegno della mappa.
Viene aggiunto un fumetto vuoto. Fai doppio clic su di esso e si apre una finestra di dialogo con varie opzioni.
Questa finestra di dialogo è quasi la stessa per tutti i tipi di annotazione:

• Nella parte superiore, un selettore di file da riempire con il percorso di un html, svg o ui a seconda
del tipo di annotazione. Per l’annotazione di testo, puoi inserire il tuo messaggio in una casella di testo e
impostarne la visualizzazione con i normali strumenti per i font.

• Marcatore sulla mappa: quando non spuntato, il posizionamento del fumetto si basa su una posizione
sullo schermo (invece che sulla mappa), il che significa che viene sempre mostrato indipendentemente
dall’estensione della visualizzazione mappa.

• Layer collegato: associa l’annotazione ad un layer della mappa, rendendola visibile solo quando quel layer
è visibile.
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• Simbolo della mappa: usando simboli QGIS, imposta il simbolo da visualizzare nella posizione di ancorag-
gio del fumetto (mostrato solo quando viene scelto Marcatore sulla mappa).

• Stile cornice: imposta il colore di sfondo della cornice, la trasparenza, il colore del tratto o la larghezza del
fuetto utilizzando i simboli QGIS.

• Contents margins: imposta i margini interni della cornice dell’annotazione.

Figure 11.13: Finestra di dialogo Note testuali

Le annotazioni possono essere selezionate quando è abilitato uno strumento di annotazione. Possono poi essere
spostate in base alla posizione della mappa (trascinando il marcatore della mappa) o spostando solo il fumetto. Lo

strumento Move Annotation permette anche di spostare il fumetto sulla mappa.

Per cancellare un’annotazione, selezionala e premi il pulsante Del o Backspace, oppure fai doppio clic su di
essa e premi il pulsante Cancella nella finestra di dialogo delle proprietà.

Nota: Se premi Ctrl+T mentre è attivo lo strumento Nota (sposta annotazione, annotazione del testo, anno-
tazione del modulo), gli stati di visibilità degli oggetti sono invertiti.

Suggerimento: Layout mappa con annotazioni

Puoi stampare o esportare le annotazioni con la tua mappa in vari formati utilizzando:

• strumenti per l’esportazione delle rappresentazioni cartografiche disponibili nel menu Project

• stampa il layout, nel qual caso devi selezionare Disegna gli oggetti della mappa nelle corrispondenti pro-
prietà degli oggetti della mappa

11.4.6 Misurazioni

Informazioni generali

QGIS effettua misure delle geometrie vettoriali in quattro modi:

• tramite gli strumenti di misura interattiva ,

• tramite formule generate con il Calcolatore di campi,

• misure generate con lo strumento Informazione Elementi,
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• e tramite funzioni di analisi vettoriale: Vettore → Strumenti di geometria → Esporta/Aggiungi colonne
geometriche . . .

La misurazione opera nei sistemi di coordinate proiettate piane (ad esempio UTM) e con coordinate geografiche.
I primi tre metodi di misura si comportano nello stesso modo con riferimento ai settaggi globali di proiezione.

• A differenza della maggior parte degli altri GIS, la metrica di misura predefinita è ellissoidale, utilizzando
l’ellissoide definito in Progetto → Proprietà. . . .. → Generale. . . .. Questo è vero sia quando per il progetto
vengono definiti i sistemi di coordinate geografiche che i sistemi di coordinate proiettate.

• Se vuoi calcolare l’area o la distanza proiettata/planimetrica utilizzando la matematica cartesiana,
l’ellissoide di misura deve essere impostato «None / Planimetric» (Progetto → Proprietà del progetto →
Generale). Tuttavia, con un SR geografico (= unprojected) definito per dati e progetti, le misure di are e di
distanze saranno ellissoidali.

Comunque, sia le misure ottenute tramite le formule generate con il Calcolatore di campi che le misure che
derivano dalla funzione Informazioni elementi non trasformano i dati per il SR del progetto prima della mis-
urazione. Se si vuole raggiungere questo obiettivo è necessario utilizzare lo strumento di analisi Vettoriale Vettore
→ Geometria strumenti → Esporta/Aggiungi colonne geometriche. Qui, la misura è di default planimetrica, tranne
se si sceglie di misurare con quella ellissoidale.

Misurare lunghezze, aree ed angoli in modo interattivo

Per iniziare le misurazioni fai clic sull’icona nella barra degli strumenti Attributo. La freccia rivolta verso il

basso vicino all’icona ti aiuta a passare al pratico strumento per misurare lunghezza, area o angolo.
L’unità predefinita utilizzata nella finestra di dialogo è quella impostata nel menu Progetto → Proprietà Progetto
→ Generale.

Nota: Configurazione dello strumento di misura

Mentre stai misurando la lunghezza o l’area, fai clic sul pulsante Configurazione nella parte inferiore del widget
che apre il menu Impostazioni → Opzioni → Strumenti mappa dove puoi scegliere il colore dell’elastico, la pre-
cisione delle misurazioni e il settaggio delle unità di misura. Puoi anche scegliere le unità di misura o degli angoli
che preferisci, ma tieni presente che tali valori vengono sostituiti nel progetto corrente dalle opzioni effettuate in
Progetto → Proprietà Progetto → Generale.

Tutti gli strumenti di misurazione utilizzano le impostazioni di aggancio dal modulo di digitalizzazione (vedi la
sezione Impostare la Tolleranza dello Snapping e il raggio di ricerca degli elementi). Quindi, se vuoi misurare
esattamente lungo una geometria lineare o una geometria poligonale devi prima definire la tolleranza di aggancio
e poi selezionare il vettore. In questo modo, quando vengono usati gli strumenti di misura, ogni click del mouse
(all’interno della tolleranza definita) si aggancerà a quel punto del layer.

Per default, Misura linea: QGIS misura la reale distanza reale tra due punti in funzione di uno specifico ellissoide.
Questo strumento ti permette di cliccare i punti sulla mappa. La misura di ogni segmento verrà mostrata nella
finestra dello strumento insieme alla misura totale. Per terminare la misura clicca con il tasto destro del mouse.

Nota che puoi utilizzare l’elenco a discesa vicino al totale per modificare interattivamente le unità di misura
mentre stai lavorando con lo strumento di misura (“Metri”, “Chilometri”, “Piedi”, “Yards”, “Miglia”, “Miglia
nautiche”, “Centimetri”, “Millimetri”, “Gradi”, “Unità mappa”). Questa unità viene mantenuta per il widget fino
alla creazione di un nuovo progetto o all’apertura di un altro progetto.

La sezione Info nella finestra di dialogo spiega come vengono effettuati i calcoli in base alle impostazioni SR
disponibili.

Misura area: Anche le aree possono essere misurate. Nella finestra di misura, viene visualizzata la dimen-
sione dell’area cumulativa. Fai clic con il pulsante destro per interrompere la misura. È disponibile anche la
sezione Info e la possibilità di passare da una unità di misura ad un’altra (“Metri quadri”, “Chilometri quadrati”,
“Piedi quadrati”, “Miglia quadrate”, “Ettari”, “Acri”, “Cmetri quadrati”, “millimetri quadrati”, “Miglia nautiche
quadrate”, “Gradi quadrati”, “Unità di mappa”).
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Figure 11.14: Misurare Distanza

Figure 11.15: Misurare Area

Misura angolo: Puoi anche misurare gli angoli. Il cursore diventa a forma di croce. Fai clic per disegnare il primo
segmento dell’angolo che vuoi misurare, quindi sposta il cursore per disegnare l’angolo desiderato. La misura
viene visualizzata in una finestra di dialogo a comparsa.

Figure 11.16: Misurare Angolo

11.5 Interagire con gli elementi

11.5.1 Selezionare elementi

QGIS fornisce diversi strumenti per selezionare geometrie nell’area di disegno della mappa. Gli strumenti di
selezione sono disponibili nel menu Visualizza → Seleziona o nella Barra degli strumenti relativa agli attributi.

Nota: Gli strumenti di selezione funzionano con il layer correntemente attivo.

Selezione manuale nell’area della mappa

Per selezionare una o più geometrie con il mouse, è possibile utilizzare uno dei seguenti strumenti:

• Seleziona Elementi con un rettangolo o con un singolo click

• Seleziona Elementi con un Poligono

• Seleziona Elementi a Mano Libera
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• Seleziona Elementi con un Cerchio

Nota: Tranne lo strumento Seleziona geometrie con un poligono questi strumenti di selezione manuale ti permettono di
selezionare una(più) geometria(e) rappresentata(e) in mappa con un solo click.

Nota: Utilizza lo strumento Seleziona geometrie con un poligono per utilizzare un poligono esistente per selezionare
geometrie sovrapposte. Clicca con il tasto destro del mouse sul poligono e sceglielo dal menu contestuale che
mostra una lista di tutti i poligoni che contengono il punto cliccato. Vengono selezionate tutte le geometrie in
sovrapposizione del layero attivo.

Mentre si utilizza lo strumento Seleziona geometria(e), tenendo premuto Shift or Ctrl si commuta la
selezione della geometria (ad esempio, si aggiunge alla selezione corrente o si rimuove da essa).

Per gli altri strumenti, è possibile eseguire diversi comportamenti tenendo premuto:

• Shift: aggiungi elementi alla selezione corrente

• Ctrl: sottrae elementi dalla selezione corrente

• Ctrl + Shift: intersezione con la selezione corrente, ad esempio si mantengono solo le geometrie
sovrapposte dalla selezione corrente

• Alt: seleziona le geometrie che sono totalmente all’interno della forma della selezione. Combinato con i
tasti Shift o Ctrl, puoi aggiungere o sottrarre geometrie alla/dalla selezione corrente.

Selezione automatica

Gli altri strumenti di selezione, disponibili anche dalla Attribute table, eseguono una selezione in base all’attributo
della geometria o al suo stato di selezione (nota che la tabella degli attributi e la visualizzazione mappa mostrano
le stesse informazioni, quindi se selezioni una geometria nella tabella degli attributi, sarà selezionata anche nella
mappa):

• Seleziona con espressione. . . consente di selezionare geometrie tramite una finestra di dialogo.

• Seleziona Elementi per Valore. . . o premi F3

• Deseleziona tutto o premi Ctrl+Shift+A per deselezionare tutte le geometrie in tutti i layer.

• Seleziona tutte le geometrie o premi Ctrl+A per selezionare tutte le geometrie del layer corrente.

• Inverti la selezione delle geometrie per invertire la selezione nel layer corrente.

Ad esempio, se vuoi trovare le regioni che in regions.shp dei dati di esempio QGIS sono Borough, puoi usare

l’icona Seleziona con espressione. . . . Quindi, apri il menu Campi e valori e scegli il campo che vuoi interrogare.
Doppio clic sul campo “TYPE_2” e poi ancora clic Valori univoci nel pannello che appare. Nell’elenco, scegli e
fai doppio click su “Borough”. Nel campo Espressione, dovrai poi scrivere la seguente query:

"TYPE_2" = 'Borough'

Dalla finestra di dialogo del generatore di espressioni, per effettuare una selezione che hai usato prima è anche
possibile utilizzare Cerca → Recente (Selection). La finestra di dialogo ricorda le ultime 20 espressioni utilizzate
Vedi sezione Espressioni per ulteriori informazioni e qualche esempio.

Suggerimento: Salva la selezione in un nuovo file
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Gli utenti possono salvare le geometrie selezionate in un Nuovo layer temporaneo Scratch o in un Nuovo layer
Vettoriale utilizzando il menu Modifica → Copia geometrie e Modifica → Incolla geometrie come nel formato
desiderato.

Seleziona Elementi per Valore. . .

Questo strumento di selezione apre il modulo geometria del layer che consente all’utente di scegliere, per ciascun
campo, quale valore cercare, se la ricerca deve essere sensibile al maiuscolo e al minuscolo e l’operatore da
utilizzare. Lo strumento effettua anche l’autocompletamento, riempiendo automaticamente la casella di ricerca
con i valori esistenti.

Figure 11.17: Filtro/Selezione elementi tramite finestra di dialogo

A fianco di ciascun campo c’è un menu a discesa con le opzioni degli operatori da utilizzare per la ricerca.
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Opzioni di ricerca sui campi Stringa Numerico Data

Escludi Campo dalla ricerca

Uguale a (=)

Non uguale a ()

Maggiore di (>)

Minore di (<)

Più grande o uguale a ()

Più piccolo o uguale a ()

Compreso fra (inclusivo)

Non compreso tra (inclusivo)

Contiene

Non contiene

Senza valore (null)

Non è senza valore (not null)

Inizia con

Termina con

Per il confronto tra stringhe, è anche possibile utilizzare l’opzione Case sensitive.

Dopo aver impostato tutte le opzioni di ricerca, fai clic su Seleziona elementi per selezionare le geometrie cor-
rispondenti. Le opzioni nel menu a discesa sono:

• Seleziona elementi

• Aggiungi alla selezione attuale

• Filtra la selezione attuale

• Rimuovi dalla selezione attuale

Puoi anche annullare tutte le opzioni di ricerca con il pulsante Ripristina modulo.

Una volta impostate le condizioni, puoi anche:

• Zoom alle geometrie sulla mappa senza la necessità di una preselezione.

• Lampeggia elementi, evidenziando le geometrie corrispondenti. Questo è un modo pratico per identificare
una geometria senza fare una selezione o utilizzare lo strumento Identifica. Si noti che il flash non cambia
l’estensione della mappa e sarà visibile solo se la geometria si trova entro i limiti della visualizzazione
corrente della mappa.

11.5.2 Informazione Elementi

Lo strumento Informazione elementi ti permette di interagire con la mappa e ottenere informazioni sulle caratter-
istiche delle geometrie in una finestra pop-up. Per avere informazione sulle geometrie usa:

• Visualizza → Informazioni elementi

• Ctrl+Shift+I (o Cmd+Shift+I),

• Informazioni elementi sulla barra degli Attributi
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Usare lo strumento Informazione geometrie

QGIS offre diversi modi per avere informazioni sulle geometrie con lo strumento Informazioni elementi :

• click sinistro identifica le geometrie in base alla modalità di selezione selection mode e la impostazione
selection mask nel pannello Informazioni Risultati.

• clic destro con Informazione Elementi con impostato selection mode nel pannello Informazioni Risultati
trova tutte le geometrie rilevate da tutti i layeri visibili. Questo apre un menu contestuale, permettendo
all’utente di scegliere più precisamente le geometrie da identificare o l’azione da eseguire su di esse.

• click destro con Seleziona Elementi con un Poligono con selection mode nel pannello Informazioni Risul-
tati identifica le geometrie che si sovrappongono al poligono esistente scelto, in accordo all’impostazione
ref:selection mask <identify_selection> nel pannello Informazioni Risultati.

Suggerimento: Filtra i layer su cui effettuare una query con lo strumento Informazioni Elementi

Sotto Capabilities dei Layer in Progetto → Proprietà. . . .. → Sorgenti Dati, deselezionare la colonna Interroga-

bile accanto a un layer per evitare che venga interrogato quando si usa lo strumento Informazioni Elementi in una
modalità diversa da Layer in uso. Questo è un modo pratico per restituire le geometrie dai soli layer che sono di
tuo interesse.

Se fai click su una o più geometrie, la finestra di dialogo Informazioni risultati elenca le informazioni sulle
geometrie selezionate. La vista predefinita è una vista ad albero in cui il primo elemento è il nome del layer
e i suoi figli sono le sue geometrie identificate. Ogni geometria è descritta dal nome di un campo insieme al suo
valore. Questo campo è quello impostato in Proprietà vettore -> Visualizzato come. Quindi seguono tutte le altre
informazioni sulla geometria.

Informazioni sulle geometrie

La finestra di dialogo Informazioni risultati può essere personalizzata in modo da visualizzare determinati campi,
ma in modo predefinito vengono mostrati le seguenti informazioni:

• Il display name della geometria;

• Azioni: le azioni possono essere aggiunte alle finestre delle identificazione delle geometrie. Le azioni
si visualizzano facendo click sull’etichetta azione. Per impostazione predefinita, viene aggiunta una sola
azione, vale a dire Modulo vista geometrica per effettuare modifiche. Puoi definire più azioni
nella finestra di dialogo delle proprietà del layer (vedi Proprietà Azioni).

• Derivato: questa informazione viene calcolata o derivata da altre informazioni. Include:

– informazioni generali sulla geometria dell’elemento:

* a seconda del tipo di geometria, le misure cartesiane di lunghezza, perimetro o area nelle unità
del SR del layer.

* a seconda del tipo di geometria e se nella finestra di dialogo delle proprietà del progetto è im-
postato un ellissoide per Misure, i valori ellissoidali di lunghezza, perimetro o area utilizzando le
unità specificate.

* il conteggio delle geometrie e il numero della geometria cliccata

* il numero di vertici nell’elemento

– informazioni sulle coordinate, utilizzando le impostazioni Visualizzazione Coordinate nelle proprietà
del progetto:

* coordinate X e Y del punto cliccato

* il numero del vertice più vicino al punto cliccato

* coordinate X e Y del vertice più vicino (e Z`/`M se applicabile)
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* se fai clic su un tratto curvo, viene visualizzato anche il raggio di tale parte.

• Attributi dei dati: questo è l’elenco dei campi e dei valori degli attributi per la geometria su cui è stato
fatto click.

Nota: I collegamenti negli attributi della geometria sono selezionabili dal pannello Informazioni Risultati e si
apriranno nel tuo browser Web predefinito.

Figure 11.18: Finestra di dialogo Informazioni risultati

La finestra di dialogo Informazioni risultati

Nella parte superiore della finestra, hai una serie di strumenti:

• Apri Modulo della geometria corrente

• Espandi albero

• Collassa albero

• Comportamento per definire se le informazioni sulle successiva geometria selezionata dovranno essere com-
presse o espanse

• Cancella risultati

• Copia geometrie selezionate negli appunti

• Stampa il responso HTML selezionato

• scelta modalità da utilizzare per cercare le geometrie da identificare:

– Seleziona Elementi con un rettangolo o con un singolo clic

– Seleziona Elementi con un Poligono

– Seleziona Elementi a Mano Libera

– Seleziona Elementi con un Cerchio

Nota: Quando usi Seleziona Elementi con un Poligono, puoi fare clic con il tasto destro del mouse su qualsiasi
poligono esistente e usarlo per identificare le geometrie sovrapposte in un altro layer.
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Nella parte inferiore della finestra trovi i menu a tendina Modalità e Vista. Con la casella di controllo Modalità
puoi definire per quali layer devono essere identificate le geometrie:

• Layer in uso : solo le geometrie del layer selezionato vengono identificate. Il layer può non essere visibile
sulla mappa.

• Il primo attivo: per le sole geometrie del layer visibile in alto.

• Tutti i livelli: per tutte le geometrie dei layers visibili. I risultati vengono mostrati nel pannello.

• Selezione layer: apre un menu contestuale dove l’utente seleziona il layer per il quale vuole identificare
le geometrie, in modo simile a un clic con il tasto destro del mouse. Solo le geometrie scelte verranno
visualizzate nel pannello dei risultati.

La Visualizzazione può essere impostata a Albero, Tabella o Grafica. Le visualizzazioni “Tabella” e “Grafica”
possono essere impostate solo per i layer raster.

Lo strumento di identificazione ti permette di Apri modulo. Se selezionato, ogni volta che viene identificata
una singola geometria, si apre un modulo che mostra i suoi attributi. Questo è un modo pratico per modificare
rapidamente gli attributi di una geometria.

Puoi trovare altre opzioni nel menu contestuale dell’elemento identificato. Per esempio, dal menu contestuale
puoi:

• Visualizzare il modulo dell’elemento

• Zoom all’elemento

• Copiare elementi: Copiare tutte le geometrie del’elemento e gli attributi

• Attiva selezione geometria: aggiunge le geometrie identificate alla selezione

• Copiare un valore di un attributo: copiare solo il valore dell’attributo identificato

• Copia attributi geometria: copia gli attributi della geometria

• Cancellare risultati: verranno cancellati i risultati nella finestra

• Cancellare evidenziati: verranno cancellate le geometrie evidenziate sulla mappa

• Evidenziare tutto

• Evidenziare vettore

• Attivare un vettore: scegliere un vettore che deve essere attivato

• Proprietà del vettore: aprire la finestra delle proprietà del vettore

• Espandi tutto

• Racchiudi tutto

11.6 Salvare e condividere le proprietà di un layer

11.6.1 Gestione stili personalizzati

Quando un layer vettoriale viene aggiunto alla mappa, QGIS utilizza per default un simbolo/colore casuale per
visualizzare le sue caratteristiche. Tuttavia, è possibile impostare un simbolo predefinito in Progetto → Proprietà
progetto → Stili predefiniti che verranno applicati a ogni nuovo layer aggiunto in base al tipo di geometria.

Nella maggior parte dei casi, preferisti piuttosto avere uno stile personalizzato e più complesso da applicare
automaticamente o manualmente (con meno sforzo) ai layer. Puoi raggiungere questo obiettivo usando il menu
Stile in basso nella finestra di dialogo Proprietà Layer. Questo menu ti fornisce le opzioni per creare, caricare e
gestire stili.

Uno stile memorizza le diverse informazioni nella finestra di dialogo delle proprietà del layer per la visualizzazione
o l’interazione con le geometrie (incluse le impostazioni di simbologia, etichettatura, azione, diagramma . . . ) per
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i layer di tipo vettoriale o i pixel (rappresentazione di banda o colore, trasparenza, piramidi, istogramma . . . ) per
i layer di tipo raster.

Figure 11.19: Opzioni di gestione dello stile in un vettore

Per default, lo stile applicato a un layer caricato è denominato Predefinito. Una volta ottenuta la visualiz-

zazione appropriata per il tuo layer, puoi salvarla facendo clic su Stile nel menu a tendina e scegliere:

• Rinomina l’elemento corrente. . . : Lo stile attivo viene rinominato e aggiornato con le opzioni correnti

• Aggiungi. . . . . . : Viene creato un nuovo stile utilizzando le opzioni correnti. Per impostazione predefinita,
verrà salvato nel file di progetto QGIS. Vedere in seguito come salvare lo stile in un altro file o in un database

• Rimuovi l’elemento corrente. . . : elimina lo stile corrente indesiderato, nel caso tu avessi definito più di
uno sytile per il layer.

Nella parte inferiore dell’elenco a discesa dello Stile, puoi vedere gli stili impostati per il layer con quello attivo
selezionato.

Nota che ogni volta che convalidi la finestra di dialogo delle proprietà del layer, lo stile attivo viene aggiornato
con le modifiche che hai apportato.

Puoi creare più stili per un layer, ma solo uno alla volta può essere attivo. Combinato con Map Themes, questo
offre un modo rapido e potente per gestire progetti complessi senza che tu debba duplicare alcun layer nella
legenda della mappa.

Nota: Dato che ogni volta che applichi modifiche alle proprietà del layer, le modifiche vengono memorizzate
nello stile attivo, assicuratii sempre di aver modificato lo stile giusto per evitare di alterare erroneamente uno stile
utilizzato in un map theme.

Suggerimento: Gestire gli stili dal menu contestuale del layer

Fai clic con il pulsante destro del mouse sul layer in Panello Layer per aggiungere, rinominare o rimuovere lo stile
del layer.
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11.6.2 Salvare gli stili in un File o in un Database

Mentre gli stili creati dalla casella combinata Stile sono salvati di default all’interno del progetto e possono essere
copiati e incollati da un layer all’altro nel progetto, è anche possibile salvarli all’esterno del progetto in modo che
possano essere caricati in un altro progetto.

Salvare come file di testo

Cliccando Stile → Salva stile, puoi salvare lo stile come:

• QGIS file di stile del layer (.qml)

• file SLD (.sld), formato disponibile solo per layer vettoriali.

Utilizzato su layers di formattazione basati su file (.shp, .tab. . . ), Salva come predefinito genera un .qml
collegato al vettore (con lo stesso nome). I file SLD possono essere esportati da qualsiasi tipo di visualizzazione -
singolo simbolo, suddiviso in categorie, graduato o basato su regole - ma quando si importa un SLD viene creato
un singolo simbolo o una visualizzazione basata su regole. Ciò significa che gli stili classificati o graduati vengono
convertiti in regole. Se vuoi conservare queste visualizzazioni, devi attenerti al formato QML. D’altra parte, può
a volte essere molto utile avere questo modo semplice di convertire gli stili basati su regole.

Salvare in un database

Lo stile di un layer vettoriale può anche essere memorizzato in un database se l’origine dati del layer proviene
da un database. I formati supportati sono PostGIS, GeoPackage, SpatiaLite, MSSQL e Oracle. Lo stile del layer
viene salvato all’interno di una tabella (denominata layer_styles) del database. Fai click su Salva stile →
Salva nel database, quindi compila la finestra di dialogo per definire un nome di stile, aggiungi una descrizione,
un file .ui se applicabile e verifica se lo stile deve essere lo stile predefinito.

Puoi salvare diversi stili in una singola tabella nel database. Tuttavia, ogni tabella può avere solo uno stile pre-
definito. Lo stile predefinito può essere salvato nel database dei layers o nel database locale QGIS, il database
SQLite nella cartella ~/.qgis2/ (dove QGIS memorizza le impostazioni locali).

Figure 11.20: Salvare lo stile nella finestra di dialogo database

Suggerimento: Condivisione di file di stile tra database

Puoi salvare il tuo stile in un database solo se il layer proviene da tale database. Non puoi combinare database (ad
esempio layer in Oracle e stile in MSSQL). Usa invece un file di testo normale se vuoi che lo stile sia condiviso
tra i database.
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Nota: Puoi riscontrare problemi per ripristinare la tabella Stili layer da un backup del database Post-
greSQL. Vedi Stili di default dei layer QGIS e backup del database per risolvere il problema.

Carica lo stile

Quando si carica un layer in QGIS, se esiste già uno stile predefinito per questo layer, QGIS carica il layer con
questo stile. Inoltre Stile → Ripristina predefinito cerca e carica quel file quando premuto, sostituendo lo stile
corrente del layer.

Il Stile → Carica stile ti aiuta ad applicare qualsiasi stile salvato ad un layer. Mentre lo stile di file di testo semplice
(.sld o .qml) può essere applicato a qualsiasi layer indipendentemente dal suo formato, il caricamento degli
stili memorizzati nel database è possibile solo se il layer proviene dallo stesso database o lo stile è memorizzato
nel database locale di QGIS.

La finestra di dialogo Load Style from Database visualizza un elenco di stili correlati al layer trovato nel database
e tutti gli altri stili salvati in esso, con il nome e la descrizione.

Suggerimento: Condividere rapidamente uno stile di layer all’interno del progetto

Puoi anche condividere lo stile dei layers all’interno di un progetto senza importare uno stile da file o da database:
fai click con il pulsante destro del mouse su Layers Panel e dal menu a tendina Stili copia lo stile di un layer e
incollalo in un gruppo o in una selezione di layers: lo stile è applicato a tutti i layers dello stesso tipo (vettore
o raster) del layer originale e, in caso di vettore, quelli che hanno lo stesso tipo di geometria (punto, linea o
poligono).

11.6.3 File di definizione Layer

Le definizioni dei layer possono essere salvate come Layer Definition File` (.qlr) usando Export →
Save As Layer Definition File. . . . nel menu contestuale dei layer attivi. Un file di definizione dei layer (.qlr)
include riferimenti alla fonte dati dei layer e ai loro stili. I file .qlr sono mostrati nel Pannello Browser e possono
essere usati per aggiungere i layer (con lo stile salvato) al Pannello Layer. Puoi anche trascinare e rilasciare il file
.qlr dal file manager di sistema nell’area della mappa.

11.7 Memorizzazione valori nelle Variabili

In QGIS, puoi utilizzare le variabili per memorizzare dati utili con valori ricorrenti (ad esempio il titolo del progetto
o il nome completo dell’utente) che possono essere utilizzati nelle espressioni. Le variabili possono essere definite
a livello globale dell’applicazione, a livello di progetto, a livello di layer, a livello di layout e a livello di oggetto del
layout. Proprio come le regole CSS a cascata, le variabili possono essere sovrascritte, ad esempio una variabile a
livello di progetto sovrascrive le variabili di livello globale di qualsiasi applicazione impostate con lo stesso nome.
Puoi utilizzare queste variabili per creare stringhe di testo o altre espressioni personalizzate utilizzando il carattere
@ prima del nome della variabile. Ad esempio, nel layout di stampa creando un’etichetta con questo contenuto:

This map was made using QGIS [% @qgis_version %]. The project file for this
map is: [% @project_path %]

Visualizzerà l’etichetta in questo modo:

This map was made using QGIS 3.4.4-Madeira. The project file for this map is:
/gis/qgis-user-conference-2019.qgs

Oltre alle variabili di sola lettura preimpostate, puoi definire tue variabili personalizzate per ciascuno dei livelli
sopra menzionati. Puoi gestire:
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• variabili globali dal menu Impostazioni → Opzioni

• variabili di progetto dalla finestra di dialogo Proprietà del progetto (vedi Proprietà progetto);

• variabili di layer vettoriali dalla finestra di dialogo Proprietà vettore (vedi Proprietà dei vettori);

• variabili del compositore dal pannello Compositore nel compositore di stampa (vedi Il Pannello Layout);

• e variabili di oggetti del compositore dal pannello Proprietà oggetto nel compositore di stampa (vedi
Opzioni comuni degli Oggetti del Layout).

Per differenziarsi dalle variabili modificabili, i nomi e i valori delle variabili in sola lettura sono enfatizzati in
corsivo. Peraltro le variabili di livello più elevato sovrascritte da quelle di livello inferiore vengono cancellate.

Figure 11.21: Gestione variabili a livello di progetto

Nota: Puoi leggere di più sulle variabili e trovare alcuni esempi in Nyall Dawson’s Exploring variables in QGIS
2.12, part 1, part 2 e part 3 blog posts.
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11.8 Autenticazione

QGIS ha la possibilità di archiviare/recuperare le credenziali di autenticazione in modo sicuro. Gli utenti possono
salvare in modo sicuro le credenziali nelle configurazioni di autenticazione, che sono memorizzate in un database
portatile, possono essere applicate a connessioni di server o database e referenziate in modo sicuro con i propri
token ID nei file di progetto o delle impostazioni. Per maggiori informazioni vedi Authentication System.

Una password master deve essere impostata durante l’inizializzazione del sistema di autenticazione e del relativo
database portatile.

11.9 Widget comuni

In QGIS, ci sono alcune opzioni con cui dovrai spesso lavorare. Per comodità, QGIS ti fornisce widget speciali
che sono di seguito presentati.

11.9.1 Scelta colore

La finestra di dialogo colore

La finestra di dialogo Colori apparirà ogni volta che premi l’icona per scegliere un colore.
Le caratteristiche di questa finestra di dialogo dipendono dallo stato della casella di controllo Usa le finestre di
dialogo native della selezione del colore nel menu Impostazioni → Opzioni → Generale. Se selezionato, la finestra
di dialogo del colore utilizzata è quella del sistema operativo in uso. In caso contrario, QGIS usa il selettore di
colori personalizzato.

La finestra di dialogo del selettore del colore personalizzato ha quattro diverse schede che consentono di se-

lezionare i colori tramite Scala di colori, Ruota di colori, Campioni di colore o Selettore del colore. Con le prime
due schede, è possibile sfogliare tutte le possibili combinazioni di colori e applicare la propria scelta all’elemento.

Figure 11.22: Scheda selezione scala dei colori

Nella scheda Campioni di colore, puoi scegliere da un elenco di tavolozze di colori (vedi Impostazioni colori

per i dettagli). Tutta la tavolozza Colori recenti può essere modificata con il Aggiungi colore corrente e
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Rimuovi il colore selezionato nella parte inferiore della cornice.

Anche il pulsante . . . . accanto alla casella al menu a tendina tavolozza offre diverse opzioni:

• copia, incolla, importa o esporta colori

• crea, importa o rimuovi le tavolozze di colori

• aggiungi la tavolozza personalizzata al widget del selettore colori con la voce Mostra Pulsanti colore (vedi
figure_color_selector_selector)

Figure 11.23: Scheda Selettore del colore

Un’altra opzione è usare il Selettore del colore, che ti consente di campionare un colore sotto il puntatore del mouse
in qualsiasi parte dell’interfaccia utente di QGIS o anche da un’altra applicazione: premi la barra spaziatrice
mentre la scheda è attiva, sposta il mouse sul colore desiderato e clicca su di esso o premi nuovamente la barra
spaziatrice. Puoi anche fare clic sul pulsante Colore campione per attivare il selettore del colore.

Qualsiasi metodo usi, il colore scelto viene sempre definito tramite i cursori dei colori per HSV (Tonalità, Satu-
razione, Valore) e RGB (Rosso, Verde, Blue). Il colore è anche identificabile tramite notazione HTML.

La modifica di un colore è semplice basta fare clic sulla Ruota colori o sulla Scala di colori o su uno qualsiasi
dei cursori dei parametri di colore. Puoi regolare tali parametri con la casella di selezione a lato o scorrendo la
rotella del mouse sopra il cursore corrispondente. Puoi inoltre impostare la notazione HTML colore. Infine, c’è
un cursore opacità per impostare il livello di trasparenza.

La finestra di dialogo fornisce anche un confronto visivo tra il colore Vecchio (finora applicato) e quello Attuale

(selezionato), se va bene bisogna confermare la scelta. Usando il drag-and-drop o premendo il pulsante
Add color to swatch, ognuno di questi colori può essere salvato in uno slot per un facile accesso.

Suggerimento: Modifica veloce del colore

Trascinare e rilasciare un widget di selezione del colore su un altro widget per applicare il colore.

Il menu di scelta rapida del colore

Fai clic sulla freccia a discesa a destra del pulsante per visualizzare un widget per una rapida
selezione del colore. Questa scorciatoia fornisce l’accesso a:
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• una ruota dei colori da cui prendere un colore

• un cursore alfa per cambiare l’opacità del colore

• le tavolozze di colori precedentemente impostate su Mostra nei Pulsanti Colore.

• copia il colore corrente e incollalo in un altro widget

• scegli un colore da qualsiasi punto dello schermo del computer

• scegli un colore dalla finestra di dialogo di selezione colore

Figure 11.24: Menu di scelta veloce del colore

Il menu di scelta rapida scala di colori

Le scale di colori sono un modo pratico per applicare una serie di colori ad una o più geometrie. La loro creazione
è descritta nella sezione Scala Colore. Per quanto riguarda i colori, premendo il pulsante scala
di colori si apre la corrispondente finestra di dialogo del tipo di scala di colore che ti permette di modificarne le
proprietà.

Figure 11.25: Personalizzare una scala di colori
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Il menu a discesa a destra del pulsante consente di accedere rapidamente a una serie più ampia di scale di colori e
opzioni:

• Inverti scala di colori

• un’anteprima del gradiente o catalogo: cpt-city scale di colori segnalate come Preferite nel
dialogo Gestore Stile‘

• Tutte le scale di colori per accedere al database di scale di colori

• Crea Nuova Scala di Colori. . . di qualsiasi tipo supportato che potrebbe essere usata nel widget corrente
(notare che questa scala di colori non sarà disponibile altrove a meno che non venga salvata nella libreria)

• Modifica Scala di Colori. . . , lo stesso che fare clic sul pulsante scala di colori

• Salva Scala di Colori. . . , per salvare la scala di colori corrente con le sue personalizzazioni nella libreria
degli stili

Figure 11.26: Widget di selezione rapida della scala di colori

11.9.2 Metodi di fusione

QGIS offre molte opzioni per realizzare effetti speciali di visualizzazione con strumenti che precedentemente hai
avuto a disposizione solo nei programmi specializzati in elaborazioni grafiche. I metodi di fusione possono essere
applicati ai layer e agli elementi, e anche agli elementi di un Layout di stampa:

• Normale: Questa è la modalità di fusione predefinita che usa il canale alpha del pixel più in alto fondendolo
con quello sotto. I colori non sono quindi mescolati.

• Schiarisci: Questo seleziona il valore massimo di ogni componente dal basso verso l’alto. Fai attenzione
che Il risultato può apparire frastagliato e duro.

• Scolorisci: I pixel chiari provenienti dal vettore sorgente vengono dipinti sopra la destinazione, mentre i
pixel più scuri no. Questa modalità è molto utile per mescolare le trame di un vettore con un altro (per
esempio puoi usare una ombreggiatura come trama su un altro layer).

• Scherma: Scherma schiarirà e saturerà i pixel sottostanti in base a quanto sono chiari i pixel di sopra.
In questo modo, i pixel più chiari in cima aumenteranno la saturazione e schiariranno i pixel sottostanti.
Otterrai il miglior risultato se i pixel in cima non sono troppo chiari. Altrimenti l’effetto sarà troppo estremo.

• Addiziona: Aggiunge i valori dei pixel di un elemento all’altro. In caso di valori superiori al valore massimo
(nel caso di RGB), viene visualizzato il bianco. Questa modalità è adatta per evidenziare i particolari.

• Scurisci: Mantiene i valori più bassi di ogni componente dei pixel di primo piano e di sfondo. Come per la
modalità schiarisci, il risultato tende a essere irregolare e non gradevole.
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• Moltiplica: I valori dei pixel dell’elemento superiore vengono moltiplicati con i valori corrispondenti
dell’elemento sottostante. Il risultato tende quindi a essere piuttosto scuro.

• Brucia: I colori più scuri nell’elemento superiore causano l’oscuramento degli elementi sottostanti. Questa
modalità è utile per aggiustare e colorare i layer sottostanti.

• Sovrapponi: Combina le modalità moltiplica e scolorisci. Le parti chiare diventano più chiare e le parti
scure diventano più scure.

• Luce diffusa: Molto simile alla modalità sovrapponi, ma invece di combinare le modalità molti-
plica/scolorisci, combina brucia/scherma. Questo dovrebbe emulare una luce soffusa sull’immagine.

• Luce intensa: Questa modalità è simile alla modalità sovrapponi. Proietta una luce molto intensa su tutta
l’immagine.

• Differenza: Sottrae il pixel superiore dal pixel sul fondo,oppure al contrario, ma in modo da ottenere sempre
un valore positivo. La fusione con il nero non produce alcun cambiamento, poiché la differenza con tutti i
colori è zero.

• Sottrai: Sottrae i valori dei pixel di un elemento dall’altro. In caso di valori negativi, viene visualizzato il
nero.

11.9.3 Impostazione Sovrascrittura definita dai dati

Accanto a molte opzioni nella finestra di dialogo delle Proprietà vettore o nelle impostazioni del Compositore

di stampa, puoi trovare un’icona Sovrascrittura definita dai dati. Questo strumento ti consente di impostare un valore
dinamico per il parametro interessato grazie a espressioni basate sugli attributi del vettore o sulle impostazioni
dell’elemento, funzioni e variabili preimpostate o personalizzate. Se abilitato, il valore restituito da questo widget
viene applicato al parametro indipendentemente dal suo valore normale (casella di controllo, casella di testo,
cursore . . . ).

Widget Sovrascrittura definita dai dati

Facendo clic sull’icona Sovrascrittura definita dai dati vengono visualizzate le seguenti voci:

• Descrizione. . . che indica se l’opzione è abilitata, quale input è previsto, il tipo di input valido e la
definizione corrente. Passando con il mouse sul widget compare anche questa informazione.

• Memorizzare i dati nel progetto: un pulsante che permette di memorizzare la proprietà utilizzando il mec-
canismo Proprietà Dati Ausiliari.

• Tipo di campo: una voce da selezionare tra i campi del layer che corrispondono al tipo di input valido.

• Una voce per elencare le Variabili disponibili.

• Modifica. . . . pulsante per creare o modificare l’espressione da applicare, utilizzando la finestra di dialogo
Expression String Builder. Per aiutarti a compilare correttamente l’espressione, nella finestra di dialogo
viene fornito un promemoria del formato di output previsto.

• pulsanti Incolla e Copia.

• Pulisci per rimuovere l’impostazione.

• Per le proprietà numeriche e cromatiche, Assistente. . . . per ridefinire come i dati delle caratteristiche sono
applicati alla proprietà (maggiori dettagli below)

Suggerimento: Usare click destro del mouse per (dis)attivare la modalità di sovrascrittura dati

Quando l’opzione di sovrascrittura definita dai dati è impostata correttamente, l’icona è gialla o . Se è

errata, l’icona è rossa o
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Puoi abilitare o disabilitare una scelta del pulsante Sovrascrittura definita dai dati semplicemente facendo clic sul
widget con il pulsante destro del mouse.

Usare l’interfaccia assistente definizione dati

Quando il pulsante Sovrasrittura definita dai dati è associato ad un parametro numerico o colore, ha un’opzione Assis-
tente. . . che permette di cambiare come i dati vengono applicati al parametro per ogni caratteristica. L’assistente
ti permette di:

• Definire i dati di Input, ad esempio:

– l’attributo da rappresentare, utilizzando la lista Campo o la funzione Impostra espressione per la colonna

(vedi Espressioni)

– l’intervallo di valori da rappresentare: puoi inserire manualmente i valori o usare il pulsante
Prendi l’intervallo dei valori dal layer per riempire automaticamente questi campi con i valori minimi e massimi
restituiti dall’attributo scelto o dall’espressione applicata ai tuoi dati.

• Applicare la curva di trasformazione: per impostazione predefinita, i valori di uscita (vedi di seguito
per l’impostazione) vengono applicati agli oggetti in input seguendo una scala lineare. Puoi sovrascrivere
questa logica: abilita l’opzione di trasformazione, fai clic sul grafico per aggiungere uno o più punti di
interruzione e trascina il punto o i punti per applicare una distribuzione personalizzata.

• Definire i valori di Output: le opzioni variano a seconda del parametro da definire. Puoi impostare global-
mente:

– i valori minimi e massimi da applicare alla proprietà selezionata (nel caso di un’impostazione del
colore, dovrai fornire una scala di colori :ref:‘color rampa ‘)

– il Metodo scala di rappresentazione che può essere Flannery, Esponente, Superficie o Raggio

– l” Esponente da utilizzare per la scalatura dei dati

– il valore risultante o color per rappresentare oggetti con valori NULL

Quando compatibile con la proprietà, sul lato destro della finestra di dialogo viene visualizzata un’anteprima di
aggiornamento in tempo reale per aiutare l’utente a controllare la scala dei valori.

Figure 11.27: L’assistente dimensione definita dai dati

I valori presentati per le varie dimensioni di cui sopra nell’assistente imposteranno la dimensione “Sovrascrittura
definita dai dati” con:

coalesce(scale_exp(Importance, 1, 20, 2, 10, 0.57), 1)
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CHAPTER 12

Gestione fonti dati

12.1 Accedere ai dati

Facendo parte di un ecosistema Software Open Source QGIS è costruito su diverse librerie che, unitamente agli
specifici provider, offrono la capacità di leggere e spesso scrivere molti formati:

• I formati di dati vettoriali includono formati ESRI (Shapefile, Geodatabase. . . ), formati file MapInfo e
MicroStation, AutoCAD DWG/DXF, GeoPackage, GeoJSON, GRASS, GPX, KML, Comma Separated
Values, e molti altri. . . Vedi l’elenco completo in OGR vector supported formats;

• I formati di dati raster includono ArcInfo Binary Grid, ArcInfo ASCII Grid, JPEG, GeoTIFF, ERDAS
IMAGINE, MBTiles, R o Idrisi rasters, ASCII Gridded XYZ, GDAL Virtual, SRTM, Sentinel Data, e molti
altri. . . Vedi l’elenco completo in raster supported formats.

• I formati di database includono PostgreSQL/PostGIS, SQLite/SpatiaLite, Oracle, DB2 o MSSQL Spatial,
MySQL . . . ;

• Il supporto di servizi dati web (WM(T)S, WFS, WCS, CSW, ArcGIS Servers. . . ) è anche gestito dai
provider di QGIS (vedi QGIS come client di dati OGC).

• Puoi anche leggere i files supportati dalle cartelle archiviate e utilizzare formati nativi di QGIS come i layer
virtuali e i layer in memoria.

Con riferimento alla data di questo manuale, più di 80 formati vettoriali e 140 raster sono supportati da
GDAL/OGR e dai providers di QGIS.

Nota: Non tutti i formati in elenco possono funzionare in QGIS per vari motivi. Ad esempio, alcuni richiedono
librerie proprietarie esterne o il sistema operativo in uso potrebbe non essere tra quelli previsti per l’installazione
del formato GDAL/OGR che tu desideri utilizzare. Per avere un elenco di formati disponibili, eseguire la linea
di comando ogrinfo --formats (per i vettori) o vedere il menu Impostazioni → Opzioni → GDAL (per i
raster) in QGIS.

In QGIS, a seconda del formato dei dati, ci sono diversi strumenti per aprirlo, disponibili principalmente in Layer
→Aggiungi layer → o dalla barra degli strumenti Gestisci layer (abilitata tramite il menu Visualizza → Barre degli
Strumenti). Tuttavia, tutti questi strumenti hanno una finestra di dialogo unificata, la finestra di dialogo Gestore

della sorgente dati che si può aprire direttamente con il pulsante Apri Data Source Manager disponibile sulla Barra
degli strumenti per la gestione della sorgente dati o premendo Ctrl+L. Infatti, la finestra di dialogo Data Source
Manager offre un’interfaccia unificata per aprire dati vettoriali o raster basati su file, nonché database o servizi
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web supportati da QGIS. Può essere impostato modale o meno con la Finestra di gestione non modale della
sorgente dati in Impostazioni → Opzioni → Menu generale.

Figure 12.1: Finestra di dialogo QGIS Gestore delle sorgenti dati

Oltre a questo punto di ingresso principale, c’è anche il plugin DB Manager che offre funzionalità avanzate
per analizzare e manipolare i database collegati. Maggiori informazioni sulle funzionalità di DB Manager sono
esposte in Plugin DB Manager.

Ci sono anche molti altri strumenti, plugin nativi o di terze parti, che ti aiutano ad aprire specifici formati di dati.

Questo capitolo descrive solo gli strumenti forniti di default in QGIS per caricare i dati. Si concentrerà princi-
palmente sulla finestra di dialogo Data Source Manager ma, oltre a descrivere ogni scheda, esplorerà anche gli
strumenti riferiti al fornitore di dati o alle specificità del formato.

12.1.1 Il Pannello Browser

Il Browser è uno dei modi principali per aggiungere rapidamente e facilmente i tuoi dati ai progetti. È disponibile
come:

• una scheda Gestore della sorgente dati, abilitata premendo il pulsante Apri gestore della sorgente dati (Ctrl+L);

• come pannello QGIS che puoi aprire dal menu Visualizza → Pannelli (o Impostazioni → Pannelli) o
premendo Ctrl+2.
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In entrambi i casi, il Browser ti aiuta a navigare nel tuo file system e a gestire i geodati, indipendentemente dal
tipo di layer (raster, vettore, tabella), o dal formato della fonte di dati (file semplici o compressi, database, servizi
web).

The context menu for an element in the Browser panel is opened by right-clicking on it.

For file system directory entries, the context menu offers the following:

• Add as a Favorite

• Properties. . .

• Hide from Browser

• Fast Scan this Directory

• New Directory. . .

• Open Directory

Favourites, can also be removed and renamed:

• Rename favourite. . .

• Remove favourite

For leaf entries that can act as layers in the project, the context menu will have a selection of entries. For example,
for non-database, non-service-based vector, raster and mesh data sources:

• Add Selected Layer(s) to Canvas

• Properties. . .

• Delete File «<name of file>». . .

In the Layer properties entry, you will find (similar to what you will find in the vector and raster layer properties
once the layers have been added to the project):

• Metadata for the layer. Metadata groups: Information from provider (if possible, Path will be a hyperlink
to the source), Identification, Extent, Access, Fields (for vector layers), Bands (for raster layers), Contacts,
Links (for vector layers), References (for raster layers), History.

• A Preview panel

• The attribute table for vector sources (in the Attributes panel).

To add a layer to the project using the Browser:

1. Attiva Browser come descritto sopra. Viene visualizzato una lista ad albero con il tuo file system, i database
e i servizi web. Potrebbe essere necessario collegare i database e i servizi web prima di poterli visualizzare
(vedi le sezioni dedicate).

2. Cerca il layer nell’elenco;

3. Use the context menu, double-click its name, or drag-and-drop it into the map canvas. Your layer is now
added to the Layers panel and can be viewed on the map canvas.

Suggerimento: Aprire un progetto QGIS direttamente dal browser

Puoi anche aprire un progetto QGIS direttamente dal pannello del Browser facendo doppio clic sul suo
nome o trascinandolo e rilasciandolo nell’area di disegno della mappa.

Una volta caricato un file, puoi ingrandirlo utilizzando gli strumenti di navigazione della mappa. Per modificare
lo stile di un layer, apri la finestra di dialogo Proprietà Layer facendo doppio clic sul nome del layer o facendo
clic con il pulsante destro del mouse sul nome nella legenda e scegliendo Proprietà nel menu contestuale. Vedi la
sezione Proprietà Simbologia per ulteriori informazioni sull’impostazione di simbologia dei layer vettoriali.

Nella parte superiore del pannello Browser trovi alcune icone che ti aiutano a:
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• Aggiungi layer selezionati: puoi aggiungere dati nella mappa anche selezionando Aggiungi layer selezionato
dal menu contestuale del layer;

• Aggiorna la visualizzazione ad albero;

• Browser filtri per cercare dati specifici. Immetti una parola di ricerca o un carattere jolly e il browser
visualizzerà l’albero per visualizzare solo i percorsi corrispondenti a tabelle DB, file o cartelle DB - al-
tri dati o cartelle non verranno visualizzate. Vedi l’esempio del Pannello di Browser (2) sulla figura fig-
ure_browser_panels. La ricerca può essere sensibile alla distinzione tra maiuscole e minuscole o meno.
Può anche essere impostata su:

– normale: restituisce qualsiasi elemento contenente il testo cercato;

– utilizzando il/i carattere(i) jolly: confermare la ricerca utilizzando ? e/o * per specificare la posizione
del testo cercato;

– usando una espressione regolare.

• Racchiudi tutto collassa la struttura ad albero;

• Abilita/disabilita le proprietà del widget: quando viene attivato, viene aggiunto un nuovo widget nella parte inferi-
ore del pannello che mostra, se applicabile, i metadati dell’oggetto selezionato.

Clic destro su un elemento nell’albero del browser ti aiuta a:

• in caso di un file o di una tabella, visualizzarne i metadati o aprirli nel tuo progetto. Le tabelle possono
anche essere rinominate, cancellate o troncate;

• in caso di cartella, definirla come segnalibro nei preferiti, nasconderla dall’albero del browser. Le cartelle
nascoste possono essere gestite dalla scheda Impostazioni → Opzioni. . . → Sorgente dei dati;

• creare un collegamento a database o server web;

• aggiornare, rinominare o eliminare la scelta.

Puoi anche importare i le nei database o copiare le tabelle da uno schema/database a un altro con un semplice
trascinamento drag-and-drop. C’è un secondo pannello del browser disponibile per evitare lunghi scorrimenti
durante il trascinamento. Basta selezionare il le e fare drag-and-drop da un pannello all’altro.

Suggerimento: Aggiungi layer a QGIS con un semplice drag-and-drop dal visualizzatore file del tuo sistema
operativo

Puoi anche aggiungere i le al progetto trascinandoli dal proprio visualizzatore di le del sistema operativo in uso al
Panello Layer o all’area di visualizzazione mappa.

12.1.2 Il DB Manager

Il Plugin DB Manager è un altro degli strumenti principali e nativi per integrare e gestire i formati di database
spaziali supportati da QGIS (PostGIS, SpatiaLite, GeoPackage, Oracle Spatial, MSSQL, DB2, Virtual layers) in
un’interfaccia utente. Può essere attivato dal menu Plugins → Gestisci ed installa Plugins. . . .

Il Plugin DB Manager offre diverse funzionalità:

• collegarsi a database e visualizzare la struttura e il contenuto;

• anteprima di tabelle di database;

• aggiungere layer alla visualizzazione mappa, sia con un doppio clic che con trascina e rilascia;

• aggiungere layer a un database da QGIS Browser o da un altro database;

• creare e aggiungere l’output delle query SQL alla visualizzazione mappa;
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Figure 12.2: Pannelli QGIS Browser affiancati

• creare virtual layers.

Ulteriori informazioni sulle funzionalità di DB Manager sono esposte in Plugin DB Manager.

12.1.3 Strumenti di caricamento per specifici provider di dati

Oltre a Pannello Browser e DB Manager che sono gli strumenti di base forniti da QGIS per aggiungere layer a
prescindere dal formato, puoi anche trovate strumenti che sono specifici ai fornitori di dati.

Nota: Alcuni external plugins propongono anche strumenti per aprire in QGIS file di formato specifico.

Caricare un layer da un le

Per caricare un layer da un file, puoi:

• per i dati vettoriali (come Shapefile, Mapinfo o dxf layer), clicca su Aggiungi vettore, oppure seleziona

l’opzione Layer → Aggiungi Layer → Aggiungi vettore. . . . oppure premi Ctrl+Shift+V. Si aprirà

una nuova finestra (vedi figure_vector_add) dalla quale puoi scegliere File e cliccare su Browse. Puoi
anche specificare la codifica per il file, se vuoi.

• per i layer raster, clicca sull’icona Aggiungi raster, selezione l’opzione del menu Layer → Aggiungi layer
→ o digita Ctrl+Shift+R.

Verrà visualizzata una finestra di dialogo standard per i file aperti (vedi figure_vector_open), che ti consente di
navigare nel file system e caricare uno shapefile, un geotiff o un’altra fonte dati supportata. La casella di selezione

Filtro ti consente di preselezionare alcuni formati di file supportati. Solo i formati che sono stati ben testati
appaiono nella lista. Altri formati non testati possono essere caricati selezionando Tutti i file (*. *) .

Selezionando un file dalla lista e cliccando su Apri lo carica in QGIS. È possibile caricare più di un layer con-
temporaneamente tenendo premuto il tasto Ctrl o Shift e cliccando su più oggetti nella finestra di dialogo.
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Figure 12.3: Finestra di dialogo DB Manager

Figure 12.4: Finestra di dialogo aggiungi vettore
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Figure 12.5: Aprire una finestra di dialogo di un layer vettoriale supportato OGR

Figure_vector_loaded mostra QGIS dopo aver caricato il file alaska.shp.

Nota: Poiché alcuni formati come MapInfo (ad esempio .tab) o Autocad (.dxf) consentono di mescolare
diversi tipi di geometrie in un singolo file, il caricamento di tale formato in QGIS apre una finestra di dialogo per
selezionare le geometrie da utilizzare in modo da ricavare un layer a singola tipologia geometrica.

Utilizzando lo strumento Aggiungi Vettore:

• Puoi anche caricare formati specifici come ArcInfo Binary Coverage, UK. Formato di
trasferimento nazionale, così come il formato TIGER grezzo dell” USA Census Bureau o

OpenfileGDB. Per fare ciò, devi selezionare Cartella come :guilabel:Tipo di Sorgente. In
questo caso una directory può essere selezionata nella finestra di dialogo dopo aver premuto Sfoglia.

• Con il Tipo di Sorgente Database puoi selezionare una connessione al database esistente o crearne
una al tipo di database selezionato. I tipi di database disponibili sono ODBC, OGDI Vectors, Esri
Personal Geodatabase, MySQL, PostgreSQL o MSSQL.

Premendo il pulsante Nuovo si apre la finestra di dialogo Crea una nuova connessione database OGR i cui
parametri sono tra quelli presenti in Creazione della connessione. Premendo Apri puoi selezionare tra le
tabelle disponibili, ad esempio del database PostGIS abilitato.

• L’ultimo tipo di sorgente, Protocollo, permette di aprire i dati dal web usando per esempio il formato
GeoJSON o CouchDB. Dopo aver selezionato il tipo si deve riempire l’URI della fonte.

Suggerimento: Caricare layers e progetti da unità esterne montate su macOS

Su macOS, le unità portatili montate accanto al disco rigido primario non appaiono come previsto in File →
Open. . . .. Stiamo lavorando su piùdi una finestra di dialogo open/save macOS-native per risolvere il problema.
Come soluzione, puoi digitare /Volumi` nella casella File name e premere Enter. Poi puoi navigare verso
unità esterne e supporti di rete.
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Figure 12.6: QGIS con il caricamento dello Shapefile Alaska

Importare file di testo delimitato

Il file di testo delimitato (es. .csv, .txt) può essere caricato in QGIS utilizzando gli strumenti sopra descritti.
Tuttavia, caricato in questo modo, apparirà come una semplice tabella di dati. A volte, i file di testo delimitati

possono contenere dati geometrici che vuoi visualizzare; questo è ciò per cui è stato progettato Aggiungi layer
testo delimitato.

Fai clic sull’icona Apri gestore della sorgente dati per aprire la finestra di dialogo Gestore della sorgente dati e attiva

la scheda Testo delimitato, come mostrato in figure_delimited_text_text.

In primo luogo, seleziona il file da importare (ad esempio, qgis_sample_data/csv/elevp.csv) cliccando
sul pulsante Sfoglia. Nel campo Nome layer, fornisci il nome da utilizzare per il layer nel progetto (ad esempio,
Elevation).

Formattazione file

Una volta selezionato il file, QGIS tenta di analizzare il file con l’ultimo delimitatore utilizzato, cercando di
identificare campi e righe. Per consentire a QGIS di analizzare correttamente il file, è importante selezionare il
delimitatore corretto. È possibile specificare un delimitatore attivandolo:

• CSV (comma separated values) valori separati da virgole;

• Delimitatori personalizzati, scegliendo tra alcuni delimitatori predeniti come virgola, spazio, TAB,
punto e virgola. . . ;

• o Delimitatore espressione regolare e inserendo un testo nel campo Espressione. Per esempio se vuoi
usare TAB come delimitatore usa \t (questa è l’espressione regolare usata per TAB).
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Figure 12.7: Finestra di dialogo Testo Delimitato
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Record e campi

Oltre alle impostazioni per identificare righe e campi nei dati, è possibile utilizzare alcune utili opzioni per facil-
itare il riconoscimento dei dati:

• Numero di linee di intestazione da saltare: utile quando vuoi evitare alcune linee in importazione, sia perché
si tratta di linee vuote o con un’altra formattazione.

• Il primo record ha i nomi dei campi: i valori nella prima riga dei dati sono usati come nomi dei campi,
altrimenti QGIS aggiunge una riga di campi di tipo field_1, field_2. . . ..

• Detect field types: riconosce automaticamente il tipo di campo. Se deselezionato, tutti gli attributi sono
trattati come campi di testo.

• La virgola è il separatore decimale: se necessario, puoi forzare una virgola come separatore decimale.

• Rifinisci i campi: ti permette di troncare gli spazi iniziale e finali dai campi.

• Scarta i campi vuoti.

Mentre imposti le proprietà di interpretazione, un’anteprima dei dati campione viene aggiornata nella parte infe-
riore della finestra di dialogo.

Definizione geometria

Una volta che il file è stato interpretato, imposta Definizione della Geometria a:

• Coordinate del punto e attiva Campo X e Campo Y se il layer è di tipo geometrico e contiene tali tipi di

coordinate. Se le coordinate sono definite come gradi/minuti/secondi, attiva la casella di controllo DMS
coordinates;

• Well known text (WKT) opzione se l’informazione spaziale è rappresentata da WKT: seleziona il Campo
Geometria contenente la definizione WKT e scegli l’appropriato Tipo di geometria oppure lascia che QGIS
lo rilevi automaticamente;

• Se il file contiene dati non spaziali, attiva Nessuna geometria (solo tabella attributi) e verrà caricato
come una normale tabella.

Oltre alle informazioni sulla geometria degli oggetti, puoi anche impostare il SR della geometria del layer utiliz-

zando il widget Seleziona SR.

Impostazioni layer

Puoi anche attivare:

• Usa indice spaziale per migliorare le prestazioni di visualizzazione e di selezione spaziale degli oggetti;

• Usa indice di raggruppamento per migliorare le prestazioni di subset filters (quando definito nelle pro-
prietà del layer);

• Controlla file per controllare le modifiche al file da parte di altre applicazioni mentre QGIS è in ese-
cuzione.

Alla fine, fai clic su OK per aggiungere il layer alla mappa. Nel nostro esempio, al progetto viene aggiunto un
layer di punti chiamato Elevazione e si comporta come qualsiasi altro layer di mappa in QGIS. Tuttavia, questo
layer è il risultato di una query sul layer sorgente .csv (quindi, collegato ad esso) e richiederebbe to be saved per
ottenere un layer spaziale su disco.
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Importare file DXF o DWG

I file DXF e DWG possono essere aggiunti a QGIS con un semplice drag-and-drop dal comune pannello del browser.
Ti verrà richiesto di selezionare i sublayer che vorresti aggiungere al progetto. I layer vengono aggiunti con
proprietà di stile casuali.

Nota: Per i file DXF contenenti diversi tipi di geometria (punto, linea e/o poligono), il nome del layer sarà
composto da <filename.dxf> entities <geometry type>.

Per mantenere la struttura del file dxf/dwg e la sua simbologia in QGIS, puoi utilizzare lo strumento dedicato
Progetto → Importa/Esporta → Importa layer da DWG/DXF. . . . che ti permette di:

1. importare oggetti dal file DWG/DXF in un database di GeoPackage.

2. e aggiungere al progetto tutti gli oggetti importati.

Nella finestra di dialogo Importa DWG/DXF, per prima cosa per importare il contenuto del file:

1. Inserisci la posizione del Target package, cioè il nuovo file GeoPackage che memorizzerà i dati. Se viene
fornito un file esistente, allora verrà sovrascritto.

2. Specifica il sistema di riferimento delle coordinate dei dati del file DWG/DXF.

3. Seleziona Espandi riferimenti blocco per importare i blocchi nel file di disegno come oggetti normali.

4. Scegli Usa curve per trasformare i layer importati in un tipo di geometria curva.

5. Usa il pulsante Importa per selezionare il file DWG/DXF da utilizzare (uno per ogni geopackage). Il
database del GeoPackage verrà automaticamente popolato con il contenuto del file DWG/DXF. A seconda
delle dimensioni del file *CAD, questo potrebbe richiedere un po” di tempo.

Dopo che i dati .dwg o .dxf vengono importati nel database di GeoPackage, la cornice nella metà inferiore del
dialogo viene popolata con l’elenco dei layer del file importato. Qui è possibile selezionare quali layer aggiungere
al progetto QGIS:

1. Nella parte superiore, imposta un Nome gruppo per raggruppare i file di disegno nel progetto.

2. Scegli i layer da mostrare: Ogni layer selezionato viene aggiunto ad un gruppo ad hoc che contiene layer
vettoriali per gli oggetti punto, linea, etichetta e area del layer DXF/DWG. Lo stile di ogni layer è impostato
in modo che assomigli all’aspetto che aveva originariamente in *CAD.

3. Scegli se il layer deve essere visibile all’apertura.

4. In alternativa, utilizzando l’opzione Fondi layer, tutti i layer vengono posti in un unico gruppo.

5. Premi OK per aprire i layer in QGIS.

Importare vettori OpenStreetMap

Negli ultimi anni il progetto OpenStreetMap ha guadagnato popolarità perché in molti Paesi non sono disponibili
dati geodati gratuiti quali mappe stradali digitali. L’obiettivo del progetto OSM è quello di creare una mappa
liberamente modificabile del mondo da dati GPS, fotografia aerea o conoscenze locali. Per supportare questo
obiettivo, QGIS fornisce il supporto per i dati OSM.

Utilizzando il Pannello Browser, puoi caricare un file .osm sulla mappa, nel qual caso ti verrà visualizzata una
finestra di dialogo per selezionare i sublayers in base al tipo di geometria. I layers caricati conterrano tutti i dati di
quella tipologia di geometria presenti nel file e manterranno la struttura dati del file osm.

SpatiaLite Layers

La prima volta che carichi i dati da un database di SpatiaLite, inizia da:

12.1. Accedere ai dati 139



QGIS User Guide, Release 3.4

Figure 12.8: Finestra di dialogo per importazione file DWG/DXF
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• facendo clic sul pulsante Aggiungi vettore SpatiaLite della barra degli strumenti;

• selezionando l’opzione Aggiungi vettore SpatiaLite. . . dal menu Layer → Aggiungi Layer;

• o digitando Ctrl+Shift+L.

Si aprirà una finestra che ti permetterà di collegarti ad un database SpatiaLite già noto a QGIS, che puoi scegliere
dal menu a tendina, oppure di definire una nuova connessione ad un nuovo database. Per definire una nuova con-
nessione, clicca su Nuovo e usa il file browser per puntare al tuo database SpatiaLite, che è un file con estensione
.sqlite.

QGIS supporta anche viste modificabili in SpatiaLite.

GPS

Il caricamento dei dati GPS in QGIS può essere effettuato utilizzando il plugin di base: Strumenti GPS. Le
istruzioni sono descritte nel paragrafo Plugin GPS.

GRASS

Lavorare con i dati vettoriali GRASS è descritto nel capitolo Integrazione con GRASS GIS.

Strumenti riferiti ai Database

Creazione della connessione

Per leggere e scrivere tabelle dai molti formati di database supportati da QGIS devi creare una connessione a
quel database. Mentre :ref:‘QGIS Browser Panel ‘ è il modo più semplice e consigliato per connettersi e usare i
database, QGIS fornisce altri strumenti per connettersi a ciascuno di essi e caricare le loro tabelle:

• Aggiungi vettore PostGIS. . . . o digitando Ctrl+Shift+D;

• Aggiungi vettore MSSQL Spatial. . . . o digitando Ctrl+Shift+M;

• Aggiungi vettore Oracle Spatial. . . . o digitando Ctrl+Shift+O;

• Aggiungi vettore DB2 Spatial. . . . o digitando Ctrl+Shift+2.

Questi strumenti sono accessibili dalla Barra degli strumenti Gestisci la barra dei layer o dal menu Layer →
Aggiungi Layer → menu. La connessione al database SpatiaLite è descritta in SpatiaLite Layers.

Suggerimento: Creare una connessione al database dal pannello Browser QGIS

Seleziona il formato di database corrispondente nell’albero Browser, fai clic con il pulsante destro del mouse e
scegliendo connetti ti fornirà la finestra di dialogo per la connessione al database.

La maggior parte delle finestre di connessione seguono una base comune che verrà descritta di seguito utilizzando
come esempio lo strumento di database PostGreSQL. Per ulteriori impostazioni specifiche di altri provider, è
possibile trovare la descrizione corrispondente:

• Connessione a MSSQL Spatial;

• Connessione a Oracle Spatial;

• Connessione a DB2 Spatial.
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La prima volta che utilizzi una fonte dati PostGIS, devi creare un collegamento a un database contenente i dati. In-
izia facendo clic sul pulsante appropriato come esposto sopra, aprendo una finestra di dialogo Aggiungi tabella(e)
PostGIS (vedi figure_add_postgis_tables). Per accedere al gestore delle connessioni, fai clic sul pulsante Nuovo
per visualizzare la finestra di dialogo Crea una nuova connessione PostGIS.

Figure 12.9: Crea una nuova finestra di dialogo PostGIS

I parametri richiesti per la connessione di PostGIS sono elencati di seguito. Per gli altri tipi di database, vedere le
loro differenze ai requisiti di connessione in Requisiti specifici per le connessioni.

• Nome: Nome della connessione. Può essere uguale a quello del Database.

• Servizio: Parametri del servizio da usare alternativamente a host/porta (e potenzialmente database). Lo
puoi definire in pg_service.conf. Vedi la sezione File per la connessione a Servizio PostgreSQL per
maggiori dettagli.

• Host: Nome del server che ospita il database. Deve essere un host con indirizzo raggiungibile, lo stesso
che potrebbe essere usato per aprire una connessione telnet o per fare il ping all’host. Se il database è sullo
stesso computer sul quale è installato QGIS, inserisci semplicemente localhost.

• Porta: Numero della porta del server database PostgreSQL. La porta di default per PostGIS è 5432.

• Database: Nome del database.

• Modalità SSL: Come la connessione SSL verrà negoziata con il server. Puoi velocizzare la visualizzazione
dei vettori PostGIS disabilitando la connessione SSL. Sono disponibili le seguenti opzioni:

– Disabilitato: Prova solo una connessione SSL non criptata.

– Permesso: Tenta una connessione non-SSL, se questa fallisce ne tenta una SSL;

– Preferito (predefinito): Tenta una connessione SSL, se questa fallisce ne prova una non-SSL;

– Richiesto: Tenta solo una connessione SSL.

• Nome utente: Nome dell’utente usato per accedere al database.
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• Password: Password usata dal Nome utente per collegarsi al database.

Puoi salvare uno o entrambi i parametri username e password, nel qual caso saranno utilizzati per im-
postazione predefinita ogni volta che è necessario connettersi a questo database. Se non vengono salvati, ti
verrà chiesto di riempire le credenziali mancanti per connetterti al database nelle prossime sessioni QGIS;
nel contempo i parametri di connessione che hai inserito vengono memorizzati in una cache interna tem-
poranea e restituiti ogni volta che viene richiesto un nome utente/password per lo stesso database, fino alla
chiusura del processo QGIS corrente.

Avvertimento: QGIS impostazioni utente e sicurezza

Nella scheda Autenticazione il salvataggio del nome utente e della password manterrà le credenziali
non protette nella configurazione di connessione. Queste credenziali saranno visibili se, ad esempio,
hai condiviso il progetto con qualcuno. Pertanto, è consigliabile salvare le credenziali in una Configu-
razione di autenticazione (scheda Configurazioni, - vedi Authentication System per maggiori dettagli) o
in una connessione di servizio (vedi File per la connessione a Servizio PostgreSQL per un esempio).

In alternativa, a seconda del tipo di database, è possibile attivare le seguenti caselle di controllo:

• Mostra solamente i layer contenuti nel registro

• Non risolvere tipo di geometria senza restrizioni (GEOMETRY)

• Cerca solo nello schema “public”

• Mostra anche le tabelle senza geometria

• Usa i metadati stimati della tabella

• Permetti salvataggi/caricamenti di progetti QGIS nel database: maggiori dettagli in here

Suggerimento: Utilizza metadati di tabella stimati per velocizzare le operazioni

Durante l’inizializzazione dei layer, potrebbero essere necessarie varie query per stabilire le caratteristiche delle
geometrie memorizzate nella tabella del database. Quando l’opzione Usa i metadati di tabella stimati è selezion-
ata, queste query esaminano solo un esempio delle righe e utilizzano le statistiche della tabella anziché l’intera
tabella. Ciò può accelerare in modo drastico le operazioni su grandi set di dati, ma può causare una caratteriz-
zazione non corretta dei layers (ad esempio, il conteggio delle funzioni dei layer risolti non verrà determinato in
modo preciso) e può anche causare un comportamento strano nel caso in cui le colonne che si supponga siano
uniche in realtà non lo sono.

Una volta impostati tutti i parametri e le opzioni, puoi verificare la connessione facendo clic sul pulsante Prova
connessione o applicarlo premendo OK. Nella finestra di dialogo Aggiungi tabella(e) PostGIS ), facendo ora
click su Connetti la finestra di dialogo viene completata dalle tabelle dal database selezionato (come mostrato in
figure_add_postgis_tables).

Requisiti specifici per le connessioni

In funzione delle particolarità del tipo di database, le opzioni fornite sono tutte uguali per tutti i database. Di
seguito sono esposte queste specificità di connessione.

File per la connessione a Servizio PostgreSQL

Il file di connessione del servizio consente di associare parametri di connessione PostgreSQL a un singolo nome di
servizio. Quel nome di servizio può essere specificato da un client e verranno utilizzate le impostazioni associate.
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Si chiama .pg_service.conf nei sistemi *nix systems (GNU/Linux, macOS etc.) e pg_service.conf
in Windows.

Il file di servizio è del tipo:

[water_service]
host=192.168.0.45
port=5433
dbname=gisdb
user=paul
password=paulspass

[wastewater_service]
host=dbserver.com
dbname=water
user=waterpass

Nota: Nell’esempio precedente ci sono due servizi: water_service e wastewater_service. Puoi
utilizzarli per connetterti da QGIS, pgAdmin etc. specificando solo il nome del servizio a cui desideri connet-
terti (senza le parentesi di chiusura). Se vuoi utilizzare il servizio con psql devi fare qualcosa come export
PGSERVICE=water_service prima di eseguire i comandi psql.

Puoi trovare tutti i parametri qui

Nota: Se non desideri salvare le password nel file di servizio puoi utilizzare l’opzione .pg_pass .

Nei sistemi operativi *nix (GNU/Linux, macOS etc.) puoi salvare il file .pg_service.conf nella directory
home dell’utente e i clients PostgreSQL ne saranno automaticamente a conoscenza. Ad esempio, se l’utente
registrato è web, .pg_service.conf dovrebbe essere salvato nella directory /home/web/ per funzionare
direttamente (senza specificare nessun altro ambiente variabili).

Puoi specificare la posizione del file di servizio creando una variabile di ambiente PGSERVICEFILE (e.g. es-
eguire il comando export PGSERVICEFILE=/home/web/.pg_service.conf nel proprio OS *nix OS
per impostare temporaneamente la variabile PGSERVICEFILE)

Puoi anche rendere disponibile il file di servizio a livello di sistema (tutti gli utenti) o posizio-
nando il .pg_service.conf in pg_config --sysconfdir o aggiungendo la variabile di ambiente
PGSYSCONFDIR per specificare la directory contenente il file di servizio. Se esistono definizioni di servizio
con lo stesso nome nel file utente e nel file di sistema, il file utente ha la precedenza.

Avvertimento: Ci sono alcune particolarità per Windows:

• Il service le deve essere salvato come pg_service.conf e non come .pg_service.conf.

• Il service le deve essere salvato nel formato Unix. Un modo per fare ciò è di aprire il file con Notepad++
ed eseguire Edit → EOL Conversion → UNIX Format → File save.

• Puoi aggiungere le variabili di ambiente in vario modo, un modo testato è Control Panel → Sys-
tem and Security → System → Advanced system settings → Environment Variables aggiungendo
PGSERVICEFILE e un percorso del tipo C:\Users\John\pg_service.conf

• Dopo l’aggiunta di una variabile di ambiente è necessario riavviare il computer.

Connessione a Oracle Spatial

Le caratteristiche spaziali di Oracle Spatial aiutano gli utenti a gestire i dati geografici e di localizzazione in un
tipo nativo all’interno di un database Oracle. Oltre ad alcune delle opzioni in Creazione della connessione, la
finestra di dialogo di connessione propone:
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• Database: SID o SERVICE_NAME dell’istanza Oracle;

• Porta: Numero di porta su cui il database Oracle rimane in ascolto. La porta predefinita è 1521;

• Workspace: La Workspace alla quale collegarsi.

Opzionalmente puoi attivare le seguenti scelte:

• Guarda solo nella tabella metadati: restringe le tabelle visualizzate a quelle che sono presenti nella vista
all_sdo_geom_metadata. Questo procedimento velocizza la visualizzazione iniziale delle tabelle
spaziali;

• Guarda solo nelle tabelle dell’utente: la ricerca di tabelle spaziali si limita alle tabelle di proprietà
dell’utente;

• Mostra anche tabelle senza geometria: specifica che anche le tabelle senza geometria devono essere
elencate.

• Usa i metadati stimati della tabella: quando il layer viene impostato, la tabella Oracle richiede diversi
metadati. Sono necessarie informazioni come il conteggio delle righe della tabella, il tipo di geometria
e l’estensione spaziale nella colonna geometria. Se la tabella contiene un grande numero di righe che
descrivono i metadati, stimare questi metadati porterà via molto tempo. Attivando questa opzione verranno
eseguite le seguenti rapide operazioni sulla tabella dei metadati: Il conteggio delle righe è determinato
da all_tables.num_rows. Le estensioni della tabella saranno sempre determinate con la funzione
SDO_TUNE.EXTENTS_OF anche se viene applicato un filtro di livello. La geometria della tabella è
determinata dalle prime 100 righe di geometria non-null della tabella.

• Solo tipi di geometrie esistenti elenca solo i tipi di geometria esistenti e non permettere di aggiungerne
altre.

• Includere attributi aggiuntivi alla geometrie.

Suggerimento: Vettori Oracle Spatial

Normalmente un vettore Oracle Spatial è definito con una voce nella tabella USER_SDO_METADATA.

Per garantire che gli strumenti di selezione funzionino correttamente, si consiglia che le tabelle dispongano di una
chiave primaria.

Connessione a DB2 Spatial

Oltre a alcune delle opzioni descritte in Creazione della connessione, è possibile specificare la connessione a
un database DB2 (vedi Layer DB2 Spatial per maggiori informazioni) utilizzando o un nome di Servizio/DSN
definito in ODBC o i parametri driver, host e porta.

Una connessione ODBC Service/DSN richiede il nome del servizio definito per ODBC.

Una connessione driver/host/porta richiede:

• Driver: Nome del driver DB2. In genere questo dovrebbe essere IBM DB2 ODBC DRIVER.

• Host DB2: Nome del database nell’host. Questo deve essere un nome host risolvibile come quello utilizzato
per aprire una connessione TCP/ IP o per il ping all’host. Se il database è sullo stesso computer di QGIS,
digitare localhost.

• Porta DB2: Numero di porta in cui il server di database DB2 ascolta. La porta DBW LUW predefinita è
50000. La porta DB2 z/OS predefinita è 446.

Suggerimento: DB2 Spatial Layers

Un DB2 Spatial layer è definito da una riga nella vista DB2GSE.ST_GEOMETRY_COLUMNS.
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Nota: Per poter lavorare in modo efficace con le tabelle spaziali DB2 in QGIS, è importante che le tabelle pre-
sentino una colonna INTEGER o BIGINT definita come PRIMARY KEY e se nuove funzioni saranno aggiunte,
questa colonna dovrebbe avere anche la caratteristica GENERATED.

È inoltre utile che la colonna spaziale venga registrata con un identificativo spaziale specifico (spesso 4326 per
le coordinate WGS84). Una colonna spaziale può essere registrata chiamando la procedura di memorizzazione
ST_Register_Spatial_Column.

Connessione a MSSQL Spatial

Oltre ad alcune delle opzioni in Creazione della connessione, la creazione di una nuova finestra di connessione
MSSQL ti propone di inserire un nome a Provider/DSN. Puoi anche visualizzare i database disponibili.

Caricare layer da Database

Una volta che disponi di una o più connessioni definite in un database (vedi la sezione Creazione della connes-
sione), puoi caricare dei layer da esso. Naturalmente, questo richiede la disponibilità di dati. Vedi ad esempio la
sezione Importare dati in PostgreSQL per una discussione sull’importazione di dati in un database PostGIS.

Per caricare un layer da un database, puoi eseguire le seguenti operazioni:

1. Apri la finestra di dialogo «Aggiungi <database> tabella(e)» (vedi Creazione della connessione),

2. Scegli la connessione dall’elenco a discesa e fai clic su Connetti.

3. Seleziona o deseleziona Mostra anche le tabelle senza geometria.

4. Facoltativamente, usa una delle Opzioni di ricerca per ridurre l’elenco delle tabelle a quelle che cor-
rispondono alla tua ricerca. Puoi anche impostare questa opzione prima di premere il pulsante Connetti,
accelerando in questo modo la ricerca del database.

5. Individua il(i) layer(s) che vuoi aggiungere nell’elenco dei layers disponibili.

6. Selezionalo facendo clic su di esso. Puoi selezionare più layers tenendo premuto il tasto Shift mentre fai
clic.

7. Se applicabile, usa il pulsante Imposta filtro (o fai doppio clic sul layer) per avviare la finestra di dial-
ogo Query Builder (vedi la sezione vector_query_query_builder) e definisci quali oggetti caricare dal layer
selezionato. L’espressione del filtro appare nella colonna sql. Questa restrizione può essere rimossa o
modificata nel riquadro Layer Properties → Generale → Filtro Feature.

8. La casella di controllo nella colonna Select at id che è attivata per impostazione predefinita ottiene
gli id degli oggetti senza gli attributi e rende più veloce nella maggior parte dei casi il caricamento dei dati.

9. Clicca sul pulsante Aggiungi per aggiungere il layer alla mappa.

Suggerimento: Utilizzare il pannello Browser per velocizzare il caricamento delle tabelle del database.

L’aggiunta di tabelle DB dalla loro scheda ad hoc della finestra di dialogo Data Source Manager a QGIS può
talvolta richiedere molto tempo in quanto QGIS recupera in anticipo le statistiche e le proprietà (ad es. tipo e
campo geometrico, SR, numero di elementi) di ogni tabella. Per evitare questo, una volta che the connection is
set, è meglio usare il Browser Panel o il DB Manager per trascinare e rilasciare le tabelle del database nella mappa.

12.1.4 Formati QGIS personalizzati

QGIS dispone di due formati personalizzati che puoi caricare nell’applicazione utilizzando l’appropriato stru-
mento di caricamento:

146 Chapter 12. Gestione fonti dati



QGIS User Guide, Release 3.4

Figure 12.10: Finestra di dialogo Aggiungi tabella(e) PostGIS

• Layer temporaneo: un layer in memoria associato al progetto con il quale viene aperto (vedi Creazione di
un nuovo Layer temporaneo per ulteriori informazioni)

• Layers virtuali: un layer risultante da una query su altro(i) layer(s) (per ulteriori informazioni, vedi Layers
virtuali)

12.1.5 QLR - QGIS Layer Definition File

Le definizioni del layer possono essere salvate come Layer Definition File (QLR - .qlr) usando :menuselection:‘
Esporta -> Salva come file di definizione layer. . . ‘ nel menu contestuale del layer.

Il formato QLR consente di condividere layer QGIS «completi» con altri utenti QGIS. I file QLR contengono
collegamenti alle fonti dati e tutte le informazioni di stile QGIS necessarie per lo stile del layer.

I file QLR sono mostrati nel Pannello Browser e possono essere usati per aggiungere layer (con i relativi stili
salvati) al Pannello Layer. Puoi anche trascinare e rilasciare i file QLR dal file manager di sistema nell’area della
mappa.

12.1.6 Connessione a web services

Con QGIS puoi accedere a diversi tipi di servizi web OGC (WM(T)S, WFS(-T), CSW . . . ). Grazie a QGIS Server,
puoi anche pubblicare questi servizi. La descrizione di queste funzionalità e le istruzioni per l’uso sono fornite nel
capitolo Lavorare con i dati OGC.

12.2 Creare Layer

I layer possono essere creati in molti modi, tra cui:

• layer vuoti da zero;

• layer da layer esistenti;

12.2. Creare Layer 147



QGIS User Guide, Release 3.4

• layer dagli appunti;

• come risultato di una query SQL-like basata su uno o più layer: i virtual layer.

QGIS fornisce anche strumenti specifici per importare/esportare diversi formati.

12.2.1 Creare nuovi layer Vettore

QGIS ti permette di creare nuovi layer di tipo shapefile, nuovi layer SpatiaLite, nuovi layer GPX e nuovi layer
di tipo temporaneo. La creazione di un nuovo layer GRASS è supportata all’interno del plug-in GRASS. (Fai
riferimento alla sezione Creare un nuovo layer vettoriale GRASS per ulteriori informazioni sulla creazione di
layer vettoriali GRASS).

Creare un nuovo vettore GeoPackage

Per creare un nuovo vettore GeoPackage vai su Layer → Crea vettore → Nuovo layer GeoPackage. . . . La
finestra di dialogo Nuovo layer GeoPackage verrà visualizzata come mostrato in figure_create_geopackage.

Figure 12.11: Finestra di dialogo creazione Nuovo vettore GeoPackage

Il primo passo è selezionare un GeoPackage esistente o crearne uno nuovo. Questo puoi farlo premendo il tasto coi
puntini di sospensione . . . alla destra del campo Database. Quindi, assegna un nome per il nuovo layer, definisci
il tipo di layer e specifica il sistema di riferimento delle coordinate con Specifica SR.

Per definire una tabella di attributi per il nuovo livello di GeoPackage, aggiungi il nome della colonna degli
attributi che desideri creare con il tipo di colonna corrispondente e fai clic sul pulsante Aggiungi a Lista campi.
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Una volta completati gli attributi, clicca su OK. QGIS aggiungerà automaticamente il nuovo layer alla legenda e
potrai modificarlo come descritto nella sezione Modifica di un layer esistente.

Creare un nuovo layer Shapele

Per creare un nuovo layer Shapefile, scegli Crea Vettore → Nuovo shapefile. . . dal menu Layer oppure
selezionalo dalla barra degli strumenti Barra degli strumenti per la gestione della sorgente dati. Viene visualizzata
la finestra di dialogo Nuovo Shapefile, come mostrato nella figura figure_create_shapefile. Il primo passo è quello
di fornire un percorso e un nome per lo Shapefile. QGIS aggiungerà automaticamente l’estensione .shp al nome
specificato. Quindi, scegli il tipo di vettore (punto, linea o poligono) e le dimensioni opzionali Z o M, così come
il SR (sistema di riferimento delle coordinate).

Figure 12.12: Finestra di dialogo creazione nuovo Layer Shapefile

Per completare la creazione del nuovo Shapefile, aggiungi gli attributi desiderati specificando un nome e un tipo
per ogni attributo e cliccando sul pulsante Add to Fields List. Una prima colonna “id” viene aggiunta di default

ma può essere rimossa, se non lo si desidera. Sono supportati solo Numero decimale , Numero intero ,

dati testuali e Data . Inoltre, a seconda del tipo di attributo, puoi anche definire la lunghezza e la
precisione della nuova colonna attributo. Una volta soddisfatto degli attributi, fai clic su OK. Una volta creato
lo Shapefile, verrà aggiunto alla mappa come nuovo layer, e puoi modificarlo nello stesso modo descritto nella
sezione Modifica di un layer esistente.

Creare un nuovo layer SpatiaLite

Per creare un nuovo layer SpatiaLite scegli Nuovo → Nuovo Vettore SpatiaLite . . . dal menu Layer oppure
selezionalo dalla barra degli strumenti Data Source Manager. Viene visualizzata la finestra di dialogo Nuovo layer
SpatiaLite come mostrato nella figura Figure_create_spatialite.
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Figure 12.13: Finestra di dialogo creazione Nuovo layer SpatiaLite

Il primo passo è quello di selezionare un database SpatiaLite esistente o di creare un nuovo database SpatiaLite.
Questo può essere fatto con il pulsante . . . . alla destra del campo del database. Quindi, aggiungi un nome per il
nuovo layer, definisci il tipo di layer e specifica il sistema di riferimento delle coordinate con Seleziona SR. Se

vuoi, puoi selezionare Crea una chiave primaria autoincrementale.

Per definire una tabella degli attributi per il nuovo layer SpatiaLite, aggiungi i nomi delle colonne degli attributi
che vuoi creare con il tipo di colonna corrispondente e fai clic sul pulsante Aggiungi alla lista campi. Una volta
soddisfatto degli attributi, fai clic su OK. QGIS aggiungerà automaticamente il nuovo layer alla legenda, e puoi
modificarlo nello stesso modo descritto nella sezione sec_edit_edit_esistente.

Ulteriore gestione dei layer SpatiaLite può essere eseguita con il DB Manager. Vedi Plugin DB Manager.

Creare un nuovo layer GPX

Per creare un nuovo file GPX, devi prima aver caricato il plugin GPS. Plugin → Gestisci e installa Plugin. . .

apre la finestra di dialogo Gestione Plugin. Attiva la casella Strumenti GPS.

Quando questo plugin è attivo, scegli Crea vettore → Nuovo vettore GPX. . . dal menu Layer. Nella finestra
di dialogo Salva nuovo vettore GPX . . . . scegli dove salvare il nuovo file e premi Salva. Tre nuovi layer vengono
aggiunti al Layers Panel: waypoints, routes e tracks con struttura predefinita.

Creare un nuovo vettore temporaneo

I Layer Scratch Temporanei sono layer in memoria, cioè non vengono salvati su disco e verranno cancellati quando
QGIS viene chiuso. Possono essere utili per memorizzare gli oggetti di cui si ha temporaneamente bisogno o come
layer intermedi durante le operazioni di geoprocessing.
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I layer scratch temporanei vuoti e modificabili possono essere definiti usando Layer → Crea vettore →

Nuovo vettore temporaneo. . . . o Nuovo vettore temporaneo. . . . dal pulsante Barra degli strumenti per la gestione
della sorgente dati. Qui è possibile creare un:

• Layer di tipo No geometry, utilizzato come semplice tabella,

• layer Punto o Multi punto,

• layer LineString/CompoundCurve o MultiLineString/MultiCurve,

• layer Polygon/CurvePolygon o MultiPolygon/MultiSurface.

Figure 12.14: Finestra di dialogo creazione nuovo vettore temporaneo

Per impostazione predefinita, viene creato un nuovo layer scratch temporaneo senza alcun attributo. Ma si possono
anche creare layer scratch temporanei prepopolati usando ad esempio gli appunti (vedi Creare nuovi layer dagli
appunti) o come risultato di un algoritmo di elaborazione Processing.

Suggerimento: Salvataggio permanente di un vettore temporaneo su disco

Per evitare la perdita di dati quando chiudi il progetto con layer scratch temporanei, puoi salvare questi layer in
qualsiasi formato vettoriale supportato da QGIS:

• cliccando sull’icona accanto al layer;

• selezionando Rendi permanente nel menu contestuale del layer;

• o come per qualsiasi altro layer vettoriale, usando la voce Esporta → dal menu contestuale o dal menu
Layer → Salva con nome. . . ..

Ognuno di questi comandi attiva la finestra di dialogo Salva il vettore come esposta nella sezione Creare nuovi
layer da layer esistente e il file salvato sostituisce quello temporaneo nel pannello Layer.

12.2.2 Creare nuovi layer da layer esistente

Sia i layer raster che vettoriali possono essere salvati in un formato diverso e/o riproiettati in un diverso sistema
di riferimento di coordinate (SR) usando il menu Layer → Salva con nome. . . . o facendo clic destro sul layer nel
pannello Layer e selezionando:
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• Esporta → Salva con nome. . . per layer raster

• Esporta → Salva Elementi Come. . . or Esporta → Salva Elementi Selezionati Come. . . per layer vettoriali.

• Trascina il layer dall’albero layer alla voce PostGIS nel Pannello Browser. Nota che devi avere già una
connessione PostGIS nel Pannello Browser.

Parametri comuni

La finestra di dialogo Salva Layer come. . . . mostra diversi parametri per cambiare il risultato con il salvataggio
del layer. Tra i parametri comuni per raster e vettori ci sono:

• Nome file

• SR: può essere cambiato per riproiettare i dati.

• Aggiungi il file salvato sulla mappa per aggiungere il nuovo layer alla mappa

• Estensione (i valori possibili sono Estensione del Layer, Estensione della mappa o Estensione definita
dall’utente)

Tuttavia, alcuni parametri sono specifici per i formati raster e vettoriali

Parametri specifici per i Raster

A seconda del formato di esportazione, alcune di queste opzioni potrebbero non essere disponibili:

• Modalità uscita (può essere Dati grezzi o Immagine visualizzata)

• Formato: esportazioni in qualsiasi formato raster che GDAL può scrivere, come GeoTiff, GeoPackage,
MBTiles, Geospatial PDF, SAGA GIS Binary GIS Grid, Intergraph Raster, ESRI .hdr Labelled. . . ..

• Risoluzione

• Opzioni di creazione: utilizzare le opzioni avanzate (compressione file, dimensioni dei blocchi, colorime-
tria. . . .) quando si generano file, o da predefined create profiles relativi al formato di output o impostando
ciascun parametro.

• Piramidi creazione

• Mattonelle VRT nel caso in cui hai scelto Crea VRT

• Valori nulli

Parametri specifici per i Vettori

A seconda del formato di esportazione, alcune di queste opzioni sono disponibili o meno:

• Formato: le esportazioni in qualsiasi formato raster che GDAL può scrivere, come GeoPackage, ESRI
Shapefile, AutoCAD DXF, ESRI FileGDB, Mapinfo TAB or MIF, SpatiaLite, CSV, KML, ODS. . .

• Nome vettore a seconda del formato selezionato

• Codifica

• Salva solo le geometrie selezionate

• Seleziona i campi da esportare e le loro opzioni di esportazione. Nel caso in cui imposti i comportamenti dei
campi con alcuni Edit widgets ad esempio «valore», puoi mantenere i valori visualizzati nel layer scegliendo

Sostituisci tutti i valori grezzi selezionati dai valori mostrati.

• Esporta simbologia: opzione che puoi utilizzare principalmente per l’esportazione del formato DXF e per
tutti i formati di file che gestiscono le tipologie di file OGR (vedi nota di seguito) come i formati DXF,
KML, i formati tabelle:

– Nessuna simbologia: stile di default dell’applicazione che legge i dati
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Figure 12.15: Salvare come un nuovo layer raster

– Simbologia geometrie: salva lo stile utilizzando gli stili OGR (vedi la nota di seguito)

– Simbologia simboli vettore: salva con gli stili OGR (vedi nota di seguito) ma esporta la stessa ge-
ometria più volte se sono utilizzati più simboli

– Un valore di Scala può essere applicato alle scelte più recenti.

Nota: Gli Stili di Geometrie OGR sono un modo per memorizzare lo stile direttamente nei dati come un attributo
nascosto. Solo alcuni formati possono gestire questo tipo di informazioni. Formati KML, DXF e TAB sono tali
formati. Per utenti avanzati, è possibile leggere il documento OGR Feature Styles specification

• Geometria: puoi definire le caratteristiche geometriche del layer in output

– Tipo di geometria: mantiene la geometria originale quando impostata su Automatico, altrimenti
rimuove o sovrascrive con qualsiasi tipo. Puoi aggiungere una colonna vuota di geometria a una
tabella di attributo, rimuovere la colonna geometrica di un layer spaziale.

– Forza multi-tipo: forza la creazione di features multi-geometry nel layer

– Includi dimensione z alle geometrie.

Suggerimento: Modificare il tipo di geometria di un layer consente di eseguire cose come salvare una tabella
senza geometrie (ad esempio file .csv) in uno shapefile con qualsiasi tipo di geometria (punto, linee, poligono),

in modo che le geometrie possano essere aggiunte manualmente a righe con lo strumento Aggiungi parte.

• Opzioni su origine dati, Opzioni del layer o Opzioni personalizzate che ti consentono di configurare alcuni
parametri avanzati. Consulta la documentazione del driver gdal-ogr
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Figure 12.16: Salvare come un nuovo layer vettoriale
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Quando si salva un layer vettoriale in un file esistente, a seconda delle capacità del formato di output (Geopackage,
SpatiaLite, FileGDB . . . ), l’utente può decidere se:

• sovrascrivere l’intero file

• sovrascrivere solo il layer di destinazione (il nome del layer è configurabile)

• aggiungere geometrie ad un layer esistente

• aggiungere geometrie, aggiungere nuovi campi se ce ne sono.

Sono disponibili opzioni per aggiungere geometrie ai formati come ESRI Shapefile, MapInfo .tab,.

12.2.3 Creazione di nuovi file DXF

Oltre alla finestra di dialogo Salva come. . . che offre opzioni per esportare un singolo layer in un altro formato,
incluso *.DXF, QGIS fornisce un altro strumento per esportare più layers come singoli layers DXF. È accessibile
nel menu Progetto → Esporta progetto in DXF. . . .

Nella finestra di dialogo Esportazione DXF:

1. indicare la destinazione del layer file;

2. Scegliere la tipologia e la scala dei simboli (vedi la nota OGR Feature Styles ) se applicabile;

3. Selezionare la Codifica dei dati.

4. Selezionare il SR da applicare: i layer selezionati verranno riproiettati nel SR indicato.

5. selezionare i layer da includere nei file DXF o controllando ciascuno nel widget della tabella o selezio-
nandoli automaticamente da un tema esistente map theme. I pulsanti Seleziona Tutto e Deseleziona Tutto
possono anche aiutare ad impostare rapidamente i dati da esportare.

Per ogni layer, puoi anche scegliere se esportare tutti gli oggetti in un singolo layer DXF o fare affidamento
su un campo i cui valori sono usati per separare gli oggetti nei layer di destinazione generati nell’output
DXF.

Opzionalmente puoi anche scegliere di:

• Se impostato usa il titolo del layer come nome invece del nome del layer stesso;

• Esporta gli elementi che intersecano l’attuale estensione della mappa;

• Forza risultato 2D (ad esempio per supportare la larghezza della polilinea);

• Esporta le etichette come MTEXT o elementi TEXT.

12.2.4 Creare nuovi layer dagli appunti

Le geometrie che si trovano negli appunti possono essere incollate in un nuovo layer. Seleziona alcune geometrie
e poi copiale in un nuovo layer usando Modifica → Incolla geometrie come → e scegliendo:

• Nuovo vettore. . . : devi selezionare il SR, aprire la finestra di dialogo Salva i vettori come. . . in cui puoi
selezionare qualsiasi formato di dati supportato (vedi Creare nuovi layer da layer esistente for parameters);

• oppure Layer Scratch Temporaneo. . . : devi selezionare il SR del layer e assegnare un nome.

Viene creato un nuovo layer, completo delle geometrie selezionate e relativi attributi e aggiunto alla visualiz-
zazione mappa se richiesto.

Nota: La creazione di layer dagli appunti è possibile con oggetti selezionati e copiati all’interno di QGIS, nonché
oggetti di un’altra applicazione, a condizione che siano definitie utilizzando il formato stringa well-known text
(WKT).
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Figure 12.17: Esportazione di un progetto nella finestra di dialogo DXF

12.2.5 Creazione di layer virtuali

I layer virtuali sono una tipologia speciale di layer vettoriale. Permettono di definire un layer come il risultato di
una query SQL che coinvolge un qualsiasi numero di altri layer vettoriali che QGIS è in grado di aprire. I layer
virtuali non hanno dati propri e possono essere visti come viste ad altri layer.

Per creare un layer virtuale, apri la finestra di dialogo per la creazione di un layer virtuale:

• selezionando l’opzione Add Virtual Layer dal menu Layer → Aggiungi Layer →;

• abilitando il Aggiungi layer virtuale nella finestra di dialogo Data Source Manager;

• oppure utilizzando la voce della finestra di dialogo DB Manager.

La finestra di dialogo ti consente di specificare un Nome vettore e una SQL Interrogazione. Questa interrogazione
può utilizzare il nome (o id) dei vettori esistenti, così come i nomi dei campi del layer.

Ad esempio, se hai un layer chiamato airports, puoi creare un nuovo layer virtuale da denominare
public_airports con una query SQL del tipo:

SELECT *
FROM airports
WHERE USE = "Civilian/Public"

La query SQL verrà eseguita, qualunque sia la struttura di base del vettore airports e anche se questa fonte
dati non supporta direttamente le query SQL.

È inoltre possibile creare join e query complesse, ad esempio, per unire aeroporti e informazioni sui paesi:

SELECT airports.*, country.population
FROM airports
JOIN country
ON airports.country = country.name
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Figure 12.18: Finestra di dialogo creare layer virtuali

Nota: Layer virtuali possono essere creati anche usando la finestra di dialogo SQL di Plugin DB Manager.

Layer nidificati da usare nelle query

Oltre ai layer vettoriali disponibili nell’area di visualizzazione della mappa, l’utente può aggiungere layer alla lista
Layer inclusi, layer che può utilizzare nelle query senza doverli mostrare nell’area di visualizzazione della mappa
o nel Pannello Layer.

Per incorporare un layer, fai clic su Aggiungi e inserisci Nome locale, Sorgente dati, Codifica e il percorso della
Sorgente dati.

Il pulsante Importa consente di aggiungere i layer caricati nell’area di disegno della mappa all’elenco dei layer
incorporati. Questo consente di rimuovere successivamente questi layer dal Pannello Layer senza interrompere
alcuna query esistente.

Linguaggi query supportati

Il motore incorporato utilizza SQLite e SpatiaLite per operare.

Ciò significa che puoi utilizzare tuttoi l’SQL che l’installazione locale di SQLite comprende.

Funzioni di SQLite e funzioni spaziali di SpatiaLite possono anche essere utilizzate in una query di layer virtuale.
Ad esempio, la creazione di un layer di punti da un layer di solo attributo può essere fatto con una query simile a:

SELECT id, MakePoint(x, y, 4326) as geometry
FROM coordinates

Functions of QGIS expressions possono essere utilizzate anche in una query di layer virtuale.

Per fare riferimento alla colonna geometrica di un layer, utilizzare il nome geometry.
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Contrariamente a una query SQL pura, devono essere denominati tutti i campi di una query di layer virtuale. Non
dimenticare di utilizzare la parola chiave as per indicare le colonne se sono il risultato di un calcolo o di una
funzione.

Problemi relativi alle prestazioni

Con parametri predefiniti, il motore del layer virtuale proverà a rilevare il tipo delle diverse colonne della query,
incluso il tipo di colonna geometria se presente.

Questo viene fatto analizzando l’interrogazione se possibile o recuperando la prima riga dell’interrogazione
(LIMIT 1) in ultima istanza. Il recupero della prima riga del risultato per creare lo strato può essere indesiderabile
per motivi di prestazioni

La finestra di dialogo per creare un layer virtuale ti permette di specificare diversi parametri.

• Colonna identificativa univoca: questa opzione ti permette di specificare quale campo dell’interrogazione
rappresenta i valori interi univoci che QGIS può utilizzare come identificatore di riga. Per default, viene
utilizzato un valore intero autoincrementale. Specificando una colonna identificatore univoco potrai velo-
cizzare la selezione delle righe.

• Nessuna geometria: questa opzione forza il layer virtuale a ignorare qualsiasi campo geometria. Il layer
risultante sarà solamente un layer tabella attributi.

• Colonna geometria: questa opzione ti permette di specificare il nome della colonna da utilizzare come
geometria del layer.

• Tipo: questa opzione ti permette di specificare il tipo di geometria del layer virtuale.

• SR: quest’opzione ti permette di specificare il sistema di riferimento delle coordinate del layer virtuale.

Commenti speciali

L’interprete del layer virtuale tenta di determinare il tipo di ogni colonna della query. Se non riesce, viene eseguita
la prima riga della query per determinare i tipi colonna.

Il tipo di una particolare colonna può essere specificato direttamente nella query utilizzando alcuni commenti
speciali.

La sintassi è la seguente: /*: type*/. Deve essere inserita subito dopo il nome di una colonna. il tipo può
essere int per interi, real per numeri a virgola mobile o text.

Ad esempio:

SELECT id+1 as nid /*:int*/
FROM table

Il tipo e il sistema di riferimento della colonna geometrica può essere impostato anche grazie a speciali commenti
con la seguente sintassi /*:gtype: srid*/ dove gtype è il tipo geometrico (point, linestring,
polygon, multipoint, multilinestring o multipolygon) e srid un intero che rappresenta il
codice EPSG di un sistema di riferimento di coordinate.

Uso degli indici

Quando si interagisce con un layer virtuale, gli indici di questo layer vengono utilizzati nei seguenti modi:

• se viene usato = nella colonna chiave primaria del layer, al fornitore di dati sottostante verrà richiesto un id
particolare (FilterFid)

• per tutti gli altri predicati (>, <=, !=, etc.) o per richiesta su una colonna senza chiave primaria, verrà
utilizzata una richiesta costruita da un” espressione per il driver attivo. Ciò significa che gli indici possono
essere utilizzati sui drivers di database, se esistono.
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Esiste una sintassi specifica per gestire le predicazioni spaziali nelle richieste e innesca l’utilizzo di un indice
spaziale: una colonna nascosta denominata _search_frame_ esiste per ogni layer virtuale. Questa colonna
può essere paragonata per l’uguaglianza con un riquadro di limitazione. Ad esempio:

SELECT *
FROM vtab
WHERE _search_frame_=BuildMbr(-2.10,49.38,-1.3,49.99,4326)

I predicati binari spaziali come ST_Intersects consentono significative accelerazioni quando utilizzati in
combinazione con questa sintassi dell’indice spaziale.

12.3 Esplorare i formati dati e i campi

12.3.1 Dati Raster

I dati raster sono matrici di celle discrete che rappresentano oggetti della superficie terrestre o dell’ambiente al di
sopra o al di sotto di essa. Ogni cella nella matrice ha la stessa dimensione e le celle sono solitamente rettangolari
(in QGIS sono sempre rettangolari). Esempi tipici di dati raster sono quelli provenienti dal telerilevamento come
le fotografie aeree, le immagini da satellite e i dati modellati come le matrici dell’elevazione.

A differenza dei dati vettoriali, i dati raster in genere non hanno un record di database associato per ogni cella.
Sono geocodificati dalla risoluzione dei pixel e dalla coordinata X/Y di un pixel d’angolo del layer raster. Questo
permette a QGIS di posizionare correttamente i dati nell’area di disegno della mappa.

The GeoPackage format is convenient for storing raster data when working with QGIS. The popular and powerful
GeoTiff format is a good alternative.

QGIS makes use of georeference information inside the raster layer (e.g., GeoTiff) or an associated world file to
properly display the data.

12.3.2 Dati vettoriali

Molte delle geometrie disponibili in QGIS funzionano allo stesso modo, indipendentemente dalla fonte dei dati
vettoriali. Tuttavia, a causa delle differenze nelle specifiche dei formati (ESRI Shapefile, MapInfo e MicroStation,
AutoCAD DXF, PostGIS, SpatiaLite, DB2, Oracle Spatial e MSSQL Spatial database, e molti altri), QGIS può
gestire in modo diverso alcune delle loro proprietà. Questa sezione descrive come lavorare con queste specificità.

Nota: QGIS supports (multi)point, (multi)line, (multi)polygon, CircularString, CompoundCurve, CurvePolygon,
MultiCurve, MultiSurface feature types, all optionally with Z and/or M values.

You should also note that some drivers don’t support some of these feature types, like CircularString, Compound-
Curve, CurvePolygon, MultiCurve, MultiSurface feature type. QGIS will convert them.

GeoPackage

The GeoPackage (GPKG) format is platform-independent, and is implemented as a SQLite database container,
and can be used to store both vector and raster data. The format was defined by the Open Geospatial Consortium
(OGC), and was published in 2014.

GeoPackage can be used to store the following in a SQLite database:

• vector features

• tile matrix sets of imagery and raster maps

• attributes (non-spatial data)

• extensions
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ESRI Shapefile

L’ESRI shapele è ancora uno dei formati di le vettoriali più utilizzati in QGIS. Tuttavia, questo formato ha qualche
limitazione che altri formati non hanno (come il Geopackage, SpatiaLite). Il supporto è fornito dalla libreria OGR
Simple Feature Library.

Un formato dati shapele è costituito da diversi le. I seguenti tre sono obbligatori:

1. .shp file contenente le geometrie

2. .dbf file contenente gli attributi in formato dBase

3. .shx file indici

Uno shapele può anche includere un le con suffisso .prj che contiene le informazioni sulla proiezione. Anche
se non è obbligatorio, è molto utile avere informazioni sulla proiezione. Uno shapele può contenere anche al-
tri les. Per ulteriori informazioni, vedi le specifiche tecniche di ESRI all’indirizzo http://www.esri.com/library/
whitepapers/pdfs/shapele.pdf.

Ottimizzare le prestazioni per gli shapefile

Per migliorare le prestazioni di visualizzazione di uno shapefile, puoi creare un indice spaziale. L’indice spaziale
migliora la velocità di visualizzazione quando usi le funzioni di zoom e di spostamento. Gli indici spaziali usati
da QGIS hanno estensione .qix.

Segui questi passi per creare un indice spaziale:

1. Carica uno shapefile (vedi Il Pannello Browser).

2. Apri la finestra di dialogo Proprietà vettore facendo doppio click sul nome dello shapefile nella legenda o
cliccandoci con il tasto destro e scegliendo Proprietà. . . dal menu contestuale.

3. Nella scheda Sorgente, fai clic sul pulsante Crea Indice Spaziale.

Problemi nel caricare un file .prj

Se carichi un dataset in formato Shapefile con un file .prj file e QGIS non è in grado di leggere il sistema
di riferimento delle coordinate da quel file, dovrai definire manualmente la proiezione corretta all’interno della

scheda Proprietà vettore → Sorgente del layer cliccando sul pulsante Seleziona SR. Ciò è dovuto al fatto che i file
.prj spesso non forniscono i parametri di proiezione completi come quelli utilizzati in QGIS ed elencati nella
finestra di dialogo SR.

Per lo stesso motivo, se crei un nuovo set di dati in formato Shapefile con QGIS, vengono creati due diversi file
di proiezione: un file .prj file con parametri di proiezione limitati, compatibile con il software ESRI, e un file
.qpj file, che fornisce i parametri completi del SR utilizzato. Ogni volta che QGIS trova un file .qpj file, sarà
usato al posto del .prj.

Files Testo Limitato

Il file di testo delimitato è un formato molto comune e ampiamente utilizzato per la sua semplicità e leggibilità -
i dati possono essere visualizzati e modificati anche con un editor di testo. Un file di testo delimitato è un dato
tabellare con ogni colonna separata da un definito carattere e ogni riga separata da un’interruzione di riga. La
prima riga di solito contiene i nomi delle colonne. Un tipo comune di file di testo delimitato è un CSV (Comma
Separated Values), con ogni colonna separata da una virgola. Tali file di dati possono contenere anche informazioni
sulla posizione (vedi Memorizzazione informazioni di geometrie in un file di testo delimitato).

QGIS ti permette di caricare un file in formato di testo delimitato come layer o come semplice tabella (vedi Il
Pannello Browser o Importare file di testo delimitato). Prima però verifica che soddisfi questi requisiti:

1. Il file deve avere una riga di intestazione con il nome dei campi. Questa deve essere la prima riga del file di
testo (preferibilmente la prima riga del file di testo).

2. Se si deve abilitare la geometria, la riga di intestazione deve contenere uno o più campi con la definizione
della geometria. Questi campi possono avere qualsiasi nome.
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3. Le coordinate X e Y (se la geometria è identificata da coordinate) devono essere specificate come numeri.
Il sistema di coordinate non è importante.

4. Se hai dati che non sono una stringa (testo) e il file è un file CSV, devi avere un file CSVT (vedi sezione
Utilizzo di file CSVT per controllare la formattazione del campo).

Come esempio di un file di testo valido, importa il file di punti quotati elevp.csv presente nell’insieme di dati
campione di QGIS (vedi sezione Dati campione):

X;Y;ELEV
-300120;7689960;13
-654360;7562040;52
1640;7512840;3
[...]

Alcune cose da tenere in considerazione in merito al file di testo:

1. Il file di testo usato come esempio usa ; (punto e virgola) come delimitatore. Ma qualsiasi carattere può
essere usato per delimitare i campi.

2. La prima riga è la riga di intestazione. Questa contiene i campi X, Y e ELEV.

3. Nessun tipo di virgoletta (") dev’essere usata per delimitare i campi di testo.

4. Le coordinate X sono contenute nel campo X.

5. Le coordinate Y sono contenute nel campo Y.

Memorizzazione informazioni di geometrie in un file di testo delimitato

I file testo delimitato possono contenere informazioni sulla geometria in due forme principali:

• Come coordinate in colonne separate (es. Xcol, Ycol. . . . ), compatibili con i dati geometrici dei punti;

• Come well-known text (WKT) rappresentazione della geometria in una singola colonna, per qualsiasi tipo
di geometria.

Sono supportati anche oggetti con geometrie curve (CircularString, CurvePolygon and CompoundCurve). Di
seguito tre esempi di tali tipologie geometriche nel formato geometrie WKT:

Label;WKT_geom
LineString;LINESTRING(10.0 20.0, 11.0 21.0, 13.0 25.5)
CircularString;CIRCULARSTRING(268 415,227 505,227 406)
CurvePolygon;CURVEPOLYGON(CIRCULARSTRING(1 3, 3 5, 4 7, 7 3, 1 3))
CompoundCurve;COMPOUNDCURVE((5 3, 5 13), CIRCULARSTRING(5 13, 7 15,

9 13), (9 13, 9 3), CIRCULARSTRING(9 3, 7 1, 5 3))

Il formato testo delimitato supporta anche geometrie che hanno coordinate Z e M:

LINESTRINGZ(10.0 20.0 30.0, 11.0 21.0 31.0, 11.0 22.0 30.0)

Utilizzo di file CSVT per controllare la formattazione del campo

Quando carichi i file CSV, il driver OGR presuppone che tutti i campi siano stringhe (cioè tipo testo) a meno che
non sia detto diversamente. Puoi creare un file CSVT per indicare a OGR (e QGIS) quali tipi di dati ci sono nelle
diverse colonne:
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Type Name Example
Whole number Integer 4
Decimal number Real 3.456
Date Date (YYYY-MM-DD) 2016-07-28
Time Time (HH:MM:SS+nn) 18:33:12+00
Date & Time DateTime (YYYY-MM-DD HH:MM:SS+nn) 2016-07-28 18:33:12+00

Il file CSVT è un file di testo normale di UNA sola riga con i tipi di dati racchiusi da virgolette e separati da
virgole, ad esempio:

"Integer","Real","String"

Puoi anche specificare la larghezza e la precisione di ogni colonna, ad esempio:

"Integer(6)","Real(5.5)","String(22)"

Questo file viene salvato nella stessa cartella del file .csv, con lo stesso nome, ma con .csvt come estensione.

Puoi trovare maggiori informazioni in GDAL CSV Driver.

Layer PostGIS

I vettori PostGIS sono memorizzati in un database PostgreSQL. PostGIS ha diversi vantaggi: creazione dell’indice
spaziale, capacità di filtraggio e di interrogazione molto potenti. Usando PostGIS, le funzioni vettoriali come la
selezione e l’identificazione sono più precise che con i vettori OGR in QGIS.

Suggerimento: Layer PostGIS

Normalmente, un vettore PostGIS è definito da una voce nella tabella geometry_columns. QGIS può caricare
layers che non dispongono di una voce nella tabella geometry_columns. Ciò include sia tabelle che viste. La
definizione di una vista spaziale fornisce un potente mezzo per visualizzare i tuoi dati. Consulta il tuo manuale
PostgreSQL per informazioni sulla creazione di viste.

Questa sezione contiene alcuni dettagli su come QGIS accede ai vettori PostgreSQL. La maggior parte delle volte
QGIS dovrebbe semplicemente fornirti un elenco di tabelle del database che possono essere caricate e dovrebbe
poi caricarle in base alla tua richiesta. Comunque se hai difficoltà a caricare una tabella di PostgreSQL in QGIS,
le informazioni seguenti ti possono aiutare a capire tutti i messaggi di QGIS e ti possono dare un’indicazione di
come cambiare le tabelle o le definizioni delle viste di PostgreSQL in modo che QGIS le possa caricare.

Chiave primaria

QGIS richiede che i vettori PostgreSQL contengano una colonna che possa essere usata come chiave univoca per il
vettore. Le tabelle devono contenere una chiave primaria o una colonna con un vincolo univoco. Questa colonna
deve essere di tipo int4 (un numero intero di 4 byte). Alternativamente, la colonna ctid può essere usata come
chiave primaria. Se a una tabella mancano queste informazioni, verrà usata la colonna oid. Le prestazioni saranno
migliori se la colonna è indicizzata (le chiavi primarie sono indicizzate automaticamente in PostgreSQL).

QGIS prevede una casella di controllo Seleziona all’ID che viene attivata per impostazione predefinita. Questa
opzione ottiene gli id senza gli attributi il che è più veloce nella maggior parte dei casi.

Viste

Se il layer di PostgreSQL è una vista sussistono gli stessi requisiti, ma non sempre necessitano chiavi primarie o
colonne con vincoli univoci. Devi definire un campo della chiave primaria (deve essere un intero) nella finestra
di dialogo di QGIS prima di caricare la vista. Se non c’è una colonna adatta nella vista, QGIS non caricherà il
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vettore. Se succede la soluzione è di modificare la vista in modo che contenga una colonna adatta (un intero e una
chiave primaria con un vincolo univoco, preferibilmente indicizzato).

Come per le tabelle, una casella di controllo Seleziona all’ID è attiva per impostazione predefinita (vedere sopra
per il significato della casella di controllo). Può aver senso disattivare questa opzione quando si utilizzano viste
impegnative.

Stili di default dei layer QGIS e backup del database

Se vuoi fare una copia di backup del tuo database PostGIS usando i comandi pg_dump e pg_restore, e gli
stili di default dei layer come salvati da QGIS non ripristinabili in seguito, devi impostare l’opzione XML su
DOCUMENT prima del comando di ripristino.

SET XML OPTION DOCUMENT;

Filtro lato server

QGIS consente di filtrare le geometrie già sul lato server. Per fare ciò attiva Impostazioni → Opzioni → Origine

dati → Esegui le espressioni sul lato server sul lato server se possibile. Saranno accettate solo le espressioni
supportate dal database. Le espressioni che utilizzano operatori o funzioni non supportati saranno restituite alla
esecuzione in locale.

Supporto di PostgreSQL alle diverse tipologie di dati

La maggior parte dei tipi di dati più comuni sono supportati da PostgreSQL: intero, numero in virgola mobile, dati
stringa a lunghezza variabile, geometria, timestamp, array e hstore.

Importare dati in PostgreSQL

I dati possono essere importati in PostreSQL/PostGIS usando diversi strumenti, come il plugin DB Manager e gli
strumenti da riga di comando shp2pgsql e ogr2ogr

DB Manager

QGIS ha un plugin di base chiamato DB Manager. Si può utilizzare per caricare dati, e include il supporto per gli
schemi. Vedi la sezione Plugin DB Manager per ulteriori informazioni.

shp2pgsql

PostGIS include una utility chiamata shp2pgsql che può essere utilizzata per importare i set di dati in formato
Shapefile in un database PostGIS. Per esempio, per importare un set di dati in formato Shapefile chiamato lakes.
shp` in un database PostgreSQL chiamato gis_data, usare il seguente comando:

shp2pgsql -s 2964 lakes.shp lakes_new | psql gis_data

Questo comando crea un nuovo vettore, chiamato lakes_new , nel database gis_data. Il nuovo vettore
avrà un identificatore del sistema di riferimento (SRID) corrispondente a 2964. Vedi la sezione Lavorare con le
proiezioni per ulteriori informazioni sui sistemi di riferimento spaziali e sulle proiezioni.

Suggerimento: Esportare dati da PostGIS
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Come lo strumento di importazione shp2pgsql, c’è anche uno strumento per esportare i set di dati PostGIS nel
formato Shapefile: pgsql2shp. Questo viene fornito all’interno della tua distribuzione PostGIS.

ogr2ogr

Oltre a shp2pgsql e DB Manager c’è un altro strumento per caricare dati in PostGIS: ogr2ogr. Questo strumento
fa parte dell’installazione di GDAL

Per importare un set di dati in formato Shapefile in PostGIS, procedere come segue:

ogr2ogr -f "PostgreSQL" PG:"dbname=postgis host=myhost.de user=postgres
password=topsecret" alaska.shp

Questo importerà il set di dati alaska.shp in formato Shapefile nel database PostGIS postgis usando l’utente
postgres con la password topsecret sul server host myhost.de.

Nota che OGR deve essere compilato con PostgreSQL per supportare PostGIS. Puoi verificare ciò digitando (in

) :

ogrinfo --formats | grep -i post

Se preferisci utilizzare il comando COPY di PostgreSQL invece del metodo predefinito INSERT INTO, puoi

esportare la seguente variabile d’ambiente (disponibile almeno in e ):

export PG_USE_COPY=YES

ogr2ogr non crea indici spaziali come shp2pgsl. Devi crearli manualmente, usando come passo aggiuntivo il
comando SQL CREATE INDEX dopo l’importazione, come passo aggiuntivo (come descritto nella sezione
seguente Migliorare le prestazioni).

Migliorare le prestazioni

Recuperare gli oggetti da un database PostgreSQL può richiedere molto tempo, specialmente in rete. Puoi miglio-
rare le prestazioni di caricamento dei layer PostgreSQL assicurando l’esistenza di un indice spaziale PostGIS su
ogni layer del database. PostGIS supporta la creazione di un indice GiST (Generalized Search Tree) per velo-
cizzare le ricerche spaziali dei dati (le informazioni dell’indice GiST sono tratte dalla documentazione PostGIS
disponibile all’indirizzo https://postgis.net).

Suggerimento: Puoi utilizzare il DBManager per creare un indice del tuo layer. Dovresti prima selezionare il
livello e cliccare su Tabella → Modifica tabella, andare nella scheda Indici e cliccare su Aggiungi indice spaziale.

La sintassi per creare un indice GIST è:

CREATE INDEX [indexname] ON [tablename]
USING GIST ( [geometryfield] GIST_GEOMETRY_OPS );

Nota che per tabelle molto grandi, la creazione dell’indice può richiedere parecchio tempo. Non appena l’indice
è stato creato, dovresti effettuare un VACUUM ANALYZE. Vedi la documentazione di PostGIS (POSTGIS-
PROJECT Letteratura e riferimenti web) per ulteriori informazioni.

Segue un esempio di come creare un indice GiST:

gsherman@madison:~/current$ psql gis_data
Welcome to psql 8.3.0, the PostgreSQL interactive terminal.

Type: \copyright for distribution terms
\h for help with SQL commands
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\? for help with psql commands
\g or terminate with semicolon to execute query
\q to quit

gis_data=# CREATE INDEX sidx_alaska_lakes ON alaska_lakes
gis_data-# USING GIST (the_geom GIST_GEOMETRY_OPS);
CREATE INDEX
gis_data=# VACUUM ANALYZE alaska_lakes;
VACUUM
gis_data=# \q
gsherman@madison:~/current$

Vettori a cavallo dei 180° di longitudine

Molti pacchetti GIS non prevedono mappe vettoriali con un sistema di riferimento geografico (lat/lon) che at-
traversa la linea di longitudine a 180 gradi (http://postgis.refractions.net/documentation/manual-2.0/ST_Shift_
Longitude.html_Shift_Longitude.html). Come risultato, se apriamo una tale mappa in QGIS, vedremo due lu-
oghi lontani e distinti, che dovrebbero apparire uno vicino all’altro. In Figure_vector_crossing, il piccolo punto
all’estrema sinistra della mappa (Chatham Islands) dovrebbe essere all’interno della griglia, alla destra delle isole
principali della Nuova Zelanda.

Figure 12.19: Mappa in lat/lon a cavallo dei 180° di longitudine

Una soluzione consiste nel trasformare i valori di longitudine utilizzando PostGIS e la funzione
ST_Shift_Longitude. Questa funzione legge i punti/vertici di ogni elemento di una geometria e se la coordi-
nata di longitudine è < 0° , aggiunge 360°. Il risultato sarà una versione 0° - 360° dei dati, che verranno poi
visualizzati su una mappa centrata a 180°.

Figure 12.20: Vettori a cavallo di 180° di longitudine usando la funzione ST_Shift_Longitude

Guida all’uso

• Importa i dati in PostGIS (Importare dati in PostgreSQL) usando, per esempio, il plugin DB Manager.
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• Usa l’interfaccia da linea di comando di PostGIS per dare il seguente comando (nell’esempio
“TABLE” è il nome della tua tabella PostGIS): gis_data=# update TABLE set
the_geom=ST_Shift_Longitude(the_geom);

• Se tutto è andato a buon fine, riceverai la conferma sul numero di geometrie che sono state aggiornate.
Potrai cosi caricare la mappa e vedere le differenze (Figure_vector_crossing_map).

Vettori SpatiaLite

Se vuoi salvare un layer vettoriale in formato SpatiaLite, puoi farlo cliccando con il tasto destro del mouse sul
layer nella legenda. Quindi, fai clic su Salva come. . . , definisci il nome del file di output e seleziona “SpatiaLite”
come formato e il SR. Inoltre, puoi selezionare “SQLite” come formato e poi aggiungere SPATIALITE=YES nel
campo di opzione per la creazione dell’origine dati OGR. Questo dice a OGR di creare un database SpatiaLite.
Vedi anche https://www.gdal.org/ogr/drv_sqlite.html_sqlite.html.

QGIS supporta anche viste modificabili in SpatiaLite.

Se vuoi creare un nuovo layer SpatiaLite, fai riferimento alla sezione Creare un nuovo layer SpatiaLite.

Suggerimento: SpatiaLite data management Plugins

Per la gestione dei dati di SpatiaLite puoi utilizzare anche diversi plugin Python: QSpatiaLite, SpatiaLite Manager
o DB Manager (plugin core, consigliato). Se necessario, possono essere scaricati e installati con il programma di
installazione plugin.

Parametri specifici di GeoJSON

Quando esportazione dei layer in GeoJSON, questo formato ha alcune specifiche Opzioni del Layer disponibili.
Queste opzioni provengono in realtà da GDAL che è responsabile della scrittura del file:

• COORDINATE_PRECISION il numero massimo di cifre dopo il separatore decimale da inserire in coordi-
nate. I valori predefiniti sono 15 (nota: per le coordinate Lat Lon 6 è considerato sufficiente). La troncatura
si verifica per rimuovere gli zeri finali.

• WRITE_BBOX impostato su YES per scrivere una proprietà bbox con il rettangolo di delimitazione delle
geometrie a livello di elemento e di collezione di elementi.

Layer DB2 Spatial

IBM DB2 per Linux, Unix e Windows (DB2 LUW), i prodotti IBM DB2 per z/OS (mainframe) e IBM DashDB
consentono agli utenti di memorizzare e analizzare i dati spaziali nelle colonne della tabella relazionale. La
funzione DB2 per QGIS supporta la gamma completa di visualizzazione, analisi e manipolazione dei dati spaziali
in questi database.

La documentazione utente su queste funzionalità può essere trovata in DB2 z/OS KnowledgeCenter, DB2 LUW
KnowledgeCenter e DB2 DashDB KnowledgeCenter.

Per ulteriori informazioni sul funzionamento delle opzioni spaziali DB2, consulta il Tutorial DB2 Spatial Tutorial
su IBM DeveloperWorks.

La funzionalità DB2 attualmente supporta solo l’ambiente Windows tramite il driver ODBC di Windows.

Il client che esegue QGIS deve disporre di uno dei seguenti componenti installati:

• DB2 LUW

• IBM Data Server Driver Package

• IBM Data Server Client

166 Chapter 12. Gestione fonti dati

https://www.gdal.org/ogr/drv_sqlite.html_sqlite.html
https://www.ibm.com/support/knowledgecenter/en/SSEPEK_11.0.0/spatl/src/tpc/spatl_db2sb03.html
https://www.ibm.com/support/knowledgecenter/SSEPGG_11.1.0/com.ibm.db2.luw.spatial.topics.doc/doc/db2sb03.html
https://www.ibm.com/support/knowledgecenter/SSEPGG_11.1.0/com.ibm.db2.luw.spatial.topics.doc/doc/db2sb03.html
https://www.ibm.com/support/knowledgecenter/SS6NHC/com.ibm.db2.luw.spatial.topics.doc/doc/csbp1001.html
https://www.ibm.com/developerworks/data/tutorials/dm-1202db2spatialdata1/


QGIS User Guide, Release 3.4

Per aprire un database DB2 in QGIS, si può fare riferimento alla sezione:ref:browser_panel o Caricare layer da
Database.

Se stai accedendo a un database DBW LUW sulla stessa macchina o che utilizza DB2 LUW come client, i file di
esecuzione e i files di supporto DB2 devono essere inclusi nel percorso di Windows. Ciò può essere fatto creando
una file batch come seguire con il nome db2.bat e includendolo nella directory %OSGEO4W_ROOT%/etc/ini.

@echo off
REM Point the following to where DB2 is installed
SET db2path=C:\Program Files (x86)\sqllib
REM This should usually be ok - modify if necessary
SET gskpath=C:\Program Files (x86)\ibm\gsk8
SET Path=%db2path%\BIN;%db2path%\FUNCTION;%gskpath%\lib64;%gskpath%\lib;%path%
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CHAPTER 13

Lavorare con i vettori

13.1 Libreria della simbologia

13.1.1 Gestore di stile

Il Gestore di stile è il luogo in cui gli utenti possono gestire e creare la simbologia e le scale di colori generali da
usare in diversi progetti QGIS. Puoi aprire tale finestra di dialogo non modale:

• con il pulsante Gestore di stile della barra degli strumenti;

• dal menu Impostazioni → Gestore di stile. . . ;

• o dalla scheda Proprietà layer → Simbologia di un vettore (usando il pulsante Gestore di stile in una finestra
di dialogo di proprietà della simbologia ).

La finestra di dialogo ti permette di:

• creare, modificare e rimuovere la simbologia e le scale di colore;

• organizzare la simbologia e le scale di colore in gruppi personalizzati;

• esportare e importare la simbologia e le scale di colore.

Organizzare la simbologia e le scale di colore

La finestra di dialogo Gestore di stile mostra al centro una cornice con elementi in anteprima organizzati in schede:

• Tutti per una raccolta completa di simboli punto, lineari e di superficie poiché i seguenti elementi consentono
solo di visualizzare un singolo gruppo di articoli

• Simbolo per simboli puntuali;

• Linea per simboli lineari;

• Riempimento per simboli areali;

• e Scala di colori
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Figure 13.1: Gestore di stile

Per ogni insieme di oggetti, puoi organizzare gli oggetti in diverse categorie, elencate nel pannello a sinistra:

• Preferiti: visualizzato di default quando si configura un oggetto, mostra un insieme di simboli di default e
scale di colori che è possibile estendere;

• Tutti: elenco di tutti i simboli e le scale di colori installate;

• Etichette: mostra un elenco di etichette che è possibile utilizzare per identificare gli articoli. Un simbolo
o una scala di colori può essere etichettato più di una volta. Seleziona una etichetta nell’elenco e vedrai
gli elementi che gli appartengono per ogni tipo di oggetto. Per creare una nuova etichetta da allegare

successivamente ai simboli o alle scale di colori, usa il pulsante Aggiungi Etichetta. . . oppure seleziona
Aggiungi oggetto da qualsiasi menu contestuale delle etichette;

• Gruppo intelligente: un gruppo intelligente recupera dinamicamente i suoi simboli in base alle condizioni
impostate (vedi ad esempio, figura_smart_group_group). Fai clic sul pulsante Aggiungi gruppo intelli-
gente. . . . per creare gruppi intelligenti. La finestra di dialogo consente di inserire un’espressione per filtrare
gli elementi da selezionare (ha un etichetta particolare, ha una stringa nel suo nome). Qualsiasi simbolo o
scala di colori che soddisfi la/e condizione/i immessa/e viene aggiunto automaticamente al gruppo intelli-
gente.

Figure 13.2: Creare un gruppo intelligente

Le etichette e i gruppi intelligenti non si escludono a vicenda: sono semplicemente due modi diversi per orga-
nizzare i tuoi simboli e le scale di colori. A differenza dei gruppi intelligenti che recuperano automaticamente

170 Chapter 13. Lavorare con i vettori



QGIS User Guide, Release 3.4

gli oggetti di loro proprietà in base ai vincoli di input, le etichette sono caricate dall’utente. Per modificare una
qualsiasi di queste categorie, puoi:

• seleziona gli oggetti, fai clic con il tasto destro del mouse e scegli Aggiungi alle Etichette → e quindi
seleziona il nome dell’etichetta o crea una nuova etichetta;

• seleziona l’etichetta e premi Modifica Gruppo → Attach Selected Tag to Symbols. Una casella di con-

trollo appare vicino ad ogni oggetto per aiutarti a selezionarlo o deselezionarlo. Quando la selezione è
terminata, premi Modifica Gruppo → Finish Tagging.

• seleziona il gruppo intelligente, premi Modifica Gruppo → Modifica Gruppo intelligente. . . . e configura
un nuovo insieme di vincoli nella finestra di dialogo Editor del gruppo intelligente. Questa opzione è
disponibile anche nel menu contestuale del gruppo intelligente.

Per rimuovere una etichetta o un gruppo intelligente, fai clic con il tasto destro del mouse su di esso e seleziona il

pulsante Rimuovi. Da notare che questo non cancella gli oggetti raggruppati nella categoria.

Aggiungere, modificare o rimuovere un oggetto

Come visto in precedenza, i simboli e le scale di colori sono elencati in diverse schede il cui contenuto dipende
dalla categoria attiva (etichette, gruppi intelligenti, preferiti. . . .). Per ogni tipo di simboli (Simbolo , Linea o
Riempimento) e scala di colori, quando la scheda è abilitata, puoi:

• Aggiungere nuovi oggetti: premi il pulsante Aggiungi Etichetta. . . . e configura l’oggetto come descritto nel
costruttore di symbols o color ramps.

• Modificare un oggetto esistente: seleziona un oggetto e premi il pulsante Modifica Oggetto. . . e configura
come sopra indicato.

• Cancellare oggetti esistenti: per cancellare un simbolo non più necessario, selezionalo e clicca su
Rimuovi Oggetto (disponibile anche con il tasto destro del mouse). Il simbolo viene cancellato dalla banca dati
locale dei simboli.

Facendo clic destro su una selezione di oggetti puoi anche fare:

• Aggiungi ai Preferiti;

• Rimuovi dai Preferiti;

• Add to Tag → e selezionare l’etichetta appropriata o crearne una nuova da utilizzare;

• Cancella Etichette: elimina i simboli da tutti gli elenchi;

• Rimuovi Oggetto(i);

• Modifica Oggetto. . . : si applica all’oggetto sul quale si fa clic con il tasto destro del mouse;

• Esporta Simbolo(i) selezionato(i) come PNG. . . . (non disponibile con scale di colori);

• Esporta Simbolo(i) selezionato(i) come SVG. . . . (non disponibile con rampe di colore);

Condivisione di simboli e scale di colori

Lo strumento Importa/Esporta, in basso a sinistra della finestra di dialogo Gestore di stile, offre opzioni per
condividere facilmente simboli e scale di colori con altri. Queste opzioni sono disponibili anche cliccando con il
tasto destro del mouse sugli oggetti.

Esportare oggetti

Puoi esportare un insieme di oggetti in un file .XML:
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1. Espandi il menu a discesa Importa/Esporta e seleziona Esporta oggetto(i). . .

2. Scegli i simboli e le scale di colori che vorresti inserire. La selezione dei simboli può essere effettuata con
il mouse o utilizzando una etichetta o un gruppo precedentemente impostato.

3. Premi Esporta quando hai finito. Ti verrà richiesto di indicare la destinazione del file da salvare. Il formato
XML genera un unico file contenente tutti i simboli selezionati. Questo file può quindi essere importato
nella libreria di stile di un altro utente.

Figure 13.3: Esportare simboli e scale di colori

Quando i simboli sono selezionati, puoi anche esportarli in .PNG o .SVG. L’esportazione in .PNG o .SVG
(entrambi non disponibili per i simboli di scala di colori) crea un file per ogni simbolo selezionato in una data
cartella. La cartella SVG può essere aggiunta alla cartella Percorsi SVG nel menu Impostazioni → Opzioni →
Sistema di un altro utente, permettendogli l’accesso diretto a tutti questi simboli.

Importare oggetti

Puoi ampliare la tua libreria di simboli importando nuovi simboli:

1. Espandi il menu a discesa Importa/Esporta e seleziona Importa Oggetti. . . nella parte inferiore
sinistra della finestra di dialogo.

2. Nella nuova finestra di dialogo, indica la fonte dei simboli (può essere un .xml su disco o un URL),

3. Scegli se Aggiungi ai Preferiti gli oggetti da importare.

4. Seleziona Non importare etichette incorporate per evitare l’importazione di etichette associate agli
oggetti da importare.

5. Inserisci il nome per ogni Aggiungi Etichetta da applicare alle nuove voci.

6. Seleziona dall’anteprima l’elemento che vuoi aggiungere alla tua libreria.

7. e premi Importa.
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Figure 13.4: Importare simboli e scale di colori

Scala Colore

La scheda Scala di colori nella finestra di dialogo Gestore di stile ti aiuta a visualizzare in anteprima le diverse
scale di colori in base alla categoria selezionata nel pannello di sinistra.

Per creare una scala di colori personalizzata, attiva la scheda Scala di colori e clicca il pulsante Agiungi oggetto.
Il pulsante apre un menù a tendina per scegliere il tipo di scala:

• Gradiente: dati i colori di inizio e fine, genera una scala di colori che può essere di tipo continuo o discreto.
Facendo doppio click sull’anteprima della scala, puoi aggiungere tutti i punti di interruzione intermedi di
colore che vuoi.

• Colori preimpostati: permette di creare una scala di colori composta da una lista di colori selezionati
dall’utente;

• Casuale: crea una serie casuale di colori basata su un intervallo di valori per Tonalità, Saturazione, Valori e
Opacità e una serie di colori (Classi);

• ColorBrewer: una serie di gradienti di colore predefiniti di tipo discreto di cui puoi personalizzare il numero
di colori nella scala;

• o Catalog: cpt-city: un accesso a un intero catalogo di gradienti di colore da salvare a livello locale :guilabel:
Salva come gradiente standard. L’opzione cpt-city apre un nuova finestra di dialogo con centinaia di temi
inclusi “pronti all’uso”.

Suggerimento: Regolare facilmente le interruzioni di colore della scala di colori a gradiente

Facendo doppio click sull’anteprima della scala o trascinando e rilasciando un colore da quelli disponibili dentro
l’anteprima della scala, si aggiunge una nuova interruzione di colore. Ciascuna interruzione di colore può essere
aggiustati usando il widget Scelta colore o tramite il grafico per ciascun parametro. Puoi anche riposizionarla
usando il mouse , i tasti freccia (in combinazione con il tasto Shift per uno spostamento maggiore) o la casella
di selezione Posizione relativa . Premendo Elimina interruzione oppure il tasto DEL si rimuove l’interruzione di
colore selezionata.

13.1. Libreria della simbologia 173



QGIS User Guide, Release 3.4

Figure 13.5: Esempio di Scala di colori a gradiente personalizzata con interruzioni multiple
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Figure 13.6: Finestra di dialogo cpt-city con centinaia di scale di colori
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13.1.2 Selettore Simbolo

Il selettore simbolo è la finestra di dialogo principale per disegnare una simbologia. Puoi creare o modificare la
simbologia Simbolo, Linea o Riempimento.

Figure 13.7: Configurare un simbolo lineare

Due componenti principali strutturano la finestra di dialogo Selettore simbolo:

• l’albero del simbolo, che mostra i layer del simbolo che vengono poi combinati per formare un nuovo
simbolo globale

• e le impostazioni per configurare il layer simbolo selezionato all’interno dell’albero.

L’albero dei layer simbolo

Un simbolo può essere costituito da vari Layer simbolo. L’albero del simbolo mostra la sovrapposizione di questi
layer simbolo che vengono poi combinati per formare un nuovo simbolo globale. Infatti, appena le proprietà del
simbolo cambiano, una rappresentazione dinamica del simbolo viene aggiornata.

È disponibile una serie di strumenti per gestire gli oggetti dell’albero del simbolo e, in corrispondenza con il livello
selezionato, saranno abilitati differenti strumenti sotto la finestra di dialogo per:

• aggiungere un nuovo layer simbolo: puoi impilare quanti simboli vuoi

• rimuovere il layer simbolo selezionato
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• bloccare i colori del layer del simbolo: un colore bloccato rimane invariato quando l’utente cambia il
colore del simbolo a livello globale (o superiore)

• duplicare un (gruppo di) layer simbolo

• spostare in sù o in giù un layer simbolo

Quando è selezionato un layer simbolo nell’albero, puoi anche:

• controllare la sua visibilità con l’opzione Abilita layer. I layer simboli disabilitati non vengono dis-
egnati, ma vengono salvati e possono essere attivati in un secondo momento. In questo modo è più facile
personalizzare parti del simbolo in base agli attributi degli oggetti o modificare l’aspetto del simbolo senza
dover cancellare completamente un layer simbolo;

• applicare rendering effects utilizzando il pulsante Personalizza gli effetti.

Configurare una simbologia

In QGIS la configurazione di una simbologia viene fatta in due fasi: il simbolo e il layer simbolo

Il simbolo

Al livello superiore dell’albero, la simbologia dipende dalla geometria del layer e può essere di tipo Simbolo,
Linea o Riempimento. Ogni simbolo può incorporare uno o più simboli (compresi quelli di qualsiasi altro tipo)
o simboli vettoriali.

Puoi impostare alcuni parametri che si appliccano al simbolo globale:

• Unità o Dimensione o Spessore: può essere Millimetri, Punti, Pixel, Metri alla Scala, Unità mappa o
Pollici.

• Trasparenza

• Colore: quando questo parametro viene cambiato dall’utente, il suo valore viene ereditato dai colori dei
sotto-simboli purché non siano bloccati

• Dimensione e Rotazione per simboli puntuali

• Larghezza per simboli lineari

Nota: Il pulsante Data-defined override accanto ai parametri relativi all’ultimo layer è inattivo quando si imposta
il simbolo dalla finestra di dialogo Gestore di stile. Quando il simbolo è connesso a un vettore della mappa, questo
pulsante aiuta a creare un’analisi di visualizzazione proporzionale o multivariata.

I simboli usati a questo livello sono oggetti che puoi scegliere dalla libreria Gestore di stile. I simboli disponibili
del tipo corrispondente sono mostrati e, attraverso l’elenco a discesa modificabile di cui sopra, possono essere

filtrati da testo libero o da categories. Puoi anche aggiornare l’elenco dei simboli usando il pulsante Gestore di stile

e aprire la relativa finestra di dialogo. Qui puoi utilizzare qualsiasi funzionalità esposta nella sezione Gestore di
stile.

I simboli vengono visualizzati o:

• in una lista di icone (con miniature, nome e etichette associate) usando il pulsante List View situato nella
parte inferiore della cornice;

• o come anteprima dell’icona usando il pulsante Icon View.

Premi il pulsante Salva il Simbolo per aggiungere qualsiasi simbolo in fase di modifica alla libreria dei simboli.

Con l’opzione Avanzato , puoi:
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• impostare Livelli simbolo: definire il modo in cui i livelli del simbolo sono connessi tra loro nella mappa
(vedi Livelli simbolo per maggiori informazioni)

• per simboli Linea e Riempimento, Ritaglia le geometrie all’estensione della mappa.

Suggerimento: Nota che una volta impostata la dimensione nei livelli inferiori della finestra di dialogo del Layer
simbologia , la dimensione dell’intero simbolo può essere cambiata nuovamente con il menù Dimensione (per
simboli punto) o Larghezza (per simboli linea). La dimensione dei livelli inferiori cambia di conseguenza, mentre
il rapporto di proporzione tra le dimensioni rimane invariato.

Layer della simbologia

Al livello inferiore dell’albero puoi personalizzare i layer della simbologia. I tipi di simbolo del layere dipendono

dal tipo di simbologia del livello superiore. Puoi applicare al layer della simbologia Effetti disegno per
migliorarne la visualizzazione.

Poiché descrivere tutte le opzioni di tutti i tipi di layer simbolo non sarebbe possibile, sono menzionati qui sotto
solo quelli particolari e significativi.

Parametri comuni

Sono disponibili alcune opzioni e widget comuni per costruire un layer simbolo, a prescindere che sia di tipo
puntuale, lineare o riempimento

• il widget selettore colore per facilitare la manipolazione del colore

• Unit: può essere Millimetri, Punti, Pixel, Metri alla Scala, Unità mappa o Pollici

• il widget sovrascrittura definita dai dati accanto a quasi tutte le opzioni, per estendere le possibilità di personal-
izzare ciascun simbolo (vedi Impostazione Sovrascrittura definita dai dati per maggiori informazioni)

Nota: La descrizione qui sotto presuppone che il Tipo simbolo del vettore sia legato alla geometria dell’elemento,
ma tieni a mente che puoi impilare i layer della simbologia l’uno sull’altro. In tal caso il parametro del simbolo di
livello inferiore (posizionamento, offset. . . ) può essere legato al simbolo del livello superiore, e non alla geometria
dell’elemento in sé.

Simboli per vettori puntuali

Per caratterizzare le geometria puntuali sono disponibili diverse Tipologie di simboli:

• Simbolo semplice (default);

• Simbolo ellisse: un simbolo semplice con larghezza e altezza personalizzabili;

• Simbolo riempito: simile al simbolo semplice, ad eccezione del fatto che utilizza un fill sub symbol per
realizzare il simbolo. Ciò ti consente di utilizzare per i simboli tutti gli stili di riempimento (e contorni)
esistenti di QGIS, ad es. sfumature o riempimenti a gradiente;

• Simbolo carattere: utilizza per i simboli puntuali i caratteri installati;

• Generatore geometria (vedi Generatore geometria);

• Simbolo campo vettoriale (vedi Il Simbolo di Campo Vettoriale);

• Simbolo SVG: ti rende disponibili immagini dai percorsi SVG (impostati nel menu Impostazioni →
Opzioni. . . .. → Sistema) da utilizzare come simbolo. La larghezza e l’altezza del simbolo possono essere
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impostate indipendentemente o usando il Blocca le proprzioni. Ogni file SVG può anche essere modificato
nei colori e nei contorni.

Nota: Requisiti versione SVG

QGIS visualizza i file SVG che rispettano il formato SVG Tiny 1.2, destinato all’implementazione su una
gamma di dispositivi, dai telefoni cellulari e PDA ai computer portatili e desktop, e quindi include un sottoin-
sieme delle funzionalità incluse in SVG 1.1 Full, insieme a nuove funzionalità per estendere le funzionalità
di SVG.

Alcune funzionalità non incluse in queste specifiche potrebbero non essere visualizzate correttamente in
QGIS.

Suggerimento: Attivare la personalizzazione del simbolo del marcatore SVG

Per avere la possibilità di cambiare i colori di un Simbolo SVG, è necessario aggiungere il
param(fill) per il riempimento con il colore, il param(outline) per il colore del contorno e il
param(outline-width) per lo spessore del contorno. Questi parametri possono essere facoltativa-
mente seguiti da un valore predefinito, ad esempio:

<svg width="100%" height="100%">
<rect fill="param(fill) #ff0000" stroke="param(outline) #00ff00" stroke-width=
→˓"param(outline-width) 10" width="100" height="100">
</rect>
</svg>

Per ogni tipologia di simbolo puntuale, puoi impostare alcune delle seguenti proprietà:

• Dimensione

• Colore di riempimento usando tutte le funzionalità del widget Scelta colore, estese da una opzione per
applicare un Riempimento trasparente.

• Colore tratto usando tutte le funzionalità del widget Scelta colore, estese da una opzione per applicare un
Tratto trasparente.

• Stile tratto

• Larghezza tratto

• Stile unione

• Rotazione

• Offset: Puoi spostare il simbolo nella direzione X o Y;

• Punto di ancoraggio.

Nella maggior parte delle finestre di dialogo dei simboli di marcatura, è anche disponibile una finestra con an-
teprime dei simboli predefiniti fra cui è possibile scegliere.

Simboli lineari

Specifici per le geometria lineari, i simboli lineari prevedono le seguenti tipologie di simboli:

• Linea semplice (predefinito): le impostazioni disponibili sono:

– Colore

– Larghezza tratto

– Stile tratto
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– Stile unione

– Stile testata

– Offset

– Usa pattern tratteggiato personalizzato: sovrascrive l’impostazione Stile tratto con un tratteggio
personalizzato.

• Freccia: disegna linee con frecce curve (o non) con una singola o una doppia testa con larghezza, lunghezza
e spessore configurabili. Per creare una linea con freccia curva la linea deve avere almeno tre vertici. Usa
anche fill symbol come gradiente o ombreggiatura per enfatizzare il corpo della freccia. In combinazione
con il generatore di geometrie, questo tipo di simbolo per le linee aiuta a rappresentare mappe di flusso;

• Generatore geometria (vedi Generatore geometria);

• Linea di evidenziazione: visualizza un simbolo marcatore lungo la linea. Può essere a una distanza regolare
o basata sulla sua geometria: primo, ultimo o ogni vertice, sul punto centrale o su ogni punto della curva.
Puoi impostare un offset lungo la linea per la simbologia o compensare la linea stessa. L’opzione Ruota
simbolo ti consente di impostare se il simbolo deve seguire l’orientamento della linea o meno.

Simboli di riempimento

Appropriati per le geometrie poligonali, i simboli di riempimento sono di diverse tipologie:

• Riempimento semplice (predefinito): sono disponibili le seguenti impostazioni:

– Colore di riempimento usando tutte le funzionalità del widget Scelta colore, estese da una opzione per
applicare un Riempimento trasparente.

– Stile riempimento

– Colore tratto usando tutte le funzionalità del widget Scelta colore, estese da una opzione per applicare
un Tratto trasparente.

– Larghezza tratto

– Stile tratto

– Stile unione

– Offset: Puoi spostare il simbolo nella direzione X o Y;

• Riempimento con centroide: pone un simbolo al centroide della geometria visibile. La posizione del sim-
bolo non può tuttavia essere il centroide reale della geometria poiché il calcolo tiene conto del(i) poligono(i)
ritagliato(i) nell’area visibile nella mappa rappresentata e ignora eventuali “buchi”. Utilizza il Generatore
di geometrie se vuoi utilizzare il centroide esatto.

Il simbolo può essere posizionato su ogni parte di un poligono a più parti o solo sulla sua parte più grande
e costretto ad essere all’interno del poligono;

• Generatore geometria (vedi Generatore geometria);

• Riempimento a gradiente: per riempire le superfici poligonali utilizza un gradiente radiale, lineare o
conico, basato su gradienti semplici di due colori o su una gradient color ramp predefinita. Il gradiente può
essere ruotato e applicato su una singola geometria o in tutta l’estensione della mappa. Anche i punti di
inizio e di fine possono essere impostati tramite coordinate o utilizzando il centroide (del poligono o nella
sua visualizzazione in mappa);

• Riempimento a pattern lineare: riempe il poligono con un tipo di tratteggio della simbologia linerare. È
possibile impostare la spaziatura tra le righe e un offset dal contorno del poligono;

• Riempimento a pattern puntuale: riempe il poligono con un simbolo puntuale scelta tra la simbologia
puntuale. È possibile impostare la spaziatura tra le righe e un offset dal contorno del poligono;
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• Riempimento Raster: puoi riempire i poligoni con una immagine raster ripetuta. Le opzioni includono
(definizione dati) il nome del le, l’opacità, la dimensione dell’immagine (in pixel, mm o unità mappa), la
modalità coordinata (geometria o parte visualizzata) e la rotazione;

• Riempimento SVG: riempe il poligono usando SVG markers;

• Riempimento sfumato: questa opzione riempe il poligono in modo sfumato, la sfumatura viene disegnata
dal contorno del poligono verso il centro del poligono. I parametri di configurazione includono la distanza
dal contorno all’ombra, l’uso delle scale di colore o semplici due gradienti di colore, la sfocatura facoltativa
del riempimento e gli offset;

• Cornice: freccia: usa un simbolo lineare arrow symbol per rappresentare il contorno del poligono;

• Cornice: Simbolo lineare: utilizza una simbologia lineare per rappresentare il contorno del poligono;

• Cornice: linea semplice: utilizza un semplice simbolo lineare per rappresentare il contorno poligonale.
L’opzione Disegna la linea solo all’interno del poligono evidenzia i bordi poligonali all’interno e può essere
utile per meglio evidenziare i confini poligonali di aree adiacenti.

Nota: Quando il tipo geometria è un poligono, è possibile scegliere di disabilitare il ritaglio automatico di
linee/poligoni sull’estensione della mappa in visualizzazione. In alcuni casi questo ritaglio si traduce in una
simbologia non ottimale (ad esempio non può essere rispettato che il baricentro del riempimento sia nel baricentro
effettivo del poligono).

Generatore geometria

Disponibile per tutti i tipi di simbologia, il layer simbolo generatore geometria permette di usare le espressioni
per generare una geometria al volo durante il processo di visualizzazione. La geometria risultante non deve
corrispondere con il tipo di geometria originaria del vettore e puoi aggiungere vari layer simbolo, modificati
diversamente, l’uno sull’altro.

Alcuni esempi:

-- render the centroid of a feature
centroid( $geometry )

-- visually overlap features within a 100 map units distance from a point
-- feature, i.e generate a 100m buffer around the point
buffer( $geometry, 100 )

-- Given polygon layer1( id1, layer2_id, ...) and layer2( id2, fieldn...)
-- render layer1 with a line joining centroids of both where layer2_id = id2
make_line( centroid( $geometry ),

centroid( geometry( get_feature( 'layer2', 'id2', attribute(
$currentfeature, 'layer2_id') ) )

)

Il Simbolo di Campo Vettoriale

Il simbolo di campo vettoriale viene utilizzato per visualizzare dati puntuali a variabilità vettoriale come la defor-
mazione della terra, le ampiezze di marea e simili. Visualizza gli indicatori con segmenti (preferibilmente frecce)
che vengono ridimensionati e orientati in base agli attributi selezionati dei punti dati. Può essere utilizzato solo
per la visualizzazione di dati puntuali; i layer lineari e poligonali non utilizzano questa simbologia.

Il simbolo di campo vettoriale è definito dagli attributi nei dati, tramite:

• le componenti cartesiane (componenti x e y del campo)

• o le coordinate polari: in questo caso, gli attributi definiscono la Lunghezza e l”Angolo. L’angolo può
essere misurato in senso orario da nord, o in senso antiorario da est, e può essere in gradi o radianti.
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• o solo come dati di altezza, che visualizza una freccia verticale che viene dimensionata utilizzando un at-
tributo dei dati. Ciò è appropriato ad esempio per visualizzare la componente verticale di una deformazione.

La grandezza del simbolo può essere aumentata o diminuita per ottimizzare la visualizzazione nella rappresen-
tazione.

13.2 Proprietà dei vettori

La finestra di dialogo Proprietà. . . . fornisce le impostazioni generali per gestire l’aspetto degli oggetti del
layer nella mappa (simbologia, etichettatura, diagrammi), l’interazione con il mouse (azioni, suggerimenti per
la mappa). Fornisce anche informazioni sul layer.

Per accedere alla finestra di dialogo Proprietà. . . .:

• Nel pannello Layer, fai doppio clic sul layer o fai clic con il tasto destro del mouse e seleziona Proprietà. . . .
dal menu pop-up;

• Vai al menu Layer → Proprietà. . . . quando il layer è selezionato.

La finestra di dialogo sul vettore Proprietà vettore ha le seguenti sezioni:

• Information

• Source

• Symbology (disponibile anche nel Layer styling panel)

• Labels (disponibile anche nel pannello Layer styling)

• Diagrams

• 3D View (disponibile anche nel pannello Layer styling)

• Source Fields

• Attributes Form

• Joins

• Auxiliary Storage

• Actions

• Display

• Rendering

• Variables

• Metadata

• Dependencies

• Legend

• QGIS Server

• Digitizing

• e opzionalmente, nuove schede vengono aggiunte con gli external plugins che hai installato. Queste non
vengono trattate qui di seguito.
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Suggerimento: Condividere completamente o in parte le proprietà degli stili dei layer

Il menu Stile nella parte inferiore della finestra di dialogo consente di importare o esportare queste proprietà o
parte di esse da/per diverse destinazioni (file, appunti, database). Vedi Gestione stili personalizzati.

Nota: Poiché le proprietà (simbologia, etichetta, azioni, valori predefiniti, moduli . . . ) di layer incorporati (vedi
Progetti nidificati) sono ricavate dal file di progetto originale per evitare modifiche che potrebbero alterare questo
comportamento, la finestra di dialogo delle proprietà dei layer non è disponibile per questi layer.

13.2.1 Proprietà Informazioni

La scheda Informazioni è di sola lettura e rappresenta un posto interessante per avere rapidamente infor-
mazioni e metadati di sintesi sul layer corrente. Le informazioni fornite sono:

• basate sulla fonte dati del layer (formato di memorizzazione, percorso, tipo di geometria, codifica sorgente
dati, estensione. . . .);

• ricavato da filled metadata (accesso, link, contatti, cronologia. . . .);

• o in base alla sua geometria (estensione spaziale, SR. . . ..) o ai suoi attributi (numero di campi, caratteristiche
di ciascuno. . . .).

13.2.2 Proprietà Sorgente

Usa questa scheda per gestire le impostazioni generali di un layer vettoriale.

Figure 13.8: Finestra di dialogo scheda Generale Proprietà Layer

Oltre l’impostazione del Nome vettore come visualizzato nel pannello Layer, le opzioni disponibili includono:
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Sistema di Riferimento delle Coordinate

• Visualizza il Sistema di Riferimento delle Coordinate (SR) del vettore come una stringa PROJ.4. Puoi
modificare il SR del vettore selezionando un SR usato di recente nell’elenco a discesa o facendo clic sul

pulsante Seleziona SR (vedi Scelta del sistema di riferimento delle coordinate). Utilizza questo metodo
solo se il SR applicato al vettore è sbagliato o se non ne è stato applicato alcuno. Se si desidera riproiettare i
dati in un altro SR, utilizzare piuttosto gli algoritmi di riproiezione layer da Processing o Save it into another
layer.

• Crea indice spaziale (solo per formati supportati da OGR).

• Aggiorna estensione del vettore.

Costruttore di interrogazioni

La finestra di dialogo Costruttore di interrogazioni è accessibile attraverso il pulsante eponimo in fondo alla scheda
Sorgente nella finestra di dialogo Proprietà vettore, sotto il gruppo Filtro delle geometrie della sorgente dati.

Il Costruttore di interrogazioni fornisce un’interfaccia che permette di definire un sottoinsieme delle geometrie del
layer utilizzando una clausola SQL-like WHERE e di visualizzare il risultato nella finestra principale. Finché la
query è attiva, nel progetto sono disponibili solo le geometrie corrispondenti al suo risultato.

Puoi utilizzare uno o più attributi del layer per definire il filtro nel Costruttore di interrogazioni‘. L’uso di più di
un attributo è mostrato in Figure_vector_querybuilder. Nell’esempio, il filtro combina gli attributi

• toa (DateTime field: cast("toa" as character) > '2017-05-17' and cast("toa" as
character) < '2019-12-24T18:00:00'),

• name (String field: "name" > 'S') and

• FID (Integer field: FID > 10)

utilizzando gli operatori AND, OR e NOT e le parentesi. Questa sintassi (incluso il formato DateTime per il
campo toa) funziona per i set di dati GeoPackage.

Il filtro viene creato a livello della fonte dati (OGR, PostgreSQL, MSSQL . . . ). Quindi la sintassi dipende dalla
fonte dati (DateTime ad esempio non è supportato per il formato Shapefile ESRI). L’espressione completa:

cast("toa" as character) > '2017-05-17' AND
cast("toa" as character) < '2019-12-24T18:00:00' AND
NOT ("name" > 'S' OR FID > 10)

Puoi anche aprire la finestra di dialogo Costruttore di interrogazioni utilizzando l’opzione Filtro. . . dal menu
Layer o dal menu contestuale del layer. Le sezioni Campi, Valori e Operatori nella finestra di dialogo ti aiutano a
costruire la query di tipo SQL visualizzata nella casella Espressioni filtro specifiche del gestore.

L’elenco Campi contiene tutti i campi del layer. Per aggiungere una colonna attributo al campo della condizione
SQL WHERE, fai doppio click sul suo nome o semplicemente digitalo nel box SQL.

Il riquadro Valori elenca i valori del campo attualmente selezionato. Per elencare tutti i valori unici di un campo,
fai clic sul pulsante Tutto. Per elencare invece i primi 25 valori univoci della colonna, fai clic sul pulsante Cam-
pione. Per aggiungere un valore al campo della clausola SQL WHERE, fai doppio clic sul suo nome nella lista
Valori. Puoi utilizzare la casella di ricerca nella parte superiore del riquadro Valori per sfogliare e trovare facil-
mente i valori degli attributi nella lista.

La sezione Operatori elenca tutti gli operatori che puoi usare. Per aggiungere un operatore nella casella delle
clausole SQL WHERE, clicca sul pulsante appropriato. Sono disponibili operatori relazionali (=, >, . . . ), operatori
per confrontare stringhe di testo (LIKE) ed operatori logici (AND, OR, . . . ).

Il pulsante Test ti aiuta a controllare la tua richiesta e visualizza una casella messaggio con il numero di geometrie
che soddisfano la richiesta corrente. Utilizza il pulsante Pulisci per cancellare la query SQL e ripristinare il layer
al suo stato originale (cioè, caricare completamente tutte le geometrie).

Quando viene applicato un filtro, QGIS tratta il sottoinsieme risultante agisce come se fosse l’intero layer. Per
esempio, se applichi il filtro di cui sopra per “Borough” ("TYPE_2" = 'Borough'), non puoi visualizzare,
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Figure 13.9: Costruttore di interrogazioni
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interrogare, salvare o modificare Anchorage, perché questo è una “Municipality” e quindi non fa parte del
sottoinsieme.

Suggerimento: I Layer filtrati sono evidenziati nel Pannello Layer

Nel pannello Layer, il layer filtrato è elencato con una icona Filter accanto ad esso che indica la query utilizzata
quando il mouse passa sopra il pulsante. Facendo doppio clic sull’icona si apre la finestra di dialogo Costruttore
di interrogazioni per la modifica.

13.2.3 Proprietà Simbologia

La Scheda Simbologia ti fornisce uno strumento completo per la visualizzazione e la simbologia dei dati
vettoriali. Puoi utilizzare gli strumenti che sono comuni a tutti i dati vettoriali, così come gli strumenti simbolo
speciale che sono stati progettati per i diversi tipi di dati vettoriali. Tuttavia tutti i tipi condividono la seguente
struttura della finestra di dialogo: nella parte superiore, disponi di un widget che ti consente di impostare il tipo
simbolo e la classificazione per le geometrie e nella parte inferiore il widget Visualizzazione del layer.

Suggerimento: Scorri rapidamente tra le diverse rappresentazioni del layer

Utilizzando il menu Stile → Aggiungi. . . in fondo alla finestra di dialogo Proprietà Layer, è puoi salvare tutti
gli stili di cui hai bisogno. Uno stile è la combinazione di tutte le proprietà che desideri per un layer (come la
simbologia, l’etichettatura, il diagramma, la forma dei campi, le azioni. . . .). Quindi, basta passare da uno stile
all’altro dal menu contestuale del layer in Pannello layer per ottenere automaticamente rappresentazioni diverse
dei tuoi dati.

Suggerimento: Esporta simbologia vettore

Hai la possibilità di esportare la simbologia del vettore da QGIS nei file Google *.kml, *.dxf e MapInfo *.tab.
Semplicemente, clicca con il tasto destro sul vettore per aprire il menu contestuale e clicca su Salva con nome. . .
per specificare il nome del file in uscita e il suo formato. Nella finestra di dialogo, usa il menu Esporta simbologia
per salvare la simbologia o come Simbologia elementi → o come Simbologia simboli del vettore →. Se hai
utilizzato dei simboli, si consiglia di utilizzare la seconda impostazione.

Visualizzazione delle geometrie

Il visualizzatore è responsabile della visualizzazione di una geometria insieme al simbolo corretto. Indipenden-
temente dal tipo di geometria del vettore, esistono quattro tipologie comuni di visualizzatori: simbolo singolo,
categorizzato, graduato e tramite regole. Per vettori di punti, sono disponibili i visualizzatori spostamento punto
e mappa di concentrazione, mentre i vettori di poligoni possono essere visualizzati anche con il visualizzatore
invertito e il visualizzatore 2.5 D.

Il visualizzatore a colorazione continua non c’è perché è a tutti gli effetti un caso speciale del visualizzatore
graduato. I visualizzatori categorizzato e graduato possono essere modificati con simboli specifici e con scale di
colore personalizzate - i colori per i simboli saranno realizzati in modo appropriato. Per ogni tipo di vettori (punti,
linee e poligoni), sono disponibili tipi di simboli. A seconda del visualizzatore selezionato, la finestra di dialogo
offre diverse sezioni aggiuntive.

Nota: Se cambi il tipo di visualizzatore mentre imposti lo stile di un vettore, le impostazioni effettuate per
il simbolo saranno mantenute. Questo funziona solo per un cambiamento. Se si ripete la modifica del tipo di
visualizzatore le impostazioni per il simbolo saranno perse.
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Visualizzatore Simbolo Singolo

Il Visualizzatore Simbolo Singolo rappresenta tutti gli elementi di un layer tramite un unico simbolo definito
dall’utente. Vedi Selettore Simbolo per informazioni aggiuntive sulla rappresentazione del simbolo.

Figure 13.10: Finestra di dialogo Simbolo singolo

Suggerimento: Editare simboli direttamente dal Pannello Layer

Se nel tuo Panello Layer hai layer definiti in modalità categorizzata, graduata o in modalità di base, puoi mod-
ificare rapidamente il colore del simbolo delle categorie facendo clic con il pulsante destro del mouse su una

categoria e scegliere il colore che desideri con il menu Ruota colore. Facendo clic con il pulsante destro del
mouse su una categoria ti darà anche l’accesso alle opzioni Nascondi tutti gli elementi, Mostra tutti gli ele-
menti e Modifica simbolo. . . .

Visualizzatore Senza Simboli

Il visualizzatore Senza Simboli è un caso di utilizzo speciale della visualizzazione a Simbolo Singolo in
quanto applica la stessa rappresentazione a tutti gli oggetti. Utilizzando questa tipologia di visualizzazione, nes-
suna simbologia verrà disegnata sulle caratteristiche geometriche (sulla rappresentazione del punto o della linea
o del poligono), ma l’etichettatura, eventuali diagrammi e altre parti non-simbologia geometrica saranno ancora
visualizzate.

Le selezioni possono ancora essere effettuate sul layer in mappa e le geometrie selezionate verranno visualizzate
con un simbolo predefinito. Verranno mostrate anche le geometrie modificate.

Questo è inteso come una comoda scorciatoia per i layer per i quali vuoi mostrare solo le etichette o i diagrammi
evitando di dover rendere totalmente trasparente la simbologia per raggiungere questo obiettivo.
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Visualizzatore Categorizzato

Il visualizzatore Categorizzato viene utilizzato per eseguire la visualizzazione delle geometrie di un layer,
utilizzando una simbologia adatta a rappresentare i valori discreti di un campo della tabella attributi o di un campo
costruito con una espressione. Il menu categorizzato ti consente di:

• selezionare un campo esistente (utilizzando la lista a discesa) o

• digitare o generare una expression utilizzando il pulsante Imposta espressione per la colonna. L’espressione uti-
lizzata per classificare le geometrie può essere di qualsiasi tipo; può per esempio:

– fare un confronto, ad esempio myfield >= 100, $id = @atlas_featureid, myfield %
2 = 0, within( $geometry, @atlas_geometry ). In questo caso le risposte possibili
sono 1 (Vero) e 0 (Falso).

– combinare campi diversi, ad esempio concat( field1, ' ', field2 ) particolarmente
utile quando si desidera elaborare classificazioni su due o più campi contemporaneamente.

– eseguire calcoli su campi, ad esempio: myfield % 2, year( myfield ) field_1 +
field_2.

– trasformare valori lineari in classi discrete, ad esempio:

CASE WHEN x > 1000 THEN 'Big' ELSE 'Small' END

– combinare diversi valori discreti in una singola categoria, ad esempio:

CASE
WHEN building IN ('residence', 'mobile home') THEN 'residential'
WHEN building IN ('commercial', 'industrial') THEN 'Commercial and
→˓Industrial'
END

Nota: Sebbene puoi utilizzare qualsiasi tipo di espressione per categorizzare le geometrie, per alcune
espressioni complesse potrebbe essere più semplice utilizzare la rule-based rendering.

• scegliere il simbolo (utilizzando la finestra di dialogo Selettore Simbolo) che sarà utilizzato come simbolo
di base per ogni classe;

• definire l’intervallo di colori (utilizzando la casella di riepilogo della scala di colori) da cui viene selezionato
il colore applicato al simbolo.

Quindi fai clic sul pulsante Classifica per creare la classi dei valori distinti degli colonna attributi. Ogni classe
può essere disabilitata spuntando la casella a sinistra del nome della classe.

Per cambiare simbolo, valore e/o etichetta della classe, semplicemente fai doppio click sull’oggetto che vuoi
cambiare.

Il tasto destro mostra un menù contestuale con Copia/Incolla, Cambia colore, Cambia trasparenza, Cambia
unità, Cambia dimensione del simbolo.

L’esempio in figure_categorized_symbology mostra la finestra di dialogo per la visualizzazione per categorie sul
layer rivers del DataSet di esempio QGIS.

Suggerimento: Selezionare e cambiare simboli multipli

La Simbologia ti permette di scegliere simboli multipli e di cliccare con il tasto destro per cambiare il coloro, la
trasparenza, la dimensione e lo spessore di quello che hai selezionato.

Suggerimento: Abbina le categorie al nome del simbolo
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Figure 13.11: Finestra di dialogo Simbologia Categorizzata

Nel menu [Avanzato], sotto le classi, puoi scegliere una delle prime due azioni per abbinare il nome del simbolo
al nome di una categoria nella tua classificazione. Fai corrispondere ai simboli salvati nome della categoria di
corrispondenza con un nome di simbolo dal tuo Gestore di Simbologia. Fai corrispondere ai simboli da file nome
della categoria di corrispondenza a un nome di simbolo di un file esterno.

Visualizzatore Graduato

Il Visualizzatore graduato è usato per visualizzare tutte le geometrie di un layer, utilizzando un simbolo
definito dall’utente il cui colore o dimensione riflettono la classificazione in classi dell’attributo scelto.

Come il Visualizzatore Categorizzato, quello Graduato ti permette di impostare la rotazione e la dimensione della
scala in base a valori presenti in colonne specifiche.

Inoltre, analogamente al Visualizzatore Categorizzato, ti permette di selezionare:

• L’attributo (utilizzando la casella di riepilogo Colonna o la funzione Imposta espressione per la colonna)

• Il simbolo (utilizzando la finestra di dialogo Selettore simbolo)

• Il formato legenda e la precisione

• Il metodo da usare per cambiare il simbolo: colore e dimensione

• I colori (usando la Scala di colori) se il metodo per il colore è selezionato

• La dimensione (utilizzando il dominio di dimensioni e la sua unità)

Quindi puoi utilizzare la scheda Istogramma che mostra un istogramma interattivo dai valori del campo assegnato
o dalla espressione. Le interruzioni di classe possono essere spostate o aggiunte utilizzando il widget istogramma.

Nota: Puoi usare il pannello Sintesi delle Statistiche per ottenere maggiori informazioni sul tuo vettore. Vedi
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Pannello Statistiche.

Tornando alla scheda Classi, puoi specificare il numero di classi e anche la modalità per classificare le geometrie
all’interno delle classi (utilizzando l’elenco in Modo). Le modalità disponibili sono:

• Intervallo uguale: ogni classe ha la stessa dimensione ( per esempio valori da 0 a 16 e quattro classi, ogni
classe ha dimensione 4).

• Quantile: ogni classe avrà lo stesso numero di elementi all’interno (l’idea di una scatola a baffi).

• Natural Breaks (Jenks): la varianza all’interno di ogni classe è minima, mentre quella tra le classi è massima;

• Deviazione standard: le classi sono costruite in funzione della deviazione standard dei valori.

• Pretty Breaks: calcola una sequenza di circa n + 1 valori, valori che vengono scelti in modo che siano di
1, 2 o 5 volte la potenza di 10 che coprono l’intervallo dei valori in x. (I valori vengono scelti secondo
l’ambiente statistico R http://astrostatistics.psu.edu/datasets/R/html/base/html/pretty.html)

La parte centrale della scheda Simbologia elenca le classi insieme ai relativi intervalli, etichette e simboli che
verranno sottoposti a visualizzazione.

Clicca sul pulsante Classifica per creare la classi usando il metodo scelto. Ogni classe può essere disabilitata
spuntando la casella a sinistra del nome della classe.

Per cambiare simbolo, valore e/o etichetta della classe, semplicemente fai doppio click sull’oggetto che vuoi
cambiare.

Il tasto destro mostra un menù contestuale con Copia/Incolla, Cambia colore, Cambia trasparenza, Cambia
unità, Cambia dimensione del simbolo.

L’esempio in figure_graduated_symbology mostra la finestra di dialogo di visualizzazione graduata per il vettore
dei fiumi dell’insieme di dati di esempio di QGIS.

Figure 13.12: Finestra di dialogo Simbologia Graduata

Suggerimento: Mappe tematiche usando un’espressione

Puoi creare mappe tematiche categorizzate o graduate usando il risultato di un’espressione. Nella fines-

tra di dialogo delle proprietà del vettore il selettore degli attributi viene esteso con una funzione
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Imposta funzione espressione colonna. Non hai quindi più bisogno di creare una nuova colonna nella tabella degli attributi di
un vettore se desideri che l’attributo di classificazione sia composto da più campi o da un qualche tipo di formula.

Simboli Proporzionali e Analisi Multivariata

Il Simbolo Proporzionale e l’Analisi Multivariata non sono tipologie di visualizzazione disponibili nell’elenco a
discesa dello stile. Tuttavia con le opzioni data-defined override applicate a qualsiasi delle precedenti opzioni di
Visualizzazione, QGIS ti consente di visualizzare i dati di punti e linee con tale rappresentazione.

Creare simboli proporzionali

Per applicare una rappresentazione proporzionale:

1. Per prima cosa applica al layer il single symbol renderer.

2. Quindi imposta il simbolo da applicare alle geometrie.

3. Seleziona la voce al livello superiore dell’albero dei simboli, e usa il pulsante button
Sovrascrittura definita dai dati accanto all’opzione Dimensione (per layer puntuale) o Larghezza (per layer lineare).

4. Seleziona un campo o inserisci un’espressione e, per ogni geometria, QGIS applicherà il valore di output
alla proprietà e ridimensionerà proporzionalmente il simbolo nell’area di disegno della mappa.

Se necessario, utilizza l’opzione Assistente. . . . del menu per applicare alcune trasformazioni (esponen-
ziale, flannery. . . .) al ridimensionamento della dimensione del simbolo (vedi Usare l’interfaccia assistente
definizione dati per maggiori dettagli).

Puoi scegliere di visualizzare i simboli proporzionali nel pannello Layers: apri l’elenco a discesa Avanzato in
fondo alla finestra di dialogo principale della scheda Simbologia e seleziona Dimensione legenda definita dai
dati. . . per configurare le voci della leggenda (vedi Dimensione legenda definita dai dati per i dettagli).

Figure 13.13: Classificare gli aeroporti in base all’altitudine dell’aeroporto

Creazione di analisi multivariata
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Una visualizzazione con analisi multivariata ti consente di valutare la relazione tra due o più variabili ad esempio,
una può essere rappresentata da una scala di colori mentre l’altra è rappresentata da una dimensione.

Il modo più semplice per creare analisi multivariate in QGIS è quello di:

1. Per prima cosa applica una rappresentazione categorizzata o graduata su un layer, usando lo stesso tipo di
simbolo per tutte le classi.

2. Poi, applica una simbologia proporzionale alle classi:

(a) Clicca sul pulsante Cambia sopra il riquadro di classificazione: si apre la finestra di dialogo simbolo-
selettore.

(b) Ridimensiona la dimensione o la larghezza del simbolo del layer usando il widget data defined
override come visto sopra.

Come il simbolo proporzionale, la simbologia in scala può essere aggiunta all’albero dei layer, nella parte superiore
dei simboli delle classi categorizzate o graduate usando la funzione data defined size legend. Ed entrambe le
rappresentazioni sono disponibili nella voce della legenda del layout di stampa.

Figure 13.14: Esempio di analisi multivariata con legenda a scalare

Visualizzazione basata su Regole

Il visualizzatore Tramite regole viene utilizzato per eseguire la visualizzazione di un layer, utilizzando simboli
basati su regole il cui aspetto rispecchia l’assegnazione dell’attributo di una geometria selezionata a una classe.
Le regole sono basate su istruzioni SQL e possono essere annidiate. La finestra di dialogo consente di definire
le regole per filtrare il raggruppamento o condizionare la visualizzazione alla scala e tu puoi decidere se vuoi
cambiare l’ordine gerarchico o utilizzare la prima regola proposta.

Per creare una regola:

1. Attiva una riga esistente facendo doppio clic su di essa (per impostazione predefinita, QGIS aggiunge un

simbolo senza una regola quando la modalità di visualizzazione è abilitata) oppure fai clic sul pulsante
Modifica regola o Aggiungi regola.

2. Nella finestra di dialogo Modifica regola che si apre, puoi definire una etichetta per aiutarti a identificare
ogni regola. Questa è l’etichetta che verrà visualizzata nel pannello Layer e anche nella legenda del layout
di stampa.
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3. Inserisci manualmente una espressione nella casella di testo accanto all’opzione Filtro oppure premi il

pulsante accanto ad essa per aprire la finestra di dialogo del costruttore di stringhe di espressione.

4. Usa le funzioni fornite e gli attributi del layer per costruire un’espressione expression per filtrare le caratter-
istiche che vorresti selezionare. Premi il pulsante Prova per controllare il risultato della query.

5. Puoi digitare un’etichetta più lunga per rendere più completa la descrizione della regola.

6. Puoi utilizzare l’opzione Intervallo di scala per impostare le scale alle quali applicare la regola.

7. Infine, configura il simbolo simbolo da usare per queste geometrie.

8. E premi OK.

Una nuova riga che riassume la regola viene aggiunta alla finestra di dialogo Proprietà Layer. Puoi creare tutte le
regole necessarie seguendo i passaggi precedenti o copiare incollandola una regola esistente. Trascina e rilascia le
regole una sopra l’altra per annidarle e perfezionare le funzionalità delle regole superiori nelle sottoclassi.

Selezionando una regola, puoi anche organizzare le sue funzionalità in sottoclassi usando il menu a discesa Refine
selected rules. L’affinamento automatico delle regole può essere basato su:

• scale;

• Categorie: applicando un categorized;

• o intervalli: applicando un graduated.

Le classi perfezionate appaiono come sotto-voci della regola, in una gerarchia ad albero e come sopra, puoi
impostare la simbologia di ogni classe.

Nella finestra di dialogo Modifica regola, puoi evitare di scrivere tutte le regole e utilizzare l’opzione Altri-
menti per rilevare tutte le geometrie che non corrispondono a nessuna delle altre regole, nello stesso layer. Questo
può anche essere ottenuto scrivendo Altrimenti nella colonna Regola della finestra di dialogo Proprietà Layer
→ Simbologia → Basata su regole.

Le regole create appaiono anche in una gerarchia ad albero nella legenda della mappa. Fai doppio clic sulle regole
nella legenda della mappa e viene visualizzata la scheda Simbologia delle proprietà del layer che mostra la regola
che è di riferimento al simbolo nell’albero.

L’esempio in figure_rule_based_symbology mostra la finestra di dialogo visualizzazione basata su regole per il
layer dei fiumi majrivers del DataSet di esempio QGIS.

Visualizzatore Spostamento Punto

Il visualizzatore Spostamento punto permette di visualizzare gli elementi di un layer di punti anche se hanno la
stessa posizione. Per ottenere questo, il visualizzatore prende i punti che cadono in un data Distanza di tolleranza
l’uno dall’altro e li posiziona intorno al loro baricentro seguendo diversi Metodi di posizionamento:

• Anello: posiziona tutti i punti su un cerchio il cui raggio dipende dal numero di punti da visualizzare.

• Anelli concentrici: utilizza una serie di cerchi concentrici per mostrare i punti.

• Reticolo: genera un reticolo regolare con un simbolo puntuale ad ogni intersezione.

Il widget Simbolo centrale ti aiuta a personalizzare il simbolo e il colore del punto centrale. Per i simboli dei punti
distribuiti, puoi applicare Senza simboli, Simbolo singolo, Categorizzato, Graduato o Basato su regole utilizzando
l’elenco a discesa Visualizzatore e personalizzarli utilizzando il pulsante Impostazioni Visualizzatore. . . .

Mentre la spaziatura minima di Linee di spostamento dipende dal simbolo del punto, puoi ancora personaliz-
zare alcune delle sue impostazioni come Spessore tratto, Colore tratto e Rettifica dimensione (ad esempio, per
aggiungere più spaziatura tra i punti visualizzati).

Utilizza le opzioni del gruppo Etichette per eseguire l’etichettatura sui punti: le etichette sono posizionate vi-
cino alla posizione del simbolo, e non nella posizione reale del punto. Oltre a Attributo dell’etichetta, Carattere
dell’etichetta e Colore dell’etichetta, puoi impostare la Scala minima della mappa per visualizzare le etichette.
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Figure 13.15: Opzioni Simboli definiti Tramite regole

Figure 13.16: Finestra di dialogo Spostamento punti
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Nota: Il visualizzatore Spostamento punto non altera la geometria dei punti, il che significa che i punti non
vengono spostati dalla loro posizione. Si trovano ancora al loro posto iniziale. Le modifiche sono solo visive, a
scopo di visualizzazione. Utilizza invece l’algoritmo di Processing qgispointsdisplacement se vuoi generare punti
spostati.

Visualizzatore Gruppo di punti

A differenza della visualizzazione Spostamento punto che fa spostare il punto più vicino o sovrapposto, il
Gruppo di punti raggruppa la visualizzazione di punti vicini in un unico simbolo. Sulla base di una determinata
Distanza, i punti che tra loro vicini vengono fusi in un unico simbolo. L’aggregazione dei punti viene fatta in base
al gruppo più vicino che si sta formando, piuttosto che assegnando loro il primo gruppo all’interno della distanza
di ricerca.

Dalla finestra di dialogo principale, puoi:

• imposta il simbolo per rappresentare l’insieme di punti in Cluster symbol; la visualizzazione predefinita
mostra il numero di punti aggregati grazie al @cluster_size variable sul carattere del simbolo del
layer.

• utilizza l’elenco a discesa Visualizzatore per applicare uno qualsiasi degli altri tipi di visualizzazione degli
oggetti al layer (singolo, categorizzato, basato su regole. . . ..). Poi, premi il pulsante Impostazioni Visualiz-
zatore. . . per configurare la simbologia dei punti come al solito. Nota che questa funzionalità è visibile solo
su geometrie che non sono raggruppate. Inoltre, quando il colore del simbolo è lo stesso per tutti i punti
all’interno di un cluster, quel colore imposta la variabile @cluster_color del cluster.

Figure 13.17: Finestra di dialogo Gruppo di punti

Nota: Il visualizzatore Spostamento Gruppo non altera la geometria dei punti, il che significa che i punti non
vengono spostati dalla loro posizione. Si trovano ancora al loro posto iniziale. Le modifiche sono solo visive, a
scopo di rendering. Utilizza invece l’algoritmo di Processing qgispointsdisplacement se vuoi generare punti basati
su cluster.
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Visualizzatore Poligoni Invertiti

La visualizzazione Poligoni invertiti consente all’utente di definire un simbolo al di fuori dei poligoni del
layer. Come sopra puoi selezionare le altre visualizzazioni, ovvero Simbolo singolo, Graduato, Categorizzato,
Basato su regole o Visualizzazione 2.5D.

Figure 13.18: Finestra di dialogo Poligoni invertiti

Visualizzatore Mappa di Concentrazione

Con la visualizzazione Mappa di concentrazione puoi creare mappe di concentrazione dinamiche per layers
puntuali e multi-puntuali. Puoi specificare il raggio di concentrazione in millimetri, punti, pixel, unità di mappa
o pollici, scegliere e modificare una scala di colore per lo stile di concentrazione e utilizzare un cursore per
selezionare un compromesso tra la velocità di visualizzazione e la qualità. Inoltre puoi definire un valore limite
massimo e dare un peso ai punti utilizzando un campo o una espressione. Quando si aggiunge o si rimuove una
geometria, il visualizzatore Mappa di concentrazione aggiorna automaticamente lo stile.

Visualizzatore 2.5D

Utilizzando la visualizzazione 2.5D è possibile creare un effetto 2.5D sulle geometrie del tuo layer. Inizia
scegliendo un valore di Altezza (in unità di mappe). Per questo puoi utilizzare un valore fisso, uno dei campi del
tuo layer o un’espressione. È inoltre devi scegliere un Angolo (in gradi) per ricreare la posizione del visualizzatore
(0 ° significa ovest, crescente in senso antiorario). Usa le opzioni avanzate di configurazione per impostare il
Colore tetto e Colore muro. Se vuoi simulare la radiazione solare sulle pareti delle caratteristiche, assicurati di
scegliere l’opzione Ombra muri basata sull’aspetto. Puoi anche simulare la presenza di un’ombra impostando un
Colore e una Dimensione (in unità di mappa).

Suggerimento: Utilizzare l’effetto 2.5D con altre visualizzazioni

Una volta che hai finito di impostare lo stile di base nella visualizzazione 2.5D, puoi convertirlo in un altra tipologia
di visualizzazione (Singolo, Categorizzato, Graduato). Gli effetti 2.5D verranno mantenuti e tutte le altre opzioni
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Figure 13.19: Finestra di dialogo Mappa di concentrazione

Figure 13.20: Finestra di dialogo mappa 2.5D
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di visualizzazione saranno disponibili per essere o meno confermate (in questo modo puoi avere, ad esempio,
simboli categorizzati con una bella rappresentazione 2.5D o aggiungere un certo stile aggiuntivo ai tuoi simboli
2.5D). Per assicurarti che l’ombra e l“«edificio» non interferiscano con altre geometrie vicine, potrebbe essere
necessario attivare i Livelli dei simboli ( Avanzate → Livelli dei Simboli. . . ). I valori di altezza e angolo 2.5D
vengono salvati nelle variabili del layer, quindi puoi modificarla successivamente nella scheda variabili della
finestra di dialogo delle proprietà del layer

Visualizzazione del layer

Nella scheda Stile puoi anche impostare alcune opzioni che agiscono contemporaneamente su tutte le geometrie
del layer:

• Trasparenza del layer : Con questo strumento è possibile rendere visibile il layer sot-
tostante della mappa. Usa il cursore per adattare la visibilità del tuo layer vettoriale alle tue esigenze. Puoi
anche definire con precisione la percentuale di visibilità nel menu accanto al cursore.

• Modalità fusione layer e Modalità fusione elementi: puoi ottenere effetti speciali di visualizzazione con
questi strumenti che potresti già aver avuto a disposizione con programmi specializzati per la elaborazione
di immagini. I pixel dei tuoi layer in sovrapposizione e di geometria sovrapposte vengono mischiati tramite
le impostazioni descritte in Metodi di fusione.

• Applica paint effects su tutte le geometrie del layer con il pulsante Personalizza effetti.

• Controllo ordine di visualizzazione ti permette, utilizzando gli attributi delle geometrie, di definire in quale

ordine z vengono visualizzati. Attiva la casella di controllo e fai click sul pulsante accanto . Ottiene
quindi la finestra di dialogo Definisci l’ordine in cui:

1. Scegli un campo o crea un’Espressione da applicare alle geometrie del layer.

2. Imposta con quale sequenza le geometrie coinvolte devono essere ordinate, quindi se scegli ordine
Crescente, le geometrie con valore inferiore vengono visualizzate sotto quelle con valore superiore.

3. Definisci se le geometrie che hanno per il campo scelto valore NULL devono essere visualizzati per
Prime o per Ultime.

4. Ripeti i passaggi precedenti per tutte le regole che vuoi utilizzare.

La prima regola viene applicata a tutte le geometrie del layer, ordinandole in base al valore z restituito.
Quindi, per ciascun gruppo di geometrie con lo stesso valore (compresi quelli con valore NULL) e quindi
dello stesso livello z, viene applicata la regola successiva per ordinare i propri elementi tra di loro. E così
via. . .

Figure 13.21: Opzioni di visualizzazione del layer

Altre impostazioni

Livelli simbolo

Per i visualizzatori che permettono layer di simbolo sovrapposti (solo la mappa di concentrazione non lo permette)
c’è un’opzione per controllare l’ordine di visualizzazione di ciascun livello del simbolo.
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Nella maggior parte delle visualizzazioni puoi accedere all’opzione livelli dei simboli facendo clic sul pulsante
Avanzato al di sotto dell’elenco dei simboli salvati e scegliendo Livelli simbolo. . . . Nell’opzione Visualizzazione
basata su Regole è direttamente disponibile tramite il pulsante Livelli simbolo. . . , mentre nella visualizzazione
Visualizzatore Spostamento Punto lo stesso pulsante si trova all’interno della finestra di dialogo Impostazioni di
visualizzazione.

Per attivare i livelli dei simboli, selezionare Abilita livelli simbolo. Ogni riga mostrerà un piccolo campione
del simbolo combinato, la sua etichetta e il singolo livello di simbolo diviso in colonne con un numero accanto ad
esso. I numeri rappresentano l’ordine di visualizzazione con cui verrà prelevato il livello di simbolo. I livelli di
valori inferiori vengono tracciati prima, rimanendo in basso, mentre i valori più alti vengono tracciati per ultimi,
sopra agli altri.

Figure 13.22: Finestra di dialogo dei livelli simbolo

Nota: Se i livelli simbolo sono disattivati, saranno mostrati i simboli completi secondo il rispettivo ordine delle
geometrie. I simboli sovrapposti copriranno quelli al di sotto di essi. Inoltre, simboli simili non si «uniranno» gli
uni con gli altri.

Figure 13.23: Differenza tra i livelli simboli attivati (A) e disattivati (B)
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Dimensione legenda definita dai dati

Quando un layer è rappresentato con il simbolo proporzionale o il rendering multivariato o quando al layer viene
applicato un diagramma scaled size diagram, puoi abilitare la visualizzazione dei simboli scalati sia nel Layers
panel che nel print legend layout.

Per abilitare la finestra di dialogo Dimensioni della Legenda Definita dai Dati. . . per attivare la simbologia, se-
leziona l’opzione del pulsante Avanzato sotto l’elenco dei simboli salvati. Per i diagrammi, l’opzione è disponibile
sotto la scheda Legenda. La finestra di dialogo fornisce le seguenti opzioni per:

• seleziona il tipo di legenda: Legenda non attivata, Oggetti della legenda separati e Legenda
racchiusa. Per quest’ultima opzione, puoi selezionare se gli elementi della legenda sono allineati In Basso
o Al Centro;

• imposta il :ref:‘simbolo da usare <symbol-selector>‘per la rappresentazione della legenda;

• inserire il titolo nella legenda;

• ridefinisci le classi da utilizzare: per impostazione predefinita, QGIS fornisce una legenda di cinque classi

(basata sulle pause naturali), ma puoi applicare la tua classificazione utilizzando l’opzione Classi per-

sonalizzate. Usa i pulsanti e per impostare i valori e le etichette delle classi personalizzate.

Un’anteprima della legenda viene visualizzata nel pannello destro della finestra di dialogo e aggiornata quando si
impostano i parametri. Per le legende collassate, viene tracciata una linea di separazione dal centro orizzontale
del simbolo al testo della legenda corrispondente.

Figure 13.24: Impostazione delle dimensioni in scala delle legenda

Nota: Attualmente, la dimensione della legenda definita dai dati per la simbologia dei layer può essere applicata
solo al layer di punti utilizzando la simbologia singola, categorizzata o graduata.
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Effetti disegno

Al fine di migliorare la rappresentazione dei vettori ed evitare (o perlomeno ridurre) il ricorso ad altri software per

la rappresentazione finale delle mappe, QGIS fornisce un’altra potente funzionalità: l’opzione Effetti Disegno,
che aggiunge effetti grafici per personalizzare la visualizzazione di vettori.

L’opzione è disponibile nella finestra di dialogo Proprietà vettore –> Simbologia, all’interno del gruppo Layer
rendering (si applica all’intero layer) oppure in symbol layer properties (si applica alla geometria corrispondente).
Puoi combinare entrambi gli usi.

Gli effetti disegno possono essere attivati selezionando l’opzione Effetti disegno e facendo click sul pulsante
Personalizza effetti che apre la finestra di dialogo Proprietà Effetti (vedi figure_effects_source). Sono disponibili i

seguenti Tipo effetto, con opzioni personalizzabili:

• Sorgente: Mostra lo stile originale della geometria in accordo alla configurazione delle proprietà del vettore.
La Trasparenza dello stile può essere regolata così come lal Blend mode e la Draw mode. Queste sono
proprietà comuni per tutti i tipi di effetti.

Figure 13.25: Finestra di dialogo Effetti di disegno

• Sfumatura: aggiunge un effetto di sfumatura sul layer vettoriale. Le opzioni di personalizzazione che puoi
scegliere sono Tipo di sfumatura (Stack blur (fast) o Gaussian blur (quality)) e Grado di sfumatura.

Figure 13.26: Effetti di disegno: finestra di dialogo Sfumatura
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• Colorazione: Questo effetto può essere utilizzato per creare una versione dello stile utilizzando una singola
tinta. La base del simbolo avrà sempre una versione in scala di grigi e puoi:

– Usare Scala di grigi per selezionare come crearlo: le opzioni sono “Per brillantezza”, “Per
luminosità”, “Per media” e “Spento”.

– Se viene selezionato Colora, sarà possibile mescolare un altro colore e scegliere quanto deve essere
forte.

– Controllare i livelli di Brillantezza, Contrasto e Saturazione del simbolo risultante.

Figure 13.27: Effetti di disegno: finestra di dialogo Colorazione

• Ombreggiatura: utilizzando questo effetto si aggiunge un’ombra sulla geometria, che sembra aggiungere
una dimensione aggiuntiva. Questo effetto può essere personalizzato modificando l’angolo di Offset e la dis-
tanza, determinando dove verso dove si sposta l’ombra e la prossimità dell’oggetto sorgente. Ombreggiatura
ha anche l’opzione di modificare Raggio di sfocatura e il Colore.

• Ombreggiatura interna: questo effetto è simile all’effetto Ombreggiatura, ma aggiunge l’effetto om-
bra all’interno dei bordi della geometria. Le opzioni disponibili per la personalizzazione sono le stesse
dell’effetto Ombreggiatura.

• Luminescenza interna: aggiunge un effetto di incandescenza all’interno della geometria. Questo ef-
fetto può essere personalizzato regolando la Diffusione (larghezza) del bagliore o il Raggio di sfumatura.
Quest’ultima specifica la vicinanza dal margine della geometria alla quale si vuole che si verifichi la sfu-
matura. Inoltre, esistono opzioni per personalizzare il colore del bagliore, utilizzando un Singolo colore o
una Scala di colori.

• Luminescenza esterna: questo effetto è simile all’effetto Luminescenza interna, ma aggiunge l’effetto di
incandescenza all’esterno dei bordi della geometria. Le opzioni disponibili per la personalizzazione sono le
stesse dell’effetto Luminescenza interna.

• Trasformazione: aggiunge la possibilità di trasformare la forma del simbolo. Le prime opzioni disponibili
per la personalizzazione sono Rifletti orizzontalmente e Rifletti verticalmente che creano una rotazione sugli
assi orizzontali e / o verticali. Le altre opzioni sono:

– Tagliare X,Y: Allinea la geometria lungo l’asse X e/o Y.
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Figure 13.28: Effetti di disegno: finestra di dialogo Ombreggiatura
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Figure 13.29: Effetti di disegno: finestra di dialogo Ombreggiatura interna

– Ridimensiona X,Y: ingrandisce o rimpicciolisce la geometria lungo l’asse X e/o Y per la percentuale
data,

– Rotazione: Ruota la geometria intorno al punto centrale.

– e Trasla modifica la posizione dell’oggetto in base a una distanza data sull’asse X e/o sull’asse Y.

Uno o più effetti di disegno possono essere usati contemporaneamente. Puoi attivare/disattivare un effetto uti-
lizzando la relativa casella di controllo nell’elenco degli effetti. Puoi modificare il tipo di effetto selezionato

utilizzando l’opzione Tipo effetto . Puoi riordinare gli effetti utilizzando i pulsanti Sposta in alto e
Sposta in basso e anche aggiungere o rimuovere gli effetti utilizzando i pulsanti Aggiungi nuovo effetto e Rimuovi effetto.

Ci sono alcune opzioni comuni disponibili per tutti i tipi di effetti. Le opzioni Trasparenza e Modalità di fusione
operano in modo simile a quelle descritte in Visualizzazione del layer e possono essere utilizzate in tutti gli effetti

di disegno, tranne che per la Trasformazione. C’è anche un’opzione Modalità disegno disponibile per ogni
effetto, e puoi scegliere se visualizzare e/o modificare il simbolo, seguendo alcune regole:

• Visualizza gli effetti dall’alto verso il basso.

• la modalità Visualizza solamente significa che l’effetto sarà visibile.

• la modalità Modifica solamente significa che l’effetto non sarà visibile ma i cambiamenti che applica saranno
passati all’effetto successivo (quello immediatamente sotto).

• La modalità Visualizza e modifica renderà visibile l’effetto e passerà tutte le modifiche all’effetto successivo.
Se l’effetto si trova in cima alla lista degli effetti o se l’effetto immediatamente precedente non è in modalità
modifica, allora utilizzerà il simbolo originale dalle proprietà dei layer (simile al sorgente).

13.2.4 Proprietà etichette

Le proprietà Etichette ti offrono tutte le funzioni necessarie e appropriate per configurare l’etichettatura
intelligente dei vettori. Puoi accedere a questa finestra di dialogo anche dal pannello Stile o utilizzando
Opzioni per l’etichetta del layer dell’icona Barra degli strumenti delle etichette.
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Figure 13.30: Effetti di disegno: finestra di dialogo Ombreggiatura interna
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Figure 13.31: Effetti di disegno: finestra di dialogo Ombreggiatura esterna
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Figure 13.32: Effetti di disegno: finestra di dialogo Trasformazione
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Il primo passo è quello di scegliere il metodo di etichettatura dall’elenco a discesa. I metodi disponibili sono:

• Non mostrare le etichette: il valore predefinito, che non mostra alcuna etichetta per il layer.

• Single labels, descritto di seguito

• Rule-based labeling

• e Blocco in corso: ti permette di impostare un layer come un ostacolo per le etichette degli altri layer
senza che vengano visualizzate le relative etichette.

Impostazione etichetta

I passi successivi presuppongono che selezioni l’opzione Etichette singole, abilitando le seguenti schede che
ti consentono di configurare l’etichettatura:

• Text

• Formatting

• Buffer

• Background

• Shadow

• Placement

• Rendering

Abilita anche l’elenco a discesa Etichetta con, dal quale puoi selezionare una colonna di attributi da utilizzare. Fai

clic su se vuoi definire le etichette in base alle espressioni - Vedi Definire le etichette tramite espressioni.

I passi seguenti descrivono un’etichettatura semplice, senza usare la funzione di Sovrascrittura definita dai dati,
situata vicino ai menu a tendina - vedi Etichettare in funzione dei dati per un caso di uso.

Scheda testo

Nella scheda Testo, puoi definire Carattere, Stile, e Dimensione delle tue etichette (vedi Figure_labels). . Sono
disponibili opzioni per impostare il Colore e la Trasparenza delle etichette. Utilizza l’opzione Tipo maiuscolo per
cambiare lo stile del testo. Hai la possibilità di visualizzare il testo come “Tutto maiuscolo”, “Tutto minuscolo”
o “Prima lettera maiuscola”. In Spaziatura, puoi modificare lo spazio tra le parole e tra le singole lettere. Infine,
utilizza l’opzione Modalità di fusione per determinare come le etichette si mescolano con gli oggetti di mappa
sottostanti (vedi ulteriori informazioni in Metodi di fusione).

L’opzione Applica sostituzione testo etichetta ti consente di specificare una lista di testi delle etichette delle ge-
ometrie da sostituire (ad esempio abbreviazione di tipi di strada). I testi di sostituzione vengono quindi utilizzati
per visualizzare le etichette nella mappa al posto di quello/i contenuti nella colonna di attributi scelta per la etichet-
tatura. Gli utenti possono anche esportare e importare elenchi di sostituzione per rendere più facile il riutilizzo e
la condivisione.

Scheda Formattazione

Nella scheda Formattazione, puoi definire un carattere per andare a capo nelle etichette con l’opzione A capo
con il carattere. Puoi formattare l” Altezza linea e l” Allineamento. Per questa ultima opzione sono disponibili
valori tipici (sinistra, destra e centro), più Posiziona le etichette a fianco per i layer puntuali. Quando è impostata
questa modalità, l’allineamento del testo per le etichette dipenderà dal posizionamento finale dell’etichetta rispetto
al punto. Ad esempio, se l’etichetta è posta a sinistra del punto, l’etichetta sarà allineata a sinistra, mentre se è
posizionata a destra, verrà allineata a destra.
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Figure 13.33: Impostazioni etichettatura vettore - Scheda testo
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Per i layer vettoriali lineari puoi includere Simbolo di direzione della linea per determinare le linee di direzione.
Funzionano particolarmente bene quando vengono utilizzate con le opzioni di posizionamento “Parallelo” o “Cur-
vato” della successiva scheda Posizionamento. Ci sono opzioni per impostare la posizione dei simboli e per
invertire la direzione.

Utilizza l’opzione Numeri formattati per formattare etichette numeriche. Puoi impostare il numero di Posizioni
decimali. Per impostazione predefinita, verranno utilizzate 3 cifre decimali. Utilizza Mostra il segno più se
desideri mostrare il segno più per i numeri positivi.

Scheda Buffer

Per creare un contorno attorno alle etichette, attiva la casella di controllo Disegna buffer del testo nella scheda
Buffer. Puoi impostare la Dimensione, il Colore, e la Opacità del buffer. Il buffer si espande dalla linea di
etichetta, quindi, se è attivata la casella Colore riempimento del buffer, la parte interna viene riempita. Ciò può
essere rilevante quando si utilizzano etichette parzialmente trasparenti o con modalità di miscelazione non nor-
mali, che consentiranno di vedere dietro il testo dell’etichetta. La disattivazione della casella di controllo Colore
riempimento del buffer, (quando utilizzi etichette totalmente trasparenti) ti consente di creare etichette di testo
contornate.

Scheda Sfondo

Nella scheda Sfondo puoi definire con la Dimensione X e la Dimensione Y la forma del tuo sfondo. Utilizza il
Tipo dimensione per inserire un ulteriore “Buffer” nel tuo sfondo. La dimensione del buffer è impostata per im-
postazione predefinita qui. Lo sfondo è quindi costituito dal buffer più lo sfondo in Dimensione X e in Dimensione
Y. Puoi impostare una Rotazione e puoi scegliere tra “Sincronizzazione con l’etichetta”, “Offset dell’etichetta” e
“Fissa”. Utilizzando “Offset dell’etichetta” e “Fissa”, puoi ruotare lo sfondo. Definire un Offset X,Y con valori X
e Y e lo sfondo verrà spostato. Quando si applica Raggio X,Y, lo sfondo riceve ha angoli arrotondati. Ancora una
volta, è possibile mescolare lo sfondo con i layers sottostanti nella mappa utilizzando la Modalità fusione (vedi
Metodi di fusione).

Scheda Ombra

Utilizza la scheda Ombra per un Disegna ombreggiatura definita dall’utente. Il disegno dello sfondo è
molto variabile. Scegli tra “Componente etichetta inferiore”, “Testo”, “Contorno” e “Sfondo”. L’angolo di Off-

set dipende dall’orientamento dell’etichetta. Se scegli la casella di controllo Usa ombreggiatura globale il
punto zero dell’angolo è sempre orientato a nord e non dipende dall’orientamento dell’etichetta. Puoi influenzare
l’aspetto dell’ombra con Raggio di sfumatura. Maggiore è il numero, più morbide le ombre. L’aspetto dell’ombra
può anche essere alterato scegliendo una modalità di fusione.

Scheda Posizionamento

Scegli la scheda Posizionamento per configurare il posizionamento delle etichette e la priorità di etichettatura.
Nota che le opzioni di posizionamento differiscono a seconda della tipologia di layer vettoriale, cioè punto, linea
o poligono, e sono influenzate dall’impostazione globale PAL setting.

Posizionamento per vettori di punti

Con la modalità di posizionamento Cartografico le etichette per i vettori puntuali vengono generate con una
migliore relazione visiva seguendo le regole di posizionamento cartografico ideali. Le etichette possono essere
posizionate ad una Distanza impostata sia dal punto che dai bordi del simbolo utilizzato per rappresentare l’oggetto
puntuale. Quest’ultima opzione è particolarmente utile quando la dimensione del simbolo non è fissa, ad esempio

210 Chapter 13. Lavorare con i vettori



QGIS User Guide, Release 3.4

se è impostato da una dimensione definita dai dati o quando si utilizzano diversi simboli in una classificazione
categorizzata. Per impostazione predefinita, i posizionamenti sono effettuati nel seguente ordine:

Per impostazione predefinita, i posizionamenti sono effettuati nel seguente ordine:

1. in alto a destra

2. in alto a sinistra

3. in basso a destra

4. in basso a sinistra

5. al centro a destra

6. al centro a sinistra

7. in alto, leggermente a destra

8. in basso, leggermente a sinistra

La priorità di posizionamento può tuttavia essere personalizzata o impostata utilizzando un elenco definito di po-
sizioni prioritarie. Ciò consente inoltre di utilizzare solo determinati posizionamenti, ad esempio per gli elementi
sulla costa è possibile impedire che le etichette siano collocate sulla terra.

L’impostazione Intorno al punto posiziona l’etichetta in un raggio uguale (impostato in Distanza) intorno
all’elemento. Il posizionamento dell’etichetta può anche essere limitato utilizzando l’opzione Quadrante.

Con Offset dal punto, le etichette vengono posizionate ad un offset fisso dal punto. Puoi selezionare il
Quadrante in cui inserire l’etichetta. Puoi inoltre impostare le distanze di Offset X,Y tra i punti e le rispettive
etichette e puoi modificare l’angolo del posizionamento delle etichette con l’impostazione Rotazione. Pertanto è
possibile il posizionamento in un quadrante selezionato con una rotazione definita.

Posizionamento per vettori di linee

Le opzioni per le etichette di layers lineari includono Parallelo, Curvato o Orizzontale. Per le opzioni

Parallelo e Curvato puoi impostare la posizione su Sopra la linea, Sulla linea e Sotto la linea.
Puoi selezionare più opzioni contemporaneamente. In questo caso, QGIS cercherà per l’etichetta la posizione
ottimale. Per le opzioni di posizionamento parallelo e curvo, puoi anche utilizzare l’orientamento della linea per
la posizione dell’etichetta. Inoltre, puoi definire un Angolo massimo tra caratteri curvi quando selezioni l’opzione

Curvato (vedi Figure_labels_placement_line).

Figure 13.34: Esempi di posizionamento di etichette in vettori lineari

Per tutte le tre opzioni di posizionamento, in Ripeti, è possibile impostare una distanza minima per ripetere le
etichette. La distanza può essere in mm o in unità di mappa.
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Posizionamento per vettori poligonali

Puoi scegliere una delle seguenti opzioni per il posizionamento di etichette in poligoni (vedi fig-
ure_labels_placement_polygon):

• Offset dal centroide,

• Orizzontale (lento),

• Attorno al centroide,

• Libero (lento),

• Utilizzando il perimetro,

• and Utilizzando il perimetro (curvo).

Nelle impostazioni Offset dal centroide puoi specificare se il centroide è del poligono visibile o del intero
poligono. Ciò significa che venga utilizzato o il centroide della parte di poligono che si può vedere sulla mappa
o il centroide dell’intero poligono, non importa se si può vedere tutto sulla mappa. Puoi inserire l’etichetta in un
quadrante specifico e definire offset e rotazione.

L’impostazione Attorno al centroide indica a quale distanza porre l’etichetta dal centroide. Ancora una volta, puoi

definire il centroide del poligono visibile o dell” intero poligono.

Con le opzioni Orizzontale (lento) o Libero (lento), QGIS posiziona nella posizione migliore un’etichetta orizzon-
tale o una etichetta ruotata all’interno del poligono.

Con l’opzione Utilizzando il perimetro, l’etichetta verrà disegnata accanto al limite del poligono. L’etichetta
si comporterà come nell’opzione parallela per le linee. È possibile definire una posizione e una distanza per

l’etichetta. Per la posizione sono possibili le opzioni Sopra la linea, Sulla linea, Sotto la linea e

Posizione dipendente dall’orientazione della linea. Puoi specificare la distanza tra l’etichetta e il bordo del
poligono, nonché l’intervallo di ripetizione per l’etichetta.

L’opzione Utilizzando il perimetro (curvo) ti consente di disegnare l’etichetta lungo il contorno del poligono,
utilizzando un’etichetta curva. Oltre ai parametri disponibili con l’utilizzo dell’impostazione Usando il perimetro,
puoi impostare l” Angolo massimo tra caratteri curvi, sia all’interno che all’esterno.

Nella sezione Priorità puoi definire la priorità con cui vengono generate le etichette per tutti e tre i tipi di layer
vettoriali (punto, linea, poligono). Questa opzione di posizionamento interagisce con le etichette di altri strati
vettoriali nella mappa. Se ci sono etichette di diversi layers nella stessa posizione, verrà visualizzata l’etichetta
con la priorità più alta e le altre non saranno visibili.

Scheda Visualizzazione

Nella scheda Visualizzazione puoi stabilire quando le etichette saranno visibili e la loro interazione con le altre
etichette e geometrie.

In Opzioni etichetta, trovi le impostazioni di visibilità scale-based e la Visibilità basata sulla dimensione in pixel
(etichette in unità di mappa)

Livello dell’etichetta (z-index) determina l’ordine in cui vengono visualizzate le etichette, nonché in relazione ad
altre etichette degli elementi del layer (utilizzando l’espressione definita in funzione dei dati) come con le etichette
di altri layer. Le etichette con un z-index più alto vengono visualizzate sopra le etichette (di qualsiasi layer) con
z-index inferiore.

Inoltre, se 2 etichette hanno corrispondenti z-indici, allora:

• se provengono dallo stesso layer, l’etichetta più piccola verrà disegnata sopra l’etichetta più grande
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Figure 13.35: Esempi di posizionamento di etichette in vettori poligonali

• se vengono da layer diversi, le etichette verranno disegnate nello stesso ordine dei layer (rispettando l’ordine
impostato nella legenda della mappa).

Tieni presente che questa impostazione non permette alle etichette di essere disegnate sotto gli elementi di altri
layer, ma controlla semplicemente l’ordine in cui le etichette vengono disegnate sopra tutte le geometrie dei layer.

Durante la creazione di etichette e per visualizzare le etichette leggibili, QGIS valuta automaticamente la po-
sizione delle etichette e può nascondere alcune di esse in caso di collisione. Puoi comunque scegliere l’opzione
Mostra tutte le etichette per questo layer (incluse le etichette che collidono) al fine di definire manualmente il loro
posizionamento.

Con Sovrascrittura definita dai dati in Mostra etichetta e Mostra sempre puoi meglio definire quali etichette devono
essere visualizzate.

Nella scheda Opzioni elementi, puoi scegliere Etichetta ogni parte di elementi multiparte e Numero massimo di
elementi da etichettare. Sia i layer lineari che poligonali offrono l’opzione di impostare una dimensione minima
per le geometrie da etichettare, utilizzando Elimina l’etichettatura degli elementi più piccoli di. Per le geometrie
poligonali, puoi anche definire come visibili solo le etichette secondo se stanno completamente all’interno della
geometria o meno. Per le geometrie lineari, puoi scegliere l’opzione Fondi le linee collegate per evitare la du-
plicazione delle etichette, rendendo la mappa abbastanza alleggerita in combinazione con le opzioni Distanza o
Ripeti nella scheda Posizionamento.

Con la scheda Ostacoli puoi gestire la relazione di copertura tra le etichette e le geometrie. Attiva l’opzione
Evita che le etichette si sovrappongano alle geometrie per decidere se le geometrie del layer devono agire come
ostacoli per qualsiasi etichetta (incluse le etichette di altri elementi dello stesso layer). Un ostacolo è un elemento
che QGIS cerca per quanto possibile di evitare nel posizionare le etichette. Invece di tutto il layer, è possibile

definire un sottoinsieme di elementi da considerare come ostacoli, utilizzando Sovrascrittura definita dai dati accanto
all’opzione

Il cursore di controllo di priorità per gli ostacoli ti consente di mostrare in caso di sovrap-
posizione le etichette di determinati layers anziché di altri. Una priorità di ostacolo a Peso basso significa che le
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geometrie del layer sono meno considerate come ostacoli e quindi è più probabile che possano essere ricoperte
da etichette di altri layers. Questa priorità può anche essere definita dai dati, in modo che all’interno dello stesso
layer, per alcune geometrie ci sia più probabilità di essere ricoperte rispetto ad altre.

Per i layers poligonali, puoi scegliere il tipo di geometria da considerare come ostacolo riducendo al minimo i
posizionamenti delle etichette:

• All’interno dell’elemento: evita di inserire etichette all’interno del poligono (preferisce collocare le
etichette all’esterno o solo leggermente all’interno del poligono)

• o Lungo il contorno dell’elemento: evita di posizionare etichette oltre il contorno del poligono (preferisce
inserire le etichette all’esterno o completamente all’interno del poligono). Ad esempio, può essere utile per
i layers di confini regionali, dove le geometrie coprono un’intera area. In questo caso, è impossibile evitare
di inserire etichette all’interno di queste geometrie, e sembra molto meglio evitare di metterle oltre i confini
tra le geometrie.

Impostazioni sistema di posizionamento automatico

Nell’angolo in alto a destra della scheda Etichette, puoi utilizzare il
Impostazioni di disposizione automatica (si applica a tutti i layer) per configurare un comportamento globale e automatico delle

etichette. Facendo clic sul pulsante ti offre le seguenti opzioni:

Figure 13.36: Il motore di posizionamento automatico delle etichette

• La casella combinata Modalità di ricerca ti offre diversi metodi di posizionamento per trovare buone
soluzioni per il posizionamento dell’etichettatura di punti, linee e poligoni. Maggiori dettagli in questo
article.
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• Il Numero di candidati imposta quanti controlli al posizionamento delle etichette dovrebbero essere generati
per ogni tipo di oggetto. Più controlli vengono generati, migliore sarà l’etichettatura, ma ad un prezzo da
pagare sulle velocità di visualizzazione. Un numero minore di controlli si traduce in un minor numero di
etichette ottimizzate nella posizione, ma più rapidamente ridisegnate.

• Visualizzazione del testo: controlla se le etichette di testo sono disegnate (ed esportate) proprio come
oggetti di testo o solo come percorsi. Se vengono esportati come oggetti di testo, possono essere modificati
in applicazioni esterne (ad es. Inkscape) come testo normale. MA l’effetto collaterale è che la qualità di
visualizzazione è diminuita, E ci sono problemi di visualizzazione quando alcune sono attive impostazioni
di testo come i buffer. Questo è il motivo per cui si raccomanda di disegnare come contorni. Notare che
quando esportare un layout in svg c’è in effetti un override per questa impostazione - così puoi lasciare la
visualizzazione del progetto come outline ma con una esportazione .svg esporta le etichette come testo.

• Mostra le etichette che sarebbero troncate ai bordi della mappa: controlla se le etichette che non
rientrano parzialmente nell’estensione della mappa devono essere visualizzate. Se spuntata, queste etichette
saranno mostrate (quando non c’è modo di posizionarle completamente all’interno dell’area visibile). Se
non spuntata, le etichette visibili in modo parziale saranno eliminate.

• Mostra tutte le etichette per tutti i layer (anche se collidono). Si noti che questa opzione può essere
impostata anche per i layer (vedi Scheda Visualizzazione).

• Mostra i candidati (per debugging): controlla se devono essere disegnate sulla mappa che le caselle
mostrano tutti i controlli generati per il posizionamento delle etichette. Come dice il nome della opzione,
è utile solo per il debug e per testare l’effetto che hanno le diverse impostazioni di etichettatura. Questo
potrebbe essere utile per un migliore posizionamento manuale con gli strumenti della label toolbar.

Etichettatura tramite regole

Con Etichettatura tramite regole le etichette possono essere definite e applicate selettivamente sulla base di filtri
tramite espressioni e di intervalli di scala, come nella Rule-based rendering.

Per creare una regola, seleziona l’opzione Etichettatura tramite regole nell’elenco a discesa principale dalla

scheda Etichette e fai click sul pulsante nella parte inferiore della finestra di dialogo. Poi inserisci nella
nuova finestra di dialogo una descrizione e un’espressione che consente di selezionare le geometrie. Puoi anche
impostare un Intervallo di scala in cui deve essere applicata la regola per le etichette. Le altre opzioni disponibili
in questa finestra di dialogo sono le common settings viste in precedenza.

Un riepilogo delle regole esistenti è mostrato nella finestra di dialogo principale (vedi figure_labels_rule_based).
Puoi aggiungere più regole, riordinarle o sovrapporle con un drag-and-drop. Puoi anche rimuoverle con il pulsante

o modificarle con il pulsante o con un doppio click.

Definire le etichette tramite espressioni

Sia che tu scelga il tipo di etichettatura singola o basata su regole, QGIS consente di utilizzare le espressioni per
l’etichettatura di elementi.

Supponendo che stai utilizzando il metodo Etichette singole, fai clic sull’icona vicino all’elenco a discesa
Etichetta con nella scheda Etichette della finestra di dialogo delle proprietà.

In figure_labels_labels_expression, vedi un’esempio di espressione per etichettare il layer alaska trees con il tipo
di albero e l’area, basato sul campo “VEGDESC”, qualche testo descrittivo, e la funzione $area in combinazione
con format_number() per renderlo più bello.

L’etichettatura a base di espressioni è facile da gestire. Tutto quello che devi fare è che:

• Potresti avere necessità di combinare tutti gli elementi (stringhe, campi e funzioni) con una funzione di
concatenamento stringa come concat, + or ||. Ricorda che in alcune situazioni (quando sono coinvolti
null o valori numerici), non tutti questi strumenti sono adatti alle tue esigenze.
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Figure 13.37: Modifica regola216 Chapter 13. Lavorare con i vettori
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Figure 13.38: Pannello etichettatura tramite regole

Figure 13.39: Uso di espressioni per l’etichettatura
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• Le stringhe sono scritte tra “singoli apici”.

• I campi sono scritti tra «apici doppi» o senza alcun apice.

Guarda alcuni esempi:

1. Etichetta basata su due campi “nome” e “luogo” con una virgola come separatore:

"name" || ', ' || "place"

Risulta:

John Smith, Paris

2. Etichetta basata su due campi “nome” e “luogo” con altri testi:

'My name is ' + "name" + 'and I live in ' + "place"
'My name is ' || "name" || 'and I live in ' || "place"
concat('My name is ', name, ' and I live in ', "place")

Risulta:

My name is John Smith and I live in Paris

3. Etichetta basata su due campi “nome” e “luogo” con altri testi che combinano diverse funzioni di concate-
nazione:

concat('My name is ', name, ' and I live in ' || place)

Risulta:

My name is John Smith and I live in Paris

Oppure, se il campo “luogo” è NULL, restituisce:

My name is John Smith

4. Etichetta a più righe basata su due campi “nome” e “luogo” con un testo descrittivo:

concat('My name is ', "name", '\n' , 'I live in ' , "place")

Risulta:

My name is John Smith
I live in Paris

5. Etichetta basata su un campo e la funzione $area per mostrare il nome del luogo e la sua superficie arroton-
data in una unità convertita:

'The area of ' || "place" || ' has a size of '
|| round($area/10000) || ' ha'

Risulta:

The area of Paris has a size of 10500 ha

6. Creare una condizione CASE ELSE. Se il valore della popolazione nel campo “popolazione” è <= 50000 è
una town, altrimenti è una city:

concat('This place is a ',
CASE WHEN "population" <= 50000 THEN 'town' ELSE 'city' END)

Risulta:
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This place is a town

7. Visualizza il nome della città e nessuna etichetta per le altre voci (per il caso della «città», vedi esempio
sopra):

CASE WHEN "population" > 50000 THEN "NAME" END

Risulta:

Paris

Come puoi vedere nel costruttore di espressioni, puoi creare espressioni semplici o molto complesse con tantissime
funzioni utili, per etichettare i tuoi dati in QGIS. Vedi il capitolo Espressioni per ulteriori esempi e informazioni
sulle espressioni.

Etichettare in funzione dei dati

Con la funzione Sovrascrittura definita dai dati, le impostazioni per l’etichettatura sono sovrascritte dalle voci della
tabella degli attributi o da espressioni basate su di essi. Questa funzione può essere usata per impostare i valori
per la maggior parte delle opzioni di etichettatura sopra descritte.

Per esempio, usando il set di dati campione QGIS dell’Alaska, etichettiamo il layer airports con il loro nome,
in base al loro USE militare, cioè se l’aeroporto è accessibile a:

• personale militare, allora mostralo in grigio, dimensione 8;

• altri, allora mostralo in blu, dimensione 10.

Per ottenere ciò, dopo aver abilitato l’etichettatura sul campo NAME del layer (vedi Impostazione etichetta):

1. Attiva la scheda Testo.

2. Fai clic sull’icona accanto alla proprietà Dimensioni.

3. Seleziona Modifica. . . e digita:

CASE
WHEN "USE" like '%Military%' THEN 8 -- because compatible values are

→˓'Military'
-- and 'Joint Military/Civilian'

ELSE 10
END

4. Premi OK per convalidare. La finestra di dialogo si chiude e il pulsante diventa il che significa che
una regola è in esecuzione.

5. Quindi fai clic sul pulsante accanto alla proprietà colore, digita l’espressione sottostante e convalida:

CASE
WHEN "USE" like '%Military%' THEN '150, 150, 150'
ELSE '0, 0, 255'

END

Allo stesso modo, puo personalizzare qualsiasi altra proprietà dell’etichetta, nel modo desiderato. Vedi mag-

giori dettagli sulla descrizione e manipolazione del widget Sovrascrittura definita dai dati nella sezione Impostazione
Sovrascrittura definita dai dati.
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Figure 13.40: Le etichette degli aeroporti sono formattate in base ai loro attributi

Barra delle etichette

La Barra delle etichette fornisce alcuni strumenti per manipolare le proprietà dell” etichetta o del
diagramma, ma solo se è indicata l’opzione corrispondente definita dai dati (altrimenti i pulsanti sono disabilitati).
Il vettore dovrebbe anche essere in modalità di modifica.

Figure 13.41: La barra degli strumenti etichetta

Mentre per la leggibilità è stato usato etichetta per descrivere la barra degli strumenti etichette, nota che
quando menzionati nel loro nome, gli strumenti funzionano quasi nello stesso modo con i diagrammi:

• Ancora/disancora etichette e diagrammi che dispongono di una posizione definita da dati. Facendo clic o trasci-
nando un’area, inserire le etichette. Se scegli o trascini su una zona premendo Maiuscolo, la(e)
etichetta(e) sono disattivate. Infine, puoi anche cliccare o trascinare un’area tenendo Ctrl per alternare
lo stato dei pin della(e) etichetta(e).

• Evidenzia etichette e diagrammi ancorati. Se il vettore delle etichette è modificabile, allora gli evidenziati sono
verdi altrimenti sono blu.

• Muovi etichetta e diagramma che ha posizione definita. Devi trascinare l’etichetta nella posizione desiderata.

• Mostra/Nascondi etichette e diagrammi che hanno la visibilità definita dai dati. Se scegli o trascini su una zona
premendo Maiuscolo, la(e) etichetta(e) sono nascoste. Quando un’etichetta è nascosta, devi solo cliccare
o trascinare un’area attorno al punto dell’elemento per ripristinare la sua visibilità.
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• Ruota etichetta. Click sull’etichetta e ruotala.

• Cambia l’etichetta. Apre una finestra di dialogo per modificare le proprietà dell’etichetta cliccata; può essere
l’etichetta stessa, le sue coordinate, l’angolo, il carattere, la dimensione . . .

Avvertimento: Gli strumenti di etichetta sovrascrivono i valori del campo corrente

L’utilizzo di Barra degli strumenti di etichetta per personalizzare l’etichetta effettivamente scrive il nuovo
valore della proprietà nel campo mappato. Quindi, presta attenzione a non sostituire inavvertitamente i dati
che ti potrebbero essere necessari in seguito!

Nota: Il meccanismo Proprietà Dati Ausiliari può essere utilizzato per personalizzare l’etichettatura (posizione
e così via) senza modificare la fonte dati sottostante.

Personalizza le etichette nella mappa

In combinazione con la Barra delle etichette, l’impostazione di sovrascrittura definita dai dati ti aiuta a manipo-
lare le etichette nella mappa (spostare, modificare, ruotare). Ora descriviamo un esempio usando la funzione di

sovrascrittura definita dai dati per la funzione Move label (vedi figure_labels_coordinate_data_defined).

1. Importa il lakes.shp dall’insieme di dati di esempio di QGIS.

2. Fai doppio clic sul layer per aprire le proprietà del layer. Clicca su Etichette e Posizionamento. Seleziona

Offset dal centride.

3. Cercare la voce Definito in funzione dei dati. Fai clic sull’icona per definire il tipo campo per Coordi-
nata. Scegli xlabel per X e ylabel per Y. Le icone sono ora evidenziate in giallo.

Figure 13.42: Etichettatura di vettori poligonali sovrascritti in funzione dei dati

4. Fai zoom su un lago

5. Imposta come modificabile il layer utilizzando il pulsante Attiva modifiche

6. Vai sulla Barra delle etichette e fai clic sull’icona . Adesso puoi spostare manualmente l’etichetta in
un’altra posizione (vedi figure_labels_move). La nuova posizione dell’etichetta viene salvata nelle colonne
xlabel e ylabel della tabella degli attributi.

7. Utilizzando Generatore geometria con l’espressione sottostante, puoi anche aggiungere un layer di simboli
di linea per collegare ciascun lago alla sua etichetta spostata:

make_line( centroid( $geometry ), make_point( "xlabel", "ylabel" ) )

Nota: Il meccanismo Proprietà Dati Ausiliari può essere utilizzato con proprietà definite dai dati senza avere una
fonte di dati modificabile.
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Figure 13.43: Spostamento etichette

13.2.5 Proprietà Diagrammi

La scheda Diagrammi ti consente di aggiungere una sovrapposizione grafica a un layer vettoriale (vedi
figure_diagrams_attributes).

Attualmente le tipologie di diagrammi supportati sono:

• Nessun diagramma: il valore di default senza visualizzazione di diagrammi sulle geometrie;

• Grafico a torta, un grafico statistico a forma di cerchio diviso in fette per illustrare le proporzioni
numeriche. La lunghezza dell’arco di ogni fetta è proporzionale alla quantità che rappresenta;

• Diagramma testo, un cerchio diviso orizzontalmente che mostra i valori statistici al suo interno;

• e Istogramma.

Nell’angolo in alto a destra della scheda Diagrammi, il pulsante
Impostazioni di posizionamento automatico (si applica a tutti i layer) fornisce gli strumenti per controllare il diagramma posizione
delle etichette sulla visualizzazione mappa.

Suggerimento: Passare rapidamente tra tipi di diagrammi

Dato che le impostazioni sono quasi comuni ai diversi tipi di diagrammi, nella progettazione del diagramma è
possibile modificare facilmente il tipo di diagramma e verificare quale è più appropriato ai tuoi dati senza perdita
delle impostazioni e dei dati.

Per ogni tipo di diagramma, le proprietà sono suddivise in più schede:

• Attributes
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• Rendering

• Size

• Placement

• Options

• Legend

Attributi

Attributi definisce quali variabili da visualizzare nel diagramma. Utilizza il pulsante Aggiungi elemento per se-
lezionare i campi desiderati nel pannello «Attributi assegnati». Possono essere utilizzati anche gli attributi generati
con le Espressioni.

Puoi spostarti su e giù in qualsiasi riga con il clic e trascina, ordinando come vengono visualizzati gli at-
tributi. Puoi inoltre modificare l’etichetta nella colonna «Legenda» o nel colore dell’attributo facendo doppio
clic sull’elemento.

Questa etichetta è il testo predefinito visualizzato nella legenda del layout di stampa o dell’albero dei layer.

Figure 13.44: Proprietà Diagrammi – Scheda Attributi

Visualizzazione

Aspetto definisce come appare il diagramma. Fornisce impostazioni generali che non interferiscono con i valori
statistici quali:

• la trasparenza grafica, lo spessore e il colore del contorno

• e, a seconda del tipo di diagramma:

– la larghezza della barra in caso di istogramma;

– il colore di sfondo del cerchio in caso di diagramma di testo e il carattere utilizzato per i testi;

– l’orientamento della linea sinistra della prima fetta rappresentata nel grafico a torta. Si noti che le fette
sono visualizzate in senso orario.
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in questa scheda, puoi anche gestire e ottimizzare la visibilità del diagramma con diverse opzioni:

• Livello del diagramma (z-index): controlla come i diagrammi sono disegnati uno sopra l’altro e sopra le
etichette. Un diagramma con un alto indice viene disegnato sopra diagrammi ed etichette;

• Mostra tutti i diagrammi: mostra tutti i diagrammi anche se si sovrappongono tra loro;

• Mostra diagramma: permette di visualizzare solo diagrammi specifici;

• Mostra sempre: seleziona diagrammi specifici da visualizzare sempre, anche quando si sovrappongono ad
altri diagrammi o a etichette delle mappe;

• impostando Visibilità dipendente dalla scala ;

• Evitare che i diagrammi e le etichette si sovrappongano alle geometrie: definisce le geometrie da consider-
are come ostacoli, cioè QGIS cercherà di non posizionare diagrammi o etichette su queste geometrie.

Figure 13.45: Proprietà Diagramma – Scheda Visualizzazione

Dimensione

Dimensione è la scheda principale per impostare come vengono rappresentate le statistiche selezionate. Le unità
di misura del diagramma possono essere “Millimetro”, “Punti”, Pixel, “Unità di mappa” o “Pollici”. Puoi usare:

• Dimensione fissa, una dimensione unica per rappresentare l’immagine di tutti gli elementi, ad eccezione
della visualizzazione di istogrammi

• o Dimensione scalata, basata su un’espressione che utilizza gli attributi del layer.
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Figure 13.46: Proprietà Diagrammi – Scheda Dimensione

Posizionamento

Posizionamento aiuta a disegnare la posizione del diagramma. Secondo il tipo di geometria del layer, offre diverse
opzioni per il posizionamento:

• “Sopra il punto” o “Intorno al punto” per la geometria puntuale. Quest’ultima variabile richiede
l’assegnazione di una distanza.

• “Sopra la linea” o “Intorno alla linea” per la geometria lineare. Come per la geometria punto, l’ultima vari-
abile richiede una distanza da rispettare e l’utente può specificare il posizionamento del diagramma relativo
alla funzione (“sopra”, “su” e / o “sotto” la linea) È possibile selezionare più opzioni contemporaneamente.
In questo caso, QGIS cercherà la posizione ottimale del diagramma. Ricorda che qui puoi anche utilizzare
l’orientamento della linea per la posizione del diagramma.

• “Sopra il centroide”, “Intorno al centroide” (con una impostazione di distanza), “Perimetro” e comunque
“Dentro il poligono” sono le opzioni per le geometrie poligonali.

Il diagramma può anche essere posizionato utilizzando i dati della geometria con i campi X e Y delle coordinate.

Il posizionamento dei diagrammi può interferire con l’etichettatura, perciò puoi rilevare e risolvere i conflitti di
posizione tra diagrammi ed etichette impostando il valore del cursore Priorità.

Opzioni

La scheda Opzioni ha impostazioni solo in caso di istogramma. Puoi scegliere se l’orientamento della barra sia
“Su”, “Giù”, “Destra” e “Sinistra”.

Legenda

Dalla scheda Legenda, puoi scegliere di visualizzare gli elementi del diagramma in Pannello dei Layer, e in print
layout legend, accanto alla simbologia dei layer:

• seleziona Mostra legenda degli attributi del diagramma per visualizzare nelle legende le proprietà Colore
e Legenda, come precedentemente assegnato nella scheda Attributi;
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Figure 13.47: Finestra di dialogo proprietà vettori con Proprietà Diagrammi, Scheda Posizionamento

• e, quando per i diagrammi viene utilizzata una dimensione scaled size, premi il pulsante Legend Entries for
Diagram Size. . . . per configurare l’aspetto del simbolo del diagramma nelle legende. Questo apre la finestra
di dialogo Dimensione legenda definita dai dati le cui opzioni sono descritte in Dimensione legenda definita
dai dati.

Quando sono impostate, le voci della legenda del diagramma (attributi con colore e dimensioni del diagramma)
sono visualizzate anche nella legenda del layout di stampa, accanto alla simbologia dei layer.

Argomenti di studio

Mostreremo un esempio mostrando una sovrapposizioni di un layer vettoriale dei dati climatici di temperatura
sul layer del confine Alaska. Entrambi i layers vettoriali fanno parte del set di dati del campione QGIS (vedi la
sezione Dati campione).

1. Innanzitutto, fai clic sull’icona Aggiungi Vettore, esegui la ricerca nella cartella dei dataset di esempio di
QGIS e carica i due layers vettoriali in formato shapefile alaska.shp e climate.shp.

2. Fai doppio click sul vettore climate nella legenda per aprire la finestra di dialogo Proprietà layer.

3. Fai click sulla scheda Diagrammi e dalla casella combinata di scelta del Tipo Diagramma seleziona
«Diagramma testo».

4. Nella scheda Aspetto scegli un blu chiaro come colore di sfondo e nella scheda Dimensione imposta 18 mm
come dimensione fissa.

5. Nella scheda Posizione scegli “Intorno al punto” come posizionamento.

6. Nel diagramma, vogliamo visualizzare i valori delle tre colonne T_F_JAN, T_F_JUL e T_F_MEAN.

Quindi, nella scheda Attributi, prima seleziona T_F_JAN e fai click sul pulsante quindi ripeti con
T_F_JUL e infine T_F_MEAN.

7. Ora clicca su Applica per visualizzare il diagramma nella finestra principale di QGIS.

8. Puoi adattare la dimensione del grafico nella scheda Dimensioni. Attiva Dimensione scalata e imposta la
dimensione dei diagrammi in base al Valore massimo di un attributo e l’opzione Dimensioni. Se i diagrammi
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appaiono troppo piccoli sullo schermo, puoi attivare la casella di controllo Aumenta la dimensione dei
diagrammi piccoli e definire la dimensione minima dei diagrammi.

9. Modifica i colori degli attributi facendo doppio click sui valori di colore nel campo Attributi assegnati.
Figure_diagrams_mapped dà un’idea del risultato.

10. Infine, clicca OK.

Figure 13.48: Diagrammi di temperatura sovrapposti su una mappa

Ricordati che puoi usare anche l’opzione Posizione definita da attributo per posizionare i diagrammi. Inoltre puoi
anche impostare la visibilità dei diagrammi in funzione di determinate scale dalla scheda Aspetto.

La dimensione e gli attributi possono anche essere un’espressione. Utilizza il pulsante per aggiungere
un’espressione. Per ulteriori informazioni ed esempi vedi il capitolo Espressioni.

Utilizzo di sovrascrittura definita dei dati

Come ricordato sopra, puoi utilizzare alcuni modi di definizione dati per affinare la visualizzazione dei diagrammi:

• posizione tramite il riempimento dei campi X e Y nella scheda Posizionamento

• visibilità nella scheda Aspetto tramite il riempimento del campo Visibilità

Vedi Etichettare in funzione dei dati per maggiori informazioni.

13.2.6 Proprietà Campi Sorgente

La scheda Campi Sorgente fornisce informazioni sui campi relativi al layer e ti aiuta ad organizzarli.

Puoi rendere modificabile il layer usando Attiva/disattiva modalità modifica. A questo punto puoi modificarne la strut-

tura usando i pulsanti Nuovo campo e Elimina campo.

Puoi anche rinominare i campi facendo doppio clic sul nome. Questa opzione è supportata solo per le sorgenti
dati come PostgreSQL, Oracle, Memory layer e qualche layer OGR a seconda del formato e della versione dei
dati OGR.

Se è impostato nella sorgente dati o nelle forms properties, viene visualizzato anche l’alias del campo. Un alias
è un nome di campo leggibile dall’uomo che puoi usare nel modulo delle geometrie o nella tabella degli attributi.
Gli alias vengono salvati nel file di progetto.proprietà
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A seconda della sorgente dati, puoi associare un commento a un campo, ad esempio al momento della sua
creazione. Questa informazione viene recuperata e mostrata nella colonna Commento e viene poi visualizzata
nel modulo della geometria quando si passa sopra l’etichetta del campo.

Oltre ai campi contenuti nel dataset, campi virtuali e Auxiliary Storage inclusi, la scheda Campi Sorgente elenca
anche campi da qualsiasi joined layers. A seconda dell’origine del campo, viene applicato un diverso colore di
sfondo.

Per ogni campo elencato, la finestra di dialogo elenca anche caratteristiche di sola lettura come il suo Tipo, Nome,
Lunghezza e Precisione. Quando si usano layer come WMS o WFS, si può anche controllare qui quali campi
possono essere ricavati.

Figure 13.49: Scheda Proprietà Campi Sorgente

13.2.7 Proprietà Modulo Attributi

La scheda Modulo Attributi ti aiuta a impostare il modulo da visualizzare quando si creano nuove geometrie o
si interrogano quelle esistenti. Puoi definire:

• lo stile e il comportamento di ogni campo nel modulo delle geometrie o nella tabella degli attributi (etichetta,
widget, vincoli. . . .);

• la struttura del modulo (personalizzata o autogenerata):

• logica extra in Python per gestire l’interazione con i widget del modulo o dei campi.

In alto a destra della finestra di dialogo, puoi impostare se il modulo viene aperto in maniera predefinita quando
si creano nuove funzioni. Puoi configurarlo per layer o globalmente con l’opzione Non aprire il modulo dopo la
creazione di ogni geometria nel menu Impostazioni → Opzioni → Digitalizzazione.

Personalizzare un modulo per i tuoi dati

Per impostazione predefinita, quando clicchi su una geometria con lo strumento Informazione elementi o apri la
tabella degli attributi nella modalità vista modulo, QGIS visualizza un modulo base con widget predefiniti (gen-
eralmente caselle a tendina e caselle di testo — ogni campo è rappresentato su una riga dedicata dalla sua etichetta
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accanto al widget). Se sono configurate relazioni del layer, i campi dei layer di riferimento sono mostrati in una
cornice incorporata nella parte inferiore del modulo, seguendo la stessa struttura di base.

Questa visualizzazione è il risultato del valore predefinito Genera automaticamente dell’impostazione
Configurazione dell’editor degli attributi nella scheda Proprietà vettore → Modulo attributi. Questa proprietà
contiene tre diversi valori:

• Genera automaticamente: mantiene la struttura di base di «una riga - un campo» per il modulo, ma
permette di personalizzare ogni widget corrispondente.

• Crea maschera di inserimento: oltre alla personalizzazione del widget, la struttura del modulo
può essere resa più complessa, ad esempio, con widget incorporati in gruppi e schede.

• Fornisci file ui: permette di utilizzare un file di Qt designer, quindi un modello potenzialmente più
complesso e completo, come modulo per le geometrie.

Il modulo generato automaticamente

Quando l’opzione Genera automaticamente è attivata, il pannello Widgets disponibili ti mostra le liste di
campi (del layer e delle sue relazioni) che verranno mostrati nel modulo. Seleziona un campo e puoi configurare
il suo aspetto e il suo comportamento nel pannello di destra:

• aggiungendo una etichetta personalizzabile e spunte automatizzate al campo;

• impostando un widget particolare da usare.

Editor clicca e trascina

Scegli Crea maschera di insermento dal menu a tendina Configurazione editore attributi e attiva un
pannello Layout del modulo accanto al pannello Widget disponibili. Da questo pannello puoi creare un editor con
diverse schede e gruppi di nomi per mostrare i campi attributo, come mostrato ad esempio in Modulo personaliz-
zato con schede e gruppi distinti.

Figure 13.50: Modulo personalizzato con schede e gruppi distinti

13.2. Proprietà dei vettori 229



QGIS User Guide, Release 3.4

Per creare il modulo, puoi trascinare e rilasciare i campi dal pannello Widgets disponibili al pannello Layout del
Modulo per aggiungere campi al tuo modulo personalizzato e trascinare e rilasciare i campi all’interno del Layout
del Modulo per riordinare la loro posizione.

Puoi anche utilizzare le categorie (schede o riquadri gruppo) per strutturare meglio il modulo. Il primo passaggio

consiste nell’utilizzare l’icona per creare una scheda in cui verranno visualizzati i campi e i gruppi (vedi
Finestra di dialogo per creare categorie con la maschera di inserimento). Puoi creare tutte le categorie che vuoi.

Usa il pulsante per rimuovere gli elementi indesiderati. Il passo successivo sarà quello di assegnare ad ogni
categoria i campi rilevanti, con un semplice clicca e trascina. Puoi usare gli stessi campi più volte.

Figure 13.51: Finestra di dialogo per creare categorie con la maschera di inserimento

Puoi configurare schede o gruppi con un doppio clic. QGIS apre un modulo in cui puoi:

• scegli di nascondere o mostrare l’etichetta dell’oggetto;

• rinominare la categoria;

• stabilire su quante colonne devono essere distribuiti i campi della categoria;

• inserisci un’espressione per controllare la visibilità della categoria. L’espressione verrà ricalcolata ogni
volta che i valori nel modulo cambiano e la scheda o il gruppo mostrato/nascosto di conseguenza.

• mostra la categoria come un gruppo (disponibile solo per le schede).

Con un doppio clic su un’etichetta di campo, puoi anche specificare se l’etichetta del suo widget deve essere
visibile o meno nel modulo.

Nel caso in cui il layer sia coinvolto in relazione uno a molti (vedi Creare una relazione uno a molti o
molti a molti), i layer di riferimento sono elencati nella cornice Relazioni e il loro modulo può essere incorporato
con clicca e trascina nel modulo del layer corrente. Come per gli altri elementi, fai doppio clic sull’etichetta della
relazione per configurare alcune opzioni:

• scegli di nascondere o mostrare l’etichetta dell’oggetto;

• mostra il pulsante del collegamento;

• mostrare il pulsante dello scollegamento.
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Utilizzare file-ui personalizzato

L’opzione Fornisci file UI ti permette di usare finestre di dialogo complesse fatte con Qt-Designer.
L’utilizzo di un file UI consente una grande libertà nella creazione di una finestra di dialogo. Nota che, per
collegare gli oggetti grafici (casella di testo, casella combinata . . . ) ai campi del livello, è necessario assegnare
loro lo stesso nome.

Usa Modifica UI per definire il percorso del file da utilizzare.

Troverai qualche esenpio nella lezione Crea un nuovo modulo del QGIS-training-manual-index-reference. Per
maggiori informazioni vedi https://nathanw.net/2011/09/05/qgis-tips-custom-feature-forms-with-python-logic/.

Migliora il tuo modulo con funzioni personalizzate

I moduli QGIS possono avere una funzione Python chiamata quando viene aperta la finestra di dialogo. Usa questa
funzione per aggiungere ulteriori comandi alle tue finestre di dialogo. Il codice del modulo può essere specificato
in tre modi diversi:

• Carica dall'ambiente: utilizza una funzione, ad esempio in startup.py` o da un plugin instal-
lato.

• carica da un file esterno: in questo caso verrà visualizzato un selezionatore di fileper consen-
tire all’utente di selezionare un file Python dal proprio filesystem

• Fornisci il codice in questa finestra: apparirà un editor Python dove puoi digitare diret-
tamente la funzione da usare.

In tutti i casi devi inserire il nome della funzione che verrà chiamata (open nell’esempio sotto).

Un esempio è (nel modulo MyForms.py):

def open(dialog,layer,feature):
geom = feature.geometry()
control = dialog.findChild(QWidged,"My line edit")

Riferimento in Python Init Function in questo modo: open

Configurare il comportamento dei campi

La parte principale della scheda Modulo Attributi ti aiuta a impostare il tipo di widget utilizzato per riempire o
visualizzare i valori del campo, nella tabella degli attributi o nel modulo geometrie: puoi definire come l’utente
interagisce con ogni campo e i valori o la gamma di valori che possono essere aggiunti a ciascuno.

Impostazioni comuni

Indipendentemente dal tipo di widget applicato al campo, ci sono alcune proprietà comuni che puoi impostare per
controllare se e come un campo può essere modificato.

Opzioni generali

• Alias: un nome comprensibile da usare per i campi. Gli alias saranno visualizzati nel modulo geometrie,
nella tabella degli attributi o nel pannello Visualizzatore risultati. Può anche essere usato come sostituto
del nome del campo in Costruttore di espressioni 1, facilitando la comprensione delle espressioni e delle
verifiche. Gli alias sono salvati nel file di progetto.

• Commento: visualizza il commento del campo come mostrato nella scheda Campi sorgente, in stato di sola
lettura. Queste informazioni sono mostrate come suggerimento quando si passa sopra l’etichetta del campo
in un modulo geometria.
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Figure 13.52: Finestra di dialogo per modificare un campo

• Modificabile: deseleziona questa opzione per impostare il campo in sola lettura (non modificabile man-
ualmente) anche quando il layer è in modalità di modifica. Nota che il controllo di questa impostazione non
prevale su qualsiasi altra limitazione di modifica da parte del fornitore dati.

• Etichetta in alto: posiziona il nome del campo sopra o accanto al widget nel modulo delle geometrie.

Valori predefiniti

• Valore predefinito: per nuove geometrie, popola automaticamente il campo con un valore predefinito o un
valore expression-based one 1. Per esempio, puoi:

– utilizzare $x, $length, $area per popolare automaticamente un campo con la coordinata X
dell’elemento, la lunghezza, l’area o qualsiasi informazione geometrica alla sua creazione;

– incrementare un campo di 1 per ogni nuova geometria usando maximum("field")+1;

– salvare la data e l’ora di creazione della geometria usando now();

– usare variables nelle espressioni, rendendo più facile, ad esempio, inserire il nome dell’operatore
(@user_full_name`), il percorso del file del progetto (@project_path), . . . .

Un’anteprima del conseguente valore predefinito viene visualizzata nella parte inferiore del widget.

Nota: L’opzione Valore predefinito ignora i valori in ogni altro campo della geometria creata,
quindi non sarà possibile utilizzare un’espressione che combina uno qualsiasi di questi valori, ad esempio
utilizzando un’espressione come concat(field1, field2) potrebbe non funzionare.

• Applica valore predefinito all’aggiornamento: ogni volta che l’attributo della geometria o la geometria
viene modificata, il valore predefinito viene ricalcolato. Questo potrebbe essere utile per salvare valori come
modificati dall” ultimo utente, l’ultima volta che è stato modificato. . . ..
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Vincoli

Puoi vincolare il valore da inserire nel campo. Questo vincolo può essere:

• Non nullo: richiede che l’utente fornisca un valore;

• Univoco: per garantire che il valore inserito sia unico in ogni campo;

• basato su un’espressione personalizzata: ad esempio regexp_match(col0,'A-Za-z') per assicurare
che il valore del campo col0 contenga solo lettere dell’alfabeto.

Ogni volta che un valore viene aggiunto o modificato in un campo, viene sottoposto ai vincoli esistenti e:

• se soddisfa tutti i requisiti, un segno di spunta verde viene mostrato accanto al campo nel modulo;

• se non soddisfa tutti i requisiti, in prossimità del campo viene visualizzata una croce gialla o rossa. È
possibile passare sopra la croce per ricordarsi quali vincoli sono applicati al campo e correggere il valore:

– Una croce gialla appare quando il vincolo non soddisfatto è un vincolo non obbligatorio e non im-
pedisce di salvare le modifiche con i valori «sbagliati»;

– Una croce rossa non può essere ignorata e non consente di salvare le modifiche fino a quando non

vengono rispettati i vincoli. Appare quando l’opzione Fai rispettare il vincolo espressione è se-
lezionata.

Widgets disponibili

In base al tipo di campo, QGIS determina e assegna automaticamente un tipo di widget predefinito. È quindi
possibile sostituire il widget con qualsiasi altro compatibile con il tipo di campo. I widget disponibili sono:

• Casella di controllo: Visualizza una casella di controllo il cui stato definisce il valore da inserire.

• Classificazione: Disponibile solo quando un categorized symbology è applicato al layer, visualizza una
casella combinata con i valori delle classi.

• Colore: Visualizza un color widget che permette di selezionare un colore; il valore del colore è memorizzato
come notazione html nella tabella degli attributi.

• Data/ora: Visualizza un campo che può aprire un widget di calendario per inserire una data, un tempo
o entrambi. Il tipo di colonna deve essere testo. Puoi selezionare un formato personalizzato, aprire un
calendario, ecc.

• Numerazione: Apre una combo box con valori predefiniti provenienti dal database. Questo è attualmente
supportato solo da PostgreSQL, per campi di tipo enum.

• Allegato: utilizza una finestra di dialogo «Apri file» per memorizzare il percorso del file in modalità relativa
o assoluta. Può anche essere utilizzato per visualizzare un collegamento ipertestuale (per il percorso del
documento), un’immagine o una pagina web.

• Nascosto: rende invisibile la colonna, quindi non potrai vederne il contenuto.

• Chiave/Valore: Visualizza una tabella a due colonne per memorizzare insiemi di coppie chiave/valore in
un unico campo. Questo è attualmente supportato da PostgreSQL, per campi di tipo hstore.

• Lista: Visualizza una tabella a colonna singola per aggiungere valori diversi all’interno di un singolo campo.
Questo è attualmente supportato da PostgreSQL, per campi di tipo array.

• Intervallo: ti permette di impostare dei valori di un preciso intervallo numerico. Il widget può apparire
come un cursore o come un campo modificabile.

• Riferimento della relazione: questo widget ti consente di incorporare il modulo della geometria del layer
di riferimento nel modulo della geometria del layer attivo. Vedi Creare una relazione uno a molti o molti a
molti.

• Modifica testo (impostazione predefinita): consente di aprire un campo di modifica del testo che consente
di utilizzare testi semplici testi o a più righe. Se scegli più righe puoi anche scegliere contenuto html.
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• Valori univoci: puoi selezionare uno dei valori già utilizzati nella tabella degli attributi. Se è attivato
“Modifica”, viene visualizzata una scelta in linea con il supporto di autocompletamento, altrimenti viene
visualizzato un menu a tendina.

• Generatore UUID: genera un campo UUID (Universally Unique Idetifiers) di sola lettura, se il campo è
vuoto.

• Mappa valore: un menu a tendina con elementi predefiniti. Il valore viene memorizzato nell’attributo, la
descrizione viene visualizzata nel menu a tendina. Puoi definire i valori manualmente oppure caricarli da
un layer o da un file CSV.

• Relazione valore: offre valori da una tabella correlata in caselle combinate. Puoi selezionare layer, colonna
chiave e colonna valore. Sono disponibili diverse opzioni per modificare i comportamenti standard: con-
sentire il valore nullo, l’ordine per valore, consentire più selezioni e utilizzare l’autocompletamento. Le
maschere visualizzeranno un elenco a discesa o un elemento di modifica in linea quando la casella di con-
trollo autocompletamento è abilitata.

Suggerimento: Percorso relativo nel widget allegato

Se il percorso selezionato con il browser file si trova nella stessa directory del file di progetto .qgs o in cartella
sottostante, i percorsi vengono convertiti in percorsi relativi. Ciò aumenta la portabilità di un progetto .qgs con
le informazioni multimediali allegate.

13.2.8 Proprietà Join

La scheda Joins ti consente di unire una tabella di attributi a un layer vettoriale. Dopo aver cliccato su ,
viene visualizzata la finestra Aggiungi vettore da unire (join). Come colonne chiave, devi definire un layer da
unire (join) da connettere con il layer vettoriale. Quindi, devi specificare il campo join che è comune sia al layer
di unire e al layer destinazione. Ora puoi anche specificare un sottoinsieme di campi dal layer di join in base alla
casella seleziona i campi per l’unione. Come risultato del join, tutte le informazioni dal layer di join e del layer
di destinazione vengono visualizzate nella tabella degli attributi del vettore di destinazione come informazioni
aggiunte. Se hai specificato un sottoinsieme di campi solo questi campi vengono visualizzati nella tabella degli
attributi del layer di destinazione.

Se il layer di riferimento è modificabile, alcune icone saranno visualizzate nella tabella degli attributi accanto ai
campi, per informarne lo stato:

• : il layer di join non è configurato per essere modificabile. Se vuoi essere in grado di modificare le
geometrie in join dalla tabella degli attributi di destinazione, allora devi spuntare l’opzione ||checkbox|
Layer di unione modificabile.

• : il layer di join è ben configurato per essere modificabile, ma il suo stato attuale è in sola lettura.

• : il layer di join è modificabile ma i meccanismi di sincronizzazione non sono attivati. Se vuoi ag-
giungere automaticamente una geometria nel layer di join quando una geometria viene creata nel layer di

destinazione, allora devi selezionare l’opzione Inserimento in modifica. Simmetricamente, l’opzione

Elimina a cascata può essere attivata se vuoi eliminare automaticamente le geometrie in join.

Inoltre, l’opzione Modulo dinamico aiuta a sincronizzare al volo i campi join, secondo l’opzione Campo
destinazione. In questo modo, anche i vincoli per i campi join sono aggiornati correttamente. Si noti che è
disattivato di default perché può richiedere molto tempo se si hanno molte caratteristiche o una miriade di join.

Altrimenti, l’opzione Vettore unito in memoria virtuale permette di memorizzare i valori in memoria (senza
geometrie) dal layer di join per velocizzare le ricerche.

QGIS attualmente supporta anche join di tabelle non spaziali supportate da OGR (come CSV, DBF e EXcel), le di
testo delimitato e fonti dati di PostgreSQL (vedi figure_joins).
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Figure 13.53: Unisci una tabella di attributi ad un layer vettoriale
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Inoltre, la finestra di dialogo aggiungi vettore da unire ti permette di:

• Crea un indice nel campo unito

• Seleziona i campi per l’unione

• Crea un Prefisso del nome del campo personalizzato

13.2.9 Proprietà Dati Ausiliari

Il modo consueto per personalizzare lo styling e l’etichettatura è quello di utilizzare proprietà definite dai dati
come descritto in Impostazione Sovrascrittura definita dai dati. Tuttavia, potrebbe non essere possibile se i dati
sottostanti sono di sola lettura. Inoltre, la configurazione di queste proprietà definite dai dati può richiedere molto
tempo o non essere auspicabile! Per esempio, se si desidera utilizzare completamente gli strumenti della mappa
con Barra delle etichette, è necessario aggiungere e configurare più di 20 campi nella sorgente dati originale
(posizioni X e Y, angolo di rotazione, stile del carattere, colore e così via).

Il meccanismo Dati Ausiliari fornisce la soluzione a queste limitazioni e complesse configurazioni. I campi
ausiliari sono un modo alternativo per gestire e memorizzare automaticamente queste proprietà definite dai dati
(etichette, diagrammi, simbologia. . . .) in un database SQLite grazie a collegamenti modificabili. Questo permette
di memorizzare proprietà per layer che non sono modificabili.

Una scheda è disponibile nella finestra di dialogo delle proprietà del layer vettoriale per gestire la memoria ausil-
iaria:

Figure 13.54: Scheda Dati Ausiliari

Etichettatura

Considerando che l’origine dati può essere personalizzata grazie alle proprietà definite dai dati senza essere mod-
ificabile, gli strumenti di etichettatura della mappa descritti in Barra delle etichette sono sempre disponibili non
appena l’etichettatura viene attivata.
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In realtà, il sistema di archiviazione ausiliario ha bisogno di un layer ausiliario per memorizzare queste proprietà
in un database SQLite (vedi Database Dati Ausiliari). Il suo processo di creazione viene eseguito la prima volta
che si clicca sulla mappa mentre uno strumento di etichettatura della mappa è attualmente attivato. Poi, viene
visualizzata una finestra che permette di selezionare la chiave primaria da utilizzare per l’unione (per assicurarsi
che le geometrie siano univocamente identificate):

Figure 13.55: Finestra di dialogo Layer Ausiliario

Non appena viene configurato un layer ausiliario come fonte di dati corrente, puoi recuperare le sue informazioni
nella scheda:

Figure 13.56: Chiave layer ausiliario

Il layer ausiliario ha ora queste caratteristiche:

• la chiave primaria è ID,

• ci sono 0 geometrie che utilizzano un campo ausiliario,

• ci sono 0 campi ausiliari.

Ora che il layer ausiliario è stato creato, puoi modificare le etichette del layer. Clicca su un’etichetta mentre è

attivato lo strumento Change Label strumenti mappa, poi puoi aggiornare le proprietà di stile come dimensioni,
colori e così via. Le corrispondenti proprietà definite dai dati vengono create e possono essere recuperate:
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Figure 13.57: Campi ausiliari
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Come puoi vedere nella figura sopra, i campi 21``vengono automaticamente creati e
configurati per l'etichettatura. Per esempio, il tipo di campo ausiliario
``FontStyle è uno String ed è chiamato labeling_fontstyle nel database SQLite sottostante. C’è
anche la geometria 1 che attualmente utilizza questi campi ausiliari.

Notare che l’icona è visualizzata nella scheda Etichette proprietà che indica che le opzioni di sovrapposizione
dei dati definiti sono impostate correttamente:

Figure 13.58: Proprietà definite dai dati create automaticamente

Altrimenti, c’è un altro modo per creare un campo ausiliario per una specifica proprietà grazie al pulsante
Sovrascrittura definita dai dati. Cliccando su Salva Dati nel Progetto, viene creato automaticamente un campo ausiliario
per il campo Opacità. Se clicchi su questo pulsante mentre il layer ausiliario non è ancora stato creato, allora
viene visualizzata la finestra Finestra di dialogo Layer Ausiliario per selezionare la chiave primaria da utilizzare
per l’unione.

Simbologia

Come il metodo sopra descritto per la personalizzazione delle etichette, i campi ausiliari possono essere usati

anche per stilizzare simboli e diagrammi. Per fare questo, clicca su Sovrascrittura definita dai dati e seleziona Salva
Dati nel Progetto per una proprietà specifica. Per esempio, il campo Colore di riempimento:

Ci sono diversi attributi per ogni simbolo (es. stile di riempimento, colore di riempimento, colore di riempimento,
colore del tratto, ecc. . . .), quindi ogni campo ausiliario che rappresenta un attributo richiede un nome unico per
evitare conflitti. Dopo aver selezionato Salva Dati nel Progetto, si apre una finestra che visualizza Tipo del campo
e richiede di inserire un nome univoco per il campo ausiliario. Ad esempio, quando si crea un campo ausiliario
Colore di riempimento si apre la seguente finestra:

Una volta creato, il campo ausiliario può essere richiamato nella scheda dati ausiliari:
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Figure 13.59: Menu definizione proprietà per i simboli

Figure 13.60: Nome del campo ausiliario di un simbolo
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Figure 13.61: Simbolo campo ausiliario
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Tabella degli attributi e widget

I campi ausiliari possono essere modificati utilizzando la attributo table. Tuttavia, non tutti i campi ausiliari sono
inizialmente visibili nella tabella degli attributi.

I campi ausiliari che rappresentano gli attributi della simbologia, dell’etichettatura, dell’aspetto o dei diagrammi
di un layer appariranno automaticamente nella tabella degli attributi. L’eccezione sono gli attributi che possono
essere modificati usando la Label Toolbar che sono nascosti per impostazione predefinita. I campi ausiliari che
rappresentano un Colore hanno un widget Colore impostato di default, mentre i campi ausiliari sono predefiniti
dal widget Testo Modifica.

I campi ausiliari che rappresentano gli attributi che possono essere modificati utilizzando la barra degli strumenti
Label toolbar per impostazione predefinita sono Nascosti nella tabella degli attributi. Per rendere visibile un
campo, aprire la scheda Attribute Form properties tab e cambiare il valore di un campo ausiliario Tipo Widget
da Nascosto ad un altro valore pertinente. Per esempio, cambiare auxiliary_storage_labeling_size in Modifica
testo o cambiare auxiliary_storage_labeling_color nel widget Colore. Questi campi saranno ora visibili nella
tabella degli attributi.

I campi ausiliari nella tabella degli attributi appariranno come nell” immagine seguente:

Figure 13.62: Modulo con campi ausiliari

Gestione

Il menu Dati Ausiliari permette di gestire i campi ausiliari:

La prima voce Crea in questo caso è disabilitata perché il layer ausiliario è stato già creato. Ma nel caso di
un lavoro nuovo, puoi usare questa azione per creare un layer ausiliario. Come spiegato in Etichettatura, sarà
necessaria una chiave primaria.

L’azione Pulisci permette di mantenere tutti i campi ausiliari, ma di rimuoverne il contenuto. In questo modo, il
numero di funzioni che utilizzano questi campi scenderà a 0.

L’azione Elimina rimuove completamente il layer ausiliario. In altre parole, la tabella corrispondente viene can-
cellata dal database SQLite sottostante e la personalizzazione delle proprietà viene persa.
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Figure 13.63: Gestione layer ausiliario

Infine, l’azione Esporta permette di salvare il livello ausiliario come un new vector layer. Si noti che le geometrie
non sono memorizzate in una memoria ausiliaria. Tuttavia, in questo caso, anche le geometrie vengono esportate
dall’origine dati originale.

Database Dati Ausiliari

Quando salvi il tuo progetto con il formato .qgs, il database SQLite utilizzato per i dati ausiliari viene salvato
nello stesso posto ma con l’estensione .qgd.

Per comodità, un archivio invece può essere utilizzato invece grazie al formato .qgz. In questo caso, i file .qgd
e .qgs sono entrambi incorporati nell’archivio.

13.2.10 Proprietà Azioni

La scheda ti offre la possibilità di creare azioni sulla base degli attributi associati ai singoli elementi del
vettore. Potrai cosi creare un grande numero di azioni, per esempio, avviare un programma con argomenti come
gli attributi di un vettore o inviare parametria una applicazione di rete.

Le azioni sono utili quando vuoi avviare un’applicazione esterna oppure aprire una pagina web sulla base di uno
o più valori associati al vettore. Ci sono sei tipologie di azioni che puoi usare nel seguente modo:

• Le azioni Generic, Mac, Windows e Unix avviano un processo esterno.

• Le azioni python eseguono un’espressione python,

• Le azioni generic e python sono visibili ovunque.
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Figure 13.64: Panoramica della finestra di dialogo Azioni con esempi

• Le azioni Mac, Windows e Unix sono visibili solo sulle rispettive piattaforme (cioè puoi definire le azioni,
ma sarai in grado di vedere i risultati solamente sulla piattaforma dalla quale è stato lanciato l’editor).

Ci sono diversi esempi inclusi nella finestra di dialogo. Puoi caricarli cliccando su Crea Azioni Predefinite. Per
modificare uno qualsiasi degli esempi, fare doppio clic sulla sua riga. Un esempio è l’esecuzione di una ricerca
basata su un valore di un attributo. Questo concetto è usato nella seguente discussione.

Mostra nella tabella degli attributi permette di visualizzare nella finestra di dialogo della tabella degli attributi
le azioni selezionate, sia come Combo Box o come Pulsanti separati (vedi Configurare le colonne).

Definire le azioni

Per definire un’azione di attributo, apri la finestra di dialogo Proprietà e fai click sulla scheda Azioni. Nella scheda

Azioni fai click su Aggiunge una nuova azione per aprire la finestra di dialogo Aggiunge nuova azione.

Seleziona Tipo e fornisci un nome descrittivo per l’azione. L’azione stessa deve contenere il nome
dell’applicazione che verrà eseguita quando viene richiamata l’azione. Puoi aggiungere uno o più valori del
campo attributo come argomenti all’applicazione. Quando viene richiamata l’azione, qualsiasi gruppo di caratteri
che inizia con un % seguito dal nome di un campo verrà sostituito dal valore di quel campo. I caratteri speciali
%% verranno sostituiti dal valore del campo selezionato dalla opzione di identificazione dei risultati o dalle tabella
attributi (vedi using_actions_below). Le virgolette doppie possono essere utilizzate per raggruppare il testo come
un unico argomento al programma, allo script o al comando. Le virgolette doppie saranno ignorate se precedute
dal carattere .

Ambiti Azione permette di definire dove l’azione dovrebbe essere disponibile. Hai 4 diverse scelte:

1. Ambito Elemento: l’azione è disponibile quando si clicca con il tasto destro del mouse nella cella all’interno
della tabella degli attributi.

2. Ambito Campo: l’azione è disponibile quando si clicca con il tasto destro del mouse nella cella all’interno
della tabella degli attributi, nel modulo delle geometrie e nel pulsante di azione predefinito della barra degli
strumenti principale.

3. Ambito Layer: l’azione è disponibile nel pulsante azione nella barra degli strumenti della tabella degli
attributi. Da notare che questo tipo di azione coinvolge l’intero layer e non le singole geometrie.

4. Mappa: l’azione è disponibile nel pulsante azione principale nella barra degli strumenti.
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Se sono presenti nomi di campi che possono essere interpretati come sotto-stringhe di altri nomi di campi (ad
es. col1 e col10) devi racchiudere il nome (e il carattere %) tra parentesi quadre (es. [%col10]). Questo
impedirà che il nome di campo %col10 possa essere confuso con %col1 con uno 0 alla fine. Le virgolette
saranno rimosse da QGIS mano che inserirai i valori del campo. Se vuoi che i campi sostituiti vengano racchiusi
entro parentesi quadre, aggiungi una seconda coppia di parentesi quadre: [[%col10]].

La finestra di dialogo Informazione sui risultati che compare quando usi lo strumento Informazioni elementi ha una
voce (Derivato) che contiene informazioni che dipendono dal tipo di vettore interrogato. Puoi accedere ai valori
di questa voce in modo simile a come accedi ad altri campi della tabella attributi anteponendo al nome del campo
(Derivato). Per esempio un vettore di punti ha due campi, X e Y, e puoi usare il loro valore nell’azione con
l’espressione %(Derivato).X e %(Derivato).Y. Gli attributi derivati sono disponibili solo nella finestra
Informazione sui risultati e non nella finestra Tabella degli attributi.

Due esempi di azioni sono di seguito mostrati:

• konqueror https://www.google.com/search?q=%nam

• konqueror https://www.google.com/search?q=%%

Nel primo esempio, verrà lanciato il browser konqueror che aprirà un URL. L’URL crea una ricerca Google sul
valore del campo nam nel vettore. Il programma o lo script richiamato dall’azione deve essere nel path delle
variabili d’ambiente altrimenti dovrai specificare il percorso completo del programma. Il primo esempio infatti
è accessibile anche con /opt/kde3/bin/konqueror http://www.google.com/search?q=%nam.
In questo modo sei sicuro che l’applicazione konqueror verrà eseguita quando si richiama l’azione..

Nel secondo esempio viene usata la notazione %% che non si basa su un particolare campo per il suo valore.
Quando richiami l’azione, il %% sarà rimpiazzato dal valore del campo selezionato nella finestra Informazioni
risultati o nella tabella degli attributi.

Uso delle azioni

QGIS offre molti modi per eseguire le azioni che hai attivato su un layer. A seconda delle loro impostazioni,
possono essere disponibili:

• nel menu a discesa di Avvia azione sull’element dalla finestra di dialogo Barra degli strumenti relativa agli
attributi o dalla Tabella degli Attributi;

• quando si clicca con il tasto destro del mouse su una geometria con lo strumento Informazioni Elementi (vedi
Informazione Elementi per maggiori informazioni);

• dal pannello Informazioni Risultati, sotto la sezione Azioni;

• come elementi di una colonna Azioni nella finestra di dialogo Tabella degli Attributi.

Se stai richiamando un’azione che usa l’annotazione %%, fai click con il tasto destro sul valore del campo nella
finestra Informazioni risultati oppure dalla finestra Tabella attributi e scegli l’applicazione o lo script da assegnare.

In questo altro esempio viene mostrato come estrarre dati da un vettore per inserirli in un file usando il terminale e

il comando echo (quindi funzionerà su e forse su ). Il vettore in questione ha i seguenti campi nella tabella
attributi: nome della specie taxon_name, latitudine lat e longitudine long. Vuoi eseguire una selezione
spaziale delle specie (taxon) presenti in determinate posizioni, esportando i risultati in un file di testo (evidenziate
in giallo sulla mappa di QGIS ). Ecco l’azione giusta per questo scopo:

bash -c "echo \"%taxon_name %lat %long\" >> /tmp/species_localities.txt"

Selezionando solo alcune posizioni, l’esecuzione dell’azione precedente genera un file di output fatto così:

Acacia mearnsii -34.0800000000 150.0800000000
Acacia mearnsii -34.9000000000 150.1200000000
Acacia mearnsii -35.2200000000 149.9300000000
Acacia mearnsii -32.2700000000 150.4100000000
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Come esercizio puoi creare un’azione che lancia una ricerca su Google in base al vettore lakes. Prima di
tutto devi impostare l’URL necessario per eseguire una ricerca basata su una parola chiave. Questo è facile da
fare andando su Google e facendo una semplice ricerca, poi acquisendo l’URL dalla barra degli indirizzi del tuo
browser. Da questo semplice tentativo, vediamo che il formato è https://www.google.com//search?q=QGIS, dove
QGIS è il termine di ricerca. Sulla base di queste informazioni, possiamo procedere:

1. Assicurarti di aver caricato il vettore lakes.

2. Apri la finestra di dialogo Proprietà layer facendo doppio click sul vettore o cliccandoci sopra con il tasto
destro del mouse e scegliendo Proprietà dal menu contestuale.

3. Clic sulla scheda Azioni.

4. Clic Aggiungi nuova azione.

5. Scegli il tipo di azione Apri,

6. Inserisci un nome descrittivo per l’azione, ad esempio Ricerca Google.

7. Inoltre puoi aggiungere un Descrizione breve o anche un Icona.

8. Scegli l’azione in Ambiti Azione. Vedi Definire le azioni per ulteriori informazioni. Lascia le impostazioni
predefinite per questo esempio.

9. Devi fornire il nome del programma esterno, in questo caso Firefox. Se il programma non è presente nel
tuo path, devi inserire il path assoluto.

10. Dopo il nome dell’applicazione esterna, aggiungi l’URL della ricerca di Google, senza includere il termine
della ricerca:http://google.com/search?q=

11. A questo punto il testo nel campo Azioni dovrebbe apparire così: firefox http://google.com/
search?q=

12. Clicca sul menu a tendina che contiene i nomi dei campi del vettore lakes. E” posizionato immediata-
mente a sinistra del pulsante Inserisci.

13. Dal menu a tendina, seleziona ‘NAMES’ e clicca sul pulsante Inserisci.

14. Il testo dell’azione dovrebbe ora apparire come segue:

https://www.google.com//search?q=[%NAMES%]

15. Per concludere e aggiungere l’azione, clicca sul pulsante OK.

Questo ultimo passo completa l’azione che è ora pronta per essere usata. Il testo finale dell’azione dovrebbe
apparire così:

https://www.google.com//search?q=[%NAMES%]

A questo punto puoi usare l’azione. Chiudi la finestra Proprietà layer e usa lo zoom su un’area a scelta. Assicurati
che il vettore lakes sia attivo ed identifica con l’apposito strumento un lago qualsiasi. Nella finestra risultante
dovrebbe essere visibile l’azione:

Cliccando sull’azione, verrà lanciato Firefox all’URL http://www.google.com/search?q=Tustumena. Puoi anche
aggiungere altri campi all’azione, aggiungendo un + alla fine della stringa che definisce l’azione, selezionando
quindi un altro campo e cliccando sul pulsante Inserisci. Nel nostro esempio non c’è alcun altro campo sul quale
avrebbe senso fare una ricerca.

Puoi definire più di un’azione per ogni vettore, ognuna delle quali verrà mostrata nella finestra di dialogo Infor-
mazioni Risultati.

Puoi anche richiamare le azioni dalla tabella degli attributi selezionando una riga e cliccando col tasto destro,
allora puoi scegliere un’azione dal menu a tendina.

Puoi creare tantissimi tipi di azione. Per esempio se hai un vettore di punti che fa riferimento alle posizioni
dove sono state scattate foto o immagini, insieme al nome stesso del file, puoi creare un’azione per avviare un
programma che visualizzerà l’immagine. Puoi usare le azioni anche per lanciare report sul web per uno o più
campi della tabella degli attributi, definendole allo stesso modo dell’esempio per la ricerca con Google.
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Figure 13.65: Esempio finestra di dialogo di definizione di un azione

Figure 13.66: Seleziona un elemento e scegli un’azione
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Ci sono esempi anche molto più complicati, per esempio usando le azioni Python.

Di solito, quando creiamo un’azione per aprire un file con un’applicazione esterna, possiamo usare percorsi as-
soluti, o eventualmente relativi. Nel secondo caso, il percorso è relativo alla posizione del file eseguibile del
programma esterno. Ma cosa succede se abbiamo bisogno di usare percorsi relativi, relativi al layer selezionato
(uno layer basato su file, come Shapefile o SpatiaLite)? Il codice seguente servirà allo scopo:

command = "firefox"
imagerelpath = "images_test/test_image.jpg"
layer = qgis.utils.iface.activeLayer()
import os.path
layerpath = layer.source() if layer.providerType() == 'ogr'

else (qgis.core.QgsDataSourceURI(layer.source()).database()
if layer.providerType() == 'spatialite' else None)

path = os.path.dirname(str(layerpath))
image = os.path.join(path,imagerelpath)
import subprocess
subprocess.Popen( [command, image ] )

Ricordati che l’azione è del tipo Python, quindi devi cambiare le variabili command e imagerelpath.

E se il percorso relativo deve essere relativo al file di progetto (salvato)? Il codice per l’azione Python diventa:

command = "firefox"
imagerelpath = "images/test_image.jpg"
projectpath = qgis.core.QgsProject.instance().fileName()
import os.path
path = os.path.dirname(str(projectpath)) if projectpath != '' else None
image = os.path.join(path, imagerelpath)
import subprocess
subprocess.Popen( [command, image ] )

Un altro esempio di azione python è quello che ti permette di aggiungere nuovi layer al progetto. In questo esempio
aggiungeremo sia un vettore che un raster. Il nome dei file da aggiungere al progetto e il nome da assegnare ai
layer è specificato dai dati (filename e layname sono nomi di colonne della tabella dagli attributi del vettore dove
l’azione è stata creata):

qgis.utils.iface.addVectorLayer('/yourpath/[% "filename" %].shp',
'[% "layername" %]', 'ogr')

Per aggiungere un raster (in questo caso un’immagine TIF), diventa:

qgis.utils.iface.addRasterLayer('/yourpath/[% "filename" %].tif',
'[% "layername" %]')

13.2.11 Proprietà Suggerimenti

La scheda Suggerimenti ti aiuta a configurare i campi da utilizzare per l’identificazione degli elementi:

• Il Nome visualizzato: basato su un campo o su un espressione. Questo è:

– l’etichetta mostrata sulla parte superiore delle informazioni della geometria nel risultato di in Identify
tool;

– il campo utilizzato nella locator bar quando si cercano geometrie in tutti i layer;

– l’identificatore della geometria nella tabella degli attributi form view;

– geometria del layer attivo con l’icona Mostra suggerimenti mappa. Applicabile quando HTML Map Tip è
impostato a no.
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• HTML Map Tip è stato creato appositamente per i suggerimenti della mappa: si tratta di un testo HTML
più complesso e completo che mescola campi, espressioni e tag html (multilinea, font, immagini, immagini,
collegamenti ipertestuali. . . ..).

Figure 13.67: Codice HTML per suggerimento mappa

Per attivare Suggerimenti mappa, seleziona l’opzione di menu Visualizza → Mostra Suggerimenti mappa o fai

clic sull’icona Mostra Suggerimenti mappa. Suggerimenti mappa è una funzionalità di cross-session che, una volta
attivata, rimane attiva e si applica a qualsiasi layer impostato in qualsiasi progetto, anche nelle future sessioni di
QGIS finché non viene disattivato.

Figure 13.68: Suggerimento mappa realizzato con codice HTML

13.2.12 Proprietà Visualizzazione

Visibilità dipendente dalla scala

Puoi impostare la scala Massimo (incluso) e quella Minimo (escluso), definendo un intervallo di valori di scala

in cui le geometrie saranno visibili. Fuori di questo intervallo sono nascoste. Il pulsante Imposta alla scala corrente

dell’estensione della mappa ti consente di utilizzare la scala corrente della mappa come limite di visibilità.
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Semplifica geometria

QGIS offre il supporto per la generalizzazione delle geometrie on-the-fly. Ciò può migliorare i tempi di visu-
alizzazione quando si disegnano molteplici oggetti complessi a piccole scale. Questa funzionalità può essere

abilitata o disattivata nelle impostazioni del layer utilizzando l’opzione Semplifica geometrie. Esiste anche
un’impostazione globale che consente la generalizzazione per impostazione predefinita per i nuovi layer aggiunti
(per ulteriori informazioni, vedi global simplification)

Figure 13.69: Finestra di dialogo vettore Semplifica geometrie

Nota: La generalizzazione delle geometrie può in alcuni casi presentare artefatti nel tuo output di visualizzazione.
Questi possono includere slivers tra poligoni e visualizzazioni imprecise quando si utilizzano layers di simboli
basati su offset.

Durante la visualizzazione di layers estremamente dettagliati (ad esempio, layers poligonali con un numero
enorme di nodi), ciò può far sì che le esportazioni delle composizioni di stampa in formato PDF/SVG siano
enormi in quanto tutti i nodi sono inclusi nei file esportati. Questo può anche rendere i file risultanti molto lenti
per funzionare con/aprire in altri programmi.

Con l’opzione Forza la visualizzazione del vettore come raster si impone per questi layer una rasterizzazione
in modo che i file esportati non dovranno includere tutti i nodi contenuti in questi layers e quindi rendere più
rapida la visualizzazione.

Puoi anche farlo obbligando il layout ad esportare come raster, ma è una soluzione tutto o niente, dato che la
rasterizzazione viene applicata a tutti i layer.

Aggiorna i layer a intervalli (secondi): imposta un timer per aggiornare automaticamente i singoli layeri ad un
intervallo corrispondente. Gli aggiornamenti delle mappee sono posticipati per evitare di aggiornare più volte se
più di un layer ha impostato un intervallo di aggiornamento automatico.

A seconda del fornitore di dati (ad es. PostgreSQL), le notifiche possono essere inviate a QGIS quando vengono

applicate modifiche all’origine dati, da QGIS. Utilizza Livello di aggiornamento sulla notifica per attivare un
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aggiornamento. Puoi anche limitare l’aggiornamento del layer ad un messaggio specifico impostato nella casella

di controllo Solo se il messaggio è casella di testo .

13.2.13 Scheda Variabili

La scheda Variabili elenca tutte le variabili disponibili a livello di layer (che include tutte le variabili globali
e di progetto).

Consente inoltre all’utente di gestire le variabili a livello di layer. Fai click sul pulsante per aggiungere
una nuova variabile a livello di layer personalizzato. Allo stesso modo, seleziona una variabile a livello di layer

personalizzato dall’elenco e fai click sul pulsante per rimuoverla.

Ulteriori informazioni sull’utilizzo delle variabili nella sezione Memorizzazione valori nelle Variabili.

13.2.14 Scheda Metadati

La scheda Metadata ti propone delle opzioni per creare e modificare un report di metadati sul tuo layer. Le
informazioni da inserire riguardano:

• Identificazione: attributi di base del dataset (genitore, identificatore, titolo, abstract, lingua. . . .);

• Categorie a cui appartengono i dati. Accanto alle categorie ISO, è possibile aggiungere categorie personal-
izzate;

• Parole chiave per recuperare i dati e i concetti associati seguendo un vocabolario standard;

• il Accesso al dataset (licenze, diritti, tariffe e vincoli);

• l” Estensione del dataset, sia spaziale (SR, estensione della mappa, altitudini) che temporale;

• il Contatti del proprietario(i) del dataset;

• i Collegamenti alle risorse ausiliarie e alle relative informazioni;

• lo Storico del dataset.

Una sintesi delle informazioni compilate è fornito nella scheda Validazione e ti aiuta a identificare potenziali
problemi relativi al modulo. Puoi quindi correggerli o ignorarli.

I metadati sono correntemente salvati nel file di progetto. Possono anche essere salvati come file:.XML accanto ai
layer basati su file o in un database locale .sqlite per i layer remoti (ad esempio PostGIS).

13.2.15 Proprietà Dipendenze

La scheda Dipendenze permette di stabilire le dipendenze dei dati tra i layer. Una dipendenza dai dati si
verifica quando una modifica dei dati in un layer, non tramite manipolazione diretta da parte dell’utente, può
modificare i dati di altri layer. Questo è il caso per esempio quando la geometria di un layer è aggiornata da un
trigger di database o da uno scripting PyQGIS personalizzato dopo la modifica della geometria di un altro layer.

Nella scheda Dipendenze, puoi selezionare tutti i layer che possono alterare esternamente i dati del layer corrente.
Specificare correttamente i livelli dipendenti permette a QGIS di invalidare le cache per questo layer quando i
layer dipendenti vengono alterati.

13.2.16 Proprietà Legenda

La scheda proprietà Legenda ti fornisce impostazioni avanzate per il Layers panel e/o la print layout legend.
Queste opzioni includono:
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• Testo sui simboli: In alcuni casi può essere utile aggiungere informazioni aggiuntive ai simboli nella
legenda. Con questa finestra, puoi applicare ai simboli utilizzati nella simbologia dei layer un testo che
viene visualizzato sopra il simbolo, sia nel pannello Layer che nella legenda del layout di stampa. Questa
mappatura viene eseguita digitando ogni testo accanto al simbolo nel widget della tabella o riempiendo la
tabella usando il pulsante Imposta etichette da espressione. L’aspetto del testo viene gestito attraverso i
widget di selezione dei caratteri e dei colori del pulsante Formato Testo.

Figure 13.70: Impostazione testo sui simboli (a sinistra) e sua visualizzazione nel pannello Layer (destra)

• un elenco di widget che puoi incorporare all’interno dell’albero dei layer nel pannello dei layer. L’idea
è quella di avere un modo per accedere rapidamente ad alcune azioni che sono spesso usate con il layer
(configurazione trasparenza, filtraggio, selezione, stile o altre impostazioni. . . .).

Per impostazione predefinita, QGIS fornisce widget di trasparenza, ma questo può essere esteso da plugin
che registrano i propri widget e assegnano azioni personalizzate ai layers che gestiscono.

13.2.17 Proprietà Server QGIS

La scheda QGIS Server ha le sezioni: Descrizione, Attribuzione, URL Metadati e LegendUrl.

Puoi aggiungere o modificare un titolo e un abstract per il layer nella sezione Descrizione. Puoi qui definire anche
una Lista delle parole chiave. Queste liste di parole chiave può essere utilizzata in un catalogo di metadati. Se
vuoi utilizzare un titolo da un file di metadati XML, devi immettere un collegamento nel campo URL Dati.

Utilizza Attribuzione per ottenere i dati di attributo da un catalogo di metadati in formato XML.

In URL Metadati, puoi definire il percorso generale del catalogo metadati XML. Queste informazioni verranno
salvate nel file di progetto QGIS per le sessioni successive e verranno utilizzate per il server QGIS.

Nella sezione LegendUrl puoi fornire l’URL di un’immagine per la legenda nel campo URL. È possibile utilizzare
le opzioni del menu a discesa su Formato per applicare il formato appropriato dell’immagine. Attualmente sono
supportati i formati di immagine png, jpg e jpeg.

13.2.18 Proprietà Digitalizzazione

|digitizing|la scheda Digitalizzazione dà accesso a opzioni che aiutano a garantire la qualità delle geometrie digi-
talizzate.

Correzioni automatiche

Le opzioni nella sezione Correzioni Automatiche influenzano direttamente i vertici di qualsiasi geometria aggiunta

o modificata. Se l’opzione Rimuovi nodi duplicati è selezionata, tutte le coppie di vertici successivi con le
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Figure 13.71: Scheda Server QGIS nella finestra di dialogo delle proprietà dei layer vettoriali

stesse coordinate saranno rimosse. Se è impostata l’opzione Precisione delle geometrie, tutti i vertici saranno
arrotondati al multiplo più vicino alla precisione geometrica configurata. L’arrotondamento avverrà nel sistema di
riferimento delle coordinate del layer. I valori Z e M non vengono arrotondati. Con molti strumenti, una griglia
viene mostrata sulla mappa durante la digitalizzazione.

Controlli geometria

Nella sezione Controlli geometria possono essere attivate ulteriori convalide per geometria. Immediatamente dopo
ogni modifica della geometria, gli errori di questi controlli sono segnalati all’utente nel pannello di convalida della

geometria. Fino a che un controllo fallisce, non è possibile salvare il layer. La casella di controllo Is valid
eseguirà controlli di validità di base come l’intersezione automatica delle geometrie.

Controlli topologici

Nella sezione Controlli topologici possono essere attivati ulteriori controlli di convalida della topologia. I controlli
topologici saranno eseguiti quando l’utente salva il layer. Gli errori a seguito del controllo saranno riportati nel
pannello di validazione della geometria. Finché gli errori di validazione sono presenti, il layer non può essere sal-
vato. I controlli di topologia vengono eseguiti nell’area del rettangolo di delimitazione delle geometrie modificate.
Poiché altre geometrie possono essere presenti nella stessa area, vengono riportati gli errori topologici relativi a
queste geometrie e gli errori introdotti nella sessione di modifica corrente.
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Figure 13.72: Scheda Digitalizzazione QGIS nella finestra di dialogo delle proprietà dei layer vettoriali
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Opzione verifica topologica Illustrazione

La verifica Gap controllerà la presenza di spazi vuoti tra i poligoni adiacenti.

Overlap controllerà le sovrapposizioni tra i poligoni vicini.

Missing Vertex controlla i confini condivisi dei poligoni vicini quando un con-
fine manca di un vertice presente sull’altro.

13.3 Espressioni

Partendo dagli attributi del layer e da funzioni predefinite o definite dall’utente, la finestra Espressioni offre un
modo efficace per manipolare il valore dell’attributo, la geometria e le variabili al fine di modificare dinamicamente
lo stile della geometria, il contenuto o la posizione dell’etichetta, il valore per il diagramma, l’altezza di un
elemento nel compositore di stampe, selezionare alcune caratteristiche, creare un campo virtuale . . .

13.3.1 Il Calcolatore di campi

La finestra di dialogo principale per la creazione di espressioni Calcolatore di campi è disponibile da molte parti
in QGIS e, in particolare, puoi accederci:

• facendo click sul pulsante ;

• selecting features con lo strumento Seleziona con espressione. . . ;

• Modifica attributi per esempio con il Calcolatore di campi ;

• nella manipolazione dei parametri di simbologia, di etichetta o del layout con lo strumento
Sovrascrittura definita dai dati (vedi Impostazione Sovrascrittura definita dai dati);

• nel costruire geometry generator un layer di simboli;

• nell’attivare alcuni geoprocessing.

Le finestre di dialogo del Costruttore di Espressioni offrono l’accesso a:

• Expression tab che, grazie ad un elenco di funzioni predefinite, aiuta a scrivere e controllare l’espressione
da utilizzare;

• Function Editor tab delle funzioni che consente di ampliare l’elenco delle funzioni creando quelle person-
alizzate.
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Alcuni casi d’uso di espressioni:

• Dal Calcolatore Campo, calcolare un campo «pop_density» utilizzando i campi esistenti «total_pop» e
«area_km2»:

"total_pop" / "area_km2"

• Aggiornare il campo «density_level» con le categorie in base ai valori «pop_density»:

CASE WHEN "pop_density" < 50 THEN 'Low population density'
WHEN "pop_density" >= 50 and "pop_density" < 150 THEN 'Medium population

→˓density'
WHEN "pop_density" >= 150 THEN 'High population density'

END

• Applicare uno stile categorizzato a tutte le geometrie in base al fatto che il prezzo medio della casa sia più
piccolo o superiore a 10000C per metro quadrato:

"price_m2" > 10000

• Utilizzando lo strumento «Seleziona per espressione . . . », selezionare tutte le geometrie che rappresentano
aree di «Alta densità di popolazione» e il cui prezzo medio di casa è superiore a 10000C per metro quadrato:

"density_level" = 'High population density' and "price_m2" > 10000

Allo stesso modo, l’espressione precedente potrebbe anche essere utilizzata per definire quali geometrie
dovrebbero essere etichettate o mostrate nella mappa.

L’uso delle espressioni offre molte possibilità.

Suggerimento: Utilizzare parametri espliciti per migliorare la lettura dell’espressione

Alcune funzioni richiedono che siano impostati molti parametri. Il motore di espressione supporta l’utilizzo di
parametri espliciti. Ciò significa che, invece di scrivere l’espressione criptica clamp( 1, 2, 9), puoi us-
are clamp( min:=1, value:=2, max:=9). Ciò consente inoltre l’inserimento di argomenti, ad esempio
clamp( value:=2, max:=9, min:=1). L’utilizzo di parametri espliciti aiuta a chiarire quali sono gli
argomenti di una funzione espressione, utile quando si tenta di interpretare un’espressione in una data successiva!

13.3.2 Lista delle funzioni

La scheda Espressione fornisce l’interfaccia principale per scrivere le espressioni utilizzando funzioni, campi del
layer e valori. Contiene widget per:

• Un’area per comporre espressioni per digitare o copiare espressioni. L’autocompletamento è disponibile
per velocizzare la scrittura delle espressioni:

– Le variabili, i nomi delle funzioni e dei campi corrispondenti al testo di input sono mostrati di seguito:
usare le frecce Up e Down per sfogliare gli elementi e premere Tab per inserireli nell’espressione o
semplicemente cliccare sull’elemento desiderato.

– I parametri delle funzione vengono visualizzati durante la digitazione.

QGIS controlla anche la correttezza dell’espressione ed evidenzia tutti gli errori utilizzando:

– Sottolineatura: per funzioni sconosciute, argomenti errati o non corretti;

– Simbolo: per ogni altro errore (es. parentesi mancante, carattere imprevisto) in una singola posizione.

Suggerimento: Documentare le tue espressioni con i commenti

Quando si usa un’espressione complessa, è buona pratica aggiungere testo sia come commento multilinea
che come commento in linea per aiutarti a ricordare.
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/*
Labels each region with its highest (in altitude) airport(s)
and altitude, eg 'AMBLER : 264m' for the 'Northwest Artic' region

*/
with_variable(
'airport_alti', -- stores the highest altitude of the region
aggregate(

'airports',
'max',
"ELEV", -- the field containing the altitude
-- and limit the airports to the region they are within
filter := within( $geometry, geometry( @parent ) )

),
aggregate( -- finds airports at the same altitude in the region

'airports',
'concatenate',
"NAME",
filter := within( $geometry, geometry( @parent ) )
and "ELEV" = @airport_alti

)
|| ' : ' || @airport_alti || 'm'
-- using || allows regions without airports to be skipped

)

• Sotto l’editor di espressioni, un Output preview mostra il risultato dell’espressione valutata sulla prima
geometria del layer. In caso di errore, lo indica ed è possibile accedere ai dettagli con il collegamento
ipertestuale fornito.

• Un selettore di funzioni visualizza l’elenco di funzioni, variabili, campi. . . . organizzati in gruppi. Una
casella di ricerca è disponibile per filtrare l’elenco e trovare rapidamente una particolare funzione o campo.
Facendo doppio clic su un elemento lo aggiunge all’editor di espressioni.

• Un pannello di aiuto visualizza la guida per ogni voce selezionata nel selettore di funzione.

Suggerimento: Premi Ctrl+Click quando passi con il mouse sul nome di una funzione in
un’espressione per visualizzare automaticamente il suo aiuto nella finestra di dialogo.

• Il widget dei valori di un campo mostrato quando un campo è selezionato nel selettore di funzioni aiuta a
trovare gli attributi delle caratteristiche. Facendo doppio clic su un valore lo aggiunge all’editor di espres-
sioni.

Suggerimento: Il pannello di destra, che mostra le funzioni di aiuto o i valori del campo, può essere chiuso
(invisibile) nella finestra di dialogo. Premi il pulsante Mostra valori o Mostra aiuto per recuperarlo.

Funzioni di aggregazione

Questo gruppo contiene funzioni che aggregano valori su layer e campi
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Figure 13.73: La scheda Espressioni

Funzioni Descrizione
aggregate Restituisce un valore aggregato calcolato utilizzando le geometrie di un altro layer
array_agg Restituisce un array di valori aggregati da un campo o espressione.
collect Restituisce la geometria a parti multiple di geometrie aggregate da una espressione
concatenate Restituisce tutte le stringhe aggregate da un campo o un’espressione unita da un delimitatore
count Restituisce il conteggio delle geometrie corrispondenti
count_distinct Restituisce il conteggio di valori distinti
count_missing Restituisce il conteggio di valori mancanti (nulli)
iqr Restituisce l’intervallo inter quartile calcolato da un campo o un’espressione
majority Restituisce la maggioranza aggregata di valori (il valore più comunemente presente) da un

campo o da un’espressione
max_length Restituisce la lunghezza massima delle stringhe da un campo o da un’espressione
maximum Restituisce il valore massimo aggregato da un campo o da un’espressione
mean Restituisce il valore medio aggregato da un campo o da un’espressione
median Restituisce il valore della mediana aggregato da un campo o da un’espressione
min_length Restituisce la lunghezza minima delle stringhe da un campo o da un’espressione
minimum Restituisce il valore minimo aggregato da un campo o da un’espressione
minority Restituisce la minoranza dei valori aggregata (valore che si verifica meno comunemente) da

un campo o da un’espressione
q1 Restituisce il primo quartile calcolato da un campo o da un’espressione
q3 Restituisce il terzo quartile calcolato da un campo o da un’espressione
range Restituisce l’intervallo di valori aggregato (massimo - minimo) da un campo o un’espressione
rela-
tion_aggregate

Restituisce un valore aggregato calcolato utilizzando tutte le geometrie figlie corrispondenti
da una relazione sul layer

stdev Restituisce il valore della deviazione standard aggregato da un campo o da un’espressione
sum Restituisce il valore sommato aggregato da un campo o da un’espressione

Esempi:

• Restituisce il massimo del campo «Passeggeri» dalle geometrie nel layer raggruppato dal campo «sta-
tion_class» :
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maximum("passengers", group_by:="station_class")

• Calcola il numero totale di passeggeri per le stazioni all’interno della geometria Atlante corrente:

aggregate('rail_stations','sum',"passengers",
intersects(@atlas_geometry, $geometry))

• Restituisce la media del campo «field_from_related_table» per tutte le geometrie figlio corrispondenti us-
ando la relazione “my_relation” dal layer:

relation_aggregate('my_relation', 'mean', "field_from_related_table")

oppure:

relation_aggregate(relation:='my_relation', aggregate := 'mean',
expression := "field_from_related_table")

Funzioni Array

Questo gruppo contiene funzioni per la creazione e la manipolazione di array (noti anche come strutture dati ad
elenco). L’ordine dei valori all’interno dell’array è importante, al contrario della “map” data structure, in cui
l’ordine delle coppie chiave-valore è irrilevante e i valori vengono identificati dalle loro chiavi.
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Funzioni Descrizione
array Restituisce un array contenente tutti i valori passati come parametro.
ar-
ray_append

Restituisce un array con il valore passato aggiunto alla fine.

array_cat Restituisce un array contenente tutti gli array passati concatenati.
ar-
ray_contains

Restituisce vero se un array contiene il valore specificato.

ar-
ray_distinct

Restituisce un array contenente valori distinti dell’array dato.

ar-
ray_filter

Restituisce un array con solo gli elementi per i quali una espressione valuta come vero

array_find Restituisce l’indice (0 per il primo elemento) di un valore all’interno di un array. Restiuisce -1
se il valore non viene trovato

array_first Restituisce il primo valore di un array
ar-
ray_foreach

Restituisce un array con l’espressione data valutata per ogni elemento

array_get Restituisce il valore ennesimo (0 per il primo elemento) di un array.
ar-
ray_insert

Restituisce un array con il valore dato aggiunto nella posizione indicata.

ar-
ray_intersect

Restituisce vero se almeno un elemento dell’array1 esiste in array2.

array_last Restituisce l’ultimo elemento di un array
ar-
ray_length

Restituisce il numero di elementi di un array

ar-
ray_prepend

Restituisce un array con il valore dato aggiunto all’inizio

ar-
ray_remove_all

Restituisce un array con tutti gli elementi del valore passato rimossi.

ar-
ray_remove_at

Restituisce un array con l’indice dato rimosso

ar-
ray_reverse

Restituisce l’array dato con valori dell’array in ordine inverso

ar-
ray_slice

Restituisce i valori dell’array dal parametro start_pos fino a includere il parametro end_pos

ar-
ray_to_string

Concatena gli elementi di un array in una stringa separata da un delimitatore usando una stringa
opzionale per valori mancanti

gener-
ate_series

Crea un array contenente una sequenza di numeri

reg-
exp_matches

Restituisce un array di tutte le stringhe catturate dai gruppi, nell’ordine con cui i gruppi stessi
compaiono con l’espressione regolare fornita con una stringa

string_to_arrayDivide la stringa in un array usando il delimitatore fornito e la stringa opzionale per valori man-
canti

Funzioni colore

Questo gruppo contiene funzioni per la manipolazione dei colori.
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Funzioni Descrizione
color_cmyk Restituisce una rappresentazione in formato stringa di un colore in base alle componenti

ciano, magenta, giallo e nero
color_cmyka Restituisce una rappresentazione in formato stringa di un colore in base ai componenti

ciano, magenta, giallo, nero e alfa (trasparenza)
color_grayscale_averageApplica un filtro in scala di grigi e restituisce una rappresentazione di stringa da un dato

colore
color_hsl Restituisce una rappresentazione in formato stringa di un colore in base agli attributi di

tonalità, saturazione e luminosità
color_hsla Restituisce una rappresentazione in formato stringa di un colore in base agli attributi di

tonalità, saturazione, luminosità e alfa (trasparenza)
color_hsv Restituisce una rappresentazione in formato stringa di un colore in base agli attributi di

tonalità, saturazione e valore
color_hsva Restituisce una rappresentazione in formato stringa di un colore in base agli attributi di

tonalità, saturazione, valore e alfa (trasparenza)
color_mix_rgb Restituisce una stringa che rappresenta un colore che mescola i valori di rosso, verde, blu e

alfa di due dati colori in base ad un dato rapporto
color_part Restituisce un componente specifico da una stringa di colori, ad esempio il componente

rosso o il componente alfa
color_rgb Restituisce una rappresentazione in formato stringa di un colore in base alle componenti

rosso, verde e blu
color_rgba Restituisce una rappresentazione in formato stringa di un colore in base alle componenti

rosso, verde, blu e alfa (trasparenza)
create_ramp Restituisce una scala di colori a gradiente per una mappa di colori e gradini
darker Restituisce una stringa di colore più scuro (o più chiaro)
lighter Restituisce una stringa di colore più chiara (o più scura)
project_color Restituisce un colore dalla combinazione dei colori del progetto
ramp_color Restituisce una stringa che rappresenta un colore da una scala di colori
set_color_part Imposta un componente di colore specifico per una stringa di colore, ad esempio il compo-

nente rosso o il componente alfa

Funzioni Condizionali

Questo gruppo contiene funzioni per eseguire controlli condizionali nelle espressioni.

Funzioni Descrizione
CASE WHEN . . . THEN . . .
END

Valuta un’espressione e restituisce un risultato se è vera. Puoi testare più
condizioni

CASE WHEN . . . THEN . . .
ELSE . . . END

Valuta un’espressione e restituisce un risultato diverso secondo se è vera o
falsa. Puoi testare più condizioni

coalesce Restituisce il primo valore non NULL dall’elenco in espressione
if Verifica una condizione e restituisce un risultato diverso a seconda della

verifica della condizione

Alcuni esempi

• Restituisce un valore se la prima condizione è vera, altrimenti un altro valore

CASE WHEN "software" LIKE '%QGIS%' THEN 'QGIS' ELSE 'Other' END
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Funzioni di conversione

Questo gruppo contiene funzioni per convertire un tipo di dati in un altro (ad esempio stringa su intero, intero su
stringa).

Funzioni Descrizione
to_date Converte una stringa in formato data
to_datetime Converte una stringa in formato datetime
to_dm Converte una coordinata in gradi, minuti.
to_dms Converte una coordinata in gradi, minuti, secondi.
to_int Converte una stringa in numero intero
to_interval Converte una stringa in un tipo di intervallo (può essere utilizzata per ricavare giorni, ore, mesi,

ecc. da una data)
to_real Converte una stringa in un numero reale
to_string Converte numero in stringa
to_time Converte una stringa in un formato orario

Funzioni personalizzate

Questo gruppo contiene funzioni create dall’utente. Vedi Editor delle Funzioni per maggiori dettagli.

Funzioni di data e ora

Questo gruppo contiene funzioni per la gestione dei dati in formato data e ora.

Funzioni Descrizione
age Restituisce come intervallo la differenza tra due date o datetime
day Estrae il giorno da una data o un datetime o il numero di giorni da un intervallo
day_of_week Restituisce un numero corrispondente al giorno della settimana per una data o un datetime

specificato
epoch Restituisce l’intervallo in millisecondi fra l’epoca unix e la data inserita.
hour Estrae l’ora da un datetime o tempo, o il numero di ore da un intervallo
minute Estrae il minuto da un datetime o tempo, o il numero di minuti da un intervallo
month Estrae la parte del mese da una data o datetime o il numero di mesi da un intervallo
now Restituisce la data e l’ora correnti
second Estrae il secondo da un datetime o time, o il numero di secondi da un intervallo
week Estrae il numero della settimana da una data o datetime, o il numero di settimane da un inter-

vallo
year Estrae la parte dell’anno da una data o datetime o il numero di anni da un intervallo

Questo gruppo condivide anche diverse funzioni con i gruppi Funzioni di conversione (to_date, to_time,
to_datetime, to_interval) e Funzioni Stringa (format_date).

Alcuni esempi:

• Ricava il mese e l’anno di oggi nel formato «numero_mese/anno»:

format_date(now(),'MM/yyyy')
-- Returns '03/2017'

Oltre a queste funzioni, le differenze di data, i tempi o le ore che usano l’operatore ‘‘ -‘‘ (meno) restituiscono un
intervallo.
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Aggiungendo o sottraendo un intervallo a date, datetime o tempi, usando gli operatori + (più) e - (meno), restitu-
isce un datetime.

• Fino alla versione di QGIS 3.0 dà il numero di giorni:

to_date('2017-09-29') - to_date(now())
-- Returns <interval: 203 days>

• Lo stesso con time:

to_datetime('2017-09-29 12:00:00') - to_datetime(now())
-- Returns <interval: 202.49 days>

• Ottieni il tempo di 100 giorni a partire da adesso:

now() + to_interval('100 days')
-- Returns <datetime: 2017-06-18 01:00:00>

Nota: Memorizzazione di formati data e di intervalli di tempo su campi

La capacità di memorizzare le date nei formati date, datatime e time sui campi può dipendere dalla fonte dei dati
(ad esempio, gli shapefile accettano il formato date, ma non il formato datetime o time). Di seguito ci sono alcuni
suggerimenti per superare questa limitazione:

• date, datetime e time possono essere memorizzati nei campi di tipo di testo dopo aver utilizzato la funzione
to_format().

• intervals possono essere memorizzati in campi di numeri interi o decimali dopo aver utilizzato una delle
funzioni di estrazione della data (ad esempio, day() per ottenere l’intervallo espresso in giorni)

Campi e Valori

Contiene la lista dei campi di un layer.

Fai doppio clic sul nome di un campo per aggiungerlo all’espressione. Puoi anche digitare il nome del campo
(preferibilmente all’interno di virgolette doppie) o il suo alias.

Per recuperare i valori dei campi da utilizzare in un’espressione, seleziona il campo appropriato e, nel widget
mostrato, scegli tra 10 Samples e All Unique. I valori richiesti vengono quindi visualizzati e puoi utilizzare la
casella Search nella parte superiore dell’elenco per filtrare il risultato. I valori dei campioni sono accessibili anche
facendo clic con il tasto destro del mouse su un campo.

Per aggiungere un valore all’espressione che stai scrivendo, fai doppio clic su di essa nell’elenco. Se il valore è di
tipo stringa, dovrebbe essere tra virgolette semplici, altrimenti non è necessaria alcuna virgoletta.

Funzioni varie di confronto

Questo gruppo contiene funzioni per confronti vari tra valori.

Funzioni Descrizione
ham-
ming_distance

Restituisce il numero di caratteri nelle posizioni corrispondenti all’interno delle stringhe in
input in cui i caratteri sono diversi

levensheim Restituisce il numero minimo di caratteri (inserzioni, cancellazioni o sostituzioni) richiesti
per cambiare una stringa in un’altra. Misura la somiglianza tra due stringhe

longest_common_substringRestituisce la sottostringa comune più lunga tra due stringhe
soundex Restituisce la rappresentazione Soundex di una stringa
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Funzioni Generali

Questo gruppo contiene funzioni assortite generali.

Fun-
zioni

Descrizione

env Acquisisce una variabile d’ambiente e restituisce il suo contenuto in formato stringa. Se la variabile
non viene trovata, verrà restituito NULL.

eval Valuta un’espressione che viene passata in una stringa. Utile per espandere i parametri dinamici
passati come variabili di contesto o campi

is_layer_visibleRestituisce vero se uno specifico layer è visibile.
layer_propertyRestituisce una proprietà di un layer o un valore dei suoi metadati. Può essere nome del layer, SR,

tipo di geometria, conteggio delle geometrie . . .
var Restituisce il valore memorizzato all’interno di una variabile specificata. Vedi funzioni variabili di

seguito
with_variableCrea e imposta una variabile per qualsiasi codice di espressione che sarà fornito come terzo

parametro. Utile per evitare la ripetizione in espressioni in cui lo stesso valore deve essere usato
più di una volta.

Funzioni Geometria

Questo gruppo contiene funzioni che operano su caratteristiche geometriche (ad es. Lunghezza, area).

Funzioni Descrizione
$area Restituisce le dimensioni dell’area della geometria corrente
$geometry Restituisce la geometria dell’elemento corrente (può essere utilizzato per l’elaborazione con altre funzioni)
$length Restituisce la lunghezza della geometria lineare corrente
$perimeter Restituisce il perimetro della geometria poligono corrente
$x Restituisce la coordinata X della geometria corrente
$x_at(n) Restituisce la coordinata X dell’ennesimo nodo della geometria corrente
$y Restituisce la coordinata Y della geometria corrente
$y_at(n) Restituisce la coordinata Y dell’ennesimo nodo della geometria corrente
angle_at_vertex Restituisce l’angolo bisettrice (angolo medio) alla geometria per un vertice specificato su una geometria lineare. Gli angoli sono in gradi in senso orario da nord
area Restituisce l’area di una geometria poligono. I calcoli sono nel Sistema di riferimento spaziale di questa geometria
azimuth Restituisce l’azimut a nord come angolo in radianti misurato in senso orario dalla verticale su point_a a point_b
boundary Restituisce la chiusura del confine al bordo della geometria (cioè il confine topologico della geometria - vedi anche qgisboundary).
bounds Restituisce una geometria che rappresenta il rettangolo di delimitazione di una geometria di input. I calcoli si trovano nel sistema di riferimento spaziale di questa geometria (vedi anche qgisboundingboxes).
bounds_height Restituisce l’altezza del riquadro di delimitazione di una geometria. I calcoli sono nel Sistema di riferimento spaziale di questa geometria
bounds_width Restituisce la larghezza del riquadro di delimitazione di una geometria. I calcoli sono nel Sistema di riferimento spaziale di questa geometria
buffer Restituisce una geometria che rappresenta tutti i punti la cui distanza da questa geometria è inferiore o uguale alla misura data. I calcoli si trovano nel sistema di riferimento spaziale di questa geometria (vedi anche qgisbuffer).
buffer_by_m Crea un buffer lungo una geometria lineare dove il diametro del buffer varia secondo i valori M ai vertici della linea (vedi anche qgisbufferbym)
centroid Restituisce il centro geometrico di una geometria (vedi anche qgiscentroids)
closest_point Restituisce il punto su una geometria che è più vicino a una seconda geometria
combine Restituisce la combinazione di due geometrie
contains(a,b) Restituisce 1 (vero) se e solo se nessun punto di b giace nell’esterno di a, e almeno un punto dell’interno di b si trova all’interno di a
convex_hull Restituisce il poligono convesso di una geometria (rappresenta la geometria minima convessa che racchiude tutte le geometrie all’interno dell’insieme) (vedi anche qgisconvexhull)
crosses Restituisce 1 (vero) se le geometrie fornite hanno in comune alcuni punti interni, ma non tutti
difference(a,b) Restituisce una geometria che rappresenta quella parte di geometria a che non si interseca con la geometria b (vedi anche qgisdifferenza)
disjoint Restituisce 1 (vero) se le geometrie non condividono nessuno spazio
distance Restituisce la distanza minima (in base al Sistema di riferimento spaziale) tra due geometrie in unità proiettate
distance_to_vertex Restituisce la distanza lungo la geometria a un vertice specificato
end_point Restituisce l’ultimo nodo da una geometria (vedi anche qgisextractspecificvertices)
extend Estende l’inizio e la fine di un geometria lineare di una quantità specificata (vedi anche qgisextendlines)
exterior_ring Restituisce una stringa lineare che rappresenta l’anello esterno di una geometria poligonale o null se la geometria non è un poligono

Continued on next page
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Table 13.1 – continued from previous page
Funzioni Descrizione
extrude(geom,x,y) Restituisce una versione estrusa della geometria (Multi-) Curve o (Multi-) Linestring in ingresso con un’estensione specificata da X e da Y
flip_coordinates Restituisce una copia della geometria con le coordinate X e Y scambiate (vedi anche qgisswapxy)
geom_from_gml Restituisce una geometria creata da una rappresentazione GML della geometria
geom_from_wkt Restituisce una geometria creata da una rappresentazione Well-Known Text (WKT)
geom_to_wkt Restituisce la rappresentazione Well-Known Text (WKT) della geometria senza i metadati del SRID
geometry Restituisce la geometria di un elemento
geometry_n Restituisce l’ennesima geometria da una raccolta di geometrie, o null se la geometria in input non è una raccolta
hausdorff_distance Restituisce fondamentalmente una misura di quanto sono simili o dissimili 2 geometrie, con una distanza inferiore che indica geometrie più simili.
inclination Restituisce l’inclinazione misurata dallo zenit (0) al nadir (180) del punto_a al punto_b.
interior_ring_n Restituisce la geometria dell’ennesimo anello interno da una geometria poligonale, oppure null se la geometria non è un poligono
intersection Restituisce una geometria che rappresenta la porzione condivisa di due geometrie (vedi anche qgisintersection)
intersects Verifica se una geometria interseca un’altra. Restituisce 1 (vero) se le geometrie si intersecano spazialmente (condividono qualsiasi porzione di spazio) e 0 se non lo fanno
intersects_bbox Verifica se il riquadro di delimitazione di una geometria si sovrappone al riquadro di delimitazione di un’altra geometria. Restituisce 1 (vero) se le geometrie intersecano spazialmente (condividono qualsiasi porzione di spazio) nelle loro casella di delimitazione, o 0 se non lo fanno
is_closed Restituisce vero se una linea è chiusa (i punti di inizio e di fine sono coincidenti), falso se una linea non è chiusa o null se la geometria non è una linea
length Restituisce la lunghezza di una geometria lineare (o la lunghezza di una geometria di tipo linestring)
line_interpolate_angle Restituisce l’angolo parallelo alla geometria ad una distanza specificata lungo una geometria di tipo linestring. Gli angoli sono in gradi in senso orario da nord.
line_interpolate_point Restituisce il punto interpolato da una distanza specificata lungo una geometria lineare. (vedi anche qgisinterpolatepoint)
line_locate_point Restituisce la distanza lungo una linestring corrispondente alla posizione più vicina alla linestring di una geometria puntuale specificata
line_substring Restituisce la porzione di geometria di una geometria lineare o curva che ricade tra le distanze iniziali e finali specificate (misurate dall’inizio della linea) (vedi anche: ref:qgislinesubstring)
line_merge Restituisce una geometria (Multi-)LineString, in cui tutte le LineString connesse dalla geometria in input sono state unite in una singola linestring.
m Restituisce il valore M di una geometria puntuale
make_circle Crea una geometria circolare basata su punto centrale e raggio
make_ellipse Crea una geometria ellittica basata su punto centrale, assi e azimut
make_line Crea una geometria lineare da una serie di geometrie punto
make_point(x,y,z,m) Restituisce una geometria puntuale dai valori X e Y (e opzionalmente Z o M)
make_point_m(x,y,m) Restituisce una geometria puntuale dai valori delle coordinate X e Y e M
make_polygon Crea una geometria poligono da un anello esterno e una serie opzionale di geometrie ad anello interne
make_regular_polygon Crea un poligono regolare
make_triangle Crea un poligono triangolare
minimal_circle Restituisce il cerchio minimo circoscritto ad una geometria in ingresso (vedi anche qgisminimumenclosingcircle)
nodes_to_points Restituisce una geometria multipunto costituita da ogni nodo della geometria in ingresso (vedere anche qgisextractractractvertices)
num_geometries Restituisce il numero di geometrie in una raccolta di geometrie, o null se la geometria in ingresso non è una raccolta
num_interior_rings Restituisce il numero di anelli interni in un poligono o in una raccolta di geometrie, oppure null se la geometria in input non è un poligono o una raccolta
num_points Restituisce il numero di vertici in una geometria
num_rings Restituisce il numero di anelli (inclusi gli anelli esterni) in un poligono o in una raccolta di geometrie, oppure null se la geometria in input non è un poligono o una raccolta
offset_curve Restituisce una geometria formata dallo spostamento laterale della geometria lineare. Le distanze sono nel sistema di riferimento spaziale di questa geometria. (vedi anche qgisoffsetline)
order_parts Ordina le parti di una MultiGeometry secondo un determinato criterio
oriented_bbox Restituisce una geometria che rappresenta il rettangolo di contorno minimo orientato di una geometria di input (vedi anche qgisorientedminimumboundingbox)
overlaps Verifica se una geometria si sovrappone a un’altra. Restituisce 1 (vero) se le geometrie condividono lo spazio, sono della stessa dimensione, ma non sono completamente contenute l’una all’altra
perimeter Restituisce il perimetro di una geometria poligonale. I calcoli sono nel Sistema di riferimento spaziale di questa geometria
point_n Restituisce un nodo specifico da una geometria (vedi anche qgisextractspecificvertices)
point_on_surface Restituisce un punto che si trova sulla superficie di una geometria (vedi anche: ref:qgispointonsurface)
pole_of_inaccessibility Calcola il punto approssimativo di inaccessibilità di una superficie, che è il punto interno più distante dal confine della superficie (vedi anche qgispoleofinaccessibility)
project Restituisce un punto proiettato da un punto di partenza utilizzando una distanza e rilevamento (azimut) in radianti (vedi anche qgisprojectpointcartesian)
relate Testa o restituisce la rappresentazione Dimensional Extended 9 Intersection Model (DE-9IM) della relazione tra due geometrie.
inverti Inverte la direzione di una geometria lineare invertendo l’ordine dei suoi vertici (vedi anche qgisreverselinedirection)
segments_to_lines Restituisce una geometria multilinea composta da una linea per ogni segmento della geometria in input (vedi anche qgisexplodelines)
shortest_line Restituisce la linea più breve che unisce due geometrie. La linea risultante inizierà dalla geometria 1 e terminerà alla geometria 2
simplify Semplifica una geometria eliminando nodi utilizzando una soglia basata sulla distanza (vedi anche qgissimplifygeometries)
simplify_vw Semplifica una geometria eliminando nodi utilizzando una soglia basata sull’area (vedi anche qgissimplifygeometries)
single_sided_buffer Restituisce una geometria formata dal buffering di un solo lato di una geometria lineare. Le distanze sono nel sistema di riferimento spaziale di questa geometria (vedi anche qgissinglesidedbuffer)
smooth Smussa una geometria aggiungendo altri nodi che arrotondano gli angoli della geometria (vedi anche qgissmoothgeometry)
start_point Restituisce il primo nodo da una geometria (vedi anche qgisextractspecificvertices)

Continued on next page
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Table 13.1 – continued from previous page
Funzioni Descrizione
sym_difference Restituisce una geometria che rappresenta le porzioni di due geometrie che non si intersecano (vedi anche qgissymmetricaldifference)
tapered_buffer Crea un buffer lungo una geometria lineare dove il diametro del buffer varia uniformemente sulla lunghezza della linea (vedi anche qgistaperedbuffer)
touches Verifica se una geometria tocca un’altra. Restituisce 1 (vero) se le geometrie hanno almeno un punto in comune, ma i loro interni non si intersecano
transform Restituisce la geometria trasformata dal SR sorgente al SR di destinazione (vedi anche qgisreprojectlayer)
translate Restituisce una versione traslata di una geometria. I calcoli sono nel sistema di riferimento spaziale della geometria (vedi anche qgistranslategeometry)
union Restituisce una geometria che rappresenta l’unione dell’insieme dei punti delle geometrie
wedge_buffer Restituisce un buffer a forma di cuneo che ha origine da una geometria puntuale con un angolo e con dei raggi (vedere anche qgiswedgebuffers)
within (a,b) Verifica se una geometria si trova all’interno di un’altra. Restituisce 1 (vero) se la geometria a è completamente all’interno della geometria b
x Restituisce la coordinata X di una geometria puntuale o la coordinata X del centroide per una geometria non puntuale
x_min Restituisce la coordinata X minima di una geometria. I calcoli sono nel Sistema di riferimento spaziale di questa geometria
x_max Restituisce la coordinata X massima di una geometria. I calcoli sono nel Sistema di riferimento spaziale di questa geometria
y Restituisce la coordinata Y di una geometria puntuale o la coordinata Y del centroide per una geometria non puntuale
y_min Restituisce la coordinata Y minima di una geometria. I calcoli sono nel Sistema di riferimento spaziale di questa geometria
y_max Restituisce la coordinata Y massima di una geometria. I calcoli sono nel Sistema di riferimento spaziale di questa geometria
z Restituisce la coordinata Z di una geometria puntuale

Alcuni esempi:

• Puoi manipolare la geometria corrente con la variabile $geometry per creare un buffer o ottenere il punto
sulla superficie:

buffer( $geometry, 10 )
point_on_surface( $geometry )

• Restituire la coordinata X del centroide della geometria corrente

x( $geometry )

• Generare un valore in base all’area della geometria:

CASE WHEN $area > 10 000 THEN 'Larger' ELSE 'Smaller' END

Funzioni per il Layout

Questo gruppo contiene funzioni per manipolare le proprietà degli oggetti del layout di stampa.

Funzioni Descrizione
item_variables Restituisce una mappa delle variabili da un oggetto del layout dentro il layout.

Alcuni esempi

• Seleziona la scala della “Mappa 0” nel layout di stampa corrente:

map_get( item_variables('Map 0'), 'map_scale')
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Layer della Mappa

Questo gruppo contiene un elenco dei layer disponibili nel progetto corrente. Questo offre un modo conveniente
per scrivere espressioni che si riferiscono a layer multipli, come quando si eseguono query aggrega, attributo o
spaziale.

Funzioni mappa

Questo gruppo contiene funzioni per creare o manipolare chiavi e valori di strutture di dati cartografici (noti anche
come oggetti dizionario, coppie chiave-valore o array associativi). A differenza di :ref:‘list data structure ‘ dove
l’ordine dei valori è importante, l’ordine delle coppie chiave-valore nell’oggetto mappa non è rilevante e i valori
sono identificati dalle loro chiavi.

Funzioni Descrizione
hstore_to_mapCrea una mappa da una stringa in formato hstore
json_to_mapCrea una mappa da una stringa in formato json
map Restituisce una mappa con tutte le chiavi ed i valori passati come coppie di parametri
map_akeys Restituisce tutte le chiavi di una mappa come un array
map_avals Restituisce tutti valori di una mappa come un array
map_concat Restituisce una mappa con tutte le entità delle mappe fornite. Se due mappe contengono la stessa

chiave, viene restituito il valore della seconda mappa.
map_delete Restituisce una mappa con il valore della corrispondente chiave e valore rimossi
map_exist Restituisce vero se la chiave data esiste nella mappa
map_get Restituisce il valore di una mappa, passando la sua chiave
map_insert Restituisce una mappa con una chiave/valore aggiunto
map_to_hstoreCombina gli elementi della mappa in una stringa in formato hstore
map_to_jsonCombina gli elementi della mappa in una stringa in formato json

Funzioni Matematiche

Questo gruppo contiene funzioni matematiche (ad es. Radice quadrata, seno e coseno).
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Funzioni Descrizione
abs Restituisce il valore assoluto di un numero
acos Restituisce l’arcocoseno di un valore in radianti
asin Restituisce l’arcoseno di un valore in radianti
atan Restituisce l’arcotangente di un valore in radianti
atan2(y,x) Restituisce l’arcotangente di Y/X utilizzando i segni dei due argomenti per determinare il quad-

rante del risultato
az-
imuth(a,b)

Restituisce l’azimut a nord come angolo in radianti misurato in senso orario dalla verticale sul
punto a al punto b

ceil Arrotonda un numero verso l’alto
clamp Limita un valore in ingresso a un intervallo specificato
cos Restituisce il coseno di un angolo in radianti
degrees Converte da radianti a gradi
exp Restituisce un valore esponenziale
floor Arrotonda un numero verso il basso
inclina-
tion

Restituisce l’inclinazione misurata dallo zenit (0) al nadir (180) del punto_a al punto_b.

ln Restituisce il logaritmo naturale dell’espressione immessa
log Restituisce il valore del logaritmo immesso in una data base
log10 Restituisce il valore del logaritmo di base 10 dell’espressione immessa
max Restituisce il valore più grande non nullo in un insieme di valori
min Restituisce il valore più piccolo non nullo in un insieme di valori
pi Restituisce il valore di pi greco per i calcoli
radians Converte da gradi a radianti
rand Restituisce il numero intero casuale nell’intervallo specificato dal parametro minimo e massimo

(incluso)
randf Restituisce il numero reale casuale all’interno dell’intervallo specificato dal parametro minimo e

massimo (incluso)
round Arrotonda al numero di cifre decimali
scale_exp Trasforma un determinato valore da un dominio di input a un intervallo di output utilizzando una

curva esponenziale
scale_linear Trasforma un determinato valore da un dominio di input a un intervallo di output utilizzando

l’interpolazione lineare
sin Restituisce il seno di un angolo in radianti
sqrt Restituisce la radice quadrata di un valore
tan Restituisce la tangente di un angolo

Operatori

Questo gruppo contiene operatori (e.g., +, -, *). Si noti che per la maggior parte delle funzioni matematiche di
seguito se uno dei input è NULL il risultato è NULL.
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Funzioni Descrizione
a + b Somma di due valori (a più b)
a - b Sottrazione tra due valori (a meno b).
a * b Moltiplicazione tra due valori (a moltiplicato per b)
a / b Divisione tra due valori (a diviso per b)
a % b Resto della divisione di a diviso b (ad esempio, 7 % 2 = 1 o 2 si entra nel 7 tre volte con il resto

di 1)
a ^ b Elevazione a potenza di due valori (ad esempio, 2^2=4 o 2^3=8)
a < b Confronta due valori e restituisce 1 se il valore di sinistra è inferiore al valore di destra (a è

minore di b)
a <= b Confronta due valori e restituisce 1 se il valore di sinistra è minore o uguale al valore di destra
a <> b Confronta due valori e restituisce 1 se non sono uguali
a = b Confronta due valori e restituisce 1 se sono uguali
a ! = b a e b non sono uguali
a > b Confronta due valori e restituisce 1 se il valore di sinistra è maggiore del valore di destra (a è

maggiore di b)
a >= b Confronta due valori e restituisce 1 se il valore di sinistra è maggiore o uguale al valore di

destra
a ~ b a corrisponde al valore assoluto di b
|| Unisce insieme due valori in una stringa. Se uno dei valori è NULL, il risultato sarà NULL
“\n” Inserisce una nuova riga in una stringa
LIKE Restituisce 1 se il primo parametro corrisponde al filtro scelto
ILIKE Restituisce 1 se il primo parametro corrisponde senza distinzione tra maiuscole e minuscole

al filtro scelto (ILIKE può essere usato al posto di LIKE per rendere la corrispondenza senza
distinzione tra maiuscole e minuscole)

a IS b Verifica se due valori sono identici. Restituisce 1 se a è uguale a b
a OR b Restituisce 1 quando la condizione a o la condizione b è vera
a AND b Restituisce 1 quando le condizioni a e b sono vere
NOT Inverte una condizione
column
name «col-
umn name»

Valore del nome della colonna del campo, fare attenzione a non essere confuso con i semplici
apici, vedi sotto

“string” valore stringa, fare attenzione a non essere confuso gli apici doppi, vedi sopra
NULL valore nullo
a IS NULL a ha valore nullo
a IS NOT
NULL

a contiene un valore

a IN
(value[,value])

a ha valore contenuto nei valori in lista

a NOT IN
(value[,value])

il valore di a non è tra i valori in lista

Nota: Informazioni sulla concatenazione dei campi

Puoi concatenare le stringhe utilizzando o || o +. Quest’ultimo ha anche il significato di somma. Quindi, se
si dispone di un numero intero (campo o valore numerico) questo può essere causa di errore. In questo caso, si
dovrebbe usare ||. Se concatenate due valori di stringa, è possibile utilizzare entrambi.

Alcuni esempi:

• Unire una stringa e un valore da un nome di colonna:
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'My feature''s id is: ' || "gid"
'My feature''s id is: ' + "gid" => triggers an error as gid is an integer
"country_name" + '(' + "country_code" + ')'
"country_name" || '(' || "country_code" || ')'

• Testare se il campo di attributo «descrizione» inizia con la stringa «Hello» (notare la posizione del carattere
%):

"description" LIKE 'Hello%'

Funzioni Raster

Questo gruppo contiene funzioni che operano sui layer raster.

Funzioni Descrizione
raster_statistic Restituisce statistiche da un layer raster
raster_value Restituisce il valore della banda raster nel punto dato

Funzioni relative ai record e agli attributi

Questo gruppo contiene funzioni che operano sugli identificativi dei record.

Funzioni Descrizione
$current-
feature

Restituisce l’elemento corrente da valutare. Questo può essere usato con la funzione “attribute”
per valutare i valori degli attributi dell’elemento corrente.

$id Restituisce l’ID della geometria della riga corrente
attribute Restituisce il valore di uno specifico attributo di una geometria
get_feature Restituisce la prima geometria di un layer che corrisponde a un determinato valore di attributo
get_feature_by_idRestituisce la geometria di un layer che corrisponde a un determinato valore di ID
is_selected Restituisce se è stata selezionata una geometria
num_selected Restituisce il numero di geometrie selezionate su un dato layer
repre-
sent_value

Restituisce il metodo di rappresentazione configurato per un campo (conveniente con alcune
tipologie widget)

uuid Genera un Identificatore Univoco Universale (UUID) per ogni riga. Ogni UUID è lungo 38
caratteri

Alcuni esempi:

• Restituire la prima geometria nel layer «LayerA» il cui campo «id» ha lo stesso valore del campo «name»
della geometria corrente (una specie di jointure) :

get_feature( 'layerA', 'id', attribute( $currentfeature, 'name') )

• Calcolare l’area della geometria unita con l’esempio precedente:

area( geometry( get_feature( 'layerA', 'id', attribute( $currentfeature, 'name
→˓') ) ) )

Funzioni Stringa

Questo gruppo contiene le funzioni che operano sulle stringhe (ad esempio sostituisci, converti in maiuscolo).
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Funzioni Descrizione
char Restituisce il carattere associato a un codice Unicode
concat Concatena più stringhe in una
format Formatta una stringa usando gli argomenti forniti
for-
mat_date

Formatta un tipo data o una stringa in un formato stringa personalizzato

for-
mat_number

Restituisce un numero formattato con il separatore delle impostazioni internazionali per le migli-
aia (inoltre tronca il numero al numero di posti forniti)

left(string,
n)

Restituisce una sottostringa che contiene gli n caratteri più a sinistra della stringa

length Restituisce la lunghezza di una stringa (o la lunghezza di una geometria di tipo linestring)
lower converte una stringa in lettere minuscole
lpad Restituisce una stringa riempita a sinistra alla larghezza specificata, usando il carattere di riempi-

mento
reg-
exp_match

Restituisce la prima posizione che corrisponde a un’espressione regolare all’interno di una stringa,
o 0 se la sottostringa non viene trovata.

reg-
exp_replace

Restituisce una stringa con la parte che soddisfa l’espressione regolare sostituita

reg-
exp_substr

Restituisce la parte di una stringa che corrisponde all’espressione regolare fornita

replace Restituisce una stringa con la stringa fornita, l’array o la mappa di stringhe sostituite da una
stringa, array di stringhe o valori associati.

right(string,
n)

Restituisce una sottostringa che contiene gli n caratteri più a destra della stringa

rpad Restituisce una stringa riempita a destra alla larghezza specificata, usando il carattere di riempi-
mento

strpos Restituisce la prima posizione di corrispondenza di una sottostringa dentro un’altra stringa o 0 se
la sottostringa non viene trovata.

substr Restituisce una parte di una stringa
title Converte tutte le parole di una stringa in “Titolo maiuscolo” (tutte le parole in minuscolo con la

prima lettera maiuscola)
trim Rimuove tutti gli spazi bianchi iniziali e finali (spazi, tabulazioni, ecc.) da una stringa
upper Converte una stringa in lettere maiuscole
word-
wrap

Restituisce una stringa posta a capo ad un massimo/minimo numero di caratteri

Funzioni Variabili

Questo gruppo contiene variabili dinamiche relative all’applicazione, al file di progetto e ad altre impostazioni.
Significa che alcune funzioni potrebbero non essere disponibili in base al contesto:

• dalla finestra di dialogo Seleziona tramite una espressione

• dalla finestra di dialogo Calcolatore campo

• dalla finestra di dialogo Proprietà layer

• dal layout di stampa

Per utilizzare queste funzioni in un’espressione, dovrebbero essere precedute da un carattere @ (ad esempio,
@row_number). Riguardano:

Funzioni Descrizione
algorithm_id Restituisce l’ID univoco di un algoritmo
atlas_feature Restituisce la geometria atlante corrente (come oggetto geometria)
atlas_featureid Restituisce l’ID della geometria atlante corrente

Continued on next page
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Table 13.2 – continued from previous page
Funzioni Descrizione
atlas_featurenumber Restituisce il numero dell’oggetto corrente dell’atlante nel layout
atlas_filename Restituisce il nome del file atlante corrente
atlas_geometry Restituisce la geometria dell’elemento corrente dell’atlante
atlas_layerid Restituisce l’ID del layer corrente di copertura dell’atlante.
atlas_layername Restituisce il nome del layer corrente di copertura dell’atlante.
atlas_pagename Restituisce il nome della pagina atlante corrente
atlas_totalfeatures Restituisce il numero totale di geometrie nell’atlante
canvas_cursor_point Restituisce l’ultima posizione del cursore sulla mappa nelle coordinate geografiche del progetto
cluster_color Restituisce il colore dei simboli all’interno di un gruppo, o NULL se i simboli hanno colori misti.
cluster_size Restituisce il numero di simboli contenuti in un gruppo
current_feature Restituisce l’oggetto attualmente in fase di modifica nel modulo attributo o nella riga della tabella.
current_geometry Restituisce la geometria dell’oggetto attualmente in fase di modifica nel modulo o nella riga della tabella.
geometry_part_count Restituisce il numero di parti nella geometria dell’oggetto visualizzato
geometry_part_num Restituisce il numero della parte della geometria corrente dell’oggetto che sarà visualizzato
geometry_point_count Restituisce il numero di punti nella parte della geometria visualizzata
geometry_point_num Restituisce il numero del punto corrente nella parte della geometria visualizzata
grid_axis Restituisce l’annotazione corrente dell’asse del reticolo (ad esempio “X” per longitudine, “y” per latitudine)
grid_number Restituisce il valore corrente dell’annotazione del reticolo
item_id Restituisce l’ID utente dell’oggetto del layout (non necessariamente univoco)
item_uuid Restituisce l’ID univoco dell’oggetto del layout
layer Restituisce il layer corrente
layer_id Restituisce l’ID del layer corrente
layer_name Restituisce il nome del layer corrente
layout_dpi Restituisce la risoluzione della composizione di stampa (DPI)
layout_name Restituisce il nome del layout
layout_numpages Restituisce il numero di pagine nel layout
layout_page Restituisce il numero di pagina dell’oggetto corrente nel layout
layout_pageheight Restituisce l’altezza della pagina attiva nel layout (in mm)
layout_pagewidth Restituisce la larghezza della pagina attiva nel layout (in mm)
map_crs Restituisce il sistema di riferimento delle coordinate della mappa corrente
map_crs_definition Restituisce la definizione completa del sistema di riferimento delle Coordinate della mappa corrente
map_extent Restituisce la geometria che rappresenta l’estensione corrente della mappa
map_extent_center Restituisce il punto centrale della mappa
map_extent_height Restituisce l’altezza corrente della mappa
map_extent_width Restituisce la larghezza corrente della mappa
map_id Restituisce l’ID della destinazione della mappa corrente. Questo sarà “canvas” per la visualizzazione della mappa e l’ID dell’oggetto per le visualizzazioni in mappa del layout
map_layer_ids Restituisce l’elenco degli ID dei layer visibili nella mappa
map_layers Restituisce l’elenco dei layer visibili nella mappa
map_rotation Restituisce la rotazione corrente della mappa
map_scale Restituisce la scala corrente della mappa
map_units Restituisce le unità di misura della mappa
notification_message Contenuto del messaggio di notifica spedito dalla sorgente (disponibile solo per azioni provenienti da notifiche dal sorgente).
parent Si riferisce alla geometria del layer padre, fornendo accesso ai suoi attributi e alla sua geometria quando si filtra una funzione aggregate.
project_abstract Restituisce l’abstract del progetto, tratto dai metadati del progetto
project_author Restituisce l’autore del progetto, tratto dai metadati del progetto
project_basename Restituisce il nome di base del nome del file del progetto corrente (senza percorso ed estensione)
project_creation_date Restituisce la data di creazione del progetto, ricavata dai metadati del progetto
project_crs Restituisce il sistema di riferimento delle Coordinate del progetto
project_crs_definition Restituisce la definizione completa del sistema di riferimento delle Coordinate del progetto
project_filename Restituisce il nome del file del progetto corrente
project_folder Restituisce la cartella del progetto corrente
project_home Restituisce il percorso della cartella per il progetto corrente
project_identifier Restituisce l’identificatore del progetto, tratto dai metadati del progetto

Continued on next page
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Table 13.2 – continued from previous page
Funzioni Descrizione
project_keywords Restituisce le parole chiave del progetto, tratte dai metadati del progetto
project_path Restituisce il percorso completo (incluso il nome del file) del progetto corrente
project_title Restituisce il titolo del progetto corrente
qgis_locale Restituisce la lingua corrente di QGIS
qgis_os_name Restituisce il nome corrente del sistema operativo, ad esempio «windows», «linux» o «osx»
qgis_platform Restituisce la piattaforma QGIS, ad esempio “desktop” o “server”
qgis_release_name Restituisce il nome della versione corrente di QGIS
qgis_short_version Restituisce la stringa della versione corrente di QGIS
qgis_version Restituisce la stringa della versione corrente di QGIS
qgis_version_no Restituisce il numero di versione corrente di QGIS
snapping_results Dà accesso ai risultati dell’aggancio durante la digitalizzazione di una geometria (disponibile solo nella funzionalità di aggiunta)
symbol_angle Restituisce l’angolo del simbolo utilizzato per la visualizzazione dell’elemento (valido solo per i simboli marker)
symbol_color Restituisce il colore del simbolo utilizzato per la visualizzazione dell’elemento
user_account_name Restituisce il nome corrente dell’account utente nel sistema operativo
user_full_name Restituisce il nome corrente dell’utente nel sistema operativo
row_number Memorizza il numero della riga corrente
value Restituisce il valore corrente
with_variable Consente di impostare una variabile da utilizzare all’interno di un’espressione ed evitare di ricalcolare ripetutamente lo stesso valore

Alcuni esempi:

• Restituisce la coordinata X di un oggetto della mappa da inserire in un’etichetta nel layout:

x( map_get( item_variables( 'map1'), 'map_extent_center' ) )

• Restituisce per ogni geometria del layer corrente il numero di aeroporti che si sovrappongono:

aggregate( layer:='airport', aggregate:='count', expression:="code",
filter:=intersects( $geometry, geometry( @parent ) ) )

• Ottenere l’object_id del primo punto agganciato di una linea:

with_variable(
'first_snapped_point',
array_first( @snapping_results ),
attribute(

get_feature_by_id(
map_get( @first_snapped_point, 'layer' ),
map_get( @first_snapped_point, 'feature_id' )

),
'object_id'

)
)

Funzioni recenti

Questo gruppo contiene le funzioni utilizzate di recente. A seconda del contesto del suo utilizzo (selezione delle
geometrie, calcolatore di campo, generico), ogni espressione applicata viene aggiunta alla lista corrispondente
(fino a dieci espressioni), ordinata dalla più recente alla meno recente. Questo aiuta a recuperare e riapplicare
rapidamente qualsiasi espressione usata in precedenza.
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13.3.3 Editor delle Funzioni

Con la scheda Editor delle funzioni, puoi scrivere le tue funzioni nel linguaggio Python. Ciò fornisce un modo
pratico e comodo per affrontare esigenze particolari che non sarebbero coperte dalle funzioni predefinite.

Figure 13.74: La scheda Editor delle funzioni

Per creare una nuova funzione:

1. Premi il pulsante New File.

2. Inserisci un nome da utilizzare nel modulo che compare e premi OK.

Un nuovo oggetto con il nome da te fornito viene aggiunto nel pannello sinistro della scheda Editor delle
funzioni; si tratta di un file .py basato sul file del modello predefinito di QGIS e memorizzato nella cartella
/python/expressions sotto la directory attiva :ref:‘user profile ‘.

3. Il pannello di destra mostra il contenuto del file: un template di script python. Aggiorna il codice e il suo
aiuto in base alle tue esigenze.

4. Premi il pulsante Salva e Carica Funzioni. La funzione scritta viene aggiunta all’albero delle funzioni
nella scheda Espressione, di default nel gruppo Custom.

5. Goditi la tua nuova funzione.

6. Se la funzione necessita di richiede miglioramenti, abilita la scheda Editor delle Funzioni, fai le modifiche

e premi nuovamente il pulsante Salva e Carica Funzioni per renderle disponibili nel file, quindi in
qualsiasi scheda di espressione.

Le funzioni personalizzate Python sono memorizzate nella directory del profilo utente, il che significa che ad ogni
avvio di QGIS, caricherà automaticamente tutte le funzioni definite con il profilo utente corrente. Tieni presente
che le nuove funzioni vengono salvate solo nella cartella /python/expressions e non nel file di progetto.

274 Chapter 13. Lavorare con i vettori



QGIS User Guide, Release 3.4

Se condividi un progetto che utilizza una delle tue funzioni personalizzate, dovrai anche condividere il file .py
nella cartella /python/expressions.

Ecco un breve esempio su come creare proprie funzioni:

from qgis.core import *
from qgis.gui import *

@qgsfunction(args='auto', group='Custom')
def my_sum(value1, value2, feature, parent):

"""
Calculates the sum of the two parameters value1 and value2.
<h2>Example usage:</h2>
<ul>

<li>my_sum(5, 8) -> 13</li>
<li>my_sum("field1", "field2") -> 42</li>

</ul>
"""
return value1 + value2

Il breve esempio crea una funzione my_sum che ti darà una funzione con due valori. Quando si usa la funzione
args='auto' il numero di argomenti richiesti per la funzione sarà calcolato dal numero di argomenti con cui
la funzione è stata definita in Python (minus 2 - feature, e parent).

Questa funzione può quindi essere utilizzata nell’espressione:

Figure 13.75: Funzione personalizzata aggiunta alla scheda Espressione

Ulteriori informazioni sulla creazione di codice Python possono essere trovate nel PyQGIS-Developer-Cookbook.

13.4 Lavorare con la tabella degli attributi

La tabella degli attributi visualizza informazioni sugli oggetti di un layer selezionato. Ogni riga nella tabella
rappresenta un oggetto (con geometria o meno) e ogni colonna contiene una particolare informazione sull’oggetto.
Gli oggetti nella tabella possono essere cercati, selezionati, spostati o anche modificati.

13.4.1 Premessa: Tabelle spaziali e non spaziali

QGIS ti consente di caricare layers spaziali e non spaziali. Attualmente sono incluse tabelle supportate da OGR
e a testo delimitato, nonché sorgenti PostgreSQL, MSSQL, SpatiaLite, DB2 e Oracle. Tutti i layer caricati sono
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elencati nel pannello Layer. Se un layer è abilitato spazialmente o meno determina se è possibile interagire con
esso sulla mappa.

Le tabelle non spaziali possono essere visualizzate e modificate utilizzando la vista tabella degli attributi. Inoltre,
possono essere utilizzate per ricerche sul campo. Ad esempio, puoi utilizzare le colonne di una tabella non
spaziale per definire i valori degli attributi, o un intervallo di valori che possono essere aggiunti a uno specifico
layer vettoriale durante la digitalizzazione. Dai un’occhiata più da vicino al widget di modifica nella sezione
Proprietà Modulo Attributi per saperne di più.

13.4.2 Introduzione all’interfaccia della tabella degli attributi

Per aprire la tabella degli attributi di un layer vettoriale, attiva il layer cliccandoci sopra in Pannello dei Layer.

Poi, dal menu principale Layer, scegli Apri tabella attributi. E” anche possibile cliccare con il tasto destro del

mouse sul layer e scegliere Apri tabella attributi dal menu a discesa, oppure cliccare sul pulsante Apri
tabella attributi nella barra degli strumenti Attributi. Se preferisci le scorciatoie, F6 aprirà la tabella degli attributi.
Shift+F6 aprirà la tabella degli attributi filtrata per le geometrie selezionate e Ctrl+F6 aprirà la tabella degli
attributi filtrata per le geometrie visibili.

Si aprirà una nuova finestra che mostra gli attributi delle geometrie del layer (figure_attributes_table). In base
all’impostazione in Impostazioni -> Opzioni -> Sorgenti dei dati, la tabella degli attributi si aprirà in una finestra
agganciata o in una finestra normale. Il numero totale di geometrie nel layer e il numero di geometrie attualmente
selezionate/filtrate sono mostrati nel titolo della tabella degli attributi anche se il layer è spazialmente limitato.

Figure 13.76: Tabella degli attributi per il layer regions

I pulsanti nella parte superiore della finestra della tabella degli attributi forniscono le seguenti funzionalità:
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Icona Etichetta Azione Scorciatoie da
tastiera

Attivare/disattivare modalità modi-
fica

Attivare modalità modifica Ctrl+E

Attivare modalità modifica multipla Aggiornare più campi di molte geometrie

Salva modifiche Salva le modifiche in corso Ctrl+S

Ricarica la tabella

Aggiungi elemento Aggiungi un nuovo oggetto senza geome-
tria

Elimina elementi selezionati Rimuovi gli elementi elementi selezionati
dal layer

Taglia gli elementi selezionati nel
blocco appunti

Ctrl+X

Copia gli elementi selezionati nel
blocco appunti

Ctrl+C

Incolla elementi dagli appunti Inserisci nuovi elementi da quelli copiati Ctrl+V

Seleziona elementi usando una
Espressione

Seleziona Tutto Seleziona tutte gli elementi del layer Ctrl+A

Inverti la selezione Inverti la selezione corrente del layer Ctrl+R

Deseleziona tutto Deseleziona tutti gli elementi del layer
corrente

Ctrl+Shift+A

Filtra/Seleziona elementi usando un
modulo

Ctrl+F

Sposta la selezione in cima Sposta le righe selezionate in cima alla
tabella

Spostare mappa alle righe selezion-
ate

Ctrl+P

Zoom mappa alle righe selezionate Ctrl+J

Nuovo campo Aggiungi un nuovo campo ai dati originari Ctrl+W

Elimina campo Rimuovi un campo dall’origine dati Ctrl+L

Apri calcolatore campi Aggiornare il campo per molti elementi in
una riga

Ctrl+I

Formattazione condizionale Abilitare formattazione tabella

Aggancia Tabella degli Attributi Permette di agganciare/sganciare la
tabella degli attributi

Azioni Elenca le azioni relative al layer

Tabella Attributo 1: Strumenti disponibili

Nota: A seconda del formato dei dati e della libreria OGR creata con la versione di QGIS, alcuni strumenti
potrebbero non essere disponibili.
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Sotto questi pulsanti c’è la barra di Calcolo Rapido Campo (abilitata solo in modalità modifica), che ti consente di
applicare rapidamente filtri e calcoli a tutti o parte degli elementi nel vettore. Per i calcoli usa le stesse expressions

del Calcolatore di campi (vedi Modifica dei valori nella tabella degli attributi).

Visualizzazione Tabella e Visualizzazione Modulo

QGIS fornisce due modi di visualizzazione per manipolare facilmente i dati nella tabella degli attributi:

• La Vista tabella, visualizza i valori di più geometrie in modalità tabellare, ogni riga rappresenta una ge-
ometria e ogni colonna un campo.

• E la Visualizzazione modulo che mostra feature identifiers in un primo pannello e solo gli attributi della ge-
ometria cliccata nel secondo. La vista modulo utilizza la configurazione dei campi dei layer (vedi Proprietà
Modulo Attributi).

Puoi passare da una modalità all’altra cliccando sull’apposita icona in basso a destra della finestra di dialogo.

Puoi anche specificare la modalità di Vista predefinita all’apertura della tabella degli attributi nel menu Im-
postazioni → Opzioni → Sorgente dei dati. Può essere “Ricorda ultima vista”, “Vista tabella” o “Vista modulo”.

Configurare le colonne

Fai click con il pulsante destro del mouse in un’intestazione di colonna quando sei è in visualizzazione tabella
per accedere agli strumenti che ti consentono di definire ciò che può essere visualizzato e come nella tabella degli
attributi.

Nascondere e organizzare colonne e attivare azioni

Facendo click con il pulsante destro del mouse in un’intestazione di colonna, puoi scegliere di nasconderla dalla
tabella degli attributi. Per modificare contemporaneamente il comportamento di più colonne, mostrare una colonna
o cambiare l’ordine delle colonne, scegli Organizza colonne . . . . Nella nuova finestra di dialogo puoi:

• selezionare/deselezionare le colonne da visualizzare o nascondere

• trascinare e rilasciare gli oggetti per riordinare le colonne nella tabella degli attributi. Si noti che questa
modifica riguarda la visualizzazione della tabella e non modifica l’ordine dei campi nell’origine dati del
layer

• abilitare una nuova colonna virtuale Azioni che visualizza in ciascuna riga una casella a discesa o un elenco
di pulsanti di azioni per ciascuna riga, per ulteriori informazioni sulle azioni, vedi Proprietà Azioni.

Cambiare la larghezza delle colonne

La larghezza delle colonne può essere impostata tramite un click destro sull’intestazione della colonna e se-
lezionare:

• Imposta larghezza. . . per immettere il valore desiderato. Per impostazione predefinita, il valore corrente
viene visualizzato nel widget

• DimensioneAuto per ridimensionare al meglio la colonna.

Può essere modificata anche trascinando il limite a destra della colonna con il mouse tenendo premuto il tasto
sinistro. La nuova dimensione della colonna viene mantenuta per il layer e viene ripristinata all’apertura successiva
della tabella degli attributi.

278 Chapter 13. Lavorare con i vettori



QGIS User Guide, Release 3.4

Figure 13.77: Tabella degli Attributi nei formati di visualizzazione Modulo (in alto) e Tabella (in basso)
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Ordinare le colonne

La tabella può essere ordinata su qualsiasi colonna, facendo click sull’intestazione della colonna. Una piccola
freccia indica l’ordine di ordinamento (verso il basso significa far scendere i valori dalla riga superiore in basso,
verso l’alto significa far salire ivalori dalla riga superiore in basso). Puoi anche ordinare le righe con l’opzione di
ordinamento del menu contestuale dell’intestazione di colonna e scrivere un’espressione, ad esempio per ordinare
la riga con più colonne puoi scrivere concat(col0, col1).

Nella visualizzazione modulo, l’identificatore degli elementi può essere ordinato utilizzando l’opzione Ordina
tramite anteprima espressione.

Suggerimento: Ordinamento in base a colonne di diversa tipologia

Il tentativo di ordinare una tabella degli attributi in base a colonne di stringhe e a tipi numerici può portare a
risultati inaspettati a causa dell’espressione concat("USE", "ID") che restituisce i valori delle stringhe
(cioè, Borough105' < 'Borough6'). Puoi aggirare questo problema usando ad esempio ("USE",
lpad("ID", 3, 0)) che restituisce 'Borough105' > 'Borough006'.

Formattazione delle celle della tabella utilizzando condizioni

Le impostazioni di formattazione condizionale possono essere utilizzate per evidenziare le geometrie della tabella
degli attributi che in particolare vuoi mettere a fuoco, utilizzando condizioni specifiche per le geometrie:

• geometria (ad esempio, identificazione delle geometrie multi-parti, piccole aree o in una estensione limitata
della mappa . . . );

• o valore del campo (ad esempio, confrontando i valori con una soglia, identificando le celle vuote . . . )

Puoi abilitare il pannello di formattazione condizionale cliccando su in alto a destra nella finestra attributi in
visualizzazione tabella (non disponibile in visualizzazione modulo).

Il nuovo pannello consente all’utente di aggiungere nuove regole per modificare la visualizzazione del Campo

o Riga intera. L’aggiunta di una nuova regola apre un modulo per definire:

• il nome della regola;

• una condizione che utilizza una qualsiasi delle funzioni del expression builder

• la formattazione: può essere scelta da un elenco di formati predefiniti o creata in base a proprietà come:

– colori di sfondo e testo;

– uso dell’icona;

– grassetto, corsivo, sottolineato o testo barrato;

– carattere.

13.4.3 Interagire con gli elementi nella tabella degli attributi

Selezionare elementi

Nella vista tabella, ogni riga nella tabella degli attributi visualizza gli attributi di una specifica geometria nel layer.
Selezionando una sola riga si seleziona una geometria e allo stesso modo, selezionando una geometria nella mappa
(in caso di geometria del layer attivato), viene selezionata la corrispondente riga nella tabella degli attributi. Se
viene modificato un insieme di geometrie selezionate nella mappa (o nella tabella degli attributi), la selezione
viene aggiornata anche nella tabella degli attributi (o nella visualizzazione della mappa).

Le righe possono essere selezionate facendo clic sul numero di riga sul lato sinistro della riga. È possibile con-
trassegnare più righe tenendo premuto il tasto Ctrl. Una selezione continua può essere effettuata tenendo
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Figure 13.78: Formattazione Condizionale di una tabella degli attributi

premuto il tasto Shift e facendo click su più intestazioni di riga sul lato sinistro delle righe. Sono selezionate
tutte le righe tra la posizione corrente del cursore e la riga cliccata. Spostando la posizione del cursore nella tabella
degli attributi, facendo clic su una cella nella tabella, non cambia la selezione di riga. Cambiare la selezione nella
finestra principale non sposta la posizione del cursore nella tabella degli attributi

Nella impostazione visualizzazione della tabella degli attributi, le geometrie vengono identificate per default nel
pannello di sinistra per il valore del loro campo visualizzato (vedere Proprietà Suggerimenti). Questo identificatore
può essere sostituito utilizzando l’elenco a discesa nella parte superiore del pannello, selezionando un campo
esistente o utilizzando un’espressione personalizzata. Puoi inoltre scegliere di ordinare l’elenco delle geometrie
dal menu a discesa.

Fai click su un valore nel pannello di sinistra per visualizzare gli attributi della geometria nella destra. Per se-
lezionare una geometria, devi fare click all’interno del simbolo quadrato a sinistra dell’identificatore. Per im-
postazione predefinita, il simbolo diventa giallo. Come nella visualizzazione tabella, puoi eseguire la selezione di
più geometrie utilizzando le combinazioni di tasti precedentemente esposte.

Oltre a selezionare le geometrie con il mouse, è possibile eseguire la selezione automatica in base all’attributo
della geometria utilizzando gli strumenti disponibili nella barra degli strumenti della tabella degli attributi, ad
esempio (vedi la sezione Selezione automatica e la successiva per ulteriori informazioni e casi d’uso):

• Seleziona con Espressione. . . .

• Seleziona Elementi per Valore. . . .

• Deseleziona tutto

• Seleziona Tutti gli elementi

• Inverti Selezione Elementi.

È anche possibile selezionare gli elementi utilizzando Filtrare e selezionare elementi usando moduli.
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Filtrare elementi

Una volta che hai selezionato le geometrie nella tabella degli attributi, potresti voler visualizzare solo questi record
nella tabella. Questo può essere fatto facilmente utilizzando la voce Mostra gli elementi selezionati dall’elenco a
discesa in basso a sinistra della finestra di dialogo della tabella degli attributi. Questa lista offre i seguenti filtri:

• Mostra tutti gli elementi

• Mostra Elementi Selezionati

• Mostra Elementi visibili nella mappa

• Mostra Elementi Modificati e Nuovi

• Filtro campo: consente all’utente di eseguire il filtro in base al valore di un campo: scegliere una colonna
da un elenco, digitare un valore e premere Enter per filtrare. Quindi, nella tabella degli attributi vengono
visualizzati solo gli elementi corrispondenti.

• Filtro avanzato (Espressione) - Apre la finestra di dialogo del costruttore di espressioni. Al suo interno,
puoi creare complex expressions per selezionare righe nella tabella. Ad esempio, puoi filtrare elementi della
tabella utilizzando più di un campo. Quando viene applicato, l’espressione del filtro apparirà in fondo al
modulo.

E” anche possibile filter features using forms.

Nota: Filtrare records fuori dalla tabella degli attributi non consente di eliminare gli elementi dal layer; essi
sono semplicemente momentaneamente nascosti dalla tabella e si possono selezionare sulla mappa ovvero si può
rimuovere il filtro. Per filtri che nascondono gli elementi dal layer, utilizzare il Query Builder.

Suggerimento: Aggiornare il filtraggio della sorgente dati con Mostra gli elementi visibili
nella mappa

Quando per motivi di prestazione, gli elementi visualizzati nella tabella degli attributi sono limitati nella visual-
izzazione mappa alla sua apertura (vedi Data Source Options per come fare), selezionando Mostra gli elementi
visibili nella mappa su una nuova estensione di visibilità della mappa si aggiorna la precedente restrizione spaziale.

Filtrare e selezionare elementi usando moduli

Facendo clic su Seleziona/filtra usando un modulo o premendo Ctrl+F la finestra di dialogo della tabella degli attributi
passerà alla visualizzazione modulo e tutti i widget verranno sostituiti con le sue opzioni di ricerca.

Da questo punto in poi, questa funzionalità dello strumento è simile a quella descritta in Seleziona Elementi per
Valore. . . , dove si trovano le descrizioni di tutti gli operatori e le modalità di selezione.

Quando si selezionano/filtrano le geometrie dalla tabella degli attributi, c’è un pulsante Filtra elementi che perme-
tte di definire e rifinire i filtri. Il suo utilizzo attiva l’opzione :guilabel:‘Filtro avanzato (Espressione)‘e visualizza
la corrispondente espressione del filtro in un widget di testo modificabile nella parte inferiore del modulo.

Se ci sono elementi già selezionati, puoi reimpostare il filtro usando l’elenco a discesa accanto al pulsante in basso
a destra Filtra elementi. Le opzioni sono:

• Filtra all’interno («AND»)

• Estendi filtro («OR»)

Per cancellare il filtro seleziona l’opzione Seleziona tutto dal menu a discesa in basso a sinistra, oppure cancella
l’espressione e fai clic su Applica oppure premi Invio.
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Figure 13.79: Filtro tramite modulo della tabella degli attributi

13.4.4 Usare le azioni sugli oggetti

Gli utenti hanno diverse possibilità di manipolare elementi con il menu contestuale come:

• Seleziona tutto (Ctrl+A) selezionare tutti gli elementi;

• Copiare il contenuto di una cella negli appunti con Copia contenuto cella;

• Zoomare all’elemento senza doverlo selezionare in anticipo;

• Spostarsi sulla geometria senza doverla selezionare in anticipo;

• Flash feature, per evidenziarla sulla mappa;

• Apri modulo: attiva la tabella degli attributi nella vista modulo con un focus sulla geometria cliccata.

Figure 13.80: Copiare il contenuto di una cella
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Se vuoi utilizzare i dati degli attributi in programmi esterni (ad esempio Excel, LibreOffice,

QGIS o un’applicazione Web personalizzata), seleziona una o più righe e utilizza il pulsante
Copia le righe selezionate negli appunti o premi Ctrl+C. Nel menu Impostazioni → Opzioni. . . → Sorgenti Dati,
puoi definire il formato da incollare con le opzioni in Copia geometrie come:

• Testo normale, nessuna geometria,

• Testo normale, geometria WKT,

• GeoJSON

Puoi anche visualizzare un elenco di azioni in questo menu contestuale. Questa opzione è attivata nella scheda
Proprietà vettore → Azioni. Vedi Proprietà Azioni per ulteriori informazioni sulle azioni.

Salvare le geometrie selezionate come nuovo layer

Le geometrie selezionate possono essere salvate in qualsiasi formato vettoriale supportato da OGR e anche trasfor-
mate in un altro sistema di riferimento di coordinate (SR). Nel menu contestuale del layer, dal Panello Layer, fai
clic su Esporta → Salva con nome. . . per definire il nome del file di output, il formato e il SR (vedi la sezione

Creare nuovi layer da layer esistente). Per salvare la selezione, assicurati che sia selezionata l’opzione Salva
solo le geometrie selezionate. È anche possibile specificare le opzioni di creazione OGR all’interno della finestra
di dialogo.

13.4.5 Modifica dei valori nella tabella degli attributi

La modifica dei valori degli attributi può essere eseguita:

• digitando il nuovo valore direttamente nella cella, se la tabella degli attributi è in visualizzazione tabella o
modulo. Le modifiche vengono quindi effettuate per cella, elemento per elemento;

• utilizzando il field calculator: aggiorna in una riga un campo che può già esistere o essere creato ma per
geometrie multiple Può essere utilizzato per creare campi virtuali.

• utilizzando la modalità calculation bar: come sopra, ma solo per il campo esistente;

• o utilizzando la modalità multi edit: aggiorna in una riga più campi per più geometrie

Usare il Calcolatore di campo

Il pulsante Apri calcolatore di campi nella tabella degli attributi ti consente di eseguire calcoli sulla base dei valori di
attributi esistenti o di funzioni definite, per esempio, per calcolare la lunghezza o l’area di elementi geometrici. I
risultati possono essere usati per aggiornare un campo esistente, o scritti in un nuovo campo (che può essere un
campo virtual).

Il calcolatore di campi è disponibile su qualsiasi layer che supporta la modifica. Quando fai clic sull’icona del
calcolatore di campi, si apre la finestra di dialogo (vedi figure_field_calculator). Se il layer non è in modalità
di modifica, viene visualizzato un avviso e l’utilizzo del calcolatore provoca il cambiamento di stato del layer in
modalità di modifica prima del calcolo.

La finestra di dialogo Expression Builder offre un’interfaccia completa per definire un’espressione e applicarla a
un campo esistente o appena creato. Per utilizzare la finestra di dialogo del calcolatore di campo, devi scegliere se
vuoi:

1. applica il calcolo su tutto il layer o solo sulle geometrie selezionate

2. crea un nuovo campo per il calcolo o aggiorna un campo esistente.

Se scegli di aggiungere un nuovo campo, devi immettere un nome campo, un tipo di campo (intero, reale, data
o stringa) e, se necessario, la lunghezza totale del campo e la precisione del campo. Ad esempio, se scegli una
lunghezza del campo di 10 e una precisione del campo di 3, significa che hai 6 cifre prima del punto, poi il punto
e altre 3 cifre per la precisione.
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Figure 13.81: Calcolatore Campo

Un breve esempio illustra come funziona il calcolatore di campo quando si utilizza la scheda Espressione.
Vogliamo calcolare la lunghezza in km del layer railroads dal dataset di esempio di QGIS:

1. Carica lo shapefile railroads.shp in QGIS e premi Apri tabella attributi.

2. Fai clic su Attiva modifiche e apri la finestra di dialogo Calcolatore di campi.

3. Seleziona la casella di controllo Crea un nuovo campo per salvare i calcoli in un nuovo campo.

4. Imposta Nome campo in uscita a length_km.

5. Seleziona Numero decinale (real) come Tipo campo in uscita

6. Imposta la Lunghezza campo in uscita a 10 e la Precisione a 3

7. Fai doppio clic su $lenght nel gruppo Geometria per aggiungere la lunghezza della geometria nella
casella di espressione del calcolatore di campo.

8. Completa l’espressione digitando / 1000 nella casella Espressione del Calcolatore campo e fai click su
OK.

9. Puoi ora trovare un nuovo campo length_km nella tabella degli attributi.

Creare un Campo Virtuale

Un campo virtuale è un campo basato su un’espressione calcolata on the fly, il che significa che il suo valore viene
aggiornato automaticamente non appena il parametro sottostante cambia. L’espressione viene impostata una sola
volta; non è più necessario ricalcolare il campo ogni volta che i valori sottostanti cambiano. Ad esempio, puoi
utilizzare un campo virtuale se vuoi che un’area venga valutata quando si digitalizzano poligoni ovvero calcolare
automaticamente una durata tra date che possono cambiare (ad esempio, utilizzando la funzione now ()).
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Nota: Uso dei Campi Virtuali

• I campi virtuali non sono permanenti negli attributi del layer, nel senso che sono solo salvati e disponibili
nei file di progetto dove sono stati creati.

• Un campo può essere impostato virtuale solo alla sua creazione e l’espressione utilizzata non può più essere
modificata: è necessario eliminare e ricreare quel campo.

La barra di calcolo campo rapido

Mentre il calcolatore di campo è sempre disponibile, la barra di calcolo campo rapido in cima alla tabella di
attributo è visibile solo se il layer è in modalità di modifica. Grazie al motore calcolatore tramite espressione,
offre un accesso più rapido per modificare un campo già esistente.

1. Seleziona il campo presente da aggiornare nell’elenco a discesa.

2. Compila la casella di testo con un’espressione che direttamente scrivi o crei utilizzando il pulsante espres-

sione .

3. Fai clic sul pulsante Aggiorna tutto, Aggiorna selezione o Aggiornamento filtrato in base alle tue esigenze.

Figure 13.82: La barra di calcolo campo rapido

Modifica multipla di campi

A differenza degli strumenti precedenti, la modalità modifica multipla consente di modificare più attributi di diversi
elementi simultaneamente. Quando il layer viene impostato in modifica, sono disponibili strumenti di modifica
multipla:

• utilizzando il pulsante Attiva modalità modifica multipla nella barra degli strumenti all’interno della finestra di
dialogo della tabella degli attributi,

• o selezionando il menu Modifica → Modifica gli attributi delle geometrie selezionate

Nota: A differenza dello strumento dalla tabella degli attributi, premendo l’opzione Modifica → Modifica gli
attributi delle geometrie selezionate viene fornita una finestra di dialogo per definire le modifiche degli attributi.
Di conseguenza, è necessario selezionare le geometrie prima dell’esecuzione.

Per modificare più campi di una riga:

1. Seleziona le geometrie che vuoi modificare.
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2. Dalla barra degli strumenti della tabella degli attributi, fai click sul pulsante . In questo modo, la finestra
di dialogo viene visualizzata nella sua maschera. La selezione delle geometrie potrebbe essere effettuata
anche in questo punto.

3. Al lato destro della tabella degli attributi vengono visualizzati i campi (e i valori) delle geometrie selezionate.
Nuovi widget appaiono accanto a ciascun campo che consentono di visualizzare lo stato di modifica multipla
corrente:

• il campo contiene valori diversi per le geometrie selezionate. Viene visualizzato vuoto e ogni
geometria conserverà il suo valore originale. Puoi ripristinare il valore del campo dall’elenco a discesa
del widget.

• tutte le geometrie selezionate hanno lo stesso valore per questo campo e il valore visualizzato nel
modulo verrà mantenuto.

• il campo è stato modificato e il valore inserito verrà applicato a tutte le geometrie selezionate.
Viene visualizzato un messaggio nella parte superiore della finestra di dialogo, invitandoti a applicare
o annullare la modifica.

Facendo clic su uno di questi widget puoi o impostare il valore corrente per il campo o ripristinare il valore
originale, il che significa che puoi ripristinare le modifiche campo per campo.

Figure 13.83: Modifiche di campi per più geometrie

4. Apporta le modifiche ai campi desiderati.

5. Fai clic su Applica modifiche nel messaggio testuale superiore o a qualsiasi geometria del pannello di
sinistra.

Le modifiche verranno applicate a tutte le geometrie selezionate. Se non è selezionata alcuna geometria, l’intera
tabella viene aggiornata con le tue modifiche. Le modifiche vengono eseguite come un singolo comando di
modifica. Quindi, premendo Annulla vengono ripristinate contemporaneamente le modifiche degli attributi per tutte
le geometrie selezionate.

Nota: La modalità di modifica multipla è disponibile solo per i moduli generati automaticamente o personalizzati
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drag and drop (vedi Personalizzare un modulo per i tuoi dati); non è supportato da moduli personalizzati UI.

13.4.6 Creare una relazione uno a molti o molti a molti

Le relazioni sono una tecnica utilizzata spesso nelle banche dati. Il concetto è che le geometrie (righe) di layer
diversi (tabelle) possono appartenersi a vicenda.

Introduzione alle relazioni 1-N

Come esempio hai un layer con tutte le regioni dell’Alaska (poligono) con alcuni attributi sul suo nome e il tipo
regione e un ID univoco (che funge da chiave primaria).

Poi hai caricato un altro layer di punti o una tabella con informazioni sugli aeroporti che si trovano nelle regioni
e desideri anche tenere traccia di questi. Se vuoi aggiungerli al layer regioni, devi creare rapporti uno a molti
utilizzando chiavi esterne, in quanto in molte regioni esistono più aeroporti.

Figure 13.84: Regione dell’Alaska con areoporti

Layer in relazione 1-N

QGIS non fa differenza tra una tabella e un layer vettoriale. Fondamentalmente, un layer vettoriale è una tabella
con una geometria. Quindi puoi aggiungere la tua tabella come un layer vettoriale. Per mostrare la relazione
1-n, puoi caricare lo shapefile airports e lo shapefile airports che contiene un campo chiave esterna
(fk_region) al layer regions. Ciò significa che ogni aeroporto appartiene esattamente ad una regione, men-
tre ogni regione può avere un certo numero di aeroporti (una tipica relazione uno a molti).

Chiavi esterne nelle relazioni 1-N

Oltre agli attributi già esistenti nella tabella degli attributi degli aeroporti, avrai bisogno di un altro campo
fk_region‘ che funge da chiave esterna (se hai un database, probabilmente vorrai definire un vincolo su di esso).

Questo campo fk_region conterrà sempre un id di una regione. Può essere visto come un puntatore alla regione a
cui appartiene. E si può progettare un modulo di modifica personalizzato per l’editing e QGIS si fa carico della
sua definizione. Funziona con diverse fonti dati (quindi puoi anche usarlo con shapefile e csv) e tutto quello che
devi fare è definire in QGIS le relazioni tra le tue tabelle.
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Definizione relazioni 1-N (Relation Manager)

La prima cosa che faremo è far sapere a QGIS le relazioni tra i layer. Ciò è fatto in Progetto → Proprietà del
progetto. . . . Apri la scheda: guilabel:Relazioni e fai click su Aggiungi Relazione.

• il Nome che verrà utilizzato come titolo. Dovrebbe essere una stringa personalizzata chiara, che descriva la
relazione utilizzata. In questo caso la chiameremo solo Aeroporti.

• il Layer di riferimento (Padre) che viene considerato come layer padre, è quello con la chiave primaria a
cui puntare, quindi qui è il layer regions

• il Campo di riferimento è la chiave primaria del layer di riferimento, qui è ID

• il Layer riferito (figlio) che viene considerato come layer figlio, è quello con il campo chiave esterno. Nel
nostro caso, questo è il layer airports

• il Campo di riferimento quel campo che può collegarsi all’altro layer, quindi in questo caso è fk_region

• id sarà utilizzato per scopi interni e deve essere univoco. Ti potrebbe essere necessario per creare custom
forms. Se lo lasci vuoto, verrà generato automaticamente per te, ma puoi assegnare un nome per avere una
più chiara modalità di gestione.

• Forza della relazione definisce la forza della relazione tra il layer genitore e il layer figlio. Il tipo di
default Association significa che il layer genitore è semplicemente collegato a quello del figlio mentre il tipo
Composition permette di duplicare anche le caratteristiche del figlio quando si duplicano quelle del genitore.

Figure 13.85: Gestore delle relazioni
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Moduli per relazioni 1-N

Ora che QGIS sa la relazione, sarà usato per migliorare il modulo che genera. Poiché non abbiamo modificato
il modulo predefinito (autogenerato) aggiungerà semplicemente un nuovo widget nel nostro modulo. Quindi,
selezioniamo la regione del layer nella legenda e utilizziamo lo strumento di identificazione. A seconda delle
impostazioni, il modulo si potrebbe aprire direttamente o dovrai scegliere di aprirlo nella finestra di dialogo di
identificazione in azioni.

Figure 13.86: Finestra di dialogo identificazione relazione regioni con aeroporti

Come puoi vedere, gli aeroporti assegnati a questa particolare regione vengono tutti mostrati in una tabella. E ci
sono anche alcuni pulsanti disponibili. Guardiamoli brevemente

• Il pulsante serve per attivare la modalità di modifica. Tieni presente che imposta la modalità di modifica
per il layer airports, anche se siamo nel modulo di un elemento del layer regions. Ma la tabella rappresenta
le geometrie del layer airports.

• Il pulsante serve per salvare tutte le modifiche.

• Il pulsante aggiungerà un nuovo record alla tabella degli attributi del layer degli aeroporti. E assegnerà
il nuovo aeroporto alla regione corrente per impostazione predefinita.

• Il pulsante ti permette di copiare una o più geometrie figlie.

• Il pulsante cancellerà definitivamente l’aeroporto selezionato.

• Il simbolo aprirà una nuova finestra di dialogo in cui è possibile selezionare qualsiasi aeroporto esistente
che verrà assegnato alla regione corrente. Questo può essere utile se si è creato accidentalmente l’aeroporto
sulla regione sbagliata.

• Il simbolo scollegherà gli aeroporti selezionati dalla regione corrente, lasciandoli non assegnati (la
chiave esterna viene impostata su NULL).
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• Con il pulsante puoi ingrandire la mappa sulla geometria figlia selezionata.

• I due pulsanti e a destra ti consentono di passare dalla visualizzazione tabellare alla visualizzazione
modulo, dove poi puoi visualizzare tutti gli aeroporti nel loro rispettivo modulo.

Nell’esempio precedente il layer ha delle geometrie (quindi non è solo una tabella alfanumerica) quindi i passi
precedenti creeranno una voce nella tabella degli attributi del layer che non ha alcuna caratteristica geometrica
corrispondente. Per aggiungere la geometria:

1. Scegli Apri tabella attributi per il layer.

2. Seleziona il record che è stato aggiunto in precedenza all’interno del modulo per la geometria del layer
selezionato.

3. Utilizza lo strumento di digitalizzazione Add Part per collegare una geometria al record della tabella degli
attributi selezionata.

Se lavori sulla tabella dell’aeroporto, il widget Relation Reference viene automaticamente impostato per il campo
fk_region (quello usato per creare la relazione), vedi Relation Reference widget.

Nel modulo aeroporto vedrai il pulsante sul lato destro del campo fk_region: se clicchi sul pulsante si
aprirà il modulo del layer regione. Questo widget ti permette di aprire facilmente e rapidamente i moduli delle
geometrie padri collegate.

Figure 13.87: Finestra di dialogo identificazione aeroporti in relazione con regioni

Il widget Relation Reference ha anche un’opzione per incorporare il modulo del layer genitore all’interno di quello
figlio. È disponibile nel menu Properties → Attributes Form del layer airport: seleziona il campo fk_region e
attiva l’opzione Show embedded form.

Se ora guardi alla finestra di dialogo delle geometrie, vedrai che il modulo della regione è incorporato all’interno
del modulo aeroportuale e avrà anche una combinazione di opzioni di scelta, che ti consentono di assegnare
l’attuale aeroporto ad un’altra regione.

Inoltre, se attivi o disattivi la modalità di modifica del layer aeroporto, il campo fk_region ha anche una
funzione di autocompletamento: durante la digitazione vedrai tutti i valori del campo id del layer regionale.

Introduzione alle relazioni molti-a-molti (N-M)

Le relazioni N-M sono relazioni molti a molti rapporti tra due tabelle. Ad esempio, i layer airports e
airlines: un aeroporto serve compagnie aeree e una compagnia aerea opera in diversi aeroporti.
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Questo codice SQL crea le tre tabelle necessarie per una relazione N-M in uno schema PostgreSQL/PostGIS
denominato locations. Puoi eseguire il codice utilizzando Database → DB Manager. . . . per PostGIS o stru-
menti esterni come pgAdmin. La tabella aeroporti memorizza il layer airports e la tabella compagnie aeree
memorizza il layer airlines. In entrambe le tabelle per chiarezza vengono usati pochi campi. La parte utile
è la tabella airports_airlines`. Ne abbiamo bisogno per elencare tutte le compagnie aeree per tutti gli
aeroporti (o viceversa). Questo tipo di tabella è conosciuta come tabella pivot. Le relazioni in questa tabella
costringono a far sì che un aeroporto possa essere associato ad una compagnia aerea solo se entrambi esistono già
nei loro layer.

CREATE SCHEMA locations;

CREATE TABLE locations.airports
(

id serial NOT NULL,
geom geometry(Point, 4326) NOT NULL,
airport_name text NOT NULL,
CONSTRAINT airports_pkey PRIMARY KEY (id)

);

CREATE INDEX airports_geom_idx ON locations.airports USING gist (geom);

CREATE TABLE locations.airlines
(

id serial NOT NULL,
geom geometry(Point, 4326) NOT NULL,
airline_name text NOT NULL,
CONSTRAINT airlines_pkey PRIMARY KEY (id)

);

CREATE INDEX airlines_geom_idx ON locations.airlines USING gist (geom);

CREATE TABLE locations.airports_airlines
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(
id serial NOT NULL,
airport_fk integer NOT NULL,
airline_fk integer NOT NULL,
CONSTRAINT airports_airlines_pkey PRIMARY KEY (id),
CONSTRAINT airports_airlines_airport_fk_fkey FOREIGN KEY (airport_fk)

REFERENCES locations.airports (id)
ON DELETE CASCADE
ON UPDATE CASCADE
DEFERRABLE INITIALLY DEFERRED,

CONSTRAINT airports_airlines_airline_fk_fkey FOREIGN KEY (airline_fk)
REFERENCES locations.airlines (id)
ON DELETE CASCADE
ON UPDATE CASCADE
DEFERRABLE INITIALLY DEFERRED

);

Al posto di PostgreSQL puoi anche utilizzare GeoPackage. In questo caso, le tre tabelle possono essere create
manualmente utilizzando il menu Database → DB Manager. . . . In GeoPackage non ci sono schemi, quindi il
prefisso localizzazione non è necessario.

Chiavi esterne vincolanti nella tabella airports_airlines non possono essere creati usando Table → Create
Table. . . . o Table → Edit Table. . . . pertanto devono essere creati usando Database → SQL Window. . . .. GeoPack-
age non supporta le istruzioni ADD CONSTRAINT quindi la tabella airports_airlines dovrebbe essere
creata in due fasi:

1. Imposta la tabella solo con il campo id usando Table → Create Table. . . ..

2. Usando Database → Finestra SQL. . . ., digita ed esegui questo codice SQL:

ALTER TABLE airports_airlines
ADD COLUMN airport_fk INTEGER
REFERENCES airports (id)
ON DELETE CASCADE
ON UPDATE CASCADE
DEFERRABLE INITIALLY DEFERRED;

ALTER TABLE airports_airlines
ADD COLUMN airline_fk INTEGER
REFERENCES airlines (id)
ON DELETE CASCADE
ON UPDATE CASCADE
DEFERRABLE INITIALLY DEFERRED;

Poi, in QGIS, dovresti impostare due relazioni one-to-many relations come sopra spiegato:

• una relazione tra la tabella airlines e la tabella pivot;

• e una seconda tra la tabella airports e la tabella pivot.

Un modo più semplice per farlo (solo per PostgreSQL) è quello di utilizzare il comando Scopri relazioni in
Progetto → Proprietà → Relazioni. QGIS leggerà automaticamente tutte le relazioni nel tuo database e devi solo
selezionare le due che ti servono. Ricordati di caricare prima le tre tabelle del progetto QGIS.

Se vuoi rimuovere un airport o una airline, QGIS non rimuoverà i record associati nella tabella
airports_airlines. Questo compito sarà fatto dal database se specifichiamo i corretti vincoli nella creazione
della tabella pivot come nell’esempio corrente.

Nota: Combinare la relazione N-M con il gruppo di transazioni automatiche

Dovresti abilitare la modalità Crea automaticamente la transizione dei gruppi quando possibile in Project Pro-
prietà → Sorgente dei dati → se stai lavorando in tale contesto. QGIS dovrebbe essere in grado di aggiungere o
aggiornare le righe in tutte le tabelle (compagnie aeree, aeroporti e tabelle pivot).
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Figure 13.88: Relazioni e automatismi

Infine dobbiamo selezionare la cardinalità di destra in Layer Properties → Attributes Form per i layer airports
e airlines. Per il primo dovremmo scegliere l’opzione airlines (id) e per il secondo l’opzione airports (id).

Figure 13.89: Impostare il rapporto di cardinalità

Ora puoi associare un aeroporto con una compagnia aerea (o una compagnia aerea con un aeroporto) usando Add
child feature o Link existing child feature nei sottomoduli. Un record verrà automaticamente inserito nella tabella
airports_airlines.

Nota: Utilizzo cardinalità Relazione molti ad uno

A volte non è opportuno nascondere la tabella pivot in una relazione N-M. Principalmente perché ci sono attributi
nella relazione che possono avere valori solo quando si stabilisce una relazione. Se le tabelle sono layer (hanno
un campo geometrico) potrebbe essere interessante attivare l’opzione On map identification opzione (Layer Prop-
erties → Attributes Form → Available widgets → Fields) per i campi chiave esterna nella tabella pivot.

Nota: Chiave primaria tabella pivot

Evita di utilizzare più campi nella chiave primaria in una tabella pivot. QGIS accetta una singola chiave pri-
maria, quindi un vincolo come constraint airports_airlines_airlines_pkey primary key
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Figure 13.90: Relazioni N-M tra aeroporti e linee aeree
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(airport_fk, airline_fk) non funzionerà.

13.5 Modifica

QGIS supporta varie opzioni per la manipolazione di layers vettoriali e relative tabelle nei formati OGR, Spa-
tiaLite, PostGIS, MSSQL Spatial e Oracle Spatial.

Nota: La procedura per la modifica dei layers GRASS è diversa, per dettagli vedi la sezione Digitalizzare e
modificare layer vettoriali GRASS.

Suggerimento: Modifiche concorrenti

Questa versione di QGIS non controlla se qualcun altro sta editando la stessa geometria, vince chi per primo
effettua il salvataggio.

13.5.1 Impostare la Tolleranza dello Snapping e il raggio di ricerca degli elementi

Al fine di gestire in maniera ottimale la modifica delle geometrie di un layer vettoriale, dobbiamo impostare un
adeguato valore di aggancio e di raggio di ricerca per i vertici delle geometrie.

Tolleranza di aggancio

Quando aggiungi un nuovo vertice o sposti un vertice esistente, la tolleranza di saggancio è la distanza che QGIS
utilizza per cercare il vertice o il segmento più vicino a cui stai cercando di connetterti. Se non sei nella tolleranza
di aggancio, QGIS lascerà il vertice dove rilasci il pulsante del mouse, invece di agganciare ad un vertice o ad un
segmento esistente.

L’impostazione della tolleranza di aggancio influisce su tutti gli strumenti che lavorano con la tolleranza.

Puoi abilitare o disabilitare l’aggancio usando il pulsante Abilita Aggancio sulla Barra degli Strumenti di Aggan-
cio o premendo S in qualsiasi momento mentre sei in visualizzazione mappa. Questa barra degli strumenti è
anche molto comoda per configurare rapidamente la modalità di aggancio, il valore di tolleranza e le unità. La
configurazione dell’aggancio può anche essere impostata in Progetto → Opzioni di Aggancio. . . .

Ci sono tre opzioni per selezionare il layer o i layer su cui effettuare l’aggancio:

• Tutti i Layer: una impostazione rapida e semplice per tutti i layer visibili del progetto in modo che il
puntatore attivi lo snap a tutti i vertici e/o ai segmenti. Nella maggior parte dei casi è sufficiente utilizzare
questa modalità di aggancio, ma attenzione quando la si utilizza su progetti con molti layer vettoriali, in
quanto può causare forti rallentamenti.

• Layer Attivo: viene usato solo il layer attivo, una modalità utile per garantire la topologia all’interno del
layer da modificare.

• Configurazione Avanzata: permette di abilitare e regolare la modalità di aggancio e la tolleranza al layer
(vedi figure_edit_snapping). Se hai bisogno di modificare un layer e di agganciare i suoi vertici ad un altro,
assicurati che il layer di destinazione sia stato selezionato e aumenta la tolleranza dello aggancio ad un
valore più alto. L’aggancio non avverrà su un layer che non sia selezionato nella finestra di dialogo delle
opzioni di aggancio.

Per quanto riguarda la modalità di aggancio, puoi selezionare tra al Vertice, al Segmento e al Vertice e
Segmento.

I valori di tolleranza possono essere impostati sia nelle «unità di mappa» del progetto che in «pixel». Il vantaggio
di scegliere px è che mantiene l’aggancio costante alle diverse scale della mappa. Da 10 a 12 pixel è normalmente
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un buon valore, ma dipende dal DPI del tuo schermo. L’uso di unità di mappa permette di mettere in relazione la
tolleranza con le distanze reali dal suolo. Ad esempio, se hai una distanza minima tra gli elementi, questa opzione
può essere utile per essere sicuro di non aggiungere vertici troppo vicini tra loro.

Figure 13.91: Opzioni di aggancio (modalità Configurazione Avanzata)

Nota: Per impostazione predefinita, possono essere agganciate solo le geometrie visibili (le geometrie la cui sim-
bologia è visualizzata, ad eccezione dei layer in cui la simbologia è «Nessun simbolo»). Puoi abilitare l’aggancio

sulle geometrie invisibili selezionando Abilita aggancio su elementi invisibili (non mostrati sulla mappa) nella
scheda Impostazioni → Opzioni → Digitalizzazione.

Suggerimento: Abilitare l’aggancio per default

Puoi impostare l’aggancio come abilitato di default su tutti i nuovi progetti nella scheda Impostazioni → Opzioni
→ Digitalizzazione. Puoi anche impostare la modalità di aggancio di default, il valore di tolleranza e le unità, che
popoleranno la finestra di dialogo Aggancio.

Abilita aggancio alle intersezioni

Un’altra opzione disponibile è quella di usare Abilita Aggancio all’Intersezione, che ti permette di agganciare
alle intersezioni geometriche dei layer abilitati all’aggancio, anche se non ci sono vertici nelle intersezioni.

Raggio di ricerca

Il raggio di ricerca è la distanza che QGIS utilizza per «cercare» il vertice più vicino che stai tentando di selezionare
quando clicchi sulla mappa. Se non ti trovi entro il raggio di ricerca, QGIS non troverà e selezionerà alcun vertice
da modificare. Il raggio di ricerca per la modifica dei vertici può essere definito nella scheda Impostazioni →
Opzioni → Digitalizzazione. Questo è lo stesso posto dove si definiscono i valori di default dell’aggancio.

La tolleranza di aggancio e il raggio di ricerca sono impostati in unità di mappa o pixel, quindi potresti
scoprire di dover sperimentare per impostarli correttamente. Se specifichi una tolleranza troppo grande, QGIS
potrebbe agganciare al vertice sbagliato, specialmente se hai a che fare con un gran numero di vertici in prossimità.
Impostando il raggio di ricerca troppo piccolo QGIS non troverà nulla da spostare.

13.5.2 Modifiche topologiche

Oltre alle opzioni di aggancio, la finestra di dialogo Impostazioni di Aggancio del Progetto (Progetto → Opzioni
di aggancio. . . .) e la Barra degli Strumenti di Aggancio ti consentono di abilitare e disabilitare alcune funzionalità
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topologiche.

Abilitare la modifica topologica

Il pulsante Modifica Topologica ti aiuta a modificare e mantenere le geometrie con confini comuni. Con questa
opzione abilitata, QGIS “rileva” i confini che sono condivisi dalle geometrie; quando sposti vertici/segmenti co-
muni, QGIS li sposta anche nelle geometrie degli elementi vicini.

La modifica topologica funziona con le geometrie di diversi layer, purché i layer siano visibili e siano in modalità
di modifica.

Evitare intersezioni di nuovi poligoni

Quando la modalità di aggancio è impostata su Configurazione avanzata, per i layer poligonali, c’è

un’opzione chiamata Evita intersezioni. Questa opzione ti impedisce di disegnare nuove geometrie che si
sovrappongono a quelle esistenti nel layer selezionato, velocizzando la digitalizzazione di poligoni adiacenti.

Con abilitato Evita intersezioni, se hai già di un poligono, puoi digitalizzare un secondo poligono in modo che
si intersechino. QGIS taglierà il secondo poligono al confine di quello esistente. Il vantaggio è che non devi
digitalizzare tutti i vertici del confine comune.

Nota: Se la nuova geometria è totalmente coperta da quella esistente, viene cancellata e QGIS mostrerà un
messaggio di errore.

Avvertimento: Usare con cautela l’opzione Evita intersezioni

Poiché questa opzione taglia nuove geometrie sovrapposte di qualsiasi layer poligonale, potresti ottenere ge-
ometrie inaspettate se dimentichi di deselezionare questa opzione quando non è più necessaria.

Controllo Geometria

Un plugin di base che può aiutare l’utente a controllare la validità della geometria. Puoi trovare ulteriori infor-
mazioni su questo plugin in Plugin Controllo Geometria.

Tracciamento Automatico

Generalmente, quando stai utilizzando gli strumenti di registrazione sulla mappa (aggiungi geometria, aggiungi
parte, aggiungi anello, rimodella e dividi), è necessario fare clic su ogni vertice della geometria. Con la modalità di
tracciamento automatico, puoi accelerare il processo di digitalizzazione in quanto non è più necessario posizionare
manualmente tutti i vertici durante la digitalizzazione:

1. Attiva lo strumento Abilita ricalco premendo l’icona o il tasto T.

2. Snap to un vertice o segmento di una geometria che vuoi disegnare.

3. Sposta il mouse su un altro vertice o segmento sul quale vorresti agganciare e, invece della solita linea retta,
l’elastico di digitalizzazione materializza un percorso dall’ultimo punto al quale hai effettuato l’aggancio
alla posizione corrente.

QGIS utilizza in realtà la topologia delle geometrie sottostanti per costruire il percorso più breve tra i
due punti. Il tracciamento richiede l’attivazione dell’aggancio in layer tracciabili per costruire il percorso.
Dovresti inoltre agganciare a un vertice o segmento esistente durante la digitalizzazione e assicurarti che i
due nodi siano collegabili topologicamente con i contorni delle geometrie esistenti, altrimenti QGIS non è
in grado di collegarli e quindi traccia una singola linea retta.
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4. Clicca e QGIS posiziona i vertici intermedi seguendo il percorso visualizzato.

Deseleziona l’icona Enable Tracing e imposta l’opzione Offset per digitalizzare un percorso parallelo alle linee
invece di tracciarle lungo di esse; un valore positivo sposta il nuovo tracciato sul lato sinistro della direzione di
tracciamento e un valore negativo fa il contrario.

Nota: Regolare la scala della mappa o le impostazioni di aggancio per un tracciamento ottimale

Se ci sono troppe geometrie nella visualizzazione della mappa, il tracciamento è disattivato per evitare una elabo-
razione potenzialmente lunga nella costruzione del tracciamento e un sovraccarico di memoria elevato. Dopo aver
ingrandito o disattivato alcuni layers, il tracciamento viene nuovamente abilitato.

Nota: Non aggiunge punti topologici

Questo strumento non aggiunge punti alle geometrie dei poligoni esistenti anche se la Modifica topologica è
abilitata. Se la precisione geometrica è attivata sul layer modificato, la geometria risultante potrebbe non seguire
esattamente una geometria esistente.

Suggerimento: Attiva o disattiva rapidamente il tracciamento automatico premendo il tasto T

Premendo il tasto T, il tracciamento può essere abilitato/disabilitato in qualsiasi momento anche durante la dig-
italizzazione di una geometria, quindi è possibile digitalizzare alcune parti della geometria con il tracciamento
abilitato e altre parti con il tracciamento disabilitato. Gli strumenti si comportano come al solito quando il traccia-
mento è disabilitato.

13.5.3 Modifica di un layer esistente

Di default, i dati sono caricati in QGIS in modalità di sola lettura. Questa è una salvaguardia per evitare di
modificare accidentalmente un layer se c’è uno spostamento involontario del mouse. Comunque, puoi sempre
modificare un layer se ciò è consentito dalla sorgente dati e se il dato medesimo è anche scrivibile (ad esempio i
suoi file non sono in modalità di sola lettura).

Suggerimento: Limitare l’autorizzazione di modifica ai layer all’interno di un progetto

Nella tabella Progetto → Proprietà. . . → Sorgenti Dati → Capabilities dei Layer, puoi scegliere di impostare
qualsiasi layer in sola lettura indipendentemente dal permesso del provider. Questo può essere un modo pratico,
in un ambiente multi-utente per evitare che utenti non autorizzati modifichino erroneamente i layer (ad esem-
pio, Shapefile), quindi dati potenzialmente corrotti. Nota che questa impostazione si applica solo all’interno del
progetto corrente.

In generale, gli strumenti per la modifica dei layer vettoriali sono suddivisi in una Barra degli strumenti di dig-
italizzazione e in una Barra degli strumenti di digitalizzazione avanzata, descritta nella sezione Digitalizzazione
avanzata. Puoi selezionare e deselezionare le due barre sotto Visualizza → Barre degli strumenti →. Utilizzando
gli strumenti di digitalizzazione di base, puoi eseguire le seguenti funzioni:
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Icona Azione Icona Azione

Modifiche in uso Attiva modifica

Salva modifiche

Aggiungi nuovo record Aggiungi Elemento: inserisci
punto

Aggiungi geometria: inserisci linea Aggiungi geometria: inserisci
poligono

Strumento Vertice (Tutti i Layer) Strumento Vertice (Layer Cor-
rente)

Modifica simultaneamente gli attributi di tutti gli elementi
selezionati

Elimina Elementi selezionati Taglia Elementi

Copia Elementi Incolla Elementi

Annulla Ripristina

Modifica Tabella: Strumenti di base per la modifica di layer vettoriali

Si noti che durante l’utilizzo di uno degli strumenti di digitalizzazione, è possibile fare zoom or pan nella visual-
izzazioni mappa senza perdere l’operatività dello strumento.

Tutte le sessioni di modifica iniziano selezionando l’opzione Attiva modifiche che si trova cliccando con il tasto
destro del mouse sul nome del layer nella legenda, nella finestra di dialogo degli attributi, o nella barra degli
strumenti di digitalizzazione o nel menu Layer.

Una volta che il layer è in modalità modifica, ulteriori pulsanti di modifica diventeranno disponibili nella barra
degli strumenti e i marcatori verranno visualizzati ai vertici di tutte le geometrie a meno che non si seleziona
l’opzione Usa simboli solo per le geometrie selezionate in Impostazioni → Opzioni. . . → Digitalizzazione.

Suggerimento: Salvataggio ad intervalli regolari

Ricordatii di usare Salva modifiche vettore regolarmente, in modo da consentire il salvataggio delle tue modifiche
recenti e per verificare che le stesse siano accettate dalla fonte di dati.

Aggiungere Elementi

A seconda del tipo di layer, puoi utilizzare le icone Aggiungi Record, Aggiungi elemento Puntuale,
Aggiungi elemento Lineare o Aggiungi elemento Poligonale sulla barra degli strumenti per aggiungere nuovi elementi al layer
corrente.

Per aggiungere un elemento senza geometria, fari clic sul pulsante Aggiungi Record e puoi inserire gli attributi nel
modulo elemento che si apre. Per creare elementi con gli strumenti abilitati spazialmente, si digitalizza prima la
geometria e poi si inseriscono i suoi attributi. Per digitalizzare la geometria:

1. Fai clic con il tasto sinistro del mouse sull’area della mappa per creare il primo punto della tua nuova
geometria. Per le geometrie puntuali, questo dovrebbe essere sufficiente e attiva, se necessario, il modulo
per compilare gli attributi. Dopo aver impostato geometry precision nelle proprietà del layer puoi qui usare
snap to grid per creare elementi basati su una distanza regolare.

2. Per le geometrie lineari o poligonali, continua a cliccare a sinistra per ogni punto aggiuntivo che vuoi
catturare o utilizza automatic tracing per accelerare la digitalizzazione. Questo creerà linee rette consecutive
tra i vertici posizionati.
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Nota: Premendo il tasto Canc o Backspace viene ripristinato l’ultimo nodo che hai aggiunto.

3. Quando non hai altri punti da inserire, fai clic con il tasto destro del mouse in un punto qualsiasi dell’area
della mappa per confermare che hai finito di inserire geometrie per tale elemento.

Nota: Mentre digitalizzi le geometrie lineari o poligonali, puoi fare avanti e indietro tra gli strumenti lineari
Aggiungi elemento e circular string tools per creare geometrie curve composte.

Suggerimento: Personalizza il tracciamento ad elastico durante la digitalizzazione

Mentre si genera il poligono, il tracciamento ad elastico rosso di default può nascondere le geometrie o i
luoghi sottostanti per i quali potresti desiderare di catturare un punto. Ciò può essere cambiato impostando
un opacità inferiore (o un canale alfa) al Colore di riempimento nel menu Impostazioni → Opzioni. . . →
Digitalizzazione. Puoi inoltre evitare l’uso del tracciamento ad elastico selezionando Non agganciare linea
elastico durante l’edit dei nodi.

4. Verrà visualizzata la finestra attributo, che ti consente di inserire le informazioni per la nuova geometria.
Figure_edit_values mostra gli attributi di impostazione per un nuovo tronco di fiume fittizio in rivers di
Alaska. Comunque, nel menu Digitalizzazione in Impostazioni → Ozioni. . . puoi anche attivare:

• Non aprire il modulo dopo la creazione di ogni geometria per evitare l’apertura del modulo;

• o Ripeti i valori degli attributi usati per ultimi per avere i campi automaticamente riempiti
all’apertura del modulo e doverli solo eventualmente cambiare.

Figure 13.92: Attivare la finestra di dialogo dei valori degli attributi dopo aver digitalizzato una nuova geometria
vettoriale

Strumento Vertice

Nota: QGIS 3 cambiamenti principali

In QGIS 3, lo strumento nodo è stato completamente riprogettato e rinominato in Strumento Verice. In precedenza
lavorava con la modalità «clicca e sposta» e ora utilizza un flusso di lavoro «clic - clic». Questo permette importanti
miglioramenti come la possibilità di sfruttare il pannello di digitalizzazione avanzata con lo strumento vertice
mentre si digitalizzano o si modificano oggetti di più layer contemporaneamente.

Per qualsiasi layer vettoriale modificabile, lo strumento Strumento Vertice (vettore corrente) fornisce funzionalità di
manipolazione dei vertici delle geometrie simili ai programmi CAD. E” possibile selezionare più vertici contem-
poraneamente e spostarli, aggiungerli o cancellarli del tutto. Lo strumento vertex funziona anche con la proiezione
“al volo” attivata e supporta la funzione di editing topologico. Questo strumento è di selezione persistente, quindi
quando viene eseguita un’operazione, la selezione rimane attiva per questa geometria e per questo strumento.
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È importante impostare la proprietà Impostazioni ->‘|options| :menuselection:‘Opzioni -> Digitalizzazione ->
Raggio di ricerca per la modifica dei vertici a un numero maggiore di zero. Altrimenti, QGIS non ri-
conoscerà il vertice da editare.

Suggerimento: Indicatori dei vertici

L’attuale versione di QGIS supporta tre tipi di indicatori di vertice: “Cerchio semi trasparente”, “Croce” e “Nes-
suno”. Per cambiare lo stile dell’indicatore, scegli Impostazioni Opzioni -> Digitalizzazione ->, e seleziona la
voce appropriata.

Operazioni di base

Inizia attivando lo strumento Strumento Vertice (vettore corrente). Cerchi rossi appariranno quando passi sopra i vertici.

• Selezione vertici: Puoi selezionare i vertici cliccando su di essi uno alla volta tenendo premuto il tasto
Shift, oppure cliccando e trascinando un rettangolo intorno ad alcuni vertici. Quando un vertice è se-
lezionato, il suo colore cambia in blu. Per aggiungere altri vertici alla selezione corrente, tieni premuto il
tasto Shift mentre clicchi. Per rimuovere i vertici dalla selezione, tieni premuto Ctrl.

• Modalità di selezione vertici batch: La modalità di selezione batch può essere attivata premendo
Shift+R. Seleziona un primo nodo con un solo clic, quindi passa il mouse senza cliccare su un al-
tro vertice. Questo selezionerà dinamicamente tutti i nodi nel mezzo usando il percorso più breve (per i
poligoni).

Figure 13.93: Selezione batch dei vertici usando Shift+R

Premendo Ctrl invertirà la selezione, selezionando il percorso più lungo il contorno dell’elemento. Ter-
minando la selezione del nodo con un secondo click, oppure premendo Esc si uscirà dalla modalità batch.

• Aggiunta di vertici: Per aggiungere un vertice, sul centro del segmento appare un nuovo nodo virtuale.
Basta selezionarlo per aggiungere un nuovo vertice. Facendo doppio clic su una qualsiasi posizione del
perimetro si crea anche un nuovo nodo. Per le linee, viene proposto anche un nodo virtuale ad entrambe le
estremità di una linea per estenderla.
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Figure 13.94: Nodi virtuali per aggiungere vertici

• Eliminazione di vertici: dopo aver selezionato i vertici per l’eliminazione, fai click sul tasto Canc.
L’eliminazione di tutti i vertici di una geometria genera, se compatibile con la sorgente dei dati, un oggetto
privo di geometria. Notare che non elimina completamente una geometria, ma solo la parte geometrica. Per

eliminare completamente una geometria utilizza lo strumento Elimina selezionato.

• Spostamento vertici: Seleziona tutti i vertici che vuoi spostare, clicca su un vertice o contorno selezionato
e clicca nuovamente sulla nuova posizione desiderata. Tutti i vertici selezionati si sposteranno insieme. Se è
attivato l’aggancio, l’intera selezione può spostarsi al vertice o alla linea più vicina. Puoi usare i vincoli del
pannello di digitalizzazione avanzata per la distanza, gli angoli e l’esatta posizione X Y prima del secondo
clic. Qui puoi usare la funzione aggancia-alla-griglia. Dopo aver impostato un valore per la geometry
precision nelle proprietà del layer, appare una griglia in funzione del livello di zoom in accordo con la
precisione geometrica.

Figure 13.95: Selezione di un vertice e spostamento dei vertici nella griglia

Ogni modifica apportata al vertice viene memorizzata come voce separata nella finestra di dialogo Annulla. Ri-
cordati che tutte le operazioni supportano l’editing topologico quando questo è attivato. È supportata anche la
proiezione al volo, e lo strumento nodo fornisce suggerimenti per identificare un vertice facendovi passare sopra
il puntatore.
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Il Pannello Modifica Vertice

Quando si utilizza lo strumento Strumento Vertice su unageometria, è possibile fare clic destro per aprire il pan-
nello Editor Vertice che elenca tutti i vertici della geometria con le loro coordinate x, y (z, m se applicabile) e r
(per il raggio, in caso di geometria circolare). Basta selezionare una riga nella tabella per selezionare il vertice
corrispondente nella mappa e viceversa. Basta cambiare una coordinata nella tabella e la posizione del vertice
viene aggiornata. Puoi anche selezionare più righe e cancellarle totalmente.

Nota: Comportamento modificato in QGIS 3.4

Cliccando con il tasto destro del mouse su una geometria, viene immediatamente visualizzato l’editor dei vertici
e si blocca questa geometria, disabilitando così la modifica di qualsiasi altra geometria. Durante il blocco, una
geometria è esclusiva per l’editing: La selezione e lo spostamento di vertici e segmenti cliccando o trascinando
è possibile solo per questa geometria. Nuovi vertici possono essere aggiunti solo alla geometria bloccata. In-
oltre, il pannello dell’editor dei vertici ora si apre automaticamente quando si attiva lo strumento vertice e la sua
posizione/stato del vertice viene ricordato in tutti gli usi.

Figure 13.96: Pannello Editor Vertice con selezione di alcuni nodi

Tagliare, copiare ed incollare elementi

Le geometrie selezionate possono essere tagliate, copiate e incollate tra i layers nello stesso progetto QGIS, a patto

che i layers di destinazione siano impostati in precedenza in modalità Attiva modifiche.

Suggerimento: Trasformare il poligono in linea e viceversa usando copia/incolla

Copiare una linea e incollarla in un vettore poligonale: QGIS copia nel layer di destinazione un poligono il cui
confine corrisponde alla geometria chiusa della geometria lineare. Questo è un modo rapido per generare diverse
geometrie con gli stessi dati.

Le geometrie possono anche essere incollate ad applicazioni esterne come testo. Cioè, le geometrie sono rapp-
resentate in formato CSV, con i dati di geometria che appaiono nel formato OGC Well-Known Text (WKT). Le
geometrie WKT e GeoJSON dall’esterno di QGIS possono anche essere incollate ad un layer all’interno di QGIS.

Quando la funzione di copia e incolla è utile? Beh, si scopre che è possibile modificare più di un layer alla volta e
copiare/incollare le geometrie tra i layers. Perché vogliamo farlo? Diciamo che dobbiamo fare un po” di lavoro su
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un nuovo layer, ma abbiamo solo bisogno di uno o due laghi, non i 5.000 del nostro layer big_lakes. Possiamo
creare un nuovo layer e utilizzare copia/incolla per copiare i laghi necessari.

Ad esempio, copiamo alcuni laghi in un nuovo layer:

1. Caricare il layer dal quale vogliamo copiare gli elementi (layer sorgente)

2. Caricare o creare il layer nel quale vogliamo incollare gli elementi copiati (layer di destinazione)

3. Impostare entrambi i layer in modalità modifica

4. Rendere attivo il layer sorgente cliccando sul relativo nome nella legenda

5. Utilizza lo strumento Seleziona le geometrie con un rettangolo o con un singolo click per selezionare la geometria(e) sul
layer sorgente

6. Fare clic sullo strumento Copia geometrie

7. Rendere attivo il layer di destinazione cliccando sul relativo nome nella legenda

8. Fare clic sullo strumento Incolla geometrie

9. Terminare le modifiche e salvare

Cosa succede se gli strati di origine e di destinazione presentano schemi diversi (i nomi dei campi e i tipi non sono
gli stessi)? QGIS popola ciò che corrisponde e ignora il resto. Se non ti interessa che gli attributi che vengano
copiati nel layer di destinazione, non importa come progetti i campi e i tipi di dati. Se vuoi assicurarti che tutto -
la geometria e i suoi attributi - sia copiato, assicurati che gli schemi corrispondano.

Nota: Congruenza degli elementi incollati

Se i tuoi layer di origine e destinazione utilizzano la stessa proiezione, le geometrie incollate avranno geometria
identica al layer di origine. Però, se il layer di destinazione è in una proiezione diversa, QGIS non può garantire
che la geometria sia identica. Questo è semplicemente perché ci sono piccoli errori di arrotondamento coinvolti
nella conversione tra le proiezioni.

Suggerimento: Copiare attributo tipo stringa

Se hai creato una nuova colonna nella tua tabella degli attributi con il tipo “stringa” e vuoi incollare i valori da
un’altra colonna di attributo che ha una lunghezza maggiore, la lunghezza della dimensione della colonna verrà
estesa allo stesso valore. Questo perché il driver di GDAL Shapefile dalla versione GDAL/OGR 1.10 è capace di
estendere automaticamente campi stringa e interi per ospitare dinamicamente la lunghezza dei dati da inserire.

Eliminare Elementi Selezionati

Se desideriamo eliminare un’intera geometria (attributo e geometria), possiamo farlo prima selezionando la ge-

ometria usando il normale strumentoi Seleziona le geometrie con un rettangolo o con un singolo clic. La selezione può essere
effettuata anche dalla tabella degli attributi. Una volta impostata la selezione, premi il tasto Canc o Backspace

o utilizza lo strumento Elimina selezionato per eliminare le geometrie. È possibile eliminare più geometrie se-
lezionate contemporaneamente.

Anche lo strumento Taglia geometrie sulla barra degli strumenti di digitalizzazione può essere utilizzato per elim-
inare le geometrie. Questo elimina effettivamente le geometrie ma le mette anche su «appunti spaziali». Quindi,

dobbiamo tagliare la geometria per eliminarla. Potremmo però utilizzare lo strumento Incolla geometrie per ri-
portarci indietro, dandoci la possibilità di annullare l’eliminazione. Taglia, copia e incolla sono opzioni attive
sulle geometrie attualmente selezionate, il che significa che possiamo operare su più di una alla volta.
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Annullare e rispristinare

Gli strumenti Annulla e Ripristina ti consentono di annullare o ripetere le operazioni di modifica dei vettori.
Esiste anche un pannello associato che mostra tutte le operazioni nella cronologia di annullamento/ripristino (vedi
Figure_edit_undo). Questo pannello non viene visualizzato per impostazione predefinita; può essere visualizzato
facendo click con il pulsante destro sulla barra degli strumenti di digitalizzazione avanzata attivando nell’elenco
Pannelli la casella di controllo Annulla/Rifai. La funzione Annulla/Rifai è comunque attiva, anche se il pannello
non viene visualizzato.

Figure 13.97: Ripristinare e annullare nelle fasi di digitalizzazione

Quando viene premuto Annulla o Ctrl+Z (o Cmd+Z) lo stato di tutte le geometrie e gli attributi vengono riportati
allo stato in cui erano avevano prima di quella modifica. Le modifiche diverse dalle operazioni normali di modifica
vettore (ad esempio, le modifiche apportate da un plugin) potrebbero o non potrebbero essere ripristinate a seconda
di come sono state eseguite le modifiche.

Per utilizzare il widget della cronologia Annulla/Ripristina, fai clic per selezionare un’operazione nell’elenco della
cronologia. Tutti le geometrie verranno ripristinate allo stato in cui si trovavano dopo l’operazione selezionata.

Salvare i layer modificati

Quando un layer è in modalità di modifica, tutte le modifiche rimangono nella memoria di QGIS. Pertanto, non
vengono eseguite/salvate immediatamente nei dati di origine o nel disco. Se vuoi salvare le modifiche al layer

corrente ma vuoi continuare a modificare senza lasciare la modalità di modifica, puoi fare clic sul pulsante
Salva modifiche vettore. Quando disattivi la modalità con Attiva modifiche (o esci da chiude QGIS per qualche ragione),
ti viene anche chiesto se si vuoi salvare le modifiche o eliminarle.

Se le modifiche non possono essere salvate (ad esempio, il disco è pieno o gli attributi hanno valori fuori gamma),
lo stato di QGIS nello stato di memoria viene preservato. Ciò consente di regolare le modifiche e di riprovare.

Suggerimento: Integrità dei dati

È sempre una buona idea eseguire il backup dei dati originari prima di iniziare a modificare. Mentre gli autori
di QGIS hanno fatto ogni sforzo per preservare l’integrità dei tuoi dati, non offriamo alcuna garanzia a questo
proposito.

Salvare più layers contemporaneamente

Questa funzione si riferisce alla digitalizzazione di più layers. Scegli Salva vettore selezionato/i per salvare

tutte le modifiche apportate in più layer. Hai anche l’opportunità di Rollback per il vettore selezionato/i, in
modo che la digitalizzazione possa essere annullata per uno/tutti i layer selezionato/i. Se vuoi interrompere la

modifica dei layer selezionati un modo semplice è attivare l’opzione Annulla per il vettore selezionato/i.
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Le stesse funzioni sono disponibili per la modifica di tutti i layer del progetto.

Suggerimento: Utilizza gruppo di transazioni per modificare, salvare o ripristinare contemporaneamente
le modifiche di più layers

Quando lavori con layer dello stesso database PostGreSQL, attiva l’opzione Crea automaticamente gruppi di
transazioni dove possibile in Progetto → Proprietà . . . . → Sorgenti di dati per sincronizzare il loro comportamento
(entrare o uscire dalla modalità di modifica, salvare o ripristinare le modifiche allo stesso tempo).

13.5.4 Digitalizzazione avanzata

Icona Azione Icona Azione

Attiva gli strumenti di digitalizzazione avanzata Attiva tracciamento

Sposta Elemento(i) Copia e Sposta Elemento(i)

Ruota Elemento/i Semplifica Elemento

Aggiungi buco Aggiungi Parte

Riempi buco

Elimina buco Elimina Parte

Curva di Offset Modifica la forma

Dividi Parti Spezza Elementi

Fondi Attributi Elementi Selezionati (merge) Fondi Elementi Selezionati

Ruota Simboli del Punto Offset dei simboli per i punti

Barra degli strumenti di digitalizzazione avanzata

Sposta Elemento(i)

Lo strumento Muovi elemento(i) ti permette di spostare geometrie esistenti:

1. Seleziona Elemento(i) da spostare

2. Fai clic sull’area di disegno della mappa per indicare il punto di origine dello spostamento; puoi fare affida-
mento sulla capacità di aggancio per selezionare un punto preciso.

Puoi anche sfruttare i vantaggi di advanced digitizig constraints per impostare con precisione le coordinate
del punto di origine. In questo caso:

(a) Per prima cosa fai clic sul pulsante per abilitare il pannello.

(b) Digita x e inserisci il valore corrispondente al punto di origine che vuoi utilizzare. Quindi premi il

pulsante accanto all’opzione per bloccare il valore.

(c) Fai lo stesso per la coordinata y.

(d) Clicca sulla mappa e il tuo punto di partenza è posizionato alle coordinate indicate.

3. Spostati sulla mappa per indicare il punto di destinazione dello spostamento, utilizzando ancora la modalità
aggancio o, come sopra, utilizza il pannello di digitalizzazione avanzata che rende disponibili vincoli com-
plementari di posizionamento di distanza e angolo per posizionare il punto finale della traslazione.

4. Clicca sulla mappa: tutte le geometrie vengono spostate nella nuova posizione.
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Allo stesso modo, puoi creare una copia traslata delle geometrie utilizzando lo strumento Copy and Move Feature(s).

Nota: Se non viene selezionata alcuna geometria quando si clicca per la prima volta sulla mappa con uno degli
strumenti Move Feature(s) o Copy and Move Feature(s), allora solo la geometria sotto il mouse è influenzata
dall’azione. Quindi, vuoi spostare piu geometrie, queste dovrebbero essere prima selezionate.

Ruota Elemento/i

Utilizza lo strumento Ruota geometria(e) per ruotare una o più geometrie nell’area di disegno della mappa:

1. Premi l’icona Ruota geometria(e)

2. Quindi fare clic sulla geometria per ruotare. Il centroide della geometria è indicato come centro di ro-
tazione, viene visualizzata un’anteprima della geometria ruotata e si apre un widget che mostra l’angolo di
:guilabel:‘Rotazione‘corrente.

3. Fai clic sull’area di disegno della mappa quando sei soddisfatto del nuovo posizionamento o inserisci man-
ualmente l’angolo di rotazione nella casella di testo. Puoi anche utilizzare la casella Aggancia a ° per
definire i valori di rotazione.

4. Se vuoi ruotare più geometrie contemporaneamente, devono essere prima selezionate e la rotazione è di
default intorno al centroide delle geometrie combinate.

Puoi anche utilizzare un punto di ancoraggio diverso dal centroide predefinito: premi il pulsante Ctrl, clicca
sulla mappa e quel punto sarà usato come nuovo centro di rotazione.

Se tieni premuto Shift prima di cliccare sulla mappa, la rotazione verrà eseguita in passi di 45 gradi, che possono
essere modificati successivamente nel widget di input dell’utente.

Per annullare la rotazione della geometria, premi il pulsante ESC oppure fai clic sull’icona Ruota geometria(e).

Semplifica Elemento

Lo strumento Semplifica geometria ti permette di rimodellare interattivamente una geometria di linee o poligoni
riducendo o addensando il numero di vertici, fintanto che la geometria rimane valida:

1. Seleziona lo strumento Semplifica geometria.

2. Fai clic sulla geometria o trascina un rettangolo sopra le geometrie.

3. Si apre una finestra di dialogo che ti permette di definire il Metodo da applicare, per esempio se vuoi:

• ref:simplify the geometry <qgissimplifygeometries>, il che significa meno vertici dell’originale.
I metodi disponibili sono Semplifica per distanza, Semplifica agganciando al
reticolo o semplifica per area (Visvalingam). Dovresti quindi indicare il valore di
Tolleranza in Unità del Layer, Pixel o Unità mappa da utilizzare per la semplificazione.
Più alta è la tolleranza, più vertici possono essere cancellati.

• oppure densify the geometries con nuovi vertici grazie all’opzione Lisciatura: per ogni vertice
esistente, due vertici sono posti su ciascuno dei segmenti da esso originati, ad una distanza Offset che
rappresenta la percentuale della lunghezza del segmento. Puoi anche impostare il numero di Iterazioni
con cui il posizionamento deve essere elaborato: più iterazioni, più vertici e più liscia è la geometria.

Le tue impostazioni saranno salvate quando esci da un progetto o da una sessione di modifica. In questo
modo puoi tornare agli stessi parametri la prossima volta che semplificherai una geometria.

4. In fondo alla finestra di dialogo viene mostrato un riepilogo delle modifiche applicabili, che elenca il numero
di elementi e il numero di vertici (prima e dopo l’operazione e il rapporto che la modifica rappresenta).
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Inoltre, nell’area di disegno della mappa, la geometria prevista viene visualizzata sopra quella esistente,
utilizzando il colore dell’elastico.

5. Quando la geometria stimata risponde alle tue esigenze, clicca su OK per applicare la modifica. Altrimenti,
per interrompere l’operazione, puoi premere Canc o fare clic con il tasto destro del mouse sulla mappa.

Nota: A differenza dell’opzione di semplificazione delle geometrie nel menu Impostazioni → Opzioni → Vi-

sualizzazione, che semplifica la geometria solo nella visualizzazione, lo strumento Semplifica geometria modifica
permanentemente la geometria dell’oggetto nell’origine dei dati.

Aggiungi Parte

Puoi attivare Aggiungi parte a una geometria selezionata generando una geometria multipunto, multilinea o mul-
tipoligono. La nuova parte deve essere digitalizzata al di fuori di quella esistente che deve essere selezionata in
precedenza.

Lo strumento Aggiungi parte può essere utilizzato anche per aggiungere una geometria a un oggetto senza geome-
trie. Innanzitutto, seleziona l’oggetto nella tabella degli attributi e digitalizza la nuova geometria con lo strumento

Aggiungi parte.

Elimina Parte

Lo strumento Elimina parte ti consente di eliminare parti da più geometrie (ad esempio, per eliminare i poligoni
da una geometria multi-poligono). Questo strumento funziona con tutte le geometrie a più parti: punto, linea e
poligono. Inoltre, può essere utilizzato per rimuovere completamente la componente geometrica di un oggetto.
Per eliminare una parte, basta cliccare all’interno della parte che si vuole eliminare.

Aggiungi buco

Puoi creare poligoni con buchi utilizzando l’icona Aggiungi buco nella barra degli strumenti. Ciò significa che
all’interno di un’area esistente è possibile digitalizzare ulteriori poligoni che si presentano come un “buco”, quindi
rimane solo l’area tra i confini dei poligoni esterni e interni come un poligono bucato.

Riempi buco

Lo strumento Fill Ring ti aiuta a creare una geometria poligonale che si inserisce totalmente in un’altra senza
alcuna area di sovrapposizione; questa è la nuova geometria che copre un foro all’interno di quella esistente. Per
creare una tale geometria:

1. Seleziona lo strumento Riempi buco.

2. Disegna un nuovo poligono in sovrapposizione alla geometria esistente: QGIS aggiunge un elemento alla

geometria (come se si usasse lo strumento Aggiungi buco) e crea un nuovo elemento la cui geometria

corrisponde a tale buco (come se traced lungo i confini interni con lo strumento Aggiungi elemento poligonale).

3. In alternativa, se il buco è gia presente nella geometria, posiziona il mouse sopra il buco e clicca con il tasto
sinistro del mouse mentre premi Shift: in quel punto viene disegnata una nuovo elemento che riempie il
buco.
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Si apre il modulo Attributi della nuova geometria, pre-compilata con i valori della geometria «genitore» e/o
fields constraints.

Elimina buco

Lo strumento Elimina buco ti consente di eliminare i buchi all’interno di un poligono esistente, facendo clic
all’interno del buco. Questo strumento funziona solo con geometrie poligonali e multi-poligonali. Non cambia
niente quando viene utilizzato su un anello esterno al poligono.

Modifica la forma

Puoi cambiare la forma di linee e poligoni utilizzando lo strumento Modifica la forma nella barra degli strumenti.
Per le linee, sostituisce la linea originale a partire dalla prima intersezione fino all’ultima intersezione.

Figure 13.98: Modificare la forma di vettore linea

Suggerimento: Estendere le geometrie di vettori lineari con lo strumento di modifica forma

Utilizza lo strumento Modifica la forma per estendere le geometrie esistenti di vettori lineari: aggancia al primo o
ultimo vertice della linea e disegna una nuova. Validare e la geometria del vettore è il risultato della combinazione
delle due righe.

Per i poligoni, si rimodella il bordo del poligono. Per farlo funzionare, la linea dello strumento di modifica forma
deve attraversare almeno due volte il limite del poligono. Per disegnare la riga, fare clic sulla visualizzazione della
mappa per aggiungere vertici. Per finire, basta fare clic con il pulsante destro del mouse. Come con le linee, viene
considerato solo il segmento tra le prime e le ultime intersezioni. I segmenti della linea di modifica forma che si
trovano all’interno del poligono lo ridurranno e quelli esterni al poligono lo estenderanno.

Con i poligoni, la modifica forma può talvolta portare a risultati non voluti. È principalmente utile per sostituire
le parti più piccole di un poligono, non per fare grandi cambiamenti, da notare che la linea di modifica forma non
può attraversare poligoni con buchi in quanto ciò genererebbe un poligono non valido.

Nota: Lo strumento di rimodellamento può alterare la posizione di partenza di un anello poligonale o di una
linea chiusa. Quindi, il punto che è rappresentato “due volte” non sarà più lo stesso. Questo non può essere un
problema per la maggior parte delle applicazioni, ma è qualcosa da considerare.
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Figure 13.99: Modificare la forma di vettore poligono

Curve di Offset

Lo strumento Curva di offset effettua spostamenti paralleli di layers lineari. Lo strumento può essere applicato
al layer modificato (le geometrie sono modificate) o anche ai layers di sfondo (nel qual caso crea copie delle
linee/anelli e li aggiunge al layer modificato). È quindi ideale per la creazione di layer di distanza. Viene visual-
izzata la finestra di dialogo Pannello Input Utente che mostra la distanza di spostamento.

Per creare uno spostamento di un vettore linea, devi entrare in modalità di modifica e attivare lo strumento
Curva di offset. Quindi fai click su una geometria per spostarla. Sposta il mouse e fai clic su dove vuoi oppure anche

immetti la distanza desiderata nel widget di input dell’utente. Puoi salvare le modifiche con lo strumento
Salva modifica vettore.

La finestra di dialogo Opzioni di QGIS (scheda Digitalizzazione quindi sezione Strumento per la curva di offset)
ti consente di configurare alcuni parametri come lo Stile unione, i Segmenti di quadrante, il Limite di smusso.

Spezza Elementi

Usa lo strumento Spezza elementi per dividere una geometria in due o più geometrie nuove e indipendenti, cioè
ogni geometria corrisponde ad una nuova riga della tabella degli attributi.

Per dividere una linea o un poligono:

1. Seleziona lo strumento Dividi geometrie.

2. Disegna una linea tra le geometrie che vuoi dividere. Se una selezione è attiva, solo le geometrie selezionate
vengono suddivise. Quando impostato, default values or clauses sono applicate ai campi corrispondenti e
altri attributi della geometria principale sono copiati di default nelle nuove geometrie.

3. Puoi quindi modificare, come al solito, uno qualsiasi degli attributi di qualsiasi geometria risultante.

Suggerimento: Dividere una polilinea in nuove geometrie con un solo clic

Usando lo strumento Spezza elementi, aggancia e clicca su un vertice esistente di una polilinea per dividere tale
geometria in due nuove geometrie.
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Dividi Parti

In QGIS è possibile dividere le parti di una geometria a più parti di modo che il numero di parti viene aumentato.

Basta disegnare una riga sulla parte che desideri dividere usando l’icona Dividi parti.

Suggerimento: Dividere una polilinea in nuove geometrie con un solo clic

Utilizzando lo strumento Dividi parti, aggancia e clicca su un vertice esistente di una geometria di una polilinea
per dividere la geometria in due nuove polilinee appartenenti alla stessa geometria.

Fondi elementi selezionati

Lo strumento Unisci gli elementi selezionati ti consente di creare una nuova geometria unendo quelle esistenti: le loro
geometrie vengono unite per generarne una nuova. Se le geometrie non hanno confini comuni, viene creata una
geometria multipoligono/multilinea/multipunti.

1. Per prima cosa seleziona le geometrie che vuoi combinare.

2. Poi premi il pulsante Unisci gli elementi selezionati.

3. Nella nuova finestra di dialogo, la scritta Fondi(Merge) in fondo alla tabella mostra gli attributi della ge-
ometria risultante. Puoi modificare uno qualsiasi di questi valori:

• sostituendo manualmente il valore nella cella corrispondente;

• selezionando una riga nella tabella e premendo Prendi gli attributi dall’elemento selezionato per uti-
lizzare i valori di questa geometria;

• premendo Salta tutti i campi per utilizzare attributi vuoti;

• oppure, espandendo il menu a tendina nella parte superiore della tabella, seleziona una qualsiasi delle
opzioni di cui sopra da applicare solo al campo corrispondente. Qui, puoi anche scegliere di ag-
gregare gli attributi iniziali delle geometrie (Minimo, Massimo, Mediano, Somma, Conteggio, Con-
catenazione. . . .. a seconda del tipo di campo. vedi Pannello Statistiche per l’elenco completo delle
funzioni).

Nota: Se il layer ha valori predefiniti o contenuti presenti nei campi, questi sono usati come valori iniziali
per la geometria risultante dalla fusione.

4. Premi OK per applicare le modifiche. Una singola (multi)geometria viene creata nel layer, sostituendo
quelle precedentemente selezionate.

Fondi gli attributi degli elementi selezionati (merge)

Lo strumento Unire gli attributi degli elementi selezionati ti consente di applicare gli stessi attributi agli elementi senza
fondere i loro confini. La finestra di dialogo è la stessa del precedente strumento Unisci gli elementi
selezionati ma a differenza di quello strumento, gli oggetti selezionati vengono mantenuti con la loro ge-
ometria mentre alcuni dei loro attributi vengono resi identici.

Ruota Simboli del Punto

Ruota i simboli del punto ti permette di cambiare la rotazione dei simboli puntuali nella mappa.

1. Per prima cosa, applica al simbolo una rotazione data-defined:
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(a) Nella finestra di dialogo Proprietà vettore → Simbologia, seleziona la finestra di dialogo dell’editor
dei simboli.

(b) Fai clic sul widget Sovrascrittura definita dai dati vicino (preferibilmente) all’opzione Rotazione
del livello superiore dei livelli del Simbolo.

(c) Scegli un campo nella casella combinata Tipo di campo. I valori di questo campo sono quindi utilizzati
per ruotare ogni simbolo di ciascun elemento.

Nota: Assicurarsi di assegnare lo stesso campo a tutti i layer di simboli

L’impostazione del campo di rotazione definito dai dati al livello più alto dell’albero dei simboli lo propaga
automaticamente a tutti i livelli dei simboli, un prerequisito per eseguire la rotazione dei simboli grafici con
lo strumento Ruota i simboli del punto. Infatti, se un livello simbolo non ha lo stesso campo collegato alla
sua proprietà di rotazione, lo strumento non funzionerà.

Figure 13.100: Ruotare un simbolo puntuale

2. Quindi fai clic su un punto della mappa con Ruota i simboli del punto e muovi il mouse tenendo premuto il
tasto sinistro. Verrà visualizzata una freccia rossa con il valore di rotazione (vedi Figure_rotate_point).

3. Rilascia nuovamente il pulsante sinistro del mouse, il simbolo viene definito con questa nuova rotazione e
il campo di rotazione viene aggiornato nella tabella degli attributi del layer.

Suggerimento: Se si tiene premuto il tasto Ctrl, la rotazione avverrà per step di 15 gradi.

Offset dei simboli per i punti

Lo strumento Simbolo del punto di offset ti consente di modificare in modo interattivo la posizione di visualizzazione

di simboli puntuali nella mappa. Questo strumento si comporta come lo strumento Ruota i simboli del punto salvo
che richiede di connettere un campo al dato definito in Offset (X, Y) del simbolo, campo che verrà quindi popolato
con le coordinate di offset mentre si sposta il simbolo nell’area di visualizzazione mappa.

Nota: Lo strumento Ruota i simboli del punto non sposta il punto stesso; dovresti usare lo strumento
Strumento Vertice (vettore corrente) o lo strumento Muovi elemento(i) per questo scopo.
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13.5.5 Digitalizzare forme

La Barra degli strumenti di digitalizzazione di forme offre una serie di strumenti per disegnare forme regolari e
geometrie curve.

Aggiungere arco circolare

I pulsanti Aggiungi arco circolare o Aggiungi arco circolare dal raggio permettono agli utenti di aggiungere linee o
poligoni con geometria circolare.

La creazione di geometrie con questi strumenti segue la stessa regola degli altri strumenti di digitalizzazione:
clicca con il tasto sinistro per posizionare i vertici e con il tasto destro del mouse per completare la geometria.
Durante il disegno della geometria, puoi passare da uno strumento all’altro e agli strumenti geometria lineare,
creando delle geometrie composte.

Nota: Le geometrie curve vengono memorizzate come tali solo nei gestori di dati compatibili

Anche se QGIS consente di digitalizzare geometrie curve in qualsiasi formato di dati modificabile, è necessario
utilizzare un gestore di dati (ad esempio PostGIS, gestore layer in memoria, GML o WFS) che supporta le curve
per memorizzare le geometrie come curve, altrimenti QGIS segmentizza gli archi circolari.

13.5.6 Il Pannello di Digitalizzazione Avanzata

Durante la cattura, la rimodellazione, la suddivisione delle geometrie nuove o esistenti, puoi anche utilizzare il
pannello Digitalizzazione Avanzata. Puoi digitalizzare linee esattamente parallele o perpendicolari ad una parti-
colare angolazione o bloccare le linee ad angoli specifici. Inoltre, puoi immettere direttamente le coordinate così
da poter definire in modo preciso la nuova geometria.

Figure 13.101: Il Pannello di Digitalizzazione Avanzata

Il pannello Digitalizzazione Avanzata può essere aperto sia con un clic destro sulla barra degli strumenti, dal menu

Visualizza → Pannelli → o premendo Ctrl+4. Una volta che il pannello è visibile, fai clic sul pulsante
Abilita strumenti di digitalizzazione avanzata per attivare l’insieme di strumenti.

Nota: Gli strumenti non sono abilitati se la visualizzazione mappa è in coordinate geografiche.
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Concetti

Lo scopo dello strumento di Digitalizzazione Avanzata è quello di bloccare le coordinate, le lunghezze e gli angoli
quando si sposta il mouse durante la digitalizzazione nella area di visualizzazione mappa.

Puoi inoltre creare vincoli con riferimenti relativi o assoluti. Il riferimento relativo significa che i successivi valori
dei vincoli saranno relativi al vertice o al segmento precedente.

Impostazioni di aggancio

Fai click sul pulsante per definire le impostazioni dello strumento Digitalizzazione Avanzata. Puoi utilizzare
lo strumento di aggancio ai comuni angoli. Le opzioni sono:

• Non agganciare agli angoli comuni

• Agganciare agli angoli 30°

• Agganciare agli angoli 45°

• Agganciare agli angoli 90°

Puoi anche controllare le modalità di aggancio alle geometrie. Le opzioni sono:

• Non agganciare a vertici o segmenti

• Agganciare in base alle impostazioni del progetto

• Agganciare su tutti i layer

Tasti di scelta rapida

Per velocizzare l’uso del pannello di Digitalizzazione Avanzata, sono disponibili un paio di scorciatoie da tastiera:

Chi-
ave

Semplice Ctrl+ o Alt+ Shift+

D Impostare distanza Bloccare distanza
A Impostare angolo Bloccare angolo Attivare l’angolo riferito all’ultimo seg-

mento
X Impostare la coordinata

X
Bloccare la coordinata
X

Spostare la posizione X all’ultimo vertice

Y Impostare la coordinata
Y

Bloccare la coordinata
Y

Spostare la posizione Y all’ultimo vertice

C Attivare modalità costruzione
P Attivare modalità perpendicolare e parallela

Digitalizzazione a riferimento assoluto

Quando si disegna una nuova geometria da zero, è molto utile avere la possibilità di avviare la digitalizzazione dei
vertici in corrispondenza di determinate coordinate.

Ad esempio, per aggiungere una nuovo elemento a un layer poligonale, fai click sul pulsante . Puoi scegliere
le coordinate X e Y da cui vuoi iniziare a modificare la geometria, quindi:

• Fai click sulla casella di testo x (o usa la scorciatoia da tastiera X).

• Immetti il valore della coordinata X desiderato e premi Invio oppure fai click sul pulsante a destra per
bloccare il mouse sull’asse X sulla mappa.

• Fai click sulla casella di testo y (o usa la scorciatoia da tastiera Y).
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• Immetti il valore della coordinata Y desiderato e premi Invio oppure fai click sul pulsante a destra per
bloccare il mouse sull’asse Y sulla mappa.

Due linee tratteggiate in blu e una croce verde identificano le coordinate esatte che hai immesso. Inizia la digital-
izzazione facendo clic sulla mappa; la posizione del mouse è bloccata alla croce verde.

Figure 13.102: Iniziare a tracciare da coordinate scelte

Puoi continuare la digitalizzazione a mano libera, aggiungere una nuova coppia di coordinate oppure digitare la
lunghezza (distanza) e l” angolo del segmento.

Se vuoi disegnare un segmento di una data lunghezza, fai clic sulla casella d (distanza) (scorciatoia da tastiera

d), digita il valore della distanza (in unità di mappa) e premi Invio oppure fai clic sul pulsante a destra
per bloccare il mouse sulla mappa alla lunghezza del segmento. Nella visualizzazione mappa, il punto cliccato è
circondato da un cerchio il cui raggio è il valore immesso nella casella di testo distanza.

Figure 13.103: Segmento di lunghezza fissata

Infine, puoi anche scegliere l’angolo del segmento. Come descritto in precedenza, fai clic sulla casella di testo
a (angolo) (scorciatoia da tastiera a), digitare il valore dell’angolo (in gradi) e premi Invio oppure fai clic sul
pulsante a destra per bloccarlo. In questo modo il segmento forma l’angolo desiderato:

Digitalizzazione di riferimento relativo

Invece di utilizzare valori assoluti di angoli o coordinate, puoi anche utilizzare valori relativi all’ultimo vertice o
segmento digitalizzato.
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Figure 13.104: Segmento ad angolo fissato

Per gli angoli, puoi fare clic sul pulsante a sinistra della casella di testo a (o premi Shift+A) per attivare
angoli relativi al segmento precedente. Con questa opzione, gli angoli vengono misurati tra l’ultimo segmento e il
puntatore del mouse.

Per le coordinate, fai clic sui pulsanti a sinistra dei pulsanti x o y (oppure premi Shift+X o Shift+Y) per
attivare le coordinate relative al vertice precedente. Con queste opzioni attivate, la misurazione delle coordinate
considererà l’ultimo vertice come origine degli assi X e Y.

Blocco continuo

Sia in riferimento assoluto che relativo, la digitalizzazione, l’angolo, la distanza, i vincoli x e y possono essere

bloccati in modo continuo facendo clic sui pulsanti Blocco continuo. L’utilizzo di blocco continuo ti consente
di digitalizzare più punti o vertici utilizzando gli stessi vincoli.

Linee parallele e perpendicolari

Tutti gli strumenti sopra descritti possono essere combinati con gli strumenti Perpendicolare e Parallelo. Questi
due strumenti consentono di disegnare segmenti perfettamente perpendicolari o paralleli ad un altro segmento.

Per disegnare un segmento perpendicolare, durante la modifica fai clic sull’icona Perpendicolare (scorciatoia
da tastiera p) per attivarla. Prima di disegnare la linea perpendicolare, fai clic sul segmento di una geometria
esistente alla quale desideri essere perpendicolari (la linea della geometria esistente verrà colorata in arancio
chiaro); dovresti vedere una linea punteggiata blu dove verrà attivata la tua geometria.

Per disegnare una geometria parallela, i passaggi sono gli stessi: fai clic sull’icona Parallelo (scorciatoia da
tastiera doppio p), fai clic sul segmento che vuoi utilizzare come riferimento e inizia a disegnare la tua geometria.

Solo questi due strumenti determinano l’angolo corretto perpendicolare e parallelo e bloccano questo parametro
durante la modifica.

Modalità di costruzione

Puoi attivare e disattivare la modalità costruzione cliccando sull’icona Modalità di costruzione o con la scorciatoia da
tastiera c. Mentre si è in modalità di costruzione, cliccando sulla mappa non verranno aggiunti nuovi vertici, ma
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Figure 13.105: Digitalizzare in perpendicolare

Figure 13.106: Digitalizzare in parallelo
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si cattureranno le posizioni dei clic, in modo che possano essere utilizzate come punti di riferimento per bloccare
i valori relativi a distanza, angolo o X e Y.

Ad esempio, la modalità di costruzione può essere usata per disegnare un certo punto in una distanza esatta da un
punto esistente.

Con un punto esistente nella mappa e la modalità di aggancio correttamente attivata, puoi disegnare facilmente
altri punti a determinate distanze e angoli da esso. Oltre al pulsante , devi attivare anche la modalità costruzione

facendo clic sull’icona Modalità di costruzione o con la scorciatoia da tastiera c.

Fai clic accanto al punto dal quale vuoi calcolare la distanza e fai click sulla casella d (d scorciatoia), digita la
distanza desiderata e premi Invio per bloccare la posizione del mouse nella mappa:

Figure 13.107: Distanza da un punto

Prima di aggiungere il nuovo punto, premi c per uscire dalla modalità di costruzione. Adesso puoi cliccare sulla
mappa e il punto verrà posizionato alla distanza immessa.

Puoi anche utilizzare il vincolo di angolo per creare, ad esempio, un altro punto alla stessa distanza dell’originale,

ma ad un angolo particolare dal punto appena aggiunto. Fai clic sull’icona Modalità di costruzione o con la scorcia-
toia da tastiera c per accedere alla modalità di costruzione. Fai click sul punto aggiunto di recente, quindi sull’altro
per impostare un segmento di direzione. Quindi fai clic sulla casella di testo d (d la scorciatoia da tastiera), digita
la distanza desiderata e premi Invio. Fai clic sulla casella di testo a (la scorciatoia da tastiera a) digitare l’angolo
desiderato e premere Invio. La posizione del mouse sarà bloccata sia in distanza che in angolo.

Prima di aggiungere il nuovo punto, premi c per uscire dalla modalità di costruzione. Adesso puoi cliccare sulla
mappa e il punto verrà posizionato alla distanza e all’angolo inserito. Ripetendo il processo, è possibile aggiungere
più punti.

13.5.7 Il processamento di modifiche al layer sul posto

Processing menu fornisce accesso ad un ampio set di strumenti per analizzare e creare nuove geometrie in base
alle proprietà delle geometrie di input o alle loro relazioni con altre geometrie (all’interno dello stesso layer o
meno). Mentre il comportamento comune è quello di creare nuovi layer come output, alcuni algoritmi permettono
anche di modificare il layer di input. Questo è un modo pratico per automatizzare la modifica di più geometrie
utilizzando operazioni avanzate e complesse.

Modificare geometrie sul posto:

1. Seleziona il layer da modificare nel pannello Layer.

2. Seleziona le geometrie interessate. Puoi saltare questo passaggio, nel qual caso la modifica si applicherà a
tutto il layer.
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Figure 13.108: Distanza ed angolo fra punti

Figure 13.109: Punti a distanza ed angolo fissato
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3. Premi il pulsante Modifica elementi sul posto nella parte superiore del Processing toolbox. L’elenco degli algo-
ritmi è filtrato, mostrando solo quelli compatibili con le modifiche sul-posto, ad esempio:

• Lavorano a livello della geometria e non a livello di layer.

• Non cambiano la struttura del layer, ad esempio aggiungendo o rimuovendo campi.

• Non cambiano il tipo di geometria, ad esempio da layer lineare a layer puntuale.

Figure 13.110: Algoritmi di elaborazione: tutti (sinistra) e modifiche sul posto di vettore poligonale (destra)

4. Trova l’algoritmo che vuoi eseguire e fai doppio clic su di esso.

Nota: Se l’algoritmo non necessita di parametri aggiuntivi impostati dall’utente (esclusi i soliti parametri
del layer di ingresso e di uscita), l’algoritmo viene eseguito immediatamente senza comparsa di finestre di
dialogo.

(a) Se sono necessari parametri diversi dai consueti layer di ingresso o di uscita, si apre la finestra di
dialogo dell’algoritmo. Compila le informazioni richieste.

(b) Fai clic su Modifica elementi selezionati o Modifica tutti gli elementi a seconda della selezione attiva.

Le modifiche vengono applicate al layer inserite nel buffer di modifica: il layer viene infatti commutato in

modalità di modifica con modifiche non salvate come indicato dall’icona accanto al nome del layer.
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5. Come al solito, premi Salva modifiche layer per effettuare il commit dei cambiamenti nel layer. Puoi anche

premere Annulla per annullare tutte la modifiche.
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CHAPTER 14

Lavorare con i dati raster

14.1 Proprietà raster

Per visualizzare e impostare le proprietà di un layer raster, fai doppio clic sul nome del layer nella legenda della
mappa, oppure fai clic con il tasto destro del mouse sul nome del layer e scegli Proprietà dal menu contestuale.
In questo modo si aprirà la finestra di dialogo Proprietà layer

Ci sono diverse schede nella finestra di dialogo:

• Information

• Source

• Symbology

• Transparency

• Histogram

• Rendering

• Pyramids

• Metadata

• Legend

• QGIS Server

Suggerimento: Aggiornamenti in tempo reale

Il pannello Pannello Stile Layer ti fornisce alcune delle caratteristiche comuni della finestra di dialogo Proprietà
layer ed è uno strumento semplice che puoi utilizzare per velocizzare la configurazione degli stili del layer e
automaticamente visualizzare le modifiche apportate alla mappa.

Nota: Poiché le proprietà (simbologia, etichetta, azioni, valori predefiniti, moduli. . . ) dei layer nidificati (vedi
Progetti nidificati) vengono estratte dal progetto originale, per evitare modifiche che potrebbero interrompere

323



QGIS User Guide, Release 3.4

questo comportamento, la finestra di dialogo Proprietà Layer non è disponibile per questi layer.

14.1.1 Proprietà Informazioni

La scheda Informazioni è di sola lettura e rappresenta un posto interessante per avere rapidamente infor-
mazioni e metadati riassunti sul layer corrente. Le informazioni fornite sono:

• in base alla fonte dati del layer (formato di memorizzazione, percorso, tipo di dati, estensione,
larghezza/altezza, compressione, dimensione dei pixel, statistiche sulle bande, numero di colonne, numero
di righe e valore per nessun dato del raster. . . .);

• prelevate da filled metadata: accesso, link, contatti, storico. . . .. nonché informazioni sui dati (SR, Esten-
sione, Bande. . . .).

14.1.2 Proprietà Sorgente

La scheda Sorgente mostra le informazioni di base sul raster selezionato, inclusi:

• Il Nome layer da visualizzare nel Pannello Layer;

• Imposta Sistema di Riferimento coordinate sorgente: Visualizza il sistema di riferimento delle coordinate
(SR) del layer come stringa PROJ.4. Puoi cambiare il SR del layer, selezionandone uno usato di recente

nell’elenco a discesa o cliccando su Selettore Sistema di Riferimento delle Coordinate (vedi Scelta del sistema di
riferimento delle coordinate). Usa questo processo solo se il SR applicato al layer è sbagliato o se non è
stato applicato. Se vuoi riproiettare i tuoi dati in un altro SR, usa piuttosto gli algoritmi di riproiezione dei
layer di Processing o Save it into another layer.

Figure 14.1: Layer Raster- Finestra di dialogo Proprietà Sorgente

14.1.3 Proprietà Simbologia

Visualizzazione banda

QGIS offre cinque Tipo visualizzazione. La scelta dipende dal tipo di dato.
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1. Multiband color - se il file viene fornito come multibanda con diverse bande (ad esempio, usato con
un’immagine satellitare con diverse bande).

2. Paletted/Unique values - per file a banda singola con tavolozza indicizzata (ad esempio, usata con una
mappa topografica digitale) o per l’uso generale delle tavolozze per la visualizzazione di layer raster.

3. Singleband gray - (una banda) l’immagine sarà visualizzata in grigio; QGIS sceglierà questa visualizzazione
se il file non ha né multibande né una tavolozza indicizzata né una tavolozza continua (ad esempio, usata
con mappa in rilievo ombreggiata).

4. Singleband pseudocolor - questa visualizzazione è possibile per i file con una tavolozza continua, o una
mappa a colori (ad esempio, usata con una mappa altimetrica).

5. Hillshade - Crea una ombreggiatura da una banda.

Colori Banda Multipla

Con la visualizzazione colore multibanda, verranno visualizzate le tre bande selezionate dall’immagine, ogni
banda rappresenta la componente rossa, verde o blu che verrà utilizzata per creare un’immagine a colori. QGIS
recupera automaticamente i valori Min e Max per ogni banda del raster e scala la colorazione di conseguenza.
Puoi controllare gli intervalli di valori con l’aiuto della sezione Min/Max Value Settings.

Può anche essere applicato un metodo Miglioramento contrasto ai valori: “Nessun miglioramento”, “Stira a Min-
Max”, “Stira e taglia a MinMax” e “Taglia a MinMax”.

Nota: Miglioramento contrasto

Quando si aggiungono raster GRASS, l’opzione Miglioramento del contrasto sarà sempre impostata automatica-
mente su Stira a MinMax, indipendentemente dal fatto che sia impostata su un altro valore nelle opzioni generali
di QGIS.

Suggerimento: Visualizzare una singola banda di un raster multibanda

Se vuoi visualizzare una singola banda di un’immagine multibanda (ad esempio, Rossa), potresti pensare di im-
postare le bande Verde e Blu su Non impostato. Ma questo non è il modo corretto. Per visualizzare la banda rossa,
impostare il tipo di immagine su Singleband gray, quindi selezionare Rosso come Banda grigio da utilizzare.

Valori a tavolozza/Univoci

This is the standard render option for singleband files that include a color table, where a certain color is assigned
to each pixel value. In that case, the palette is rendered automatically.

It can be used for all kinds of raster bands, assigning a color to each unique raster value.

If you want to change a color, just double-click on the color and the Select color dialog appears.

It is also possible to assign labels to the colors. The label will then appear in the legend of the raster layer.

Right-clicking over selected rows in the color table shows a contextual menu to:

• Change Color. . . for the selection

• Change Opacity. . . for the selection

• Change Label. . . for the selection

The pulldown menu, that opens when clicking the . . . (Advanced options) button below the color map to the right,
offers color map loading (Load Color Map from File. . . ) and exporting (Export Color Map to File. . . ), and loading
of classes (Load Classes from Layer).
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Figure 14.2: Simbologia Raster - Visualizzazione colore multibanda

Banda singola grigia

Questa visualizzazione ti permette di visualizzare un singolo layer di banda con un Gradiente colore: “Da nero a
bianco” o “Da bianco a nero”. Puoi definire un intervallo di valori per il colore diverso dai valori predefiniti Min
e Max dell’intero raster, grazie all’opzione Min/Max Value Settings.

Anche in questo caso, puoi applicare ai valori un Miglioramento contrasto: “Nessun miglioramento”, “Stira a
MinMax”, “Stira e taglia a MinMax” e “Taglia a MinMax”.

Banda singola falso colore

This is a render option for single-band files that include a continuous palette. You can also create color maps for
a bands of a multiband raster.

Usando una Banda singola falso colore per il layer e un values range, sono disponibili tre tipi di Interpolazione
del colore:

• Discreto (nella colonna Valore <= viene visualizzata un simbolo)

• Lineare

• Esatto (nella colonna Valore <= viene visualizzato un simbolo corrispondente)

L’elenco a discesa Scala di colori elenca la scala di colore nel tuo QGIS. Puoi aggiungerne una nuova, modificare
o salvare quella che hai cambiato. Il nome della scala di colore sarà salvato nella configurazione e nei file QML.

La Unità etichetta suffisso è un’etichetta aggiunta dopo il valore nella legenda.

Per la classificazione Moda “Intervallo uguale”, devi solo selezionare il numero di Classi e premere

il pulsante Classifica. Nel caso di Moda “Continuo”, QGIS crea automaticamente le classi a seconda di
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Figure 14.3: Simbologia Raster - Visualizzazione valori a tavolozza univoci

Figure 14.4: Simbologia Raster - Visualizzazione banda singola grigia
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Figure 14.5: Simbologia Raster - Visualizzazione banda singola falso colore
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Min e Max.

Il pulsante Aggiungi valori manualmente aggiunge un valore alla singola tabella colori. Il pulsante
Rimuovi la/le righe selezionate cancella un valore dalla singola tabella colori. Facendo doppio clic sulla colonna dei valori
è possibile inserire un valore specifico. Facendo doppio clic sulla colonna colore si apre la finestra di dialogo
Cambia colore, dove è possibile selezionare un colore da applicare a quel valore. Inoltre, è anche possibile ag-
giungere etichette per ogni colore, ma questo valore non verrà visualizzato quando si utilizza lo strumento di
identificazione.

Right-clicking over selected rows in the color table shows a contextual menu to:

• Change Color. . . for the selection

• Change Opacity. . . for the selection

You can use the buttons Load color map from file or Export color map to file to load an existing color table or to save
the color table for later use.

La Ritaglia valori dell’intervallo permette a QGIS di non visualizzare il pixel maggiore del valore Max.

Ombreggiatura

Visualizzare una banda di un layer Raster usando l’ombreggiatura

Figure 14.6: Simbologia Raster - Visualizzazione ombreggiatura

Opzioni:

• Banda: La banda del raster da usare.

• Altitudine: L’angolo di elevazione della sorgente luminosa (il valore predefinito è 45°).

• Azimuth: L’azimut della sorgente luminosa (il valore predefinito è 315°).

• Fattore Z: Fattore di scala per i valori della banda raster (il valore predefinito è 1).

• Multidirezionale: Specifica se deve essere usata l’ombreggiatura multidirezionale (il valore predefinito
è off`).

14.1. Proprietà raster 329



QGIS User Guide, Release 3.4

Impostazione dei valori min e max

Per impostazione predefinita, QGIS imposta i valori Min e Max della(e) banda(e) del raster. Alcuni valori molto
bassi e/o alti possono avere un impatto negativo sulla visualizzazione del raster. Il menu Min/Max Value Settings
ti aiuta a controllare i valori della visualizzazione.

Figure 14.7: Simbologia Raster - Impostazione dei valori Min e Max

Sono disponibili le opzioni:

• Definito dall’utente: I valori predefiniti Min e Max della(e) banda(i) possono essere sovrascritti.

• Taglio conteggio Cumulativo: Rimuove i valori estremi. L’intervallo standard dei valori è compreso tra
2% e 98%, ma può essere adattato manualmente.

• Min/max: Utilizza l’intera gamma di valori nella banda dell’immagine.

• Media +/- deviazione standard x: Crea una tabella colori che considera solo i valori all’interno della
deviazione standard o all’interno di deviazioni standard multiple. Questo è utile quando si hanno una o
due celle con valori anormalmente alti in una griglia raster che stanno creando un impatto negativo sulla
visualizzazione del raster.

Il calcolo dei valori minimi e massimi delle bande viene effettuato in base a:

• Statistics extent: it can be Whole raster, Current canvas or Updated canvas. Updated canvas means that
min/max values used for the rendering will change with the canvas extent (dynamic stretching).

• Accuracy, which can be either Estimate (faster) or Actual (slower).

Nota: Per alcune impostazioni, potrebbe essere necessario premere il pulsante Applica della finestra di dialogo
delle proprietà del layer per visualizzare i valori minimi e massimi effettivi nei widget.

Visualizzazione colore

Per ogni Visualizzazione banda, è disponibile una Visualizzazione colore.

Puoi anche ottenere effetti speciali per i tuoi file(s) raster usando una delle modalità di fusione (vedi Metodi di
fusione).

Ulteriori impostazioni possono essere fatte modificando la Luminosità, la Saturazione e il Contrasto. Puoi usare
anche l’opzione Scala di grigi dove puoi scegliere fra ‘Per chiarezza’, ‘Per luminosità’ e ‘Per media’. Puoi
modificare la ‘Forza’ per ogni tonalità della tabella dei colori.
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Ricampionamento

La sezione Ricampionamento ha effetto quando ingrandisci o rimpicciolisci l’immagine. I metodi di ricampiona-
mento ottimizzano l’aspetto della mappa perché calcolano una nuova matrice di grigi attraverso una trasformazione
geometrica.

Figure 14.8: Simbologia Raster - Visualizzazione del colore e impostazioni del Ricampionamento

Applicando il metodo “Vicino più prossimo” la mappa potrebbe avere un aspetto pixellato quando viene in-
grandita. Questo aspetto può essere migliorato usando i metodi “Bilineare” o “Cubico” perché creano la sfocatura
dei dettagli grafici. Il risultato è un’immagine più omogenea. Puoi applicare questo metodo, per esempio, a mappe
raster topografiche.

Nella parte inferiore della scheda Simbologia, puoi vedere una miniatura del layer, della legenda e della tavolozza.

14.1.4 Proprietà Trasparenza

QGIS ha la possibilità di visualizzare ogni layer del raster con un diverso livello di trasparenza. Usa il

cursore trasparenza per indicare in che misura i layer sottostanti (se presenti) dovrebbero
essere visibili attraverso il layer raster corrente. Questo è molto utile se vuoi sovrapporre più di un layer raster (ad
esempio, una mappa in rilievo ombreggiata sopra una mappa raster classificata). Questo renderà l’aspetto della
mappa più tridimensionale.

Inoltre puoi inserire un valore del dato raster che deve essere trattato come NODATA con la opzione Valori nulli
aggiuntivi.

Un modo ancora più flessibile per personalizzare la trasparenza può essere fatto nella sezione Opzioni di
trasparenza personalizzate:

• Usa Banda trasparenza per applicare la trasparenza su un’intera banda.

• Fornisci un elenco di pixel per impostare la trasparenza con il corrispondente livello di trasparenza:

1. Clicca sul pulsante Aggiungi valori manualmente. Apparirà cosi una nuova riga.

2. Inserisci i valori Rosso, Verde e Blu del pixel e regola la Percentuale Trasparenza da applicare.

3. In alternativa, puoi recuperare direttamente i valori dei pixel dal raster utilizzando il pulsante
Aggiungi valori dal display. Quindi inserisci il valore di trasparenza.

4. Ripeti i passi per regolare più valori con una trasparenza personalizzata.

5. Premi il pulsante Applica e dai una controllata alla mappa.

Come puoi vedere è molto semplice impostare una trasparenza personalizzata, però richiede comunque un

po’ di lavoro. Proprio per questo puoi usare il pulsante Esporta su le per salvare la lista dei valori su un

le esterno. Il pulsante Importa da file ti permette di caricare le impostazioni di trasparenza e applicarle al
raster selezionato.
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Figure 14.9: Trasparenza Raster

14.1.5 Proprietà Istogramma

La scheda Istogramma ti permette di visualizzare la distribuzione delle bande o dei colori nel tuo raster.
L’istogramma viene generato quando si preme il pulsante Applica. Tutte le bande esistenti saranno visualizzate

insieme. È possibile salvare l’istogramma come immagine con il pulsante .

Nella parte inferiore dell’istogramma, puoi selezionare una banda raster nel menu a discesa e Imposta stile

min/max per. Il menu a discesa Preferiti/Azioni offre opzioni avanzate per personalizzare l’istogramma:

• Con l’opzione Visibilità puoi visualizzare gli istogrammi delle singole bande. Devi selezionare l’opzione

Mostra la banda selezionata.

• Le Opzioni Min/max permettono di “Mostra sempre i simboli min/max”, “Zoom a min/max” e “Aggiorna
stile a min/max”.

• L’opzione Azioni ti permette di effettuare il “Ripristino” o il “Ricalcolo istogramma” dopo che hai cambiato
i valori minimi o massimi della banda (o delle bande).

14.1.6 Proprietà Visualizzazione

Nella scheda Visualizzazione, è possibile:

• applicare al layer una Visibilità dipendente dalla scala. Puoi impostare la scala Massimo (incluso) e Minimo
(escluso), definendo un intervallo di scala in cui il layer sarà visibile. Al di fuori di questo intervallo, è

nascosto. Il pulsante Imposta alla scala corrente dell’estensione della mappa ti aiuta ad utilizzare la scala della mappa
corrente come limite della visibilità dell’intervallo. Vedi Visualizzazione in funzione della scala per ulteriori
informazioni.

• Aggiorna i layer a intervalli (secondi): imposta un timer per aggiornare automaticamente i singoli layer ad
un intervallo corrispondente. Gli aggiornamenti delle mappe sono posticipati per evitare di aggiornare più

332 Chapter 14. Lavorare con i dati raster



QGIS User Guide, Release 3.4

Figure 14.10: Istogramma del raster
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volte se più di un layer ha impostato un intervallo di aggiornamento automatico.

Puoi impostare la scala a Massimo (incluso) e Minimo (escluso), definendo un intervallo di scala in cui il layer sarà

visibile. Fuori di questo intervallo, il layer sarà nascosto. Il pulsante Imposta alla scala corrente dell’estensione della mappa ti
consente di utilizzare la scala corrente della mappa come limite di visibilità del raster. Per maggiori informazioni
vedi Visualizzazione in funzione della scala.

Figure 14.11: Visualizzazione Raster

14.1.7 Proprietà Piramidi

I raster ad alta risoluzione possono rallentare notevolmente il lavoro in QGIS. Creando copie a bassa risoluzione
dei dati (piramidi) puoi incrementare notevolmente le prestazioni in quanto QGIS sceglierà la risoluzione migliore
in funzione del fattore di zoom.

Per creare piramidi devi avere i permessi di scrittura nella cartella contenente il dato originale: in questa cartella
verranno salvate le copie a bassa risoluzione.

Dall’elenco Risoluzioni, seleziona le risoluzioni per le quali si desidera creare la piramide facendo clic su di esse.

Se scegli Interno (se possibile) dal menu a tendina Formato panoramica, QGIS proverà a costruire le piramidi
internamente.

Nota: La costruzione delle piramidi può alterare il dato originale in maniera irreversibile, quindi ti raccomandi-
amo di fare una copia del raster originale prima di eseguire l’operazione.

Se scegli Esterno e Esterno (immagine Erdas) le piramidi verranno create in un file accanto al raster originale
con lo stesso nome e un’estensione .ovr.

Diversi metodi di Ricampionamento possono essere utilizzati per calcolare le piramidi:

• Vicino più prossimo (metodo Nearest Neighbour)

• Media

• Gauss

• Cubico

• Spline Cubica
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• Laczos

• Moda

• Nessuno

Infine, fai clic su Costruisci piramidi per avviare il processo.

Figure 14.12: Piramidi raster

14.1.8 Proprietà Metadati

La scheda Metadati ti fornisce le opzioni per creare e modificare un report dei metadati sul tuo layer. Vedi
vector layer metadata properties per ulteriori informazioni.

14.1.9 Proprietà Legenda

La scheda Legenda ti fornisce una lista di widget che puoi inserire all’interno dell’albero dei layer nel Pannello
Layer. L’idea è quella di avere un modo per accedere rapidamente ad alcune azioni che sono spesso usate con il
layer (impostazioni trasparenza, filtraggio, selezione, stile o altre cose. . . .).

Per impostazione predefinita, QGIS fornisce il widget di trasparenza ma a questa opzione possono aggiungersi i
widget dei plugin che hanno propri widget e assegnano azioni personalizzate ai layer che gestiscono.

14.1.10 Proprietà Server QGIS

La scheda QGIS Server mostra una grande quantità di informazioni sul layer raster, incluse le statistiche su
ogni banda del layer raster corrente. In questa scheda, è possibile inserire le voci per Descrizione, Assegnazione,
URL Metadati e URL Legenda. In Proprietà, le statistiche sono raccolte sulla base del “bisogno di sapere”, quindi
può darsi che le statistiche di un dato layer non siano ancora state raccolte.
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Figure 14.13: QGIS Server nelle Proprietà Raster

14.2 Analisi raster

14.2.1 Calcolatore raster

Il Calcolatore raster. . . . nel menu Raster ti consente di eseguire calcoli sulla base dei valori dei pixel esistenti nel
raster (vedi figure_raster_calculator). I risultati vengono scritti in un nuovo raster con un formato supportato da
GDAL

La lista Bande raster elenca i raster caricati che possono essere utilizzati. Per aggiungere un raster nella fines-
tra Espressione del calcolatore di raster, fai doppio click sul suo nome nella finestra Bande raster. Puoi usare
gli operatori per costruire un’espressione oppure puoi scriverla direttamente nella finestra delle Espressione del
calcolatore di raster.

Nella sezione Risultato del layer devi definire il nome del raster in output. Hai diverse opzioni per scegliere
l’estensione dell’area di calcolo: sulla base del raster in input, su coordinate X e Y oppure sulla base del numero
di righe e colonne, per impostare la risoluzione finale del raster in output. Se il raster in input ha una risoluzione
diversa, i valori verranno ricampionati con l’algoritmo del vicino più prossimo.

La sezione Operatori elenca tutti gli operatori disponibili. Per aggiungere un operatore alla finestra Espressione
del calcolatore di raster, clicca sul pulsante appropriato. Sono disponibili operatori Matematici (+, -, *, . . . ) e
funzioni trigonometriche (sin, cos, tan, . . . ). Le espressioni condizionali (=, !=, <, >=, . . . . ) restituiscono
0 per falso o 1 per vero, e quindi possono essere utilizzate con altri operatori e funzioni. Restate sintonizzati per
l’arrivo di altri operatori!

Selezionando la casella di controllo Aggiungi al progetto il raster finale verrà aggiunto automaticamente alla
legenda e lo potrai visualizzare sulla mappa.

Esempi

Convertire unità di misura dell’elevazione da metri a piedi

Per creare un raster con altimetria in piedi a partire da un raster con altimetria in metri devi utilizzare il fattore di
conversione di 3,28 piedi per metro. L’espressione è:

"elevation@1" * 3.28

Utilizzare una maschera
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Figure 14.14: Calcolatore raster
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Se vuoi usare una maschera su parti di un raster - perché, per esempio, sei interessato solo ai valori di altezza
superiori allo 0 - puoi usare l’espressione seguente per creare in un solo passaggio una maschera e applicare il
risultato al raster:

("elevation@1" >= 0) * "elevation@1"

In altre parole, per ogni cella maggiore o uguale a 0 imposta il valore uguale a 1, in questo modo si mantiene il
valore originario moltiplicandolo per 1. Altrimenti imposta 0, il che imposta il valore del raster a 0. In questo
modo creerai la maschera al volo.

Se vuoi classificare un raster, ad esempio, in due classi di elevazione, puoi utilizzare la seguente espressione per
creare un raster con due valori 1 e 2 in un solo passo:

("elevation@1" < 50) * 1 + ("elevation@1" >= 50) * 2

In altre parole, per ogni cella minore di 50 imposta il valore su 1. Per ogni cella maggiore o uguale a 50 imposta
il valore su 2.

14.2.2 Allineamento Raster

Questo strumento è in grado di prendere diversi raster come input e di allinearli perfettamente, il che significa:

• riproiettare allo stesso SR,

• ricampionare alla stessa dimensione di cella e offset nella griglia,

• ritagliare a una regione di interesse,

• ridimensionare i valori quando necessario.

Tutti i raster saranno salvati in altri file.

In primo luogo, apri gli strumenti da Raster → Allinea Raster. . . e fai clic sul pulsante Aggiungi nuovo raster

per scegliere un raster esistente in QGIS. Seleziona un le di output per salvare il raster dopo l’allineamento, il
metodo di ricampionamento e se è necessario Riscala i valori in base alla dimensione della cella. Il metodo di
ricampionamento può essere (vedi figure_raster_align_edit):

• Vicini più prossimi (Nearest Neighbor)

• Bilineare (2x2 kernel)

• Cubica (4x4 kernel)

• Cubica B-Spline (4x4 kernel)

• Lanczos (6x6 kernel)

• Media

• Modo

• Massimo, Minimo, Mediana, Primo Quartile (Q1) o Terzo Quartile (Q3) di tutti i pixel diversi da
NODATA

Nota: I metodi Massimo, Minimo, Mediana, Primo e Terzo Quartile sono disponibili solo se QGIS opera con
GDAL >= 2.0.

Nella finestra di dialogo principale Allinea Raster. . . puoi anche Modificare le impostazioni del file o
Rimuovere un file esistente dall’elenco dei layer raster. Puoi scegliere una o più opzioni (vedi figure_raster_align):

• Seleziona Layer di riferimento,

• Trasforma in un nuovo SR,

• Settaggio ad una diversa Dimensione cella,
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Figure 14.15: Selezione Opzioni di ricampionamento raster

• Settaggio ad un differente Offset reticolo,

• Ritaglio all’estensione della mappa: definito dall’utente o basato sul layer o sulla vista del layer nella mappa

• Dimensioni in uscita,

• Aggiungi i raster allineati alla mappa.
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Figure 14.16: Allineamento Raster
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CHAPTER 15

Lavorare con i dati Mesh

15.1 Lavorare con i dati Mesh

15.1.1 Cos’è una mesh?

Una mesh è una griglia non strutturata, di solito con componenti temporali e di altro tipo. La componente spaziale
contiene un insieme di vertici, bordi e facce nello spazio 2D o 3D:

• vertici - Punti XY(Z) (nel sistema di riferimento delle coordinate del layer)

• bordi - collegano coppie di vertici

• Facce - una faccia è un insieme di bordi che formano una forma chiusa - tipicamente un triangolo o un
poligono a quattro lati (quadrilatero), raramente poligoni con più vertici.

Figure 15.1: Differenti tipologie di dati mesh

QGIS è attualmente in grado di visualizzare i dati delle mesh utilizzando triangoli o rettangoli regolari.
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Mesh contiene le informazioni sulla struttura spaziale. Inoltre, la mesh può avere set di dati (gruppi) che as-
segnano un valore ad ogni vertice. Ad esempio, avere una mesh triangolare con vertici numerati come mostrato
nell’immagine seguente:

Figure 15.2: Griglia triangolare con vertici numerati

Ogni vertice può memorizzare insiemi di dati diversi (tipicamente quantità multiple), e questi insiemi di dati
possono anche avere una dimensione temporale. Pertanto un singolo file può contenere insiemi di dati multipli.

La tabella seguente dà un’idea delle informazioni che possono essere memorizzate nei set di dati delle mesh. Le
colonne della tabella rappresentano gli indici dei vertici delle mesh, ogni riga rappresenta un set di dati. I set di dati
possono avere diversi tipi di dati. In questo caso, memorizza la velocità del vento a 10m in momenti particolari
(t1, t2, t3).

In modo simile, il set di dati della mesh può anche memorizzare valori vettoriali per ogni vertice. Ad esempio, il
vettore della direzione del vento in corrispondenza degli orari indicati:

Velocità del vento a 10 metri 1 2 3 . . .
Velocità del vento a 10 metri al tempo=t1 17251 24918 32858 . . .
Velocità del vento a 10 metri al tempo=t2 19168 23001 36418 . . .
Velocità del vento a 10 metri al tempo=t3 21085 30668 17251 . . .
. . . . . . . . . . . . . . .
Direzione del vento a 10 metri al tempo=t1 [20,2] [20,3] [20,4.5] . . .
Direzione del vento a 10 metri al tempo=t2 [21,3] [21,4] [21,5.5] . . .
Direzione del vento a 10 metri al tempo=t3 [22,4] [22,5] [22,6.5] . . .
. . . . . . . . . . . . . . .

342 Chapter 15. Lavorare con i dati Mesh



QGIS User Guide, Release 3.4

Possiamo visualizzare i dati assegnando i colori ai valori (analogamente a come viene fatto con visualizzazione
raster Singleband pseudocolor) e interpolando i dati tra i vertici secondo la topologia della mesh. Generalmente
alcune grandezze sono vettori 2D piuttosto che semplici valori scalari (ad esempio direzione del vento). Per tali
quantità è utile visualizzare le frecce che indicano le direzioni.

Figure 15.3: Possibile visualizzazione di dati mesh

15.1.2 Formati supportati

QGIS accede ai dati della mesh utilizzando MDAL drivers. Quindi, i formati supportati nativamente sono:

• NetCDF: Formato generico per dati scientifici

• GRIB: Formato comunemente utilizzato in meteorologia

• XMDF: Ad esempio, il flusso di inondazione del pacchetto di modellazione TUFLOW

• DAT: Output di vari pacchetti di modellazione idrodinamica (ad esempio BASEMENT, HYDRO_AS-2D,
TUFLOW)

• 3Di: Formato del package di modellizzazione 3Di basato sulle regole e previsioni sul clima (http:
//cfconventions.org/)

• Alcuni esempi di dataset mesh sono disponibili all’indirizzo https://apps.ecmwf.int/datasets/data/
interim-full-daily/levtype=sfc/

15.1.3 Caricare un layer mesh

Aggiungere un layer mesh in QGIS

1. Apri la finestra di dialogo Gestore della sorgente dati, sia selezionandola dal menu Layer → o cliccando sul

pulsante Apri Gestore della sorgente dati.

2. Quindi, attiva la scheda Mesh dataset sul pannello di sinistra

3. Premi il pulsante . . . . per selezionare il file e premi Aggiungi. Il layer verrà aggiunto utilizzando la visual-
izzazione nativa della mesh.
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Figure 15.4: Scheda Mesh in Gestore della sorgente dati
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15.1.4 Proprietà del Dataset Mesh

Informazioni

Figure 15.5: Proprietà del Layer Mesh

La scheda Informazioni è di sola lettura e rappresenta un posto interessante per avere rapidamente informazioni
e metadati riassunti sul layer corrente. Le informazioni fornite sono (in base al fornitore del layer) uri, conteggio
dei vertici, conteggio delle facce e conteggio dei gruppi dei dataset.

Sorgente

La scheda Sorgente visualizza le informazioni di base sulla mesh selezionata, tra cui:

• il nome del Layer da visualizzare nel pannello Nome vettore

• impostazione del sistema di riferimento delle coordinate: Visualizza il sistema di riferimento delle coordi-
nate (SR) del layer come stringa PROJ.4. Puoi cambiare il SR del layer selezionandone uno usato di recente

nell’elenco a discesa o cliccando sul pulsante Seleziona SR (vedi Scelta del sistema di riferimento delle
coordinate). Utilizza questo processo solo se il SR applicato al layer è sbagliato o se non è stato applicato.

Utilizza il pulsante Assign Extra Dataset to Mesh per aggiungere altri gruppi al layer del mesh corrente.

Stile

Fai clic sul pulsante Stile per attivare la finestra di dialogo come mostrato nella figura seguente:

Le proprietà dello stile sono suddivise in diverse schede:

• General

• Contours Symbology

• Vectors Symbology

• Rendering
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Figure 15.6: Stile del layer Mesh

Generale

La scheda contiene le seguenti informazioni:

• gruppi disponibili nel dataset mesh

• nel(i) gruppo(i) selezionato(i), ad esempio, se il layer ha una dimensione temporale

• metadati se disponibili

• blending mode disponibili per i dataset selezionati.

I pulsanti , le caselle combinate e permettono di esplorare un’altra dimensione dei
dati, se disponibile. Mentre il cursore mobile si muove, i metadati vengono visualizzati di conseguenza. Vedi la
figura Mesh groups qui sotto come esempio. L’area di disegno della mappa mostrerà anche il gruppo del dataset
selezionato.

Figure 15.7: Dataset nel(i) Gruppo(i) selezionato
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Puoi applicare la simbologia a ciascun gruppo utilizzando le schede.

Simbologia dei contorni

In Gruppi, clicca su per visualizzare i contorni con i parametri di visualizzazione predefiniti.

Nella scheda puoi vedere e modificare le opzioni di visualizzazione correnti dei contorni per il gruppo se-
lezionato, come mostrato nell’immagine sottostante Styling contours in a mesh:

Figure 15.8: Stile dei contorni in un layer Mesh

Utilizza la barra di scorrimento o la casella combinata per impostare l’opacità del gruppo corrente.

Usa Carica per regolare i valori minimi e massimi del gruppo corrente.

La lista Interpolazione contiene tre opzioni per visualizzare i contorni: Lineare, Discreto e Esatto.

Il widget Scala di colori apre color ramp drop-down shortcut.

La Unità etichetta suffisso è un’etichetta aggiunta dopo il valore della legenda.

Selezionando Continua nella classificazione Moda, QGIS crea automaticamente delle classi considerando i valori
Min e Max. Con “Intervallo uguale”, è sufficiente selezionare il numero di classi utilizzando la casella combinata
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Classi e premere il pulsante Classifica.

Il pulsante Aggiungi valori manualmente aggiunge un valore alla singola tabella colori. Il pulsante
Rimuovi le righe selezionate cancella un valore dalla singola tabella colori. Facendo doppio clic sulla colonna dei val-
ori è possibile inserire un valore specifico. Facendo doppio clic sulla colonna colore si apre la finestra di dialogo
Cambia colore, dove è possibile selezionare un colore da applicare a quel valore.

Simbologia Vettori

Nella scheda , fai clic su per visualizzare i vettori, se disponibili. L’area di disegno della mappa mostrerà

i vettori del gruppo selezionato con i parametri predefiniti. Fai clic sulla scheda per modificare i parametri
di visualizzazione dei vettori come mostrato nella figura seguente:

Figure 15.9: Stile dei vettori in un layer Mesh

La larghezza della linea può essere impostata utilizzando la casella combinata o digitando il valore. Il widget
colore apre la finestra di dialogo Cambia colore, dove puoi selezionare un colore da applicare ai vettori.

Inserisci i valori per Min e Max per filtrare i vettori in base alla loro grandezza.
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Spuntando la casella di controllo Display Vectors on User Grid e specificando i valori Spaziatura X e
Spaziatura Y, QGIS visualizzerà i vettori con la spaziatura impostata.

Con le opzioni Head Options, QGIS permette di impostare la forma della punta della freccia specificando
larghezza e lunghezza (in percentuale).

La Arrow length dei vettori può essere visualizzata in QGIS in tre modi diversi:

• Defined by Min and Max: Definisci la lunghezza minima e massima per i vettori, QGIS regolerà di con-
seguenza la loro visualizzazione

• Scale to Magnitude: Definisci il fattore (moltiplicatore) da utilizzare

• Fisso: tutti i vettori sono mostrati con la stessa lunghezza

Visualizzazione

Nella scheda , QGIS offre due possibilità per visualizzare la griglia, come mostrato nell’immagine Mesh
rendering:

• Native Mesh Rendering che visualizza quadrilateri

• Triangular Mesh Rendering che visualizza triangoli

La larghezza della linea e il colore possono essere modificati in questa finestra di dialogo ed entrambe le visualiz-
zazioni della griglia possono essere disattivate.
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Figure 15.10: Visualizzazione Mesh
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CHAPTER 16

Layout di stampa

Con i Layout di stampa e i Report puoi creare mappe e atlanti, stamparli o salvarli come file immagine, PDF o
SVG.

16.1 Panoramica sul Layout di stampa

Il layout di stampa serve a creare il layout della rappresentazione voluta e a ottenere la stampa della stessa. Ti
permette di aggiungere elementi come la mappa QGIS, etichette di testo, immagini, legende, barre di scala, forme
di base, frecce, tabelle degli attributi e cornici HTML. Puoi dimensionare, raggruppare, allineare, posizionare e
ruotare ogni elemento e regolare le sue proprietà per creare il layout. Il layout può essere stampato o esportato
in formati immagine, PostScript, PDF o in SVG (l’esportazione in SVG non funziona correttamente con alcune
recenti versioni di Qt4; dovresti provare a controllare sul tuo specifico sistema). Puoi salvare il layout come
modello e caricarlo nuovamente in un’altra sessione. Infine, la generazione di diverse mappe basate su un template
può essere fatta attraverso il generatore di atlante.

16.1.1 Sessione di esempio

Prima di iniziare a lavorare con il layout di stampa, devi caricare qualche layer raster o vettoriale nell’area mappa di
QGIS e adattare le relative proprietà in base alle tue esigenze. Dopo che tutto viene visualizzato e simboleggiato a

tuo piacimento, clicca sull’icona Nuovo Layout di stampa nella barra degli strumenti oppure scegli Progetto →Nuovo
Layout di stampa. . . .. Ti verrà chiesto di scegliere un titolo per il nuovo layout.

Per mostrare come creare una mappa segui le seguenti istruzioni.

1. Sulla sinistra, seleziona il pulsante della barra degli strumenti Aggiungi nuova mappa al Layout e disegna un
rettangolo sul foglio del layout di stampa tenendo premuto il pulsante sinistro del mouse. All’interno del
rettangolo disegnato si attiva la visualizzazione della mappa QGIS.

2. Seleziona il pulsante della barra degli strumenti Aggiungi nuova Barra di scala al layout di stampa e fai clic con il tasto
sinistro del mouse sull’area di stampa del layout. Una barra di scala sarà aggiunta.

3. Seleziona Aggiungi una nuova Legenda al layout e disegna un rettangolo sul foglio tenendo premuto il pulsante
sinistro del mouse. Nel rettangolo verrà disegnata una legenda.

4. Seleziona l’icona Seleziona/Sposta oggetto per selezionare la mappa sul foglio e spostarla di un po”.
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5. Mentre l’oggetto mappa è ancora selezionato puoi modificare le dimensioni della mappa. Fai clic tenendo
premuto il pulsante sinistro del mouse, in un piccolo rettangolo bianco in uno degli angoli dell’oggetto
mappa e scegli una nuova posizione per modificare la sua dimensione.

6. Fai clic sulla scheda Proprietà dell’oggetto sul lato sinistro e cerca le impostazioni per l’orientamento.
Cambia il valore dell’impostazione Rotazione mappa a “15,00° “. Dovresti vedere cambiato l’orientamento
della mappa.

7. Ora, puoi stampare o esportare il tuo layout di stampa in formati immagine, PDF o SVG con gli strumenti
di esportazione nel menu Layout

8. Infine, puoi salvare il layout di stampa all’interno del file di progetto con il pulsante Salva Progetto.

Puoi aggiungere elementi multipli al layout di stampa. Puoi anche avere più di una mappa, legenda o barra di
scala nel layout di stampa, su una o più pagine. Ogni elemento ha le proprie proprietà e, nel caso della mappa,
la propria estensione. Se vuoi rimuovere un qualsiasi elemento dal layout puoi farlo con il tasto Cancella o il
tasto Backspace.

16.1.2 Il Gestore del Layout

Il Gestore del Layout è la finestra principale per gestire i layout di stampa nel progetto. Fornisce una panoramica
dei layout di stampa esistenti e dei report del progetto e offre strumenti per farlo:

• aggiungere un nuovo layout di stampa o un nuovo report da zero, un modello o la duplicazione di uno
esistente;

• rinominarli o cancellarli;

• aprirli in un progetto.

Per aprire la finestra di dialogo Gestore del Layout:

• dalla finestra di dialogo principale di QGIS, seleziona il menu Progetto → Gestore del Layout. . . oppure

fai clic sul pulsante Mostra Gestore del Layout in Barra del Progetto;

• da un layout di stampa o dalla finestra di dialogo dei report, seleziona il menu Layout → Gestore del Layout

o fai clic sul pulsante Gestore del Layout in Barra del Layout.

Figure 16.1: Il Gestore del Layout di Stampa

Il Gestore del Layout elenca nella sua parte superiore tutti i layout di stampa o report disponibili nel progetto con
gli strumenti per:

• mostrare la selezione: puoi selezionare più report e/o stampare il/i layout di stampa e aprirli con un solo
clic. Facendo doppio clic si apre anche un nome;
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• duplicare il layout di stampa selezionato o il rapporto (disponibile solo se ne è selezionato uno): crea una
nuova finestra di dialogo utilizzando come modello quello selezionato. Ti verrà chiesto di scegliere un
nuovo titolo per il nuovo layout;

• rinominare il report o il layout (disponibile solo se ne è selezionato uno): ti verrà chiesto di scegliere un
nuovo titolo per il layout;

• rimuovere il layout: il(i) layout di stampa selezionato(i) verrà eliminato(i) dal progetto.

Nella parte inferiore, è possibile creare nuovi layout di stampa o report da zero o da un modello. Per impostazione
predefinita, QGIS cercherà i modelli nel profilo utente e nelle directory dei modelli dell’applicazione (accessibili
con i due pulsanti in fondo al pannello), ma anche in qualsiasi cartella dichiarata come Percorso(i) per cercare
modelli di stampa aggiuntivi in Impostazioni → Opzioni → Layout. I modelli trovati sono elencati nella casella
a scelta multipla. Seleziona un elemento e premi il pulsante Crea. . . per generare un nuovo report o stampare il
layout.

Puoi anche utilizzare modelli di layout da una cartella personalizzata; in tal caso, seleziona Specifico nell’elenco
a discesa dei modelli, sfoglia per selezionare il modello e premi Crea. . . .

Suggerimento: Creazione di layout di stampa basati su modelli dal pannello Browser

Trascinando e rilasciando un modello di layout di stampada qualsiasi file del tipo .qpt sulla mappa o facendo
doppio clic nel Browser panel si genera un nuovo layout di stampa dal modello.

16.1.3 Menu, strumenti e pannelli del Layout di stampa

L’apertura del layout di stampa fornisce un riquadro bianco che rappresenta la superficie della carta quando si
utilizza l’opzione di stampa. Inizialmente si trovano pulsanti a sinistra accanto al riquadro per aggiungere elementi
del layout di stampa: la mappa QGIS corrente QGIS, le etichette di testo, immagini, legende, barre di scala, forme
di base, frecce, tabelle degli attributi e cornici HTML. In questa barra degli strumenti si trovano anche pulsanti per
navigare, ingrandire un’area e scorrere la vista sul layout e pulsanti per selezionare qualsiasi elemento del layout
e per spostare il contenuto dell’oggetto mappa.

figure_layout_overview mostra la vista iniziale del layout di stampa prima di aggiungere elementi.

Sulla destra accanto all’area di stampa trovi due gruppi di pannelli. Quello superiore contiene i pannelli Oggetti e
Storico dei comandi e quello inferiore contiene i pannelli Layout, Proprietà dell’oggetto e Atlante.

• Il pannello Oggetti fornisce un elenco di tutti gli oggetti del layout di stampa aggiunti all’area di stampa e
dei modi per interagire globalmente con essi (vedi Il Pannello Oggetti per maggiori informazioni).

• Il pannello Storico dei comandi mostra una cronologia di tutte le modifiche apportate alla composizione.
Con un clic del mouse, è possibile annullare e ripetere i passaggi fatti sulla composizione avanti e indietro
fino ad un certo stato.

• Il pannello Layout ti permette di impostare parametri generali da applicare al layout di stampa quando lo
esporti o stai lavorando su di esso (vedi Il Pannello Layout per maggiori dettagli);

• Il pannello Proprietà oggetto mostra le proprietà per l’oggetto selezionato. Fai clic sull’icona
Scegli/Sposta oggtto per selezionare un oggetto (ad esempio, legenda, barra di scala o etichetta) sull’area di
stampa. Poi clicca sul pannello Proprietà oggetto e personalizza le impostazioni per l’oggetto selezion-
ato (vedi Oggetti del Layout per informazioni dettagliate sulle impostazioni di ciascun oggetto).

• Il pannello Atlante ti permette di abilitare la generazione di un atlante per il layout corrente e ti dà accesso
ai suoi parametri (vedi Generazione Atlante per informazioni dettagliate sull’utilizzo della generazione
dell’atlante).

Nella parte inferiore della finestra del layou di stampa, troverai una barra di stato con la posizione del mouse,
il numero attuale della pagine e un menu a tendina per selezionare il livello di zoom, il numero degli oggetti
selezionati - se applicabile e se attivata la generazione di un atlante - il numero degli oggetti.
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Figure 16.2: Layout di stampa

Nella parte superiore della finestra del layout di stampa puoi trovare menu e altre barre degli strumenti. Tutti gli
strumenti per il layout di stampa sono disponibili nei menu e come icone in una barra degli strumenti.

Le barre degli strumenti e i pannelli possono essere disattivati e attivati utilizzando il pulsante destro del mouse su
qualsiasi barra degli strumenti o attraverso Visualizza → Barre degli strumenti o Visializza → Panelli →.

Menu e Strumenti

Menu Layout

Il menu Layout fornisce l’azione per gestire il layout:

• Salva il file di progetto direttamente dalla finestra del layout di stampa.

• Crea un nuovo layout di stampa con Nuovo Layout. . . ..

• Duplica Layout. . . : crea un nuovo layout di stampa duplicando quello attuale.

• Rimuovi il layout corrente con Elimina layout. . . .

• Apri Gestore del Layout. . . .

• Layout → : Apre un layout di stampa esistente.

Una volta completato il layout, con le icone Salva come modello e Aggiungi oggetti dal modello, puoi salvare lo stato
corrente di una sessione del layout di stampa come .qpt template e caricare nuovamente il modello in un’altra
sessione.

Nel menu Layout, ci sono potenti strumenti per condividere le rappresentazioni prodotte con QGIS e inserirle in

relazioni e pubblicazioni. Gli strumenti sono: Esporta come immagine. . . , Esporta come PDF. . . , Esporta come SVG. . .
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e Stampa. . . .

Di seguito è riportato un elenco di tutti gli strumenti disponibili in questo menu con alcune utili informazioni.

Strumento Scorciatoia Barra degli Stru-
menti

Riferimento

Salva Progetto Ctrl+S Layout Introduzione ai progetti QGIS

Nuovo Layout. . . Ctrl+N Layout Il Gestore del Layout

Duplica Layout Layout Il Gestore del Layout

Elimina Layout

Gestore del Layout Layout Il Gestore del Layout
Layout →
Proprietà del Layout. . . Il Pannello Layout
Rinomina Layout. . .

Aggiungi Pagine. . . Layout Lavorare con le proprietà della
pagina

Aggiungi Oggetti da Mod-
ello. . .

Layout Creare un oggetto nel Layout

Salva come Modello. . . Layout Il Gestore del Layout

Esporta come Immagine. . . Layout Esportare in formato Immagine

Esporta come SVG. . . Layout Esportare in formato SVG

Esporta come PDF. . . Layout Esportare in formato PDF
Imposta Pagina. . . Ctrl+Shift+P

Stampa. . . Ctrl+P Layout Creare un Output
Chiudi Ctrl+Q

Menu Modifica

Il menu Modifica offre strumenti per manipolare gli elementi del layout di stampa. Include azioni comuni come gli
strumenti di selezione, la funzioni di Copia/Taglia/Incolla e annulla/ripristina (vedi Pannello Storico dei comandi:
Annulla e Ripristina azioni) per elementi del layout.

Quando si usa l’azione Incolla, gli elementi verranno incollati in base alla posizione corrente del mouse. Usando
l’azione Modifica → Incolla sul posto o premendo Ctrl+Shift+V incollerà gli elementi nella pagina corrente,
nella stessa posizione in cui si trovavano nella loro pagina iniziale. Garantisce di copiare/incollare gli elementi
nello stesso posto, da pagina a pagina.

Di seguito è riportato un elenco di tutti gli strumenti disponibili in questo menu con alcune utili informazioni.
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Strumento Scorciatoia Barra degli
Strumenti

Riferimento

Annulla (ultimo cambia-
mento)

Ctrl+Z Layout Pannello Storico dei comandi: Annulla e
Ripristina azioni

Rifai (ripeti il cambia-
mento precedente)

Ctrl+Y Layout Pannello Storico dei comandi: Annulla e
Ripristina azioni

Elimina Del

Taglia Ctrl+X

Copia Ctrl+C

Incolla Ctrl+V
Incolla sul posto Ctrl+Shift+V

Seleziona tutto Ctrl+A

Deseleziona tutto Ctrl+Shift+A

Inverti selezione
Seleziona il prossimo oggetto
Sotto

Ctrl+Alt+[

Seleziona il prossimo oggetto
Sopra

Ctrl+Alt+]

Sposta Layout P Barra di Nav-
igazione

Zoom Z Barra di Nav-
igazione

Seleziona/Sposta Oggetto V Barra di Nav-
igazione

Interagire con gli oggetti del layout

Sposta Contenuto C Barra di Nav-
igazione

L’Oggetto Mappa

Modifica nodi Barra di Nav-
igazione

Oggetti Forma a Nodi

Menu Visualizza

Il menu Visualizza dà accesso agli strumenti di navigazione e aiuta a configurare il comportamento generale del
layout di stampa. Oltre ai comuni strumenti di zoom, hai strumenti per:

• Aggiorna la vista (se ti trovi in uno stato di visualizzazione inconsistente)

• abilitando una grid puoi agganciare gli oggetti quando li sposti o li crei. L’impostazione del reticolo viene
effettuata in Impostazioni → Opzioni di layout. . . . o in Layout Panel;

• gestisci guide puoi agganciare gli oggetti quando li sposti o li crei. Il reticolo è costituito da linee rosse
che puoi creare cliccando sul righello (sopra o a sinistra del layout) e trascinare e rilasciare nella posizione
desiderata;

• Guide intelligenti: utilizza altri oggetti del layout come linee di allineamento da agganciare in modo dinam-
ico quando l’utente sposta o rimodella un oggetto.

• Azzera tutte le guide rimuove tutte le guide;

• Mostra i perimetri di delimitazione mostra un riquadro a contorno degli oggetti.

• Mostra righelli ai bordi del layout.
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• Mostra pagine o rendi le pagine trasparenti. Spesso le composizioni di stampa sono realizzate per creare
composizioni in realtà da non stampare, ad esempio per essere incluse in presentazioni o in altri elaborati
nei quali si vuole esportare quanto realizzato con uno sfondo totalmente trasparente. A volte è indicato
come «infinite canvas» in software di editing grafico.

Nel layout puoi cambiare il livello di zoom usando la rotellina del mouse o la casella combinata nella barra di
stato. Se devi passare alla modalità pan mentre stai lavorando nell’area della composizione di stampa, puoi tenere
premuta Spacebar la barra spaziatrice o la rotellina del mouse. Con Ctrl+Spacebar, puoi temporaneamente
cambiare la modalità di visualizzazione a Ingrandisci e con Ctrl+Shift+Spacebar, a Rimpicciolisci.

I pannelli e le barre degli strumenti possono essere abilitati dal menu Visualizza →. Per massimizzare lo spazio

disponibile per interagire con una composizione puoi seleziona l’opzione Visualizza → Attiva visibilità pan-
nello oppure premi Ctrl+Tab; tutti i pannelli sono nascosti e solo i pannelli precedentemente visibili vengono
ripristinati quando non selezionati.

E” anche possibile passare ad una modalità a schermo intero per avere più spazio con cui interagire premendo

F11 o usando Visualizza → Schermo intero.

Strumento Scorciatoia Barra degli Stru-
menti

Riferimento

Aggiorna la vista F5 Barra di Nav-
igazione

Anteprima →

Ingrandisci Ctrl++ Barra di Nav-
igazione

Rimpicciolisci Ctrl+- Barra di Nav-
igazione

Zoom al 100% Ctrl+1 Barra di Nav-
igazione

Zoom completo Ctrl+0 Barra di Nav-
igazione

Zoom alla larghezza

Mostra Reticolo Ctrl+' Guide e Reticolo

Aggancia al reticolo Ctrl+Shift+' Guide e Reticolo

Mostra Guide Ctrl+; Guide e Reticolo

Aggancia alle guide Ctrl+Shift+; Guide e Reticolo

Guide intelligenti Ctrl+Alt+;
Gestisci Guide. . . Il Pannello Guide
Azzera Guide Il Pannello Guide

Mostra Righelli Ctrl+R

Mostra i Perimetri di Delimi-
tazione

Ctrl+Shift+B

Mostra pagine
Barre degli Strumenti → Pannelli e Barre degli stru-

menti
Pannelli → Pannelli e Barre degli stru-

menti

Schermo intero F11 Mappa

Attiva visibilità pannello Ctrl+Tab Mappa
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Menu Oggetti

Il menu Oggetti aiuta a configurare la posizione degli elementi nel layout e le relazioni tra di essi (vedi Interagire
con gli oggetti del layout).

Strumento Scorciatoia Barra degli Stru-
menti

Riferimento

Raggruppa Ctrl+G Barra delle azioni Raggruppamento degli oggetti

Sblocca tutto Ctrl+Shift+GBarra delle azioni Raggruppamento degli oggetti

Muovi in alto Ctrl+] Barra delle azioni Allineamento

Muovi in basso Ctrl+[ Barra delle azioni Allineamento

Porta in Cima Ctrl+Shift+]Barra delle azioni Allineamento

Sposta in fondo Ctrl+Shift+[Barra delle azioni Allineamento

Blocca gli oggetti se-
lezionati

Ctrl+L Barra delle azioni Bloccare gli oggetti

Sblocca tutto Ctrl+Shift+LBarra delle azioni Bloccare gli oggetti
Allinea Elementi → Barra delle azioni Allineamento
Distribuisci Elementi → Barra delle azioni Spostamento e ridimensionamento

degli oggetti
Ridimensiona → Barra delle azioni Spostamento e ridimensionamento

degli oggetti

Menu Aggiungi oggetto

Questi sono strumenti per creare oggetti di layout. Ognuno di essi è descritto in dettaglio nel capitolo Oggetti del
Layout.

Strumento Barra degli Strumenti Riferimento

Aggiungi Mappa Barra di Navigazione L’Oggetto Mappa

Aggiungi Immagine Barra di Navigazione L’Oggetto Immagine

Aggiungi Etichetta Barra di Navigazione L’Oggetto Etichetta

Aggiungi Legenda Barra di Navigazione L’Oggetto Legenda

Aggiungi Barra di Scala Barra di Navigazione L’oggetto Barra di Scala

Aggiungi Forma → Barra di Navigazione L” Oggetto Forma Regolare

Aggiugi Freccia Barra di Navigazione L’oggetto Freccia

Aggiungi Nodo → Barra di Navigazione Oggetti Forma a Nodi

Aggiungi HTML Barra di Navigazione La cornice HTML

Aggiungi Tabella Attributi Barra di Navigazione L’oggetto Tabella degli Attributi
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Menu Atlante

Strumento Scorciatoia Barra degli Stru-
menti

Riferimento

Anteprima Atlante Ctrl+ALt+/ Barra dell’Atlante Anteprima e generazione
dell’atlante

Prima geometria Ctrl+< Barra dell’Atlante Anteprima e generazione
dell’atlante

Geometria precedente Ctrl+, Barra dell’Atlante Anteprima e generazione
dell’atlante

Geometria successiva Ctrl+. Barra dell’Atlante Anteprima e generazione
dell’atlante

Ultima geometria Ctrl+> Barra dell’Atlante Anteprima e generazione
dell’atlante

Stampa atlante. . . Barra dell’Atlante Anteprima e generazione
dell’atlante

Esporta atlante come immag-
ini. . .

Barra dell’Atlante Anteprima e generazione
dell’atlante

Esporta atlante come SVG. . . Barra dell’Atlante Anteprima e generazione
dell’atlante

Esporta atlante come PDF. . . Barra dell’Atlante Anteprima e generazione
dell’atlante

Impostazioni atlante Barra dell’Atlante Generazione Atlante

Menu Impostazioni

Il menu Impostazioni → Opzioni Layout. . . . è un collegamento a Impostazioni → Opzioni → Menu layout della
mappa principale di QGIS. Qui, puoi impostare alcune opzioni che verranno utilizzate di default su qualsiasi
nuovo layout di stampa:

• Definizioni predefinite del Layout ti consente di specificare il carattere predefinito da utilizzare.

• Con Reticolo, puoi impostare lo stile del reticolo e il suo colore. Esistono tre tipi di reticolo: Punti, Pieno
e Croci.

• Opzioni predefinite delle guide e del reticolo definisce la spaziatura, l’offset del reticolo e la tolleranza di
aggancio (vedi Guide e Reticolo per maggiori dettagli);

• Percorsi Layout: per gestire la lista di percorsi personalizzati per la ricerca di modelli di stampa.

Menu contestuali

A seconda di dove fai clic con il tasto destro del mouse nella finestra di dialogo del layout di stampa, apri un menu
contestuale con varie funzioni:

• Cliccando con il tasto destro del mouse sulla barra dei menu o su qualsiasi barra degli strumenti, ottieni
l’elenco dei pannelli di layout e delle barre degli strumenti che puoi attivare o disattivare con un solo clic.

• Cliccando con il tasto destro del mouse su un righello e puoi selezionare Mostra guide, Aggancia
alle guide, Gestisci guide. . . . che apre il Guide panel o Azzera guide. E” anche possibile nascondere i
righelli.
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• Fai clic con il tasto destro del mouse sul’area del layout di stampa e:

– Sarai in grado di Annullare e Rifare i recenti cambiamenti, oppure Copiare qualsiasi oggetto (disponi-
bile solo se non è stato selezionato nessun oggetto).

– Se fai clic su una pagina, puoi anche accedere al pannello Page Properties o Rimuovi Pagina.

– Se fai clic su un oggetto selezionato, puoi tagliarlo o copiarlo e aprire il pannello Item Properties.

– Se viene selezionato più di un oggetto, puoi raggrupparli e/o disaggregarli se almeno un gruppo è già
presente nella selezione.

• Facendo clic con il pulsante destro del mouse all’interno di una casella di testo o del widget casella numerica
di qualsiasi pannello del layout vengono fornite opzioni di modifica per manipolarne il contenuto.

Il Pannello Layout

Nel pannello Layout puoi definire le impostazioni globali per la composizione in corso di realizzazione.

Figure 16.3: Impostazioni Layout nel Layout di stampa
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Impostazioni generali

In un layout di stampa, puoi utilizzare più di un oggetto mappa. La Mappa di riferimento seleziona la mappa da
utilizzare come mappa principale del layout. Il layout utilizzerà questa mappa in qualsiasi proprietà e di calcolo
delle variabili o di scala. Questo include l’esportazione del layout di stampa in formati georeferenziati.

Guide e Reticolo

Puoi mettere alcuni segni di riferimento sull’area della composizione di stampa per meglio posizionare alcuni
oggetti. Questi segni possono essere:

• semplici linee orizzontali o verticali (chiamate Guide) poste nella posizione desiderata (vedi Il Pannello
Guide per la creazione delle guide).

• o un Reticolo regolare: una rete di linee orizzontali e verticali sovrapposte alla composizione di stampa.

Impostazioni come Spaziatura reticolo o Offset reticolo possono essere regolate in questo gruppo così come la
Tolleranza di aggancio da utilizzare per gli oggetti. La tolleranza è la distanza massima al di sotto della quale il
cursore del mouse viene agganciato a un reticolo o a una guida, mentre si sposta, ridimensiona o crea un oggetto.

Se il reticolo o le guide devono essere mostrate è impostato nel menu Visualizza. Lì puoi anche decidere se possono
essere utilizzati per agganciare gli oggetti del layout. Quando sia una linea del reticolo che una linea guida rien-
trano nella tolleranza di un punto, le guide avranno sempre la precedenza - dato che sono state impostate manual-
mente (quindi, si suppone che siano state collocate esplicitamente in posizioni di aggancio altamente desiderabili,
e dovrebbero essere selezionate sopra il reticolo generale).

Nota: Nel menu Impostazioni → Layout, puoi anche impostare i parametri del reticolo e delle guide sopra esposti.
Tuttavia, queste opzioni si applicano solo come impostazione predefinita alle nuove composizioni di stampa.

Impostazioni per l’esportazione

Puoi definire una risoluzione da utilizzare per tutte le mappe esportate in Risoluzione di esportazione. Questa
impostazione può essere sovrascritta ogni volta che esporti una mappa.

A causa di alcune opzioni di visualizzazione avanzate (blending mode, effects. . . ), un oggetto del layout potrebbe
aver bisogno di rasterizzazione per essere esportato correttamente. QGIS lo rasterizza individualmente senza
forzare la rasterizzazione per ogni altro elemento. Questo permette di stampare o salvare come PostScript o PDF
per mantenere gli oggetti il più possibile come vettori, ad esempio, un elemento di mappa con opacità di layer non
costringerà le etichette, le barre di scala, ecc. ad essere anch’esse rasterizzate. Tuttavia, puoi:

• forzare la rasterizzazione di tutti gli oggetti selezionando Stampa come raster;

• oppure utilizzare l’opzione opposta, ad esempio Esporta sempre come vettori, per forzare l’esportazione
per mantenere gli oggetti come vettori quando sono esportati in un formato compatibile. Nota che in alcuni
casi, questo potrebbe far sì che l’output abbia un aspetto diverso dal layout.

Quando il formato lo rende possibile (ad esempio, .TIF, .PDF) l’esportazione di un layout di stampa risulta di
default un file georeferenziato (in base alla voce Mappa di Riferimento nel gruppo Impostazioni generali). Per

altri formati, l’output georeferenziato richiede di generare un world file selezionando Salva il file world. Il
world file viene creato accanto alla mappa(e) esportata, ha il nome della pagina di output con la voce della mappa
di riferimento e contiene informazioni per georeferenziarla facilmente.

Ridimensionare il layout in base al contenuto

Usando lo strumento Ridimensiona Layout al contenuto in questo gruppo, si crea un’unica composizione di pagina
la cui estensione copre il contenuto corrente del layout di stampa (con alcuni opzioni sui margini intorno ai limiti
di taglio).

16.1. Panoramica sul Layout di stampa 361



QGIS User Guide, Release 3.4

Si noti che questo comportamento è diverso dall’opzione crop to content con la quale tutti gli elementi sono
posizionati su una pagina reale e unica in sostituzione di tutte le pagine esistenti.

Variabili

Variabili elenca tutte le variabili disponibili a livello di layout (che include tutte le variabili globali e di progetto).

Permette all’utente di gestire variabili anche a livello di layout. Fai clic sul pulsante per aggiungere una nuova
variabile personalizzata a livello di layout. Allo stesso modo, seleziona una variabile personalizzata a livello di

layout dall’elenco e fai clic sul pulsante per rimuoverla.

Maggiori informazioni sull’utilizzo delle variabili nella sezione General Tools.

Figure 16.4: Gestione Variabili nel layout di stampa

Lavorare con le proprietà della pagina

Un layout può essere suddiviso in più pagine. Ad esempio, una prima pagina può mostrare una mappa e una
seconda pagina può mostrare la tabella degli attributi associata a un layer, mentre una terza mostra una cornice
HTML che collega al sito web della tua organizzazione. Oppure puoi aggiungere molti tipi di oggetti in ogni
pagina.

Aggiungere una nuova pagina

Inoltre, è possibile creare un layout utilizzando diverse dimensioni e/o orientamento delle pagine. Per aggiungere

una pagina, seleziona lo strumento Aggiungi Pagine. . . dal menu Layout o Barra del Layout. Si apre la
finestra di dialogo Inserisci Pagine e ti viene chiesto di riempirla:

• il numero di pagine da inserire;

• la posizione della(e) pagina: prima o dopo una data pagina o alla fine del layout di stampa;

• Il Page size: potrebbe essere di un formato predefinito (A4, B0, Legal, Letter, ANSI A, Arch A e
loro derivati e un tipo di risoluzione, come 1920x1080 o 1024x768) con associata Direzione (Verticale
o Orizzontale).

La dimensione della pagina può anche essere in un formato personalizzato; devi inserire la sua
Larghezza e Altezza (con il rapporto di dimensioni bloccato se necessario) e selezionare l’unità da uti-
lizzare tra mm, cm, px, pt, in, ft. . . .. La conversione dei valori immessi viene applicata automaticamente
quando si passa da un’unità all’altra.
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Figure 16.5: Creare una nuova pagina nel Layout di stampa

Aggiornamento delle proprietà della pagina

Ogni pagina può essere personalizzata successivamente attraverso il pannello Pagina Proprietà dell’oggetto. Fai
clic con il tasto destro del mouse su una pagina e seleziona Proprietà pagina. . . .. Si apre il pannello Proprietà
oggetto con impostazioni come:

• la scheda Dimensione pagina prima descritta. Puoi modificare ogni proprietà usando le opzioni di sovrascrit-
tura definita dai dati (vedi Esplorare Sovrascrittura definita dai dati con atlante per un caso d’uso);

• Escludi pagina dalle esportazioni per controllare se la pagina corrente con il suo contenuto deve essere
inclusa nel layout output;

• lo Sfondo usando il color o symbol che vuoi.

Figure 16.6: Finestra di dialogo Proprietà pagina

Il Pannello Guide

Le guide sono linee di riferimento verticali o orizzontali che puoi inserire in una pagina di layout per aiutarti a
posizionare gli elementi, a crearli, spostarli o ridimensionarli. Per essere attive, le guide richiedono le opzioni
Visualizza → Mostra Guide e Visualizza → Aggancia alle Guide. Per creare una guida, due modi:

• supponendo impostata l’opzione Visualizza → Mostra Guide, trascina fuori un righello e rilascia il pulsante
del mouse all’interno dell’area della pagina, nella posizione desiderata.

• più preciso e sempre disponibile, utilizzare il pannello Guide.
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Figure 16.7: Il pannello Guide

Il pannello Guide permette la creazione di linee di aggancio in punti specifici: cliccare sul pulsante
Aggiungi nuova guida e inserire le coordinate della linea orizzontale o verticale. Per l’impostazione sono disponibili
diverse unità di misura. Il pannello permette anche di regolare la posizione delle guide esistenti in base alle
coordinate esatte: fare doppio clic su una coordinata della guida e sostituire il valore.

Per eliminare una guida, selezionarla e premere il pulsante Rimuovi guide selezionate. Usare Azzera tutte le Guide
per rimuovere tutte le guide nel pannello.

Le guide sono sulla singola pagina, il che significa che il pannello Guide elenca le guide della pagina corrente (il
cui numero è mostrato nella parte superiore della finestra di dialogo). Allo stesso modo, permette la creazione o
la rimozione di guide solo nella pagina corrente. Il pulsante Applica a tutte le pagine consente di impostare la
configurazione della guida su una singola pagina e di trasferirla facilmente a tutte le altre pagine del layout.

Suggerimento: Aggancio ad oggetti di layout esistenti

Oltre al reticolo e alle griglie, puoi utilizzare gli oggetti esistenti come riferimenti di aggancio quando si spostano,
ridimensionano o creano nuovi oggetti; queste sono chiamate guide intelligenti e richiedono la selezione Visu-
alizza →Guide intelligenti per essere controllate. Ogni volta che il puntatore del mouse è vicino al limite di un
elemento, appare una croce di aggancio.

Il Pannello Oggetti

Il pannello Oggetti offre alcune opzioni per gestire la selezione e la visibilità degli oggetti. Tutti gli oggetti
aggiunti all’area di disegno del layout (inclusi items group) sono mostrati in una lista e selezionando un oggetto
viene anche selezionata la riga corrispondente della lista e selezionando una riga della lista viene selezionato
l’oggetto corrispondente nell’area di stampa del layout. Questo è quindi un modo pratico per selezionare un
oggetto posto dietro ad un altro. Si noti che la riga selezionata è indicata in grassetto.

Per ogni oggetto selezionato puoi:
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• impostarlo o meno visibile;

• bloccarlo o meno nella posizione;

• ordinare la sua posizione nella lista. Puoi spostare su e giù ogni oggetto nell’elenco con un click e trascinare.
L’oggetto più in alto dell’elenco verrà portato in primo piano nel layout di stampa. Per default ogni nuovo
oggetto aggiunto viene posizionato in fondo alla lista.

• modificare l’ID dell’oggetto facendo doppio clic sul testo;

• fai clic con il tasto destro del mouse su un oggetto e copialo, cancellalo o apri il suo properties panel.

Una volta che hai trovato la giusta posizione per un oggetto lo puoi bloccare selezionando in on la casella. Gli
oggetti bloccati non possono essere selezionati nell’area di stampa. Gli oggetti bloccati possono essere sbloccati
selezionando l’oggetto nella lista del pannello Oggetti e passando a non selezionata la relativa casella oppure puoi
usare l’icona nella barra degli strumenti.

Pannello Storico dei comandi: Annulla e Ripristina azioni

Durante il processo di layout è possibile annullare e ripristinare le modifiche. Questo può essere fatto con gli
strumenti di ripristino disponibili nel menu Modifica, nella barra degli strumenti Layout o nel menu contestuale
ogni volta che si fa clic con il tasto destro del mouse nell’area del layout di stampa:

• Annulla l’ultimo cambiamento

• Ripristina l’ultimo cambiamento

Questo può essere fatto anche con un clic del mouse all’interno del pannello Storico dei comandi (vedi fig-
ure_layout). Il pannello Storico dei comandi elenca le ultime azioni effettuate all’interno del layout di stampa.
Basta selezionare il punto a cui si vuole tornare e una volta eseguita una nuova azione tutte le azioni fatte dopo
quella selezionata saranno rimosse.

Figure 16.8: Storico dei comandi nella stampa Layout

16.2 Oggetti del Layout

16.2.1 Opzioni comuni degli Oggetti del Layout

QGIS fornisce un’ampia gamma di oggetti per il layout di una mappa. Possono essere di mappa, legenda, barra di
scala, immagine, tabella, freccia nord, tipo immagine. . . .. Tuttavia, condividono alcune opzioni e comportamenti
comuni che vengono di seguito trattati.

Creare un oggetto nel Layout

Gli oggetti possono essere creati utilizzando diversi strumenti, sia da zero o sulla base di oggetti esistenti.

16.2. Oggetti del Layout 365



QGIS User Guide, Release 3.4

Per creare un oggetto di layout da zero:

1. Seleziona lo strumento corrispondente o dal menu Aggiungi Oggetto o dalla barra Strumenti.

2. Poi:

• Clicca sulla pagina e immetti la dimensione e le informazioni di posizionamento richieste nella finestra
di dialogo Proprietà nuovo oggetto che compare (per i dettagli, vedi Posizione e Dimensione);

Figure 16.9: Finestra di dialogo Proprietà nuovo oggetto

• Oppure tieni premuto il clic sinistro e trascina per definire la dimensione iniziale e il posizionamento
dell’oggetto. Puoi contare sull’aggancio di griglie e guide per un posizionamento migliore.

Nota: Poiché possono avere forme particolari, il disegno di oggetti nodi o frecce non funziona con i
metodi con un solo clic né con clic e trascina; devi fare clic e posizionare ogni nodo dell’oggetto. Vedi lay-
out_node_node_based_shape_item per maggiori dettagli.

Puoi anche:

1. Selezionare un oggetto esistente con il pulsante Seleziona/Sposta oggetto dalla barra Strumenti

2. Usare il menu contestuale o gli strumenti del menu Modifica per copiare/tagliare l’oggetto e incollarlo nella
posizione del mouse come nuovo oggetto.

Puoi anche utilizzare il comando Incolla sul posto (Ctrl+Shift+V) per duplicare un oggetto da una
pagina all’altra e posizionarlo nella nuova pagina alle stesse coordinate dell’originale.

Inoltre, puoi creare oggetti utilizzando un modello di layout di stampa (per i dettagli, vedi Il Gestore del Layout)
tramite il comando Layout → Aggiungi Oggetti da modello. . . .

Suggerimento: Aggiungere elementi di layout utilizzando il file browser

Dal tuo file browser o usando il pannello Browser, trascina e rilascia un modello di layout di stampa (.qpt file)
in una finestra di dialogo di layout di stampa e QGIS aggiunge automaticamente tutti gli elementi di quel modello
al layout.

Interagire con gli oggetti del layout

Ogni oggetto all’interno del layout di stampa può essere spostato e ridimensionato per creare un layout per-

fetto. Per entrambe le operazioni il primo passo è quello di attivare lo strumento Seleziona/Sposta oggetto e cliccare
sull’oggetto.
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Puoi selezionare più oggetti con il pulsante Seleziona/Sposta oggetto: fai clic e trascina gli oggetti o tieni premuto
il pulsante Shift e fai clic su ciascuno degli oggetti desiderati. Per deselezionare un oggetto, clicca su di esso
tenendo premuto il pulsante Shift.

Ogni volta che c’è una selezione, il conteggio degli oggetti selezionati viene visualizzato sulla barra di stato.
All’interno del menu Modifica menu, è possibile trovare azioni per selezionare tutti gli oggetti, cancellare tutte le
selezioni, invertire la selezione corrente e altro ancora. . . ..

Spostamento e ridimensionamento degli oggetti

A meno che l’opzione Visualizza → Mostra i Perimetri di Delimitazione non sia deselezionata, un oggetto se-
lezionato mostrerà dei quadrati sui suoi confini; spostando uno di essi con il mouse ridimensionerà l’oggetto nella
direzione corrispondente. Durante il ridimensionamento, tenendo premuto Shift manterrà il rapporto di aspetto.
Tenendo premuto Alt si ridimensiona dal centro dell’oggetto.

Per spostare un oggetto del layout, selezionarlo con il mouse e muoverlo tenendo premuto il tasto sinistro. Se è
necessario limitare i movimenti all’asse orizzontale o verticale, basta tenere premuto il tasto Shift sulla tastiera
mentre si muove il mouse. Puoi anche spostare un oggetto selezionato usando il tasto Arrow keys sulla tastiera;
se il movimento è troppo lento, puoi accelerarlo tenendo premuto Shift. Se hai bisogno di maggiore preci-
sione, usa le proprietà Posizione e Dimensione, o aggancio al reticolo/guide come spiegato sopra per la creazione
dell’oggetto.

Il ridimensionamento o lo spostamento di più oggetti contemporaneamente è fatto allo stesso modo come per
un singolo oggetto. QGIS fornisce tuttavia alcuni strumenti avanzati per ridimensionare automaticamente una
selezione di oggetti seguendo regole diverse:

• l’altezza di ogni oggetto corrisponde al più alto o a quella più corto oggetto selezionato;

• la larghezza di ogni oggetto corrisponde al più largo o più stretto oggetto selezionato;

• ridimensiona gli oggetti in quadrati: ogni oggetto viene ridimensionato in forma quadrata.

Allo stesso modo, sono disponibili strumenti automatici per organizzare la posizione di più oggetti i distribuendoli
in modo equidistante:

• al bordo (sinistro, destro, superiore o inferiore) degli oggetti;

• centrando gli oggetti sia orizzontalmente che verticalmente.

Raggruppamento degli oggetti

Raggruppare gli oggetti ti permette di manipolare un insieme di oggetti come un unico oggetto: si possono facil-
mente ridimensionare, spostare, eliminare, copiare gli oggetti nel loro insieme.

Per creare un gruppo di oggetti, selezionane più di uno e premi il pulsante Raggruppa nel menu Oggetti o nella
barra delle Azioni o dal menu tasto destro del mouse. Una riga denominata Group viene aggiunta al pannello
Oggetti e può essere bloccata o nascosta come qualsiasi altro Items panel’s object. Gli oggetti raggruppati sono
non selezionabili singolarmente sulla mappa; utilizza il pannello Oggetti per la selezione diretta e accedi al
pannello delle proprietà dell’oggetto.

Bloccare gli oggetti

Quando hai trovato la posizione corretta per un oggetto, puoi bloccarlo utilizzando il pulsante Blocca gli
oggetti selezionati nel menù Oggetti o nella Barra delle Azioni o selezionando la casella accanto all’oggetto nel
pannello Oggetti. Gli elementi bloccati sono non selezionabili sull’area di stampa.
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Gli oggetti bloccati possono essere sbloccati selezionando l’oggetto nel pannello Oggetti e deselezionando la
casella di spunta oppure puoi utilizzare le icone sulla barra degli strumenti.

Allineamento

Lo spostamento in alto o in basso nella gerarchia visiva degli oggetti si trova all’interno del menu a discesa
Muovi in alto. Scegli un oggetto nell’area di stampa del layout e seleziona la funzione corrispondente per alzare
o abbassare l’oggetto selezionato rispetto agli altri oggetti. Questo ordine è mostrato nel pannello Oggetti. Puoi
anche alzare o abbassare gli oggetti nel pannello Oggetti cliccando e trascinando l’etichetta di un oggetto in questa
lista.

Figure 16.10: Allineamento alle linee di aiuto nel layout di stampa

Ci sono diverse opzioni di allineamento disponibili nel menu a tendina Allinea a sinistra (vedi fig-
ure_layout_common_align). Per usare una funzione di allineamento, si selezionano prima gli oggetti e poi si
clicca su una delle icone di allineamento:

• Allinea a sinistra o Allinea a destra;

• Allinea in alto o Allinea in fondo;

• Allinea al centro orizzontale o Allinea al centro Verticale.

Tutti gli oggetti selezionati saranno quindi allineati al loro comune rettangolo di delimitazione. Quando si spostano
oggetti sull’area di disegno, le linee di aiuto all’allineamento appaiono quando i bordi, i centri o gli angoli sono
allineati.

Proprietà comuni Oggetti

Gli oggetti del layout hanno un insieme di proprietà comuni che si trovano in fondo al pannello Proprietà
dell’oggetto: Posizione e dimensione, Rotazione, Cornice, Sfondo, ID oggetto, Variabili e Visualizzazione (vedi
figure_layout_common).
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Figure 16.11: Gruppi di Proprietà comuni in Proprietà dell’Oggetto
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Nota: L’icona Sovrascrittura definita dai dati accanto alla maggior parte delle opzioni significa che puoi associare
quella proprietà ad un layer, agli attributi degli oggetto, alla geometria o a qualsiasi altra proprietà di layout,
usando expressions o variables. Per ulteriori informazioni vedi data_definita.

• Il gruppo Posizione e Dimensione ti permette di definire la dimensione e la posizione del riquadro che
contiene l’oggetto (vedi Posizione e Dimensione per maggiori informazioni).

• La Rotazione imposta la rotazione dell’oggetto (in gradi).

• La Cornice mostra o nasconde la cornice intorno all’oggetto. Clicca su Colore e Spessore e il widget
Stile unione per regolare queste proprietà.

• Utilizza il menu Sfondo per impostare un colore di sfondo. Fai clic sul pulsante [Colore] per visualizzare
una finestra di dialogo in cui puoi scegliere un colore o un’impostazione personalizzata. La trasparenza può
essere regolata modificando le impostazioni del campo alfa.

• Utilizza il pulsante ID oggetto per creare una relazione con altri oggetti del layout di stampa. Questo viene
utilizzato con il server QGIS e altri potenziali client web. Puoi impostare un ID su un oggetto (ad esempio,
una mappa o un’etichetta), e poi il client web può inviare dati per impostare una proprietà (ad esempio, il
testo dell’etichetta) per quell’oggetto specifico. Il comando GetProjectSettings elenca gli oggetti e gli ID
disponibili in un layout.

• Visualizzazione ti aiuta ad impostare se e come l’oggetto può essere visualizzato: puoi, per esempio, appli-
care modo di miscelazione, regolare l’opacità dell’oggetto o Escludi oggetto dalle esportazioni.

Posizione e Dimensione

Estendendo le opzioni della finestra di dialogo New Item Properties con funzionalità definite dai dati, questo
gruppo permette di posizionare gli oggetti con precisione.

Figure 16.12: Finestra di dialogo Proprietà nuovo oggetto

• il numero specifico della pagina su cui posizionare l’oggetto;

• il punto di riferimento dell’oggetto;

• le coordinate X e Y del Punto di riferimento dell’oggetto nella pagina scelta. Il rapporto tra questi valori

può essere bloccato cliccando sul pulsante . Le modifiche apportate a un valore utilizzando il widget o

lo strumento Seziona/Sposta oggetto si rifletteranno in entrambi;

• il Larghezza e Altezza del perimetro di delimitazione dell’oggetto. Per quanto riguarda le coordinate, il
rapporto tra larghezza e altezza può essere bloccato.
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Visualizzazione

QGIS permette di effettuare visualizzazioni avanzate per gli oggetti del layout, proprio come per i layer vettoriali
e raster.

Figure 16.13: Visualizzazione

• Modalità fusione: con questo strumento puoi ottenere effetti che altrimenti sarebbero possibili solo usando
software specializzati per la manipolazione grafica. I pixel degli elementi di sovrapposizione e di sottofondo
possono essere mescolati in base alla modalità impostata (vedi Metodi di fusione per la descrizione di
ciascun effetto).

• Trasparenza : Con questo strumento Puoi rendere visibile l’oggetto sottostante nel lay-
out. Usa il cursore per adattare la visibilità del tuo oggetto alle tue esigenze. Puoi anche definire con
precisione la percentuale di visibilità nel menu accanto al cursore.

• Escludi oggetto dalle esportazioni: puoi decidere di rendere invisibile un oggetto in tutte le esportazioni.
Dopo aver attivato questa casella di controllo, l’oggetto non sarà incluso nell’esportazione in PDF, stampa
ecc.

Variabili

Variabili elenca tutte le variabili disponibili a livello di layout (che include tutte le variabili globali, di progetto
e di composizione). Gli oggetti mappa mappa includono anche le variabili delle impostazioni della mappa che
forniscono un facile accesso a valori come la scala della mappa, l’estensione e così via.

In Variabili, è anche possibile gestire variabili a livello di oggetto. Fai click sul pulsante per aggiungere una
nuova variabile personalizzata. Allo stesso modo, seleziona qualsiasi variabile a livello di elemento personalizzato

dall’elenco e fai click sul pulsante per rimuoverlo.

Maggiori informazioni sull’utilizzo delle variabili nella sezione Memorizzazione valori nelle Variabili.

16.2.2 L’Oggetto Mappa

L’oggetto mappa è la cornice principale che visualizza la mappa che hai disegnato nell’area di disegno della

mappa. Utilizza lo strumento Aggiungi Mappa seguendo items creation instructions per aggiungere un nuovo
oggetto mappa che potrai poi manipolare come esposto in Interagire con gli oggetti del layout.

Per impostazione predefinita, un nuovo oggetto mappa mostra lo stato attuale della map canvas con la sua es-
tensione e layer visibili. Puoi personalizzarlo grazie al pannello Proprietà dell’oggetto. Oltre a items common
properties, questo pannello ha le seguenti opzioni:

Proprietà principali

Nel gruppo Proprietà Principali (vedi figure_layout_map_map) del pannello Proprietà dell’oggetto mappa, le
opzioni disponibili sono:
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Figure 16.14: Pannello Proprietà Oggetto Mappa

• Il pulsante Aggiorna Anteprima per aggiornare la visualizzazione dell’oggetto mappa se la visualizzazione
nell’area della mappa è stata modificata. Da notare che la maggior parte delle volte, l’aggiornamento
dell’oggetto mappa viene attivato automaticamente dalle modifiche;

• La Scala per impostare manualmente la scala dell’oggetto mappa;

• La Rotazione mappa ti permette di ruotare in senso orario il contenuto dell’oggetto mappa in gradi. Qui può
essere definita la rotazione dell’area della mappa;

• Il SR permette di visualizzare il contenuto dell’oggetto mappa in qualsiasi CRS. L’impostazione predefinita
è Usa il SR del progetto;

• Disegna elementi sulla mappa ti permette di visualizzare nel layout di stampa annotazioni che sono
posizionati nell’area di disegno principale della mappa.

Layer

Per impostazione predefinita, l’aspetto dell’oggetto mappa è sincronizzato con la visualizzazione nell’area di
disegno della mappa, il che significa che la visibilità dei layer o la modifica del loro stile nel pannello Layer
viene applicata automaticamente all’oggetto mappa. Poiché, come qualsiasi altro elemento, puoi aggiungere più
oggetti mappa a un layout di stampa, c’è la necessità di interrompere questa sincronizzazione per permettere
di mostrare aree diverse, combinazioni di layer, a scale diverse. . . .. Le proprietà del gruppo Layer (vedi fig-
ure_layout_map_layers) ti aiutano a farlo.

Se vuoi mantenere l’oggetto mappa coerente con un esistente map theme, spunta Segui il tema mappa e
seleziona il tema desiderato nell’elenco a discesa. Tutte le modifiche apportate alla finestra principale di QGIS
(utilizzando la preimpostazione di sostituzione) verranno mostrate nell’oggetto mappa. Se viene selezionato un
tema mappa, l’opzione Blocca stili per i layer è disabilitata perché Segui il tema mappa aggiorna anche lo stile
(simbologia, etichette, diagrammi) dei layer.
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Figure 16.15: Gruppo Layer dell’oggetto Mappa

Per bloccare i layer mostrati in un oggetto mappa alla visibilità corrente della mappa, seleziona Blocca layer.
Quando questa opzione è abilitata, qualsiasi modifica della visibilità dei layer nella finestra principale di QGIS non
influisce sull’oggetto mappa del layout. Tuttavia, lo stile e le etichette dei layer bloccati sono ancora aggiornati in
accordo alla finestra principale di QGIS. Puoi evitare questo problema utilizzando Blocca stili per i layer.

Invece di utilizzare la mappa corrente, puoi anche bloccare i layer dell’oggetto mappa a quelli di un tema esistente:

seleziona un tema mappa dal pulsante a discesa Segui il tema mappa, e Blocca layer è attivata. L’insieme dei
layer visibili nel tema mappa è d’ora in poi utilizzato per l’oggetto mappa fino a quando non si seleziona un altro

tema mappa o si deseleziona l’opzione Blocca layer. Potrebbe essere necessario aggiornare la vista utilizzando

il pulsante Aggiorna la vista della barra degli strumenti Navigazione o il pulsante Aggiorna l’anteprima visto sopra.

Nota che, a differenza dell’opzione Segui il tema mappa, se l’opzione Blocca layer è abilitata e impostata su un
tema mappa, i layer nell’oggetto mappa non saranno aggiornati anche se il tema mappa è aggiornato (utilizzando
la funzione di sostituzione del tema) nella finestra principale di QGIS.

I layer bloccati nell’oggetto mappa possono anche essere data-defined, usando l’icona accanto all’opzione.
Quando viene utilizzato, sostituisce la selezione impostata nell’elenco a discesa. Devi costruire una lista di layer
separati da un carattere |`. Il seguente esempio blocca l’oggetto mappa ad usare solo i livelli layer 1 e layer
2:

concat ('layer 1', '|', 'layer 2')

Estensione mappa

Il gruppo Estensione mappa del pannello proprietà dell’oggetto mappa fornisce le seguenti funzionalità (vedi
figure_layout_map_extents):

Figure 16.16: Gruppo Estensione dell’oggetto Mappa

L’area Estensione mappa visualizza le coordinate X e Y dell’area mostrata nell’oggetto mappa. Ognuno di questi
valori può essere sostituito manualmente, modificando l’area di disegno della mappa visualizzata e/o le dimensioni
dell’oggetto mappa. Facendo clic sul pulsante Imposta all’estensione della mappa imposti l’estensione del layout

16.2. Oggetti del Layout 373



QGIS User Guide, Release 3.4

della mappa all’estensione della mappa principale. Il pulsante Vedi l’estensione sulla mappa fa esattamente il
contrario; aggiorna l’estensione della mappa principale fino all’estensione dell’oggetto layout mappa.

Puoi anche modificare l’estensione di un oggetto mappa usando lo strumento Sposta contenuto elemento: clicca e
trascina all’interno dell’oggetto mappa per modificare la sua visualizzazione corrente, mantenendo la stessa scala.

Con lo strumento attivato, usa la rotellina del mouse per ingrandire o rimpicciolire, modificando la scala della
mappa visualizzata. Combina il movimento con il tasto Ctrl premuto per avere uno zoom più piccolo.

Controllato da Atlante

Controllato da Atlante è disponibile solo se un atlas è attivo nel layout di stampa. Seleziona questa opzione
se vuoi che l’oggetto mappa sia governato dall’atlante; durante l’interazione sul layer di copertura, l’estensione
dell’oggetto mappa viene spostata/zoomata all’elemento dell’atlante seguente:

• Margine attorno all’elemento: ingrandisce l’elemento alla migliore scala, mantenendo intorno a cias-
cuno un margine che rappresenta una percentuale della larghezza o dell’altezza dell’elemento della mappa.
Il margine può essere lo stesso per tutte le caratteristiche o set variable, ad esempio, a seconda della scala
della mappa;

• Scala predefinita (miglior adattamento): ingrandisce l’elemento al progetto predefined scale dove
l’elemento dell’atlante si adatta meglio;

• Scala fissa: gli elementi dell’atlante vengono spostati uno dopo l’altro, mantenendo la stessa scala
dell’oggetto mappa. Ideale quando si lavora con elementi della stessa dimensione (ad esempio, una griglia)
o quando si desidera evidenziare le differenze di dimensione tra gli elementi dell’atlante.

Reticoli

Con le griglie, puoi aggiungere, sulla tua mappa, informazioni relative alla sua estensione o coordinate, sia nella
proiezione dell’oggetto mappa o in un altro oggetto. Il gruppo Reticoli offre la possibilità di aggiungere più reticoli
ad una mappa.

• Con i pulsanti e puoi aggiungere o rimuovere specifici reticoli.

• Con i pulsanti e puoi spostare su e giù un reticolo nell’elenco, quindi spostarla sopra o sotto un’altra,
sopra l’oggetto mappa.

Doppio-clic sul reticolo aggiunto per rinominarlo.

Figure 16.17: Finestra di dialogo Reticoli mappa

Dopo aver aggiunto un reticolo, puoi attivare la casella di controllo Disegna reticolo per consentire la sovrap-
posizione del reticolo sull’oggetto mappa. Premi il pulsante Modifica reticolo. . . per accedere alle opzioni di
configurazione.
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Aspetto del Reticolo

Come tipologia di reticolo, puoi scegliere di utilizzare:

• Pieno: mostra una linea che attraversa la cornice della griglia. Lo Stile linea può essere personalizzato
usando il widget di selezione color e simbolo;

• Croce: visualizza segmenti all’intersezione delle linee del reticolo, per il quale puoi impostare il valore Stile
linea e il valore Spessore della croce;

• Simboli: visualizza solo il simbolo personalizzabile all’intersezione delle linee del reticolo;

• o Solo cornice e annotazioni

Oltre alla tipologia di reticolo, puoi definire:

• il SR che potrebbe non essere lo stesso dell’oggetto mappa;

• il Intervallo tra due riferimenti consecutivi del reticolo nelle direzioni X e Y;

• il Intervallo Unità da utilizzare per i riferimenti della cornice, in Map units, Millimetri o
Centimetri;

• un Offset dai bordi dell’oggetto mappa, nelle direzioni X e Y;

• e la Modalità fusione del reticolo (vedi Metodi di fusione) quando compatibile.

Figure 16.18: Finestra di dialogo Disegna Reticolo

Cornice Reticolo

Ci sono diverse opzioni per modellare la cornice che contiene la mappa. Sono disponibili le seguenti
opzioni: Nessuna cornice, Zebrato, Tacche interne, Tacche esterne, Tacche interne
ed esterne e Bordo linea. Inoltre, puoi scegliere di rendere visibile o meno ogni lato della cornice del
reticolo.

Quando compatibile, è possibile impostare Dimensione cornice, Spessore linea cornice, Colori riempimento cor-
nice. Con le impostazioni Solo Latitudine/Y e Solo Longitudine/X nella sezione Divisioni hai la
possibilità di impedire che un mix di latitudine/Y e longitudine/X venga visualizzato su un lato quando si lavora
con mappe ruotate o griglie riproiettate.
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Figure 16.19: Finestra di dialogo Cornice Reticolo

Coordinate

Disegna coordinate ti consente di aggiungere le coordinate alla cornice della mappa. Puoi scegliere il formato
numerico dell’annotazione, le opzioni variano da decimale a gradi, minuti e secondi, con o senza suffisso, allineati
o meno e un formato personalizzato utilizzando la finestra di dialogo delle espressioni.

Puoi scegliere quale annotazione mostrare. Le opzioni sono: mostra tutte, solo latitudine, solo longitudine o dis-
abilita (nessuna). Questo è utile quando la mappa viene ruotata. L’annotazione può essere disegnata all’interno o
all’esterno della cornice della mappa. La direzione dell’annotazione può essere definita come orizzontale, verticale
ascendente o verticale discendente.

Infine, puoi scegliere il carattere dell’annotazione, il colore del carattere, la distanza dalla cornice della mappa e
la precisione delle coordinate rappresentate.

Panoramiche

A volte puoi avere più di una mappa nel layout di stampa e vuoi localizzare l’area di studio di un oggetto mappa su
un’altra mappa. Questo potrebbe essere, ad esempio, per aiutare i lettori di mappe a identificare l’area in relazione
al contesto geografico più ampio mostrato nella seconda mappa.

Il gruppo Panoramiche del pannello mappe ti aiuta a creare il collegamento tra due diverse estensioni di mappa e
fornisce le seguenti funzionalità:

Per creare una panoramica, seleziona l’oggetto mappa su cui vuoi mostrare l’estensione dell’altro oggetto mappa

ed espandere l’opzione Panoramica nel pannello Proprietà dell’oggetto. Quindi premi il pulsante per aggiun-
gere una panoramica.

Inizialmente questa panoramica si chiama “Panoramica 1” (vedi Figure_layout_map_overview). Puoi:

• Rinominarlo con un doppio-clic;

• Con i pulsanti e aggiungere o rimuovere panoramiche;

• Con i pulsanti e , spostare in alto e in basso una panoramica nell’elenco, quindi spostarla sopra o
sotto un altro oggetto mappa.

Quindi seleziona l’oggetto panoramica nell’elenco e seleziona Disegna la panoramica «<name_overview>»
per abilitare il disegno della panoramica sul riquadro selezionato. Puoi personalizzarla con:
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Figure 16.20: Finestra di dialogo Scrivi Coordinate

Figure 16.21: Gruppo Panoramiche della Mappa
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• L’elenco combinato Cornice della mappa può essere utilizzato per selezionare l’oggetto mappa la cui es-
tensione sarà disegnata sull’attuale oggetto mappa.

• Lo Stile cornice ti consente di modificare lo stile della cornice della panoramica.

• La Modalità fusione ti consente di impostare diverse modalità di fusione e trasparenza.

• La Inverti panoramica se attivata crea una maschera attorno alla estensione: la parte di mappa a cui si
fa riferimento è visualizzata in chiaro, mentre tutto il resto viene colorato con lo stesso colore della cornice.

• La Centra sulla panoramica mette l’estensione della cornice della panoramica centrata sulla mappa
panoramica. Puoi attivare solo una panoramica in modo centrato se si sono aggiunte diverse panoramiche.

16.2.3 L’Oggetto Etichetta

L’oggetto Etichetta è uno strumento per decorare la mappa con testi che aiutano a comprenderla; può essere il

titolo, l’autore, le fonti dati o qualsiasi altra informazione. . . .. Puoi aggiungere un’etichetta con lo strumento
Aggiungi Etichetta seguendo items creation instructions e manipolarla come esposto in Interagire con gli oggetti
del layout.

Per impostazione predefinita, l’oggetto etichetta fornisce un testo predefinito che è possibile personalizzare utiliz-
zando il pannello Proprietà dell’oggetto. Oltre a items common properties, questo pannello ha le seguenti opzioni
(vedi figure_layout_label):

Figure 16.22: Pannello Proprietà Oggetto Etichetta

Proprietà principali

Il gruppo Proprietà Principali è il luogo dove fornire il testo (può essere in HTML) o l’espressione per costruire
l’etichetta. Le espressioni devono essere circondate da [% e %] per essere interpretate come tali.

• Le etichette possono essere interpretate come codice HTML: spunta Visualizza come HTML. Ora puoi
inserire un URL, un’immagine cliccabile che si collega a una pagina web o qualcosa di più complesso.

• Puoi anche usare espressioni: clicca sul pulsante Inserisci un’Espressione. . . , scrivi la tua formula come al
solito e quando la finestra di dialogo viene completata, QGIS aggiunge automaticamente i caratteri risultanti.
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Nota: Facendo clic sul pulsante Inserisci un’Espressione. . . quando non viene effettuata alcuna selezione nella
casella di testo, la nuova espressione verrà aggiunta al testo esistente. Se vuoi aggiornare un testo esistente, è
necessario selezionare in anticipo la parte di interesse.

Puoi combinare le visualizzazioni HTML e le espressioni, per realizzare un testo, ad esempio, come:

[% '<b>Check out the new logo for ' || '<a href="https://www.qgis.org" title="Nice
→˓logo" target="_blank">QGIS ' ||@qgis_short_version || '</a>' || ' : <img src=
→˓"https://qgis.org/en/_downloads/qgis-icon128.png" alt="QGIS icon"/>' %]

che sarà visualizzato: Check out the new logo for QGIS 3.0 :

Aspetto

• Definisci il Carattere cliccando sul pulsante Carattere o un Colore carattere spingendo il pulsante color
widget

• Puoi specificare diversi margini orizzontali e verticali in mm. Questo è il margine dal bordo dell’oggetto
dal layout. L’etichetta può essere posizionata al di fuori dei limiti dell’etichetta, ad esempio per allineare
gli elementi dell’etichetta con altri elementi. In questo caso è necessario utilizzare valori negativi per il
margine.

• Utilizzare l’allineamento del testo è un altro modo per posizionare la tua etichetta. Può essere:

– Sinistra, Centro, Destra o Giustifica per Allineamento orizzontale.

– e In alto, Al centro, In basso per Allineamento verticale.

Usare le espressioni in un oggetto etichetta

Di seguito alcuni esempi di espressioni che puoi usare per popolare l’oggetto etichetta con informazioni interes-
santi - ricordati che il codice, o almeno la parte calcolata, dovrebbe essere circondato da [% e %] nel riquadro
Proprietà Principali:

• Visualizza un titolo con il valore corrente dell’elemento dell’atlante in «field1»:

'This is the map for ' || "field1"

o, scritto nella sezione Proprietà Principali

This is the map for [% "field1" %]

• Aggiunge una paginazione per l’elemento dell’atlante in realizzazione (ad esempio, Page 1/10):

concat( 'Page ', @atlas_featurenumber, '/', @atlas_totalfeatures )

• Restituisce la coordinata X dell’angolo in basso a sinistra di una mappa:

x_min( map_get( item_variables( 'Map 1' ), 'map_extent' ) )

• Restituisce il nome dei layer nell’oggetto del corrente layout “Mappa 1”, e formattati in un nome per riga:

array_to_string(
array_foreach(

map_get( item_variables( 'Map 1' ), 'map_layers' ), -- retrieve the layers
→˓list

layer_property( @element, 'name' ) -- retrieve each layer name
),
'\n' -- converts the list to string separated by breaklines

)
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16.2.4 L’Oggetto Legenda

L’oggetto Legenda è una casella o una tabella che spiega il significato dei simboli usati sulla mappa. Una legenda

è quindi legata ad un elemento della mappa. È possibile aggiungere una legenda con lo strumento Aggiungi
una nuova legenda al Layout seguendo items creation instructions e manipolarla come esposto in Interagire con
gli oggetti del layout.

Per impostazione predefinita, l’elemento legenda visualizza tutti i layer disponibili e può essere raffinato utiliz-
zando il pannello Proprietà dell’oggetto. A parte le items common properties, questo pannello ha le seguenti
funzionalità (vedi figure_layout_legend):

Figure 16.23: Pannello Proprietà Oggetto Legenda

Proprietà principali

La finestra di dialogo Proprietà principali del pannello legenda Proprietà dell’oggetto fornisce le seguenti opzioni
(vedi figure_layout_legend_ppt):

Figure 16.24: Legenda gruppo Proprietà principali

Nelle proprietà principali puoi:

• cambiare il titolo della legenda. Può essere reso dinamico usando l’impostazione data-defined override,
utile ad esempio quando si genera l’atlante;

• impostare Allineamento Titolo a Sinistra, Centro o Destra;

• scegliere a quale oggetto Mappa la legenda attuale farà riferimento tra quelle nell’elenco selezionato;
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• mandare a capo il testo della legenda su un dato carattere: ogni volta che il carattere appare, viene sostituito
da un’interruzione di riga;

• utilizzare Ridimensiona per adattare i contenuti per controllare che la legenda venga ridimensionata
automaticamente al contesto. Se non selezionato, la legenda non sarà ridimensionata e sarà impostata alla
dimensione scelta dall’utente. Qualsiasi contenuto che non rientra nel contesto sarà tagliato.

Oggetti della Legenda

Il gruppo Oggetti della Legenda del pannello Legenda di Proprietà dell’oggetto fornisce le seguenti funzionalità
(vedi figure_layout_legend_items):

Figure 16.25: Gruppo Oggetti della Legenda

• La legenda verrà aggiornata automaticamente se è selezionato Aggiorna automaticamente. Quando
Aggiorna automaticamente non è selezionato questo ti darà più controllo sulle voci legenda. Le icone sotto
l’elenco delle voci legenda saranno attivate.

• La finestra degli oggetti legenda elenca tutte gli oggetti legenda e consente di modificare l’ordine degli
oggetti, raggruppare i layer, rimuovere e ripristinare gli oggetti nell’elenco, modificare i nomi dei layer e
aggiungere un filtro.

– L’ordine degli oggetti può essere modificato utilizzando i pulsanti e , oppure con la funzionalità
“drag-and-drop”. L’ordine non può essere modificato per le legende WMS.

– Utilizza il pulsante per aggiungere un gruppo legenda.

– Utilizza il pulsante per aggiungere layer e il pulsante per rimuovere gruppi, layer o classi di
simboli.

– Il pulsante viene utilizzato per modificare il nome del layer, del gruppo o del titolo. In primo luogo
devi selezionare l’oggetto della legenda. Facendo doppio click sull’oggetto si apre anche la casella di
testo per rinominarlo.

– Il pulsante aggiunge il conteggio delle ricorrenze per ogni tipo di layer vettoriale.

– Con il pulsante Filtra la legenda in base al contenuto della mappa solo le voci di legenda degli oggetti visibili
nella mappa saranno elencate nella finestra di dialogo legenda. Questo strumento rimane disponibile

quando è attivo Aggiorna automaticamente.
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– Il pulsante Filtra legenda tramite espressione ti aiuta a filtrare quali delle voci della legenda di un layer
saranno visualizzate per un layer che ha oggetti diversificati (ad esempio, da una simbologia basata
su regole o categorizzata) si può specificare un’espressione booleana per rimuovere dall’albero della
legenda, stili che non hanno alcun elemento soddisfacente una condizione. Tieni presente che gli
elementi sono comunque conservati e mostrati nell’oggetto della mappa del layout.

Mentre il comportamento predefinito dell’oggetto legenda è quello di simulare l’albero del Pannello Layer,
visualizzando gli stessi gruppi, layer e classi di simbologia, facendo click con il pulsante destro del mouse
su uno oggetto sono disponibili opzioni per nascondere il nome del layer o alzarlo così come un gruppo
o sottogruppo. Nel caso in cui hai apportato alcune modifiche a un layer, puoi ripristinarle scegliendo
Ripristina ai valori predefiniti nel menu contestuale.

Dopo aver modificato la simbologia nella finestra principale di QGIS, puoi fare click su Aggiorna tutto per
adottare le modifiche nell’oggetto legenda del layout di stampa.

• Durante la generazione di un atlante con layers poligonali, è possibile filtrare gli oggetti di legenda che

si trovano al di fuori della scelta fatta per l’atlante corrente. Per farlo, seleziona l’opzione Mostra
solamente elementi all’interno della geometria dell’atlante.

Caratteri, Colonne, Simboli

Il gruppi Caratteri, Colonne e Simbolo del pannello Proprietà dell’oggetto della legenda forniscono le seguenti
funzionalità (vedi figure_layout_legend_fonts):

Figure 16.26: Gruppi Caratteri, Colonne e Simbolo della Legenda

• Puoi modificare il carattere del titolo della legenda, del gruppo, del sottogruppo e dell’elemento (layer) nella
voce legenda utilizzando il widget di selezione dei caratteri;

• Dai alle etichette un Colore usando il widget color selector. Il colore selezionato si applica a tutti gli
elementi carattere nella legenda;

• Le voci di legenda possono essere disposti su più colonne. Imposta il numero di colonne nel campo Con-
teggio . Questo valore può essere reso dinamico, ad esempio, seguendo le caratteristiche dell’atlante,
i contenuti delle legende, le dimensioni della cornice. . . ..
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– Uguale larghezza delle colonne imposta la stessa larghezza fra le colonne affiancate.

– L’opzione Dividi i layer consente di dividere le colonne della legenda per layer categorizzati o
graduati.

• Puoi anche modificare la larghezza e l’altezza del simbolo della legenda, impostare un colore e uno spessore
in caso di simbolo di layer raster.

Legenda WMS e Spaziatura

Il pannello Legenda WMS e Spaziatura gruppi della leggenda Proprietà dell’oggetto forniscono le seguenti opzioni
(vedi figure_layout_legend_wms):

Figure 16.27: Legenda WMS e Spaziatura gruppi

Quando hai aggiunto un layer WMS e inserisci un oggetto legenda, viene inviata una richiesta al server WMS
per fornire una legenda WMS. Questa legenda verrà mostrata solo se il server WMS fornisce la funzionalità
GetLegendGraphic. Il contenuto della legenda WMS sarà fornito come immagine raster.

Legenda WMS consente di regolare la Larghezza legenda e la Altezza legenda dell’immagine raster della legenda
WMS.

Spaziatura intorno al titolo, gruppo, sottogruppo, sottogruppo, simbolo, icona, etichetta, box, colonna o linea può
essere personalizzato attraverso questa finestra di dialogo.

16.2.5 L’oggetto Barra di Scala

Le barre di scala forniscono un’indicazione visiva della dimensione degli elementi e della distanza tra gli elementi

sulla mappa. Un oggetto barra di scala richiede un oggetto mappa. Usa lo strumento Aggiungi una nuova
Barra di Scala al layout seguendo items creation instructions per aggiungere un nuovo oggetto barra di scala che
si può poi manipolare come esposto in Interagire con gli oggetti del layout.

Per impostazione predefinita, un nuovo oggetto barra di scala mostra la scala della mappa aggiunta più recen-
temente. Puoi personalizzarla grazie al pannello Item Proprietà dell’oggetto. Oltre a items common properties,
questa scheda offre le seguenti funzionalità (vedi figure_layout_scalebar):

Proprietà principali

Il gruppo Proprietà principali del pannello Proprietà dell’oggetto della barra di scala fornisce le seguenti funzion-
alità (vedi figure_layout_scalebar_ppt):
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Figure 16.28: Pannello Proprietà Oggetto della Barra di scala

Figure 16.29: Gruppo Proprietà Principali della Barra di Scala

• Prima di tutto scegli a quale mappa vuoi aggiungere la barra di scala.

• Poi scegli lo stile della barra di scala. Hai a disposizione sei stili:

– Riquadro singolo e Riquadro doppio che contengono una o due linee con colori alternati;

– Linea con tacche al centro, Linea con tacche in basso o Linea con tacche in alto;

– Numerico che mostra semplicemente il rapporto di scala (ad esempio 1:50000).

Unità e Segmenti

I gruppi Unità e Segmenti del pannello Proprietà dell’oggetto della barra di scala forniscono le seguenti funzion-
alità (vedi figure_layout_scalebar_units):

In questi due gruppi, puoi impostare come sarà rappresentata la barra di scala.

• Selezionare le unità che vuoi utilizzare con Unità barra di scala. Ci sono molte possibilità di scelta: Unità
mappa (quella di default), Metri, Piedi, Miglia o Miglia nautiche. . . .. che possono forzare le conversioni
delle unità di misura.

• Moltiplicare unità etichetta specifica quante unità di scala a barre per unità etichettata. Ad esempio, se la tua
unità di misura è impostata su «metri», un moltiplicatore di 1000 provocherà le etichette in «chilometri».

• Il campo Etichetta per unità definisce il testo usato per descrivere le unità della barra di scala, ad esempio
m or km. Questo dovrebbe essere abbinato in modo da riflettere il moltiplicatore di cui sopra.

• Puoi scegliere quanti Segmenti devono essere disegnati a sinistra e a destra della barra di scala

• Puoi impostare quanto ogni segmento deve essere lungo (Larghezza fissata), o limitare le dimensioni della
barra della scala in mm con l’opzione Adatta la larghezza del segmento. In quest’ultimo caso, ogni volta
che la scala della mappa cambia, la barra della scala viene ridimensionata (e la sua etichetta aggiornata) per
adattarsi all’intervallo impostato.
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Figure 16.30: Gruppi Unità e Segmenti della Barra di scala

• Altezza serve per regolare lo spessore della barra.

Visualizza

Il gruppo Visualizza del pannello Proprietà dell’oggetto della barra di scala fornisce le seguenti funzionalità (vedi
figura_layout_scalebar_display_display):

Figure 16.31: Gruppo Visualizza della Barra di Scala

Puoi definire come verrà visualizzata la barra di scala nella sua cornice.

• Margine box: spazio tra i confini del testo e della cornice

• Margine etichette: spazio tra il testo delle etichette e la barra disegnata

• Spessore linea: larghezza della linea del disegno della barra di scala

• Stile unione: angoli alla fine della barra di scala in stile “Smussato”, “Seghettato” e “Arrotondato”, (opzione
disponibile solo per gli stili della barra di scala Riquadro singolo & Riquadro doppio)

• Stile testata: imposta la parte terminale delle tacche in stile “Quadrato”, “Rotondo” o “Piatto” (disponibile
solo per gli stili della barra di scala Linee con tacche al centro, Linee con tacche in basso o Linee con tacche
in alto)

• Allineamento: imposta il testo sul lato sinistro, metà o destro della cornice (funziona solo per lo stile della
barra di scala Numerico)

16.2. Oggetti del Layout 385



QGIS User Guide, Release 3.4

Caratteri e colori

Il gruppo Caratteri e Colori del pannello Proprietà dell’oggetto della Barra di scala fornisce le seguenti opzioni
(vedi figure_layout_scalebar_fonts):

Figure 16.32: Gruppi Caratteri e Colori della Barra di scala

Puoi definire i caratteri e i colors utilizzati per la barra di scala.

• Utilizza il pulsante Carattere per impostare il carattere dell’etichetta della barra di scala

• Colore carattere: imposta il colore del carattere

• Colore di riempimento: imposta il primo colore di riempimento

• Colore di riempimento secondario: imposta il secondo colore di riempimento

• Colore della linea: imposta il colore delle righe della barra di scala

I colori di riempimento sono usati solo per gli stili Riquadro singolo e Riquadro doppio.

16.2.6 L’oggetto Tabella degli Attributi

Ogni layer del progetto può avere i suoi attributi visualizzati nel layout di stampa. Puoi usarlo per decorare

e spiegare la tua mappa con informazioni sui relativi dati. Usa lo strumento Aggiungi una nuova Tabella
Attributi al layout seguendo items creation instructions per aggiungere un nuovo elemento mappa che potrai poi
manipolare come esposto in Interagire con gli oggetti del layout.

Per impostazione predefinita, un nuovo oggetto tabella degli attributi carica le prime righe del primo (ordinato
alfabeticamente) layer, con tutti i campi. Puoi comunque personalizzare la tabella grazie al suo pannello Pro-
prietà dell’oggetto. Oltre alle items common properties, questa pannello ha le seguenti funzionalità (vedi fig-
ure_layout_table):

Proprietà principali

Il gruppo Proprietà Principali della tabella degli attributi fornisce le seguenti funzionalità (vedi fig-
ure_layout_table_ppt):

• In Sorgente per impostazione predefinita puoi solo selezionare Etichetta le geometrie che consente di
selezionare un Vettore dai layer vettoriali caricati nel progetto.

Il pulsante Sovrascrittura definita dai dati vicino alla lista Vettore ti permette di cambiare dinamicamente il
vettore che viene utilizzato per popolare la tabella, ad esempio puoi riempire la tabella degli attributi con
diversi attributi del vettore per ogni pagina dell’atlante. Nota che la struttura della tabella utilizzata (column
settings) è quella del vettore mostrato nell’elenco a discesa Vettore ed è lasciata intatta, il che significa che
impostando una tabella definita dai dati ad un vettore con campi diverso(i) si otterranno colonna(e) vuote
nella tabella.

Nel caso in cui attivi l’opzione Genera un atlante nel pannello Atlante (vedi Generazione Atlante), ci
sono due ulteriori possibili Sorgenti:
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Figure 16.33: Pannello Proprietà Oggetto per la Tabella degli attributi

Figure 16.34: Gruppo Proprietà Principali della Tabella degli Attributi
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– Geometria atlante attuale (vedi figure_layout_table_atlas): non vedrai nessuna opzione per scegliere
il layer, e l’oggetto tabella mostrerà solo una riga con gli attributi dell’oggetto corrente del layer di
copertura dell’atlante.

– e Relazione figlio (vedi figure_layout_table_relation): apparirà un’opzione con i nomi delle relazioni.
Questa opzione può essere usata solo se si è definita una relazione usando il layer di copertura
dell’atlante come genitore, e la tabella mostrerà le righe dei figli dell’oggetto corrente del layer di
copertura dell’atlante.

• Il pulsante Aggiorna i Dati della Tabella può essere usato per aggiornare la tabella quando il contenuto
effettivo della tabella è cambiato.

Figure 16.35: Proprietà principali Tabella degli Attributi per il layer corrente dell’atlante

Figure 16.36: Proprietà principali Tabella degli Attributi per “Relazione figlio”

• Il pulsante Attributi. . . . avvia la finestra di dialogo Seleziona Attributi, (vedi figure_layout_table_select)
che può essere utilizzata per modificare il contenuto visibile della tabella. La parte superiore della finestra
mostra l’elenco degli attributi da visualizzare e la parte inferiore aiuta a ordinare i dati.

Nella sezione Colonne puoi:

– Spostare gli attributi in alto o in basso nell’elenco selezionando le righe e quindi utilizzando i pulsanti

e per spostare le righe. È possibile selezionare e spostare più righe contemporaneamente.

– Aggiungere un attributo con il pulsante . Questo aggiungerà una riga vuota in fondo alla
tabella dove è possibile selezionare un campo come valore dell’attributo o creare un attributo tramite
un’espressione regolare.

– Rimuovere un attributo con il pulsante . È possibile selezionare e rimuovere più righe contempo-
raneamente.

– Ripristinare la tabella degli attributi al suo stato predefinito con il pulsante Ripristina.

– Cancellare la tabella usando il pulsante Cancella. Questo è utile quando hai una tabella grande, ma
vuoi mostrare solo un piccolo numero di attributi. Invece di rimuovere manualmente ogni riga, può
essere più veloce per cancellare la tabella e aggiungere le righe necessarie.

– Le intestazioni delle celle possono essere modificate aggiungendo il testo personalizzato nella colonna
Intestazione.

– L’allineamento delle celle può essere gestito con Allineamento colonna che determinerà la posizione
dei testi all’interno della celle della tabella.

– La larghezza delle celle può essere gestita manualmente aggiungendo valori personalizzati alla colonna
Larghezza.

388 Chapter 16. Layout di stampa



QGIS User Guide, Release 3.4

Figure 16.37: Finestra di dialogo Selezione attributi della Tabella degli Attributi

Nella sezione Ordina puoi:

– Aggiungere un attributo con cui ordinare la tabella. Seleziona un attributo e imposta l’ordine di ordina-

mento su Crescente o Decrescente e premi il pulsante . Una nuova riga viene aggiunta all’elenco
ordina.

– selezionare una riga nell’elenco e utilizza i pulsanti e per modificare la priorità di ordinamento
a livello di attributo. Selezionando una cella nella colonna Tipo ordinamento ti aiuta a modificare
l’ordinamento sul campo attributo.

– utilizzare il pulsante per rimuovere un attributo dalla lista in ordinamento.

Filtro delle geometrie

Il gruppo Filtro delle Geometrie della tabella degli attributi fornisce le seguenti funzionalità (vedi fig-
ure_layout_table_filter):

Figure 16.38: Gruppo Filtro Geometrie della Tabella degli Attributi

Puoi:
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• Definire il Numero massimo righe da visualizzare.

• Attivare Elimina righe duplicate dalla tabella per mostrare solo records univoci.

• Attivare Mostra solo le geometrie visibili nella mappa e seleziona la corrispondente Mappa collegata i
cui attributi delle geometrie visibili saranno mostrati.

• Attivare Mostra solo le geometrie che intersecano le geometrie dell’Atlante è disponibile solo quando è

attivato Genere un atlante. Quando attivato, mostrerà una tabella con solo le geometrie che intersecano
la geometria corrente dell’atlante.

• Attivare Filtra con e fornire un filtro digitandolo nella riga di input o inserire un’espressione regolare

usando il pulsante visualizzato. Alcuni esempi di istruzioni di filtraggio che puoi utilizzare quando hai
caricato il layer degli aeroporti dal dataset del campione dati:

– ELEV > 500

– NAME = 'ANIAK'

– NAME NOT LIKE 'AN%'

– regexp_match( attribute( $currentfeature, 'USE' ) , '[i]')

L’ultima espressione includerà solo gli aeroporti che hanno la lettera ‘i’ nel campo attributi ‘USE’.

Aspetto

Il gruppo Aspetto della tabella degli attributi fornisce le seguenti funzionalità (vedi fig-
ure_layout_table_appearance):

Figure 16.39: Gruppo Aspetto della tabella degli attributi

• Fai clic su Mostra righe vuote per riempire la tabella degli attributi con celle vuote. Questa opzione può
anche essere utilizzata per fornire ulteriori celle vuote quando hai un risultato da mostrare!

• Con Margini cella puoi definire il margine intorno al testo in ciascuna cella della tabella.

• Con Mostra intestazione puoi scegliere una delle opzioni in elenco: “Sulla prima cornice”, “Su tutte le
cornici” o “Nessuna intestazione”.

• L’opzione Tabelle vuote controlla ciò che verrà visualizzato quando la selezione risultante è vuota:

– Disegna solo le intestazioni, disegna solo l’intestazione, tranne se si è scelto “Nessuna intestazione”
in Mostra intestazione.
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– Nascondi intera tabella, viene disegnato solo lo sfondo della tabella. Puoi attivare Non disegnare
lo sfondo se la cornice è vuota in Cornici per nascondere completamente la tabella.

– Mostra messaggio impostato, disegna l’intestazione e aggiunge una cella che attraversa tutte le
colonne e visualizza un messaggio come “Nessun risultato” tche può essere fornito nell’opzione Mes-
saggio da visualizzare.

• L’opzione Messaggio da mostrare si attiva solo quando hai selezionato Mostra messaggio impostato per
Tabelle vuote. Quando il risultato è una tabella vuota il messaggio verrà mostrato nella prima riga della
tabella.

• Con Colore di sfondo puoi impostare il colore di sfondo della tabella utilizzando il widget color selector.
L’opzione Personalizzazione avanzata. . . ti aiuta a definire diversi colori di sfondo per ogni cella (vedi
figure_layout_table_background).

Figure 16.40: Finestra di dialogo Colori di sfondo della Tabella degli attributi

• Con l’opzione Testo a capo con puoi definire un carattere sul quale il contenuto della cella sarà mandato a
capo ogni volta che viene incontrato.

• Con Testo fuori misura definisci il comportamento quando la larghezza impostata per una colonna è inferiore
alla lunghezza del suo contenuto. Può essere Testo a capo o Tronca testo.

Visualizza reticolo

Il gruppo Visualizza reticolo della tabella degli attributi fornisce le seguenti funzionalità (vedi fig-
ure_layout_table_grid):

Figure 16.41: Gruppo Visualizza reticolo della tabella degli attributi
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• Attiva Visualizza reticolo quando vuoi visualizzare il reticolo, i contorni delle celle della tabella. Puoi
anche selezionare Disegna linee orizzontali o Disegna linee verticali o entrambe.

• Con Spessore linea puoi impostare lo spessore delle linee utilizzate nel reticolo.

• Il Colore del reticolo può essere impostato utilizzando il widget di selezione del colore.

Caratteri e stile testo

Il gruppo Caratteri e Stile Testo della tabella degli attributi fornisce le seguenti funzionalità (vedi fig-
ure_layout_table_fonts):

Figure 16.42: Gruppo Caratteri e Stile Testo della Tabella degli Attributi

• Puoi definire Carattere e Colore per Intestazione Tabella e Contenuti Tabella, utilizzando caratteri e widget
di selezione del colore.

• Per Intestazione Tabella puoi inoltre impostare il parametro Allineamento su Segui l'allineamento
della colonna oppure sovrascrivere questa impostazione scegliendo Sinistra, Centro o Destra.
L’allineamento delle colonne viene impostato usando la finestra di dialogo Seleziona Attributi (vedi fig-
ure_layout_table_select).

Cornici

Il gruppo Cornici delle proprietà della tabella degli attributi fornisce le seguenti funzionalità (vedi fig-
ure_layout_table_frames):

Figure 16.43: Gruppo Cornici della Tabella degli Attributi

• Con Modalità ridimensionamento puoi scegliere come visualizzare il contenuto della tabella degli attributi:

– Usa cornici esistenti visualizza il risultato nella prima cornice e solo nelle cornici aggiunte.

– Estendi fino a pagina creerà tutte le cornici (e le pagine corrispondenti) necessarie per visu-
alizzare la selezione completa della tabella degli attributi. Ogni cornice può essere spostata sul layout.
Se si ridimensiona una cornice, la tabella risultante sarà divisa tra le altre cornici. L’ultima cornice
sarà ritagliata per adattarsi alla tabella.
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– Ripeti fino alla fine creerà anche tante cornici quante sono con l’opzione Estendi fino a
pagina successiva, tranne che tutte le cornici avranno la stessa dimensione.

• Usa il pulsante Aggiungi cornice per aggiungere un altra cornice con le stesse dimensioni della cornice
selezionata. Il risultato della tabella che non rientra nella prima cornice continuerà nella cornice successiva
quando si utilizza la modalità di ridimensionamento Usa cornici esistenti.

• Attiva Non esportare la pagina se la cornice è vuota impedisce di esportare la pagina quando il riquadro
della tabella non ha contenuto. Questo significa che tutti gli altri elementi del layout, mappe, barra di scala,
legende, ecc. non saranno visibili nel risultato.

• Attiva Non disegnare lo sfondo se la cornice è vuota per non avere lo sfondo quando la cornice non ha
contenuti della tabella.

16.2.7 L’Oggetto Immagine

L’oggetto Immagine è uno strumento che aiuta a decorare la mappa con immagini, loghi. . . .. È anche quello

che fornisce al suo interno le frecce nord. Puoi aggiungere un’immagine con Aggiungi Immagine seguendo items
creation instructions e manipolarla come esposto in Interagire con gli oggetti del layout.

Per impostazione predefinita, l’oggetto immagine è una cornice vuota che è possibile personalizzare utilizzando
il pannello Proprietà dell’oggetto. A parte il pannello items common properties, questo oggetto ha le seguenti
opzioni (vedi figure_layout_image):

Figure 16.44: Pannello Immagine delle Proprietà dell’oggetto

Per prima cosa devi selezionare l’immagine che vuoi visualizzare. Ci sono diversi modi per impostare Sorgente
dell’immagine:

1. Nel gruppo Proprietà Principali, usa il pulsante . . . . Browse di Sorgente dell’immagine per selezionare un file
sul tuo computer. Il browser si avvierà nelle librerie SVG fornite con QGIS. Oltre a SVG, è anche possibile
selezionare altri formati immagine come .png o .jpg.
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2. Puoi inserire il sorgente direttamente nel campo di testo Sorgente dell’immagine. Puoi anche fornire un
indirizzo URL remoto ad un’immagine.

3. Dall’area Cartelle di Ricerca puoi anche selezionare un’immagine dalle anteprime caricate per impostare
la sorgente dell’immagine. Queste immagini sono fornite di default dalle cartelle impostate in Impostazioni
→ Opzioni → Sistema → Percorsi SVG.

4. Usa il pulsante sovrascrittura definita dai dati per impostare la sorgente immagine da un attributo di un elemento
o usando un’espressione regolare.

Nota: Nel gruppo Cartelle di Ricerca, puoi utilizzare i pulsanti Aggiungi. . . . e Rimuovi per personalizzare
l’elenco delle cartelle da cui recuperare e visualizzare in anteprima le immagini.

Con l’opzione Modalità ridimensionamento, puoi impostare come l’immagine viene visualizzata quando la cor-
nice viene ridimensionata:

• Zoom: ingrandisce/riduce l’immagine alla cornice mantenendo le proporzioni nella restituzione
dell’immagine;

• Stiramento: stira l’immagine per adattarla all’interno della cornice, ignora le proporzioni;

• Ritaglia: usa questa modalità solo per le immagini raster, imposta la dimensione dell’immagine alla
dimensione originale dell’immagine senza ridimensionamento e la cornice viene utilizzata per ritagliare
l’immagine, quindi solo la parte dell’immagine all’interno della cornice è visibile;

• Zoom e ridimensiona la cornice: ingrandisce l’immagine per adattarla alla cornice, poi ridi-
mensiona la cornice per adattarla all’immagine risultante;

• Ridimensiona la cornice alla dimensione dell'immagine: imposta la dimensione
della cornice in modo che corrisponda alla dimensione originale dell’immagine senza ridimensionamento.

A seconda delle Modalità ridimensionamento, le opzioni Posizionamento e Rotazione dell’immagine sono dis-
abilitate o meno. Con Posizionamento puoi scegliere la posizione dell’immagine all’interno della cornice. I file
.SVG forniti per impostazione predefinita da QGIS sono personalizzabili, il che significa che puoi applicare facil-
mente diversi Colore di riempimento, Colore tratto (compresa l’opacità) e Spessore tratto rispetto all’originale,
utilizzando la funzione corrispondente nel gruppo Parametri SVG. Queste proprietà possono anche essere in data-
defined.

Se aggiungi un file .SVG che non abilita queste proprietà, potrebbe essere necessario aggiungere i seguenti tag al
file per aggiungere supporto, ad esempio per la trasparenza:

• fill-opacity=»param(fill-opacity)»

• stroke-opacity=»param(outline-opacity)»

Per vedere un esempio puoi leggere questo blog post .

Le immagini possono essere ruotate con il campo Rotazione immagine. Attivando la casella di controllo
Sincronizza con la mappa sincronizza la rotazione dell’immagine con la rotazione applicata all’oggetto mappa
selezionato; questa è una comoda opzione per le frecce nord che puoi allineare con:

• la direzione Nord del reticolo: direzione di una linea del reticolo parallela al meridiano centrale sul reticolo
nazionale/locale;

• o la direzione Nord vero: direzione di un meridiano di longitudine che converge sul Polo Nord.

Puoi inoltre applicare una declinazione Offset alla rotazione dell” immagine.

Nota: Molte delle frecce nord non hanno un “N” aggiunto nella freccia nord, questo è fatto appositamente per le
lingue che non utilizzano la lettera “N” per il Nord, in modo che possano utilizzare un’altra lettera.
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Figure 16.45: Frecce Nord disponibili nella libreria SVG di installazione

16.2.8 La cornice HTML

È possibile aggiungere una cornice che visualizza i contenuti di un sito web o addirittura creare e modellare la

propria pagina HTML e visualizzarla! È possibile aggiungere un’immagine con Aggiungi HTML seguendo
items creation instructions e manipolarla come esposto in Interagire con gli oggetti del layout.

L’oggetto HTML può essere personalizzato utilizzando il pannello Proprietà dell’oggetto. A parte quanto visto in
items common properties, questo pannello ha le seguenti opzioni (vedi figure_layout_html):

Figure 16.46: Cornice HTML, il Pannello Proprietà oggetto
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Sorgente HTML

Il gruppo Sorgente HTML della Cornice HTML del pannello Proprietà dell’oggetto fornisce le seguenti funzion-
alità (vedi figure_layout_html_ppt):

Figure 16.47: Cornice HTML, le proprietà Sorgente HTML

• Nell” URL puoi inserire l’URL di una pagina web che hai copiato dal tuo browser Internet o se-

lezionare un file HTML usando il pulsante . . . . Sfoglia. C’è anche la possibilità di usare il pulsante
Sovrascrittura definita dai dati, per fornire un URL dal contenuto di un campo attributo di una tabella o usando
un’espressione regolare.

• In Sorgente puoi inserire il testo nella casella con tag HTML o fornire una pagina HTML completa.

• Il pulsante Inserisci un’Espressione può essere usato per inserire un’espressione come
‘‘[%Year($now)%]‘‘nella casella di testo della Sorgente per visualizzare l’anno corrente. Questo
pulsante viene attivato solo quando è selezionato il pulsante di opzione Sorgente. Dopo aver inserito
l’espressione clicca da qualche parte nella casella di testo prima di aggiornare la cornice HTML, altrimenti
perderai l’espressione.

• Attiva Valuta le espressioni QGIS in HTML per vedere il risultato dell’espressione che hai incluso.

• Usa il pulsante Aggiorna HTML per aggiornare la(e) cornice(i) HTML e vedere il risultato delle modifiche.

Cornici

Il gruppo Cornici della Cornice HTML del pannello Proprietà dell’oggetto fornisce le seguenti opzioni (vedi
figure_layout_html_frames):

Figure 16.48: Cornice HTML, proprietà cornici

• Con Modalità ridimensionamento puoi scegliere come visualizzare il contenuto HTML

– Usa cornici esistenti visualizza il risultato nella prima cornice e solo nelle cornici aggiunte.

– Estendi fino a pagina successiva creerà tante cornici (e le pagine corrispondenti)
quante necessarie per essere visualizzate nell’altezza della pagina web. Ogni cornice può essere
spostata sul layout. Se si ridimensiona una cornice, la pagina web sarà suddivisa tra le altre cornici.
L’ultima cornice sarà ridotta per adattarsi al contenuto residuo della pagina web.
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– Ripeti su ogni pagina ripeterà la parte superiore sinistra della pagina web su ogni pagina in
cornici della stessa dimensione.

– Ripeti fino alla fine creerà anche tante cornici come per l’opzione Estendi fino a
pagina successiva, ma tutte le cornici avranno la stessa dimensione.

• Utilizza il pulsante Aggiungi cornice per aggiungere un’altra cornice con la stessa dimensione della cornice
selezionata. Se la pagina HTML non si inserisce nella prima cornice, continuerà nella cornice successiva
quando utilizzi la Modalità ridimensionamento o Usa cornici esistenti.

• Attiva Non esportare la pagina se la cornice è vuota impedisce l’esportazione del layout della mappa
quando la cornice non contiene contenuti HTML. Questo significa che tutti gli altri elementi del layout,
mappe, barre di scala, legende, ecc. non saranno visibili nel risultato.

• Attiva Non disegnare lo sfondo se la cornice è vuota impedisce che la cornice HTML venga disegnata
se il contenuto della cornice è vuoto.

Usa Interruzioni di Pagina Intelligenti e fogli di stile Utente

Le finestre di dialogo Usa Interruzioni di Pagina Intelligenti e Foglio di stile Utente della Cornice HTML in
Proprietà dell’oggetto forniscono le seguenti opzioni (vedi figure_layout_html_breaks):

Figure 16.49: Proprietà Cornice HTML, Usa interruzioni di pagina intelligente e Foglio di stile utente

• Attiva Usa interruzioni di pagina intelligenti per impedire che i contenuti della cornice HTML vadano
a capo a metà strada di una riga di testo in modo che venga proposta in modo adeguato e senza interruzioni
nella cornice successiva.

• Imposta Distanza massima per definire dove posizionare le interruzioni di pagina nell’HTML. Questa dis-
tanza è la quantità massima di spazio vuoto consentito in fondo a una cornice dopo aver calcolato la po-
sizione di rottura ottimale. L’impostazione di un valore più grande determinerà una migliore scelta della
posizione di interruzione della pagina, ma più spazio sprecato nella parte inferiore delle cornici. Questa
opzione viene utilizzata solo quando viene attivato l’uso delle interruzioni delle pagine intelligenti.

• Attiva Foglio di stile utente per applicare gli stili HTML spesso forniti nei fogli di stile a cascata. Un
esempio di codice di stile è fornito di seguito per impostare il colore del <h1> tag di intestazione in verde
e impostare il font e la dimensione del font in verde del testo incluso nei tag di paragrafo <p>.

h1 {color: #00ff00;
}
p {font-family: "Times New Roman", Times, serif;

font-size: 20px;
}

• Usa il pulsante Aggiorna HTML per vedere il risultato del foglio di stile definito.
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16.2.9 Oggetti Forma

QGIS fornisce un paio di strumenti per disegnare forme regolari o più complesse sul layout di stampa.

Nota: A differenza di altri oggetti del layout di stampa, non puoi applicare stili alla cornice né definire il colore
di sfondo della cornice di delimitazione delle forme (impostata per impostazione predefinita su trasparente).

L” Oggetto Forma Regolare

L’oggetto Forma è uno strumento che permette di decorare la mappa con forme regolari come triangolo, rettangolo,

ellisse. . . .. Puoi aggiungere una forma regolare usando lo strumento Aggiungi forma che dà accesso a particolari

strumenti come Aggiungi Rettangolo, Aggiungi Ellisse e Aggiungi Triangolo. Una volta selezionato lo strumento
appropriato, puoi disegnare l’oggetto seguendo items creation instructions. Come altri oggetti del layout, una
forma regolare può essere manipolata nello stesso modo in Interagire con gli oggetti del layout.

Nota: Tenendo premuto il tasto Shift mentre stai disegnando la forma di base con il metodo clic e sposta crei
un un quadrato, un ellisse o un triangolo perfetto.

L’oggetto forma predefinito può essere personalizzato utilizzando il pannello Proprietà dell’oggetto. Oltre a items
common properties, questo pannello ha le seguenti opzioni (vedi figure_layout_label):

Figure 16.50: Pannello Proprietà Principali dell” Oggetto Forma

Il gruppo Proprietà Principali mostra e permette di cambiare il tipo di oggetto di forma (Ellisse, Rettangolo o
Triangolo) all’interno della cornice data.

Puoi impostare lo stile della forma utilizzando il widget avanzato di selezione simbolo e color .

Per la forma rettangolo, puoi impostare in unità diverse il valore del Raggio degli angoli per arrotondare gli angoli.

Oggetti Forma a Nodi

Mentre lo strumento Aggiungi Forma fornisce il modo per creare elementi geometrici semplici e predefiniti,

lo strumento Aggiungi Nodo aiuta a creare un elemento geometrico personalizzato e più complesso. Per
polilinee o poligoni, puoi disegnare tutte le linee o i lati che vuoi e i vertici degli elementi possono essere manipo-

lati indipendentemente e direttamente utilizzando lo strumento Modifica Nodi. L’oggetto stesso può essere
manipolato come esposto in Interagire con gli oggetti del layout.

Per aggiungere una forma a base di nodi:
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1. Clicca l’icona Aggiungi Nodo

2. Seleziona gli strumenti Aggiungi Poligono o Aggiungi Polilinea

3. Esegui clic consecutivi con tasto sinistro per aggiungere nodi del tuo oggetto. Se tieni premuto il tasto
Shift mentre disegni un segmento, sarà vincolato a seguire un orientamento multiplo di 45°.

4. Quando hai finito, clicca col destro per terminare la forma.

Puoi personalizzare l’aspetto della forma nel pannello Proprietà dell’oggetto

Figure 16.51: Pannello Poligono Nodo nelle Proprietà dell’oggetto

Nelle Proprietà Principali, puoi impostare lo stile della forma utilizzando il widget avanzato di selezione simbolo
e color.

Per gli oggetti polilinea a nodi, puoi anche parametrizzare il parametro Simboli Linea ad esempio:

• simboli di inizio e/o fine con opzioni:

– Nessuno: disegna una polilinea semplice.

– Freccia: aggiunge in punta una normale freccia triangolare che è possibile personalizzare.

– simbolo SVG: utilizza come freccia un file SVG all’estremità dell’elemento.

• personalizzare la testa della freccia:

– Colore tratto della freccia: imposta il colore di contorno della testa della freccia.

– Colore riempimento freccia: imposta il colore di riempimento della testa della freccia .

– Spessore tratto della freccia: imposta lo spessore del contorno della testa della freccia.

– Larghezza punta freccia: imposta la dimensione della testa della freccia.

Le immagini SVG vengono ruotate automaticamente con la linea. I colori predefiniti di QGIS per le linee e per
il riempimento delle immagini SVG possono essere modificati utilizzando le opzioni corrispondenti. Le SVG
personalizzate possono chiedere di definire alcuni tag seguendo queste instruction.

L’oggetto Freccia

Lo strumento Aggiungi Freccia è una scorciatoia per creare una polilinea con freccia, che quindi ha le stesse
proprietà e lo stesso comportamento di una polilinea a nodi.

In realtà, l’oggetto freccia può essere utilizzato per aggiungere una semplice freccia, ad esempio, per mostrare la
relazione tra due diversi oggetti del layout di stampa. Tuttavia, per creare una freccia nord, la freccia image item
dovrebbe essere considerata la scelta migliore in quanto dà accesso ad una serie di frecce nord nel formato .SVG
che è possibile sincronizzare con un oggetto della mappa in modo che ruoti automaticamente con esso.
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Figure 16.52: Pannello Polilinea Nodo nelle Proprietà dell’oggetto

Modificare un oggetto geometria a nodi

Per la modifica di forme basate su nodi viene fornito uno strumento specifico tramite Modifica nodi. All’interno
di questa modalità, è possibile selezionare un nodo facendo clic su di esso (un marcatore viene visualizzato sul
nodo selezionato). Un nodo selezionato può essere spostato trascinandolo o utilizzando i tasti freccia. Inoltre,
in questa modalità, puoi aggiungere nodi a una forma esistente: fai doppio clic su un segmento e un nodo viene
aggiunto nel punto in cui hai fatto clic. Infine, puoi rimuovere il nodo attualmente selezionato premendo il tasto
Del.

16.3 Creare un Output

La figure below mostra un esempio di layout di stampa che include ogni tipo di layout di oggetti descritto nella
sezione precedente.

Dal menu Layout o dalla barra degli strumenti, puoi stampare il layout di stampa in diversi formati di file, ed è
possibile modificare la risoluzione (qualità di stampa) e le dimensioni della carta:

• L’icona Stampa ti consente di stampare il layout su una stampante collegata o su un le Postscript, a
seconda dei driver di stampa installati.

• L’icona Esporta come immagine esporta il layout di stampa in diversi formati immagine come PNG, BMP, TIF,
JPG, e molti altri. . . .

• L’icona Esporta come SVG. . . salva il layout di stampa come SVG (Scalable Vector Graphic).

• L’icona Esporta come PDF. . . salva il layout di stampa definito direttamente come file PDF.
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Figure 16.53: Layout di stampa con visualizzazione della mappa, legenda, immagine, barra di scala, coordinate,
testo e cornice HTML aggiunti

16.3.1 Impostazioni per l’esportazione

Ogni volta che esporti un layout di stampa, vi è una selezione di impostazioni di esportazione che QGIS deve
controllare per restituire l’output più appropriato. Queste configurazioni sono:

• Le Export settings del pannello Layout, come Risoluzione di esportazione, Stampa come raster, Esporta
sempre come vettori o Salva il file world;

• Escludi pagina dalle esportazioni nel pannello page item properties;

• Escludi oggetto dalle esportazioni nel pannello item properties.

16.3.2 Esportare in formato Immagine

Cliccando sull’icona Esporta come Immagine. . . ti chiederà di selezionare il formato immagine e di inserire il nome
del file da utilizzare per esportare il layout di stampa: in caso di composizione a più pagine, ogni pagina verrà
esportata in un file con il nome indicato, cui verrà aggiunto il numero di pagina.

Nella finestra di dialogo successiva Opzioni di esportazione, è possibile sovrascrivere facoltativamente la
risoluzione del layout di stampa e le dimensioni della pagina esportata (imposta in Layout panel).

Selezionando l’opzione ||checkbox| Taglia al Contenuto, l’immagine prodotta dal layout includerà l’area minima
che racchiude tutti gli elementi (mappa, legenda, barra di scala, forme, etichetta, immagine. . . .) di ogni pagina
della composizione:

• Se la composizione include una singola pagina, allora l’output viene ridimensionato per includere TUTTO
nella composizione. La pagina può quindi essere ridotta o estesa a tutti gli oggetti a seconda della loro
posizione (sopra, sopra, sotto, a sinistra o a destra della pagina).

• Nel caso di un layout a più pagine, ogni pagina sarà ridimensionata per includere gli oggetti nella sua area
(lati destro e sinistro per tutte le pagine, più in alto per la prima pagina e in basso per l’ultima pagina). Ogni
pagina ridimensionata viene esportata in un file separato.
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La finestra di dialogo Tagia al Contenuto permette anche di aggiungere dei margini intorno ai limiti ritagliati.

Figure 16.54: Opzioni di esportazione delle immagini, l’output viene ridimensionato alla estensione degli oggetti

Suggerimento: Utilizza formati immagine che supportano la trasparenza quando gli oggetti si estendono
oltre l’estensione della carta

Poiché gli oggetti del layout possono essere posizionati al di fuori dell’estensione della carta, utilizzando l’opzione
Taglia al Contenuto mentre si esporta può risultare in un’immagine che si estende oltre l’estensione della carta.
Poiché lo sfondo al di fuori dell’estensione della carta sarà trasparente, per i formati di immagine che non suppor-
tano la trasparenza (ad esempio, .BMP, .JPG) lo sfondo sarà visualizzato completamente nero, «corrompendo»
l’immagine.

Utilizza in questo caso formati compatibili con la trasparenza come .TIFF o .PNG .

fileSe hai bisogno di esportare il tuo layout come immagine georeferenziata (ad esempio, da condividere con

altri progetti), seleziona l’opzione Salva il world file e un world file chiamato come la pagina in cui si trova
il riferimento alla mappa impostata nel pannello Layout viene creato durante la/le esportazione/i. Questa opzione
può anche essere selezionata per impostazione predefinita nel pannello layout panel.

Quando necessario, la visualizzazione delle immagini può anche essere migliorata con l’opzione Abilita l’anti-
scalettatura.

16.3.3 Esportare in formato SVG

Con Esporta come SVG, devi anche necessario immetter il nome del file (usato come nome di base per tutti i file in

caso di composizione a più pagine) e quindi puoi applicare Ritaglia al contenuto opzione.

La finestra di dialogo delle opzioni di esportazione SVG permette anche di sovrascrivere le impostazioni predefi-
nite del layout e offre altre impostazioni:

• Esportare i layer mappa come gruppi SVG: può influire sul posizionamento delle etichette.

• Etichette mappa con contorni: deselezionando questa opzione è possibile modificare le etichette come
testi nel software di illustrazione vettore.

• Esporta sempre come vettori: alcune opzioni di visualizzazione richiedono che gli elementi siano raster-
izzati per una migliore visualizzazione. Selezionare questa opzione per mantenere gli oggetti come vettori
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con il rischio che l’aspetto del file di output possa non corrispondere all’anteprima del layout di stampa (per
maggiori dettagli, vedi Impostazioni per l’esportazione).

• Esporta metadati RDF.

Figure 16.55: Opzioni esportazione SVG

Nota: Attualmente l’output SVG è molto scarno. Questo non è un problema QGIS, ma un problema con la
libreria Qt sottostante. Questo sarà probabilmente risolto nelle versioni future.

16.3.4 Esportare in formato PDF

Lo strumento Esporta come PDF. . . esporta tutte le pagine di composizione in un unico file PDF per il quale devi
fornire percorso e nome. A differenza degli altri formati, esportare in .PDF non fornisce strumenti per sovrascri-
vere le impostazioni di esportazione del layout. Quindi controlla these settings per assicurarti che siano compatibili
con le tue esigenze.

Figure 16.56: Opzioni esportazione PDF

Nota: L’esportazione di un layout di stampa nei formati .PDF o .TIFF crea di default un output georeferenziato
(nessun file world necessario)
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16.3.5 Generazione Atlante

Le funzioni dell’Atlante consentono di creare libri cartografici in modo automatico. Atlante utilizza gli oggetti
di uno layer vettoriale o tabellare chiamato strato di copertura e crea un output per ogni oggetto dell’Atlante.
L’uso più comune è lo zoom di un elemento della mappa sulla funzione dell’atlante corrente. Altri casi d’uso
includono:

• un oggetto mappa che mostra, per un altro layer, solo gli oggetti che condividono lo stesso attributo
dell’oggetto dell’atlante o che si trovano all’interno della sua geometria;

• un’etichetta o un oggetto html il cui testo viene sostituito quando gli oggetti vengono ripetuti;

• un oggetto tabella che mostra gli attributi degli oggetti associati parent or children all’oggetto corrente
dell’atlante. . . .

Per ogni oggetto, viene elaborato un output per tutte le pagine e gli oggetti in base alle impostazioni di es-
portazione.

Suggerimento: Usare le variabili per una maggiore flessibilità

QGIS fornisce un ampio ventaglio di funzioni e variables, compresi quelli relativi all’atlante, che puoi utiliz-
zare per manipolare gli elementi del layout ma anche la simbologia dei layer in base allo stato dell’atlante. La
combinazione di queste opzioni ti dà molta flessibilità e ti aiuta a produrre facilmente mappature avanzate.

Per abilitare la generazione di un atlante e accedere ai parametri dell’atlante, fai riferimento al pannello Atlante.
Questo pannello contiene le seguenti funzionalità (vedi figure_layout_atlas_atlas):

Figure 16.57: Pannello Atlante

• Genera un Atlante, che abilita o disabilita la generazione dell’atlante;

• Una casella a scelta multipla Coverage layer che permette di scegliere la tabella o il layer vettoriale conte-
nente gli oggetti da iterare;

• Un opzionale Vettore di copertura nascosto che, se selezionato, nasconde il layer di copertura (ma non
gli altri layer) durante la generazione;

• Una opzionale casella a scelta multipla Nome pagina per dare un nome più esplicito ad ogni pagina(i)
quando si visualizza l’anteprima dell’atlante. Puoi selezionare un campo del layer di copertura o impostare
una espressione. Se questa opzione è vuota, QGIS utilizzerà un ID interno, in base al filtro e/o all’ordine di
ordinamento applicato al layer;

• Un’opzione Filtra con l’area di testo che ti permette di specificare un’espressione per il filtraggio degli
oggetti del layer di copertura. Se l’espressione non è vuota, saranno elaborate solo gli oggetti che vengono
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valutati come Vero;

• Una casella di controllo opzionale Ordina per che permette di ordinare gli oggetti del layer di coper-
tura, usando un campo del layer di copertura o un’espressione. La modalità di ordinamento (ascendente o
discendente) è impostata dal pulsante direzione ordinamento a due scelte che visualizza una freccia su o giù.

Hai anche le opzioni per impostare l’output dell’Atlante:

• Una casella di testo Espressione del nome del file di uscita che viene utilizzata per generare un nome
file per ogni geometria, se necessario. Si basa su espressioni. Questo campo è significativo solo per la
visualizzazione su file multipli;

• Una casella Esporta singolo file se possibile ti permette di forzare la generazione di un singolo file se
possibile con il formato di output scelto (PDF, per esempio). Se questo campo è selezionato, il valore del
campo Espressione del nome del file di uscita non ha senso;

• Un elenco a discesa Esporta Atlante per selezionare il formato di output quando si usa il tasto
Esporta atlante come immagini. . . ..

Mappa di controllo per atlante

L’uso più comune dell’atlante è con l’oggetto mappa, zoomando all’oggetto corrente dell’atlante, mentre
l’iterazione va oltre il layer di copertura. Questo comportamento è impostato in Controllato dall’atlante
dell’oggetto mappa. Vedi Controllato da Atlante per diverse impostazioni che è possibile applicare all’oggetto
mappa.

Personalizzare le etichette con un’espressione

Per adattare le etichette alla geometria dell’atlante, puoi inserire espressioni. Quello che devi tener presente e che
devi inserire l’espressione (incluse funzioni, campi o variabili) tra [% e %] (vedi L’Oggetto Etichetta per maggiori
dettagli).

Per esempio, per un layer città con i campi CITY_NAME e ZIPCODE, puoi inserire questo:

The area of [% concat( upper(CITY_NAME), ',', ZIPCODE, ' is ',
format_number($area/1000000, 2) ) %] km2

o, un’altra espressione:

The area of [% upper(CITY_NAME)%],[%ZIPCODE%] is
[%format_number($area/1000000,2) %] km2

L’informazione [% upper(CITY_NAME) || ',' || ZIPCODE || ' is '
format_number($area/1000000,2) %] è un’espressione usata all’interno dell’etichetta. Le due
espressioni darebbero come risultato nell’atlante generato:

The area of PARIS,75001 is 1.94 km2

Esplorare Sovrascrittura definita dai dati con atlante

Ci sono diversi punti in cui è possibile utilizzare il pulsante Sovrascrittura definita dai dati per sovrascrivere
l’impostazione selezionata. Queste opzioni sono particolarmente utili per la generazione di atlante. Vedi Im-
postazione Sovrascrittura definita dai dati per maggiori dettagli su questo widget.

Per i seguenti esempi viene utilizzato il file:Regions layer del dataset di esempio QGIS e selezionato come layer
di copertura per la generazione dell’atlante. Supponiamo anche che si tratta di una singola pagina di layout
contenente come oggetti una mappa e un’etichetta.
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Quando l’altezza (nord-sud) delle estensioni di una regione è maggiore della sua larghezza (est-ovest), dovresti

utilizzare Verticale invece dell’orientamento Orizzontale per ottimizzare l’uso della carta. Con il pulsante
Sovrascrittura definita dai dati puoi impostare dinamicamente l’orientamento della carta.

Fai clic con il tasto destro del mouse sulla pagina e seleziona Proprietà pagina. . . per aprire il pannello. Vogliamo
impostare l’orientamento in modo dinamico, utilizzando un’espressione che dipenda dalla geometria della re-

gione, quindi premi il pulsante del campo Direzione, seleziona Modifica. . . . per aprire la finestra di dialogo
Costruttore stringhe espressione e inserisci la seguente espressione:

CASE WHEN bounds_width(@atlas_geometry) > bounds_height(@atlas_geometry)
THEN 'Landscape' ELSE 'Portrait' END

Ora, se per te preview the atlas, la carta si orienta automaticamente ma il posizionamento degli oggetti potrebbe
non essere ideale. Per ogni Regione voui riposizionare meglio la posizione degli oggetti nel layout. Per l’oggetto

mappa puoi utilizzare il pulsante della sua proprietà Larghezza per impostarla dinamicamente utilizzando la
seguente espressione:

@layout_pagewidth - 20

Allo stesso modo, utilizzare il pulsante della proprietà Altezza per fornire la seguente espressione e definire le
dimensioni degli oggetti mappa:

@layout_pageheight - 20

Per assicurarti che l’elemento della mappa sia centrato nella pagina, imposta il suo Punto di riferimento al pulsante
di opzione in alto a sinistra e inserisci 10 per le sue posizioni X e Y.

Aggiungiamo un titolo sopra la mappa al centro della pagina. Seleziona lìoggetto etichetta e imposta

l’allineamento orizzontale su Centro. Quindi sposta l’etichetta nella posizione corretta, attiva da Punto di
riferimento uno qualsiasi dei pulsanti centrali, e fornisci la seguente espressione per il campo X:

@layout_pagewidth / 2

Per tutti gli altri oggetti del layout puoi impostare la posizione analogamente in modo che siano posizionati
correttamente quando la pagina viene ruotata automaticamente in verticale o orizzontale. Puoi anche fare al-
tre modifiche come la personalizzazione del titolo con gli attributi degli oggetti (vedi Personalizzare le etichette
con un’espressione esempio), l’aggiornamento delle immagini con la funzione atlante, il ridimensionamento del
numero di colonne della legenda in base all’orientamento della pagina. . . ..

Le informazioni fornite derivano dall’ottimo blog (in Inglese e Portoghese) sulle opzioni di sovrascrittura dei dati
predefiniti in Multiple_format_map_series_using_QGIS_2.6 .

Questo è solo un esempio di come è possibile utilizzare alcune impostazioni avanzate con atlante.

Anteprima e generazione dell’atlante

Figure 16.58: Barra degli strumenti anteprima Atlante

Una volta che sono state configurate le impostazioni dell’atlante e gli elementi di layout (mappa, tabella, immag-
ine. . . .) ad esso collegati, puoi creare un’anteprima di tutte le pagine cliccando sull’icona Atlante → Anteprima

Atlante o Anteprima Atlante. Puoi quindi usare le frecce nella stessa barra degli strumenti per navigare attraverso
tutte le geometrie:

• Prima geometria
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• Geometria precedente

• Geometria successiva

• Ultima geometria

Puoi anche utilizzare la casella combinata centrale per selezionare e visualizzare in anteprima una geometria
specifica. La casella combinata mostra il nome delle geometria dell’atlante in base all’espressione impostata
nell’opzione dell’atlante Nome pagina.

Per quanto riguarda le composizioni semplici, un atlante può essere generato in diversi modi (vedi Creare un
Output per maggiori informazioni). Invece del menu Layout, usa piuttosto strumenti del menu Atlante o la barra
degli strumenti.

Ciò significa che puoi stampare direttamente le tue composizioni con Atlante → Stampa Atlante. Puoi inoltre
creare un PDF utilizzando Atlante → Esporta Atlante come PDF.: ti verrà richiesta una directory per salvare tutti

i file PDF generati, a meno che non sia stata selezionata la casella di controllo Esportazione file singolo se
possibile. In questo caso, ti verrà richiesto di dare un nome al file.

Con Atlante → Esporta Atlante come immagini. . . . o Atlas → Esporta Atlante come SVG. . . ., viene anche chiesto
di selezionare una cartella. Ogni pagina di ogni composizione dell’atlante viene esportata nel formato file immag-
ine impostato nel pannello Atlante o nel file SVG.

Suggerimento: Stampare una specifica geometria dell’Atlante

Se vuoi stampare o esportare la composizione di una solo oggetto dell’atlante, è sufficiente avviare l’anteprima,
selezionare l’oggetto desiderato nell’elenco a discesa e fare clic su Layout → Stampa (oppure Esporta. . . in
qualsiasi formato di file supportato).

Usare le relazioni definite nel progetto per la creazione dell’atlante

Per gli utenti con conoscenze HTML e Javascript è possibile operare su oggetti GeoJSON e utilizzare relazioni
definite nel progetto QGIS. La differenza tra questo approccio e l’utilizzo di espressioni inserite direttamente
nell’HTML è che esso fornisce una feature GeoJSON completa e non strutturata con cui lavorare. Ciò significa
che è possibile utilizzare le librerie Javascript esistenti e le funzioni che operano sulle rappresentazioni delle
feature di GeoJSON.

Il codice seguente include tutte le feature figlie correlate dalla relazione definita. Utilizzando la funzione JavaScript
setFeature ti permette di creare un HTML flessibile che rappresenta le relazioni in qualsiasi formato tu vuoi
(liste, tabelle, ecc.). Nell’esempio di codice, creiamo un elenco dinamico delle feature figlio correlate.

// Declare the two HTML div elements we will use for the parent feature id
// and information about the children
<div id="parent"></div>
<div id="my_children"></div>

<script type="text/javascript">
function setFeature(feature)
{
// Show the parent feature's identifier (using its "ID" field)
document.getElementById('parent').innerHTML = feature.properties.ID;
//clear the existing relation contents
document.getElementById('my_children').innerHTML = '';
feature.properties.my_relation.forEach(function(child_feature) {
// for each related child feature, create a list element
// with the feature's name (using its "NAME" field)

var node = document.createElement("li");
node.appendChild(document.createTextNode(child_feature.NAME));
document.getElementById('my_children').appendChild(node);
});
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}
</script>

Durante la creazione dell’atlante ci sarà un’iterazione sul layer di copertura che contiene le feature del genitore.
In ogni pagina, si vedrà un elenco delle feature figlio correlate che seguono l’identificatore del genitore.

16.4 Creare un Report

16.4.1 Che significa?

Questa sezione ti aiuterà a impostare un report automatico in QGIS. Per definizione, un report GIS è un documento
contenente informazioni organizzate in forma narrativa, grafica, mappe o tabellare, preparato ad hoc, periodico,
ricorrente, regolare o secondo necessità. I report possono riferirsi a specifici periodi, accadimenti o argomenti,
luoghi, e possono essere comunicate o presentate in forma orale o scritta. I report in QGIS permetteranno agli
utenti di rappresentare i propri progetti GIS in modo semplice, rapido e strutturato.

16.4.2 Comincia da qui

Il Reports menu è un’estensione di Layout di stampa. Questa funzionalità può essere trovata in Progetto → Nuovo
Report o all’interno di Progetto → Gestore del Layout.

Nella finestra di dialogo Gestore del Layout il report può essere creato attraverso Nuovo da Modello e selezionare
l’opzione a tendina Layout vuoto e premendo il pulsante Crea. . . ..

Per questo esempio, usiamo alcuni confini amministrativi, luoghi popolati, porti e aeroporti dal dataset di Natural
Earth.
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Usando il comando Progetto → Nuovo Report, creiamo un nuovo report vuoto. Inizialmente, non c’è molto da
guardare - la finestra di dialogo che viene visualizzata assomiglia molto a quella del layout di stampa, tranne che
per il nuovo pannello Struttura del Report mostrato a sinistra:

16.4.3 Area di lavoro Layout Report

I report QGIS possono essere costituiti da più sezioni annidate. Nel nostro nuovo report in bianco abbiamo
inizialmente solo la sezione principale del report. Le uniche opzioni presenti per questa sezione del report sono
Includi intestazione del Report o Includi piè di pagina del Report. Se si attivano queste opzioni, l’intestazione sarà
inclusa come prima pagina (o pagine. . . . — singole parti dei report possono essere multi-pagina se lo si desidera)
nel report, e il piè di pagina sarebbe l’ultima pagina. Andiamo avanti e attiviamo l’intestazione, e premiamo il
pulsante Modifica accanto ad essa:

Di conseguenza, accadono alcune cose. In primo luogo, una matita di modifica è ora mostrata accanto alla sezione
Report nella sezione Struttura del Report, indicando che la sezione report è attualmente in fase di progetto di
modifica. Vediamo anche una nuova pagina bianca mostrata nel designer stesso, con il piccolo titolo Intestazione
Report. Nei report QGIS, ogni componente del report è costituito da layout individuali. Possono essere creati
e modificati utilizzando esattamente gli stessi strumenti disponibili per i layout di stampa standard - in modo
da poter utilizzare qualsiasi combinazione desiderata di etichette, immagini, mappe, tabelle, ecc. Aggiungiamo
alcuni elementi alla nostra intestazione del report da mostrare:
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Creeremo anche un semplice piè di pagina per il report, scegliendo l’opzione Includi piè di pagina del Report e
facendo clic su Modifica.

Prima di procedere oltre, esportiamo questo report e vediamo cosa ne ricaviamo. L’esportazione viene effettuata
dal menu Report - in questo caso selezioniamo Esporta Report come PDF per creare l’intero report in un file PDF.
Ecco il risultato non molto impressionante - un PDF di due pagine composto dalle nostre intestazione e piè di
pagina:

Rendiamo le cose più interessanti. Premendo il pulsante Aggiungi sezione nella Struttura del Report, ci viene data
una scelta di nuove sezioni da aggiungere al nostro report.

Ci sono due opzioni: Sezione Layout Statica e Sezione Gruppo Campi. La Sezione Layout Statica è un unico
layout statico. Questa opzione può essere utilizzata per incorporare layout statici in un report. In alternativa,
l’opzione Sezione Gruppo Campi ripete il layout di base per ogni oggetto di un layer. Gli oggetti sono ordinati in
base alla modalità di raggruppamento selezionata (con un’opzione per l’ordinamento ascendente/discendente). Se
una sezione di un gruppo di campi ha sezioni figlie (ad esempio, un’altra sezione di un gruppo di campi con un
campo diverso), allora solo le geometrie con valori univoci per la caratteristica del gruppo vengono iterate. Questo
permette di creare report annidati con informazioni diverse.

Per ora aggiungeremo un campo di raggruppamento al nostro rapporto. In pratica, puoi pensare ad un Sezione
Gruppo Campi come l’equivalente di un stampa atlante. Seleziona un layer da iterare e il rapporto inserirà una
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sezione per ogni oggetto trovato. Selezionando la nuova sezione Sezione Gruppo Campi mostra una serie di nuove
impostazioni correlate:

In questo caso abbiamo impostato il nostro Campo di raggruppamento in modo da iterare tutti gli stati dal livello
Admin Level 1, usando i valori del Campo adm1name. Le stesse opzioni per l’intestazione e il piè di pagina sono
presenti, insieme ad una nuova opzione per includere un Campo per questa sezione. Lo faremo, e modificheremo
il Campo:

Abbiamo impostato questo body con una mappa (impostata per seguire la funzione di report corrente - proprio
come un elemento della mappa in un atlante può seguire la funzione dell’atlante corrente), e un’etichetta che
mostra il nome dello stato. Se andassimo avanti ed esportassimo il nostro rapporto ora, otterremmo qualcosa del
genere:

In primo luogo, l’intestazione del rapporto, poi una pagina per ogni stato, e infine il piè di pagina del rapporto.
Quindi più o meno un atlante, ma con un’intestazione e una pagina di piè di pagina. Rendiamo le cose più
interessanti aggiungendo una sottosezione al nostro gruppo di stato. Lo facciamo selezionando prima il gruppo

del campo di stato nell’organizzatore, poi premendo il pulsante Aggiungi Sezione e aggiungendo una nuova Sezione
Gruppo Campi:

Quando una sezione Sezione Gruppo Campi sta iterando sui suoi oggetti, filtrerà automaticamente questi oggetti
per abbinare gli attributi degli oggetti dei suoi gruppi principali. In questo caso, la sottosezione che abbiamo
aggiunto itererà su un layer Populated Places, includendo una sezione del corpo per ogni luogo incontrato. La
magia qui è che il layer Populated Places ha un attributo chiamato adm1name, etichettando ogni luogo con lo stato
in cui si trova (se siete fortunati i vostri dati saranno già strutturati in questo modo - in caso contrario, eseguite il
Processing Join Attributes by Location algoritmo e create il vostro campo personale). Quando esportiamo questo
report, QGIS prenderà il primo stato dal layer Admin Level 1, e poi itererà su tutto il layer i Populated Places con
un corrispondente valore adm1name. Ecco cosa otteniamo:

Qui abbiamo creato un corpo di base per il gruppo Luoghi Popolati, che include una mappa del luogo e una tabella
di alcuni attributi del luogo. Quindi il nostro report è ora un’intestazione del report, una pagina per ogni stato
seguito da una pagina per ogni luogo popolato all’interno di quello stato, e infine il piè di pagina del report. Se
dovessimo aggiungere un’intestazione per il gruppo Luoghi Popolati, sarebbe inclusa poco prima di elencare i
luoghi popolati per ogni stato:
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Allo stesso modo, un piè di pagina per il gruppo Luoghi Popolati verrebbe inserito dopo che è stato incluso il
posto finale per ogni stato.

Oltre alle sottosezioni annidate, anche le sottosezioni di una relazione possono essere incluse consecutivamente.
Se aggiungiamo una seconda sottosezione al gruppo «Admin Level 1» per Airports, allora il nostro rapporto
elencherà per prima cosa TUTTI i posti popolati per ogni stato, seguiti da tutti gli aeroporti all’interno di quello
stato, prima di procedere allo stato successivo. In questo caso il nostro rapporto sarebbe strutturato in questo
modo:

16.4.4 Stampa report

Il punto chiave qui è che il nostro Gruppo Airports è una sottosezione del Gruppo Admin Level 1 - non il Grup-
poPopulated Places. Ecco come potrebbe essere il nostro rapporto ora:

La combinazione di sezioni nidificate e consecutive, insieme a testate e piè di pagina, consente una grande flessibil-
ità. Per esempio, nel report sottostante aggiungiamo un altro gruppo di campi come figlio del report principale
per il layer Ports. Ora, dopo aver elencato gli stati con i loro luoghi popolati e gli aeroporti, otterremo una lista
riassuntiva di tutti i porti della regione:

Questo viene realizzato nell’ultima parte del nostro report esportato come:

16.4.5 Impostazioni per l’esportazione

Ogni volta che esporti un report, c’è una selezione di impostazioni di esportazione che QGIS deve controllare per
restituire l’output più appropriato. Come puoi iniziare a immaginare, i report in QGIS sono estremamente potenti
e flessibili!
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Nota: Quando stai per esportare un report nei formati disponibili, scegli le opzioni (Stampa, SVG, Immagine,
PDF) che hanno le etichette con la scritta Esporta Report come. . . . altrimenti stampesti la mappa attiva corrente.

Le presenti informazioni sono state adattate dal blog di North Road, Exploring Reports in QGIS 3.0 - the Ultimate
Guide!
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CHAPTER 17

Lavorare con i dati OGC

17.1 QGIS come client di dati OGC

L’Open Geospatial Consortium (OGC), è un’organizzazione internazionale che raggruppa più di 300 organiz-
zazioni commerciali, governative, no-profit ed enti di ricerca. I suoi membri sviluppano e implementano standard
per contenuti e servizi geospaziali, analisi GIS e scambio dati.

Con la descrizione di un modello di dati per elementi geografici, un numero crescente di specifiche sono svilup-
pate da OGC per garantire le esigenze specifiche per la l’interoperabilità delle tecnologia di localizzazione e
geospaziali, compresi i GIS. Ulteriori informazioni sono disponibili all’indirizzo https://www.opengeospatial.org/.

Importanti specifiche OGC supportate da QGIS sono:

• WMS — Web Map Service (Client WMS/WMTS)

• WMTS — Web Map Tile Service (Client WMS/WMTS)

• WFS — Web Feature Service (Client WFS e WFS-T)

• WFS-T — Web Feature Service - Transactional (Client WFS e WFS-T)

• WCS — Web Coverage Service (Client WCS)

• WPS — Web Processing Service

• CSW — Catalog Service for the Web

• SFS — Simple Features for SQL (Layer PostGIS)

• GML — Geography Markup Language

I servizi OGC sempre più numerosi sono utili per scambiare dati geografici fra differenti implementazioni GIS
e archivi di dati. QGIS può gestire le specifiche sopra esposte come client, essendo SFS (tramite il supporto a
PostgreSQL/PostGIS, vedi sezione Layer PostGIS).

17.1.1 Client WMS/WMTS

Panoramica sul servizio WMS

QGIS può agire come client WMS, nel rispetto delle specifiche server 1.1, 1.1.1 e 1.3. In particolare è stato testato
nei confronti di server accessibili pubblicamente quali DEMIS.
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Un server WMS risponde alle richieste da parte del client (ad esempio QGIS) di una mappa raster di una determi-
nata estensione, con un determinato insieme di layer, simboli e trasparenze. Il server WMS quindi consulta le sue
risorse locali, genera il raster e lo invia al client in formato raster. Per QGIS tipicamente come immagini JPEG o
PNG.

WMS è un servizio REST (Representational State Transfer) piuttosto che un servizio web completo. Quindi puoi
prendere l’URL generato da QGIS e usarlo in un browser web per ottenere la stessa immagine che QGIS usa
internamente. Questo è utile per identificare le cause di eventuali problemi, dato che esistono vari tipi di server
WMS e ciascuno ha la sua propria interpretazione degli standard WMS.

I layer WMS possono essere aggiunti molto semplicemente, una volta disponibile l’indirizzo (URL) per accedere
al server WMS, una connessione adatta e posto che il server usi HTTP come meccanismo di trasferimento dati.

Inoltre, QGIS memorizzerà in cache le tue risposte WMS (cioè le immagini) per 24 ore fino a quando la richiesta
GetCapabilities non viene attivata. La richiesta GetCapabilities viene attivata ogni volta che il pulsante Connetti
nel dialogo Aggiungi layer(s) dal WMS (T)S Server viene utilizzato per recuperare i servizi del server WMS.
Questa è una funzione automatica per ottimizzare il tempo di caricamento del progetto. Se un progetto viene
salvato con un layer WMS, le mattonelle WMS corrispondenti saranno caricate dalla cache la prossima volta che
il progetto viene aperto, purché non siano più vecchie di 24H.

Panoramica sul servizio WMTS

QGIS può agire anche come client WMTS. WMTS è uno standard OGC che distribuisce insiemi di mattonelle di
dati geospaziali. È un modo più efficace e veloce rispetto a WMS perché gli insiemi di mattonelle vengono già
generati e il client deve solamente richiedere la trasmissione di queste mattonelle e non la loro produzione. Una
richiesta WMS tipicamente richiede sia la generazione che la trasmissione dei dati. Un esempio molto conosciuto
di standard non-OGC è Google Maps.

Per visualizzare i dati a diverse scale, l’insieme delle mattonelle WMTS vengono prodotte con scale molto differ-
enti fra loro in modo che per il client GIS sia più facile effettuare la richiesta.

Questo diagramma mostra il concetto delle mattonelle:

Figure 17.1: Concetto dell’insieme delle mattonelle WMTS

Le due tipologie di interfacce WMTS che supporta QGIS sono via Key-Value-Pairs (KVP) e RESTful. Queste
due interfacce sono differenti e devi specificarle in QGIS.

1. Per accedere a un servizio WMTS KVP, un utente QGIS deve aprire l’interfaccia WMS/WMTS e aggiun-
gere la seguente stringa all” URL del servizio di mattonelle WMTS:

"?SERVICE=WMTS&REQUEST=GetCapabilities"

Un esempio di questo tipo di indirizzo è:
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https://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

Per vedere se il layer topo2 funziona correttamente in questo WMTS, aggiungi la stringa indicata che il
servizio WMTS deve usare al posto del servizio WMS.

2. Il servizio RESTful WMTS segue un modulo diverso, ovvero un URL diretto. Il formato raccomandato da
OGC è:

{WMTSBaseURL}/1.0.0/WMTSCapabilities.xml

Questo formato ti aiuta a riconoscere che questo è un indirizzo RESTful. Puoi accedere a un RESTful
WMTS in QGIS semplicemente aggiungendo il suo indirizzo nella configurazione del WMS nel campo
URL del modulo. Un esempio di questo tipo di indirizzo, per una mappa di base austriaca, è http://maps.
wien.gv.at/basemap/1.0.0/WMTSCapabilities.xml.

Nota: Puoi ancora trovare alcuni vecchi servizi chiamati WMS-C. Questi servizi sono abbastanza simili al
WMTS (cioè, stesso scopo ma funzionando un po” diversamente). Puoi gestirli come fai con i servizi WMTS.
Basta aggiungere ?tiled=true alla fine dell’url. Vedi https://wiki.osgeo.org/wiki/Tile_Map_Service_Service_
Specification per ulteriori informazioni su questa specifica.

Quando leggi WMTS, puoi anche pensare a WMS-C.

Selezionare server WMS/WMTS

Al primo utilizzo di un servizio WMS in QGIS non sono presenti server predefiniti.

Puoi avviare lo strumento cliccando sul pulsante Aggiungi layer WMS/WMTS nella barra degli strumenti,
oppure scegliendo Layer → Aggiungi layer WMS/WMTS. . . .

Viene visualizzata la finestra di dialogo Gestore della sorgente dati | WMS/WMTS per aggiungere layer dal server
WMS. Puoi aggiungere alcuni server con cui interagire cliccando sul pulsante Aggiungi server predefiniti. Questo
aggiungerà due server demo WMS da utilizzare: i server WMS del DM Solutions Group e Lizardtech. Per
definire un nuovo server WMS nella scheda Layer, seleziona il pulsante Nuovo. Quindi inseririsci i parametri per
connetterti al server WMS desiderato, come indicato in table_OGC_wms:

Nome Un nome per la connessione. Questo nome verrà utilizzato nel menù a tendina dei server in
modo da distinguere i vari server WMS.

URL URL del server che fornisce i dati. Deve essere un indirizzo raggiungibile nello stesso for-
mato che verrebbe usato per aprire una connessione telnet o pingare un host.

Username Nome utente per accedere un WMS protetto. Questo parametro è opzionale.
Password Password per accedere ad un WMS protetto. Questo parametro è opzionale.

Ignora URI
GetMap

Ignora la URI GetMap riportata nelle capabilities. Viene utilizzato l’URI del campo
URL precedente.

Ignora URI
GetFeature-
Info

Ignora la URI GetFeatureInfo riportata nelle capabilities. Viene utilizzato l’URI del
campo URL precedente

Table OGC 1: Parametri di connessione WMS

Se hai bisogno di impostare i parametri di un proxy per ricevere i servizi WMS da internet, puoi aggiungere il
server proxy nelle opzioni. Seleziona Impostazioni → Opzioni e clicca sulla scheda Opzioni|Rete, nella quale puoi

inserire le impostazioni spuntando la casella di controllo Utilizza un proxy per l’accesso web. Assicurati di

scegliere il tipo di proxy corretto dal menù a tendina Tipo proxy .
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Una volta creata la connessione al server WMS verrà memorizzata e sarà disponibile per le successive sessioni di
QGIS.

Suggerimento: A PROPOSITO DI INDIRIZZI DEI SERVER WMS

Quando inserisci l’indirizzo URL del server assicurati di usare l’indirizzo di base. Ad esempio non devi inserire
frammenti tipo request=GetCapabilities o version=1.0.0 nell’indirizzo.

Avvertimento: Inserendo nome utente e password nella scheda Autenticazione, le credenziali non sono
protette nella configurazione della connessione. Queste credenziali saranno visibili se, per esempio, hai
condiviso il file del progetto con qualcuno. Pertanto, è invece consigliabile salvare le credenziali in una Con-
figurazione di autenticazione (tabella configurazioni). Vedi Authentication System per maggiori dettagli.

Caricare layer WMS/WMTS

Una volta compilati con successo i parametri, è possibile utilizzare il pulsante Connetti percaricare le capabilities
del server selezionato. Questo include la codifica delle immagini, i livelli, gli stili dei livelli e le proiezioni. Poiché
si tratta di una operazione di rete, la velocità della risposta dipende dalla qualità della connessione di rete al server
WMS. Durante il download dei dati dal server WMS, l’avanzamento del download viene visualizzato in basso a
sinistra della finestra di dialogo WMS.

Il tuo schermo adesso dovrebbe essere simile a quello rappresentato nella figura figure_OGC_add_wms, che
mostra la risposta fornita dal server WMS di European Soil Portal.

Codifica immagine

La sezione Codifica immagine elenca i formati supportati sia dal client che dal server. La scelta è in funzione dei
requisiti di accuratezza.

Suggerimento: Codifica immagine

Un server WMS offre normalmente la scelta fra immagini JPEG o PNG. Il formato JPEG è un formato di com-
pressione lossy, mentre il formato PNG riproduce fedelmente i dati raster.

È meglio usare il formato JPEG per dati di natura fotografica e/o se la perdita parziale di qualità dell’immagine non
causa problemi. Questa scelta riduce normalmente di cinque volte il volume di dati trasferiti rispetto al formato
PNG.

L’uso del formato PNG permette una visualizzazione più precisa ed è da usare se non ci sono problemi per
l’incremento dei dati trasferiti.

Opzioni

La sezione Opzioni mette a disposizione il campo testo Nome layer per dare un nome al layer WMS. Questo nome
apparirà nella legenda a caricamento avvenuto.

Sotto il nome del layer puoi scegliere la Dimensione delle tile, (per esempio 256x256) in modo da dividere la
richiesta WMS in richieste multiple.

Il campo Limite di elementi per GetFeatureInfo definisce quali elementi del server interrogare.

Se selezioni un WMS dall’elenco, appare un campo con la proiezione predefinita fornita dal mapserver. Se il
pulsante Cambia. . . . è attivo, puoi fare clic su di esso e cambiare la proiezione predefinita del WMS in un altro
SR fornito dal server WMS.

Infine puoi attivare Usa la legenda WMS contestuale se il server WMS supporta questa funzionalità. Quindi
verrà mostrata solo la legenda pertinente per l’estensione della visualizzazione mappa corrente e quindi non in-
cluderà gli elementi della legenda per ciò che non puoi vedere nella mappa corrente.

Ordine dei Layer
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Figure 17.2: Finestra di dialogo per aggiungere un server WMS, mostrando i layer disponibili
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La scheda Ordine layer elenca i diversi layer disponibili sul server WMS a cui sei connesso. Puoi notare che
alcuni layer sono espandibili; questo significa che puoi visualizzare quei layer con diversi stili di immagine.

Puoi selezionare più layer in una volta, ma solo uno stile di visualizzazione per layer. Quando più layer sono
selezionati questi vengono combinati dal server WMS ed inviati a QGIS in un’unica volta.

Suggerimento: Ordine dei layer WMS

I layer WMS caricati sono sovrapposti in base all’ordine in cui sono elencati nella sezione Layer, ovvero dall’alto
verso il basso. Se vuoi cambiare l’ordine di visualizzazione, usa la scheda Ordine layer.

Trasparenza

In questa versione di QGIS l’impostazione della Trasparenza globale che si imposta da Proprietà layer per essere
sempre attiva, se disponibile.

Suggerimento: Trasparenza dei layer WMS

La possibilità di rendere trasparenti i layer WMS dipende dalla codifica tramite la quale sono stati caricati: PNG
e GIF gestiscono la trasparenza mentre il JPEG no.

Sistema di Riferimento

Sistema di riferimento delle coordinate (CRS) è il termine OGC per una proiezione in QGIS.

Ogni layer WMS può avere diversi SR, in funzione delle capacità del server.

Per scegliere un SR, seleziona Cambia. . . . e apparirà una finestra di dialogo simile a Finestra di dialogo SR
personalizzato. La differenza principale con la versione WMS della finestra di dialogo è che verranno mostrati
solo i SR supportati dal server WMS.

Ricerca Server

Con QGIS puoi anche cercare server WMS. La figura Figure_OGC_search mostra la scheda Cerca Server con la
finestra di dialogo Aggiungi layer(s) da un Server.

Come puoi vedere, è possibile inserire una stringa di ricerca nel campo di testo e premere il pulsante Cerca. Dopo
un breve periodo di tempo, il risultato della ricerca verrà inserito nell’elenco sotto il campo di testo. Sfoglia
l’elenco dei risultati e controlla i risultati della tua ricerca all’interno della tabella. Per visualizzare i risultati,
seleziona una voce della tabella, premi il pulsante Aggiungi riga alla lista WMS e torna alla scheda Layer. QGIS
ha aggiornato automaticamente la tua lista dei server, e il risultato della ricerca selezionata è già abilitato nella
lista dei server WMS salvati nella scheda Layer. È sufficiente richiedere l’elenco dei layer cliccando sul pulsante
Connetti. Questa opzione è molto utile quando vuoi cercare le mappe per parole chiave specifiche.

Si tratta fondamentalmente di un front end alle API di http://geopole.org.

Impostazioni mattonelle

Quando usi servizi WMTS (Cached WMS) come

https://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

puoi visualizzare la scheda Opzioni fornita dal server. Informazioni aggiuntive come la dimensione delle mat-
tonelle, i formati e i SR supportati sono elencati in questa tabella. In combinazione con questa funzionalità, puoi

usare il cursore della scala delle mattonelle selezionando Visualizza → Panelli ( o Impostazioni → Panelli),
scegliendo Pannello scala mattonelle. Questo ti dà le scale disponibili dal server delle mattonelle con un comodo
cursore inserito.
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Figure 17.3: Finestra di dialogo della ricerca di server WMS con alcune parole chiave

Uso dello strumento di identificazione

Dopo aver aggiunto un server WMS, e se sul server WMS è possibile eseguire query su qualsiasi layer, puoi utiliz-

zare lo strumento Informazione elementi per selezionare un pixel sulla mappa. Viene eseguita una query sul server
WMS per ogni selezione effettuata. I risultati della query vengono restituiti in formato testo. La formattazione di
questo testo dipende dal particolare WMS server utilizzato. Selezione formato

Se il server supporta diversi formati in output, un menu a tendina verrà automaticamente aggiunto alla finestra
delle informazioni risultati in modo che i diversi formati possano essere memorizzati nel progetto. Supporto
formato GML

Lo strumento Informazione elementi supporta anche le risposte WMS (GetFeatureInfo) in formato GML (in questo
contesto è chiamato Geometria nell’interfaccia di QGIS). Se il formato “Geometria” è supportato dal server, i
risultati dello strumento ‘Informazione elementi’ sono geometrie proprio come un layer vettore. Quando selezioni
una singola geometria nell’albero, questa viene evidenziata sulla mappa e la puoi copiare negli appunti e incollare
su un altro layer vettore. Vedi l’esempio UMN Mapserver per il supporto GetFeatureInfo in formato GML.

# in layer METADATA add which fields should be included and define geometry
→˓(example):

"gml_include_items" "all"
"ows_geometries" "mygeom"
"ows_mygeom_type" "polygon"

# Then there are two possibilities/formats available, see a) and b):

# a) basic (output is generated by Mapserver and does not contain XSD)
# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "application/vnd.ogc.gml,text/html"

# b) using OGR (output is generated by OGR, it is send as multipart and contains
→˓XSD)
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# in MAP define OUTPUTFORMAT (example):
OUTPUTFORMAT

NAME "OGRGML"
MIMETYPE "ogr/gml"
DRIVER "OGR/GML"
FORMATOPTION "FORM=multipart"

END

# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "OGRGML,text/html"

Proprietà del server

Una volta aggiunto un server WMS, puoi visualizzarne le proprietà cliccando con il tasto destro sul suo nome
nella legenda e selezionando Proprietà. Scheda Metadati

La scheda Metadata mostra molte informazioni sul server WMS, generalmente fornite dalle capabilities restituite
da quel server. Molte definizioni possono essere ricavate leggendo gli standard WMS (vedi OPEN-GEOSPATIAL-
CONSORTIUM in Letteratura e riferimenti web), ma qui sono riportate alcune utili definizioni:

• Proprietà del server

– Versione WMS — La versione WMS supportata dal server.

– Formati immagine - L’elenco dei tipi MIME disponibili sul server durante la visualizzazione della
mappa. QGIS permette l’uso di qualunque formato supportato dalle librerie Qt, solitamente sono
image/png ed image/jpeg.

– Interroga formati - L’elenco dei tipi MIME con i quali il server può fornire risposta quando usi lo
strumento Informazioni elementi. Attualmente QGIS supporta il tipo text-plain.

• Propertà layer

– Selezionato — Indica se il layer era selezionato quando il server è stato aggiunto al progetto.

– Visibilità - Indica se il layer è stato impostato come visibile in legenda. (funzione non ancora utilizzata
in questa versione di QGIS).

– Può interrogare —Indica se il layer fornisce o meno informazioni se si usa lo strumento Informazioni
elementi.

– Può essere trasparente - Indica se il layer può essere o meno reso trasparente. Questa versione di
QGIS userà sempre la trasparenza se questa è Sì e se il formato immagine la supporta.

– Può ingrandire- Indica se il layer può essere ingrandito dal server. Questa versione di QGIS assume
in modo predefinito che tutti i layer WMS abbiano questa impostazione su Si. I layer senza questa
impostazione potrebbero essere visualizzati in modo anomalo.

– Conteggio a cascata — I server WMS possono fungere da proxy per altri server WMS dai quali
ottengono i dati raster per un certo layer. La voce mostra quindi quante richieste per questo layer
vengono inoltrate ai nodi per ottenere un risultato.

– Larghezza fissa, Altezza fissa - Indica se questo layer ha una dimensione fissa dei pixel. In questa
versione di QGIS tutti i layer WMS hanno questa impostazione impostata su nulla. I layer con im-
postazioni diverse potrebbero essere visualizzati in modo anomalo.

– Perimetro WGS 84 - Il riquadro di delimitazione in coordinate WGS84. Alcuni server WMS non
impostano questo parametro correttamente (ad es. usano coordinate UTM invece di WGS84). In
questo caso sembrerà che la vista iniziale del layer sia ad uno zoom molto ridotto. Bisognerebbe
informare di questi errori il webmaster del server WMS,che potrebbe conoscere come elementi WMS
XML LatLonBoundingBox, EX_GeographicBoundingBox o CRS:84 BoundingBox.

– Disponibilità in SR — Sistemi di riferimento nel quale il layer può essere rappresentato dal server
WMS, elencati nel formato nativo WMS.

– Disponibile in stile — Stili visuali applicabili al layer dal server WMS.
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Mostra la legenda WMS nella lista dei layer e nel layout

La sorgente dati WMS di QGIS può visualizzare la legenda nella lista dei layer e nel layout di stampa. La legenda
WMS verrà mostrata solo se il server WMS ha le capability GetLegendGraphic e se il layer ha l’url getCapability
specificato. Potrai anche selezionare uno stile per il layer.

Se legendGraphic è disponibile, viene mostrato sotto il layer. È piuttosto piccolo e dovrai cliccarci sopra per
aprirlo nelle dimensioni reali (fatto dovuto alle limitazioni QgsLegendInterface). Cliccando sulla legenda del
layer si aprirà una finestra con la legenda alla massima risoluzione.

Nel layout di stampa, la legenda verrà integrata nella sua dimensione originale (scaricata). La risoluzione grafica
della legenda può essere impostata nelle proprietà dell’elemento in :menuselection: Legenda -> WMS Legend-
Graphic in base alle tue esigenze di stampa.

La legenda mostrerà informazioni contestuali riferite alla scala attuale. La legenda WMS verrà mostrata solo se
il server WMS ha le capability GetLegendGraphic e se il layer ha le capability dell’url getCapability specificate,
cosi puoi anche scegliere uno stile per il layer.

Limitazioni del client WMS

Non tutte le funzionalità client WMS sono state incluse in questa versione di QGIS. Le eccezioni più rilevanti
sono le seguenti.

Modificare le impostazioni del layer WMS

Una volta completata la procedura Aggiungi layer WMS/WMTS, non puoi più modificarne i parametri. Una possibile
soluzione è quella di eliminare completamente il layer e ricaricarlo reimpostando i parametri.

Server WMS che richiedono un’autenticazione

Attualmente sono accessibili server pubblici e server protetti. Puoi accedere ai server protetti con autenticazione
pubblica. Puoi aggiungere le credenziali (opzionali) quando carichi un server WMS. Vedi sezione Selezionare
server WMS/WMTS per ulteriori dettagli.

Suggerimento: Accesso ai layer OCG protetti

Se hai bisogno di accedere a layer protetti con metodi sicuri diversi dall’autenticazione di base, puoi usare In-
teProxy come proxy trasparente, che supporta diversi metodi di autenticazione. Ulteriori informazioni possono
essere trovate nel manuale di InteProxy all’indirizzo https://inteproxy.wald.intevation.org.

Suggerimento: WMS Mapserver QGIS

A partire dalla versione 1.7.0, in QGIS è stato implementato un server WMS 1.3.0 Mapserver. Ulteriori infor-
mazioni nel capitolo QGIS come OGC Data Server.

17.1.2 Client WCS

Un servizio WCS fornisce accesso a dati raster che sono utili per la visualizzazione lato client, come input
per modelli scientifici e per molti altri usi. Quali sono le caratteristiche che distinguono un servizio WCS dai
servizi WFS e WMS? Mentre i servizi WFS e WMS sono istanze server, il servizio WCS permette al client di
scegliere le porzioni di server che contengono le informazioni desiderate. Queste informazioni possono essere
filtrate attraverso limiti spaziali o altre tipologie di interrogazioni.

QGIS ha un servizio WCS nativo e supporta le versioni 1.0 e 1.1 (che sono molto diverse fra di loro), ma attual-
mente preferisce la versione 1.0, perché la 1.1 ha ancora troppi problemi (ad esempio ogni server lo implementa
in modo diverso con differenti particolarità).
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Il supporto nativo WCS si occupa di tutte le richieste di rete e usa tutte le impostazioni standard di QGIS (spe-
cialmente i proxy). Puoi anche scegliere la modalità cache (‘sempre cache’, ‘preferisci cache’, ‘preferisci rete’,
‘sempre rete’) e la fonte dati supporta anche la posizione temporale se questa è disponibile dal server.

Avvertimento: Inserendo nome utente e password nella scheda Autenticazione, le credenziali non sono
protette nella configurazione della connessione. Queste credenziali saranno visibili se, per esempio, hai
condiviso il file del progetto con qualcuno. Pertanto, è invece consigliabile salvare le credenziali in una Con-
figurazione di autenticazione (tabella configurazioni). Vedi Authentication System per maggiori dettagli.

17.1.3 Client WFS e WFS-T

In QGIS, un layer WFS si comporta come un qualsiasi altro layer vettoriale. Puoi identificare, selezionare elementi
e visualizzare la tabella degli attributi. A partire da QGIS 1.6.0 è anche supportata la gestione di layer WFS-T.

Normalmente la procedura per l’aggiunta di un layer WFS è molto simile a quella vista per i WMS. La differenza
sta nel fatto che non ci sono server predefiniti, quindi devi aggiungere manualmente i server noti.

Caricare un layer WFS

Come esempio, usiamo il server Gateway Geomatics WFS e visualizziamo un layer. https://demo.
gatewaygeomatics.com/cgi-bin/wfs_gateway?REQUEST=GetCapabilities&VERSION=1.0.0&SERVICE=WFS

Per poter caricare un layer WFS per prima cosa creiamo una connessione al server WFS.

1. Apri la finestra di dialogo Gestore della sorgente dati premendo il pulsante Apri Gestore della sorgente dati

2. Attiva la scheda WFS

3. Fai clic su Nuovo per aprire la finestra di dialogo Crea una nuova connessione WFS.

4. Inserisci Gateway Geomatics come nome

5. Immetti l’URL (vedi sopra)

6. Nella finestra di dialogo impostazioni WFS puoi:

• Indicare la versione WFS del server. Se sconosciuto, premi il pulsante Rileva per recuperarlo auto-
maticamente.

• Definire il Numero max. di geometrie recuperate in una singola richiesta GetFetFeature. Se vuoto, non
viene impostato alcun limite.

• Inverti orientamento assi.

• E a seconda della versione WFS:

– Forza a Ignora orientamento assi (WFS 1.1/WFS 2.0)

– Enable feature paging e specifica il numero massimo di geometrie da recuperare con Dimensione
pagina. Se non viene definito alcun limite, viene applicato il valore predefinito del server.

Avvertimento: Inserendo Nome utente e Password nella scheda Autenticazione, le credenziali non
sono protette nella configurazione della connessione. Queste credenziali saranno visibili se, per es-
empio, hai condiviso il file del progetto con qualcuno. Pertanto, è consigliabile invece salvare le tue
credenziali in una Configurazione di autenticazione (scheda Configurazioni). Vedi Authentication Sys-
tem per maggiori dettagli.

7. Premi OK per creare la connessione.

Ogni impostazione proxy presente nelle preferenze viene automaticamente riconosciuta.

Ora siamo pronti a caricare i layer WFS dalla connessione di cui sopra.
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Figure 17.4: Creazione di una connessione a server WFS
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1. Scegli «Gateway Geomatics» dall’elenco a discesa Connessioni server .

2. Clicca Connetti

3. Seleziona il layer Parks nella lista

4. Puoi scegliere se fare o meno:

• Usa il titolo come nome del layer, mostrando il titolo dello strato come definito sul server nel
pannello Layer al posto del suo Nome

• Solo le geometrie sovrapposte all’estensione della vista

• Cambia. . . il SR del layer

• o Crea interrogazione per specificare particolari geometrie da recuperare, utilizzando il pulsante cor-
rispondente o facendo doppio clic sul layer di destinazione.

5. Clicca Aggiungi per aggiungere il layer alla mappa.

Figure 17.5: Aggiungere un layer WFS

Noterai che l’avanzamento del download viene visualizzato in basso a sinistra della finestra principale di QGIS.
Una volta caricato il layer, puoi identificare e selezionare un paio di elementi e visualizzare la tabella degli attributi.

Nota: QGIS supporta diverse versioni del protocollo WFS, con download in background e visualizzazione
progressiva, caching su disco delle geometrie scaricate e rilevamento automatico delle versioni.

Suggerimento: Cercare server WFS
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Puoi ricercare ulteriori server WFS tramite Google o altro motore di ricerca preferito. Ci sono anche diversi
elenchi di URL pubblici, alcuni dei quali aggiornati e altri non più manutenuti.

17.2 QGIS come OGC Data Server

QGIS Server è un’applicazine WMS 1.3, WFS 1.0.0, WFS 1.1.0 e WCS 1.1.1 a codice aperto che, inoltre, attiva
funzionalità cartografiche avanzate per la mappatura tematica. QGIS Server è un’applicazione FastCGI / CGI
(Common Gateway Interface) scritta in C ++ che funziona insieme a un server Web (ad es. Apache, Lighttpd). Ha
il supporto plugin Python che consente lo sviluppo e l’implementazione rapidi ed efficienti di nuove funzionalità.
Lo sviluppo originale di QGIS Server è stato finanziato dai progetti dell’UE Orchestra, Sany e dalla città di Uster
in Svizzera.

QGIS Server utilizza QGIS come backend per la restituzione delle mappe e per le operazioni gis. Inoltre, la libreria
Qt viene utilizzata per la grafica e per la programmazione C ++ indipendente dalla piattaforma. A differenza di altri
sserver WMS, QGIS Server usa regole cartografiche come linguaggio di configurazione, sia per la configurazione
a livello server che per le configurazioni utente.

Come QGIS desktop, QGIS Server utilizza le stesse librerie di visualizzazione e le mappe che vengono pubblicate
sulla rete hanno lo stesso aspetto che in desktop GIS.

Nelle sezioni seguenti, vedrai una configurazione di esempio per impostare un server QGIS su Debian/Ubuntu
Linux. Per istruzioni di installazione più dettagliate su altre piattaforme o distribuzioni e ulteriori informazioni su
come lavorare con il server QGIS, si consiglia di leggere il Manuale di formazione QGIS or server_plugins.

17.2.1 Come Iniziare

INstallazione su sistemi Debian

A questo punto, ti forniamo un’installazione breve e semplice per una minima configurazione di lavoro sui sistemi
Debian. Tuttavia, molte altre distribuzioni e sistemi operativi forniscono pacchetti per QGIS Server.

I requisiti e i passaggi per installare QGIS server su un sistema Debian sono forniti nella “pagina dei programmi
di installazione di QGIS <https://qgis.org/en/site/forusers/alldownloads.html>‘_. Fai riferimento a quella sezione.

Configura il server HTTP

Apache

Puoi usare Apache e il suo modulo mod_fcgid <https://httpd.apache.org/mod_fcgid/mod/mod_fcgid.html> per
eseguirre QGIS server.

Installa Apache e mod_fcgid:

sudo apt install apache2 libapache2-mod-fcgid

Qui assumiamo che un VirtualHost di Apache sia già impostato. Ad esempio, questo è l’aspetto di una
configurazione di base VirtualHost:

<VirtualHost *:80>

ServerAdmin webmaster@localhost
DocumentRoot /var/www/html

ErrorLog ${APACHE_LOG_DIR}/error.log
CustomLog ${APACHE_LOG_DIR}/access.log combined

</VirtualHost>
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Nota: Sui sistemi Debian è utilizzabile un VirtualHost predefinito in /etc/apache2/
sites-available/000-default.conf.

Aggiungi ora le direttive di configurazione mod_fcgid per QGIS Server:

<VirtualHost *:80>

ServerAdmin webmaster@localhost
DocumentRoot /var/www/html

ErrorLog ${APACHE_LOG_DIR}/error.log
CustomLog ${APACHE_LOG_DIR}/access.log combined

FcgidInitialEnv DISPLAY ":99"
FcgidInitialEnv QGIS_SERVER_LOG_LEVEL "0"
FcgidInitialEnv QGIS_SERVER_LOG_STDERR "1"

<Location /qgisserver>
SetHandler fcgid-script
FcgidWrapper /usr/lib/cgi-bin/qgis_mapserv.fcgi virtual
Options +ExecCGI -MultiViews +FollowSymLinks
Require all granted

</Location>

</VirtualHost>

Vedi la documentazione di mod_fcgid per ulteriori informazioni sui parametri Fcgid utilizzati e vedi sotto per
capire quando e perché la variabile d’ambiente DISPLAY deve essere impostata.

Ora riavvia Apache per usare la nuova configurazione:

sudo service apache2 restart

QGIS Server è ora utilizzabile a http://localhost/qgisserver.

NGINX

Puoi utilizzare QGIS Server con NGINX. A differenza di Apache, NGINX non genera automaticamente processi
FastCGI. I processi FastCGI devono essere attivati.

Sui sistemi basati su Debian, puoi utilizzare**fcgiwrap** o spawn-fcgi per avviare e gestire i processi di QGIS
server. Esistono pacchetti ufficiali Debian per entrambi.

Nota: fcgiwrap è più facile da configurare rispetto a spawn-fcgi, perché è già incluso in un servizio Systemd. Ma
porta anche a una soluzione che è molto più lenta rispetto all’utilizzo di spawn-fcgi. Con fcgiwrap viene creato
un nuovo processo di QGIS server su ogni richiesta, il che significa che il processo di inizializzazione di QGIS
server, che include la lettura e l’analisi del file di progetto QGIS, viene eseguito su ogni richiesta. Con spawn-
fcgi, il processo di QGIS server rimane attivo tra le richieste, con prestazioni molto migliori. Per questo motivo,
spawn-fcgi è raccomandato per l’uso in produzione.

Installa NGINX:

sudo apt install nginx
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fcgiwrap

If you want to use fcgiwrap to run QGIS Server, you first have to install the corresponding package:

sudo apt install fcgiwrap

Then, introduce the following block in your NGINX server configuration:

1 location /qgisserver {
2 gzip off;
3 include fastcgi_params;
4 fastcgi_pass unix:/var/run/fcgiwrap.socket;
5 fastcgi_param SCRIPT_FILENAME /usr/lib/cgi-bin/qgis_mapserv.fcgi;
6 }

Finally, restart NGINX and fcgiwrap to take into account the new configuration:

sudo service nginx restart
sudo service fcgiwrap restart

QGIS Server è ora utilizzabile a http://localhost/qgisserver.

spawn-fcgi

If you prefer to use spawn-fcgi instead of fcgiwrap, the first step is to install the package:

sudo apt install spawn-fcgi

Then, introduce the following block in your NGINX server configuration:

location /qgisserver {
gzip off;
include fastcgi_params;
fastcgi_pass unix:/var/run/qgisserver.socket;

}

And restart NGINX to take into account the new configuration:

sudo service nginx restart

Finally, considering that there is no default service file for spawn-fcgi, you have to manually start QGIS Server in
your terminal:

sudo spawn-fcgi -s /var/run/qgisserver.socket \
-U www-data -G www-data -n \
/usr/lib/bin/cgi-bin/qgis_mapserv.fcgi

Of course, you may write an init script (like a qgisserver.service file with Systemd) to start QGIS Server
at boot time or whenever you want.

QGIS Server è ora utilizzabile a http://localhost/qgisserver.

Nota: With the above command spawn-fcgi spawns only one QGIS Server process. To use more than one QGIS
Server process you can combine spawn-fcgi with the multiwatch tool, which is also packaged in Debian.
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Configuration

The include fastcgi_params; used in previous configuration is important as it adds the parameters from /etc/
nginx/fastcgi_params:

fastcgi_param QUERY_STRING $query_string;
fastcgi_param REQUEST_METHOD $request_method;
fastcgi_param CONTENT_TYPE $content_type;
fastcgi_param CONTENT_LENGTH $content_length;

fastcgi_param SCRIPT_NAME $fastcgi_script_name;
fastcgi_param REQUEST_URI $request_uri;
fastcgi_param DOCUMENT_URI $document_uri;
fastcgi_param DOCUMENT_ROOT $document_root;
fastcgi_param SERVER_PROTOCOL $server_protocol;
fastcgi_param REQUEST_SCHEME $scheme;
fastcgi_param HTTPS $https if_not_empty;

fastcgi_param GATEWAY_INTERFACE CGI/1.1;
fastcgi_param SERVER_SOFTWARE nginx/$nginx_version;

fastcgi_param REMOTE_ADDR $remote_addr;
fastcgi_param REMOTE_PORT $remote_port;
fastcgi_param SERVER_ADDR $server_addr;
fastcgi_param SERVER_PORT $server_port;
fastcgi_param SERVER_NAME $server_name;

# PHP only, required if PHP was built with --enable-force-cgi-redirect
fastcgi_param REDIRECT_STATUS 200;

Of course, you may override these variables in your own configuration. For example:

include fastcgi_params;
fastcgi_param SERVER_NAME domain.name.eu;

Moreover, you can use some Environment variables to configure QGIS Server. With NGINX as HTTP Server,
you have to use fastcgi_param to define these variables as shown below:

fastcgi_param QGIS_DEBUG 1;
fastcgi_param QGIS_SERVER_LOG_FILE /tmp/qgis-000.log;
fastcgi_param QGIS_SERVER_LOG_LEVEL 0;

Nota: When using spawn-fcgi, you may directly define environment variables before running the server. For
example: export QGIS_SERVER_LOG_FILE=/home/user/qgis.log

Xvfb

QGIS Server needs a running X Server to be fully usable. But if you don’t have one, you may use xvfb to have a
virtual X environment.

To install the package:

sudo apt install xvfb

Then, according to your HTTP server, you should configure the DISPLAY parameter or directly use xvfb-run.

For example with NGINX and spawn-fcgi using xvfb-run:
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xvfb-run /usr/bin/spawn-fcgi -f /usr/lib/bin/cgi-bin/qgis_mapserv.fcgi \
-s /tmp/qgisserver.socket \
-G www-data -U www-data -n

The other option is to start a virtual X server environment with a specific display number thanks to Xvfb:

/usr/bin/Xvfb :99 -screen 0 1024x768x24 -ac +extension GLX +render -noreset

Then we just have to set the DISPLAY environment variable in the HTTP server configuration. For example with
NGINX:

fastcgi_param DISPLAY ":99";

Or with Apache:

FcgidInitialEnv DISPLAY ":99"

Installation on Windows

QGIS Server can also be installed on Windows systems. While the QGIS Server package is available in the 64 bit
version of the OSGeo4W network installer (https://qgis.org/en/site/forusers/download.html) there is no Apache
(or other web server) package available, so this must be installed by other means.

A simple procedure is the following:

• Download the XAMPP installer (https://www.apachefriends.org/download.html) for Windows and install
Apache

• Download the OSGeo4W installer, follow the «Advanced Install» and install both the QGIS Desktop and
QGIS Server packages
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• Edit the httpd.conf file (C:\xampp\apache\httpd.conf if the default installation paths have been
used) and make the following changes:

From:

ScriptAlias /cgi-bin/ "C:/xampp/cgi-bin/"

To:

ScriptAlias /cgi-bin/ "c:/OSGeo4W64/apps/qgis/bin/"

From:

<Directory "C:/xampp/cgi-bin">
AllowOverride None
Options None
Require all granted
</Directory>

To:

<Directory "c:/OSGeo4W64/apps/qgis/bin">
SetHandler cgi-script
AllowOverride None
Options ExecCGI
Order allow,deny
Allow from all
Require all granted
</Directory>

From:

AddHandler cgi-script .cgi .pl .asp

To:

AddHandler cgi-script .cgi .pl .asp .exe
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Then at the bottom of httpd.conf add:

SetEnv GDAL_DATA "C:\OSGeo4W64\share\gdal"
SetEnv QGIS_AUTH_DB_DIR_PATH "C:\OSGeo4W64\apps\qgis\resources"
SetEnv PYTHONHOME "C:\OSGeo4W64\apps\Python36"
SetEnv PATH "C:\OSGeo4W64\bin;C:\OSGeo4W64\apps\qgis\bin;C:\OSGeo4W64\apps\Qt5\bin;
→˓C:\WINDOWS\system32;C:\WINDOWS;C:\WINDOWS\System32\Wbem"
SetEnv QGIS_PREFIX_PATH "C:\OSGeo4W64\apps\qgis"
SetEnv QT_PLUGIN_PATH "C:\OSGeo4W64\apps\qgis\qtplugins;
→˓C:\OSGeo4W64\apps\Qt5\plugins"

Restart the Apache web server from the XAMPP Control Panel and open browser window to testing a GetCapa-
bilities request to QGIS Server

http://localhost/cgi-bin/qgis_mapserv.fcgi.exe?SERVICE=WMS&VERSION=1.3.0&REQUEST=
GetCapabilities

Serve a project

Now that QGIS Server is installed and running, we just have to use it.

Obviously, we need a QGIS project to work on. Of course, you can fully customize your project by defining
contact information, precise some restrictions on CRS or even exclude some layers. Everything you need to know
about that is described later in Configure your project.

But for now, we are going to use a simple project already configured. To retrieve the project:

cd /home/user/
wget https://github.com/qgis/QGIS-Training-Data/archive/QGIS-Training-Data-v2.0.
→˓zip -O qgis-server-tutorial.zip
unzip qgis-server-tutorial.zip
mv QGIS-Training-Data-QGIS-Training-Data-v2.0/training_manual_data/qgis-server-
→˓tutorial-data ~

The project file is qgis-server-tutorial-data-master/world.qgs. Of course, you can use your
favorite GIS software to open this file and take a look on the configuration and available layers.

By opening the project and taking a quick look on layers, we know that 4 layers are currently available:

• airports

• places

• countries

• countries_shapeburst

You don’t have to understand the full request for now but you may retrieve a map with some of the previous layers
thanks to QGIS Server by doing something like this in your web browser to retrieve the countries layer:

http://localhost/qgisserver?
MAP=/home/user/qgis-server-tutorial-data-master/world.qgs&
LAYERS=countries&
SERVICE=WMS&
REQUEST=GetMap&
CRS=EPSG:4326&
WIDTH=400&
HEIGHT=200

If you obtain the next image, then QGIS Server is running correctly:

Note that you may define PROJECT_FILE environment variable to use a project by default instead of giving a
MAP parameter (see Environment variables).

For example with spawn-fcgi:
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Figure 17.6: Server response to a basic GetMap request

export PROJECT_FILE=/home/user/qgis-server-tutorial-data-master/world.qgs
spawn-fcgi -f /usr/lib/bin/cgi-bin/qgis_mapserv.fcgi \

-s /var/run/qgisserver.socket \
-U www-data -G www-data -n

Configure your project

To provide a new QGIS Server WMS, WFS or WCS, you have to create a QGIS project file with some data or use
one of your current project. Define the colors and styles of the layers in QGIS and the project CRS, if not already
defined.

Then, go to the QGIS Server menu of the Project → Properties. . . dialog and provide some information about
the OWS in the fields under Service Capabilities. This will appear in the GetCapabilities response of the WMS,

WFS or WCS. If you don’t check Service capabilities, QGIS Server will use the information given in the
wms_metadata.xml file located in the cgi-bin folder.

WMS capabilities

In the WMS capabilities section, you can define the extent advertised in the WMS GetCapabilities response by
entering the minimum and maximum X and Y values in the fields under Advertised extent. Clicking Use Current

Canvas Extent sets these values to the extent currently displayed in the QGIS map canvas. By checking CRS
restrictions, you can restrict in which coordinate reference systems (CRS) QGIS Server will offer to render maps.
It is recommended that you restrict the offered CRS as this reduces the size of the WMS GetCapabilities response.

Use the button below to select those CRSs from the Coordinate Reference System Selector, or click Used to
add the CRSs used in the QGIS project to the list.

If you have print layouts defined in your project, they will be listed in the GetProjectSettings response, and they
can be used by the GetPrint request to create prints, using one of the print layout layouts as a template. This is
a QGIS-specific extension to the WMS 1.3.0 specification. If you want to exclude any print layout from being

published by the WMS, check Exclude layouts and click the button below. Then, select a print layout
from the Select print layout dialog in order to add it to the excluded layouts list.

If you want to exclude any layer or layer group from being published by the WMS, check Exclude Layers

and click the button below. This opens the Select restricted layers and groups dialog, which allows you to
choose the layers and groups that you don’t want to be published. Use the Shift or Ctrl key if you want to
select multiple entries. It is recommended that you exclude from publishing the layers that you don’t need as this
reduces the size of the WMS GetCapabilities response which leads to faster loading times on the client side.
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Figure 17.7: Definitions for a QGIS Server WMS/WFS/WCS project
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You can receive requested GetFeatureInfo as plain text, XML and GML. Default is XML, text or GML format
depends the output format chosen for the GetFeatureInfo request.

If you wish, you can check Add geometry to feature response. This will include in the GetFeatureInfo response
the geometries of the features in a text format.

As many web clients can’t display circular arcs in geometries you have the option to segmentize the geometry
before sending it to the client in a GetFeatureInfo response. This allows such clients to still display a feature’s

geometry (e.g. for highlighting the feature). You need to check the Segmentize feature info geometry to activate
the option.

You can also use the GetFeatureInfo geometry precision option to set the precision of the GetFeatureInfo geometry.
This enables you to save bandwidth when you don’t need the full precision.

If you want QGIS Server to advertise specific request URLs in the WMS GetCapabilities response, enter the
corresponding URL in the Advertised URL field.

Furthermore, you can restrict the maximum size of the maps returned by the GetMap request by entering the
maximum width and height into the respective fields under Maximums for GetMap request.

If one of your layers uses the Map Tip display (i.e. to show text using expressions) this will be listed inside the
GetFeatureInfo output. If the layer uses a Value Map for one of its attributes, this information will also be shown
in the GetFeatureInfo output.

WFS capabilities

In the WFS capabilities area you can select the layers you want to publish as WFS, and specify if they will allow
update, insert and delete operations. If you enter a URL in the Advertised URL field of the WFS capabilities
section, QGIS Server will advertise this specific URL in the WFS GetCapabilities response.

WCS capabilities

In the WCS capabilities area, you can select the layers that you want to publish as WCS. If you enter a URL in the
Advertised URL field of the WCS capabilities section, QGIS Server will advertise this specific URL in the WCS
GetCapabilities response.

Fine tuning your OWS

For vector layers, the Fields menu of the Layer → Properties dialog allows you to define for each attribute if it
will be published or not. By default, all the attributes are published by your WMS and WFS. If you don’t want a
specific attribute to be published, uncheck the corresponding checkbox in the WMS or WFS column.

You can overlay watermarks over the maps produced by your WMS by adding text annotations or SVG annotations
to the project file. See the Note testuali section for instructions on creating annotations. For annotations to be
displayed as watermarks on the WMS output, the Fixed map position checkbox in the Annotation text dialog must
be unchecked. This can be accessed by double clicking the annotation while one of the annotation tools is active.
For SVG annotations, you will need either to set the project to save absolute paths (in the General menu of the
Project → Properties. . . dialog) or to manually modify the path to the SVG image so that it represents a valid
relative path.

17.2.2 Servizi

QGIS è in grado di gestire i dati secondo i protocolli standard come descritto da Open Geospatial Consortium
(OGC):

• WMS 1.1.0 e 1.3.0

• WFS 1.0.0 e 1.1.0

448 Chapter 17. Lavorare con i dati OGC



QGIS User Guide, Release 3.4

• WCS 1.1.1

• WMTS 1.0.0

Ulteriori parametri e richieste sono supportati in aggiunta allo standard originale che migliora notevolmente le
possibilità di personalizzazione grazie al motore di visualizzazione QGIS.

Web Map Service (WMS)

The 1.1.0 and 1.3.0 WMS standards implemented in QGIS Server provide a HTTP interface to request map or
legend images generated from a QGIS project. A typical WMS request defines the QGIS project to use, the layers
to render as well as the image format to generate. Basic support is also available for the Styled Layer Descriptor
(SLD) standard.

Specifications document according to the version number of the service:

• WMS 1.1.0

• WMS 1.3.0

Standard requests provided by QGIS Server:

Request Description
GetCapabilities Return XML metadata with information about the server
GetMap Return a map
GetFeatureInfo Retrieves data (geometry and values) for a pixel location
GetLegendGraphics Returns legend symbols

Vendor requests provided by QGIS Server:

Request Description
GetPrint Returns a QGIS composition
GetProjectSettings Returns specific information about QGIS Server

GetMap

Standard parameters for the GetMap request according to the OGC WMS 1.1.0 and 1.3.0 specifications:

Parameter Required Description
SERVICE Yes Name of the service (WMS)
VERSION No Version of the service
REQUEST Yes Name of the request (GetMap)
LAYERS No Layers to display
STYLES No Layers” style
SRS / CRS Yes Coordinate reference system
BBOX No Map extent
WIDTH Yes Width of the image in pixels
HEIGHT Yes Height of the image in pixels
FORMAT No Image format
TRANSPARENT No Transparent background
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In addition to the standard ones, QGIS Server supports the following extra parameters:

Parameter Required Description
MAP Yes Specify the QGIS project file
BGCOLOR No Specify the background color
DPI No Specify the output resolution
IMAGE_QUALITY No JPEG compression
OPACITIES No Opacity for layer or group
FILTER No Subset of features
SELECTION No Highlight features
FILE_NAME No Only for

FORMAT=application/dxf
File name of the downloaded file

FORMAT_OPTIONS No Only for
FORMAT=application/dxf
key:value pairs separated by semi-
colon.

• SCALE: to be used for
symbology rules, filters and
styles (not actual scaling of
the data - data remains in the
original scale).

•
MODE:NOSYMBOLOGY|FEATURESYMBOLOGY|SYMBOLLAYERSYMBOLOGY:
corresponds to the three ex-
port options offered in the
QGIS Desktop DXF export
dialog.

•
LAYERSATTRIBUTES:yourcolumn_with_values_to_be_used_for_dxf_layernames
if not specified, the original
QGIS layer names are used.

•
USE_TITLE_AS_LAYERNAME:
if enabled, the title of the
layer will be used as layer
name.

URL example:

http://localhost/qgis_server?
SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&MAP=/home/user/project.qgs
&LAYERS=mylayer1,mylayer2,mylayer3
&STYLES=style1,default,style3
&OPACITIES=125,200,125
&CRS=EPSG:4326
&WIDTH=400
&HEIGHT=400
&FORMAT=image/png
&TRANSPARENT=TRUE

450 Chapter 17. Lavorare con i dati OGC



QGIS User Guide, Release 3.4

&DPI=300

SERVICE

This parameter has to be WMS in case of the GetMap request.

VERSION

This parameter allows to specify the version of the service to use. Available values for the VERSION parameter
are:

• 1.1.0

• 1.3.0

If no version is indicated in the request, then 1.3.0 is used by default.

According to the version number, slight differences have to be expected as explained later for the next parameters:

• CRS / SRS

• BBOX

REQUEST

This parameter is GetMap in case of the GetMap request.

LAYERS

This parameter allows to specify the layers to display on the map. Names have to be separated by a comma.

In addition, QGIS Server introduced some options to select layers by:

• a short name

• the layer id

The short name of a layer may be configured through Properties → Metadata in layer menu. If the short name is
defined, then it’s used by default instead of the layer’s name:

http://localhost/qgis_server?
SERVICE=WMS
&REQUEST=GetMap
&LAYERS=mynickname1,mynickname2
&...

Moreover, there’s a project option allowing to select layers by their id in OWS Server → WMS capabilities menu
of the Project → Properties. . . dialog. To activate this option, the checkbox Use layer ids as names has to be
selected.

http://localhost/qgis_server?
SERVICE=WMS
&REQUEST=GetMap
&LAYERS=mylayerid1,mylayerid2
&...
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STYLES

This parameter can be used to specify a layer’s style for the rendering step. Styles have to be separated by a
comma. The name of the default style is default.

SRS / CRS

This parameter allows to indicate the map output Spatial Reference System in WMS 1.1.0 and has to be formed
like EPSG:XXXX. Note that CRS is also supported if current version is 1.1.0.

For WMS 1.3.0, CRS parameter is preferable but SRS is also supported.

Note that if both CRS and SRS parameters are indicated in the request, then it’s the current version indicated in
VERSION parameter which is decisive.

In the next case, the SRS parameter is kept whatever the VERSION parameter because CRS is not indicated:

http://localhost/qgis_server?
SERVICE=WMS
&REQUEST=GetMap
&VERSION=1.3.0
&SRS=EPSG:2854
&...

In the next case, the SRS parameter is kept instead of CRS because of the VERSION parameter:

http://localhost/qgis_server?
SERVICE=WMS
&REQUEST=GetMap
&VERSION=1.1.0
&CRS=EPSG:4326
&SRS=EPSG:2854
&...

In the next case, the CRS parameter is kept instead of SRS because of the VERSION parameter:

http://localhost/qgis_server?
SERVICE=WMS
&REQUEST=GetMap
&VERSION=1.3.0
&CRS=EPSG:4326
&SRS=EPSG:2854
&...

BBOX

This parameter allows to specify the map extent with units according to the current CRS. Coordinates have to be
separated by a comma.

However, a slight difference has to be noticed according to the current VERSION parameter. Actually, in WMS
1.1.0, coordinates are formed like minx,miny,maxx,maxy or minlong,minlat,maxlong,maxlat.
For example:

http://localhost/qgis_server?
SERVICE=WMS
&REQUEST=GetMap
&VERSION=1.1.0
&SRS=epsg:4326
&BBOX=-180,-90,180,90
&...
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But the axis is reversed in WMS 1.3.0, so coordinates are formed like: miny,minx,maxy,maxx or minlat,
minlong,maxlat,maxlong. For example:

http://localhost/qgis_server?
SERVICE=WMS
&REQUEST=GetMap
&VERSION=1.3.0
&CRS=epsg:4326
&BBOX=-90,-180,90,180
&...

WIDTH

This parameter allows to specify the width in pixels of the output image.

HEIGHT

This parameter allows to specify the height in pixels of the output image.

FORMAT

This parameter may be used to specify the format of map image. Available values are:

• jpg

• jpeg

• image/jpeg

• image/png

• image/png; mode=1bit

• image/png; mode=8bit

• image/png; mode=16bit

• application/dxfOnly layers that have read access in the WFS service are exported in the DXF format.

URL example:

http://localhost/qgis_server?
SERVICE=WMS&VERSION=1.3.0
&REQUEST=GetMap
&FORMAT=application/dxf
&LAYERS=Haltungen,Normschacht,Spezialbauwerke
&STYLES=
&CRS=EPSG%3A21781&BBOX=696136.28844801,245797.12108743,696318.91114315,245939.
→˓25832905
&WIDTH=1042
&HEIGHT=811
&FORMAT_OPTIONS=MODE:SYMBOLLAYERSYMBOLOGY;SCALE:250&FILE_NAME=plan.dxf

TRANSPARENT

This boolean parameter can be used to specify the background transparency. Available values are (not case sensi-
tive):

• TRUE

• FALSE
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However, this parameter is ignored if the format of the map image indicated with FORMAT is different from PNG.

MAP

This parameter allows to define the QGIS project file to use.

As mentioned in GetMap parameters table, MAP is mandatory because a request needs a QGIS project to actually
work. However, the QGIS_PROJECT_FILE environment variable may be used to define a default QGIS project.
In this specific case, MAP is not longer a required parameter. For further information you may refer to Advanced
configuration.

BGCOLOR

This parameter allows to indicate a background color for the map image. However it cannot be combined with
TRANSPARENT parameter in case of PNG images (transparency takes priority). The colour may be literal or in
hexadecimal notation.

URL example with the literal notation:

http://localhost/qgis_server?
SERVICE=WMS
&REQUEST=GetMap
&VERSION=1.3.0
&BGCOLOR=green
&...

URL example with the hexadecimal notation:

http://localhost/qgis_server?
SERVICE=WMS
&REQUEST=GetMap
&VERSION=1.3.0
&BGCOLOR=0x00FF00
&...

DPI

This parameter can be used to specify the requested output resolution.

IMAGE_QUALITY

This parameter is only used for JPEG images. By default, the JPEG compression is -1.

You can change the default per QGIS project in the OWS Server → WMS capabilities menu of the Project →
Properties. . . dialog. If you want to override it in a GetMap request you can do it using the IMAGE_QUALITY
parameter.

OPACITIES

Opacity can be set on layer or group level. Allowed values range from 0 (fully transparent) to 255 (fully opaque).
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FILTER

A subset of layers can be selected with the FILTER parameter. Syntax is basically the same as for the QGIS
subset string. However, there are some restrictions to avoid SQL injections into databases via QGIS Server. If a
dangerous string is found in the parameter, QGIS Server will return the next error:

Indeed, text strings need to be enclosed with quotes (single quotes for strings,
→˓double quotes for attributes). A space between each word / special character is
→˓mandatory. Allowed Keywords and special characters are 'AND','OR','IN','=','<','>
→˓=','>','>=','!=*,'(',')'. Semicolons in string expressions are not allowed

URL example:

http://localhost/qgis_server?
SERVICE=WMS
&REQUEST=GetMap
&LAYERS=mylayer1,mylayer2
&FILTER=mylayer1:"OBJECTID" = 3;mylayer2:'text' = 'blabla'
&...

Nota: It is possible to make attribute searches via GetFeatureInfo and omit the X/Y parameter if a FILTER is
there. QGIS Server then returns info about the matching features and generates a combined bounding box in the
xml output.

SELECTION

The SELECTION parameter can highlight features from one or more layers. Vector features can be selected by
passing comma separated lists with feature ids.

http://localhost/qgis_server?
SERVICE=WMS
&REQUEST=GetMap
&LAYERS=mylayer1,mylayer2
&SELECTION=mylayer1:3,6,9;mylayer2:1,5,6
&...

The following image presents the response from a GetMap request using the SELECTION option e.g. http://
myserver.com/...&SELECTION=countries:171,65.

As those features id’s correspond in the source dataset to France and Romania they’re highlighted in yellow.

GetFeatureInfo

Standard parameters for the GetFeatureInfo request according to the OGC WMS 1.1.0 and 1.3.0 specifications:

17.2. QGIS come OGC Data Server 455



QGIS User Guide, Release 3.4

Figure 17.8: Server response to a GetMap request with SELECTION parameter
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Parameter Required Description
SERVICE Yes Name of the service (WMS)
VERSION No See GetMap
REQUEST Yes See GetMap
LAYERS No See GetMap
STYLES No See GetMap
SRS / CRS Yes See GetMap
BBOX No See GetMap
WIDTH Yes See GetMap
HEIGHT Yes See GetMap
TRANSPARENT No See GetMap
INFO_FORMAT No Output format
QUERY_LAYERS Yes Layers to query
FEATURE_COUNT No Maximum number of features to return
I No Pixel column of the point to query
X No Same as I parameter, but in WMS 1.1.0
J No Pixel row of the point to query
Y No Same as J parameter, but in WMS 1.1.0

In addition to the standard ones, QGIS Server supports the following extra parameters:

Parameter Required Description
MAP Yes See GetMap
FILTER No See GetMap
FI_POINT_TOLERANCE No Tolerance in pixels for point layers
FI_LINE_TOLERANCE No Tolerance in pixels for line layers
FI_POLYGON_TOLERANCE No Tolerance in pixels for polygon layers
FILTER_GEOM No Geometry filtering
WITH_MAPTIP No Add map tips to the output
WITH_GEOMETRY No Add geometry to the output

URL example:

http://localhost/qgis_server?
SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&MAP=/home/user/project.qgs
&LAYERS=mylayer1,mylayer2,mylayer3
&CRS=EPSG:4326
&WIDTH=400
&HEIGHT=400
&INFO_FORMAT=text/xml
&TRANSPARENT=TRUE
&QUERY_LAYERS=mylayer1
&FEATURE_COUNT=3
&I=250
&J=250
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INFO_FORMAT

This parameter may be used to specify the format of the result. Available values are:

• text/xml

• text/html

• text/plain

• application/vnd.ogc.gml

• application/json

QUERY_LAYERS

This parameter specifies the layers to display on the map. Names are separated by a comma.

In addition, QGIS Server introduces options to select layers by:

• short name

• layer id

See the LAYERS parameter defined in See GetMap for more information.

FEATURE_COUNT

This parameter specifies the maximum number of features per layer to return. For example if QUERY_LAYERS
is set to layer1,layer2 and FEATURE_COUNT is set to 3 then a maximum of 3 features from layer1 will be
returned. Likewise a maximun of 3 features from layer2 will be returned.

By default, only 1 feature per layer is returned.

I

This parameter, defined in WMS 1.3.0, allows you to specify the pixel column of the query point.

X

Same parameter as I, but defined in WMS 1.1.0.

J

This parameter, defined in WMS 1.3.0, allows you to specify the pixel row of the query point.

Y

Same parameter as J, but defined in WMS 1.1.0.

FI_POINT_TOLERANCE

This parameter specifies the tolerance in pixels for point layers.
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FI_LINE_TOLERANCE

This parameter specifies the tolerance in pixels for line layers.

FI_POLYGON_TOLERANCE

This parameter specifies the tolerance in pixels for polygon layers.

FILTER_GEOM

This parameter specifies a WKT geometry with which features have to intersect.

WITH_MAPTIP

This parameter specifies whether to add map tips to the output.

Available values are (not case sensitive):

• TRUE

• FALSE

WITH_GEOMETRY

This parameter specifies whether to add geometries to the output.

Available values are (not case sensitive):

• TRUE

• FALSE

GetPrint

QGIS Server has the capability to create print layout output in pdf or pixel format. Print layout windows in the
published project are used as templates. In the GetPrint request, the client has the possibility to specify parameters
of the contained layout maps and labels.

Parameters for the GetPrint request:
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Parameter Required Description
MAP Yes Specify the QGIS project file
SERVICE Yes Name of the service (WMS)
VERSION No See GetMap
REQUEST Yes Name of the request (GetPrint)
LAYERS No See GetMap
TEMPLATE Yes Layout template to use
SRS / CRS Yes See GetMap
FORMAT Yes Output format
STYLES No See GetMap
TRANSPARENT No See GetMap
OPACITIES No See GetMap
SELECTION No See GetMap
mapX:EXTENT No Extent of the map “X”
mapX:LAYERS No Layers of the map “X”
mapX:STYLES No Layers” style of the map “X”
mapX:SCALE No Layers” scale of the map “X”
mapX:ROTATION No Rotation of the map “X”
mapX:GRID_INTERVAL_X No Grid interval on x axis of the map “X”
mapX:GRID_INTERVAL_Y No Grid interval on y axis of the map “X”

URL example:

http://localhost/qgis_server?
SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetPrint
&MAP=/home/user/project.qgs
&CRS=EPSG:4326
&FORMAT=png
&map0:EXTENT=-180,-90,180,90
&map0:LAYERS=mylayer1,mylayer2,mylayer3
&map0:OPACITIES=125,200,125
&map0:ROTATION=45

Note that the layout template may contain more than one map. In this way, if you want to configure a specific
map, you have to use mapX: parameters where X is a positive number that you can retrieve thanks to the GetPro-
jectSettings request.

For example:

<WMS_Capabilities>
...
<ComposerTemplates xsi:type="wms:_ExtendedCapabilities">
<ComposerTemplate width="297" height="210" name="Druckzusammenstellung 1">
<ComposerMap width="171" height="133" name="map0"/>
<ComposerMap width="49" height="46" name="map1"/></ComposerTemplate>
</ComposerTemplates>
...
</WMS_Capabilities>

SERVICE

This parameter has to be WMS.
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REQUEST

This parameter has to be GetPrint for the GetPrint request.

TEMPLATE

This parameter can be used to specify the name of a layout template to use for printing.

FORMAT

This parameter specifies the format of map image. Available values are:

• jpg

• jpeg

• image/jpeg

• png

• image/png

• svg

• image/svg

• image/svg+xml

• pdf

• application/pdf

If the FORMAT parameter is different from one of these values, then an exception is returned.

mapX:EXTENT

This parameter specifies the extent for a layout map item as xmin,ymin,xmax,ymax.

mapX:ROTATION

This parameter specifies the map rotation in degrees.

mapX:GRID_INTERVAL_X

This parameter specifies the grid line density in the X direction.

mapX:GRID_INTERVAL_Y

This parameter specifies the grid line density in the Y direction.

mapX:SCALE

This parameter specifies the map scale for a layout map item. This is useful to ensure scale based visibility of
layers and labels even if client and server may have different algorithms to calculate the scale denominator.
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mapX:LAYERS

This parameter specifies the layers for a layout map item. See See GetMap for more information on this parameter.

mapX:STYLES

This parameter specifies the layers” styles defined in a specific layout map item. See See GetMap for more
information on this parameter.

GetLegendGraphics

Several additional parameters are available to change the size of the legend elements:

• BOXSPACE space between legend frame and content (mm)

• LAYERSPACE vertical space between layers (mm)

• LAYERTITLESPACE vertical space between layer title and items following (mm)

• SYMBOLSPACE vertical space between symbol and item following (mm)

• ICONLABELSPACE horizontal space between symbol and label text (mm)

• SYMBOLWIDTH width of the symbol preview (mm)

• SYMBOLHEIGHT height of the symbol preview (mm)

These parameters change the font properties for layer titles and item labels:

• LAYERFONTFAMILY / ITEMFONTFAMILY font family for layer title / item text

• LAYERFONTBOLD / ITEMFONTBOLD TRUE to use a bold font

• LAYERFONTSIZE / ITEMFONTSIZE Font size in point

• LAYERFONTITALIC / ITEMFONTITALIC TRUE to use italic font

• LAYERFONTCOLOR / ITEMFONTCOLOR Hex color code (e.g. #FF0000 for red)

• LAYERTITLE / RULELABEL set them to FALSE to get only the legend graphics without labels

Content based legend. These parameters let the client request a legend showing only the symbols for the features
falling into the requested area:

• BBOX the geographical area for which the legend should be built

• CRS / SRS the coordinate reference system adopted to define the BBOX coordinates

• WIDTH / HEIGHT if set these should match those defined for the GetMap request, to let QGIS Server
scale symbols according to the map view image size.

Content based legend features are based on the UMN MapServer implementation:

• SHOWFEATURECOUNT if set to TRUE adds in the legend the feature count of the features like in the
following image:
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GetProjectSettings

This request type works similar to GetCapabilities, but it is more specific to QGIS Server and allows a client to
read additional information which is not available in the GetCapabilities output:

• initial visibility of layers

• information about vector attributes and their edit types

• information about layer order and drawing order

• list of layers published in WFS

Web Feature Service (WFS)

The 1.0.0 and 1.1.0 WFS standards implemented in QGIS Server provide a HTTP interface to query geographic
features from a QGIS project. A typical WFS request defines the QGIS project to use and the layer to query.

Specifications document according to the version number of the service:

• WFS 1.0.0

• WFS 1.1.0

Standard requests provided by QGIS Server:

Request Description
GetCapabilities Returns XML metadata with information about the server
GetFeature Returns a selection of features
DescribeFeatureType Returns a description of feature types and properties
Transaction Allows features to be inserted, updated or deleted

GetFeature

Standard parameters for the GetFeature request according to the OGC WFS 1.0.0 and 1.1.0 specifications:

Parameter Required Description
SERVICE Yes Name of the service
VERSION No Version of the service
REQUEST Yes Name of the request
TYPENAME No Name of layers
OUTPUTFORMAT No Output Format
RESULTTYPE No Type of the result
PROPERTYNAME No Name of properties to return
MAXFEATURES No Maximum number of features to return
SRSNAME No Coordinate reference system
FEATUREID No Filter the features by ids
FILTER No OGC Filter Encoding
BBOX No Map Extent
SORTBY No Sort the results

In addition to the standard ones, QGIS Server supports the following extra parameters:
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Parameter Required Description
MAP Yes Specify the QGIS project file
STARTINDEX No Paging
GEOMETRYNAME No Type of geometry to return
EXP_FILTER No Expression filtering

SERVICE

This parameter has to be WFS in case of the GetFeature request.

For example:

http://localhost/qgis_server?
SERVICE=WFS
&...

VERSION

This parameter allows to specify the version of the service to use. Available values for the VERSION parameter
are:

• 1.0.0

• 1.1.0

If no version is indicated in the request, then 1.1.0 is used by default.

URL example:

http://localhost/qgis_server?
SERVICE=WFS
&VERSION=1.1.0
&...

REQUEST

This parameter is GetFeature in case of the GetFeature request.

URL example:

http://localhost/qgis_server?
SERVICE=WFS
&VERSION=1.1.0
&REQUEST=GetFeature
&...

RESULTTYPE

This parameter may be used to specify the kind of result to return. Available values are:

• results: the default behavior

• hits: returns only a feature count

URL example:
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http://localhost/qgis_server?
SERVICE=WFS
&VERSION=1.1.0
&REQUEST=GetFeature
&RESULTTYPE=hits
&...

GEOMETRYNAME

This parameter can be used to specify the kind of geometry to return for features. Available values are:

• extent

• centroid

• none

URL example:

http://localhost/qgis_server?
SERVICE=WFS
&VERSION=1.1.0
&REQUEST=GetFeature
&GEOMETRYNAME=centroid
&...

STARTINDEX

This parameter is standard in WFS 2.0, but it’s an extension for WFS 1.0.0. Actually, it can be used to skip some
features in the result set and in combination with MAXFEATURES, it provides the ability to page through results.

URL example:

http://localhost/qgis_server?
SERVICE=WFS
&VERSION=1.1.0
&REQUEST=GetFeature
&STARTINDEX=2
&...

Web Map Tile Service (WMTS)

The 1.0.0 WMTS standard implemented in QGIS Server provides a HTTP interface to request tiled map images
generated from a QGIS project. A typical WMTS request defined the QGIS project to use, some WMS parameters
like layers to render, as well as tile parameters.

Specifications document of the service:

• WMTS 1.0.0

Standard requests provided by QGIS Server:

Request Description
GetCapabilities Returns XML metadata with information about the server
GetTile Returns a tile
GetFeatureInfo Retrieves data (geometry and values) for a pixel location
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GetCapabilities

Standard parameters for the GetCapabilities request according to the OGC WMTS 1.0.0 specifications:

Parameter Required Description
SERVICE Yes Name of the service (WMTS)
REQUEST Yes Name of the request (GetCapabilities)

In addition to the standard ones, QGIS Server supports the following extra parameters:

Parameter Required Description
MAP Yes Specify the QGIS project file

URL example:

http://localhost/qgis_server?
SERVICE=WMTS
&REQUEST=GetCapabilities
&MAP=/home/user/project.qgs

SERVICE

This parameter has to be WMTS in case of the GetCapabilities request.

REQUEST

This parameter is GetCapabilities in case of the GetCapabilities request.

MAP

This parameter allows to define the QGIS project file to use.

GetTile

Standard parameters for the GetTile request according to the OGC WMTS 1.0.0 specifications:

Parameter Required Description
SERVICE Yes Name of the service (WMTS)
REQUEST Yes Name of the request (GetTile)
LAYER Yes Layer identifier
FORMAT Yes Output format of the tile
TILEMATRIXSET Yes Name of the pyramid
TILEMATRIX Yes Meshing
TILEROW Yes Row coordinate in the mesh
TILECOL Yes Column coordinate in the mesh
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In addition to the standard ones, QGIS Server supports the following extra parameters:

Parameter Required Description
MAP Yes Specify the QGIS project file

URL example:

http://localhost/qgis_server?
SERVICE=WMTS
&REQUEST=GetTile
&MAP=/home/user/project.qgs
&LAYER=mylayer
&FORMAT=image/png
&TILEMATRIXSET=EPSG:4326
&TILEROW=0
&TILECOL=0

SERVICE

This parameter has to be WMTS in case of the GetTile request.

REQUEST

This parameter is GetTile in case of the GetTile request.

LAYER

This parameter allows to specify the layer to display on the tile.

In addition, QGIS Server introduced some options to select a layer by:

• a short name

• the layer id

The short name of a layer may be configured through Properties → Metadata in layer menu. If the short name is
defined, then it’s used by default instead of the layer’s name:

http://localhost/qgis_server?
SERVICE=WMTS
&REQUEST=GetTile
&LAYER=mynickname
&...

Moreover, there’s a project option allowing to select layers by their id in OWS Server → WMS capabilities menu
of the Project → Project Properties dialog. To activate this option, the checkbox Use layer ids as names has to be
selected.
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http://localhost/qgis_server?
SERVICE=WMTS
&REQUEST=GetTile
&LAYER=mylayerid1
&...

FORMAT

This parameter may be used to specify the format of tile image. Available values are:

• jpg

• jpeg

• image/jpeg

• image/png

If the FORMAT parameter is different from one of these values, then the default format PNG is used instead.

TILEMATRIXSET

This parameter allows to define the CRS to use to compute the underlying pyramid and has to be formed like
EPSG:XXXX.

TILEMATRIX

This parameter allows to define the matrix to use for the output tile.

TILEROW

This parameter allows to select the row of the tile to get within the matrix.

TILECOL

This parameter allows to select the column of the tile to get within the matrix.

MAP

This parameter allows to define the QGIS project file to use.

As mentioned in GetMap parameters table, MAP is mandatory because a request needs a QGIS project to actually
work. However, the QGIS_PROJECT_FILE environment variable may be used to define a default QGIS project.
In this specific case, MAP is not longer a required parameter. For further information you may refer to Advanced
configuration.

GetFeatureInfo

Standard parameters for the GetFeatureInfo request according to the OGC WMTS 1.0.0 specifications:

• WMS 1.1.0
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Parameter Required Description
SERVICE Yes Name of the service (WMTS)
REQUEST Yes Name of the request (GetFeatureInfo)
LAYER Yes Layer identifier
INFOFORMAT No Output format
I No X coordinate of a pixel
J No Y coordinate of a pixel
TILEMATRIXSET Yes See GetTile
TILEMATRIX Yes See GetTile
TILEROW Yes See GetTile
TILECOL Yes See GetTile

In addition to the standard ones, QGIS Server supports the following extra parameters:

Parameter Required Description
MAP Yes Specify the QGIS project file

URL example:

http://localhost/qgis_server?
SERVICE=WMTS
&REQUEST=GetFeatureInfo
&MAP=/home/user/project.qgs
&LAYER=mylayer
&INFOFORMAT=image/html
&I=10
&J=5

SERVICE

This parameter has to be WMTS in case of the GetFeatureInfo request.

REQUEST

This parameter is GetFeatureInfo in case of the GetFeatureInfo request.

MAP

This parameter allows to define the QGIS project file to use.

As mentioned in GetMap parameters table, MAP is mandatory because a request needs a QGIS project to actually
work. However, the QGIS_PROJECT_FILE environment variable may be used to define a default QGIS project.
In this specific case, MAP is not longer a required parameter. For further information you may refer to Advanced
configuration.
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LAYER

This parameter allows to specify the layer to display on the tile.

In addition, QGIS Server introduced some options to select a layer by:

• a short name

• the layer id

The short name of a layer may be configured through Properties → Metadata in layer menu. If the short name is
defined, then it’s used by default instead of the layer’s name:

http://localhost/qgis_server?
SERVICE=WMTS
&REQUEST=GetFeatureInfo
&LAYER=mynickname
&...

Moreover, there’s a project option allowing to select layers by their id in OWS Server → WMS capabilities menu
of the Project → Project Properties dialog. To activate this option, the checkbox Use layer ids as names has to be
selected.

http://localhost/qgis_server?
SERVICE=WMTS
&REQUEST=GetFeatureInfo
&LAYER=mylayerid1
&...

INFOFORMAT

This parameter allows to define the output format of the result. Available values are:

• text/xml

• text/html

• text/plain

• application/vnd.ogc.gml

The default value is text/plain.

I

This parameter allows to define the X coordinate of the pixel for which we want to retrieve underlying information.

J

This parameter allows to define the Y coordinate of the pixel for which we want to retrieve underlying information.

Extra parameters supported by all request types

• FILE_NAME parameter: if set, the server response will be sent to the client as a file attachment with the
specified file name.

• MAP parameter: Similar to MapServer, the MAP parameter can be used to specify the path to the QGIS
project file. You can specify an absolute path or a path relative to the location of the server executable
(qgis_mapserv.fcgi). If not specified, QGIS Server searches for .qgs files in the directory where the
server executable is located.
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Example:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&MAP=/home/qgis/mymap.qgs&...

Nota: You can define a QGIS_PROJECT_FILE as an environment variable to tell the server executable where
to find the QGIS project file. This variable will be the location where QGIS will look for the project file. If not
defined it will use the MAP parameter in the request and finally look at the server executable directory.

REDLINING

This feature is available and can be used with GetMap and GetPrint requests.

The redlining feature can be used to pass geometries and labels in the request which are overlapped by the server
over the standard returned image (map). This permits the user to put emphasis or maybe add some comments
(labels) to some areas, locations etc. that are not in the standard map.

The request is in the format:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi?map=/world.qgs&SERVICE=WMS&
→˓VERSION=1.3.0&
REQUEST=GetMap
...
&HIGHLIGHT_GEOM=POLYGON((590000 5647000, 590000 6110620, 2500000 6110620, 2500000
→˓5647000, 590000 5647000))
&HIGHLIGHT_SYMBOL=<StyledLayerDescriptor><UserStyle><Name>Highlight</Name>
→˓<FeatureTypeStyle><Rule><Name>Symbol</Name><LineSymbolizer><Stroke><SvgParameter
→˓name="stroke">%23ea1173</SvgParameter><SvgParameter name="stroke-opacity">1</
→˓SvgParameter><SvgParameter name="stroke-width">1.6</SvgParameter></Stroke></
→˓LineSymbolizer></Rule></FeatureTypeStyle></UserStyle></StyledLayerDescriptor>
&HIGHLIGHT_LABELSTRING=Write label here
&HIGHLIGHT_LABELSIZE=16
&HIGHLIGHT_LABELCOLOR=%23000000
&HIGHLIGHT_LABELBUFFERCOLOR=%23FFFFFF
&HIGHLIGHT_LABELBUFFERSIZE=1.5

Here is the image outputed by the above request in which a polygon and a label are drawn on top of the normal
map:

You can see there are several parameters in this request:

• HIGHLIGHT_GEOM: You can add POINT, MULTILINESTRING, POLYGON etc. It supports multipart
geometries. Here is an example: HIGHLIGHT_GEOM=MULTILINESTRING((0 0, 0 1, 1 1)).
The coordinates should be in the CRS of the GetMap/GetPrint request.

• HIGHLIGHT_SYMBOL: This controls how the geometry is outlined and you can change the stroke width,
color and opacity.

• HIGHLIGHT_LABELSTRING: You can pass your labeling text to this parameter.

• HIGHLIGHT_LABELSIZE: This parameter controls the size of the label.

• HIGHLIGHT_LABELCOLOR: This parameter controls the label color.

• HIGHLIGHT_LABELBUFFERCOLOR: This parameter controls the label buffer color.

• HIGHLIGHT_LABELBUFFERSIZE: This parameter controls the label buffer size.

External WMS layers

QGIS Server allows including layers from external WMS servers in WMS GetMap and WMS GetPrint requests.
This is especially useful if a web client uses an external background layer in the web map. For performance
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Figure 17.9: Server response to a GetMap request with redlining parameters
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reasons, such layers should be directly requested by the web client (not cascaded via QGIS server). For printing
however, these layers should be cascaded via QGIS server in order to appear in the printed map.

External layers can be added to the LAYERS parameter as EXTERNAL_WMS:<layername>. The parameters for
the external WMS layers (e.g. url, format, dpiMode, crs, layers, styles) can later be given as service parameters
<layername>:<parameter>. In a GetMap request, this might look like this:

http://localhost/qgis_server?
SERVICE=WMS&REQUEST=GetMap
...
&LAYERS=EXTERNAL_WMS:basemap,layer1,layer2
&STYLES=,,
&basemap:url=http://externalserver.com/wms.fcgi
&basemap:format=image/jpeg
&basemap:dpiMode=7
&basemap:crs=EPSG:2056
&basemap:layers=orthofoto
&basemap:styles=default

Similarly, external layers can be used in GetPrint requests:

http://localhost/qgis_server?
SERVICE=WMS
...
&REQUEST=GetPrint&TEMPLATE=A4
&map0:layers=EXTERNAL_WMS:basemap,layer1,layer2
&map0:EXTENT=<minx,miny,maxx,maxy>
&basemap:url=http://externalserver.com/wms.fcgi
&basemap:format=image/jpeg
&basemap:dpiMode=7
&basemap:crs=EPSG:2056
&basemap:layers=orthofoto
&basemap:styles=default

17.2.3 Plugins

Installation

To install the HelloWorld example plugin for testing the servers, you firstly have to create a directory to hold server
plugins. This will be specified in the virtual host configuration and passed on to the server through an environment
variable:

sudo mkdir -p /opt/qgis-server/plugins
cd /opt/qgis-server/plugins
sudo wget https://github.com/elpaso/qgis-helloserver/archive/master.zip
In case unzip was not installed before:
sudo apt install unzip
sudo unzip master.zip
sudo mv qgis-helloserver-master HelloServer

HTTP Server configuration

Apache

To be able to use server plugins, FastCGI needs to know where to look. So, we have to modify the Apache
configuration file to indicate the QGIS_PLUGINPATH environment variable to FastCGI:

17.2. QGIS come OGC Data Server 473



QGIS User Guide, Release 3.4

FcgidInitialEnv QGIS_SERVER_LOG_FILE /tmp/qgis-000.log
FcgidInitialEnv QGIS_SERVER_LOG_LEVEL 0
FcgidInitialEnv QGIS_PLUGINPATH "/opt/qgis-server/plugins"

Moreover, a basic HTTP authorization is necessary to play with the HelloWorld plugin previously introduced. So
we have to update the Apache configuration file a last time:

# Needed for QGIS HelloServer plugin HTTP BASIC auth
<IfModule mod_fcgid.c>

RewriteEngine on
RewriteCond %{HTTP:Authorization} .
RewriteRule .* - [E=HTTP_AUTHORIZATION:%{HTTP:Authorization}]

</IfModule>

Then, restart Apache:

sudo a2ensite 001-qgis-server
sudo service apache2 restart

Suggerimento: If you work with a feature that has many nodes then modifying and adding a new feature will
fail. In this case it is possible to insert the following code into the 001-qgis-server.conf file:

<IfModule mod_fcgid.c>
FcgidMaxRequestLen 26214400
FcgidConnectTimeout 60
</IfModule>

How to use a plugin

Test the server with the HelloWorld plugin:

wget -q -O - "http://localhost/cgi-bin/qgis_mapserv.fcgi?SERVICE=HELLO"
HelloServer!

You can have a look at the default GetCapabilities of the QGIS server at: http://localhost/cgi-bin/
qgis_mapserv.fcgi?SERVICE=WMS&VERSION=1.3.0&REQUEST=GetCapabilities

17.2.4 Advanced configuration

Logging

To log requests sent to the server, you have to set the following environment variables:

• QGIS_SERVER_LOG_LEVEL

• QGIS_SERVER_LOG_FILE

• QGIS_SERVER_LOG_STDERR

Take a look on Environment variables to understand their meanings.

Environment variables

You can configure some aspects of QGIS Server by setting environment variables.

According to the HTTP server and how you run QGIS Server, there are several ways to define these variables.
This is fully described in Configura il server HTTP.
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QGIS_OPTIONS_PATH

Specifies the path to the directory with settings. It works the same way as QGIS application --optionspath
option. It is looking for settings file in <QGIS_OPTIONS_PATH>/QGIS/QGIS3.ini.

QUERY_STRING

The query string, normally passed by the web server. This variable can be useful while testing QGIS server binary
from the command line.

For example for testing a GetCapabilities request on the command line to a project that also requires a PostgreSQL
connection defined in a pg_service.conf file:

PGSERVICEFILE=/etc/pg_service.conf QUERY_STRING="MAP=/path/to/test.qgs&SERVICE=WMS&
→˓REQUEST=GetCapabilities" /path/to/qgis_mapserv.fcgi

The result should be either the content of the GetCapabilities response or, if something is wrong, an error message.

QGIS_PROJECT_FILE

The .qgs or .qgz project file, normally passed as a parameter in the query string (with MAP), you can also set
it as an environment variable (for example by using mod_rewrite Apache module).

Note that you may also indicate a project stored in PostgreSQL, e.g. postgresql://localhost:5432?
sslmode=disable&dbname=mydb&schema=myschema&project=myproject.

QGIS_SERVER_LOG_FILE

Specify path and filename. Make sure that server has proper permissions for writing to file. File should be created
automatically, just send some requests to server. If it’s not there, check permissions.

QGIS_SERVER_LOG_FILE is deprecated since QGIS 3.4. File logging support will be removed in QGIS 4.0.

QGIS_SERVER_LOG_STDERR

Activate logging to stderr. It’s disabled by default. This variable has no effect when QGIS_SERVER_LOG_FILE
is set.

• 0 or false (case insensitive)

• 1 or true (case insensitive)

MAX_CACHE_LAYERS

Specify the maximum number of cached layers (default: 100).

DISPLAY

This is used to pass (fake) X server display number (needed on Unix-like systems).

QGIS_PLUGINPATH

Useful if you are using Python plugins for the server, this sets the folder that is searched for Python plugins.
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QGIS_SERVER_LOG_LEVEL

Specify desired log level. Available values are:

• 0 or INFO (log all requests)

• 1 or WARNING

• 2 or CRITICAL (log just critical errors, suitable for production purposes)

QGIS_SERVER_PARALLEL_RENDERING

Activates parallel rendering for WMS GetMap requests. It’s disabled (false) by default. Available values are:

• 0 or false (case insensitive)

• 1 or true (case insensitive)

QGIS_SERVER_MAX_THREADS

Number of threads to use when parallel rendering is activated. Default value is -1 to use the number of processor
cores.

QGIS_SERVER_CACHE_DIRECTORY

Specifies the network cache directory on the filesystem. The default directory is named cache and located in the
profile directory.

QGIS_SERVER_CACHE_SIZE

Sets the network cache size in MB. The default value is 50 MB.

Settings summary

When QGIS Server is starting, you have a summary of all configurable parameters thanks to environment variables.
Moreover, the value currently used and the origin is also displayed.

For example with spawn-fcgi:

export QGIS_OPTIONS_PATH=/home/user/.local/share/QGIS/QGIS3/profiles/default/
export QGIS_SERVER_LOG_FILE=/home/user/qserv.log
export QGIS_SERVER_LOG_LEVEL=2
spawn-fcgi -f /usr/lib/cgi-bin/qgis_mapserv.fcgi -s /tmp/qgisserver.sock -U www-
→˓data -G www-data -n

QGIS Server Settings:

- QGIS_OPTIONS_PATH / '' (Override the default path for user configuration): '/
→˓home/user/.local/share/QGIS/QGIS3/profiles/default/' (read from ENVIRONMENT_
→˓VARIABLE)

- QGIS_SERVER_PARALLEL_RENDERING / '/qgis/parallel_rendering' (Activate/
→˓Deactivate parallel rendering for WMS getMap request): 'true' (read from INI_
→˓FILE)

- QGIS_SERVER_MAX_THREADS / '/qgis/max_threads' (Number of threads to use when
→˓parallel rendering is activated): '4' (read from INI_FILE)
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- QGIS_SERVER_LOG_LEVEL / '' (Log level): '2' (read from ENVIRONMENT_VARIABLE)

- QGIS_SERVER_LOG_FILE / '' (Log file): '/tmp/qserv.log' (read from ENVIRONMENT_
→˓VARIABLE)

- QGIS_PROJECT_FILE / '' (QGIS project file): '' (read from DEFAULT_VALUE)

- MAX_CACHE_LAYERS / '' (Specify the maximum number of cached layers): '100'
→˓(read from DEFAULT_VALUE)

- QGIS_SERVER_CACHE_DIRECTORY / '/cache/directory' (Specify the cache
→˓directory): '/root/.local/share/QGIS/QGIS3/profiles/default/cache' (read from
→˓DEFAULT_VALUE)

- QGIS_SERVER_CACHE_SIZE / '/cache/size' (Specify the cache size): '52428800'
→˓(read from INI_FILE)

Ini file used to initialize settings: /home/user/.local/share/QGIS/QGIS3/profiles/
→˓default/QGIS/QGIS3.ini

In this particular case, we know that QGIS_SERVER_MAX_THREADS and
QGIS_SERVER_PARALLEL_RENDERING values are read from the ini file found in
QGIS_OPTIONS_PATH directory (which is defined through an environment variable). The correspond-
ing entries in the ini file are /qgis/max_threads and /qgis/parallel_rendering and their values are true and 4
threads.

Short name for layers, groups and project

A number of elements have both a <Name> and a <Title>. The Name is a text string used for machine-to-
machine communication while the Title is for the benefit of humans.

For example, a dataset might have the descriptive Title “Maximum Atmospheric Temperature” and be requested
using the abbreviated Name “ATMAX”. User can already set title for layers, groups and project.

OWS name is based on the name used in layer tree. This name is more a label for humans than a name for
machine-to-machine communication.

QGIS Server supports:

• short name line edits to layers properties You can change this by right clicking on a layer, choose Properties
→ Metadata tab → Description → Short name.

• WMS data dialog to layer tree group (short name, title, abstract)

By right clicking on a layer group and selecting the Set Group WMS data option you will get:

Figure 17.10: Set group WMS data dialog

• short name line edits to project properties - add a regexp validator "^[A-Za-z][A-Za-z0-9\._-]*"
to short name line edit accessible through a static method
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• add a regexp validator "^[A-Za-z][A-Za-z0-9\._-]*" to short name line edit accessible through a
static method

You can choose a short name for the project root by going to Project properties → OWS Server → Service
capabilities → Short name.

• add a TreeName element in the fullProjectSettings

If a short name has been set for layers, groups or project it is used by QGIS Sever as the layer name.

Connection to service file

In order to make apache aware of the PostgreSQL service file (see the File per la connessione a Servizio Post-
greSQL section) you need to make your *.conf file look like:

SetEnv PGSERVICEFILE /home/web/.pg_service.conf

<Directory "/home/web/apps2/bin/">
AllowOverride None

.....

Add fonts to your linux server

Keep in mind that you may use QGIS projects that point to fonts that may not exist by default on other machines.
This means that if you share the project, it may look different on other machines (if the fonts don’t exist on the
target machine).

In order to ensure this does not happen you just need to install the missing fonts on the target machine. Doing this
on desktop systems is usually trivial (double clicking the fonts).

For linux, if you don’t have a desktop environment installed (or you prefer the command line) you need to:

• On Debian based systems:

sudo su
mkdir -p /usr/local/share/fonts/truetype/myfonts && cd /usr/local/share/fonts/
→˓truetype/myfonts

# copy the fonts from their location
cp /fonts_location/* .

chown root *
cd .. && fc-cache -f -v

• On Fedora based systems:

sudo su
mkdir /usr/share/fonts/myfonts && cd /usr/share/fonts/myfonts

# copy the fonts from their location
cp /fonts_location/* .

chown root *
cd .. && fc-cache -f -v
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CHAPTER 18

Lavorare con i dati GPS

18.1 Plugin GPS

18.1.1 Cos’è un GPS?

Il sistema di posizionamento globale GPS. il Global Positioning System, è basato sui satelliti, permette, a chiunque
sia dotato di un ricevitore GPS, di individuare esattamente la sua posizione in qualunque zona del mondo. Il GPS
è utilizzato come strumento di aiuto nella navigazione, per esempio negli aeroplani, nelle navi e anche dagli
escursionisti. Il ricevitore GPS sfrutta il segnale dei satelliti per calcolare latitudine, longitudine e (qualche volta)
l’altitudine. Molti ricevitori possono memorizzare la posizione (chiamata waypoints), la sequenza delle posizioni
che formano una route e il tracciato o track dei movimenti che il ricevitore ha compiuto nel tempo. Waypoints,
routes e tracks sono i tre principali elementi dei dati GPS. QGIS mostra i waypoints in un vettore puntuale, mentre
route e tracks (percorsi e tracciati) sono visualizzati in vettori lineari.

Nota: QGIS supporta anche ricevitori GNSS. Ma noi continuiamo a usare il termine GPS in questa documen-
tazione.

18.1.2 Caricamento dei dati GPS da file

Ci sono una dozzina di formati di file diversi per memorizzare dati GPS. Il formato utilizzato da QGIS è chiamato
GPX (GPs eXchange format), che è un formato standard di interscambio che può contenere svariati numeri di
posizioni, percorsi e tracce nello stesso file.

Per caricare un file GPX tu devi per prima cosa installare il plugin aprendo la finestra di dialogo Plugins Gestisci

e installa plugin. . . . Attivare la casella Strumenti GPS. Quando questo plugin viene caricato, un pulsante con
un piccolo dispositivo GPS portatile verrà visualizzato nella barra degli strumenti e in Layer → Crea vettore → :

• Strumenti GPS

• Nuovo vettore GPX

Per lavorare con i dati GPS viene fornito un file GPX di esempio disponibile nel dataset di QGIS
qgis_sample_data/gps/national_monuments.gpx. Vedi la sezione Dati campione per maggiori in-
formazioni sull’insieme di dati a disposizione.
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1. Seleziona Vettore → Strumenti GPS oppure fai clic sull’icona Strumenti GPS nella barra degli strumenti e
apri la scheda Carica file GPX (vedi figura_GPS).

2. Sfoglia la cartella qgis_sample_data/gps/, seleziona il file GPX national_monuments.gpx e
clicca su Apri.

Figure 18.1: La finestra di dialogo Strumenti GPS

Utilizza il pulsante Sfoglia. . . per selezionare il file GPX, quindi utilizza le caselle di controllo per selezionare i
tipi di dati che vuoi caricare da quel file GPX. Ogni tipo di dato sarà caricato in un layer separato quando fai clic
su OK. Il file national_monuments.gpx include solo i waypoint.

Nota: I dispositivi GPS consentono di memorizzare i dati in diversi sistemi di coordinate. Quando si scarica un
file GPX (dal dispositivo GPS o da un sito web) e poi lo si carica in QGIS, assicurarsi che i dati memorizzati nel
file GPX utilizzino WGS 84 (latitudine/longitudine). QGIS si aspetta questo, ed è la specifica ufficiale GPX. Vedi
https://www.topografix.com/GPX/1/1/.

18.1.3 GPSBabel

Poiché QGIS utilizza file GPX, devi trovare un modo per convertire altri formati di file GPS in GPX. Questo
può essere fatto per molti formati utilizzando il programma gratuito GPSBabel, disponibile all’indirizzo https:
//www.gpsbabel.org. Questo programma può anche trasferire dati GPS tra il computer e un dispositivo GPS.
QGIS utilizza GPSBabel per fare queste cose, quindi si raccomanda di installarlo. Tuttavia, se vuoi solo caricare
i dati GPS da file GPX non è necessario. La versione 1.2.3 di GPSBabel è nota per funzionare con QGIS, ma
dovresti essere in grado di utilizzare le versioni successive senza problemi.

18.1.4 Importare dati GPS

Per importare dei dati che non sono dei file GPX, utilizza lo strumento Importa un altro file presente nella finestra
di dialogo degli Strumenti GPS. Qui, puoi scegliere il file da importare (e il formato del file), il tipo di dato da
estrarre da esso, dove vuoi salvare il file una volta convertito in GPX e il nome che vuoi dare al nuovo vettore.
Nota che non tutti i formati di dati GPS supportano tutti e tre i tipi di dato, così per alcuni formati potrai scegliere
solo uno e due tipi.

18.1.5 Scaricare dati GPS da un dispositivo

QGIS utilizza GPSBabel per scaricare dati da un dispositivo GPS e caricarli direttamente come nuovi layer vetto-
riali. Per questo si utilizza lo strumento Scarica dal GPS presente nella finestra di dialogo Strumenti GPS (vedi
Figure_GPS_download). Qui, è possibile selezionare il tipo di dispositivo GPS, la porta alla quale il dispositivo
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è connesso (o la porta USB se il GPS supporta questa opzione), il tipo di dati che si desidera scaricare, il le GPX
che contiene i dati da scaricare e il nome del nuovo layer.

Figure 18.2: Lo strumento di scaricamento

GPSBabel comunica con il GPS in base al tipo di dispositivo che viene selezionato nel menu. Se nessuna delle
opzioni disponibili è compatibile con il proprio dispositivo GPS è possibile creare un nuovo tipo (vedi sezione
Definire un nuovo tipo di dispositivo).

La porta potrebbe essere il nome del file o qualche altro termine che il tuo sistema operativo riconosce come porta
fisica alla quale è connesso il dispositivo GPS. Essa potrebbe essere un’uscita USB, nel caso di dispositivi abilitati
per l’USB.

• Nei sistemi Linux è qualcosa di simile a /dev/ttyS0 o /dev/ttyS1

• In Windows è COM1 o COM2.

Quando fai clic su OK, i dati vengono scaricati dal dispositivo e appaiono come un layer in QGIS.

18.1.6 Caricare dati GPS sul dispositivo

C’è anche la possibilità di caricare dati vettoriali da QGIS al dispositivo GPS utilizzando lo strumento Carica sul
GPS presente sempre nella finestra di dialogo Strumenti GPS. Per effettuare questa operazione devi seplicemente
selezionare il layer che vuoi caricare (che deve essere un layer GPX), il dispositivo GPS utilizzato, e la porta (o
l’USB) alla quale il dispositivo è collegato. Come per lo scaricamento dei dati, anche per il caricamento puoi
specificare un nuovo tipo di dispositivo se tra quelli della lista non è presente quello che si sta utilizzando.

Questo strumento è molto utile in combinazione con le capacità di editing dei dati vettoriali di QGIS. Permette
di caricare una mappa, creare delle posizioni o dei percorsi, e successivamente caricare questi dati nel dispositivo
per poi utilizzarli in campagna.

18.1.7 Definire un nuovo tipo di dispositivo

Ci sono molteplici tipologie di dispositivi GPS. GPS. Gli sviluppatori QGIS non possono testarli tutti, quindi se
ne hai uno che non funziona con nessuno dei tipi di dispositivi elencati in Scarica dal GPS e Carica sul GPS, puoi
definire il tuo tipo di dispositivo. Puoi farlo utilizzando l’editor dei dispositivi GPS, che si avvia facendo clic sul
pulsante Modifica periferiche. . . sia nella finestra di download che in quella di upload.

Per definire un nuovo dispositivo, devi solo fare clic sul pulsante Nuovo, inserire un nome, inserire i comandi di
download e upload del dispositivo e fare clic sul pulsante Aggiorna. Il nome sarà inserito nei menu del dispositivo
nelle finestre di upload e download – può essere qualsiasi stringa. Il comando download è il comando che viene
utilizzato per scaricare i dati dal dispositivo in un file GPX. Questo sarà probabilmente un comando GPSBabel, ma
è possibile utilizzare qualsiasi altro programma a riga di comando in grado di creare un file GPX. QGIS sostituirà
le parole chiave %type, %in, and %out quando esegue il comando.
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%type sarà sostituito da -w se stai scaricando dei waypoints, -r se stai scaricando delle routes e -t se stai
scaricando dei tracks. Queste sono le opzioni che comunicano a GPSBabel quali elementi scaricare.

%in indica il nome della porta selezionata nella finestra di download mentre %out indica il nome del le GPX nel
quale verranno salvati i dati. Dunque quando viene creato un nuovo dispositivo il seguente comando di download
%type -i garmin -o gpx %in %out (questo è il comando di download per la tipologia di dispositivi
predefiniti ‘Garmin serial’) verrà utilizzato per scaricare waypoints dalla porta /dev/ all’interno del le GPX
output.gpx, QGIS leggerà la stringa e avvierà il comando gpsbabel -w -i garmin -o gpx /dev/
ttyS0 output.gpx.

Il comando di upload è il comando che viene utilizzato per caricare dati sul dispositivo. Vengono utilizzati gli
stessi tasti, ma %in è utilizzato per indicare il nome del file GPX che contiene il layer in caricamento, e %out
viene sostituito dal nome della porta.

Puoi avere maggiori informazioni su GPSBabel e sulle opzioni utilizzabili tramite linea di comando sul sito http:
//www.gpsbabel.org.

Una volta che avrai creato una nuova periferica, essa apparirà nella lista dei dispositivi presenti sia nella scheda
Scarica dal GPS che nella scheda Carica sul GPS.

18.1.8 Scaricare points/tracks dall’unità GPS

Come descritto nelle sezioni precedenti, QGIS utilizza GPSBabel per scaricare punti/tracce direttamente nel pro-
getto. QGIS si configura con impostazioni predefinite per scaricare da dispositivi Garmin. Purtroppo c’è un bug
#6318 che non permette di creare altri profili, quindi il download diretto in QGIS utilizzando gli strumenti GPS è
al momento limitato alle unità Garmin USB.

Garmin GPSMAP 60cs

MS Windows

Installare i driver USB Garmin da https://www8.garmin.com/support/download_details.jsp?id=591

Connettere l’unità. Aprire gli Strumenti GPS e impostare type=garmin serial e port=usb: Riempire
i campi Nome layer and File di output. A volte si possono avere dei problemi nel salvataggio dei dati in certe
cartelle, si consiglia di utilizzare un percorso del tipo c:\temp.

Ubuntu/Mint GNU/Linux

Per prima cosa occorre risolvere un problema inerente i permessi di accesso alla periferica, seguendo quanto
scritto qui https://wiki.openstreetmap.org/wiki/USB_Garmin_on_GNU/Linux. Puoi provare a creare un file /
etc/udev/rules.d/51-garmin.rules contenente il seguente codice:

ATTRS{idVendor}=="091e", ATTRS{idProduct}=="0003", MODE="666"

Successivamente occorre essere sicuri che il modulo del kernel garmin_gps non sia caricato

rmmod garmin_gps

e poi puoi usare gli Strumenti GPS. Purtroppo sembra esserci un bug #7182 e di solito QGIS si blocca più volte
prima che l’operazione funzioni bene.

Data logger BTGP-38KM (solo Bluetooth)

MS Windows

Il baco già discusso non consente di scaricare i dati tramite QGIS, per cui è necessario utilizzare GPSBabel dalla
riga di comando o tramite la sua interfaccia. Il comando da eseguire è

gpsbabel -t -i skytraq,baud=9600,initbaud=9600 -f COM9 -o gpx -F C:/GPX/aaa.gpx
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Ubuntu/Mint GNU/Linux

Utilizzare lo stesso comando (o gli stessi parametri, se usate la GUI di GPSBabel). Su Linux potrebbe capitare di
vedere un messaggio tipo

skytraq: Too many read errors on serial port

Si tratta solo di spegnere e riaccendere il data logger e ritentare

BlueMax GPS-4044 datalogger (sia BT che USB)

MS Windows

Nota: Ha bisogno di installare i propri driver prima di essere utilizzato su Windows 7. Si veda il sito del
costruttore per il file corretto da scaricare.

Scaricando con GSPBabel, sia con USB che BT, si ottiene sempre un errore tipo

gpsbabel -t -i mtk -f COM12 -o gpx -F C:/temp/test.gpx
mtk_logger: Can't create temporary file data.bin
Error running gpsbabel: Process exited unsuccessfully with code 1

Ubuntu/Mint GNU/Linux

con USB

Dopo aver collecato il cavo, usare il comando dmesg per capire quale porta viene utilizzata, ad esempio /dev/
ttyACM3. Poi, come al solito, utilizzare GPSBabel dalla riga di comando o dalla GUI

gpsbabel -t -i mtk -f /dev/ttyACM3 -o gpx -F /home/user/bluemax.gpx

Con Bluetooth

Utilizzare il Gestore di dispositivi Blueman per accoppiare il dispositivo e renderlo disponibile tramite una porta
di sistema, poio eserguire GPSBabel

gpsbabel -t -i mtk -f /dev/rfcomm0 -o gpx -F /home/user/bluemax_bt.gpx

18.2 Tracciamento live GPS

Per attivare il tracciamento live del GPS tramite QGIS devi selezionare Visualizza → Panelli Informazioni sul
GPS information o premere Ctrl+0. Otterrai una nuova finestra agganciata sul lato sinistro dello schermo.

Ci sono 3 possibili schermate nella finestra di tracciamento GPS:

• posizione coordinate GPS ed inserimento manuale di vertici e caratteristiche

• potenza del segnale di connessione del GPS ai satelliti

• opzioni di visualizzazione GPS (vedere figure_gps_options)

Con un ricevitore GPS collegato (deve essere supportato dal sistema operativo), un semplice clic su Connetti col-
lega il GPS a QGIS. Un secondo clic (ora su Disconnetti) scollega il ricevitore GPS dal computer. Per GNU/Linux,
il supporto gpsd è integrato per supportare la connessione alla maggior parte dei ricevitori GPS. Pertanto, devi
prima configurare gpsd correttamente per connetterti a QGIS.
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Avvertimento: Se vuoi registrare la tua posizione sulla mappa devi prima creare un nuovo layer vettoriale ed
entrare nella modalità di editing in modo da registrare il percorso.

18.2.1 Posizione e attributi aggiuntivi

Se il GPS sta ricevendo segnali dai satelliti, puoi visualizzare la tua posizione in termini di latitudine longitu-
dine e quota, insieme ad altri attributi aggiuntivi.

Figure 18.3: Tracciamento della posizione GPS e attributi aggiuntivi

18.2.2 Potenza del segnale GPS

Con questa schermata è possibile vedere la potenza del segnale dei satelliti dai quali si sta ricevendo il segnale.

18.2.3 Opzioni GPS

Nel caso di problemi di connessione, puoi attivare una delle seguenti opzioni:

• Individuazione automatica

• Interno

• Device seriale
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Figure 18.4: Potenza del segnale GPS

• gpsd (selezionando Host, Porta e Device il tuo GPS si deve connettere)

Un clic su Connetti avvia di nuovo la connessione al ricevitore GPS.

Puoi attivare Salva automaticamente gli elementi aggiunti quando sei in modalità di editing. Oppure puoi

attivare l’opzione Aggiungi automaticamente punti sulla mappa con una scelta di grandezza e colore.

Attivando Cursore, puoi usare una barra a scorrimento per ridurre o aumentare la dimen-
sione del cursore sulla mappa

Puoi inoltre impostare i parametri Acquisition interval (seconds) e Distance threshold (meters) per mantenere il
cursore ancora attivo quando il ricevitore è in condizioni statiche.

Attivando Centratura mappa puoi decidere in quale modo la mappa dovrà essere aggiornata. Questa opzione
prevede ‘sempre’, ‘quando si chiude’ se le coordinate registrate escono fuori dall’estensione della mappa, o ‘mai’
se rientrano nell’estensione della mappa.

Infine puoi attivare File di log e definire un percorso e un le dove registrare i messaggi che vengono generati
durante il tracciamento GPS.

Se vuoi impostare manualmente un elemento, devi tornare a Posizione e clicca su Aggiungi punto o Aggiungi
punto traccia.

18.2.4 Connessione di un GPS Bluetooth GPS per tracciamento live

Con QGIS puoi collegare un GPS Bluetooth per la raccolta di dati. Per eseguire questa operazione è necessario
che il GPS sia dotato di Bluetooth e che il tuo computer abbia il Bluetooth.

Per prima cosa devi fare in modo che il tuo dispositivo GPS sia riconosciuto e associato al computer. Accendi il
GPS, vai sull’icona Bluetooth nell’area di notifica e cerca per Nuovo Dispositivo.

Sul lato destro della maschera di selezione dei dispositivi assicurati che tutti i dispositivi siano selezionati in modo
che probabilmente la tua unità GPS appaia tra quelle disponibili. Nella fase successiva dovrebbe essere disponibile
un servizio di connessione seriale, selezionarlo e fai clic sul pulsante Configura.

Ricorda il numero della porta COM assegnata alla connessione GPS risultante dalle proprietà Bluetooth.

Dopo che il GPS è stato riconosciuto, esegui l’accoppiamento per la connessione. Di solito il codice di autoriz-
zazione è 0000.

Ora apri il pannello Informazioni sul GPS e passa alla schermata opzioni GPS. Seleziona la porta COM asseg-
nata alla connessione GPS e fai clic sul pulsante Connetti. Dopo un po” di tempo dovrebbe apparire un cursore
che indica la tua posizione.

Se QGIS non è in grado di ricevere dati GPS, devi riavviare il dispositivo GPS, attendere 5-10 secondi e tentare
nuovamente di collegarti. Solitamente questa soluzione funziona. Se ricevi ancora un errore di connessione
accertati di non avere un altro ricevitore Bluetooth vicino a te, accoppiato con la stessa unità GPS.
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Figure 18.5: Opzioni di connessione del GPS
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18.2.5 Usare GPSMAP 60cs

MS Windows

Un modo più semplice per farlo funzionare è utilizzare un middleware (freeware, non open) chiamato GPSGate.

Avvia il programma, effettua la scansione per i dispositivi GPS (funziona sia per i dispositivi USB che quelli BT)

e quindi in QGIS fai clic su Connetti nel pannello Live tracking usando la modalità Connessione automatica.

Ubuntu/Mint GNU/Linux

Per quanto riguarda Windows, il modo più semplice è utilizzare un server, in questo caso GPSD, quindi

sudo apt install gpsd

Quindi carica il modulo del kernel garmin_gps

sudo modprobe garmin_gps

E quindi collegare l’unità. Poi controlla con dmesg il dispositivo reale utilizzato dall’unità, ad esempio /dev/
ttyUSB0. Ora puoi lanciare gpsd

gpsd /dev/ttyUSB0

E infine connettiti con lo strumento di tracciamento live di QGIS.

18.2.6 Usare BTGP-38KM datalogger (solo Bluetooth)

Usare GPSD (in ambiente Linux) o GPSGate (in ambiente Windows) è semplice.

18.2.7 Usare BlueMax GPS-4044 datalogger (sia BT che USB)

MS Windows

Il Live Tracking funziona sia per le modalità USB che BT, utilizzando GPSGate o anche senza tale opzione, basta

attivare Individuazione automatica, oppure connettere lo strumento sulla porta giusta.

Ubuntu/Mint GNU/Linux

Per USB

Il live tracking funziona anche con GPSD

gpsd /dev/ttyACM3

o senza di esso, connettendo lo strumento live tracking di QGIS direttamente al device (vedi esempio al seguente
link /dev/ttyACM3).

Per Bluetooth

Il live tracking funziona anche con GPSD

gpsd /dev/rfcomm0

o senza di esso, connettendo lo strumento live tracking di QGIS direttamente al device (vedi esempio al seguente
link /dev/rfcomm0).
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CHAPTER 19

Authentication System

19.1 Authentication System Overview

Figure 19.1: Anatomy of authentication system

19.1.1 Authentication database

The new authentication system stores authentication configurations in an SQLite database file located, by default,
at <user home>/.qgis3/qgis-auth.db.
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This authentication database can be moved between QGIS installations without affecting other current QGIS user
preferences, as it is completely separate from normal QGIS settings. A configuration ID (a random 7-character
alphanumeric string) is generated when initially storing a configuration to the database. This represents the con-
figuration, thereby allowing the ID to be stored in plain text application components, (such as project, plugin, or
settings files) without disclosure of its associated credentials.

Nota: The parent directory of the qgis-auth.db can be set using the following environment variable,
QGIS_AUTH_DB_DIR_PATH, or set on the command line during launch with the --authdbdirectory
option.

19.1.2 Master password

To store or access sensitive information within the database, a user must define a master password. A new master
password is requested and verified when initially storing any encrypted data to the database. Only when sensitive
information is accessed is the user prompted for the master password, which is then cached for the remainder of
the session (until application is quit), unless the user manually chooses an action to clear its cached value. Some
instances of using the authentication system do not require input of the master password, such as when selecting an
existing authentication configuration, or applying a configuration to a server configuration (such as when adding
a WMS layer).

Figure 19.2: Input new master password

Nota: A path to a file containing the master password can be set using the following environment variable,
QGIS_AUTH_PASSWORD_FILE.

Managing the master password

Once set, the master password can be reset; the current master password will be needed prior to resetting. During
this process, there is an option to generate a complete backup of the current database.

Figure 19.3: Resetting master password
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If the user forgets the master password, there is no way to retrieve or override it. There is also no means of
retrieving encrypted information without knowing the master password.

If a user inputs their existing password incorrectly three times, the dialog will offer to erase the database.

Figure 19.4: Password prompt after three invalid attempts

19.1.3 Authentication Configurations

You can manage authentication configurations from Configurations in the Authentication tab of the QGIS Options
dialog (Settings → Options).

Figure 19.5: Configurations editor

Use the button to add a new configuration, the button to remove configurations, and the button to
modify existing ones.

The same type of operations for authentication configuration management (Add, Edit and Remove) can be done
when configuring a given service connection, such as configuring an OWS service connection. For that, there are
action buttons within the configuration selector for fully managing configurations found within the authentication
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Figure 19.6: Adding config from within Configuration editor

database. In this case, there is no need to go to the configurations in Authentication tab of QGIS options unless
you need to do more comprehensive configuration management.

When creating or editing an authentication configuration, the info required is a name, an authentication method
and any other info that the authentication method requires (see more about the available authentication types in
Authentication Methods).

19.1.4 Authentication Methods

Available authentications are provided by C++ plugins much in the same way data provider plugins are sup-
ported by QGIS. The method of authentication that can be selected is relative to the access needed for the re-
source/provider, e.g. HTTP(S) or database, and whether there is support in both QGIS code and a plugin. As such,
some authentication method plugins may not be applicable everywhere an authentication configuration selector is
shown. A list of available authentication method plugins and their compatible resource/providers can be accessed
going to Settings → Options and, in the Authentication tab, click the Installed Plugins button.

Plugins can be created for new authentication methods that do not require QGIS to be recompiled. Since the
support for plugins is currently (since QGIS 2.12) C++-only, QGIS will need to be restarted for the new dropped-
in plugin to become available to the user. Ensure your plugin is compiled against the same target version of QGIS
if you intend to add it to an existing target install.

Nota: The Resource URL is currently an unimplemented feature that will eventually allow a particular configu-
ration to be auto-chosen when connecting to resources at a given URL.

19.1.5 Master Password and Auth Config Utilities

Under the Options menu (Settings → Options) in the Authentication tab, there are several utility actions to manage
the authentication database and configurations:

• Input master password:

– Opens the master password input dialog, independent of performing any authentication database com-
mand.
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Figure 19.7: WMS connection dialog showing Add, Edit, and Remove authentication configuration buttons

Figure 19.8: Available method plugins list

Figure 19.9: Basic HTTP authentication configs
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Figure 19.10: ESRI Token authentication configs
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Figure 19.11: OAuth2 authentication configs
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Figure 19.12: PKI paths authentication configs

Figure 19.13: PKI PKCS#12 file paths authentication configs

Figure 19.14: Stored Identity authentication configs
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Figure 19.15: Utilities menu

• Clear cached master password:

– Unsets the master password if it has been set via input dialog.

• Reset master password:

– Opens a dialog to change the master password (the current password must be known) and optionally
back up the current database.

• Clear cached authentication configurations: Clears the internal lookup cache for configurations used to
speed up network connections. This does not clear QGIS’s core network access manager’s cache, which
requires a relaunch of QGIS.

• Reset master password: Replaces the current master password for a new one. The current master password
will be needed prior to resetting and a backup of database can be done.

• Remove all authentication configurations: Clears the database of all configuration records, without re-
moving other stored records.

• Erase authentication database: Schedules a backup of the current database and complete rebuild of the
database table structure. These actions are scheduled for a later time, so as to ensure other operations like
project loading do not interrupt the operation or cause errors due to a temporarily missing database.

Figure 19.16: DB erase verification menu

19.1.6 Using authentication configurations

Typically, an authentication configuration is selected in a configuration dialog for a network services (such as
WMS). However, the selector widget can be embedded anywhere authentication is needed or in non-core func-
tionality, like in third-party PyQGIS or C++ plugins.

When using the selector, No authentication is displayed in the pop-up menu control when nothing is selected,
when there are no configurations to choose from, or when a previously assigned configuration can no longer be
found in the database. The Type and Id fields are read-only and provide a description of the authentication method
and the config’s ID respectively.
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Figure 19.17: Authentication configuration selector with no authentication

Figure 19.18: Authentication configuration selector with selected config

19.1.7 Python bindings

All classes and public functions have sip bindings, except QgsAuthCrypto, since management of the master
password hashing and auth database encryption should be handled by the main app, and not via Python. See
Security Considerations concerning Python access.

19.2 User Authentication Workflows

Figure 19.19: Generic user workflow
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19.2.1 HTTP(S) authentication

One of the most common resource connections is via HTTP(S), e.g. web mapping servers, and authentication
method plugins often work for these types of connections. Method plugins have access to the HTTP request
object and can manipulate both the request as well as its headers. This allows for many forms of internet-based
authentication. When connecting via HTTP(S) using the standard username/password authentication method will
attempt HTTP BASIC authentication upon connection.

Figure 19.20: Configuring a WMS connection for HTTP BASIC

19.2.2 Database authentication

Connections to database resources are generally stored as key=value pairs, which will expose usernames and
(optionally) passwords, if not using an authentication configuration. When configuring with the new auth system,
the key=value will be an abstracted representation of the credentials, e.g. authfg=81t21b9.

19.2.3 PKI authentication

When configuring PKI components within the authentication system, you have the option of importing compo-
nents into the database or referencing component files stored on your filesystem. The latter may be useful if such
components change frequently, or where the components will be replaced by a system administrator. In either
instance you will need to store any passphrase needed to access private keys within the database.

All PKI components can be managed in separate editors within the Certificate Manager, which can be accessed
in the Authentication tab in QGIS Options dialog (Settings → Options) by clicking the Manage Certificates button.

In the Certificate Manager, there are editors for Identities, Servers and Authorities. Each of these are contained
in their own tabs, and are described below in the order they are encountered in the workflow chart above. The tab
order is relative to frequently accessed editors once you are accustomed to the workflow.

Nota: Because all authentication system edits write immediately to the authentication database, there is no need
to click the Options dialog OK button for any changes to be saved. This is unlike other settings in the Options
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Figure 19.21: Configuring a Postgres SSL-with-PKI connection

dialog.

Authorities

You can manage available Certificate Authorities (CAs) from the Authorities tab in the Certificate manager from
the Authentication tab of the QGIS Options dialog.

As referenced in the workflow chart above, the first step is to import or reference a file of CAs. This step is
optional, and may be unnecessary if your PKI trust chain originates from root CAs already installed in your
operating system (OS), such as a certificate from a commercial certificate vendor. If your authenticating root CA
is not in the OS’s trusted root CAs, it will need to be imported or have its file system path referenced. (Contact
your system administrator if unsure.)

By default, the root CAs from your OS are available; however, their trust settings are not inherited. You should
review the certificate trust policy settings, especially if your OS root CAs have had their policies adjusted. Any
certificate that is expired will be set to untrusted and will not be used in secure server connections, unless you
specifically override its trust policy. To see the QGIS-discoverable trust chain for any certificate, select it and click

the Show information for certificate.

You can edit the trust policy for any selected certificate within the chain. Any change in trust policy to

a selected certificate will not be saved to the database unless the Save certificate trust policy change to database button is
clicked per selected certification. Closing the dialog will not apply the policy changes.

You can review the filtered CAs, both intermediate and root certificates, that will be trusted for secure connections

or change the default trust policy by clicking the Options button.
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Figure 19.22: PKI configuration workflow
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Figure 19.23: Opening the Certificate Manager

Figure 19.24: Authorities editor
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Figure 19.25: Certificate info dialog

Figure 19.26: Saving the trust policy changes
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Avvertimento: Changing the default trust policy may result in problems with secure connections.

Figure 19.27: Authorities options menu

You can import CAs or save a file system path from a file that contains multiple CAs, or import individual CAs.
The standard PEM format for files that contain multiple CA chain certifications has the root cert at the bottom of
the file and all subsequently signed child certificates above, towards the beginning of the file.

The CA certificate import dialog will find all CA certificates within the file, regardless of order, and also offers the
option to import certificates that are considered invalid (in case you want to override their trust policy). You can
override the trust policy upon import, or do so later within the Authorities editor.

Figure 19.28: Import certificates dialog

Nota: If you are pasting certificate information into the PEM text field, note that encrypted certificates are not
supported.

Identities

You can manage available client identity bundles from the Identities tab in the Certificate manager from the
Authentication tab of the QGIS Options dialog. An identity is what authenticates you against a PKI-enabled
service and usually consists of a client certificate and private key, either as separate files or combined into a single
«bundled» file. The bundle or private key is often passphrase-protected.

Once you have any Certificate Authorities (CAs) imported you can optionally import any identity bundles into the
authentication database. If you do not wish to store the identities, you can reference their component file system
paths within an individual authentication configuration.
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Figure 19.29: Identities editor

When importing an identity bundle, it can be passphrase-protected or unprotected, and can contain CA certificates
forming a trust chain. Trust chain certifications will not be imported here; they can be added separately under the
Authorities tab.

Upon import the bundle’s certificate and private key will be stored in the database, with the key’s storage encrypted
using the QGIS master password. Subsequent usage of the stored bundle from the database will only require input
of the master password.

Personal identity bundles consisting of PEM/DER (.pem/.der) and PKCS#12 (.p12/.pfx) components are sup-
ported. If a key or bundle is passphrase-protected, the password will be required to validate the component prior
to import. Likewise, if the client certificate in the bundle is invalid (for example, its effective date has not yet
started or has elapsed) the bundle can not be imported.

Figure 19.30: PEM/DER identity import
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Figure 19.31: PKCS#12 identity import

19.2.4 Handling bad layers

Occasionally, the authentication configuration ID that is saved with a project file is no longer valid, possibly
because the current authentication database is different than when the project was last saved, or due to a credentials
mismatch. In such cases the Handle bad layers dialog will be presented upon QGIS launch.

Figure 19.32: Handle bad layers with authentication

If a data source is found to have an authentication configuration ID associated with it, you will be able to edit it.
Doing so will automatically edit the data source string, much in the same way as opening the project file in a text
editor and editing the string.

19.2.5 Changing authentication config ID

Occasionally, you will need to change the authentication configuration ID that is associated with accessing a
resource. There are instances where this is useful:

• Resource auth config ID is no longer valid: This can occur when you have switched auth databases add
need to align a new configuration to the ID already associated with a resource.

• Shared project files: If you intended to share projects between users, e.g. via a shared file server, you can
predefine a 7-character (containing a-z and/or 0-9) that is associated with the resource. Then, individual
users change the ID of an authentication configuration that is specific to their credentials of the resource.
When the project is opened, the ID is found in the authentication database, but the credentials are different
per user.
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Figure 19.33: Edit bad layer’s authentication config ID

Figure 19.34: Changing a layer’s authentication config ID (unlocked yellow text field)
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Avvertimento: Changing the auth config ID is considered an advanced operation and should only be done
with full knowledge as to why it is necessary. This is why there is a lock button that needs clicked, to unlock
the ID’s text field prior to editing the ID.

19.2.6 QGIS Server support

When using a project file, with layers that have authentication configurations, as a basis for a map in QGIS Server,
there are a couple of additional setup steps necessary for QGIS to load the resources:

• Authentication database needs to be available

• Authentication database’s master password needs to be available

When instantiating the authentication system, Server will create or use qgis-auth.db in ~/.qgis2/ or the
directory defined by the QGIS_AUTH_DB_DIR_PATH environment variable. It may be that the Server’s user has
no HOME directory, in which case, use the environment variable to define a directory that the Server’s user has
read/write permissions and is not located within the web-accessible directories.

To pass the master password to Server, write it to the first line of file at a path on the file system readable by the
Server processes user and defined using the QGIS_AUTH_PASSWORD_FILE environment variable. Ensure to
limit the file as only readable by the Server’s process user and to not store the file within web-accessible directories.

Nota: QGIS_AUTH_PASSWORD_FILE variable will be removed from the Server environment immediately
after accessing.

19.2.7 SSL server exceptions

Figure 19.35: SSL server exception

You can manage SSL server configurations and exceptions from the Servers tab in the Authentication section of
the QGIS Options dialog.

Sometimes, when connecting to an SSL server, there are errors with the SSL «handshake» or the server’s certifi-
cate. You can ignore those errors or create an SSL server configuration as an exception. This is similar to how
web browsers allow you to override SSL errors, but with more granular control.

Avvertimento: You should not create an SSL server configuration unless you have complete knowledge of
the entire SSL setup between the server and client. Instead, report the issue to the server administrator.

Nota: Some PKI setups use a completely different CA trust chain to validate client identities than the chain used
to validate the SSL server certificate. In such circumstances, any configuration created for the connecting server

508 Chapter 19. Authentication System



QGIS User Guide, Release 3.4

will not necessarily fix an issue with the validation of your client identity, and only your client identity’s issuer or
server administrator can fix the issue.

You can pre-configure an SSL server configuration by clicking the button. Alternatively, you can add a
configuration when an SSL error occurs during a connection and you are presented with an SSL Error dialog
(where the error can be ignored temporarily or saved to the database and ignored):

Figure 19.36: Manually adding configuration

Once an SSL configuration is saved to the database, it can be edited or deleted.

If you want to pre-configure an SSL configuration and the import dialog is not working for your server’s con-
nection, you can manually trigger a connection via the Python Console by running the following code (replace
https://bugreports.qt-project.org with the URL of your server):

from PyQt4.QtNetwork import *
req = QNetworkRequest(QUrl('https://bugreports.qt-project.org'))
reply = QgsNetworkAccessManager.instance().get(req)

This will open an SSL error dialog if any errors occur, where you can choose to save the configuration to the
database.

19.3 Security Considerations

Once the master password is entered, the API is open to access authentication configs in the authentication
database, similar to how Firefox works. However, in the initial implementation, no wall against PyQGIS ac-
cess has been defined. This may lead to issues where a user downloads/installs a malicious PyQGIS plugin or
standalone app that gains access to authentication credentials.

19.3. Security Considerations 509



QGIS User Guide, Release 3.4

Figure 19.37: Adding configuration during SSL error

Figure 19.38: Existing SSL configuration
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Figure 19.39: Editing an existing SSL configuration

The quick solution for initial release of feature is to just not include most PyQGIS bindings for the authentication
system.

Another simple, though not robust, fix is to add a combobox in Settings → Options → Authentication (defaults to
«never»):

"Allow Python access to authentication system"
Choices: [ confirm once per session | always confirm | always allow | never]

Such an option’s setting would need to be saved in a location non-accessible to Python, e.g. the authentication
database, and encrypted with the master password.

• Another option may be to track which plugins the user has specifically

• allowed to access the authentication system, though it may be tricky to deduce which plugin is actually
making the call.

• Sandboxing plugins, possibly in their own virtual environments, would reduce “cross-plugin” hacking of
authentication configs from another plugin that is authorized. This might mean limiting cross-plugin com-
munication as well, but maybe only between third-party plugins.

• Another good solution is to issue code-signing certificates to vetted plugin authors. Then validate the plu-
gin’s certificate upon loading. If need be the user can also directly set an untrusted policy for the certificate
associated with the plugin using existing certificate management dialogs.

• Alternatively, access to sensitive authentication system data from Python

• could never be allowed, and only the use of QGIS core widgets, or duplicating authentication system in-
tegrations, would allow the plugin to work with resources that have an authentication configuration, while
keeping master password and authentication config loading in the realm of the main app.

The same security concerns apply to C++ plugins, though it will be harder to restrict access, since there is no
function binding to simply be removed as with Python.

19.3.1 Restrictions

The confusing licensing and exporting issues associated with OpenSSL apply. In order for Qt to work with SSL
certificates, it needs access to the OpenSSL libraries. Depending upon how Qt was compiled, the default is to
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dynamically link to the OpenSSL libs at run-time (to avoid the export limitations).

QCA follows a similar tactic, whereby linking to QCA incurs no restrictions, because the qca-ossl (OpenSSL)
plugin is loaded at run-time. The qca-ossl plugin is directly linked to the OpenSSL libs. Packagers would be the
ones needing to ensure any OpenSSL-linking restrictions are met, if they ship the plugin. Maybe. I don’t really
know. I’m not a lawyer.

The authentication system safely disables itself when qca-ossl is not found at run-time.
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Integrazione con GRASS GIS

L’integrazione di GRASS fornisce l’accesso ai database e alle funzionalità di GRASS GIS (vedi GRASS-
PROJECT in Letteratura e riferimenti web). L’integrazione consiste di due parti: sorgente e plugin. Il sorgente
consente di sfogliare, gestire e visualizzare i layer raster e vettoriali GRASS. Il plugin può essere utilizzato per
creare nuove posizioni e gruppi di GRASS, modificare la regione di GRASS, creare e modificare i livelli vettoriali
e analizzare i dati GRASS 2D e 3D con più di 400 moduli GRASS. In questa sezione, introdurremo le funzionalità
del sorgente e del plug-in e forniremo alcuni esempi di gestione e utilizzo dei dati GRASS.

ll sorgente supporta GRASS versione 6 e 7, il plugin supporta GRASS 6 e 7 (a partire da QGIS 2.12). La
distribuzione QGIS può contenere sorgente/plugin per GRASS 6, GRASS 7 o per entrambe le versioni contempo-
raneamente (i file binari hanno nomi dei file diversi). Tuttavia, solo una versione del sorgente/plugin può essere
caricata durante l’esecuzione.

20.1 Demo insieme di dati

As an example, we will use the QGIS Alaska dataset (see section Dati campione). It includes a small
sample GRASS LOCATION with three vector layers and one raster elevation map. Create a new folder
called grassdata, download the QGIS “Alaska” dataset qgis_sample_data.zip from https://qgis.org/
downloads/data/ and unzip the file into grassdata.

More sample GRASS LOCATIONs are available at the GRASS website at https://grass.osgeo.org/download/
sample-data/.

20.2 Caricare layer raster e vettoriali GRASS

If the provider is loaded in QGIS, the location item with GRASS icon is added in the browser tree under each
folder item which contains GRASS location. Go to the folder grassdata and expand location alaska and
mapset demo.

Puoi caricare raster e vettori GRASS come qualsiasi altro layer dal browser facendo doppio clic sul layer o trasci-
nando e rilasciando sulla mappa o sulla legenda.

Suggerimento: Caricare dati GRASS
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Se non vedi la location GRASS, verifica in Guida → Informazioni → Sorgente dati se il sorgente dei vettori
GRASS è caricato.

20.3 Importare dati nelle LOCATION GRASS tramite trascina e ri-
lascia.

Questa sezione da un esempio di come importare dati raster e vettoriali in un mapset di GRASS. 76

1. Nel browser QGIS accedi al mapset in cui desideri importare i dati.

2. Nel browser QGIS trova un layer che vuoi importare in GRASS, nota che puoi aprire un’altra finestra del
browser (Browser Panel (2)) se i dati sorgente sono troppo lontani dal mapset nell’albero.

3. Trascina un layer e rilascialo sul mapset di destinazione. L’importazione potrebbe richiedere del tempo per i
layer più grandi, vedrai un icona animata |importazione| di fronte al nuovo oggetto del layer fino al termine
dell’importazione.

Quando i raster sono in CRS diversi, possono essere riproiettati utilizzando un Approximate (veloce) o Exact
(esatta). Se viene creato un collegamento al raster sorgente (utilizzando ‘‘ r.external‘‘), i dati di origine sono nello
stesso CRS e il formato è noto a GDAL, verranno utilizzati i dati di origine CRS. Puoi impostare queste opzioni
nella scheda Browser in: ref:‘ grass_options‘.

Se un raster ha più bande, viene creata una nuova mappa GRASS per ogni raster con .<band number> suffisso e

tutto viene raggruppato in . I raster esterni hanno un’icona diversa .

20.4 Gestione dei dati GRASS in QGIS Browser

• Copia delle mappe: le mappe GRASS possono essere copiate tra i mapset all’interno della stessa location
mediante trascinamento della selezione.

• Eliminazione delle mappe: fai clic con il tasto destro su una mappa GRASS e seleziona Elimina dal menu
contestuale.

• Rinominare le mappe: fare clic con il tasto destro su una mappa GRASS e seleziona :guilabel:‘Rinomina”
dal menu contestuale.

20.5 Opzioni di GRASS

Le opzioni GRASS possono essere impostate nella finestra di dialogo Opzioni di GRASS, che può essere aperta
facendo clic con il pulsante destro del mouse sulla posizione o sull’elemento mapset nel browser e quindi
scegliendo Opzioni di GRASS.

20.6 Avviare il plugin GRASS

To use GRASS functionalities in QGIS, you must select and load the GRASS plugin using the Plugin Manager.

To do this, go to the menu Plugins → Manage and Install Plugins. . . , select GRASS and click OK.

Le seguenti funzioni principali sono fornite con il menu GRASS (Plugins -> GRASS) quando si avvia il plugin
GRASS:

• Apri mapset

• Nuovo mapset
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• Chiudi mapset

• Apri strumenti GRASS

• Visulalizza la regione di GRASS attuale

• Opzioni di GRASS

20.7 Aprire un mapset GRASS

Per accedere a strumenti GRASS devi aprire un mapset di GRASS nel plugin (gli strumenti sono disabilitati se
nessun mapset è aperto). Puoi aprire un mapset dal browser: fai clic con il pulsante destro del mouse sull’elemento
mapset e quindi scegli Apri mapset dal menu contestuale.

20.8 LOCATION e MAPSET in GRASS

I dati GRASS sono memorizzati in una cartella indicata come GISDBASE. Questa cartella, spesso chiamata
grassdata, deve essere creata prima di iniziare a lavorare con il plugin GRASS in QGIS. All’interno di questa
cartella, i dati GIS GRASS sono organizzati per progetti memorizzati in sottocartelle chiamate LOCATION. Ogni
LOCATION è definito dal suo sistema di coordinate, dalla proiezione e dai confini geografici. Ciascun LOCATION
può avere diversi MAPSET (sottocartella di LOCATION) che vengono utilizzati per suddividere il progetto in
diversi argomenti o sottoregioni o come aree di lavoro per i singoli membri del team (vedere Neteler & Mitasova
2008 in: ref: literature_and_web). Per analizzare i vettori e i raster con i moduli GRASS, devi generalmente
importarli in una LOCATION GRASS. (Questo non è sempre vero - con i moduli GRASS r.external e :file:‘
v.external‘ è possibile creare collegamenti di sola lettura a insieme di dati esterni supportati da GDAL/OGR senza
importarli. Questo non è un modo perchi inizia a lavorare con GRASS, quindi questa funzionalità non sarà
descritta qui.)

Figure 20.1: Dati di GRASS all’interno della LOCATIoN Alaska

20.9 Importare dati nelle LOCATION GRASS

See section Importare dati nelle LOCATION GRASS tramite trascina e rilascia. to find how data can be easily
imported by dragging and dropping in the browser.

This section gives an example of how to import raster and vector data into the “alaska” GRASS LOCATION
provided by the QGIS “Alaska” dataset in traditional way, using standard GRASS modules. Therefore, we use the
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landcover raster map landcover.img and the vector GML file lakes.gml from the QGIS “Alaska” dataset
(see Dati campione).

1. Avvia QGIS e assicurati che il plugin GRASS sia caricato

2. In the GRASS toolbar, click the Open MAPSET icon to bring up the MAPSET wizard.

3. Select as GRASS database the folder grassdata in the QGIS Alaska dataset, as LOCATION “alaska”, as
MAPSET “demo” and click OK.

4. Now click the Open GRASS tools icon. The GRASS Toolbox (see section The GRASS Toolbox) dialog
appears.

5. To import the raster map landcover.img, click the module r.in.gdal in the Modules Tree tab. This
GRASS module allows you to import GDAL-supported raster files into a GRASS LOCATION. The module
dialog for r.in.gdal appears.

6. Scorri la cartella raster nell’insieme di dati “Alaska” di QGIS e seleziona il file landcover.img.

7. As raster output name, define landcover_grass and click Run. In the Output tab, you see
the currently running GRASS command r.in.gdal -o input=/path/to/landcover.img
output=landcover_grass.

8. When it says Successfully finished, click View Output. The landcover_grass raster layer is now
imported into GRASS and will be visualized in the QGIS canvas.

9. To import the vector GML file lakes.gml, click the module v.in.ogr in the Modules Tree tab. This
GRASS module allows you to import OGR-supported vector files into a GRASS LOCATION. The module
dialog for v.in.ogr appears.

10. Scorri la cartella gml nell’insieme di dati “Alaska” di QGIS e selezionare il file lakes.gml come file
OGR.

11. As vector output name, define lakes_grass and click Run. You don’t have to care about the other
options in this example. In the Output tab you see the currently running GRASS command v.in.ogr -o
dsn=/path/to/lakes.gml output=lakes\_grass.

12. When it says Succesfully finished, click View Output. The lakes_grass vector layer is now imported
into GRASS and will be visualized in the QGIS canvas.

20.9.1 Creare una nuova LOCATION GRASS

As an example, here is the sample GRASS LOCATION alaska, which is projected in the Albers Equal Area
projection using feet as units. This sample GRASS LOCATION alaska will be used for all examples and exer-
cises in the following GRASS-related sections. It is useful to download and install the dataset on your computer
(see Dati campione).

1. Avvia QGIS e assicurati che il plugin GRASS sia caricato

2. Visualize the alaska.shp shapefile (see section Caricare un layer da un le) from the QGIS Alaska dataset
(see Dati campione).

3. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

4. Select an existing GRASS database (GISDBASE) folder grassdata, or create one for the new
LOCATION using a file manager on your computer. Then click Next.

5. We can use this wizard to create a new MAPSET within an existing LOCATION (see section Aggiungere

un nuovo MAPSET) or to create a new LOCATION altogether. Select Create new location (see fig-
ure_grass_new_location).

6. Enter a name for the LOCATION – we used “alaska” – and click Next.

7. Define the projection by clicking on the radio button Projection to enable the projection list.
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8. We are using Albers Equal Area Alaska (feet) projection. Since we happen to know that it is represented
by the EPSG ID 2964, we enter it in the search box. (Note: If you want to repeat this process for another

LOCATION and projection and haven’t memorized the EPSG ID, click on the CRS Status icon in the lower
right-hand corner of the status bar (see section Lavorare con le proiezioni)).

9. In Filter, insert 2964 to select the projection.

10. Click Next.

11. To define the default region, we have to enter the LOCATION bounds in the north, south, east, and west
directions. Here, we simply click on the button Set Current QGIS Extent, to apply the extent of the loaded
layer alaska.shp as the GRASS default region extent.

12. Click Next.

13. We also need to define a MAPSET within our new LOCATION (this is necessary when creating a new
LOCATION). You can name it whatever you like - we used “demo”. GRASS automatically creates a special
MAPSET called PERMANENT, designed to store the core data for the project, its default spatial extent and
coordinate system definitions (see Neteler & Mitasova 2008 in Letteratura e riferimenti web).

14. Check out the summary to make sure it’s correct and click Finish.

15. The new LOCATION, “alaska”, and two MAPSETs, “demo” and “PERMANENT”, are created. The cur-
rently opened working set is “demo”, as you defined.

16. Si noti che alcuni strumenti della barra di GRASS precedentemente disabilitati sono ora attivi.

Figure 20.2: Creating a new GRASS LOCATION or a new MAPSET in QGIS

If that seemed like a lot of steps, it’s really not all that bad and a very quick way to create a LOCATION. The
LOCATION “alaska” is now ready for data import (see section Importare dati nelle LOCATION GRASS). You can
also use the already-existing vector and raster data in the sample GRASS LOCATION “alaska”, included in the
QGIS “Alaska” dataset Dati campione, and move on to section Il modello dati vettoriale di GRASS.

20.9.2 Aggiungere un nuovo MAPSET

A user has write access only to a GRASS MAPSET which he or she created. This means that besides access to
your own MAPSET, you can read maps in other users” MAPSETs (and they can read yours), but you can modify
or remove only the maps in your own MAPSET.

All MAPSETs include a WIND file that stores the current boundary coordinate values and the currently selected
raster resolution (see Neteler & Mitasova 2008 in Letteratura e riferimenti web, and section Lo strumento Regione
di GRASS).

1. Avvia QGIS e assicurati che il plugin GRASS sia caricato

2. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

3. Select the GRASS database (GISDBASE) folder grassdata with the LOCATION “alaska”, where we
want to add a further MAPSET called “test”.
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4. Click Next.

5. We can use this wizard to create a new MAPSET within an existing LOCATION or to create a new

LOCATION altogether. Click on the radio button Select location (see figure_grass_new_location) and
click Next.

6. Enter the name text for the new MAPSET. Below in the wizard, you see a list of existing MAPSETs and
corresponding owners.

7. Click Next, check out the summary to make sure it’s all correct and click Finish.

20.10 Il modello dati vettoriale di GRASS

It is important to understand the GRASS vector data model prior to digitizing. In general, GRASS uses a topolog-
ical vector model. This means that areas are not represented as closed polygons, but by one or more boundaries.
A boundary between two adjacent areas is digitized only once, and it is shared by both areas. Boundaries must be
connected and closed without gaps. An area is identified (and labelled) by the centroid of the area.

Besides boundaries and centroids, a vector map can also contain points and lines. All these geometry elements
can be mixed in one vector and will be represented in different so-called “layers” inside one GRASS vector map.
So in GRASS, a layer is not a vector or raster map but a level inside a vector layer. This is important to distinguish
carefully. (Although it is possible to mix geometry elements, it is unusual and, even in GRASS, only used in
special cases such as vector network analysis. Normally, you should prefer to store different geometry elements
in different layers.)

It is possible to store several “layers” in one vector dataset. For example, fields, forests and lakes can be stored in
one vector. An adjacent forest and lake can share the same boundary, but they have separate attribute tables. It is
also possible to attach attributes to boundaries. An example might be the case where the boundary between a lake
and a forest is a road, so it can have a different attribute table.

The “layer” of the feature is defined by the “layer” inside GRASS. “Layer” is the number which defines if there
is more than one layer inside the dataset (e.g., if the geometry is forest or lake). For now, it can be only a number.
In the future, GRASS will also support names as fields in the user interface.

Attributes can be stored inside the GRASS LOCATION as dBase, SQLite3 or in external database tables, for
example, PostgreSQL, MySQL, Oracle, etc.

Gli attributi contenuti nelle tabelle del database sono collegati alla geometria per il tramite di un valore ’category’.

’Category’ (key, ID) è un valore intero collegato alle primitive geometriche ed è usato come collegamento ad una
colonna chiave nella tabella del database.

Suggerimento: Conoscere il modello dati vettoriale di GRASS

The best way to learn the GRASS vector model and its capabilities is to download one of the many GRASS
tutorials where the vector model is described more deeply. See https://grass.osgeo.org/documentation/manuals/
for more information, books and tutorials in several languages.

20.11 Creare un nuovo layer vettoriale GRASS

To create a new GRASS vector layer, select one of following items from mapset context menu in the browser:

• New Point Layer

• New Line Layer

• New Polygon Layer
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and enter a name in the dialog. A new vector map will be created and layer will be added to canvas and editing
started. Selecting type of the layer does not restrict geometry types which can be digitized in the vector map. In
GRASS, it is possible to organize all sorts of geometry types (point, line and polygon) in one vector map. The
type is only used to add the layer to the canvas, because QGIS requires a layer to have a specific type.

It is also possible to add layers to existing vector maps selecting one of the items described above from context
menu of existing vector map.

In GRASS, it is possible to organize all sorts of geometry types (point, line and area) in one layer, because GRASS
uses a topological vector model, so you don’t need to select the geometry type when creating a new GRASS vector.
This is different from shapefile creation with QGIS, because shapefiles use the Simple Feature vector model (see
section Creare nuovi layer Vettore).

20.12 Digitalizzare e modificare layer vettoriali GRASS

GRASS vector layers can be digitized using the standard QGIS digitizing tools. There are however some particu-
larities, which you should know about, due to

• GRASS topological model versus QGIS simple feature

• complexity of GRASS model

– multiple layers in single maps

– multiple geometry types in single map

– geometry sharing by multiple features from multiple layers

The particularities are discussed in the following sections.

Save, discard changes, undo, redo

Avvertimento: All the changes done during editing are immediately written to vector map and related at-
tribute tables.

Changes are written after each operation, it is however, possible to do undo/redo or discard all changes when
closing editing. If undo or discard changes is used, original state is rewritten in vector map and attribute tables.

There are two main reasons for this behaviour:

• It is the nature of GRASS vectors coming from conviction that user wants to do what he is doing and it is
better to have data saved when the work is suddenly interrupted (for example, blackout)

• Necessity for effective editing of topological data is visualized information about topological correctness,
such information can only be acquired from GRASS vector map if changes are written to the map.

Barra degli strumenti di digitalizzazione

The “Digitizing Toolbar” has some specific tools when a GRASS layer is edited:

Icona Strumento Azione

Nuovo punto Digitalizza un nuovo punto

Nuova linea Digitalizza una nuova linea

Nuovo contorno Digitize new boundary

Nuovo centroide Digitalizza un nuovo centroide (imposta l’etichetta per un’area esistente)

New Closed Boundary Digitize new closed boundary

Table GRASS Digitizing: GRASS Digitizing Tools
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Suggerimento: Digitalizzare poligoni in GRASS

If you want to create a polygon in GRASS, you first digitize the boundary of the polygon. Then you add a centroid
(label point) into the closed boundary. The reason for this is that a topological vector model links the attribute
information of a polygon always to the centroid and not to the boundary.

Category

Category, often called cat, is sort of ID. The name comes from times when GRASS vectors had only singly
attribute «category». Category is used as a link between geometry and attributes. A single geometry may have
multiple categories and thus represent multiple features in different layers. Currently it is possible to assign only
one category per layer using QGIS editing tools. New features have automatically assigned new unique category,
except boundaries. Boundaries usually only form areas and do not represent linear features, it is however possible
to define attributes for a boundary later, for example in different layer.

New categories are always created only in currently being edited layer.

It is not possible to assign more categories to geometry using QGIS editing, such data are properly represented as
multiple features, and individual features, even from different layers, may be deleted.

Attributes

Attributes of currently edited layer can only be modified. If the vector map contains more layers, features of other
layers will have all attributes set to “<not editable (layer #)>” to warn you that such attribute is not editable. The
reason is, that other layers may have and usually have different set of fields while QGIS only supports one fixed
set of fields per layer.

If a geometry primitive does not have a category assigned, a new unique category is automatically assigned and
new record in attribute table is created when an attribute of that geometry is changed.

Suggerimento: If you want to do bulk update of attributes in table, for example using “Field Calculator” (Usare
il Calcolatore di campo), and there are features without category which you don’t want to update (typically
boundaries), you can filter them out by setting “Advanced Filter” to cat is not null.

Editing style

The topological symbology is essential for effective editing of topological data. When editing starts, a specialized
“GRASS Edit” renderer is set on the layer automatically and original renderer is restored when editing is closed.
The style may be customized in layer properties “Style” tab. The style can also be stored in project file or in
separate file as any other style. If you customize the style, do not change its name, because it is used to reset the
style when editing is started again.

Suggerimento: Do not save project file when the layer is edited, the layer would be stored with “Edit Style”
which has no meaning if layer is not edited.

The style is based on topological information which is temporarily added to attribute table as field “topo_symbol”.
The field is automatically removed when editing is closed.

Suggerimento: Do not remove “topo_symbol” field from attribute table, that would make features invisible
because the renderer is based on that column.

Snapping

To form an area, vertices of connected boundaries must have exactly the same coordinates. This can be achieved
using snapping tool only if canvas and vector map have the same CRS. Otherwise, due conversion from map
coordinates to canvas and back, the coordinate may become slightly different due to representation error and CRS
transformations.
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Suggerimento: Use layer’s CRS also for canvas when editing.

Limitations

Simultaneous editing of multiple layers within the same vector at the same time is not supported. This is mainly
due to the impossibility of handling multiple undo stacks for a single data source.

On Linux and macOS only one GRASS layer can be edited at time. This is due to a bug in GRASS which
does not allow to close database drivers in random order. This is being solved with GRASS developers.

Suggerimento: Permessi di modifica in GRASS

You must be the owner of the GRASS MAPSET you want to edit. It is impossible to edit data layers in a MAPSET
that is not yours, even if you have write permission.

20.13 Lo strumento Regione di GRASS

The region definition (setting a spatial working window) in GRASS is important for working with raster layers.
Vector analysis is by default not limited to any defined region definitions. But all newly created rasters will have
the spatial extension and resolution of the currently defined GRASS region, regardless of their original extension
and resolution. The current GRASS region is stored in the $LOCATION/$MAPSET/WIND file, and it defines
north, south, east and west bounds, number of columns and rows, horizontal and vertical spatial resolution.

It is possible to switch on and off the visualization of the GRASS region in the QGIS canvas using the
Display current GRASS region button.

The region can be modified in “Region” tab in “GRASS Tolls” dock widget. Type in the new region bounds and
resolution, and click Apply. If you click on Select the extent by dragging on canvas you can select a new region
interactively with your mouse on the QGIS canvas dragging a rectangle.

The GRASS module g.region provides a lot more parameters to define an appropriate region extent and reso-
lution for your raster analysis. You can use these parameters with the GRASS Toolbox, described in section The
GRASS Toolbox.

20.14 The GRASS Toolbox

The Open GRASS Tools box provides GRASS module functionalities to work with data inside a selected GRASS
LOCATION and MAPSET. To use the GRASS Toolbox you need to open a LOCATION and MAPSET that you
have write permission for (usually granted, if you created the MAPSET). This is necessary, because new raster or
vector layers created during analysis need to be written to the currently selected LOCATION and MAPSET.

20.14.1 Lavorare con i moduli GRASS

The GRASS shell inside the GRASS Toolbox provides access to almost all (more than 300) GRASS modules in
a command line interface. To offer a more user-friendly working environment, about 200 of the available GRASS
modules and functionalities are also provided by graphical dialogs within the GRASS plugin Toolbox.

A complete list of GRASS modules available in the graphical Toolbox in QGIS version 3.4 is available in the
GRASS wiki at https://grass.osgeo.org/wiki/GRASS-QGIS_relevant_module_list.

It is also possible to customize the GRASS Toolbox content. This procedure is described in section Personalizzare
gli strumenti GRASS.
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Figure 20.3: GRASS Toolbox and Module Tree

As shown in figure_grass_toolbox, you can look for the appropriate GRASS module using the thematically
grouped Modules Tree or the searchable Modules List tab.

By clicking on a graphical module icon, a new tab will be added to the Toolbox dialog, providing three new
sub-tabs: Options, Output and Manual.

Opzioni

The Options tab provides a simplified module dialog where you can usually select a raster or vector layer visualized
in the QGIS canvas and enter further module-specific parameters to run the module.

The provided module parameters are often not complete to keep the dialog simple. If you want to use further
module parameters and flags, you need to start the GRASS shell and run the module in the command line.

A new feature since QGIS 1.8 is the support for a Show Advanced Options button below the simplified module
dialog in the Options tab. At the moment, it is only added to the module v.in.ascii as an example of use, but
it will probably be part of more or all modules in the GRASS Toolbox in future versions of QGIS. This allows you
to use the complete GRASS module options without the need to switch to the GRASS shell.

Output

The Output tab provides information about the output status of the module. When you click the Run button, the
module switches to the Output tab and you see information about the analysis process. If all works well, you will
finally see a Successfully finished message.

Manuale

The Manual tab shows the HTML help page of the GRASS module. You can use it to check further module
parameters and flags or to get a deeper knowledge about the purpose of the module. At the end of each module
manual page, you see further links to the Main Help index, the Thematic index and the Full index.
These links provide the same information as the module g.manual.

Suggerimento: Mostrare i risultati immediatamente

Se si desidera visualizzare il risultato di un’analisi immediatamente nella vista mappa, è possibile cliccare sul
pulsante Visualizza Output nella porzione inferiore della scheda.
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Figure 20.4: GRASS Toolbox Module Options

Figure 20.5: GRASS Toolbox Module Output
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Figure 20.6: GRASS Toolbox Module Manual
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20.14.2 Esempi di utilizzo di moduli GRASS

Gli esempi che seguono mostrano le potenzialità di alcuni moduli GRASS.

Creare curve di livello

The first example creates a vector contour map from an elevation raster (DEM). Here, it is assumed that you have
the Alaska LOCATION set up as explained in section Importare dati nelle LOCATION GRASS.

• First, open the location by clicking the Open mapset button and choosing the Alaska location.

• Now open the Toolbox with the Open GRASS tools button.

• In the list of tool categories, double-click Raster → Surface Management → Generate vector contour lines.

• Now a single click on the tool r.contour will open the tool dialog as explained above (see Lavorare con i
moduli GRASS).

• In the Name of input raster map enter gtopo30.

• Type into the Increment between Contour levels the value 100. (This will create contour lines at
intervals of 100 meters.)

• Inserire in Nome del vettoriale in output il nome ctour_100.

• Click Run to start the process. Wait for several moments until the message Successfully finished
appears in the output window. Then click View Output and Close.

Dal momento che la regione è pittosto estesa, il comando richiede del tempo. Una volta terminata l’operazione è
possibile modificare le proprietà del nuovo layer vettoriale come descritto in Proprietà dei vettori.

Next, zoom in to a small, mountainous area in the center of Alaska. Zooming in close, you will notice that the
contours have sharp corners. GRASS offers the v.generalize tool to slightly alter vector maps while keeping
their overall shape. The tool uses several different algorithms with different purposes. Some of the algorithms
(i.e., Douglas Peuker and Vertex Reduction) simplify the line by removing some of the vertices. The resulting
vector will load faster. This process is useful when you have a highly detailed vector, but you are creating a very
small-scale map, so the detail is unnecessary.

Suggerimento: Semplifica geometrie

Note that QGIS has a Vector → Geometry Tools → Simplify geometries tool that works just like the GRASS
v.generalize Douglas-Peuker algorithm.

However, the purpose of this example is different. The contour lines created by r.contour have sharp angles
that should be smoothed. Among the v.generalize algorithms, there is Chaiken’s, which does just that (also
Hermite splines). Be aware that these algorithms can add additional vertices to the vector, causing it to load even
more slowly.

• Open the GRASS Toolbox and double-click the categories Vector → Develop map → Generalization, then
click on the v.generalize module to open its options window.

• Controllare che “ctour_100” appaia come Nome della mappa vettoriale in input.

• From the list of algorithms, choose Chaiken’s. Leave all other options at their default, and scroll down to
the last row to enter in the field Name for output vector map “ctour_100_smooth”, and click Run.

• The process takes several moments. Once Successfully finished appears in the output windows,
click View Output and then Close.

• È possibile modificare il colore del layer vettoriale in modo da renderlo ben visibile sul raster si sfondo. Si
potrà notare come le curve di livello ora appaiano meno spigolose.
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Figure 20.7: GRASS module v.generalize to smooth a vector map

Suggerimento: Altri usi di r.contour

The procedure described above can be used in other equivalent situations. If you have a raster map of precipitation
data, for example, then the same method will be used to create a vector map of isohyetal (constant rainfall) lines.

Creating a Hillshade 3-D effect

Several methods are used to display elevation layers and give a 3-D effect to maps. The use of contour lines, as
shown above, is one popular method often chosen to produce topographic maps. Another way to display a 3-D
effect is by hillshading. The hillshade effect is created from a DEM (elevation) raster by first calculating the slope
and aspect of each cell, then simulating the sun’s position in the sky and giving a reflectance value to each cell.
Thus, you get sun-facing slopes lighted; the slopes facing away from the sun (in shadow) are darkened.

• Begin this example by loading the gtopo30 elevation raster. Start the GRASS Toolbox, and under the
Raster category, double-click to open Spatial analysis → Terrain analysis.

• Cliccare r.shaded.relief per aprire il modulo.

• Change the azimuth angle 270 to 315.

• Enter gtopo30_shade for the new hillshade raster, and click Run.

• Quando il processo sarà completato, aggiungere il raster ombreggiatura alla vista mappa.

• To view both the hillshading and the colors of the gtopo30 together, move the hillshade map below the
gtopo30 map in the table of contents, then open the Properties window of gtopo30, switch to the
Transparency tab and set its transparency level to about 25%.

Si dovrebbe vedere gtopo30 sopra la mappa di ombreggiatura in scala di grigi. Per riuscire a visualizzare
appieno gli effetti dell’ombreggiatura, deselezionare gtopo30_shade.

Usare la shell di GRASS

The GRASS plugin in QGIS is designed for users who are new to GRASS and not familiar with all the modules
and options. As such, some modules in the Toolbox do not show all the options available, and some modules do
not appear at all. The GRASS shell (or console) gives the user access to those additional GRASS modules that
do not appear in the Toolbox tree, and also to some additional options to the modules that are in the Toolbox with
the simplest default parameters. This example demonstrates the use of an additional option in the r.shaded.relief
module that was shown above.

The module r.shaded.relief can take a parameter zmult, which multiplies the elevation values relative to the X-Y
coordinate units so that the hillshade effect is even more pronounced.
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Figure 20.8: The GRASS shell, r.shaded.relief module
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• Load the gtopo30 elevation raster as above, then start the GRASS Toolbox and click on the
GRASS shell. In the shell window, type the command r.shaded.relief map=gtopo30
shade=gtopo30_shade2 azimuth=315 zmult=3 and press Enter.

• After the process finishes, shift to the Browse tab and double-click on the new gtopo30_shade2 raster
to display it in QGIS.

• As explained above, move the shaded relief raster below the gtopo30 raster in the table of contents, then
check the transparency of the colored gtopo30 layer. You should see that the 3-D effect stands out more
strongly compared with the first shaded relief map.

Figure 20.9: Displaying shaded relief created with the GRASS module r.shaded.relief

Statistiche raster in una mappa vettoriale

Il prossimo esempio tratta di un modulo GRASS che può aggregare dati raster ed aggiungere colonne di statistiche
per ogni poligono di una mappa vettoriale.

• Again using the Alaska data, refer to Importare dati nelle LOCATION GRASS to import the shapefiles/
trees.shp file into GRASS.

• Now an intermediate step is required: centroids must be added to the imported trees map to make it a
complete GRASS area vector (including both boundaries and centroids).

• From the Toolbox, choose Vector → Manage features, and open the module v.centroids.

• Inserire come Nome del vettoriale in output “forest_areas” e lanciare il modulo.

• Now load the forest_areas vector and display the types of forests - deciduous, evergreen, mixed - in

different colors: In the layer Properties window, Symbology tab, choose from Legend type “Unique
value” and set the Classification field to “VEGDESC”. (Refer to the explanation of the symbology tab in
Proprietà Simbologia of the vector section.)

• Next, reopen the GRASS Toolbox and open Vector → Vector update by other maps.

• Click on the v.rast.stats module. Enter gtopo30 and forest_areas.

• Only one additional parameter is needed: Enter column prefix elev, and click Run. This is a computation-
ally heavy operation, which will run for a long time (probably up to two hours).

• Finally, open the forest_areas attribute table, and verify that several new columns have been added,
including elev_min, elev_max, elev_mean, etc., for each forest polygon.
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20.14.3 Personalizzare gli strumenti GRASS

Nearly all GRASS modules can be added to the GRASS Toolbox. An XML interface is provided to parse the
pretty simple XML files that configure the modules” appearance and parameters inside the Toolbox.

Un esempio di file XML che genera il modulo v.buffer (v.buffer.qgm) ha il seguente aspetto:

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE qgisgrassmodule SYSTEM "http://mrcc.com/qgisgrassmodule.dtd">

<qgisgrassmodule label="Vector buffer" module="v.buffer">
<option key="input" typeoption="type" layeroption="layer" />
<option key="buffer"/>
<option key="output" />

</qgisgrassmodule>

The parser reads this definition and creates a new tab inside the Toolbox when you select the module. A more
detailed description for adding new modules, changing a module’s group, etc., can be found at https://qgis.org/en/
site/getinvolved/development/addinggrasstools.html.
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CHAPTER 21

ambiente Processing di QGIS

21.1 Introduzione

Questo capitolo introduce l’ambiente di processing QGIS, un ambiente di elaborazione di dati geografici grazie al
quale potrai usare algoritmi nativi di |qg| e algoritmi di terze parti. In questo modo le attività di analisi spaziale
saranno molto più produttive e facile da realizzare.

Nella sezione seguente esamineremo come usare gli elementi grafici di questo ambiente e come ottenere il mas-
simo da ciascuno di essi.

There are four basic elements in the framework GUI, which are used to run algorithms for different purposes.
Choosing one tool or another will depend on the kind of analysis that is to be performed and the particular
characteristics of each user and project. All of them (except for the batch processing interface, which is called
from the toolbox or the algorithm execution dialog, as we will see) can be accessed from the Processing menu
item (you will see more entries; the remaining ones are not used to execute algorithms and will be explained later
in this chapter).

• The Toolbox: The main element of the GUI, it is used to execute a single algorithm or run a batch process
based on that algorithm.

• The Graphical Modeler: Several algorithms can be combined graphically using the modeler to define a
workflow, creating a single process that involves several subprocesses.

• The History manager: All actions performed using any of the aforementioned elements are stored in a
history file and can be later easily reproduced using the history manager.

• The Batch Processing interface: This interface allows you to execute batch processes and automate the
execution of a single algorithm on multiple datasets.

Nelle sezioni seguenti rivedremo in dettaglio ciascuno di questi elementi.

21.2 Configuring the Processing Framework

As has been mentioned, the configuration menu gives access to a new dialog where you can configure how algo-
rithms work. Configuration parameters are structured in separate blocks that you can select on the left-hand side
of the dialog.

Along with the aforementioned Output folder entry, the General block contains parameters for setting the default
rendering style for output layers (that is, layers generated by using algorithms from any of the framework GUI
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Figure 21.1: Strumenti di Processing

Figure 21.2: Modellatore Grafico
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Figure 21.3: Cronologia Processing

Figure 21.4: Interfaccia del processo in serie
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components). Just create the style you want using QGIS, save it to a file, and then enter the path to that file in the
settings so the algorithms can use it. Whenever a layer is loaded by Processing and added to the QGIS canvas, it
will be rendered with that style.

Rendering styles can be configured individually for each algorithm and each one of its outputs. Just right-click on
the name of the algorithm in the toolbox and select Edit rendering styles for outputs. You will see a dialog like the
one shown next.

Figure 21.5: Rendering Styles

Select the style file (.qml) that you want for each output and press OK.

Other configuration parameters in the General group are listed below:

• Use filename as layer name. The name of each resulting layer created by an algorithm is defined by the
algorithm itself. In some cases, a fixed name might be used, meaning that the same output name will be
used, no matter which input layer is used. In other cases, the name might depend on the name of the input
layer or some of the parameters used to run the algorithm. If this checkbox is checked, the name will be
taken from the output filename instead. Notice that, if the output is saved to a temporary file, the filename
of this temporary file is usually a long and meaningless one intended to avoid collision with other already
existing filenames.

• Keep dialog open after running algorithm. Once an algorithm has finished execution and its output layers
are loaded into the QGIS project, the algorithm dialog is closed. If you want to keep it open (to run the
algorithm again with different parameters, or to better check the output that is written to the log tab), check
this option

• Use only selected features. If this option is selected, whenever a vector layer is used as input for an al-
gorithm, only its selected features will be used. If the layer has no selected features, all features will be
used.

• Pre-execution script file and Post-execution script file. These parameters refer to scripts written using the
processing scripting functionality, and are explained in the section covering scripting and the console.

Apart from the General block in the settings dialog, you will also find a block for algorithm providers. Each
entry in this block contains an Activate item that you can use to make algorithms appear or not in the toolbox.
Also, some algorithm providers have their own configuration items, which we will explain later when covering
particular algorithm providers.

21.3 The Toolbox

The Processing Toolbox is the main element of the processing GUI, and the one that you are more likely to use
in your daily work. It shows the list of all available algorithms grouped in different blocks called Providers, and
custom models and scripts you can add to extend the set of tools. Hence the toolbox is the access point to run
them, whether as a single process or as a batch process involving several executions of the same algorithm on
different sets of inputs.

Providers can be (de)activated in the Processing settings dialog. By default, only providers that do not rely on
third-party applications (that is, those that only require QGIS elements to be run) are active. Algorithms requiring
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Figure 21.6: Processing Toolbox
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external applications might need additional configuration. Configuring providers is explained in a later chapter in
this manual.

In the upper part of the toolbox dialog, you will find a set of tools to:

• work with Models: Create New Model. . . , Open Existing Model. . . and Add Model to Toolbox. . . ;

• work with Scripts: Create New Script. . . , Create New Script from Template. . . , Open Existing Script. . .
and Add Script to Toolbox. . . ;

• open the History panel;

• open the Results Viewer panel;

• toggle the toolbox to the in-place modification mode using the Edit Features In-Place button: only the algo-
rithms that are suitable to be executed on the active layer without outputting a new layer are displayed;

• open the Options dialog.

Below this toolbar is a Search. . . box to help you easily find the tools you need. You can enter any word
or phrase on the text box. Notice that, as you type, the number of algorithms, models or scripts in the toolbox is
reduced to just those that contain the text you have entered in their names or keywords.

Nota: At the top of the list of algorithms are displayed the most recent used tools; handy if you want to reexecute
any.

Figure 21.7: Processing Toolbox showing search results

To execute a tool, just double-click on its name in the toolbox.
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21.3.1 La finestra di configurazione di un algoritmo

Once you double-click on the name of the algorithm that you want to execute, a dialog similar to that in the figure
below is shown (in this case, the dialog corresponds to the Centroids algorithm).

Figure 21.8: Algorithm Dialog - Parameters

This dialog is used to set the input values that the algorithm needs to be executed. It shows a list of input values
and configuration parameters to be set. It of course has a different content, depending on the requirements of the
algorithm to be executed, and is created automatically based on those requirements.

Anche se il numero e tipo dei parametri dipende dal tipo di algoritmo, la struttura di base è simile per tutti. I
parametri della tabella possono essere uno dei seguenti tipi.

• A raster layer, to select from a list of all such layers available (currently opened) in QGIS. The selector
contains as well a button on its right-hand side, to let you select filenames that represent layers currently not
loaded in QGIS.

• A vector layer, to select from a list of all vector layers available in QGIS. Layers not loaded in QGIS can
be selected as well, as in the case of raster layers, but only if the algorithm does not require a table field
selected from the attributes table of the layer. In that case, only opened layers can be selected, since they
need to be open so as to retrieve the list of field names available.

You will see an iterator button by each vector layer selector, as shown in the figure below.

Se l’algoritmo ne contiene molti, potrai selezionarne anche solamente uno. Se il pulsante corrispondente a
un vettore in input è attivo, allora l’algoritmo verrà eseguito iterativamente su tutte le sue geometrie, invece
di una sola volta per tutto il vettore. Il numero di output dipende da quante volte eseguirai l’algoritmo.
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Figure 21.9: Vector iterator button

Questo ti permette di automatizzare il processo quando tutte le geometrie in un vettore devono essere elab-
orate separatamente.

Nota: By default, the parameters dialog will show a description of the CRS of each layer along with its name.
If you do not want to see this additional information, you can disable this functionality in the Processing Settings
dialog, unchecking the General → Show layer CRS definition in selection boxes option.

• A table, to select from a list of all available in QGIS. Non-spatial tables are loaded into QGIS like vector
layers, and in fact they are treated as such by the program. Currently, the list of available tables that you will
see when executing an algorithm that needs one of them is restricted to tables coming from files in dBase
(.dbf) or Comma-Separated Values (.csv) formats.

• An option, to choose from a selection list of possible options.

• A numerical value, to be introduced in a spin box. In some contexts (when the parameter applies at

the feature level and not at the layer’s), you will find a Data-defined override button by its side, allowing
you to open the expression builder and enter a mathematical expression to generate variable values for the
parameter. Some useful variables related to data loaded into QGIS can be added to your expression, so you
can select a value derived from any of these variables, such as the cell size of a layer or the northernmost
coordinate of another one.

Figure 21.10: Expression based input

• A range, with min and max values to be introduced in two text boxes.

• A text string, to be introduced in a text box.

• A field, to choose from the attributes table of a vector layer or a single table selected in another parameter.

• A coordinate reference system. You can select it among the recently used ones from the drop-down list or
from the CRS selection dialog that appears when you click on the button on the right-hand side.

• An extent, to be entered by four numbers representing its xmin, xmax, ymin, ymax limits. Clicking on
the button on the right-hand side of the value selector, a pop-up menu will appear, giving you options:
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– to select the value from a layer or the current canvas extent;

– or to define it by dragging directly onto the map canvas.

Figure 21.11: Extent selector

Se scegliete la prima opzione verrà mostrata la seguente finestra di scelta rapida.

Figure 21.12: Extent List

Se scegliete la seconda opzione, la finestra dei parametri sparirà, così potrai scegliere l’area tramite il mouse.
Una volta selezionato il rettangolo, la finestra di dialogo riapparirà completa dei limiti della regione appena
definita.

Figure 21.13: Extent Drag

• A list of elements (whether raster or vector layers, tables, fields) to select from. Click on the . . . button
at the left of the option to see a dialog like the following one. Multiple selection is allowed and when the
dialog is closed, number of selected items is displayed in the parameter text box widget.

• A small table to be edited by the user. These are used to define parameters like lookup tables or convolution
kernels, among others.

Cliccate sul bottone sul lato destro per vedere la tabella e aggiornare i suoi valori.

A seconda dell’algoritmo, potrai modificare il numero delle righe, usando i pulsanti sul lato destro della
finestra.

Nota: Some algorithms require many parameter to run, e.g. in the qgisrastercalculator you have to specify
manually the cell size, the extent and the CRS. You can avoid to choose all the parameters manually when the
algorithm has the Reference layers parameter. With this parameter you can choose the reference layer and
all its properties (cell size, extent, CRS) will be used.
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Figure 21.14: Multiple Selection

Figure 21.15: Fixed Table
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Along with the Parameters tab, there is another tab named Log (see figure below). Information provided by the
algorithm during its execution is written in this tab, and allow you to track the execution and be aware and have
more details about the algorithm as it runs. Notice that not all algorithms write information to this tab, and many
of them might run silently without producing any output other than the final files.

Figure 21.16: Algorithm Dialog - Log

At the bottom of the Log tab you will find buttons to Save Log to File, Copy Log to Clipboard
and Clear Log. These are particularly handy when you have checked the Keep dialog open after
running algorithm in the General part of the Processing options.

On the right hand side of the dialog you will find a short description of the algorithm, which will help you
understand its purpose and its basic ideas. If such a description is not available, the description panel will not be
shown.

For a more detailed help file, which might include description of every parameter it uses, or examples, you will
find a Help button at the bottom of the dialog bringing you to the Processing algorithms documentation or to the
provider documentation (for some third-party providers).

Nota sulle proiezioni

Processing algorithm execution are always performed in the input layer coordinate reference system (CRS). Due
to QGIS’s on-the-fly reprojecting capabilities, although two layers might seem to overlap and match, that might
not be true if their original coordinates are used without reprojecting them onto a common coordinate system.
Whenever you use more than one layer as input to a QGIS native algorithm, whether vector or raster, the layers
will all be reprojected to match the coordinate reference system of the first input layer.
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This is however less true for most of the external applications whose algorithms are exposed through the processing
framework as they assume that all of the layers are already in a common coordinate system and ready to be
analyzed.

By default, the parameters dialog will show a description of the CRS of each layer along with its name, making it
easy to select layers that share the same CRS to be used as input layers. If you do not want to see this additional
information, you can disable this functionality in the Processing settings dialog, unchecking the Show layer CRS
definition in selection boxes option.

If you try to execute an algorithm using as input two or more layers with unmatching CRSs, a warning dialog will
be shown. This occurs thanks to the Warn before executing if layer CRS’s do not match option.

Potrai comunque eseguire l’algoritmo, ma sappi che nella maggior parte dei casi ciò produrrà cattivi risultati,
come ad esempio layer di uscita inconsistenti, proprio perché questi non sono sovrapposti.

Suggerimento: Use Processing algorithms to do intermediate reprojection

When an algorithm can not successfully perform on multiple input layers due to unmatching CRSs, use QGIS
internal algorithm such as qgisreprojectlayer to perform layers” reprojection to the same CRS before executing
the algorithm using these outputs.

21.3.2 Dati generati dagli algoritmi

I dati generati da un algoritmo possono appartere a una delle seguenti tipologie:

• Raster

• Un vettore

• Tabella

• File HTML (usato per risultati testuali e grafici)

These are all saved to disk, and the parameters table will contain a text box corresponding to each one of these
outputs, where you can type the output channel to use for saving it. An output channel contains the information
needed to save the resulting object somewhere. In the most usual case, you will save it to a file, but in the case of
vector layers, and when they are generated by native algorithms (algorithms not using external applications) you
can also save to a PostGIS, GeoPackage or SpatiaLite database, or a memory layer.

To select an output channel, just click on the button on the right side of the text box, and you will see a small
context menu with the available options.

In the most usual case, you will select saving to a file. If you select that option, you will be prompted with a
save file dialog, where you can select the desired file path. Supported file extensions are shown in the file format
selector of the dialog, depending on the kind of output and the algorithm.

The format of the output is defined by the filename extension. The supported formats depend on what is supported
by the algorithm itself. To select a format, just select the corresponding file extension (or add it, if you are directly
typing the file path instead). If the extension of the file path you entered does not match any of the supported
formats, a default extension will be appended to the file path, and the file format corresponding to that extension
will be used to save the layer or table. Default extensions are .dbf for tables, .tif for raster layers and .gpkg
for vector layers. These can be modified in the setting dialog, selecting any other of the formats supported by
QGIS.

If you do not enter any filename in the output text box (or select the corresponding option in the context menu),
the result will be saved as a temporary file in the corresponding default file format, and it will be deleted once you
exit QGIS (take care with that, in case you save your project and it contains temporary layers).

You can set a default folder for output data objects. Go to the settings dialog (you can open it from the Settings
→ Options → Processing menu), and in the General group, you will find a parameter named Output folder. This
output folder is used as the default path in case you type just a filename with no path (i.e., myfile.shp) when
executing an algorithm.
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Durante l’esecuzione di un algoritmo che usa un vettore in modo iterativo, il percorso del file inserito è usato
come percorso di base per tutti i file generati, i quali sono nominati usando il nome del vettore e aggiungendo
poi un numero che rappresenta l’indice di iterazione. L’estensione del file (e il formato) viene usata per tutti i file
generati.

Apart from raster layers and tables, algorithms also generate graphics and text as HTML files. These results are
shown at the end of the algorithm execution in a new dialog. This dialog will keep the results produced by any
algorithm during the current session, and can be shown at any time by selecting Processing → Results Viewer
from the QGIS main menu.

Some external applications might have files (with no particular extension restrictions) as output, but they do not
belong to any of the categories above. Those output files will not be processed by QGIS (opened or included into
the current QGIS project), since most of the time they correspond to file formats or elements not supported by
QGIS. This is, for instance, the case with LAS files used for LiDAR data. The files get created, but you won’t see
anything new in your QGIS working session.

Per tutti gli altri tipi di output, troverai una casella di controllo che potrai usare per indicare se caricare o meno il
file una volta che è stato generato dall’algoritmo. Come impostazione predefinita, tutti i file vengono aperti.

Optional outputs are not supported. That is, all outputs are created. However, you can uncheck the corresponding
checkbox if you are not interested in a given output, which essentially makes it behave like an optional output (in
other words, the layer is created anyway, but if you leave the text box empty, it will be saved to a temporary file
and deleted once you exit QGIS).

21.4 Il gestore della cronologia di Processing

21.4.1 La cronologia di Processing

Ogni volta che esegui un algoritmo, le informazioni sul processo sono salvate dal gestore della cronologia. Ven-
gono salvati anche i parametri usati, la data ed il tempo di esecuzione.

In questo modo è facile tenere traccia e controllare tutto il lavoro eseguito tramite l’ambiente di Processing, e
riprodurlo.

Il gestore della cronologia è un insieme di registri raggruppati per data di esecuzione: in questo modo è molto
facile trovare l’informazione su uno specifico algoritmo eseguito in un particolare momento.

Figure 21.17: Cronologia

L’informazione sul processo è conservata come una espressione a riga di comando, anche se l’algoritmo è stato
avviato tramite Strumenti. Questo è molto utile se stai imparando ad usare la riga di comando perché puoi vedere
il comando di un algoritmo eseguito tramite Strumenti.
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Oltre a poter scorrere l’elenco del registro, puoi rieseguire i processi semplicemente facendo doppio click sul
loro nome: la finestra di dialogo dell’algoritmo si apre con i parametri già riempiti; puoi cambiarne qualsiasi per
adattarli ai tuoi bisogni ed eseguire di nuovo l’algoritmo.

The History dialog also provides a convenient way to contribute to the consolidation of the testing infrastructure of
QGIS Processing algorithms and scripts. Right-click on a command you previously executed and you can Create
Test. . . for the concerned algorithm, following instructions at https://github.com/qgis/QGIS/blob/release-3_4/
python/plugins/processing/tests/README.md.

21.4.2 Il log di Processing

La finestra di dialogo della cronologia contiene solo le chiamate in esecuzione, ma non le informazioni prodotte
dall’algoritmo quando eseguite. Tale informazione viene scritta nel log di QGIS (Visualizza → Pannelli → Mes-
saggi di Log), in una scheda Processing.

Gli algoritmi di terze parti vengono solitamente eseguiti chiamando le loro interfacce della riga di comando, che
comunicano con l’utente tramite la console. Sebbene tale console non sia mostrata, una copia completa di essa
viene scritta nel log ogni volta che si esegue uno di questi algoritmi. Per evitare di ingombrare il registro con
tali informazioni, è possibile disabilitarlo per ciascun provider, cercando l’opzione corrispondente nella voce del
provider della finestra di dialogo delle impostazioni.

Alcuni algoritmi, anche se vengono correttamente eseguiti e forniscono un risultato, possono aggiungere delle
informazioni nel log se rilevano potenziali problemi con i dati. Guarda i messaggi se vedi che il risultato non è
quello atteso.

21.5 Modellatore grafico

The graphical modeler allows you to create complex models using a simple and easy-to-use interface. When
working with a GIS, most analysis operations are not isolated, rather part of a chain of operations. Using the
graphical modeler, that chain of operations can be wrapped into a single process, making it convenient to execute
later with a different set of inputs. No matter how many steps and different algorithms it involves, a model is
executed as a single algorithm, saving time and effort.

The graphical modeler can be opened from the Processing menu (Processing → Graphical Modeler).

The modeler has a working canvas where the structure of the model and the workflow it represents are shown. The
left part of the window is a panel with two tabs that can be used to add new elements to the model.

La creazione di un modello comporta due passaggi:

1. Definizione degli input necessari. Tutti gli input verranno aggiunti alla finestra dei parametri, in questo
modo puoi impostare i valori durante l’esecuzione del modello. Il modello stesso è un algoritmo, quindi la
finestra dei parametri viene automaticamente generata come accade con tutti gli algoritmi disponibili.

2. Definition of the workflow. Using the input data of the model, the workflow is defined by adding algorithms
and selecting how they use the defined inputs or the outputs generated by other algorithms in the model.

21.5.1 Definizione dei dati di ingresso

The first step is to define the inputs for the model. The following elements are found in the Inputs tab on the left
side of the modeler window:

• Booleano

• CRS

• Distance

• Enum

• Expression
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Figure 21.18: Modellatore
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• Estensione

• Fields Mapper

• File/Folder

• Map Layer

• Matrix

• Multiple Input

• Numero

• Point

• Range

• Raster Band

• Raster Layer

• Stringhe di testo

• Vector Features

• Vector Field

• Vector Layer

When double-clicking on an element, a dialog is shown that lets you define its characteristics. Depending on
the parameter, the dialog will contain at least one basic element (the description, which is what the user will see
when executing the model). When adding a numerical value, as can be seen in the next figure, in addition to the
description of the parameter, you have to set a default value and the range of valid values.

Per ogni dato di ingresso aggiunto, appare un nuovo elemento nel pannello grafico del modellatore.

You can also add inputs by dragging the input type from the list and dropping it in the position where you want it
in the modeler canvas.

21.5.2 Definizione del flusso operativo

Once the inputs have been defined, it is time to define the algorithms of the model. Algorithms can be found in
the Algorithms tab, grouped much in the same way as they are in the Processing toolbox.

To add an algorithm to a model, double-click on its name or drag and drop it, just like for inputs. An execution
dialog will appear, with a content similar to the one found in the execution panel that is shown when executing
the algorithm from the toolbox. The ones shown next correspond to the QGIS “Drape (set Z value from raster)”
algorithm and the QGIS “Climb along line” algorithm.

Come puoi vedere, ci sono diverse differenze. Al posto della casella di output dove potevi specificare il percorso
dei layer e tabelle, qui c’è una semplice casella di testo. Se il layer generato da questo algoritmo è solamente
un layer temporaneo che deve essere usato come input da un altro algoritmo, allora non inserire niente in questa
casella. Se riempi questa casella significa che il risultato è finale e che il testo che hai inserito corrisponderà
all’output finale.

Anche il valore di ogni parametro è leggermente diverso, dal momento che che ci sono importanti differenze fra il
contesto del modello e quello degli Strumenti. Vediamo come inserire i valori per ogni tipologia di parametro.

• Layer (raster e vettoriali) e tabelle. Devi selezionarle da una lista, ma in questo caso i valori possibili
non sono i layer o le tabelle attualmente aperte in QGIS, bensì la lista dei dati di ingresso del modello
corrispondente per tipo, o altri layer e tabelle generate da algoritmi già aggiunti al modello.

• Numerical values. Literal values can be introduced directly in the text box. Clicking on the button beside
the text box, expressions can be entered. Available variables for expressions include numerical inputs of the
model, outputs from model algorithms and also statistical values from available layers within the model.

• String. Literal strings can be typed in the corresponding text box. Clicking on the button beside the text
box, expressions can be entered, as for numerical values.
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Figure 21.19: Definizione Parametri del modello

Figure 21.20: Model Parameters
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Figure 21.21: Input al modello
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Figure 21.22: Parametri dell’algoritmo del modello

• Vector Field. The fields of a vector layer cannot be known at design time, since they depend on the selection
of the user each time the model is executed. To set the value for this parameter, type the name of a field
directly in the text box, or use the list to select a table field. The validity of the selected field will be checked
at run time.

In tutti i casi troverai un parametro aggiunti chiamato Parent algorithms, non disponibile quando avvii un algo-
ritmo dagli Strumenti. Questo parametro ti permette di definire l’ordine in cui gli algoritmi vengono eseguiti, in
quanto scegli tu la nidificazione degli algoritmi. In altre parole, puoi forzare l’esecuzione di un algoritmo prima
di un altro.

When you use the output of a previous algorithm as the input of your algorithm, that implicitly sets the previous
algorithm as parent of the current one (and places the corresponding arrow in the modeler canvas). However,
in some cases an algorithm might depend on another one even if it does not use any output object from it (for
instance, an algorithm that executes a SQL sentence on a PostGIS database and another one that imports a layer
into that same database). In that case, just select the previous algorithm in the Parent algorithms parameter and
they will be executed in the correct order.

Once all the parameters have been assigned valid values, click on OK and the algorithm will be added to the
canvas. It will be linked to the elements in the canvas (algorithms or inputs) that provide objects that are used as
inputs for the algorithm.

Elements can be dragged to a different position on the canvas. This is useful to make the structure of the model
more clear and intuitive. Links between elements are updated automatically. You can zoom in and out by using
the mouse wheel.

You can run your algorithm any time by clicking on the Run button. In order to use the algorithm from the toolbox,
it has to be saved and the modeler dialog closed, to allow the toolbox to refresh its contents.

21.5.3 Salvataggio e caricamento di modelli

Use the Save button to save the current model and the Open button to open any previously saved model. Models
are saved with the .model3 extension. If the model has been already been saved from the modeler window, you
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Figure 21.23: A complete model
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will not be prompted for a filename. Since there is already a file associated with the model, that file will be used
for subsequent saves.

Before saving a model, you have to enter a name and a group for it in the text boxes in the upper part of the
window.

Models saved in the models folder (the default folder when you are prompted for a filename to save the model)
will appear in the toolbox in the corresponding branch. When the toolbox is invoked, it searches the models
folder for files with the .model3 extension and loads the models they contain. Since a model is itself an algo-
rithm, it can be added to the toolbox just like any other algorithm.

Models can also be saved within the project file using the Save model in project button. Models saved using this
method won’t be written as .model3 files on the disk but will be embedded in the project file.

Project models are available in the Project models menu of the toolbox.

Puoi specificare la cartella dei modelli nella finestra di configurazione di Processing, presente nel gruppo Model-
latore.

Models loaded from the models folder appear not only in the toolbox, but also in the algorithms tree in the
Algorithms tab of the modeler window. That means that you can incorporate a model as a part of a bigger model,
just like other algorithms.

Models will show up in the Browser panel , and can be run from there.

Exporting a model as an image, PDF or SVG

A model can also be exported as an image, SVG or PDF (for illustration purposes).

21.5.4 Aggiornare il modello

You can edit the model you are currently creating, redefining the workflow and the relationships between the
algorithms and inputs that define the model.

If you right-click on an algorithm in the canvas, you will see a context menu like the one shown next:

Figure 21.24: Click destro sul modello

Selezionando l’opzione Remove rimuoverai l’algoritmo selezionato. Non potrai rimuovere un algoritmo se altri
algoritmi dipendono da lui, ovvero quando un algoritmo vuole come input il risultato di un altro algoritmo. Se
provi a rimuovere comunque uno di questi algoritmi, apparirà una finestra di avviso.

Selecting the Edit option will show the parameter dialog of the algorithm, so you can change the inputs and
parameter values. Not all input elements available in the model will appear as available inputs. Layers or values
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Figure 21.25: L’algoritmo non può essere eliminato

generated at a more advanced step in the workflow defined by the model will not be available if they cause circular
dependencies.

Select the new values and click on the OK button as usual. The connections between the model elements will
change in the modeler canvas accordingly.

Un modello può essere eseguito parzialmente, disattivando alcuni dei suoi algoritmi. Per farlo, seleziona l’opzione
Disattiva nel menu di scelta rapida che viene visualizzato quando fai click destro e su un elemento di algoritmo.
L’algoritmo selezionato e tutti quelli del modello che ne dipendono verranno visualizzati in grigio e non verranno
eseguiti come parte del modello.

Figure 21.26: Algoritmo disattivato

When right-clicking on an algorithm that is not active, you will see a Activate menu option that you can use to
reactivate it.

21.5.5 Informazioni ed aiuto per l’aggiornamento del modello

You can document your models from the modeler itself. Just click on the Edit Model Help button, and a dialog
like the one shown next will appear.

Sulla parte destra vedrai una semplice pagina HTML, creata usando la descrizione dei parametri di input e di
output dell’algoritmo insieme ad alcuni parametri aggiuntivi come la sua descrizione e l’autore. La prima volta
che apri l’editor di aiuto, vedrai tutti i campi vuoti. Li puoi riempire usando le voci corrispondenti presenti nella
parte sinistra della finestra di dialogo. Seleziona un elemento nella parte superiore e poi inserisci la descrizione
nella casella di testo.

La guida del modello è salvata come parte del modello stesso

21.5.6 Exporting a model as a Python script

As we will see in a later chapter, Processing algorithms can be called from the QGIS Python console, and new
Processing algorithms can be created using Python. A quick way of creating such a Python script is to create a
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Figure 21.27: Editing Help
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model and then to export is as a Python file.

To do so, right click on the name of the model in the Processing Toolbox and choose Export Model as Python
Algorithm. . . .

21.5.7 A proposito degli algoritmi disponibili

You might notice that some algorithms that can be executed from the toolbox do not appear in the list of available
algorithms when you are designing a model. To be included in a model, an algorithm must have the correct
semantic. If an algorithm does not have such a well-defined semantic (for instance, if the number of output layers
cannot be known in advance), then it is not possible to use it within a model, and it will not appear in the list of
algorithms that you can find in the modeler dialog.

21.6 L’interfaccia per i processi in serie

21.6.1 Introduzione

Puoi eseguire come processi in serie tutti gli algoritmi (compresi i modelli). Questo significa che puoi eseguire
ogni algoritmo usando non solo un singolo input, ma anche più di uno. Questa funzionalità è particolarmente utile
quando hai bisogno di processare grandi quantità di dati; non dovrai più eseguire l’algoritmo singolarmente ogni
volta.

Per eseguire un algoritmo come un processo in serie, selezionarlo e col pulsante di destra del mouse scegliere la
voce Execute as batch process dal menu che apparirà.

Figure 21.28: Processi in serie facendo click con il tasto destro del mouse

Se hai la finestra di dialogo di esecuzione dell’algoritmo aperta, puoi anche avviare l’interfaccia di processamento
in serie da lì, facendo click sul pulsante Esegui come processo batch . . . .

21.6.2 La tabella dei parametri

Eseguire un processo in serie è un’operazione simile ad un’esecuzione singola di un algoritmo. Devi definire i
valori dei parametri, ma in questo caso, devi definire non solo un singolo valore per ciascunodi essi, ma un insieme
di valori, uno per ogni volta che l’algoritmo verrà eseguito. I valori sono introdotti per mezzo di una tabella del
tipo di quella mostrata oltre.

Ogni riga della tabella rappresenta una singola esecuzione dell’algoritmo mentre ogni cella contiene il valore di
uno dei parametri caratteristici dell’algoritmo. In un certo senso, è simile alla finestra di dialogo dei parametri
utilizzata quando si lancia un algoritmo da Strumenti, ma organizzata in maniera differente.

Come impostazione predefinita, la tabella contiene solo due righe. Puoi aggiungere o cancellare righe utilizzando
i pulsanti della parte inferiore della finestra.

Una volta definita la dimensione della tabella, la devi riempire con i valori desiderati.
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Figure 21.29: Processi in serie dalla finestra di dialogo Algoritmo

Figure 21.30: Processo in serie
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21.6.3 Compilazione della tabella dei parametri

Per la maggior parte dei parametri, la selezione del valore corretto è banale. Basta semplicemente scrivere il valore
o selezionarlo dalla lista delle opzioni disponibili, a seconda del tipo di parametro.

I nomi dei file per i dati di input vengono immessi direttamente digitando o, più convenientemente, facendo click
sul pulsante |browseButton| sulla parte destra della cella, che mostrerà un menu di scelta rapida con due opzioni:
una per selezionare tra i layer correntemente aperti e un’altra per selezionare dal filesystem. Questa seconda
opzione, quando selezionata, mostra una tipica finestra di dialogo di selezione dei file. È possibile selezionare
più file contemporaneamente. Se il parametro di input rappresenta un singolo oggetto dati e vengono selezionati
più file, ognuno di essi verrà inserito in una riga separata, aggiungendone di nuovi se necessario. Se il parametro
rappresenta un input multiplo, tutti i file selezionati verranno aggiunti a una singola cella, separati da punto e
virgola (;).

Gli identificativi del layer possono essere immessi direttamente nella casella di testo del parametro. Puoi inserire
il percorso completo di un file o il nome di un layer attualmente caricato nel progetto QGIS corrente. Il nome del
layer verrà automaticamente definito nel suo percorso di origine. Si noti che, se più layer hanno lo stesso nome,
questo potrebbe causare risultati imprevisti a causa di ambiguità.

I dati di output vengono sempre salvati su un file e, diversamente dall’esecuzione di un algoritmo dalla toolbox,
non è consentito il salvataggio in un file o database temporaneo. Puoi digitare direttamente il nome o utilizzare la
finestra di dialogo di selezione file visualizzata quando fai click sul pulsante di contesto.

Una volta selezionato il file di output, appare una nuova finestra di dialogo che permette l’autocompletamento
delle altre celle nella stessa colonna (stesso parametro).

Figure 21.31: Salvataggio di Processo in Serie

Se mantieni il valore predefinito (“Do not autocomplete”), Processing metterà il nome del file selezionato nella
cella selezionata dalla tabella dei parametri. Se selezioni una qualunque delle altre opzioni, tutte le celle sottostanti
a quella selezionata saranno riempite automaticamente basandosi sul criterio definito. In questo modo, è molto
più agevole riempire la tabella e puoi definire il processo in serie con meno fatica.

Puoi eseguire il riempimento automatico semplicemente aggiungendo numeri correlati al percorso del file se-
lezionato oppure aggiungendo il valore di un altro campo alla stessa riga. Questo è particolarmente utile per dare
un nome agli output che ricordi quello degli input.

21.6.4 Esecuzione di un processo in serie

Per eseguire un processo in serie, una volta introdotti tutti i valori necessari, clicca semplicemente su OK. Pro-
cessing mostrerà l’avanzamento globale del processo in serie nella barra di avanzamento nella parte inferiore della
finestra di dialogo.

21.7 Usare gli algoritmi di Processing dalla console dei comandi

La console permette ad utenti esperti di aumentare la propria produttività e di eseguire operazioni complesse che
non possono essere eseguite utilizzando uno qualsiasi degli altri elementi dell’interfaccia grafica di Processing. I
modelli che richiamano diversi algoritmi possono essere definiti utilizzando l’interfaccia della riga di comando, e
le operazioni aggiuntive, come i loop e le frasi condizionali possono essere aggiunte per creare flussi di lavoro più
flessibili e potenti.
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Figure 21.32: Percorso file dei Processo in Serie

There is not a processing console in QGIS, but all processing commands are available instead from the QGIS
built-in Python console. That means that you can incorporate those commands into your console work and connect
processing algorithms to all the other features (including methods from the QGIS API) available from there.

Il codice che puoi eseguire dalla console di python, anche se non richiama un metodo specifico di Processing, può
essere convertito in un nuovo algoritmo che potrai richiamare in seguito dagli Strumenti, dal Modellatore grafico
o da qualunque altra parte, proprio come ogni altro algoritmo. Alcuni algoritmi che trovi in Strumenti sono in
effetti degli script semplici.

In questa sezione verrà spiegato come usare gli algoritmi di Processing dalla console di Python e anche come
scrivere un algoritmo usando Python.

21.7.1 Richiamare algoritmi dalla console di python

La prima cosa da fare è importare le funzioni di Processing con la seguente istruzione:

>>> import processing

Now, there is basically just one (interesting) thing you can do with that from the console: execute an algorithm.
That is done using the run method, which takes the name of the algorithm to execute as its first parameter,
and then a variable number of additional parameters depending on the requirements of the algorithm. So the
first thing you need to know is the name of the algorithm to execute. That is not the name you see in the
toolbox, but rather a unique command–line name. To find the right name for your algorithm, you can use the
processingRegistry. Type the following line in your console:

>>> for alg in QgsApplication.processingRegistry().algorithms():
print(alg.id(), "->", alg.displayName())

You will see something like this (with some extra dashes added to improve readability).

3d:tessellate --------------> Tessellate
gdal:aspect ----------------> Aspect
gdal:assignprojection ------> Assign projection
gdal:buffervectors ---------> Buffer vectors
gdal:buildvirtualraster ----> Build Virtual Raster
gdal:cliprasterbyextent ----> Clip raster by extent
gdal:cliprasterbymasklayer -> Clip raster by mask layer
gdal:clipvectorbyextent ----> Clip vector by extent
gdal:clipvectorbypolygon ---> Clip vector by mask layer
gdal:colorrelief -----------> Color relief
gdal:contour ---------------> Contour
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gdal:convertformat ---------> Convert format
gdal:dissolve --------------> Dissolve
...

That’s a list of all the available algorithm IDs, sorted by provider name and algorithm name, along with their
corresponding names.

Once you know the command-line name of the algorithm, the next thing to do is to determine the right syntax to
execute it. That means knowing which parameters are needed when calling the run() method.

There is a method to describe an algorithm in detail, which can be used to get a list of the parameters
that an algorithm requires and the outputs that it will generate. To get this information, you can use the
algorithmHelp(id_of_the_algorithm) method. Use the ID of the algorithm, not the full descriptive
name.

Calling the method with native:buffer as parameter (qgis:buffer is an alias for native:buffer and
will also work), you get the following description:

>>> processing.algorithmHelp("native:buffer")
Buffer (native:buffer)

This algorithm computes a buffer area for all the features in an
input layer, using a fixed or dynamic distance.

The segments parameter controls the number of line segments to
use to approximate a quarter circle when creating rounded
offsets.

The end cap style parameter controls how line endings are handled
in the buffer.

The join style parameter specifies whether round, miter or
beveled joins should be used when offsetting corners in a line.

The miter limit parameter is only applicable for miter join
styles, and controls the maximum distance from the offset curve
to use when creating a mitered join.

----------------
Input parameters
----------------

INPUT: Input layer

Parameter type: QgsProcessingParameterFeatureSource

Accepted data types:
- str: layer ID
- str: layer name
- str: layer source
- QgsProcessingFeatureSourceDefinition
- QgsProperty
- QgsVectorLayer

DISTANCE: Distance

Parameter type: QgsProcessingParameterDistance

Accepted data types:
- int
- float
- QgsProperty
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SEGMENTS: Segments

Parameter type: QgsProcessingParameterNumber

Accepted data types:
- int
- float
- QgsProperty

END_CAP_STYLE: End cap style

Parameter type: QgsProcessingParameterEnum

Available values:
- 0: Round
- 1: Flat
- 2: Square

Accepted data types:
- int
- str: as string representation of int, e.g. '1'
- QgsProperty

JOIN_STYLE: Join style

Parameter type: QgsProcessingParameterEnum

Available values:
- 0: Round
- 1: Miter
- 2: Bevel

Accepted data types:
- int
- str: as string representation of int, e.g. '1'
- QgsProperty

MITER_LIMIT: Miter limit

Parameter type: QgsProcessingParameterNumber

Accepted data types:
- int
- float
- QgsProperty

DISSOLVE: Dissolve result

Parameter type: QgsProcessingParameterBoolean

Accepted data types:
- bool
- int
- str
- QgsProperty

OUTPUT: Buffered

Parameter type: QgsProcessingParameterFeatureSink

Accepted data types:
- str: destination vector file, e.g. 'd:/test.shp'
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- str: 'memory:' to store result in temporary memory layer
- str: using vector provider ID prefix and destination URI,

e.g. 'postgres:...' to store result in PostGIS table
- QgsProcessingOutputLayerDefinition
- QgsProperty

----------------
Outputs
----------------

OUTPUT: <QgsProcessingOutputVectorLayer>
Buffered

Now you have everything you need to run any algorithm. As we have already mentioned, algorithms can be run
using: run(). Its syntax is as follows:

>>> processing.run(name_of_the_algorithm, parameters)

Where parameters is a dictionary of parameters that depend on the algorithm you want to run, and is exactly the
list that the algorithmHelp() method gives you.

>>> processing.run("native:buffer", {'INPUT': '/data/lines.shp',
'DISTANCE': 100.0,
'SEGMENTS': 10,
'DISSOLVE': True,
'END_CAP_STYLE': 0,
'JOIN_STYLE': 0,
'MITER_LIMIT': 10,
'OUTPUT': '/data/buffers.shp'})

If a parameter is optional and you do not want to use it, then don’t include it in the dictionary.

If a parameter is not specified, the default value will be used.

A seconda del tipo di parametro, i valori sono inseriti in maniera diversa. Il seguente elenco dà una rapida
panoramica di come inserire valori per ogni tipo di parametro in input:

• Raster Layer, Vector Layer or Table. Simply use a string with the name that identifies the data object to use
(the name it has in the QGIS Table of Contents) or a filename (if the corresponding layer is not opened, it
will be opened but not added to the map canvas). If you have an instance of a QGIS object representing the
layer, you can also pass it as parameter.

• Enumeration. If an algorithm has an enumeration parameter, the value of that parameter should be entered
using an integer value. To know the available options, you can use the algorithmHelp() command, as
above. For instance, the «native.buffer» algorithm has an enumeration called JOIN_STYLE:

JOIN_STYLE: Join style

Parameter type: QgsProcessingParameterEnum

Available values:
- 0: Round
- 1: Miter
- 2: Bevel

Accepted data types:
- int
- str: as string representation of int, e.g. '1'
- QgsProperty

In this case, the parameter has three options. Notice that ordering is zero-based.

• Boolean. Use True or False.
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• Input multipli. Il valore è una stringa con descrittori in input separati da un punto e virgola (;). Come nel
caso di layer singoli o tabelle, ogni descrittore in input può essere il nome dell’oggetto o il suo percorso.

• Campo di una Tabella da XXX. Inserisci una stringa con il nome del campo da usare. Il parametro è sensibile
alle lettere maiuscole.

• Tabella fissa. Inserisci l’elenco di tutti i valori delle tabelle separati da una virgola (,) e racchiusi fra
virgolette ("). I valori partono dalla riga in alto e proseguono da sinistra verso destra. Puoi usare un array
2-D per i valori che rappresentano la tabella.

• SR. Inserisci il codice EPSG del SR desiderato.

• Estensione. Usa un stringa con valori xmin, xmax, ymin e ymax separati da virgole (,).

Parametri booleani, di file, di stringa e numerici non hanno bisogno di ulteriori spiegazioni.

Input parameters such as strings, booleans, or numerical values have default values. The default value is used if
the corresponding parameter entry is missing.

For output data objects, type the file path to be used to save it, just as it is done from the toolbox. If the output
object is not specified, the result is saved to a temporary file (or skipped if it is an optional output). The extension
of the file determines the file format. If you enter a file extension not supported by the algorithm, the default file
format for that output type will be used, and its corresponding extension appended to the given file path.

Unlike when an algorithm is executed from the toolbox, outputs are not added to the map canvas if you execute
that same algorithm from the Python console using run(), but runAndLoadResults() will do that.

The runmethod returns a dictionary with one or more output names (the ones shown in the algorithm description)
as keys and the file paths of those outputs as values:

>>> myresult = processing.run("native:buffer", {'INPUT': '/data/lines.shp',
'DISTANCE': 100.0,
'SEGMENTS': 10,
'DISSOLVE': True,
'END_CAP_STYLE': 0,
'JOIN_STYLE': 0,
'MITER_LIMIT': 10,
'OUTPUT': '/data/buffers.shp'})

>>> myresult['OUTPUT']
/data/buffers.shp

You can load feature output by passing the corresponding file paths to the load() method. Or you could use
runAndLoadResults() instead of run() to load them immediately.

21.7.2 Creare script ed eseguirli da Strumenti

You can create your own algorithms by writing Python code. Processing scripts extend
QgsProcessingAlgorithm, so you need to add some extra lines of code to implement mandatory
functions. You can find Create new script (clean sheet) and Create New Script from Template (template that
includes code for mandatory functions of QgsProcessingAlgorithm) under the Scripts dropdown menu on
the top of the Processing toolbox. The Processing Script Editor will open, and that’s where you should type your
code. Saving the script from there in the scripts folder (the default folder when you open the save file dialog)
with a .py extension should create the corresponding algorithm.

The name of the algorithm (the one you will see in the toolbox) is defined within the code.

Let’s have a look at the following code, which defines a Processing algorithm that performs a buffer operation
with a user defined buffer distance on a vector layer that is specified by the user, after first smoothing the layer.

from qgis.core import (QgsProcessingAlgorithm,
QgsProcessingParameterNumber,
QgsProcessingParameterFeatureSource,
QgsProcessingParameterFeatureSink)
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import processing

class algTest(QgsProcessingAlgorithm):
INPUT_BUFFERDIST = 'BUFFERDIST'
OUTPUT_BUFFER = 'OUTPUT_BUFFER'
INPUT_VECTOR = 'INPUT_VECTOR'

def __init__(self):
super().__init__()

def name(self):
return "algTest"

def displayName(self):
return "algTest script"

def createInstance(self):
return type(self)()

def initAlgorithm(self, config=None):
self.addParameter(QgsProcessingParameterFeatureSource(

self.INPUT_VECTOR, "Input vector"))
self.addParameter(QgsProcessingParameterNumber(

self.INPUT_BUFFERDIST, "Buffer distance",
QgsProcessingParameterNumber.Double,
100.0))

self.addParameter(QgsProcessingParameterFeatureSink(
self.OUTPUT_BUFFER, "Output buffer"))

def processAlgorithm(self, parameters, context, feedback):
#DO SOMETHING
algresult = processing.run("native:smoothgeometry",

{'INPUT': parameters[self.INPUT_VECTOR],
'ITERATIONS':2,
'OFFSET':0.25,
'MAX_ANGLE':180,
'OUTPUT': 'memory:'},

context=context, feedback=feedback, is_child_algorithm=True)
smoothed = algresult['OUTPUT']
algresult = processing.run('native:buffer',

{'INPUT': smoothed,
'DISTANCE': parameters[self.INPUT_BUFFERDIST],
'SEGMENTS': 5,
'END_CAP_STYLE': 0,
'JOIN_STYLE': 0,
'MITER_LIMIT': 10,
'DISSOLVE': True,
'OUTPUT': parameters[self.OUTPUT_BUFFER]},
context=context, feedback=feedback, is_child_algorithm=True)

buffered = algresult['OUTPUT']
return {self.OUTPUT_BUFFER: buffered}

After doing the necessary imports, the following QgsProcessingAlgorithm functions are specified:

• name: The id of the algorithm (lowercase).

• displayName: A human readable name for the algorithm.

• createInstance: Create a new instance of the algorithm class.

• initAlgorithm: Configure the parameterDefinitions and outputDefinitions.

Here you describe the parameters and output of the algorithm. In this case, a feature source for the input, a
feature sink for the result and a number for the buffer distance.
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• processAlgorithm: Do the work.

Here we first run the smoothgeometry algorithm to smooth the geometry, and then we run the buffer
algorithm on the smoothed output. To be able to run algorithms from within another algorithm we have
to define a dummy function for the onFinish parameter for run. This is the no_post_process
function. You can see how input and output parameters are used as parameters to the smoothgeometry
and buffer algorithms.

There are a number of different parameter types available for input and output. Below is an alphabetically sorted
list:

• QgsProcessingParameterBand

• QgsProcessingParameterBoolean

• QgsProcessingParameterCrs

• QgsProcessingParameterDistance

• QgsProcessingParameterEnum

• QgsProcessingParameterExpression

• QgsProcessingParameterExtent

• QgsProcessingParameterFeatureSink

• QgsProcessingParameterFeatureSource

• QgsProcessingParameterField - A field in the attributes table of a vector layer. The name of the
layer has to be specified.

• QgsProcessingParameterFile

• QgsProcessingParameterFileDestination

• QgsProcessingParameterFolderDestination

• QgsProcessingParameterMapLayer

• QgsProcessingParameterMatrix

• QgsProcessingParameterMultipleLayers

• QgsProcessingParameterNumber

• QgsProcessingParameterPoint

• QgsProcessingParameterRange

• QgsProcessingParameterRasterDestination

• QgsProcessingParameterRasterLayer

• QgsProcessingParameterString

• QgsProcessingParameterVectorDestination

• QgsProcessingParameterVectorLayer

The first parameter to the constructors is the name of the parameter, and the second is the description of the
parameter (for the user interface). The rest of the constructor parameters are parameter type specific.

The input can be turned into QGIS classes using the parameterAs functions of
QgsProcessingAlgorithm. For instance to get the number provided for the buffer distance as a
double:

self.parameterAsDouble(parameters, self.INPUT_BUFFERDIST, context)).

The processAlgorithm function should return a dictionary containing values for every output defined by the
algorithm. This allows access to these outputs from other algorithms, including other algorithms contained within
the same model.
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Well behaved algorithms should define and return as many outputs as makes sense. Non-feature outputs, such as
numbers and strings, are very useful when running your algorithm as part of a larger model, as these values can be
used as input parameters for subsequent algorithms within the model. Consider adding numeric outputs for things
like the number of features processed, the number of invalid features encountered, the number of features output,
etc. The more outputs you return, the more useful your algorithm becomes!

Feedback

The feedback object passed to processAlgorithm should be used for user feedback / interaction. You can
use the setProgress function of the feedback object to update the progress bar (0 to 100) to inform the user
about the progress of the algorithm. This is very useful if your algorithm takes a long time to complete.

The feedback object provides an isCanceled method that should be monitored to enable cancelation of the
algorithm by the user. The pushInfo method of feedback can be used to send information to the user, and
reportError is handy for pushing non-fatal errors to users.

Algorithms should avoid using other forms of providing feedback to users, such as print statements or logging
to QgsMessageLog, and should always use the feedback object instead. This allows verbose logging for the
algorithm, and is also thread-safe (which is important, given that algorithms are typically run in a background
thread).

Handling errors

If your algorithm encounters an error which prevents it from executing, such as invalid input values or some other
condition from which it cannot or should not recover, then you should raise a QgsProcessingException.
E.g.:

if feature['value'] < 20:
raise QgsProcessingException('Invalid input value {}, must be >= 20'.

→˓format(feature['value']))

Try to avoid raising QgsProcessingException for non-fatal errors (e.g. when a feature has a null geometry),
and instead just report these errors via feedback.reportError() and skip the feature. This helps make
your algorithm «model-friendly», as it avoids halting the execution of an entire algorithm when a non-fatal error
is encountered.

Documentare gli script

As in the case of models, you can create additional documentation for your scripts, to explain what they do and
how to use them.

QgsProcessingAlgorithm provides the helpString, shortHelpString and helpUrl functions for
that purpose. Specify / override these to provide more help to the user.

shortDescription is used in the tooltip when hovering over the algorithm in the toolbox.

21.7.3 Script agganciati pre e post esecuzione

Scripts can also be used as pre- and post-execution hooks that are run before and after an algorithm is run, respec-
tively. This can be used to automate tasks that should be performed whenever an algorithm is executed.

La sintassi è identica alla sintassi spiegato sopra, ma hai a disposizione anche una variabile globale chiamata alg
che rappresenta l’algoritmo che è appena (o che sarà) stato eseguito.

In the General group of the processing options dialog, you will find two entries named Pre-execution script and
Post-execution script where the filenames of the scripts to be run in each case can be entered.
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21.8 Writing new Processing algorithms as Python scripts

In QGIS 3.4, the only way to write Processing algorithms using Python is to extend the
QgsProcessingAlgorithm class.

Within QGIS, you can use Create new script in the Scripts menu at the top of the Processing Toolbox to open
the Processing Script Editor where you can write your code. To simplify the task, you can start with a script
template by using Create new script from template from the same menu. This opens a template that extends
QgsProcessingAlgorithm.

If you save the script in the scripts folder (the default location) with a .py extension, the algorithm will
become available in the Processing Toolbox.

21.8.1 Extending QgsProcessingAlgorithm

The following code

1. takes a vector layer as input

2. counts the number of features

3. does a buffer operation

4. creates a raster layer from the result of the buffer operation

5. returns the buffer layer, raster layer and number of features

from qgis.PyQt.QtCore import QCoreApplication
from qgis.core import (QgsProcessing,

QgsProcessingAlgorithm,
QgsProcessingException,
QgsProcessingOutputNumber,
QgsProcessingParameterDistance,
QgsProcessingParameterFeatureSource,
QgsProcessingParameterVectorDestination,
QgsProcessingParameterRasterDestination)

import processing

class ExampleProcessingAlgorithm(QgsProcessingAlgorithm):
"""
This is an example algorithm that takes a vector layer,
creates some new layers and returns some results.
"""

def tr(self, string):
"""
Returns a translatable string with the self.tr() function.
"""
return QCoreApplication.translate('Processing', string)

def createInstance(self):
# Must return a new copy of your algorithm.
return ExampleProcessingAlgorithm()

def name(self):
"""
Returns the unique algorithm name.
"""
return 'bufferrasterextend'

def displayName(self):
"""
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Returns the translated algorithm name.
"""
return self.tr('Buffer and export to raster (extend)')

def group(self):
"""
Returns the name of the group this algorithm belongs to.
"""
return self.tr('Example scripts')

def groupId(self):
"""
Returns the unique ID of the group this algorithm belongs
to.
"""
return 'examplescripts'

def shortHelpString(self):
"""
Returns a localised short help string for the algorithm.
"""
return self.tr('Example algorithm short description')

def initAlgorithm(self, config=None):
"""
Here we define the inputs and outputs of the algorithm.
"""
# 'INPUT' is the recommended name for the main input
# parameter.
self.addParameter(

QgsProcessingParameterFeatureSource(
'INPUT',
self.tr('Input vector layer'),
types=[QgsProcessing.TypeVectorAnyGeometry]

)
)
self.addParameter(

QgsProcessingParameterVectorDestination(
'BUFFER_OUTPUT',
self.tr('Buffer output'),

)
)
# 'OUTPUT' is the recommended name for the main output
# parameter.
self.addParameter(

QgsProcessingParameterRasterDestination(
'OUTPUT',
self.tr('Raster output')

)
)
self.addParameter(

QgsProcessingParameterDistance(
'BUFFERDIST',
self.tr('BUFFERDIST'),
defaultValue = 1.0,
# Make distance units match the INPUT layer units:
parentParameterName='INPUT'

)
)
self.addParameter(

QgsProcessingParameterDistance(
'CELLSIZE',
self.tr('CELLSIZE'),
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defaultValue = 10.0,
parentParameterName='INPUT'

)
)
self.addOutput(

QgsProcessingOutputNumber(
'NUMBEROFFEATURES',
self.tr('Number of features processed')

)
)

def processAlgorithm(self, parameters, context, feedback):
"""
Here is where the processing itself takes place.
"""
# First, we get the count of features from the INPUT layer.
# This layer is defined as a QgsProcessingParameterFeatureSource
# parameter, so it is retrieved by calling
# self.parameterAsSource.
input_featuresource = self.parameterAsSource(parameters,

'INPUT',
context)

numfeatures = input_featuresource.featureCount()

# Retrieve the buffer distance and raster cell size numeric
# values. Since these are numeric values, they are retrieved
# using self.parameterAsDouble.
bufferdist = self.parameterAsDouble(parameters, 'BUFFERDIST',

context)
rastercellsize = self.parameterAsDouble(parameters, 'CELLSIZE',

context)
if feedback.isCanceled():

return {}
buffer_result = processing.run(

'native:buffer',
{

# Here we pass on the original parameter values of INPUT
# and BUFFER_OUTPUT to the buffer algorithm.
'INPUT': parameters['INPUT'],
'OUTPUT': parameters['BUFFER_OUTPUT'],
'DISTANCE': bufferdist,
'SEGMENTS': 10,
'DISSOLVE': True,
'END_CAP_STYLE': 0,
'JOIN_STYLE': 0,
'MITER_LIMIT': 10

},
# Because the buffer algorithm is being run as a step in
# another larger algorithm, the is_child_algorithm option
# should be set to True
is_child_algorithm=True,
#
# It's important to pass on the context and feedback objects to
# child algorithms, so that they can properly give feedback to
# users and handle cancelation requests.
context=context,
feedback=feedback)

# Check for cancelation
if feedback.isCanceled():

return {}

# Run the separate rasterization algorithm using the buffer result
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# as an input.
rasterized_result = processing.run(

'qgis:rasterize',
{

# Here we pass the 'OUTPUT' value from the buffer's result
# dictionary off to the rasterize child algorithm.
'LAYER': buffer_result['OUTPUT'],
'EXTENT': buffer_result['OUTPUT'],
'MAP_UNITS_PER_PIXEL': rastercellsize,
# Use the original parameter value.
'OUTPUT': parameters['OUTPUT']

},
is_child_algorithm=True,
context=context,
feedback=feedback)

if feedback.isCanceled():
return {}

# Return the results
return {'OUTPUT': rasterized_result['OUTPUT'],

'BUFFER_OUTPUT': buffer_result['OUTPUT'],
'NUMBEROFFEATURES': numfeatures}

Processing algorithm standard functions:

• createInstance (mandatory) Must return a new copy of your algorithm. If you change the name of the
class, make sure you also update the value returned here to match!

• name (mandatory) Returns the unique algorithm name, used for identifying the algorithm.

• displayName (mandatory) Returns the translated algorithm name.

• group Returns the name of the group this algorithm belongs to.

• groupId Returns the unique ID of the group this algorithm belongs to.

• shortHelpString Returns a localised short help string for the algorithm.

• initAlgorithm (mandatory) Here we define the inputs and outputs of the algorithm.

INPUT and OUTPUT are recommended names for the main input and main output parameters, respec-
tively.

If a parameter depends on another parameter, parentParameterName is used to specify this rela-
tionship (could be the field / band of a layer or the distance units of a layer).

• processAlgorithm (mandatory) This is where the processing takes place.

Parameters are retrieved using special purpose functions, for instance parameterAsSource and
parameterAsDouble.

processing.run can be used to run other processing algorithms from a processing algorithm. The
first parameter is the name of the algorithm, the second is a dictionary of the parameters to the algo-
rithm. is_child_algorithm is normally set to True when running an algorithm from within
another algorithm. context and feedback inform the algorithm about the environment to run in
and the channel for communicating with the user (catching cancel request, reporting progress, pro-
viding textual feedback). When using the (parent) algorithm’s parameters as parameters to «child»
algorithms, the original parameter values should be used (e.g. parameters['OUTPUT']).

It is good practice to check the feedback object for cancelation as much as is sensibly possible! Doing
so allows for responsive cancelation, instead of forcing users to wait for unwanted processing to occur.

The algorithm should return values for all the output parameters it has defined as a dictionary. In this
case, that’s the buffer and rasterized output layers, and the count of features processed. The dictionary
keys must match the original parameter/output names.
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21.8.2 Input and output types for Processing Algorithms

Here is the list of input and output types that are supported in Processing with their corresponding alg decorator
constants (algfactory.py contains the complete list of alg constants). Sorted on class name.

Table 21.1: Input types
Class Description
QgsProcessingParameterBand A band of a raster layer
QgsProcessingParameterBoolean A boolean value
QgsProcessingParameterCrs A Coordinate Reference

System
QgsProcessingParameterDistance A double numeric parame-

ter for distance values
QgsProcessingParameterEnum An enumeration, allowing

for selection from a set of
predefined values

QgsProcessingParameterExpression An expression
QgsProcessingParameterExtent A spatial extent defined by

xmin, xmax, ymin, ymax
QgsProcessingParameterFeatureSink A feature sink
QgsProcessingParameterFeatureSource A feature source
QgsProcessingParameterField A field in the attribute table

of a vector layer
QgsProcessingParameterFile A filename of an existing

file
QgsProcessingParameterFileDestination A filename for a newly cre-

ated output file
QgsProcessingParameterFolderDestination A folder
QgsProcessingParameterMapLayer A map layer
QgsProcessingParameterMatrix A matrix
QgsProcessingParameterMultipleLayers A set of layers
QgsProcessingParameterNumber A numerical value
QgsProcessingParameterPoint A point
QgsProcessingParameterRange A number range
QgsProcessingParameterRasterLayer A raster layer
QgsProcessingParameterRasterDestination A raster layer
QgsProcessingParameterString A text string
QgsProcessingParameterVectorLayer A vector layer
QgsProcessingParameterVectorDestination A vector layer
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Table 21.2: Output types
Class Description
QgsProcessingOutputFile A filename of an existing file
QgsProcessingOutputFolder A folder
QgsProcessingOutputHtml HTML
QgsProcessingOutputLayerDefinition A layer definition
QgsProcessingOutputMapLayer A map layer
QgsProcessingOutputMultipleLayers A set of layers
QgsProcessingOutputNumber A numerical value
QgsProcessingOutputRasterLayer A raster layer
QgsProcessingOutputString A text string
QgsProcessingOutputVectorLayer A vector layer

21.8.3 Handing algorithm output

When you declare an output representing a layer (raster or vector), the algorithm will try to add it to QGIS once it
is finished.

• Raster layer output: QgsProcessingParameterRasterDestination.

• Vector layer output: QgsProcessingParameterVectorDestination.

So even if the processing.run() method does not add the layers it creates into the user’s current project, the
two output layers (buffer and raster buffer) will be loaded, since they are saved to the destinations entered by the
user (or to temporary destinations if the user does not specify a destination).

If a layer is created as output of an algorithm, it should be declared as such. Otherwise, you will not be able to
properly use the algorithm in the modeler, since what is declared will not match what the algorithm really creates.

You can return strings, numbers and more by specifying them in the result dictionary (as demonstrated for «NUM-
BEROFFEATURES»), but they should always be explicitly defined as outputs from your algorithm. We encourage
algorithms to output as many useful values as possible, since these can be valuable for use in later algorithms when
your algorithm is used as part of a model.

21.8.4 Comunicare con l’utente

If your algorithm takes a long time to process, it is a good idea to inform the user about the progress. You can use
feedback (QgsProcessingFeedback) for this.

The progress text and progressbar can be updated using two methods: setProgressText(text) and
setProgress(percent).

You can provide more information to the user using pushCommandInfo(text), pushDebugInfo(text),
pushInfo(text) and reportError(text).

If your script has a problem, the correct way of handling it is to raise a QgsProcessingException. You
can pass a message as an argument to the constructor of the exception. Processing will take care of handling it
and communicating with the user, depending on where the algorithm is being executed from (toolbox, modeler,
Python console, . . . )

21.8.5 Documenting your scripts

You can document your scripts by overloading the helpString() and helpUrl() methods of
QgsProcessingAlgorithm.
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21.8.6 Flags

You can override the flags method of QgsProcessingAlgorithm to tell QGIS more about your algorithm.
You can for instance tell QGIS that the script shall be hidden from the modeler, that it can be canceled, that it is
not thread safe, and more.

Suggerimento: By default, Processing runs algorithms in a separate thread in order to keep QGIS responsive
while the processing task runs. If your algorithm is regularly crashing, you are probably using API calls which
are not safe to do in a background thread. Try returning the QgsProcessingAlgorithm.FlagNoThreading flag from
your algorithm’s flags() method to force Processing to run your algorithm in the main thread instead.

21.8.7 Best practices for writing script algorithms

Here’s a quick summary of ideas to consider when creating your script algorithms and, especially, if you want
to share them with other QGIS users. Following these simple rules will ensure consistency across the different
Processing elements such as the toolbox, the modeler or the batch processing interface.

• Do not load resulting layers. Let Processing handle your results and load your layers if needed.

• Always declare the outputs your algorithm creates.

• Do not show message boxes or use any GUI element from the script. If you want to communi-
cate with the user, use the methods of the feedback object (QgsProcessingFeedback) or throw a
QgsProcessingException.

There are already many processing algorithms available in QGIS. You can find code on https://github.com/qgis/
QGIS/blob/release-3_4/python/plugins/processing/algs/qgis.

21.9 Configurazione di applicazioni esterne

The processing framework can be extended using additional applications. Currently, SAGA, GRASS, R, TauDEM
and LAStools are supported (and GDAL is shipped with QGIS). Algorithms that rely on external applications are
managed by their own algorithm providers. Additional providers can be found as separate plugins, and installed
using the QGIS Plugin Manager.

This section will show you how to configure the Processing framework to include these additional applications,
and it will explain some particular features of the algorithms based on them. Once you have correctly configured
the system, you will be able to execute external algorithms from any component like the toolbox or the graphical
modeler, just like you do with any other algorithm.

By default, algorithms that rely on an external application not shipped with QGIS are not enabled. You can enable
them in the Processing settings dialog if they are installed on your system.

21.9.1 Nota per gli utenti Windows

If you are not an advanced user and you are running QGIS on Windows, you might not be interested in reading
the rest of this chapter. Make sure you install QGIS in your system using the standalone installer. That will
automatically install SAGA and GRASS in your system and configure them so they can be run from QGIS. All
the algorithms from these providers will be ready to be run without needing any further configuration. If installing
with the OSGeo4W application, make sure that you also select SAGA and GRASS for installation.

21.9.2 Nota sui formati dei file

When using external software, opening a file in QGIS does not mean that it can be opened and processed in that
other software. In most cases, other software can read what you have opened in QGIS, but in some cases, that
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might not be true. When using databases or uncommon file formats, whether for raster or vector layers, problems
might arise. If that happens, try to use well-known file formats that you are sure are understood by both programs,
and check the console output (in the log panel) to find out what is going wrong.

You might for instance get trouble and not be able to complete your work if you call an external algorithm with a
GRASS raster layers as input. For this reason, such layers will not appear as available to algorithms.

You should, however, not have problems with vector layers, since QGIS automatically converts from the original
file format to one accepted by the external application before passing the layer to it. This adds extra processing
time, which might be significant for large layers, so do not be surprised if it takes more time to process a layer
from a DB connection than a layer from a Shapefile format dataset of similar size.

Providers not using external applications can process any layer that you can open in QGIS, since they open it for
analysis through QGIS.

All raster and vector output formats produced by QGIS can be used as input layers. Some providers do not support
certain formats, but all can export to common formats that can later be transformed by QGIS automatically. As
for input layers, if a conversion is needed, that might increase the processing time.

21.9.3 Nota sulla selezione di layer vettore

External applications may also be made aware of the selections that exist in vector layers within QGIS. However,
that requires rewriting all input vector layers, just as if they were originally in a format not supported by the
external application. Only when no selection exists, or the Use only selected features option is not enabled in the
processing general configuration, can a layer be directly passed to an external application.

In other cases, exporting only selected features is needed, which causes longer execution times.

21.9.4 SAGA

SAGA algorithms can be run from QGIS if you have SAGA installed and you configure the processing framework
to find SAGA executables. In particular, the SAGA command-line executable is needed to run SAGA algorithms.

If you are running Windows, both the stand-alone installer and the OSGeo4W installer include SAGA along with
QGIS, and the path is automatically configured, so there is no need to do anything else.

If you have installed SAGA yourself and your QGIS installer did not include it, the path to the SAGA executable
must be configured. To do this, open the configuration dialog. In the SAGA block, you will find a setting named
SAGA Folder. Enter the path to the folder where SAGA is installed. Close the configuration dialog, and now you
are ready to run SAGA algorithms from QGIS.

If you are running Linux, SAGA binaries are not included with Processing, so you have to download and install
the software yourself. Please check the SAGA website for more information.

In this case, there is no need to configure the path to the SAGA executable, and you will not see those folder entries.
Instead, you must make sure that SAGA is properly installed and its folder is added to the PATH environment
variable. Just open a console and type saga_cmd to check that the system can find where the SAGA binaries are
located.

Le limitazioni del sistema di griglia di SAGA

Most SAGA algorithms that require several input raster layers require them to have the same grid system. That is,
they must cover the same geographic area and have the same cell size, so their corresponding grids match. When
calling SAGA algorithms from QGIS, you can use any layer, regardless of its cell size and extent. When multiple
raster layers are used as input for a SAGA algorithm, QGIS resamples them to a common grid system and then
passes them to SAGA (unless the SAGA algorithm can operate with layers from different grid systems).

The definition of that common grid system is controlled by the user, and you will find several parameters in the
SAGA group of the settings window to do so. There are two ways of setting the target grid system:

• Setting it manually. You define the extent by setting the values of the following parameters:
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– Resampling min X

– Resampling max X

– Resampling min Y

– Resampling max Y

– Resampling cellsize

Notice that QGIS will resample input layers to that extent, even if they do not overlap with it.

• Setting it automatically from input layers. To select this option, just check the Use min covering grid system
for resampling option. All the other settings will be ignored and the minimum extent that covers all the
input layers will be used. The cell size of the target layer is the maximum of all cell sizes of the input layers.

Per gli algoritmi che non operano su molteplici layers o che non necessitano di un’unica griglia, non verrà operato
alcun campionamento.

Limitazioni per i raster multi-banda

Unlike QGIS, SAGA has no support for multi-band layers. If you want to use a multiband layer (such as an RGB or
multispectral image), you first have to split it into single-banded images. To do so, you can use the “SAGA/Grid
- Tools/Split RGB image” algorithm (which creates three images from an RGB image) or the “SAGA/Grid -
Tools/Extract band” algorithm (to extract a single band).

Limitations in cell size

SAGA assumes that raster layers have the same cell size in the X and Y axis. If you are working with a layer with
different values for horizontal and vertical cell size, you might get unexpected results. In this case, a warning will
be added to the processing log, indicating that an input layer might not be suitable to be processed by SAGA.

Registrazioni di controllo

When QGIS calls SAGA, it does so using its command-line interface, thus passing a set of commands to perform
all the required operations. SAGA shows its progress by writing information to the console, which includes the
percentage of processing already done, along with additional content. This output is filtered and used to update
the progress bar while the algorithm is running.

Both the commands sent by QGIS and the additional information printed by SAGA can be logged along with
other processing log messages, and you might find them useful to track what is going on when QGIS runs a
SAGA algorithm. You will find two settings, namely Log console output and Log execution commands, to activate
that logging mechanism.

Most other providers that use external applications and call them through the command-line have similar options,
so you will find them as well in other places in the processing settings list.

21.9.5 R scripts

To enable R in Processing you need to install the Processing R Provider plugin and configure R for QGIS.

Configuration is done in Provider-> R in the Processing tab of Settings-> Options.

Depending on your operating system, you may have to use R folder to specify where your R binaries are located.

Nota: On Windows the R executable file is normally in a folder (R-<version>) under C:\Program
Files\R\. Specify the folder and NOT the binary!

On Linux you just have to make sure that the R folder is in the PATH environment variable. If R in a terminal
window starts R, then you are ready to go.
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After installing the Processing R Provider plugin, you will find some example scripts in the Processing Toolbox:

• Scatterplot runs an R function that produces a scatter plot from two numerical fields of the provided vector
layer.

• test_sf does some operations that depend on the sf package and can be used to check if the R package
sf is installed. If the package is not installed, R will try to install it (and all the packages it depends on)
for you, using the Package repository specified in Provider-> R in the Processing options. The default is
http://cran.at.r-project.org/. Installing may take some time. . .

• test_sp can be used to check if the R package sp is installed. If the package is not installed, R will try to
install it for you.

If you have R configured correctly for QGIS, you should be able to run these scripts.

Adding R scripts from the QGIS collection

R integration in QGIS is different from that of SAGA in that there is not a predefined set of algorithms you can
run (except for some example script that come with the Processing R Provider plugin).

A set of example R scripts is available in the QGIS Repository. Perform the following steps to load and enable
them using the QGIS Resource Sharing plugin.

1. Add the QGIS Resource Sharing plugin (you may have to enable Show also experimental plugins in the
Plugin Manager Settings)

2. Open it (Plugins-> Resource Sharing-> Resource Sharing)

3. Choose the Settings tab

4. Click Reload repositories

5. Choose the All tab

6. Select QGIS R script collection in the list and click on the Install button

7. The collection should now be listed in the Installed tab

8. Close the plugin

9. Open the Processing Toolbox, and if everything is OK, the example scripts will be present under R, in
various groups (only some of the groups are expanded in the screenshot below).

The scripts at the top are the example scripts from the Processing R Provider plugin.

10. If, for some reason, the scripts are not available in the Processing Toolbox, you can try to:

(a) Open the Processing settings (Settings-> Options-> Processing tab)

(b) Go to Providers-> R-> R scripts folder

• On Ubuntu, set the path to (or, better, include in the path):

/home/<user>/.local/share/QGIS/QGIS3/profiles/default/resource_sharing/repositories/github.com/qgis/QGIS-
Resources/collections/rscripts

• On Windows, set the path to (or, better, include in the path):

C:Users<user>AppDataRoamingQGISQGIS3profilesdefaultresource_sharingrepositoriesgithub.comqgisQGIS-
Resourcescollectionsrscripts

To edit, double-click. You can then choose to just paste / type the path, or you can navigate to the
directory by using the . . . button and press the Add button in the dialog that opens. It is possible to
provide several directories here. They will be separated by a semicolon («;»).

If you would like to get all the R scrips from the QGIS 2 on-line collection, you can select QGIS R script collection
(from QGIS 2) instead of QGIS R script collection. You will find probably find that scripts that depend on vector
data input or output will not work.
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Figure 21.33: The Processing Toolbox with some R scripts shown
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Creating R scripts

You can write scripts and call R commands, as you would do from R. This section shows you the syntax for using
R commands in QGIS, and how to use QGIS objects (layers, tables) in them.

To add an algorithm that calls an R function (or a more complex R script that you have developed and you would
like to have available from QGIS), you have to create a script file that performs the R commands.

R script files have the extension .rsx, and creating them is pretty easy if you just have a basic knowledge of R
syntax and R scripting. They should be stored in the R scripts folder. You can specify the folder (R scripts folder)
in the R settings group in Processing settings dialog).

Let’s have a look at a very simple script file, which calls the R method spsample to create a random grid within
the boundary of the polygons in a given polygon layer. This method belongs to the maptools package. Since
almost all the algorithms that you might like to incorporate into QGIS will use or generate spatial data, knowledge
of spatial packages like maptools and sp/sf, is necessary.

##polyg=vector
##numpoints=number 10
##output=output vector
##sp=group
pts=spsample(polyg,numpoints,type="random")
output=SpatialPointsDataFrame(pts, as.data.frame(pts))

The first lines, which start with a double Python comment sign (##), tell QGIS about the inputs of the algorithm
in the file and the outputs that it will generate.

Nota: To find out more about how to write your own R scripts, have a look at the R Intro and the R Syntax
Training Manual Chapters.

When you declare an input parameter, QGIS uses that information for two things: creating the user interface to
ask the user for the value of that parameter, and creating a corresponding R variable that can later be used as R
function input.

In the above example, we have declared an input of type vector, named polyg. When executing the algorithm,
QGIS will open the layer selected by the user and store it in a variable named polyg. So, the name of a parameter
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is the name of the variable that we can use in R for accessing the value of that parameter (you should therefore
avoid using reserved R words as parameter names).

Spatial parameters such as vector and raster layers are read using the readOGR() and brick() commands (you
do not have to worry about adding those commands to your description file – QGIS will do it), and they are stored
as Spatial*DataFrame objects. Table fields are stored as strings containing the name of the selected field.

Tables are opened using the read.csv() command. If a table entered by the user is not in CSV format, it will
be converted prior to importing it into R.

Raster files can be read using the readGDAL() command instead of brick() by specifying
##usereadgdal.

If you are an advanced user and do not want QGIS to create the object representing the layer, you can use
##passfilenames to indicate that you prefer a string with the filename instead. In this case, it is up to
you to open the file before performing any operation on the data it contains.

With the above information, we can now understand the first line of this script (the first line not starting with a
Python comment).

pts=spsample(polyg,numpoints,type="random")

The variable polyg already contains a SpatialPolygonsDataFrame object, so it can be used when calling
the spsample method, just like the numpoints one, which specifies the number of points to add to the created
sample grid.

Since we have declared a vector output named out, we have to create a variable named out and store a
Spatial*DataFrame object in it (in this case, a SpatialPointsDataFrame). You can use any name
for your intermediate variables. Just make sure that the variable storing your final result has the same name that
you used to declare it, and that it contains a suitable value.

In this case, the result obtained from the spsample method has to be converted explicitly into a
SpatialPointsDataFrame object, since it is itself an object of class ppp, which can not be returned to
QGIS.

If your algorithm generates raster layers, the way they are saved will depend on whether or not you have used the
##dontuserasterpackage option. If you have used it, layers are saved using the writeGDAL() method.
If not, the writeRaster() method from the raster package will be used.

If you have used the ##passfilenames option, outputs are generated using the raster package (with
writeRaster()).

If your algorithm does not generate a layer, but a text result in the console instead, you have to indicate that you
want the console to be shown once the execution is finished. To do so, just start the command lines that produce
the results you want to print with the > (“greater”) sign. The output of all other lines will not be shown. For
instance, here is the description file of an algorithm that performs a normality test on a given field (column) of the
attributes of a vector layer:

##layer=vector
##field=field layer
##nortest=group
library(nortest)
>lillie.test(layer[[field]])

The output of the last line is printed, but the output of the first is not (and neither are the outputs from other
command lines added automatically by QGIS).

Se il vostro algoritmo produce qualche tipo di risultato grafico (usando la funzione plot()) dovete aggiungere
la linea seguente:

##showplots

This will cause QGIS to redirect all R graphical outputs to a temporary file, which will be opened once R execution
has finished.
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Sia i risultati grafici che quelli da console saranno mostrati nel gestore risultati di processing.

For more information, please check the script files provided with Processing. Most of them are rather simple and
will greatly help you understand how to create your own scripts.

Nota: The rgdal and raster libraries are loaded by default, so you do not have to add the correspond-
ing library() commands (you just have to make sure that those two packages are installed in your R dis-
tribution). However, other additional libraries that you might need have to be explicitly loaded by typing:
library(ggplot2) (to load the ggplot2 library). If the package is not already installed on your machine,
Processing will download and install it. In this way the package will be also available in R Standalone. Be aware
that if the package has to be downloaded, the first time you run the script it might take a long time.

21.9.6 R libraries

The R script sp_test tries to load the R packages sp and raster.

R libraries installed when running sf_test

The R script sf_test tries to load sf and raster. If these two packages are not installed, R may try to load and
install them.

The following R libraries end up in ~/.local/share/QGIS/QGIS3/profiles/default/
processing/rscripts after sf_test has been run from the Processing Toolbox on Ubuntu with
version 2.0 of the Processing R Provider plugin and R 3.4.4 (apt package r-base-core only):

abind, askpass, assertthat, backports, base64enc, BH, bit, bit64, blob,
brew, callr, classInt, cli, colorspace, covr, crayon, crosstalk, curl,
DBI, deldir, desc, dichromat, digest, dplyr, e1071, ellipsis, evaluate,
fansi, farver, fastmap, gdtools, ggplot2, glue, goftest, gridExtra,
gtable, highr, hms, htmltools, htmlwidgets, httpuv, httr, jsonlite, knitr,
labeling, later, lazyeval, leafem, leaflet, leaflet.providers, leafpop,
leafsync, lifecycle, lwgeom, magrittr, maps, mapview, markdown, memoise,
microbenchmark, mime, munsell, odbc, openssl, pillar, pkgbuild, pkgconfig,
pkgload, plogr, plyr, png, polyclip, praise, prettyunits, processx,
promises, ps, purrr, R6, raster, RColorBrewer, Rcpp, reshape2, rex, rgeos,
rlang, rmarkdown, RPostgres, RPostgreSQL, rprojroot, RSQLite, rstudioapi,
satellite, scales, sf, shiny, sourcetools, sp, spatstat, spatstat.data,
spatstat.utils, stars, stringi, stringr, svglite, sys, systemfonts, tensor,
testthat, tibble, tidyselect, tinytex, units, utf8, uuid, vctrs, viridis,
viridisLite, webshot, withr, xfun, XML, xtable

21.9.7 GRASS

Configuring GRASS is not much different from configuring SAGA. First, the path to the GRASS folder has to be
defined, but only if you are running Windows.

By default, the Processing framework tries to configure its GRASS connector to use the GRASS distribution that
ships along with QGIS. This should work without problems for most systems, but if you experience problems, you
might have to configure the GRASS connector manually. Also, if you want to use a different GRASS installation,
you can change the setting to point to the folder where the other version is installed. GRASS 7 is needed for
algorithms to work correctly.

If you are running Linux, you just have to make sure that GRASS is correctly installed, and that it can be run
without problem from a terminal window.

GRASS algorithms use a region for calculations. This region can be defined manually using values similar to
the ones found in the SAGA configuration, or automatically, taking the minimum extent that covers all the input
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layers used to execute the algorithm each time. If the latter approach is the behavior you prefer, just check the Use
min covering region option in the GRASS configuration parameters.

21.9.8 LAStools

To use LAStools in QGIS, you need to download and install LAStools on your computer and install the LAStools
plugin (available from the official repository) in QGIS.

On Linux platforms, you will need Wine to be able to run some of the tools.

LAStools is activated and configured in the Processing options (Settings → Options, Processing tab, Providers→
LAStools), where you can specify the location of LAStools (LAStools folder) and Wine (Wine folder). On Ubuntu,
the default Wine folder is /usr/bin.
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CHAPTER 22

Plugin

22.1 Plugin di QGIS

QGIS è stato progettato con un’architettura a plugin. Questo permette di poter aggiungere numerosi nuovi elementi
e funzioni all’applicazione. Molte delle funzioni di QGIS sono attualmente implementate come plugin.

22.1.1 Plugin di Base e Plugin Esterni

I plugins di QGIS sono implementati come Plugin di Base o come Plugin Esterni.

Core Plugins sono mantenuti dal team di sviluppo di QGIS e fanno automaticamente parte di ogni distribuzione
QGIS. Sono scritti in uno dei due seguenti linguaggi: C++ o Python.

La maggior parte dei plugin esterni sono attualmente scritti in Python. Sono memorizzati sia nel Repository
“Ufficiale” QGIS all’indirizzo https://plugins.qgis.org/plugins/ o in repository esterni e sono gestiti dai singoli
autori. Una documentazione dettagliata sull’uso, la versione minima di QGIS, la home page, gli autori e altre
informazioni importanti sono fornite per i plugin nel repository ufficiale. Per gli altri repository esterni, la doc-
umentazione potrebbe essere disponibile con i plugin esterni stessi. La documentazione dei plugin esterni non è
inclusa in questo manuale.

Per installare o attivare un plugin, andare nel menu Plugins e selezionare Gestire e installa plugin. . . .. I plugin
esterni installati sono posizionati nella cartella python/plugins del path user profile.

Percorsi per librerie Personalizzate di plugin in C++ possono essere aggiunti in Impostazioni → Opzioni → Sis-
tema.

Nota: Secondo le impostazioni fatte in plugin manager settings, l’interfaccia principale di QGIS può visualizzare
un’icona a destra della barra di stato per informarti che ci sono aggiornamenti per i tuoi plugin installati o per nuovi
plugin disponibili.

22.1.2 La finestra di dialogo Plugins

Le schede della finestra di dialogo dei Plugin consentono all’utente di installare, disinstallare e aggiornare i plugin
in diversi modi. Ogni plugin ha alcuni metadati visualizzati nel pannello di destra:
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• informazione se il plugin è in stato sperimentale

• descrizione

• voto(i) di valutazione (puoi valutare per il tuo plugin preferito!)

• etichette

• alcuni utili links come la home page, categoria e versione e repository in cui è disponibile

• autore(i)

• versione disponibile

Nella parte superiore della finestra di dialogo, una funzione Cerca ti aiuta a trovare qualsiasi plugin cutilizzando

le informazioni sui metadati (autore, nome, descrizione. . . .). È disponibile in quasi tutte le schede (eccetto
Impostazioni).

La scheda Impostazioni

La scheda Impostazioni è il luogo principale in cui puoi configurare quali plugin possono essere visualizzati
nella tua applicazione. Puoi utilizzare le seguenti opzioni:

• Controlla aggiornamenti all’avvio. Ogni qualvolta è disponibile un nuovo plugin o è aggiornato un
plugin, QGIS ti informa ‘ogni volta che QGIS parte’, ‘una volta al giorno’, ‘ogni 3 giorni’, ‘ogni settimana’,
‘ogni 2 settimane’ o ‘ogni mese’.

• Mostra anche plugins sperimentali. QGIS ti mostrerà i plugin in fase di sviluppo che generalmente non
sono adatti per un uso di produzione.

• Mostra anche plugins obsoleti. Poiché utilizzano funzioni che non sono più disponibili in QGIS, questi
plugin sono deprecati e generalmente non idonei per l’uso di produzione. Appaiono nell’elenco dei plugin
non validi.

Per impostazione predefinita, QGIS fornisce il suo repository ufficiale dei plugin con l’URL https://plugins.qgis.
org/plugins/plugins.xml?qgis=3.0 (nel caso di QGIS 3.0) nella sezione Repository dei plugin. Per aggiungere
repository di autori esterni, clicca su Aggiungi. . . e compila il modulo Dettagli repository con un nome e l’URL.
L’URL può essere con protocollo del tipo http:// o file://.

Il repository QGIS predefinito è un repository aperto e non è necessaria alcuna autenticazione per accedervi. Puoi
tuttavia accedere ad altri repository di plugin tramite eventuali richiedeste di autenticazione (autenticazione di
base, PKI). Puoi ottenere ulteriori informazioni sul supporto dell’autenticazione QGIS nel capitolo Autenticazione.

Se non vuoi più uno o più repository aggiunti, puoi disattivarli nella scheda Impostazioni tramite il pulsante
Modifica. . . ., oppure rimuoverli completamente con il pulsante Elimina.

La scheda Tutti

Nella scheda Tutto, sono elencati tutti i plugin disponibili, compresi sia i plugin core che esterni. Usa Aggiorna
tutto per cercare nuove versioni dei plugin. Inoltre, puoi utilizzare Installa plugin se un plugin è elencato ma
non installato, Disinstalla Plugin se un plugin è installato e Reinstalla Plugin. Un plugin installato può essere
temporaneamente disattivato utilizzando la casella di controllo.

La scheda Installati

Nella scheda Installati, troverai elencati i plugin Core, che non è possibile disinstallare. Puoi estendere questa
lista con plugin esterni che possono essere disinstallati e reinstallati in qualsiasi momento, usando i pulsanti
Disinstalla Plugin e Reinstalla Plugin. Qui puoi anche fare Aggiorna tutto.
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Figure 22.1: La scheda Impostazioni

Figure 22.2: La scheda Tutto
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Figure 22.3: La scheda Installato

La scheda Non installati

La scheda Non installati elenca tutti i plugin disponibili che non sono installati. Puoi usare il pulsante Installa
Plugin per implementare un plugin in QGIS.

Le schede Aggiornabile e Nuovo

Le schede Aggiornabili e Nuovi sono abilitate quando nuovi plugin vengono aggiunti al repository oppure

viene rilasciata una nuova versione di un plugin installato. Se hai attivato Mostra anche plugins sperimentali

nel menu Impostazioni, anche questi saranno visualizzati nella lista offrendo l’opportunità di testare in anticipo
gli strumenti in arrivo.

L’installazione può essere effettuata con i pulsanti Installa plugin, Aggiorna plugin o Aggiorna tutti.

La scheda Non valido

La scheda Non validi elenca tutti i plugins che per qualche ragione non sono attualmente funzionanti (errori
nei collegamenti, errori durante il caricamento, funzioni incompatibili con la versione di QGIS attiva. . . ). Puoi
provare con il pulsante Reinstalla Plugin per correggere un plugin non valido, ma la maggior parte delle volte la
correzione sarà altrove (si potrebbe dover installare alcune librerie, cercare un altro plugin compatibile o provare
a rimuovere le cause del mancato funzionamento).

La scheda Installa da ZIP

La scheda Installa da ZIP fornisce un widget per la scelta dei file da importare come plugin in formato zippato,
ad esempio i plugin scaricati direttamente dal loro repository.
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Figure 22.4: La scheda Non installato

Figure 22.5: La scheda Aggiornabili
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Figure 22.6: La scheda Non valido

Figure 22.7: La scheda Installa da ZIP
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22.2 Uso dei plugin di base di QGIS

22.2.1 Plugin Cattura Coordinate

Il plugin Cattura Coordinate è facile da usare e ti permette di mostrare sulla mappa coordinate in due sistemi di
riferimento (SR) distinti.

Figure 22.8: Plugin Cattura Coordinate

1. Avvia QGIS, seleziona Proprietà. . . . dal menu Progetto e clicca sulla scheda SR. In alternativa, puoi anche

fare clic sull’icona SR nell’angolo in basso a destra della barra di stato.

2. Attiva Abilita la riproiezione al volo e seleziona un sistema di coordinate proiettate a scelta (vedi anche
Lavorare con le proiezioni).

3. Attiva il plugin per la cattura delle coordinate nel Gestore Plugin(vedi management_plugins) e assicurati

che la finestra di dialogo sia visibile andando in Visualizza → Panelli verificando che Cattura coordi-
nate sia abilitato. La finestra di dialogo per la cattura delle coordinate appare come mostrato nella figura
figure_coordinate_cattura. In alternativa, è anche possibile verificare in :menu selection:Vettore –> Cattura
coordinate.

4. Clicca su Clicca per selezionare il SR da usare per la visualizzazione delle coordinate e seleziona un SR diverso da quello
selezionato precedentemente.

5. Per iniziare a catturare le coordinate, fai clic su Avvia la cattura. Ora puoi fare clic in qualsiasi punto della
mappa e il plugin mostrerà le coordinate per i tuoi SR selezionati.

6. Per abilitare la tracciatura via mouse delle coordinate seleziona l’icona
Clicca per abilitare la tracciatura via mouse. Clicca sula mappa per terminare.

7. Puoi anche copiare le coordinate selezionate negli appunti.

22.2.2 Plugin DB Manager

The DB Manager Plugin is intended to be the main tool to integrate and manage spatial database formats sup-

ported by QGIS (PostGIS, SpatiaLite, GeoPackage, Oracle Spatial, Virtual layers) in one user interface. The
DB Manager Plugin provides several features. You can drag layers from the QGIS Browser into the DB Manager, and
it will import your layer into your spatial database. You can drag and drop tables between spatial databases and
they will get imported.

The Database menu allows you to connect to an existing database, to start the SQL window and to exit the DB
Manager Plugin. Once you are connected to an existing database, the menus Schema (relevant for DBMSs, such
as PostGIS / PostgreSQL) and Table will appear.

The Schema menu includes tools to create and delete (only if empty) schemas and, if topology is available (e.g.
with PostGIS topology), to start a TopoViewer.

The Table menu allows you to create and edit tables and to delete tables and views. It is also possible to empty
tables and to move tables between schemas. You can Run Vacuum Analyze for the selected table. Vacuum reclaims
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Figure 22.9: La finestra di dialogo DB Manager
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space and makes it available for reuse, and analyze updates statistics that is used to determine the most efficient
way to execute a query. Change Logging. . . allows you to add change logging support to a table. Finally, you can
Import Layer/File. . . and Export to File. . . .

The Providers window lists all existing databases supported by QGIS. With a double-click, you can connect to the
database. With the right mouse button, you can rename and delete existing schemas and tables. Tables can also be
added to the QGIS canvas with the context menu.

If connected to a database, the main window of the DB Manager offers four tabs. The Info tab provides infor-
mation about the table and its geometry, as well as about existing fields, constraints and indexes. It allows you
to create a spatial index on a the selected table. The Table tab shows the table, and the Preview tab renders the
geometries as preview. When you open an SQL Window, it will be placed in a new tab.

Lavorare con la Finestra SQL

You can use the DB Manager to execute SQL queries against your spatial database. Queries can be saved and
loaded, and there the SQL Query Builder will help you formulate your queries. You can even view spatial output
by checking Load as new layer and specifying Column(s) with unique values (IDs), Geometry column and Layer
name (prefix). It is possible to highlight a portion of the SQL to only execute that portion when pressing Ctrl+R
or clicking the Execute button.

Figure 22.10: Eseguire SQL nella finestra di dialogo SQL DB Manager

Nota: La finestra SQL può anche essere utilizzata per creare Layers Virtuali. In questo caso, invece di selezionare
un database, seleziona QGIS Layers sotto Virtual Layers prima di aprire la finestra SQL. Per istruzioni sulla
sintassi SQL da utilizzare vedi Creazione di layer virtuali.
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22.2.3 Plugin eVis

(Questa sezione è presa da Horning, N., K. Koy, P. Ersts. 2009. eVis (v 1.1.0) Manuale dell’utente
Museo Americano di Storia Naturale, Centro per la Biodiversità e la Conservazione. Disponibile in http:
//biodiversityinformatics.amnh.org/ , e rilasciato sotto la GNU FDL).

Il Centro per la Biodiversità e la Conservazione (Center for Biodiversity and Conservation - CBC) presso il Museo
Americano di Storia Naturale (American Museum of Natural History’s - AMNH) ha sviluppato lo strumento
Event Visualization Tool (eVis), un altro strumento software aggiunto alla suite di strumenti di monitoraggio e
di supporto decisionale per la conservazione e guida dell’area protetta e del piano paesaggistico. Questo plugin
consente agli utenti di collegare facilmente dati geocodificati (ad esempio, con latitudine e longitudine o X e Y
Coordinate) quali fotografie e altri documenti di supporto ai dati vettoriali in QGIS.

eVis è ora automaticamente installato e abilitato nelle nuove versioni di QGIS, e come tutti i plugin, può essere
disattivato e abilitato utilizzando il Plugin Manager (vedi La finestra di dialogo Plugins).

Il plugin consta di tre moduli: “Connessione Database”, “ID evento”, “Browser evento”. Questi funzionano in-
sieme per consentire la visualizzazione di fotografie geocodificate e altri documenti collegati a oggetti memorizzati
file vettoriali, database o fogli di calcolo.

Browser evento

Il modulo “Sfoglia Evento” fornisce la funzionalità per visualizzare le fotografie geocodificate collegate alle ge-
ometrie vettoriali visualizzate nella finestra della mappa di QGIS. I dati dei punti, ad esempio, possono provenire
da un file vettoriale che può essere inserito utilizzando QGIS o può derivare dal risultato di una query al database.
La geometria vettoriale deve contenere le informazioni sugli attributi ad essa associati per descrivere la posizione
e il nome del file contenente la fotografia e, facoltativamente, la direzione della bussola a cui è stata puntata la
fotocamera quando è stata acquisita l’immagine. Il tuo layer vettoriale deve essere caricato in QGIS prima di
eseguire Sfoglia Evento.

Aprire il modulo Browser evento

Per avviare il modulo Sfoglia Evento, fai click su Database → eVis → Sfoglia evento eVis. Si aprirà la finestra
Browser Evento

La finestra Browser evento ha tre schede visualizzate nella parte superiore della finestra. La scheda Visualizza è
usata per visualizzare la fotografia e i suoi dati di attributo associati. La scheda Opzioni fornisce un numero di
impostazioni che possono essere regolate per controllare il comportamento del plugin eVis. Infine, la scheda Con-
figura Applicazioni Esterne serve per mantenere una tabella delle estensioni dei file e le loro associate applicazioni
per consentire a eVis di visualizzare documenti diversi dalle immagini.

Finestra Visualizza

Per visualizzare la finestra Visualizza, fai click sulla scheda Visualizza nella finestra Browser Evento. La finestra
Visualizza è usata per visualizzare le fotografie geocodificate e i relativi dati attributo.

1. Area di visualizzazione dell’immagine: un riquadro in cui sarà mostrata l’immagine.

2. Pulsante Zoom in: Ingrandisce per mostrare maggiori dettagli. Se l’intera immagine non può essere visu-
alizzata nella finestra di visualizzazione, appariranno barre di scorrimento sul lato sinistro e inferiore della
finestra per consentire di far scorrere l’immagine.

3. Rimpicciolisci: rimpicciolisce per vedere più parti dell’immagine.

4. Zoom completo: visualizza tutta l’immagine.

5. Finestra degli attributi: qui vengono visualizzate tutte le informazioni sugli attributi per il punto associato
alla fotografia visualizzata. Se il tipo di file a cui si fa riferimento nel record visualizzato non è un’immagine
ma è di un tipo di file definito in Configura applicazioni esterne, facendo doppio clic sul valore del campo
contenente il percorso del file, verrà avviata l’applicazione per aprire il file da visualizzare o ascoltare il
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Figure 22.11: La finestra di dialogo eVis
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contenuto del file. Se l’estensione del file viene riconosciuta, i dati dell’attributo verranno visualizzati in
verde.

6. Pulsanti per la navigazione: utilizzare i pulsanti Precedente e Successivo per caricare l’oggetto precedente
o successivo quando è selezionato più di un oggetto.

Finestra Opzioni

Figure 22.12: Opzioni della finestra di dialogo eVis

1. Percorso file: elenco a discesa per specificare l’attributo campo contenente il percorso o l’URL della di-
rectory per le fotografie o altri documenti visualizzati. Se la posizione è un percorso relativo, la casella di
controllo deve essere attivata. Il percorso di base per un percorso relativo può essere immesso nella casella
di testo Percorso base sottostante. Informazioni sulle diverse opzioni per specificare la posizione del le sono
indicate in basso nella sezione Specificare la localizzazione ed il nome di una foto

2. Orientamento bussola: un elenco a discesa per specificare il campo dell’attributo che contiene
l’orientamento della bussola associato alla fotografia visualizzata. Se sono disponibili informazioni sulla
bussola, è necessario fare clic sulla casella di controllo sotto il titolo del menu a discesa.

3. Offset bussola: gi offset della bussola possono essere utilizzati per compensare la declinazione (per regolare

l’orientamento magnetico all’orientamento del nord effettivo). Fai click sul pulsante radio Manuale

per immettere l’offset nella casella di testo o fai click sul pulsante radio Da Attributo per selezionare
il campo attributo contenente gli offset. Per entrambe queste opzioni, le declinazioni est devono essere
immesse usando valori positivi e le declinazioni ovest dovrebbero utilizzare valori negativi.

4. Percorso base della cartella: il percorso base su cui verrà associato il percorso relativo definito in Fig-
ure_eVis_options (A).
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5. Sostituisci percorso: se è selezionata questa casella di controllo, solo il nome di file in A verrà aggiunto al
percorso base.

6. Applica regola a tutti i documenti: se selezionato, le stesse regole di percorso definite per le fotografie
verranno utilizzate per documenti non di immagine, ad esempio filmati, documenti di testo e file audio. Se
non è selezionato, le regole del percorso si applicano solo alle fotografie e gli altri documenti ignoreranno
il parametro del percorso base.

7. Ricorda le impostazioni: Se la casella di controllo è selezionata, i valori dei parametri associati saranno
salvati per la sessione successiva quando la finestra viene chiusa o quando viene premuto il pulsante Salva
in basso.

8. Ripristina: Ripristina i valori di questa riga all’impostazione predefinita.

9. Ripristina le impostazioni predefinite: Tutti i campi verranno ripristinati alle impostazioni predefinite. Ha
lo stesso effetto di fare clic su tutti i pulsanti Ripristina.

10. Salva: salva le impostazioni senza chiudere la scheda Opzioni.

Configurazione applicazioni esterne

Figure 22.13: La finestra Applicazioni Esterne di eVis

1. Tabella riferimento file: una tabella contenente i vari tipi di file utilizzati da eVis. Ogni tipo file necessita
di un’estensione e di un percorso all’applicazione in grado di gestirlo. Ciò permette di aprire diversi tipi di
file come filmati, suoni e documenti testuali, oltre che solo immagini.

2. Aggiungi nuovo tipo file: aggiunge un nuovo tipo di file con una univoca estensione e il percorso
dell’applicazione che può aprire il file.

3. Elimina riga corrente: elimina il tipo di file selezionato in tabellae definito da un’estensione di file e da un
percorso ad un’applicazione associata.

Specificare la localizzazione ed il nome di una foto

La posizione e il nome della fotografia possono essere memorizzati utilizzando un percorso assoluto o relativo, o
un URL se la fotografia è disponibile su un server web. Esempi dei diversi approcci sono elencati nella tabella
evis_examples.

X Y FILE BEARING
780596 1784017 C:\Workshop\eVis_Data\groundphotos\DSC_0168.JPG 275
780596 1784017 /groundphotos/DSC_0169.JPG 80
780819 1784015 https://biodiversityinformatics.amnh.org/\

evis_testdata/DSC_0170.JPG 10
780596 1784017 pdf:https://www.testsite.com/attachments.php?\

attachment_id-12 76
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Specificare la localizzazione ed il nome di altri documenti

Anche i documenti di supporto come documenti di testo, video e clip audio possono essere visualizzati o riprodotti
da eVis. Per fare ciò, è necessario aggiungere una voce nella tabella di riferimento dei file a cui è possibile accedere
dalla finestra Configura applicazioni esterne in Browser eventi generici che corrisponde all’estensione del file a
un’applicazione che può essere usato per aprire il file. È inoltre necessario avere il percorso o l’URL del file nella
tabella degli attributi per il layer vettoriale. Una regola aggiuntiva che può essere utilizzata per gli URL che non
contengono un’estensione di file per il documento che si desidera aprire è specificare l’estensione del file prima
dell’URL. Il formato è — file extension:URL. L’URL è preceduto dall’estensione del file e da due punti;
questo è particolarmente utile per accedere ai documenti da wiki e altri siti Web che utilizzano un database per
gestire le pagine Web (vedi Tabella evis_examples).

Usare Browser evento

Quando si apre la finestra Browser eventi”, una fotografia apparirà nella finestra di visualizzazione se il docu-
mento a cui si fa riferimento nella tabella degli attributi del file vettoriale è un’immagine e se le informazioni sulla
posizione del file nella finestra :guilabel:‘Opzioni sono correttamente impostate. Se è prevista una fotografia e
non appare, sarà necessario regolare i parametri nella finestra Opzioni.

Se nella tabella degli attributi viene fatto riferimento a un documento (o a un’immagine che non ha un’estensione
di file riconosciuta da eVis), il campo contenente il percorso del file sarà evidenziato in verde nella finestra delle
informazioni sugli attributi se tale estensione di file è definita nel tabella di riferimento dei file situata nella finestra
Configura le applicazioni esterne. Per aprire il documento, fare doppio clic sulla linea evidenziata in verde nella
finestra delle informazioni sugli attributi. Se viene fatto riferimento a un documento nella finestra delle infor-
mazioni sugli attributi e il percorso del file non è evidenziato in verde, sarà necessario aggiungere una voce per
l’estensione del file nel file Configura le applicazioni esterne. Se il percorso del file è evidenziato in verde ma
non si apre quando si fa doppio clic, sarà necessario regolare i parametri nella finestra Opzioni in modo che il file
possa essere localizzato da eVis.

Se non si è specificato l’orientamento della fotocamera nella finestra Opzioni, compare un asterisco rosso sul
vettore associato alla fotografia. Se l’orientamento è specificato, allora comparirà una freccia che punterà nella
direzione indicata nella finestra Browser evento. La freccia sarà centrata sul punto associato con la fotografia o
con un altro documento.

Per chiudere la finestra Browser evento, clicca sul pulsante Chiudi nella finestra Visualizza.

Strumento ID evento

Il modulo “ID evento” ti permette di visualizzare una foto cliccando su un elemento nella vista mappa di QGIS.
L’elemento vettoriale deve avere associati le informazioni di attributo contenenti la localizzazione ed il nome del
le della foto e, eventualmente, la direzione della bussola della fotocamera quando l’immagine è stata acquisita.
Questo layer deve essere caricato in QGIS prima di aprire lo strumento “ID evento”.

Aprire il modulo Browser evento

Per avviare il modulo “ID evento”, fai click sull’icona ID evento o fai click su Database -> eVis -> Strumento ID
evento. Ciò farà sì che il cursore si trasformi in una freccia con una “i” sopra di esso a significare che lo strumento
ID è attivo.

Per visualizzare le fotografie collegate alle geometrie vettoriali presenti nel livello vettoriale attivo visualizzato
nella finestra della mappa QGIS, sposta il cursore ID evento sulla geometria e quindi fai click con il mouse. Dopo
aver cliccato sulla funzione, si apre la finestra Browser evento e le fotografie sulla località cliccata o nelle vicinanze
sono disponibili per la visualizzazione nel browser. Se è disponibile più di una fotografia, puoi scorrere i diversi
elementi utilizzando i pulsanti Precedente e Successivo. Altre opzioni di controllo sono presenti nella sezione
Browser evento di questa guida.
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Connessione database

Il modulo “Connessione Database” permette di connettersi ed interrogare un database o altre risorse ODBC, es.
un foglio di calcolo.

eVis può connettersi direttamente alle seguenti tipologie di database: PostgreSQL, MySQL, SQLITE; può leggere
dati da connessioni ODBC (ad esempio MS Access): in tal caso è necessario configurare il driver ODBC (come
ad esempio un foglio Excel) per il sistema operativo che stai usando.

Aprire il modulo Connessione Database

Per avviare il modulo “Connessione Database”, fai click sull’apposita icona Connessione a database eVis o fai clic su
Database -> eVis -> Connessione database. Questo lancerà la finestra Connessione Database. La finestra ha tre
schede: Query predefinite, Connessione Database e SQL Query. La finestra Console di output nella parte inferiore
della finestra mostra lo stato delle azioni avviate dalle diverse sezioni di questo modulo.

Connessione Database

Fai click sulla scheda Connessione Database per aprire l’interfaccia di connessione al database. Quindi, utilizza

Tipo database casella combinata per selezionare il tipo di database a cui ti vuoi connettere. Se è richiesta
una password o un nome utente, tali informazioni possono essere inserite nelle caselle di testo Nome utente e
Password.

Inserire il server del database in Host Database. Questa opzione non è disponibile se hai scelto “MSAccess” come
tipo di database. Se il database si trova sul tuo desktop, allora dovrai inserire «localhost».

Immetti il nome del database nella casella di testo Nome database. Se hai selezionato “ODBC” come tipo di
database, devi specificare il nome dell’origine dati.

Quando tutti i parametri sono stati compilati, fai clic sul pulsante Connetti. Se la connessione ha successo, nella
finestra Output Console verrà scritto un messaggio che indica che la connessione è stata stabilita. Se non è stata
stabilita una connessione, è necessario verificare che siano stati inseriti parametri corretti.

1. Tipo di Database: una lista a discesa per specificare il tipo di database che sarà utilizzato.

2. Host Database: nome host del database.

3. Porta: il numero di porta se il tipo di database selezionato è MYSQL o PostgreSQL.

4. Nome Database: il nome del database.

5. Connetti: un pulsante per connettersi al database utilizzando i parametri sopra definiti.

6. Console di Output: la finestra console dove vengono visualizzati i messaggi relativi alla connessione.

7. Nome utente: nome utente in caso di database protetto.

8. Password: password in caso di database protetto.

9. Query Predefinite: scheda “Query Predefinite”.

10. Connessione Database: scheda “Connessione Database”.

11. Query SQL: scheda “Query SQL”.

12. Help: mostra la guida in linea.

13. OK: chiude Connessione Database .
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Figure 22.14: La finestra connessione Database di eVis

Eseguire query SQL

Le query SQL sono utilizzate per estrarre informazioni da un database o da una risorsa ODBC. In eVis, l’output
di queste query è un layer vettoriale aggiunto alla finestra della mappa QGIS. Fai clic sulla scheda Query SQL
per visualizzare l’interfaccia delle query SQL. I comandi SQL possono essere inseriti in questa finestra di testo.
Un utile tutorial sui comandi SQL è disponibile all’indirizzo https://www.w3schools.com/sql. Per esempio, per
estrarre tutti i dati da un foglio di lavoro in un file Excel, select * from [sheet1$] dove sheet1 è il
nome del foglio di lavoro.

Fai clic sul pulsante Esegui Query per eseguire il comando. Se la query ha esito positivo, viene visualizzata
la finestra Scegli file database. Se la query non ha esito positivo, nella finestra Console di output apparirà un
messaggio di errore.

Nella finestra Scegli file Database assegnare un nome al nuovo layer che verrà creato dai risultati della query nella
casella di testo Nome del nuovo layer.

1. Query SQL: è il riquadro per inserire le query SQL.

2. Esegui Query: pulsante per mandare in esecuzione la query inserita in Query SQL.

3. Console di Output: la finestra della console dove vengono visualizzati i messaggi relativi alla connessione.

4. Help: mostra la guida in linea.

5. OK: chiude Connessione Database.

Usa le caselle combinate X Coordinate e Y Coordinate per selezionare i campi del database che
memorizza le coordinate X (o longitudine) e Y` (o latitudine). Cliccando sul pulsante OK il layer vettoriale creato
dalla query SQL viene visualizzato nella finestra della mappa QGIS.

Per salvare questo file vettoriale per uso futuro, puoi utilizzare il comando “Salva come . . . ” di QGIS a cui si
accede facendo click con il tasto destro del mouse sul nome del layer nella legenda della mappa QGIS e quindi
selezionando “Salva come . . . ”
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Figure 22.15: La scheda query SQL di eVis

Suggerimento: Creare un layer vettoriale da un foglio di lavoro Microsoft Excel

Quando crei un layer vettoriale da un foglio di lavoro di Microsoft Excel, puoi vedere che sono stati inseriti
zeri indesiderati («0») nelle righe della tabella degli attributi al di sotto dei dati validi. Ciò può essere causato
dall’eliminazione dei valori per queste celle in Excel utilizzando la chiave Backspace. Per correggere questo
problema, devi aprire il file Excel (devi chiudere QGIS se sei connesso al file, per permetterti di modificare il
file) e quindi usare Modifica -> Elimina per rimuovere le righe vuote dal file. Per evitare questo problema, puoi
semplicemente cancellare diverse righe nel foglio di lavoro di Excel usando Modifica -> Elimina prima di salvare
il file.

Eseguire query predefinite

Con le query predefinite, puoi selezionare query scritte in precedenza memorizzate in formato XML in un file.
Ciò è particolarmente utile se non hai familiarità con i comandi SQL. Fai clic sulla scheda Query predefinite per
visualizzare l’interfaccia di query predefinita.

Per caricare una serie di query predefinite, fai click sull’icona Apri file. Si apre la finestra Apri file, che viene
utilizzata per individuare il file contenente le query SQL. Quando le query vengono caricate, i loro nomi come
definiti nel file XML appariranno nel menu a discesa situato proprio sotto l’icona Apri file. La descrizione
completa della query viene visualizzata nella finestra di testo sotto il menu a discesa.

Seleziona la query che vuoi eseguire dal menu a discesa e quindi fai click sulla scheda Query SQL per verificare
che la query sia stata caricata nella finestra della query. Se è la prima volta che sta eseguendo una query predefinita
o sta cambiando database, devi assicurarti di essere connesso al database.

Fai clic sul pulsante Esegui Query nella scheda Query SQL per eseguire il comando. Se la query ha esito positivo,
viene visualizzata la finestra Selezione file database. Se la query non ha esito positivo, nella finestra Console di
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Output apparirà un messaggio di errore.

Figure 22.16: Scheda Query predefinite eVis

1. Apri file: avvia il browser file «Apri file» per cercare il file XML che contiene le query predefinite.

2. Query predefinite: un elenco a discesa con tutte le query definite dal file XML delle query predefinite.

3. Descrizione query: una breve descrizione della query. Questa descrizione proviene dal file XML delle
query predefinite.

4. Console di Output: la finestra della console dove vengono visualizzati i messaggi relativi alla connessione.

5. Help: mostra la guida in linea.

6. OK: chiude Connessione Database .

Formato XML per le query predefinite di eVis

Tag XML letti da eVis
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Tag Descrizione
query Definisce l’inizio e la fine di una istruzione di query.
shortde-
scrip-
tion

Una breve descrizione della query visualizzata nel menu a discesa eVis.

De-
scrizione

Descrizione più dettagliata che viene mostrata nella casella ’Descrizione query’ di eVis.

database-
type

Il tipo di database, definito nel menu a discesa Tipo database nella scheda Connessione database.

database-
port

La porta di connessione come definita nella casella di teso Porta nella scheda Connessione
Database.

database-
name

Il nome del database come definito nella casella di testo Nome nella scheda Connessione Database.

databaseuser-
name

Il nome utente del database definito nella casella di testo Nome utente nella scheda Connessione
database.

databasep-
assword

La password del database come definita nella casella di testo Password nella scheda Connessione
database.

sql-
state-
ment

Il comando SQL.

auto-
connect

Un flag («true»o «false «) per specificare se i tag precedenti devono essere utilizzati per connet-
tersi automaticamente al database senza eseguire la routine di connessione al database nella scheda
Connessione database.

Segue un esempio completo di file XML contenente tre query:

<?xml version="1.0"?>
<doc>
<query>
<shortdescription>Import all photograph points</shortdescription>
<description>This command will import all of the data in the SQLite database to

→˓QGIS
</description>

<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\textbackslash Workshop/textbackslash

eVis\_Data\textbackslash PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID</sqlstatement>
<autoconnect>false</autoconnect>

</query>
<query>
<shortdescription>Import photograph points "looking across Valley"</

→˓shortdescription>
<description>This command will import only points that have photographs

→˓"looking across
a valley" to QGIS</description>

<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS='Looking across
valley'</sqlstatement>

<autoconnect>false</autoconnect>
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</query>
<query>
<shortdescription>Import photograph points that mention "limestone"</

→˓shortdescription>
<description>This command will import only points that have photographs that

→˓mention
"limestone" to QGIS</description>

<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS like '%limestone%'
</sqlstatement>

<autoconnect>false</autoconnect>
</query>

</doc>

22.2.4 Plugin Controllo Geometria

Controllo Geometrie è un potente plugin di base per controllare e correggere la validità della geometria di un layer.

È disponibile dal menu Vettore ( Controllo Geometrie. . . ).

Configurare i controlli

La finestra di dialogo Controllo Geometrie mostra diverse impostazioni raggruppate nella prima scheda (Im-
postazioni):

• Vettore in ingresso: per selezionare il layer da controllare. Una casella di controllo Solo le geometrie
selezionate può essere utilzzata per limitare i controlli alle geometrie degli elementi selezionati.

• Tipi di geometria consentiti: per consentire solo alcuni tipi di geometria come punto, punto multiplo, linea,
multilinea, poligono e multipoligono.

• Validità geometria: a seconda del tipo di geometria, l’utente può scegliere Auto intersezioni, Nodi

duplicati, Autocontatti e Poligono con meno di 3 nodi.

• Proprietà geometria a seconda del tipo di geometria, l’utente può scegliere Poligoni e multipoligoni non

debbano contenere fori, Oggetti multiparte devono essere costituiti da più di una parte e Le linee
non devono avere nodi sospesi.

• Condizioni geometria: l’utente può aggiungere alcune condizioni per convalidare le geometrie con una
lunghezza minima del segmento, un angolo minimo tra segmenti, una zona poligonale minima e il rileva-
mento di poligoni sottili.

• Controlli topologici: a seconda del tipo di geometria, l’utente può scegliere Controlli per i duplicati,

Controlla gli elementi contenuti in altri elementi, Controlla le sovrapposizioni più piccole di ,

Controlla gli spazi più piccoli di , I punti devono essere coperti da linee, I punti devono

trovarsi correttamente all’interno di un poligono, Le linee non devono intersecare altre linee, Le

linee non devono intersecare con gli elementi del layer |selectSelectString|, Poligoni devono seguire i

confini del layer .

• Tolleranza: puoi definire qui la tolleranza di controllo in unità mappa del layer.
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• Vettore in uscita dà all’utente la possibilità di ottenere come risultato la modifica del layer corrente e la
creazione di un nuovo layer.

Quando sei soddisfatto con la configurazione, puoi fare clic sul pulsante Esegui.

Il Plugin Controllo Geometria può trovare i seguenti errori:

• Auto intersezioni: un poligono con confini che si intersecano;

• Nodi duplicati: due nodi duplicati in un segmento;

• Buchi: buco in un poligono;

• Lunghezza del segmento: lunghezza del segmento inferiore a una soglia;

• Angolo minimo: due segmenti con un angolo inferiore a una soglia;

• Area minima: area poligonale inferiore a una soglia;

• Poligoni sottili: questo errore viene da poligono molto piccolo (con piccola area) con un lungo perimetro;

• Elementi duplicati;

• Elemento contenuto in un altro elemento;

• Sovrapposizioni: poligoni che si sovrappongono;

• Gap: spazi tra poligoni.

La figura seguente mostra i diversi controlli effettuati dal plugin.

Analisi dei risultati

I risultati vengono visualizzati nella seconda scheda (Resultato) e come un layer panoramico degli errori nell’area
di visualizzazione mappa (il cui nome ha il prefisso di default checked_). Una tabella elenca il Risultato
controllo geometrie con un errore per riga e colonne contenenti: il nome del layer, un ID, il tipo di errore, poi
le coordinate dell’errore, un valore (a seconda del tipo di errore) e infine la colonna di risoluzione che indica la
risoluzione dell’errore. In fondo a questa tabella, puoi fare Esporta l’errore in diversi formati di file. Puoi anche
avere un contatore con il numero di errori totali e degli errori corretti.

Puoi selezionare una riga per vedere la localizzazione dell’errore. Puoi cambiare questo comportamento selezio-

nando un’altra azione tra Errore (default), Geometria, Non muovere, e Evidenzia il contorno
delle geometrie selezionate.

Sotto l’azione di zoom quando si clicca sulla riga della tabella, puoi:

• Mostra le geometrie selezionate nella tabella degli attributi;

• Riparara gli errori selezionati utilizzando la risoluzione di default;

• Correzione degli errori selezionati, richiesta del metodo di risoluzione. Vedrai una finestra per scegliere
il metodo di risoluzione tra i quali:

– Fondi con il poligono adiacente avente il margine condiviso più lungo;

– Fondi con il poligono adiacente avente l’area più grande;

– Fondi con il poligono adiacente avente valore di attributo identico, se presente, o lascia così come è;

– Elimina elemento;

– Nessuna azione.

Suggerimento: Correzione errori multipli

Puoi correggere errori multipli selezionando più di una riga nella tabella con l’azione CTRL + click.
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Figure 22.17: Il Plugin Controllo Geometria
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Figure 22.18: Some checks supported by the plugin
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L’azione predefinita può essere modificata con l’ultima icona Imposta risoluzione errore. Per alcuni tipi di
errori, puoi modificare l’azione predefinita tra alcune azioni specifiche o Nessuna azione.

Infine, puoi scegliere quale Attributo da utilizzare quando si uniscono le geometrie per valore di attributo.

22.2.5 Plugin Georeferenziatore

Il Plugin Georeferenziatore è uno strumento per generare file di georeferenziazione (world file) per i raster.
Permette di georeferenziare raster in sistemi di coordinate geografiche o proiettate, creando un nuovo GeoTiff
oppure associandogli un world file. L’approccio di base del plugin è quello di individuare punti del raster per i
quali puoi determinare accuratamente le coordinate.

Funzioni

Icona Azione Icona Azione

Carica un raster Avvia la georeferenziazione

Genera uno script GDAL Carica punti GCP (Ground Control Point)

Salva Punti GCP come. . . Imposta la trasformazione

Aggiunge un nuovo punto Elimina un punto

Sposta un punto GCP Sposta

Ingrandisce la vista Rimpicciolisce la vista

Zoom sul layer Zoom precedente

Zoom successivo Collegare il georeferenziatore a QGIS

Collegare QGIS al georeferenziatore Stiramento completo dell’istogramma

Stiramento locale dell’istogramma

Tabella Georeferenziatore: Strumenti del Georeferenziatore

Utilizzo del plugin

Per le coordinate X e Y (espresse in gradi, primi e secondi DMS (dd mm ss.ss), in gradi decimali DD (dd.dd) o le
coordinate proiettate (mmmm.mm) espresse in metri), che corrispondono ai punti selezionati sull’immagine, puoi
usare due procedure alternative:

• Alcune volte nei raster sono presenti punti con le coordinate scritte sull’immagine. In questo caso puoi
inserire manualmente le coordinate.

• Usando layer già georeferenziati. Può trattarsi di dati vettoriali o raster che contengono gli stessi
oggetti/geometrie presenti nell’immagine che si desidera georeferenziare e con la proiezione che vuoi per
la tua immagine. In questo caso, puoi inserire le coordinate facendo click sul dataset di riferimento caricato
nell’area della mappa QGIS.

La procedura più comune per la georeferenziazione di un’immagine consiste nel selezionare più punti sul raster,
specificandone le coordinate e scegliendo un tipo di trasformazione adeguata. Sulla base dei parametri di input e
dei dati, il plugin calcolerà i parametri deworld file. Più coordinate vengono fornite, migliore sarà il risultato.

Il primo passo è avviare QGIS, caricare il plugin Georeferenziatore (vedi management_plugins) e cliccare su

Raster → Georeferenziatore, che appare nella barra dei menu di QGIS. La finestra di dialogo del plugin
Georeferenziatore appare come mostrato in figure_georeferencer_dialog.
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Per questo esempio, stiamo usando una carta topografica del South Dakota di SDGS. Può essere successivamente
visualizzata insieme ai dati della cartella GRASS spearfish60. Puoi scaricare la carta topografica da qui:
https://grass.osgeo.org/sampledata/spearfish_toposheet.tar.tar.gz.

Figure 22.19: Finestra di dialogo del Plugin Georeferenziatore

Aggiungere punti di controllo (GCP)

1. Per iniziare la georeferenziazione di un raster non referenziato, dobbiamo caricarlo usando il pulsante .
Il raster verrà visualizzato nell’area di lavoro principale della finestra di dialogo. Una volta caricato il raster,
possiamo iniziare a inserire i punti di riferimento.

2. Utilizzando il pulsante Aggiungi punto, aggiungi punti all’interno dell’area di lavoro principale e insesci le
rispettive coordinate (vedi la figura figure_georeferencer_add_points). Per effettuare questa procedura, hai
tre opzioni:

• Cliccare su un punto del raster ed inserire le coordinate X/Y manualmente.

• Cliccare su un punto nell’immagine raster ed usare il pulsante Dalla mappa per inserire le coordinate
X e Y con l’aiuto di una mappa georeferenziata già caricata nella vista mappa di QGIS.

• Utilizzando il pulsante , puoi spostare i GCP in entrambe le finestre, nel caso in cui fossero po-
sizionati in maniera errata.

3. Continuare ad inserire punti. Dovresti inserire almeno 4 GCP: più punti vengono inseriti, migliore sarà il
risultato. Ci sono strumenti aggiuntivi nella finestra di dialogo del plugin per ingrandire e spostare l’area di
lavoro al fine di individuare un insieme rilevante di punti GCP.

I punti che sono stati aggiunti alla mappa verranno salvati in un le di testo separato ([filename].points) in
genere insieme all’immagine raster. Questo ti consente di aprire in un secondo momento il plugin Georeferenzi-
atore e aggiungere nuovi punti oppure cancellarne alcuni, in maniera da migliorare il risultato finale. Il file dei
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Figure 22.20: Aggiungi punti all’immagine raster

punti contiene i valori del modulo: mapX, mapY, pixelX, pixelY. Puoi usare i pulsanti Carica punti GCP

e Salva i punti GCP come per gestire i file.

Impostare una trasformazione

Dopo aver aggiunto i GCP all’immagine raster, devi definire le impostazioni di trasformazione del processo di
georeferenziazione.

Figure 22.21: Definizione delle impostazioni di trasformazione del georeferenziatore

Algoritmi di trasformazione disponibili

A seconda del numero di punti di controllo a terra acquisiti, puoi utilizzare diversi algoritmi di trasformazione. La
scelta dell’algoritmo di trasformazione dipende anche dal tipo e dalla qualità dei dati in ingresso e dalla quantità
di distorsione geometrica che sei disposto a introdurre nel risultato finale.
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Attualmente sono disponibili le seguenti tipologie di trasformazione:

• L’algoritmo di trasformazione lineare è utilizzato per generare un file di georeferenziazione o world file, ed
è differente rispetto agli altri algoritmi, in quanto attualmente non adatta deformandolo il raster originale.
Questo algoritmo in genere non è adatto nel caso in cui si lavori con immagini scannerizzate.

• La trasformazione di Helmert esegue una rototraslazione del raster con variazione di scala.

• Gli algoritmi Polinomiali di grado 1-3 sono i più utilizzati per garantire la maggior coerenza tra i punti
inseriti e quelli risultanti dopo la trasformazione. L’algoritmo polinomiale più utilizzato è la trasformazione
attraverso un polinomio di secondo grado, che permette alcune curvature. La trasformazione polinomiale
di primo grado (affine) permette di conservare la collinearità dei punti, e consente solamente di scalare,
traslare e ruotare l’immagine.

• L’algoritmo di traformazione Thin Plate Spline (TPS) è un metodo di georeferenziazione recente, che
permette di introdurre delle deformazioni localizzate all’interno dei dati. Questo algoritmo risulta partico-
larmente efficace quando si vogliono georeferenziare immagini di scarsa qualità.

• La traformazione Proiettiva consiste in una rotazione lineare ed in una traslazione delle coordinate.

Metodo di ricampionamento

Il tipo di ricampionamento scelto dipenderà probabilmente dai dati in ingresso e dall’obiettivo finale del lavoro.
Se non vuoi cambiare le statistiche dell’immagine, potresti voler scegliere «Vicino più prossimo», mentre un
«Ricampionamento cubico» probabilmente fornirà un risultato più omogeneo.

Puoi scegliere tra cinque diversi metodi di ricampionamento:

1. Vicino più prossimo

2. Lineare

3. Cubico

4. Spline Cubica

5. Lanczos

Definizione delle impostazioni di trasformazione

Ci sono diverse opzioni che devono essere definite per l’output georeferenziato di un raster.

• La casella di controllo Crea il file di georeferenziazione è attiva solo se scegli la trasformazione lineare,
quando il raster non viene fisicamente deformato. In questo caso, il campo Output raster non viene attivato,
perché verrà creato solo un nuovo file world.

• Per tutti gli altri tipi di trasformazione devi definire un Raster in output.Come modalità predefinita, viene
creato un nuovo file ([nomefile]_modificato) nella stessa cartella del raster di partenza insieme all’immagine
raster originale.

• Devi poi scegliere il SR (Sistema di riferimento) per il Raster georiferito (vedi Lavorare con le proiezioni).

• Se vuoi, puoi creare delle mappe pdf e anche dei report pdf. Il report fornisce informazioni sui parametri
di informazione utilizzati, una rappresentazione degli scarti e una lista con tutti i GCP e i loro errori RMS.

• Inoltre puoi attivare la casella di controllo imposta risoluzione finale e definire la risoluzione in pixel
del raster di output. La risoluzione predefinita orizzontale e verticale è 1.

• La casella di controllo| Utilizzare 0 per la trasparenza quando necessario può essere attivata, se i pixel
con il valore 0 devono essere visualizzati trasparenti. Nel nostro esempio toposheet, tutte le aree bianche
sarebbero trasparenti.

• Infine la casella di controllo Carica in QGIS una volta eseguito carica automaticamente il raster di
output nella vista mappa di QGIS a trasformazione terminata.
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Mostra e modifica le proprietà del raster

Cliccando sull’opzione Proprietà raster nel menu Impostazioni si apre la finestra di dialogo Layer properties del
file raster che vuoi georeferenziare.

Configurare il georeferenziatore

• Puoi definire se visualizzare le coordinate e/o gli IDs dei GCP.

• Imposta le unità dei residui, pixel e unità di mappa.

• Per i report PDF, è possibile definire un margine sinistro e destro ed è anche possibile impostare il formato
carta per la mappa PDF.

• Infine puoi attivare la casella di controllo Mostra la finestra del georeferenziatore agganciata.

Eseguire la trasformazione

Dopo aver acquisito tutti i GCP e definite tutte le impostazioni di trasformazione, basta premere il pulsante
Inizia la georeferenziazione per creare il nuovo raster georeferenziato.

22.2.6 Client Catalogo MetaSearch

Introduzione

MetaSearch è un plugin di QGIS per interfacciarsi con i servizi di catalogazione metadati, supporto standard del
Catalogue Service for the Web (CSW) dell’OGC.

MetaSearch offre un approccio semplice ed intuitivo con un’interfaccia user-friendly per effettuare ricerche in
cataloghi di metadati all’interno di QGIS.

Installazione

MetaSearch è incluso per impostazione predefinita con QGIS 2.0 e versioni successive. Tutte le interdipendenze
sono incluse in MetaSearch.

Installare MetaSearch dal plugin manager QGIS o manualmente da https://plugins.qgis.org/plugins/MetaSearch.

Lavorare con i cataloghi dei metadati in QGIS

CSW (Catalog Service for the Web)

CSW (Catalog Service for the Web) è una specifica OGC (Open Geospatial Consortium), che definisce
un’interfaccia comune per scoprire, esplorare ed interrogare metadati associati ai dati, ai servizi e ad altre possibili
risorse.

Avvio

Per avviare MetaSearch, fai click sull’icona oppure seleziona il menù Web → MetaSearch nel menù principale
di QGIS. Apparirà la finestra di dialogo MetaSearch. La GUI principale è composta da tre schede: Servizi, Cerca
e Impostazioni.
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Figure 22.22: Ricerche e risultati di Servizi in MetaSearch

Managing Catalog Services

La scheda Servizi permette all’utente di gestire tutti i servizi di catalogazione disponibili. MetaSearch offre una
lista di servizi di catalogo predefiniti, che possono essere integrati premendo il pulsante Aggiungere servizi pre-
definiti.

Per l’elenco di tutte le voci del Servizio catalogo, fai click sulla casella di selezione a discesa.

Per aggiungere una voce nel Servizio Cataloghi, fai clic sul pulsante Nuovo, e inserisci un Nome per il servizio, così
anche il pulsante URL (endpoint). Nota che è richiesto solo l’URL di base (non un URL GetCapabilities completo).
Se il CSW richiede l’autenticazione, inserisci le appropriate credenziali User name e Password. Cliccando su OK
il servizio sarà aggiunto alla lista delle voci.

Per modificare una voce esistente del Servizio Cataloghi, seleziona la voce che vuoi modificare e fai clic sul
pulsante Modifica, e modifica i valori Nome o URL, quindi fai clic su OK.

Per cancellare un servizio di catalogazione esistente, sceglielo e premi il pulsante Cancella. Ti verrà richiesta
ulteriore conferma alla cancellazione.

MetaSearch permette di caricare e salvare le connessioni usando un le XML. Questo è utile se devi condividere le
impostazioni tra più applicazioni. Segue un esempio di file in formato XML.

<?xml version="1.0" encoding="UTF-8"?>
<qgsCSWConnections version="1.0">

<csw name="Data.gov CSW" url="https://catalog.data.gov/csw-all"/>
<csw name="Geonorge - National CSW service for Norway" url="https://www.

→˓geonorge.no/geonetwork/srv/eng/csw"/>
<csw name="Geoportale Nazionale - Servizio di ricerca Italiano" url="http://

→˓www.pcn.minambiente.it/geoportal/csw"/>
<csw name="LINZ Data Service" url="http://data.linz.govt.nz/feeds/csw"/>
<csw name="Nationaal Georegister (Nederland)" url="http://www.

→˓nationaalgeoregister.nl/geonetwork/srv/eng/csw"/>
<csw name="RNDT - Repertorio Nazionale dei Dati Territoriali - Servizio di

→˓ricerca" url="http://www.rndt.gov.it/RNDT/CSW"/>
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Figure 22.23: Managing Catalog Services
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<csw name="UK Location Catalogue Publishing Service" url="http://csw.data.gov.
→˓uk/geonetwork/srv/en/csw"/>

<csw name="UNEP/GRID-Geneva Metadata Catalog" url="http://metadata.grid.unep.
→˓ch:8080/geonetwork/srv/eng/csw"/>
</qgsCSWConnections>

Per caricare un elenco di connessioni, fai click sul pulsante Carica. Una nuova finestra verrà mostrata; fai click
sul pulsante Esplora per cercare la posizione del file da aprire e fai clic su Apri. L’elenco degli elementi presenti
verrà mostrato. Scegli gli elementi da aggiungere e premi Carica.

Fai clic sul pulsante Informazioni sul servizio per visualizzare le informazioni sul servizio di catalogazione se-
lezionato come identicativo, fornitore del servizio ed informazioni di contatto. Se vuoi vedere questa informazione
in formato XML, fai clic sul pulsante Risposta di GetCapabilities. Una nuova nestra mostrerà il le XML conte-
nente le Capabilities.

Searching Catalog Services

Figure 22.24: Cercare Servizi di Catalogo

La scheda Cerca permette all’utente di cercare servizi di catalogazione per dati e servizi, impostare i parametri di
ricerca e visualizzare i risultati.
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Sono disponibili i seguenti parametri di ricerca:

• Parole chiave: ricerca a testo libero sulle parole chiave;

• Da: il servizio di catalogazione su cui effettuare le interrogazioni;

• Estensione della mappa: l’area spaziale di interesse su cui effettuare il filtro definita da Xmax, Xmin, Ymax,
and Ymin. Fai click su Imposta globalmente per eseguire una ricerca globale, fai click su Estensione della
mappa per eseguire una ricerca solo nell’area visibile o immettere manualmente i valori personalizzati come
desiderato.

Cliccando il pulsante “Ricerca” verrà effettuata una ricerca nel catalogo Metadati selezionato. I risultati sono
mostrati come lista e possono essere ordinati cliccando sul nome della colonna. Puoi esplorare i risultati della
ricerca utilizzando i pulsanti sotto la finestra dei risultati. Cliccando sul pulsante Visualizza i risultati di ricerca
come XML si aprirà una finestra con la riposta del servizio in formato XML.

Clicking a result will provide the following options:

• se il metadato ha una estensione geografica associata, il rettangolo di delimitazione sarà mostrato sulla
mappa;

• doppio click su un record ne mostra i metadati con ogni collegamento di accesso associato. Cliccando su un
link questo verrà aperto all’interno del browser;

• Se il record è un web service dell’OGC (WMS/WMTS, WFS, WCS), il relativo pulsante Aggiungi
WMS/WMTS|WFS|WCS verrà abilitato per permettere all’utente di aggiungerlo in QGIS. Quando si fa click
su questo pulsante, MetaSearch verificherà che sia un valido servizio OWS. Il servizio verrà aggiunto nel
relativo elenco di connessioni QGIS e verrà mostrata la relativa finestra di dialogo per la connessione.

Figure 22.25: Visualizzazione record Metadati
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Impostazioni

Figure 22.26: Impostazioni MetaSearch

Puoi ottimizzare MetaSearch con le seguenti Impostazioni:

• Impaginazione dei risultati: il numero di risultati da visualizzare per pagina durante la ricerca nei cataloghi
di metadati. Il valore predefinito è 10 risultati per pagina;

• Timeout del server: il numero di secondi dopo il quale bloccare il tentativo di connessione al server per la
ricerca nei cataloghi di metadati. Il valore predefinito è 10 secondi.

22.2.7 Plugin Offline Editing

In progetti di acquisizione dati è situazione comune trovarsi a lavorare sul campo con computer portatili e palmari:
i dati in tal modo acquisiti vanno, poi, sincronizzati con la banca dati principale, (ad esempio un database PostGIS).
Se più persone lavorano simultaneamente sullo stesso set di dati, risulta difficile aggiornare la banca dati principale
manualmente, anche se le persone non stanno aggiornando le stesse features.

The Offline Editing Plugin automates the synchronisation by copying the content of a datasource (usually PostGIS
or WFS-T) to a SpatiaLite or GeoPackage database and storing the offline edits to dedicated tables. After being
connected to the network again, it is possible to apply the offline edits to the master dataset.

To use the plugin:

1. Apri un progetto con alcuni layers vettoriali (ad esempio da PostGIS o da un WFS-T).

2. Assuming you have already enabled the plugin (see Plugin di Base e Plugin Esterni) go to Database →

Offline Editing → Convert to offline project. The eponym dialog opens.
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3. Select the Storage type. It can be of GeoPackage or SpatiaLite database type.

4. Use the Browse button to indicate the location of the database in which to store the Offline data. It can be
an existing file or one to create.

5. In the Select remote layers section, check the layers you’d like to save. The content of the layers is saved to
database tables.

6. You can check Only synchronize selected features if a selection is present allowing to only save and
work on a subset. It can be invaluable in case of large layers.

This is all!

7. Save your project and bring it on the field.

8. Modificare layer in modalità non in linea.

9. Dopo essersi nuovamente connessi, carica le modifiche utilizzando Database → Editing Offline →
Sincronizza.

Figure 22.27: Create an offline project

22.2.8 Plugin Validatore topologico

La topologia tratta le relazioni spaziali tra punti, linee e poligoni, che rappresentano le geometrie di una regione
geografica. Con il Plugin Validatore Topologico puoi verificare se i tuoi vettori rispettano le regole topologiche.
Queste regole verificano se le relazioni spaziale delle geometrie di un vettore sono “Uguali”, “Contiene”, “Sovrap-
pone”, “Sovraposta”, “Incrocia”, o se i vettori sono “Disgiunti”, “Intersecano”, Sovrastano” o “Toccano” altri
vettori. Dipende dalle tue richieste su quali regole di topologia applicherai per i vettori (ad esempio, normalmente
non accetterai superamento in vettori di linee se non nel caso di raffigurazione di strade senza uscita).

QGIS ha integrata una funzione di editing topologico molto utile per la creazione di nuove geometrie senza errori.
Ma gli errori di dati esistenti e gli errori degli utenti sono difficili da trovare. Questo plugin ti aiuta a trovare tali
errori attraverso un elenco di regole topologiche.
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Figure 22.28: Il Plugin Validatore Topologico

E” molto semplice creare condizioni topologiche con il Plugin Validatore Topologico.

Sui vettori di punti puoi utilizzare le seguenti condizioni:

• deve essere coperto da: puoi scegliere un vettore dal progetto. I punti che non sono coperti da un dato
vettore vengono messi nel campo “errore”.

• deve essere coperto dai punti terminali: puoi scegliere vettore di linee dal progetto.

• deve essere dentro: puoi scegliere un vettore poligonale dal progetto. I punti devono essere all’interno di
un poligono. In caso contrario, segnala “Errore” per il punto.

• non deve avere duplicati: ogni volta che un punto è rappresentato due o più volte, apparirà nel campo
“Errore”.

• non deve avere geometrie non valide. Verifica se le geometrie sono valide.

• non deve avere geometrie multi-part. Tutti i punti multipli sono segnalati come “Errore”.

Sui vettori di linee hai a disposizione le seguenti regole topologiche:

• End points must be covered by: Here you can select a point layer from your project.

• non deve avere nodi sospesi: individuerà le eccedenze nel vettore di linee.

• non deve avere duplicati: ogni volta che una linea è rappresentata due o più volte, apparirà nel campo
“Errore”.

• non deve avere geometrie non valide. Verifica se le geometrie sono valide.

• non deve avere geometrie multi-part: alcune volte, una geometria è in realtà un insieme di geometrie sem-
plici (single-parte). Tale geometria è chiamato geometria multi-part. Se contiene anche un solo elemento
di geometria multi-part, noi lo chiamiamo punti multipli, linee-multiple o poligoni multipli. Tutte le linee
multiple sono segnalate come “Errore”.

• non deve avere pseudo: il punto terminale di una linea dovrebbe essere collegato ai punti finali di altre
due geometrie. Se il punto terminale è collegato al punto terminale di una sola altra geometria, il punto
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terminale è chiamato un nodo pseudo.

Per i vettori poligono hai a disposizione le seguenti regole:

• deve contenere: il vettore poligono deve contenere almeno un punto della geometria dal secondo vettore.

• non deve avere duplicati: i poligoni dello stesso vettore non devono avere geometrie identiche. Ogni volta
che un poligono è rappresentato due o più volte aparirà nel campo “Errore”.

• non deve avere vuoti: poligoni adiacenti non devono formare spazi vuoti tra di loro. I confini amministrativi
potrebbero essere citati come esempio (i poligoni stato degli Stati Uniti non hanno spazi vuoti tra di loro
. . . ).

• non deve avere geometrie non valide: verifica se le geometrie sono validi. Alcune delle regole che definis-
cono una geometria validi sono:

– I poligoni anello devono essere chiusi.

– Anelli che definiscono i buchi devono essere all’interno di anelli che definiscono i confini esterni.

– Gli anelli non possono auto-intersecarsi (non si possono né toccare né incrociare l’un l’altro).

– Gli anelli non tocchino altri anelli, tranne che in un punto.

• non deve avere geometrie multi-part: alcune volte, una geometria è in realtà un insieme di geometrie sem-
plici (single-parte). Tale geometria è chiamato geometria multi-part. Se contiene anche un solo elemento di
geometria multi-part, noi lo chiamiamo punti multipli, linee-multiple o poligoni multipli. Ad esempio, un
paese composto di una o più isole può essere rappresentato come un multi-poligono.

• non deve sovrapporsi: poligoni adiacenti non devono condividere un’area comune.

• non deve sovrapporsi con: poligoni adiacenti da un vettore non devono condividere un’area comune con
poligoni di un altro vettore.

Di seguito è riportato l’elenco dei plugin di base forniti con QGIS. Non sono necessariamente abilitati per im-
postazione predefinita.
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Icona Plugin Descrizione Riferimento al
manuale

Acquisizione Co-
ordinate

Acquisisci le coordinate del mouse usando un SR diverso Plugin Cattura
Coordinate

DB Manager Gestire i DB all’interno di QGIS Plugin DB Man-
ager

eVis Uno strumento di visualizzazione di eventi. Visualizza im-
magini associate agli elementi di un vettore

Plugin eVis

Controllo Ge-
ometria

Verifica e elimina errori in geometrie vettoriali Plugin Controllo
Geometria

Georeferenzia-
tore GDAL

Georeferenziare i raster con GDAL Plugin Georef-
erenziatore

Strumenti GPS Strumenti per caricare e importare dati GPS Plugin GPS

GRASS Attiva i potenti strumenti di GRASS Integrazione con
GRASS GIS

Client Catalogo
MetaSearch

Interagisce con Catalog Service for the Web (CSW) Client Catalogo
MetaSearch

Offline Editing Consente l’editing offline e la sincronizzazione con il database Plugin Offline
Editing

Processing Ambiente per l’elaborazione di dati spaziali ambiente Pro-
cessing di QGIS

Verifica topolog-
ica su vettori

Trova errori topologici nei layer vettoriali Plugin Validatore
topologico

22.3 QGIS Python console

Come vedrai più avanti in questo capitolo, QGIS è stato progettato con un’architettura a plugin. I plugin possono
essere scritti in Python, una lingua molto famosa nel mondo geospaziale.

QGIS ha un’API Python (vedi PyQGIS Developer Cookbook per alcuni esempi di codice) per permettere all’utente
di interagire con i suoi oggetti (layer, elementi o interfacce). QGIS ha anche una console Python.

La Console QGIS Python è una shell interattiva per l’esecuzione dei comandi python. Ha anche un editor di file
python che permette di modificare e salvare i tuoi script python. Sia la console che l’editor sono basati sul package
PyQScintilla2. Per aprire la console vai in Plugins → Console Python (Ctrl+Alt+P).

22.3.1 The Interactive Console

The interactive console is composed of a toolbar, an input area and an output one.

Toolbar

The toolbar proposes the following tools:

• Clear Console to wipe the output area;

• Run Command available in the input area: same as pressing Enter;
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• Show Editor: toggles The Code Editor visibility;

• Options. . . : opens a dialog to configure console properties (see Options);

• Help. . . : browses the current documentation.

Console

The console main features are:

• Code completion, highlighting syntax and calltips for the following APIs:

– Python

– PyQGIS

– PyQt5

– QScintilla2

– osgeo-gdal-ogr

• Ctrl+Alt+Space to view the auto-completion list if enabled in the Options;

• Execute code snippets from the input area by typing and pressing Enter or Run Command;

• Execute code snippets from the output area using the Enter Selected from the contextual menu or pressing
Ctrl+E;

• Browse the command history from the input area using the Up and Down arrow keys and execute the
command you want;

• Ctrl+Shift+Space to view the command history: double-clicking a row will execute the command.
The Command History dialog can also be accessed from context menu of input area;

• Save and clear the command history. The history will be saved into the file ~/.qgis2/
console_history.txt;

• Open QGIS C++ API documentation by typing _api;

• Open QGIS Python API documentation by typing _pyqgis.

• Open PyQGIS Cookbook by typing _cookbook.

Suggerimento: Reuse executed commands from the output panel

You can execute code snippets from the output panel by selecting some text and pressing Ctrl+E. No matter if
selected text contains the interpreter prompt (>>>, ...).

22.3.2 The Code Editor

Use the Show Editor button to enable the editor widget. It allows editing and saving Python files and offers
advanced functionalities to manage your code (comment and uncomment code, check syntax, share the code via
codepad.org and much more). Main features are:

• Code completion, highlighting syntax and calltips for the following APIs:

– Python

– PyQGIS

– PyQt5

– QScintilla2
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Figure 22.29: The Python Console

– osgeo-gdal-ogr

• Ctrl+Space to view the auto-completion list.

• Sharing code snippets via codepad.org.

• Ctrl+4 Syntax check.

• Search bar (open it with the default Desktop Environment shortcut, usually Ctrl+F):

– Use the default Desktop Environment shortcut to find next/previous (Ctrl+G and Shift+Ctrl+G);

– Automatically find first match when typing in find box;

– Set initial find string to selection when opening find;

– Pressing Esc closes the find bar.

• Object inspector: a class and function browser;

• Go to an object definition with a mouse click (from Object inspector);

• Execute code snippets with the Run Selected command in contextual menu;

• Execute the whole script with the Run Script command (this creates a byte-compiled file with the
extension .pyc).

Nota: Running partially or totally a script from the Code Editor outputs the result in the Console output area.

22.3.3 Options

Accessible from the Console toolbar and the contextual menus of the Console output panel and the Code Editor,
the Python Console Settings help manage and control the Python console behavior.

For both Console and Editor you can specify:

• Autocompletion: Enables code completion. You can get autocompletion from the current document, the
installed API files or both.

– Autocompletion threshold: Sets the threshold for displaying the autocompletion list (in characters)

• Typing

– Automatic parentheses insertion: Enables autoclosing for parentheses
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Figure 22.30: The Python Console editor

– Automatic insertion of the “import” string on “from xxx”: Enables insertion of “import” when speci-
fying imports

For Editor you can also specify:

• Run and Debug

– Enable Object Inspector (switching between tabs may be slow): Enable the object inspector.

– Auto-save script before running: Saves the script automatically when executed. This action will store
a temporary file (in the temporary system directory) that will be deleted automatically after running.

• Font and Colors: Here you can specify the font to use in the editor and the colors to use for highlighting

For APIs you can specify:

• Using preloaded APIs file: You can choose if you would like to use the preloaded API files. If this is not
checked you can add API files and you can also choose if you would like to use prepared API files (see next
option).

• Using prepared APIs file: If checked, the chosen *.pap file will be used for code completion. To generate
a prepared API file you have to load at least one *.api file and then compile it by clicking the Compile
APIs. . . button.

Suggerimento: Save the options

To save the state of console’s widgets you have to close the Python Console from the close button. This allows
you to save the geometry to be restored to the next start.
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CHAPTER 23

Aiuto e supporto

23.1 Le Mailing list

QGIS è in continuo sviluppo e, come tale, non funzionerà sempre come ti aspetti. Il miglior modo di ottenere
aiuto è unirsi alla mailing list di qgis-users. Le tue domande raggiungeranno una audience più ampia e le risposte
ottenute saranno anche a beneficio di altri.

23.1.1 QGIS Users

Questa mailing list viene utilizzata per discussioni su QGIS in generale, così come per domande specifiche sulla
sua installazione ed uso. Puoi iscriverti alla maling list qgis-users al visitando il seguente URL: http://lists.osgeo.
org/mailman/listinfo/qgis-user

23.1.2 QGIS Developers

Se sei uno sviluppatore che affronta problemi di natura più tecnica, potresti volerti unire alla mailing list di qgis-
developer. Questa lista è anche un luogo in cui le persone possono intervenire e raccogliere e discutere problemi
di QGIS relativi a UX (User Experience)/usabilità. È qui: http://lists.osgeo.org/mailman/listinfo/qgis-developer

23.1.3 QGIS Community Team

Questa mailing list si occupa di argomenti come la documentazione, l’aiuto contestuale, la guida utente, i siti web e
i lavori di traduzione. Se vuoi lavorare anche sulla guida utente, questa mailing list è un buon punto di partenza per
fare le tue domande. Puoi sottoscriverla all’URL: http://lists.osgeo.org/mailman/listinfo/qgis-community-team

23.1.4 QGIS Translations

Questa lista si occupa delle traduzioni. Se vuoi lavorare alla traduzione del sito web, dei manuali o dell’interfaccia
grafica (GUI) trovi in questa lista un buon punto di partenza per le tue domande. Puoi iscriverti tramite l’URL
http://lists.osgeo.org/mailman/listinfo/qgis-tr
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23.1.5 QGIS Project Steering Committee (PSC)

Questa lista viene utilizzata per discutere le questioni del Comitato Direttivo relative alla gestione e alla direzione
generale di QGIS. Puoi iscriverti a questa lista su: http://lists.osgeo.org/mailman/listinfo/qgis-psc

23.1.6 QGIS User groups

Al fine di promuovere localmente QGIS e contribuire al suo sviluppo, alcune comunità QGIS sono organizzate
in Gruppi di Utenti QGIS. Questi gruppi sono luoghi in cui discutere di argomenti locali, organizzare riunioni di
utenti regionali o nazionali, organizzare sponsorizzazioni . . . L’elenco dei gruppi di utenti attuali è disponibile su
http://qgis.org/en/site/forusers/usergroups.htm

Sei invitato ad iscrivervi a una delle liste. Ricordati di contribuire alla lista rispondendo alle domande e condivi-
dendo le tue esperienze.

23.2 IRC

Siamo anche presenti su IRC - ci puoi visitare registrandoti al canale #qgis su irc.freenode.net. Per favore, aspetta
pazientemente le risposte alle tue domande, dato che molte persone sul canale IRC sono al lavoro su altre cose, e
potrebbero impiegare un po” di tempo prima di notare la tua richiesta. Se hai perso una discussione su IRC, non
c’è problema! Noi registriamo tutte le discussioni, cosicchè puoi metterti in pari semplicemente leggendo i log
salvati su http://qgis.org/irclogs.

E” inoltre disponibile un supporto commerciale per QGIS. Per maggiori informazioni, visita il sito web http:
//qgis.org/en/commercial-support.html.

23.3 BugTracker

Mentre la mailing list qgis-users è utile per le domande di tipo generale “Come faccio XYZ in QGIS”, potresti
voler notificare i bug in QGIS. Puoi inviare segnalazioni di bug usando il bug tracker di QGIS all’indirizzo https:
//issues.qgis.org/projects/qgis/issues. Quando crei un nuovo ticket per un bug, si prega di fornire un indirizzo
email dove possiamo contattarti per ulteriori informazioni.

Ricordati che un bug da te segnalato potrebbe ricevere una priorità diversa da quella che ti aspetteresti (dipende
della serietà del problema). Alcuni errori richiedono un significativo sforzo allo sviluppatore e non sempre ci sono
abbastanza risorse umane disponibili.

Le richieste per nuove funzionalità possono essere sottoposte tramite lo stesso sistema di segnalazioni usato per i
bug. Assicurati di aver prima selezionato il tipo Feature.

Se hai trovato un bug e lo hai risolto, puoi inviare una Pull Request sul progetto Github QGIS (preferibile) o una
patch. Anche il semplice sistema di ticket redmine su http://hub.qgis.org/projects/quantum-gis/issues ha questo
tipo. Controlla la casella di controllo Patch supplied fornita e allega la patch prima di inviare il bug. Uno
degli sviluppatori lo esaminerà e lo applicherà a QGIS. Non allarmarti se la tua patch non viene applicata imme-
diatamente - gli sviluppatori potrebbero essere legati ad altri impegni.

Nota che se sottoponi una Pull Request, la tua modifica potrebbe essere integrata nel codice sorgente con maggiore
probabilità!

23.4 Blog

La community di QGIS gestisce anche un weblog su http://planet.qgis.org/planet/, che contiene alcuni articoli
interessanti per utenti e sviluppatori, oltre a quelli forniti da altri blog della comunità. Sei invitato a dare il tuo
contributo al blog QGIS!
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23.5 Plugins

Il sito web http://plugins.qgis.org fornisce il portale web ufficiale dei plugin QGIS. Qui trovi una lista di tutti i
plugin QGIS stabili e sperimentali disponibili tramite il “repository ufficiale di plugin QGIS”.

23.6 Wiki

Infine, gestiamo un sito Web WIKI all’indirizzo http://hub.qgis.org/projects/quantum-gis/wiki dove puoi trovare
una varietà di informazioni utili relative allo sviluppo di QGIS, piani di rilascio, collegamenti a siti di download,
messaggi-suggerimenti per la traduzione e altro. Dai un’occhiata, ci sono alcune chicche dentro!
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CHAPTER 24

Hanno contribuito

QGIS è un progetto open source sviluppato da un team di volontari e organizzazioni dedicate. Ci sforziamo di
essere una comunità accogliente per persone di ogni razza, credo, genere e ceto sociale. In qualsiasi momento,
puoi get involved.

24.1 Autori

Di seguito sono elencate le persone che dedicano il loro tempo e le loro energie a scrivere, rivedere e aggiornare
l’intera documentazione di QGIS.
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bach
René-Luc D’Hont

Tom Chadwin Patrick Sunter Nyall Dawson Milo Van der Lin-
den

Paolo Cavallini

Paolo Corti Hugo Mercier Gavin Macaulay Stefan Blumentrath Nicholas Duggan
David Adler Vincent Mora Tudor Bărăscu QGIS Koran Trans-

lator
Stéphane Brunner

Jaka Kranjc Tom Kralidis Zoltan Siki Sebastian Dietrich Uros Preloznik
Dick Groskamp Mezene Worku Alexandre Bus-

quets
Dominic Keller Andre Mano

Chris Mayo Håvard Tveite Mie Winstrup Jonathan Willitts Giovanni Manghi
Martina Savarese icephale Andrei GiordanoPezzola zstadler
Ramon embelding ajazepk

24.2 Traduttori

QGIS è un’applicazione multilingue e, come tale, pubblica anche una documentazione tradotta in diverse
lingue. Molte altre lingue sono in fase di traduzione e saranno rilasciate non appena raggiungono una per-
centuale ragionevole di traduzione. Se vuoi aiutare a migliorare una lingua o richiederne una nuova, vedi
https://qgis.org/en/site/getinvolved/index.html.

Le traduzioni attuali sono rese possibili grazie a:
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Lin-
gua

Hanno contribuito

Ba-
hasa
In-
done-
sia

Emir Hartato, I Made Anombawa, Januar V. Simarmata, Muhammad Iqnaul Haq Siregar, Trias Aditya

Cinese
(Tradizionale)

Calvin Ngei, Zhang Jun, Richard Xie

Olan-
dese

Carlo van Rijswijk, Dick Groskamp, Diethard Jansen, Raymond Nijssen, Richard Duivenvoorde,
Willem Hoffman

Fin-
lan-
dese

Matti Mäntynen, Kari Mikkonen

FranceseArnaud Morvan, Augustin Roche, Didier Vanden Berghe, Dofabien, Etienne Trimaille, Harrissou Sant-
anna, Jean-Roc Morreale, Jérémy Garniaux, Loïc Buscoz, Lsam, Marc-André Saia, Marie Silvestre,
Mathieu Bossaert, Mathieu Lattes, Mayeul Kauffmann, Médéric Ribreux, Mehdi Semchaoui, Michael
Douchin, Nicolas Boisteault, Nicolas Rochard, Pascal Obstetar, Robin Prest, Rod Bera, Stéphane Hen-
riod, Stéphane Possamai, sylther, Sylvain Badey, Sylvain Maillard, Vincent Picavet, Xavier Tardieu,
Yann Leveille-Menez, yoda89

Gal-
iziano

Xan Vieiro

TedescoJürgen E. Fischer, Otto Dassau, Stephan Holl, Werner Macho
Hindi Harish Kumar Solanki
Ital-
iano

Alessandro Fanna, Anne Ghisla, Flavio Rigolon, Giuliano Curti, Luca Casagrande, Luca Delucchi,
Marco Braida, Matteo Ghetta, Maurizio Napolitano, Michele Beneventi, Michele Ferretti, Roberto An-
geletti, Paolo Cavallini, Stefano Campus

Gi-
ap-
ponese

Baba Yoshihiko, Minoru Akagi, Norihiro Yamate, Takayuki Mizutani, Takayuki Nuimura, Yoichi
Kayama

Core-
ano

OSGeo Korean Chapter

Po-
lacco

Andrzej Świąder, Borys Jurgiel, Ewelina Krawczak, Jakub Bobrowski, Mateusz Łoskot, Michał Kułach,
Michał Smoczyk, Milena Nowotarska, Radosław Pasiok, Robert Szczepanek, Tomasz Paul

Por-
togh-
ese

Alexandre Neto, Duarte Carreira, Giovanni Manghi, João Gaspar, Joana Simões, Leandro Infantini,
Nelson Silva, Pedro Palheiro, Pedro Pereira, Ricardo Sena

Por-
togh-
ese
(Brasile)

Arthur Nanni, Felipe Sodré Barros, Leônidas Descovi Filho, Marcelo Soares Souza, Narcélio de Sá
Pereira Filho, Sidney Schaberle Goveia

Ru-
meno

Alex Bădescu, Bogdan Pacurar, Georgiana Ioanovici, Lonut Losifescu-Enescu, Sorin Călinică, Tudor
Bărăscu

Russo Alexander Bruy, Artem Popov
Spag-
nolo

Carlos Dávila, Diana Galindo, Edwin Amado, Gabriela Awad, Javier César Aldariz, Mayeul Kauffmann

UcrainoAlexander Bruy
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CHAPTER 25

Appendices

25.1 Appendix A: GNU General Public License

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330, Boston, MA 02111-1307,
USA

Ognuno ha la possibilità di copiare e distribuire copie letterali di questo documento di licenza, i cambi non sono
permessi.

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast,
the GNU General Public License is intended to guarantee your freedom to share and change free software–to
make sure the software is free for all its users. This General Public License applies to most of the Free Software
Foundation’s software and to any other program whose authors commit to using it. (Some other Free Software
Foundation software is covered by the GNU Library General Public License instead.) You can apply it to your
programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed
to make sure that you have the freedom to distribute copies of free software (and charge for this service if you
wish), that you receive source code or can get it if you want it, that you can change the software or use pieces of
it in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to
surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients
all the rights that you have. You must make sure that they, too, receive or can get the source code. And you must
show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you
legal permission to copy, distribute and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands that there is no
warranty for this free software. If the software is modified by someone else and passed on, we want its recipients
to know that what they have is not the original, so that any problems introduced by others will not reflect on the
original authors” reputations.
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Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redis-
tributors of a free program will individually obtain patent licenses, in effect making the program proprietary. To
prevent this, we have made it clear that any patent must be licensed for everyone’s free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow. TERMS AND CONDITIONS
FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the copyright holder
saying it may be distributed under the terms of this General Public License. The «Program», below, refers to
any such program or work, and a «work based on the Program» means either the Program or any derivative
work under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim
or with modifications and/or translated into another language. (Hereinafter, translation is included without
limitation in the term «modification».) Each licensee is addressed as «you».

Activities other than copying, distribution and modification are not covered by this License; they are outside
its scope. The act of running the Program is not restricted, and the output from the Program is covered only
if its contents constitute a work based on the Program (independent of having been made by running the
Program). Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any medium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice
and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any
warranty; and give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty
protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the
Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided
that you also meet all of these conditions:

(a) You must cause the modified files to carry prominent notices stating that you changed the files and the
date of any change.

(b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived
from the Program or any part thereof, to be licensed as a whole at no charge to all third parties under
the terms of this License.

(c) If the modified program normally reads commands interactively when run, you must cause it, when
started running for such interactive use in the most ordinary way, to print or display an announcement
including an appropriate copyright notice and a notice that there is no warranty (or else, saying that
you provide a warranty) and that users may redistribute the program under these conditions, and telling
the user how to view a copy of this License. (Exception: if the Program itself is interactive but does
not normally print such an announcement, your work based on the Program is not required to print an
announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not
derived from the Program, and can be reasonably considered independent and separate works in themselves,
then this License, and its terms, do not apply to those sections when you distribute them as separate works.
But when you distribute the same sections as part of a whole which is a work based on the Program, the
distribution of the whole must be on the terms of this License, whose permissions for other licensees extend
to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you;
rather, the intent is to exercise the right to control the distribution of derivative or collective works based on
the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work
based on the Program) on a volume of a storage or distribution medium does not bring the other work under
the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or exe-
cutable form under the terms of Sections 1 and 2 above provided that you also do one of the following:
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(a) Accompany it with the complete corresponding machine-readable source code, which must be dis-
tributed under the terms of Sections 1 and 2 above on a medium customarily used for software inter-
change; or,

(b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no
more than your cost of physically performing source distribution, a complete machine-readable copy
of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a
medium customarily used for software interchange; or,

(c) Accompany it with the information you received as to the offer to distribute corresponding source
code. (This alternative is allowed only for noncommercial distribution and only if you received the
program in object code or executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an
executable work, complete source code means all the source code for all modules it contains, plus any
associated interface definition files, plus the scripts used to control compilation and installation of the ex-
ecutable. However, as a special exception, the source code distributed need not include anything that is
normally distributed (in either source or binary form) with the major components (compiler, kernel, and
so on) of the operating system on which the executable runs, unless that component itself accompanies the
executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then
offering equivalent access to copy the source code from the same place counts as distribution of the source
code, even though third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this
License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will
automatically terminate your rights under this License. However, parties who have received copies, or
rights, from you under this License will not have their licenses terminated so long as such parties remain in
full compliance.

5. You are not required to accept this License, since you have not signed it. However, nothing else grants you
permission to modify or distribute the Program or its derivative works. These actions are prohibited by law
if you do not accept this License. Therefore, by modifying or distributing the Program (or any work based
on the Program), you indicate your acceptance of this License to do so, and all its terms and conditions for
copying, distributing or modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically
receives a license from the original licensor to copy, distribute or modify the Program subject to these terms
and conditions. You may not impose any further restrictions on the recipients” exercise of the rights granted
herein. You are not responsible for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not
limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise)
that contradict the conditions of this License, they do not excuse you from the conditions of this License.
If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other
pertinent obligations, then as a consequence you may not distribute the Program at all. For example, if a
patent license would not permit royalty-free redistribution of the Program by all those who receive copies
directly or indirectly through you, then the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance
of the section is intended to apply and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or
to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the
free software distribution system, which is implemented by public license practices. Many people have
made generous contributions to the wide range of software distributed through that system in reliance on
consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute
software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this
License.
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8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copy-
righted interfaces, the original copyright holder who places the Program under this License may add an
explicit geographical distribution limitation excluding those countries, so that distribution is permitted only
in or among countries not thus excluded. In such case, this License incorporates the limitation as if written
in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to
address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a version number of this Li-
cense which applies to it and «any later version», you have the option of following the terms and conditions
either of that version or of any later version published by the Free Software Foundation. If the Program
does not specify a version number of this License, you may choose any version ever published by the Free
Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are
different, write to the author to ask for permission. For software which is copyrighted by the Free Software
Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision
will be guided by the two goals of preserving the free status of all derivatives of our free software and of
promoting the sharing and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR
THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTH-
ERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE
THE PROGRAM «AS IS» WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IM-
PLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABIL-
ITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFEC-
TIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL
ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDIS-
TRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, IN-
CLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO
LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU
OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PRO-
GRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBIL-
ITY OF SUCH DAMAGES.

QGIS Qt exception for GPL

In addition, as a special exception, the QGIS Development Team gives permission to link the code of this program
with the Qt library, including but not limited to the following versions (both free and commercial): Qt/Non-
commercial Windows, Qt/Windows, Qt/X11, Qt/Mac, and Qt/Embedded (or with modified versions of Qt that use
the same license as Qt), and distribute linked combinations including the two. You must obey the GNU General
Public License in all respects for all of the code used other than Qt. If you modify this file, you may extend this
exception to your version of the file, but you are not obligated to do so. If you do not wish to do so, delete this
exception statement from your version.

25.2 GNU General Public License

Version 1.3, 3 November 2008

Copyright 2000, 2001, 2002, 2007, 2008 Free Software Foundation, Inc

https://fsf.org/
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Ognuno ha la possibilità di copiare e distribuire copie letterali di questo documento di licenza, i cambi non sono
permessi.

Preamble

The purpose of this License is to make a manual, textbook, or other functional and useful document «free» in the
sense of freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying
it, either commercially or noncommercially. Secondarily, this License preserves for the author and publisher a
way to get credit for their work, while not being considered responsible for modifications made by others.

This License is a kind of «copyleft», which means that derivative works of the document must themselves be free
in the same sense. It complements the GNU General Public License, which is a copyleft license designed for free
software.

We have designed this License in order to use it for manuals for free software, because free software needs free
documentation: a free program should come with manuals providing the same freedoms that the software does.
But this License is not limited to software manuals; it can be used for any textual work, regardless of subject
matter or whether it is published as a printed book. We recommend this License principally for works whose
purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS

This License applies to any manual or other work, in any medium, that contains a notice placed by the copyright
holder saying it can be distributed under the terms of this License. Such a notice grants a world-wide, royalty-free
license, unlimited in duration, to use that work under the conditions stated herein. The Document, below, refers
to any such manual or work. Any member of the public is a licensee, and is addressed as «you». You accept the
license if you copy, modify or distribute the work in a way requiring permission under copyright law.

A «Modified Version» of the Document means any work containing the Document or a portion of it, either copied
verbatim, or with modifications and/or translated into another language.

A «Secondary Section» is a named appendix or a front-matter section of the Document that deals exclusively
with the relationship of the publishers or authors of the Document to the Document’s overall subject (or to related
matters) and contains nothing that could fall directly within that overall subject. (Thus, if the Document is in part
a textbook of mathematics, a Secondary Section may not explain any mathematics.) The relationship could be
a matter of historical connection with the subject or with related matters, or of legal, commercial, philosophical,
ethical or political position regarding them.

The «Invariant Sections» are certain Secondary Sections whose titles are designated, as being those of Invariant
Sections, in the notice that says that the Document is released under this License. If a section does not fit the
above definition of Secondary then it is not allowed to be designated as Invariant. The Document may contain
zero Invariant Sections. If the Document does not identify any Invariant Sections then there are none.

The «Cover Texts» are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts, in
the notice that says that the Document is released under this License. A Front-Cover Text may be at most 5 words,
and a Back-Cover Text may be at most 25 words.

A «Transparent» copy of the Document means a machine-readable copy, represented in a format whose specifi-
cation is available to the general public, that is suitable for revising the document straightforwardly with generic
text editors or (for images composed of pixels) generic paint programs or (for drawings) some widely available
drawing editor, and that is suitable for input to text formatters or for automatic translation to a variety of formats
suitable for input to text formatters. A copy made in an otherwise Transparent file format whose markup, or ab-
sence of markup, has been arranged to thwart or discourage subsequent modification by readers is not Transparent.
An image format is not Transparent if used for any substantial amount of text. A copy that is not «Transparent» is
called Opaque.

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input format,
LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming simple HTML,
PostScript or PDF designed for human modification. Examples of transparent image formats include PNG, XCF
and JPG. Opaque formats include proprietary formats that can be read and edited only by proprietary word pro-
cessors, SGML or XML for which the DTD and/or processing tools are not generally available, and the machine-
generated HTML, PostScript or PDF produced by some word processors for output purposes only.

The «Title Page» means, for a printed book, the title page itself, plus such following pages as are needed to hold,
legibly, the material this License requires to appear in the title page. For works in formats which do not have any
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title page as such, «Title Page» means the text near the most prominent appearance of the work’s title, preceding
the beginning of the body of the text.

The «publisher» means any person or entity that distributes copies of the Document to the public.

A section «Entitled XYZ» means a named subunit of the Document whose title either is precisely XYZ or contains
XYZ in parentheses following text that translates XYZ in another language. (Here XYZ stands for a specific
section name mentioned below, such as «Acknowledgements», «Dedications», «Endorsements», or «History».)
To «Preserve the Title» of such a section when you modify the Document means that it remains a section «Entitled
XYZ» according to this definition.

The Document may include Warranty Disclaimers next to the notice which states that this License applies to the
Document. These Warranty Disclaimers are considered to be included by reference in this License, but only as
regards disclaiming warranties: any other implication that these Warranty Disclaimers may have is void and has
no effect on the meaning of this License.

2. VERBATIM COPYING

You may copy and distribute the Document in any medium, either commercially or noncommercially, provided
that this License, the copyright notices, and the license notice saying this License applies to the Document are
reproduced in all copies, and that you add no other conditions whatsoever to those of this License. You may not
use technical measures to obstruct or control the reading or further copying of the copies you make or distribute.
However, you may accept compensation in exchange for copies. If you distribute a large enough number of copies
you must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.

3. COPYING IN QUANTITY

If you publish printed copies (or copies in media that commonly have printed covers) of the Document, numbering
more than 100, and the Document’s license notice requires Cover Texts, you must enclose the copies in covers
that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts
on the back cover. Both covers must also clearly and legibly identify you as the publisher of these copies. The
front cover must present the full title with all words of the title equally prominent and visible. You may add other
material on the covers in addition. Copying with changes limited to the covers, as long as they preserve the title
of the Document and satisfy these conditions, can be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed (as many
as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either include
a machine-readable Transparent copy along with each Opaque copy, or state in or with each Opaque copy a
computer-network location from which the general network-using public has access to download using public-
standard network protocols a complete Transparent copy of the Document, free of added material. If you use the
latter option, you must take reasonably prudent steps, when you begin distribution of Opaque copies in quantity, to
ensure that this Transparent copy will remain thus accessible at the stated location until at least one year after the
last time you distribute an Opaque copy (directly or through your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing any large
number of copies, to give them a chance to provide you with an updated version of the Document.

4. MODIFICHE

You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and 3 above,
provided that you release the Modified Version under precisely this License, with the Modified Version filling the
role of the Document, thus licensing distribution and modification of the Modified Version to whoever possesses
a copy of it. In addition, you must do these things in the Modified Version:

1. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of
previous versions (which should, if there were any, be listed in the History section of the Document). You
may use the same title as a previous version if the original publisher of that version gives permission.

2. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the modifi-
cations in the Modified Version, together with at least five of the principal authors of the Document (all of
its principal authors, if it has fewer than five), unless they release you from this requirement.
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3. State on the Title page the name of the publisher of the Modified Version, as the publisher.

4. Preserve all the copyright notices of the Document.

5. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

6. Include, immediately after the copyright notices, a license notice giving the public permission to use the
Modified Version under the terms of this License, in the form shown in the Addendum below.

7. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in the
Document’s license notice.

8. Include an unaltered copy of this License.

9. Preserve the section Entitled «History», Preserve its Title, and add to it an item stating at least the title, year,
new authors, and publisher of the Modified Version as given on the Title Page. If there is no section Entitled
«History» in the Document, create one stating the title, year, authors, and publisher of the Document as
given on its Title Page, then add an item describing the Modified Version as stated in the previous sentence.

10. Preserve the network location, if any, given in the Document for public access to a Transparent copy of the
Document, and likewise the network locations given in the Document for previous versions it was based
on. These may be placed in the «History» section. You may omit a network location for a work that was
published at least four years before the Document itself, or if the original publisher of the version it refers
to gives permission.

11. For any section Entitled «Acknowledgements» or «Dedications», Preserve the Title of the section, and
preserve in the section all the substance and tone of each of the contributor acknowledgements and/or
dedications given therein.

12. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section
numbers or the equivalent are not considered part of the section titles.

13. Delete any section Entitled «Endorsements». Such a section may not be included in the Modified Version.

14. Do not retitle any existing section to be Entitled «Endorsements» or to conflict in title with any Invariant
Section.

15. Preserve any Warranty Disclaimers.

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary Sections and
contain no material copied from the Document, you may at your option designate some or all of these sections
as invariant. To do this, add their titles to the list of Invariant Sections in the Modified Version’s license notice.
These titles must be distinct from any other section titles.

You may add a section Entitled «Endorsements», provided it contains nothing but endorsements of your Modified
Version by various parties—for example, statements of peer review or that the text has been approved by an
organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a Back-Cover
Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of Front-Cover Text and one
of Back-Cover Text may be added by (or through arrangements made by) any one entity. If the Document already
includes a cover text for the same cover, previously added by you or by arrangement made by the same entity you
are acting on behalf of, you may not add another; but you may replace the old one, on explicit permission from
the previous publisher that added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their names for
publicity for or to assert or imply endorsement of any Modified Version.

5. COMBINING DOCUMENTS

You may combine the Document with other documents released under this License, under the terms defined in
section 4 above for modified versions, provided that you include in the combination all of the Invariant Sections
of all of the original documents, unmodified, and list them all as Invariant Sections of your combined work in its
license notice, and that you preserve all their Warranty Disclaimers.

The combined work need only contain one copy of this License, and multiple identical Invariant Sections may be
replaced with a single copy. If there are multiple Invariant Sections with the same name but different contents,
make the title of each such section unique by adding at the end of it, in parentheses, the name of the original author
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or publisher of that section if known, or else a unique number. Make the same adjustment to the section titles in
the list of Invariant Sections in the license notice of the combined work.

In the combination, you must combine any sections Entitled «History» in the various original documents, forming
one section Entitled «History»; likewise combine any sections Entitled «Acknowledgements», and any sections
Entitled «Dedications». You must delete all sections Entitled «Endorsements».

6. COLLECTIONS OF DOCUMENTS

You may make a collection consisting of the Document and other documents released under this License, and
replace the individual copies of this License in the various documents with a single copy that is included in the
collection, provided that you follow the rules of this License for verbatim copying of each of the documents in all
other respects.

You may extract a single document from such a collection, and distribute it individually under this License,
provided you insert a copy of this License into the extracted document, and follow this License in all other respects
regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT WORKS

A compilation of the Document or its derivatives with other separate and independent documents or works, in
or on a volume of a storage or distribution medium, is called an «aggregate» if the copyright resulting from the
compilation is not used to limit the legal rights of the compilation’s users beyond what the individual works permit.
When the Document is included in an aggregate, this License does not apply to the other works in the aggregate
which are not themselves derivative works of the Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the Document
is less than one half of the entire aggregate, the Document’s Cover Texts may be placed on covers that bracket
the Document within the aggregate, or the electronic equivalent of covers if the Document is in electronic form.
Otherwise they must appear on printed covers that bracket the whole aggregate.

8. TRANSLATION

Translation is considered a kind of modification, so you may distribute translations of the Document under the
terms of section 4. Replacing Invariant Sections with translations requires special permission from their copyright
holders, but you may include translations of some or all Invariant Sections in addition to the original versions of
these Invariant Sections. You may include a translation of this License, and all the license notices in the Document,
and any Warranty Disclaimers, provided that you also include the original English version of this License and the
original versions of those notices and disclaimers. In case of a disagreement between the translation and the
original version of this License or a notice or disclaimer, the original version will prevail.

If a section in the Document is Entitled «Acknowledgements», «Dedications», or «History», the requirement
(section 4) to Preserve its Title (section 1) will typically require changing the actual title.

9. TERMINATION

You may not copy, modify, sublicense, or distribute the Document except as expressly provided under this License.
Any attempt otherwise to copy, modify, sublicense, or distribute it is void, and will automatically terminate your
rights under this License.

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated
(a) provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b)
permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior to 60 days
after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies
you of the violation by some reasonable means, this is the first time you have received notice of violation of this
License (for any work) from that copyright holder, and you cure the violation prior to 30 days after your receipt
of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies
or rights from you under this License. If your rights have been terminated and not permanently reinstated, receipt
of a copy of some or all of the same material does not give you any rights to use it.

10. FUTURE REVISIONS OF THIS LICENSE
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The Free Software Foundation may publish new, revised versions of the GNU Free Documentation License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address
new problems or concerns. See https://www.gnu.org/copyleft/.

Each version of the License is given a distinguishing version number. If the Document specifies that a particular
numbered version of this License «or any later version» applies to it, you have the option of following the terms
and conditions either of that specified version or of any later version that has been published (not as a draft) by the
Free Software Foundation. If the Document does not specify a version number of this License, you may choose
any version ever published (not as a draft) by the Free Software Foundation. If the Document specifies that a
proxy can decide which future versions of this License can be used, that proxy’s public statement of acceptance
of a version permanently authorizes you to choose that version for the Document.

11. RELICENSING

«Massive Multiauthor Collaboration Site» (or «MMC Site») means any World Wide Web server that publishes
copyrightable works and also provides prominent facilities for anybody to edit those works. A public wiki that
anybody can edit is an example of such a server. A «Massive Multiauthor Collaboration» (or «MMC») contained
in the site means any set of copyrightable works thus published on the MMC site.

«CC-BY-SA» means the Creative Commons Attribution-Share Alike 3.0 license published by Creative Commons
Corporation, a not-for-profit corporation with a principal place of business in San Francisco, California, as well as
future copyleft versions of that license published by that same organization.

«Incorporate» means to publish or republish a Document, in whole or in part, as part of another Document.

An MMC is «eligible for relicensing» if it is licensed under this License, and if all works that were first published
under this License somewhere other than this MMC, and subsequently incorporated in whole or in part into the
MMC, (1) had no cover texts or invariant sections, and (2) were thus incorporated prior to November 1, 2008.

The operator of an MMC Site may republish an MMC contained in the site under CC-BY-SA on the same site at
any time before August 1, 2009, provided the MMC is eligible for relicensing.

ADDENDUM: How to use this License for your documents

To use this License in a document you have written, include a copy of the License in the document and put the
following copyright and license notices just after the title page:

Copyright © YEAR YOUR NAME.
Permission is granted to copy, distribute and/or modify this document
under the terms of the GNU Free Documentation License, Version 1.3
or any later version published by the Free Software Foundation;
with no Invariant Sections, no Front-Cover Texts, and no Back-Cover Texts.
A copy of the license is included in the section entitled "GNU
Free Documentation License".

If you have Invariant Sections, Front-Cover Texts and Back-Cover Texts, replace the «with . . . Texts.» line with
this:

with the Invariant Sections being LIST THEIR TITLES, with the
Front-Cover Texts being LIST, and with the Back-Cover Texts being LIST.

If you have Invariant Sections without Cover Texts, or some other combination of the three, merge those two
alternatives to suit the situation.

If your document contains nontrivial examples of program code, we recommend releasing these examples in
parallel under your choice of free software license, such as the GNU General Public License, to permit their use
in free software.
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25.3 Appendix B: QGIS File Formats

25.3.1 QGS/QGZ - The QGIS Project File Format

The QGS format is an XML format for storing QGIS projects. The QGZ format is a compressed (zip) archive
containing a QGS file and a QGD file. The QGD file is the associated sqlite database of the qgis project that
contain auxiliary data for the project. If there are no auxiliary data, the QGD file will be empty.

A QGIS file contains everything that is needed for storing a QGIS project, including:

• project title

• project CRS

• the layer tree

• snapping settings

• relations

• the map canvas extent

• project models

• legend

• mapview docks (2D and 3D)

• the layers with links to the underlying datasets (data sources) and other layer properties including extent,
SRS, joins, styles, renderer, blend mode, opacity and more.

• project properties

The figures below show the top level tags in a QGS file and the expanded ProjectLayers tag.

Figure 25.1: The top level tags in a QGS file
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Figure 25.2: The expanded top level ProjectLayers tag of a QGS file
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25.3.2 QLR - The QGIS Layer Definition file

A Layer Definition file (QLR) is an XML file that contains a pointer to the layer data source in addition to QGIS
style information for the layer.

The use case for this file is simple: To have a single file for opening a data source and bringing in all the related
style information. QLR files also allow you to mask the underlying datasource in an easy to open file.

An example of QLR usage is for opening MS SQL layers. Rather than having to go to the MS SQL connection
dialog, connect, select, load and finally style, you can simply add a .qlr file that points to the correct MS SQL
layer with all the necessary style included.

In the future a .qlr file may hold a reference to more than one layer.

Figure 25.3: The top level tags of a QLR file

25.3.3 QML - The QGIS Style File Format

QML is an XML format for storing layer styling.
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A QML file contains all the information QGIS can handle for the rendering of feature geometries including symbol
definitions, sizes and rotations, labelling, opacity and blend mode and more.

The figure below shows the top level tags of a QML file (with only renderer_v2 and its symbol tag expanded).

Figure 25.4: The top level tags of a QML file (only the renderer_v2 tag with its symbol tag is expanded)
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